Alan Simpson’s Windows XP Bible, Desktop Edition
About the Author

Alan Simpson is the author of more than 90 computer books, on topics ranging from Windows to word processing and Web-page design to databases. His books have been translated into more than a dozen languages and have sold millions of copies throughout the world. Prior to becoming a full-time author, Alan taught computer science at the college level and served as a computerized-training consultant to the U.S. Air Force and U.S. Navy.
Credits

Acquisitions Editor
Katie Feldman

Development Editor
Kelly Dobbs Henthorne

Production Editor
William A. Barton

Copy Editor
Christopher Jones

Editorial Manager
Mary Beth Wakefield

Vice President & Executive Group Publisher
Richard Swadley

Vice President and Executive Publisher
Robert Ipsen

Vice President and Publisher
Joseph B. Wikert

Executive Editorial Director
Mary Bednarek

Project Coordinator
Ryan Steffen

Graphics and Production Specialists
Beth Brooks
Sean Decker
Carrie Foster
Lauren Goddard
Jennifer Heleine
Rashell Smith

Quality Control Technicians
John Greenough
Andy Hollandbeck
Carl William Pierce
Brian H. Walls

Proofreading and Indexing
TECHBOOKS Production Services
To my “Introduction to Windows XP” students,
who taught me how to explain this stuff
Every book is a team effort. But, before I give thanks where thanks are due, I want you to know that I'm not trying to pass the buck here. I typed every word and captured every screen, myself. So if you don't like something, blame me. But there's a lot more to creating a book than typing the words and making the pictures. And, for all the other countless tasks, I hereby sincerely thank the following persons:

Kelly Henthorne and Chris Jones for helping make this book read as well as it does, thanks to their flawless editing. Thanks also go to the entire team at Wiley who made the process flow so smoothly: Katie Feldman, Bill Barton, Ryan Steffen, and everyone else who contributed so much to this project.

Many thanks to Matt Wagner, Margot Maley, Maureen Maloney, and everybody else at Waterside Productions (my literary agency) for making everything work out.

And, of course, all my love and thanks to Susan, Ashley, and Alec for tolerating weeks of neglect as I pounded furiously at a keyboard.
# Contents at a Glance

Acknowledgments .................................................. ix
Introduction .......................................................... xxix

**Part I: Beginner’s Crash Course** ................................. 1
Chapter 1: Getting Started .......................................... 3
Chapter 2: Workin’ It .................................................. 23
Chapter 3: Getting Help When You Need It ...................... 41

**Part II: Programs, Documents, and Folders** .............. 55
Chapter 4: Running Programs ...................................... 57
Chapter 5: Navigating Your Folders .............................. 75
Chapter 6: Working with Documents ............................ 99
Chapter 7: Type, Edit, Copy, and Paste ......................... 123
Chapter 8: Printing and Faxing Documents .................... 141

**Part III: Using the Internet** ...................................... 161
Chapter 9: Getting Online .......................................... 163
Chapter 10: Browsing the World Wide Web ..................... 173
Chapter 11: Sending and Receiving E-mail ....................... 209
Chapter 12: Using a .NET Passport .............................. 245
Chapter 13: Keeping It Safe ........................................ 283

**Part IV: Fun with Multimedia** ................................. 301
Chapter 14: Using Your Camera and Scanner ................... 303
Chapter 15: Playing with Pictures ............................... 319
Chapter 16: Music and Video with Media Player 9 ............... 333
Chapter 17: Managing Music, Making CDs ....................... 359
Chapter 18: Making Home Movies ............................... 383

**Part V: Getting Organized, Staying Organized** .......... 417
Chapter 19: Managing Files and Folders ......................... 419
Chapter 20: Using Your Hard Disk ............................... 447
Chapter 21: Using Floppies, CDs, and DVDs .................... 477
Chapter 22: Working with Compressed (Zip) Files .......... 501
Part VI: Have It Your Way ........................................ 513
Chapter 23: Creating and Managing User Accounts .............. 515
Chapter 24: Personalizing Your Desktop .......................... 533
Chapter 25: Expanding Your System .............................. 561
Chapter 26: Disaster Prevention and Recovery .................. 577

Part VII: Connecting Your Computers .......................... 591
Chapter 27: Design and Create Your Own Network ............ 593
Chapter 28: Sharing Things on a Network ....................... 613

Appendix A: Installing Windows XP ............................ 627
Appendix B: Shortcut Key Quick Reference ..................... 633

Index ................................................................. 639
Using Dialog Boxes ................................................. 27
Using Tabs .......................................................... 28
Using Option Buttons ............................................. 28
About the Preview .................................................. 29
Using Checkboxes .................................................. 29
Using Spin Boxes .................................................. 30
Using Drop-Down Lists .......................................... 30
Using List Boxes ................................................... 31
Using Sliders ......................................................... 32
Getting Help in Dialog Boxes ................................... 33
Using Buttons ....................................................... 34
What’s the Default? .................................................. 34
Typing Text and Passwords ....................................... 35
  Changing Text in a Textbox ...................................... 35
  Changing Chunks of Text ....................................... 36
  Combo Boxes and AutoComplete ............................... 37
  Typing Passwords ................................................ 38
Summary ............................................................... 38

Chapter 3: Getting Help When You Need It ............... 41
  Using Windows XP’s Help and Support Center ............... 41
    Searching for Specific Information ........................ 42
    Using the Help Index ......................................... 45
    Getting Around in Help and Support ......................... 46
    Accessing Your Favorites ..................................... 47
    Troubleshooters ............................................... 48
    Closing Help and Support .................................... 48
Getting Help Online ............................................... 49
Getting Help with Your Computer ............................. 51
Other Sources of Help ............................................. 51
Summary ............................................................... 52

Part II: Programs, Documents, and Folders .............. 55

Chapter 4: Running Programs ................................. 57
  Starting Programs ............................................... 57
  Taking Control of Program Windows ......................... 59
    Tools Found in Most Program Windows .................... 60
    About the Active Window ................................... 61
Arranging Open Program Windows ............................ 63
  Maximizing and Minimizing Program Windows .............. 65
  See the Desktop by Minimizing All Open Windows ........ 66
  Sizing a Window ................................................ 68
  Moving a Program Window ..................................... 68
Working the Menu Bars .......................................... 68
  Watch Out for Collapsible Menus! ........................... 70
  Using Toggles on Menus ........................................ 70
  Getting Help in Programs ...................................... 71
<table>
<thead>
<tr>
<th>Chapter 7: Type, Edit, Copy, and Paste</th>
<th>123</th>
</tr>
</thead>
<tbody>
<tr>
<td>Typing on a Screen</td>
<td>124</td>
</tr>
<tr>
<td>Indenting and Aligning Text</td>
<td>125</td>
</tr>
<tr>
<td>Setting Margins</td>
<td>126</td>
</tr>
<tr>
<td>Choosing a Page Orientation</td>
<td>127</td>
</tr>
<tr>
<td>Printing Text</td>
<td>127</td>
</tr>
<tr>
<td>Navigating in Text</td>
<td>127</td>
</tr>
<tr>
<td>Selecting Text to Change</td>
<td>128</td>
</tr>
<tr>
<td>Changing Text</td>
<td>130</td>
</tr>
<tr>
<td>Deleting and Replacing Large Chunks of Text</td>
<td>131</td>
</tr>
<tr>
<td>Styling Text</td>
<td>131</td>
</tr>
<tr>
<td>Copying, Moving, and Pasting Text</td>
<td>133</td>
</tr>
<tr>
<td>Copying from One Document to Another</td>
<td>134</td>
</tr>
<tr>
<td>Copy and Paste a Picture</td>
<td>135</td>
</tr>
<tr>
<td>Move a Chunk of Text within a Document</td>
<td>137</td>
</tr>
<tr>
<td>Adding Special Characters to Text</td>
<td>137</td>
</tr>
<tr>
<td>Saving Your Text</td>
<td>138</td>
</tr>
<tr>
<td>Summary</td>
<td>139</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Chapter 8: Printing and Faxing Documents</th>
<th>141</th>
</tr>
</thead>
<tbody>
<tr>
<td>Printing a Document</td>
<td>141</td>
</tr>
<tr>
<td>Common Printing Options</td>
<td>142</td>
</tr>
<tr>
<td>Choosing a Print Quality and Such</td>
<td>143</td>
</tr>
<tr>
<td>Stopping the Printer, Managing Print Jobs</td>
<td>144</td>
</tr>
<tr>
<td>Managing Printers and Faxes</td>
<td>146</td>
</tr>
<tr>
<td>Changing the Default Printer</td>
<td>148</td>
</tr>
<tr>
<td>Using a Different Printer for One Job</td>
<td>148</td>
</tr>
<tr>
<td>Installing a Printer</td>
<td>149</td>
</tr>
<tr>
<td>USB, IEEE 1394 Firewire, or Infrared Connection</td>
<td>150</td>
</tr>
<tr>
<td>Parallel and Serial Port Connections</td>
<td>150</td>
</tr>
<tr>
<td>Printing the Screen</td>
<td>150</td>
</tr>
<tr>
<td>Troubleshooting Common Printer Problems</td>
<td>151</td>
</tr>
<tr>
<td>Faxing Documents</td>
<td>152</td>
</tr>
<tr>
<td>Using a Faxmodem</td>
<td>153</td>
</tr>
<tr>
<td>Configuring Fax Services</td>
<td>154</td>
</tr>
<tr>
<td>Using the Fax Console</td>
<td>155</td>
</tr>
<tr>
<td>Sending a Fax</td>
<td>156</td>
</tr>
</tbody>
</table>
Chapter 11: Sending and Receiving E-mail

Introducing Outlook Express
Setting Up Your E-mail Account
Sending E-mail with Outlook Express
Composing Fancier E-mail Messages
Using Fonts and Alignments
Typing a List
Inserting a Picture
Inserting a Hyperlink
Attaching Files to E-mail Messages
Sending the Message
Reading Your E-mail with Outlook Express
Opening Attachments
Checking Your Attachment Security
Viewing (Opening) an Attachment
Saving Attachments
Managing E-mail Messages
Selecting Messages
Deleting Messages
Grouping Messages into Folders
Moving Messages into Folders
Marking Messages as Read or Unread
Using Windows Address Book
Tracking Names and Addresses Automatically
Opening Windows Address Book
Managing Contacts
Adding and Changing Contacts
Deleting Contacts
Printing Contacts
Creating Groups and Mailing Lists
Using the Address Book to Send E-mail
Customizing and Configuring Outlook Express
General Options
Read Options
Receipt Options
Send Options
Compose Options
Automatic Signature Options
E-mail Spelling Options
Chapter 12: Using a .NET Passport

What Is a .NET Passport? 245
Creating Your .NET Passport 246
Opening Windows Messenger, Signing In 248
E-mail Address Not Verified 249
A New Version of Windows Messenger Is Available 250
Instant Messaging with Windows Messenger 250
Setting Up Your List of Contacts 251
Starting a Conversation 251
Adding Emoticons 252
Choosing a Message Font 255
Pasting to the Conversation Window 256
When Someone Contacts You 256
Inviting Others to Join In 257
Inviting Others to Get Lost 257
Ending a Conversation 258
Your Do Not Disturb Options 257
Transferring Files and Photos 259
Toll-Free Talking 261
Twenty-First Century Toll-Free Videophone 263
Using Remote Assistance 264
Starting a Remote Assistance Session 264
Ending a Remote Assistance Session 266
Working in Teams 266
Using the Whiteboard 268
Pasting into the Whiteboard 271
Erasing from the Whiteboard 271
Saving a Whiteboard 272
Closing a Whiteboard Session 272
Managing Your Contacts 272
Grouping Contacts 272
Creating Groups 273
Deleting Groups 274
Deleting a Contact 274
Configuring Windows Messenger 274
Choosing Your Display Name and Font 274
To Autostart or Not to Autostart 275
Showing/Hiding Message Alerts 276
Choosing Where to Put Received Files 277
Maintaining Your Privacy 277
Blocking Known and Unknown Contacts 277
See Who Has You as a Contact 278
Showing/Hiding Your Phone Number 279
Windows Messenger Phone Calls 279
Using an Alternative to Sign-ins and .NET Alerts 280
Chapter 13: Keeping It Safe ........................................ 283
Viruses, Worms, and Trojan Horses ....................... 283
Installing Anti-Virus Software .......................... 286
Using Anti-Virus Software .................................... 286
Scanning Downloaded Files ............................... 287
Hackers and Crackers ........................................... 288
Dealing with Pop-Up Ads ..................................... 290
Blocking Pop-Ups .............................................. 291
Blocking Messenger Pop-Ups .............................. 292
Dealing with Spam (Junk E-Mail) ......................... 295
Adware and Spyware ............................................ 295
Parental Controls .................................................. 296
Keep XP Up-to-Date .............................................. 297
Installing Declined Updates ............................. 298
Getting Everything Up-to-Date ......................... 299
Summary .......................................................... 299

Part IV: Fun with Multimedia ................................... 301
Chapter 14: Using Your Camera and Scanner .......... 303
About Pictures .................................................... 303
Viewing Picture Icons ......................................... 305
Types of Pictures ................................................. 305
Copying Pictures from a CD ............................... 307
Getting Pictures from a Digital Camera ................. 310
Scanning Documents ......................................... 312
Copying Pictures from a Web Page ..................... 314
Installing Cameras and Scanners ....................... 315
Troubleshooting Cameras and Scanners ................. 317
Summary .......................................................... 317
Chapter 15: Playing with Pictures ......................... 319
Using Your My Pictures Folder ......................... 319
Printing Pictures ............................................... 321
Making a Working Copy of a Picture .................... 322
Rotating a Picture ............................................... 323
Recording Details About Your Photos ................... 323
Using Windows Picture and Fax Viewer ................. 325
Editing Pictures with Paint ................................ 326
Opening Paint ..................................................... 327
Copy and Paste a Picture into Paint ..................... 327
Cropping a Picture in Paint ................................ 328
Sizing a Picture in Paint ....................................... 329
Printing and Saving a Picture in Paint ................. 330
Fancier Graphics Editing ..................................... 331
Summary .......................................................... 332
Chapter 18: Making Home Movies

Introducing Windows Movie Maker 2
Upgrading to Movie Maker 2
Taking Control of Movie Maker 2
Windows Movie Maker Panes
  Movie Tasks Pane
  Storyboard/Timeline
  Collections Pane
  Contents Pane
  Monitor
Getting Content for Your Movie
  Getting Video from Your Camcorder
    Connecting the Camera
    Using the Video Capture Wizard
  Importing Video from Files
Creating the Movie
  Arranging Your Scenes
  Previewing Your Movie
  Trimming Scenes
  Overlapping Scenes
  Spicing Up Your Movie
    Adding Titles and Credits
    Adding Still Photos to Your Movie
    Adding Video Effects
    Using Transition Effects
    Adding Narration or Background Music
  Saving a Project (Work in Progress)
Creating the Final Movie
  Trying Other Quality Settings
  Copying Movies to Tape and DVD
  Closing Windows Movie Maker
Managing Collections
  Combining Clips
  Moving, Renaming, and Deleting Clips and Collections
Summary

Part V: Getting Organized, Staying Organized

Chapter 19: Managing Files and Folders

Creating Folders
Creating Your Own Folders
  Creating a Folder on-the-Fly
Renaming Files and Folders
Working with Multiple Files and Folders
  Selecting Multiple Icons by Dragging
  Selecting All Icons in a Folder
### Chapter 22: Working with Compressed (Zip) Files

- Programs for Managing Zip Files .................................. 502
- Making Zip Files in Windows XP .................................. 502
- E-Mailing a Zip File ................................................... 505
  - Shortcut for Attaching Files to E-mail .......................... 505
  - Attaching Files without the Shortcut ............................ 506
- Using Zip Files ......................................................... 507
- Weird Compression Facts ............................................. 510
- Summary ................................................................. 511

### Chapter 23: Creating and Managing User Accounts

- What’s a User Account? ................................................. 516
- Administrators versus Limited Users .............................. 517
- Private Documents versus Shared Documents .................. 518
- Password-Protecting a User Account .............................. 518
- The Guest Account ..................................................... 519
- How to Create a User Account ...................................... 519
- Logging on to a New Account ...................................... 520
- Getting Back to Your Own User Account ......................... 521
- Changing a User Account ............................................ 521
- Deleting a User Account ............................................ 523
- Activating/Deactivating the Guest Account ...................... 524
- Keeping Your Documents Private .................................. 524
- Signing Into, and Out of, User Accounts ......................... 525
- Switching Users ....................................................... 526
- Allowing/Preventing Switch User .................................. 527
- Snooping through User Accounts .................................. 528
- Summary ................................................................. 531
Chapter 24: Personalizing Your Desktop .......................... 533
Some General Tips on Customizing ......................... 534
Creating Your Own Desktop ................................. 536
Choosing a Theme ........................................... 537
Changing the Picture on Your Desktop ................. 537
Choosing Icons to Display on the Desktop .......... 538
Choosing a Screen Saver .................................. 538
Fine-Tuning Your Color Scheme ......................... 539
Choosing a Screen Resolution and Color Depth .... 540
Saving Display Properties Settings .................... 541
Arranging Icons on Your Desktop ....................... 542
Personalizing Your Start Menu ......................... 542
Controlling What You See on the Start Menu ........ 543
Pinning Items to the Start Menu ......................... 544
Unpinning, Renaming, and Removing Start Menu Items .. 546
Rearranging Start and All Programs Menu Items .... 547
Personalizing Your Taskbar ............................... 548
Moving and Sizing Taskbar Items ......................... 550
Using the Quick Launch Toolbar ......................... 551
Personalizing the Notification Area ...................... 552
Optional Taskbar Toolbars ................................ 553
Creating Your Own Shortcuts ............................ 554
Accessibility for Sensory and Motor Impairments .... 556
Activating/Deactivating Accessibility Utilities ........ 557
Accessibility Utilities for Everyone ..................... 558
About SerialKeys ........................................... 559
Summary ...................................................... 559

Chapter 25: Expanding Your System ....................... 561
Learning About Hardware and Software for Windows XP . 561
Playing It Safe with Installations ......................... 562
Setting a Restore Point ................................... 562
Installing New Software .................................. 563
Installing Software from CDs and Floppies .......... 564
If Nothing Happens when You Insert the Disk ........ 564
Downloading and Installing Programs .................. 565
Installing Missing Windows Components ............. 566
Installing New Hardware .................................. 568
Installing USB Devices ................................... 569
Installing Non-USB Devices .............................. 570
Uninstalling Programs ..................................... 570
Uninstalling Hardware ..................................... 572
Removing USB Devices .................................... 572
Uninstalling Other Types of Hardware ................. 573
Restoring Your System Files .............................. 574
Summary ...................................................... 576

Chapter 26: Disaster Prevention and Recovery .......... 577
Dealing with Error Messages .............................. 577
Easy Troubleshooting ........................................ 579
What to Do If the Computer Freezes Up ........................................ 581
Getting Information About Your Computer .................................. 582
Fixing Startup Problems ............................................................. 583
Making Backups ........................................................................... 584
  Backing Up Windows and Programs ............................................ 585
  Backing Up Documents ............................................................. 586
  Backing Up Settings .................................................................. 588
Summary ....................................................................................... 589

Part VII: Connecting Your Computers ........................................... 591

Chapter 27: Design and Create Your Own Network ....................... 593
  What Is a LAN? ........................................................................... 593
  Planning a LAN ......................................................................... 594
  Connect Two Computers in a Traditional LAN ......................... 594
  Connect Three or More Computers in a Traditional LAN .......... 595
  Connect Computers Without Ethernet Cables ......................... 595
  Connecting Computers in a Wireless LAN ............................... 596
  Networking with a Router .......................................................... 598
  Mixed Mode Networking ............................................................ 599
  Using the Network Setup Wizard ............................................... 601
  Determine Your ICS Host .......................................................... 601
  Adding Non-XP Computers to the LAN ..................................... 602
  Running the Network Setup Wizard .......................................... 602
  Using the Internet in a LAN ........................................................ 606
  Securing a LAN ......................................................................... 607
  Beyond Firewalls ....................................................................... 608
  Testing and Troubleshooting Your LAN ..................................... 608
  Network Troubleshooting .......................................................... 609
  You Did It! ................................................................................ 611
Summary ....................................................................................... 611

Chapter 28: Sharing Things on a Network ..................................... 613
  Some Networking Buzzwords ..................................................... 613
  Using a Shared Printer ............................................................... 615
  Sharing a Printer ........................................................................ 616
  Adding a Shared Printer to Your Computer ............................... 617
  Using Shared Documents and Folders ....................................... 617
  Using My Network Places .......................................................... 618
  Opening Shared Documents and Folders .................................... 619
  Sharing Folders .......................................................................... 621
  Adding a Shared Folder to Your My Network Places Folder ......... 623
  Moving and Copying Files on a LAN ......................................... 624
Summary ....................................................................................... 626
Appendix A: Installing Windows XP .......................... 627
  Windows XP System Requirements .......................... 627
  Preinstallation Housekeeping ............................... 628
  Installing Windows XP ....................................... 628
    Installation Options ...................................... 629
    The Setup Wizard ........................................ 630
    Product Activation ....................................... 630
    Getting Online .......................................... 630
    Sharing the Computer ................................... 630
    Done! .................................................. 631
  Re-Enabling Old Startup Programs ......................... 631

Appendix B: Shortcut Key Quick Reference .................. 633
  General Keyboard Shortcuts ............................... 634
  Text-Editing Shortcut Keys ............................... 635
  Dialog Box Shortcut Keys ................................ 636
  Windows Explorer Shortcut Keys ........................... 636
  Accessibility Shortcut Keys ............................... 637
  Natural Keyboard Shortcut ................................. 637

Index ....................................................... 639
Introduction

I wish I could have titled this book something like... How to use your PC to access the Internet, do e-mail, play with pictures, print things, deal with ZIP files, download music from the Internet, e-mail pictures, open e-mail attachments, burn CDs and DVDs, talk long-distance for free, make movies, and more, without going crazy in the process.

... but that was too many words.

Books aren’t cheap, so you want to always make sure that you get a book that’s appropriate for your needs. Which brings us right to...

Who This Book Is for

In a nutshell, this book is for people who are clueless about computers and want to stop being that way. It’s a book for people who have Windows XP on their computers, but aren’t sure why, or what they’re supposed to do with it. It’s a book about using your computer to do the things that most people want to do, including (but not limited to) those activities described in the aforementioned title-with-too-many-words.

This is a book for people who have never touched a computer in their lives or have just enough experience to want to touch their PC extremely hard with a sledge hammer. It’s a book for people who either don’t yet realize, or have come to realize the hard way, that when it comes to using a PC, the following is dead-bang true:

Guessing doesn’t work

This is not an upgrade” book for people who’ve been using Windows for the last 10 years. It’s not a book for people who have already read one of my earlier Windows books and want to pick up where that book left off. If you can read the following sentence and picture clearly how, when, and why you want to do what it says, this may not the right book for you:

Right-drag the selected items to the destination folder, drop, and then choose Copy Here or Move Here, depending on which you want to do, from the shortcut menu.

This is a book for people who can read the above sentence and honestly say, “I have no idea what he’s talking about.”
How to Use This Book

I cannot tell a lie. If you try to skip the first hundred or so pages in this book and jump to a particular topic in the middle or end, you will not be a happy camper. Despite what anyone tells you, the same is true of all books. So here’s the reality check on how you should use this book:

**Part I: Beginner’s Crash Course** — This is an absolute must for anyone who has never used a PC, doesn’t know a right-click from a drag, a shortcut key from a toolbar, or a dialog box from a drop-down list. If the expression, “look it up in Help,” doesn’t help you, reading Part I is a must.

**Part II: Programs, Documents, and Folders** — This part is an absolute must for anyone who doesn’t know a program from a document, a folder from a file, or a cut from a paste. If you wonder why things keep disappearing from your screen, and you can’t get them back, this Part is your lifesaver.

**Part III: Using the Internet** — Now we’re getting into things that aren’t so critical for using your computer. After all, you can do many things with a computer without using the Internet. But, if you want to do things like browse the Web; send and receive e-mail; chat with friends; and keep your computer safe from worms, viruses, and hackers, this is the place to go.

**Part IV: Fun with Multimedia** — If you’re interested in pictures, music, movies, or DVD, this is the place to look. But, be forewarned; if you skip Parts I and II before you get here, the experience will be more along the lines of “Struggling with Multimedia.” Sadly, you have to know a little bit about what you’re doing before the fun can begin.

**Part V: Getting Organized, Staying Organized** — If you’ve ever lost a file that you created or downloaded, you need to read this part. Believe it or not, if you want to see something on your computer, you have to know where that something is first. Also, if you plan to use CDs, DVDs, floppy disks, your hard disk, or ZIPs, this is the place to look.

**Part VI: Have It Your Way** — This Part is iffy in the “must know” department. But, it is useful if you have trouble seeing things on your screen, want to add some programs to your PC, or need to solve a PC problem.

**Part VII: Connecting Your Computers** — You can ignore these two chapters if you will never own more than one computer and if you never have to use a computer that’s part of a network. This Part is a bit more technical than other parts of the book. If you’re not into technical, you can use this Part for its auxiliary backup purpose as a guaranteed cure for insomnia.
Write Me

If you need to get in touch with me, it would be best to go through my Web site at . . .

www.coolnerds.com

Don’t worry: I don’t do ads; I don’t do pop-ups; I don’t sell things. To tell you the truth, I don’t do much of anything on my Web site. But, if you go there and click on the Write to Alan link, I’ll be sure to get your message. (See Chapter 10, if you don’t know how to get to www.coolnerds.com or what a link looks like.)

You can also e-mail me at alan@coolnerds.com, but I wouldn’t recommend that. Because I have no way of knowing who is going to write when, I can’t set up my spam filter to expect your e-mail. If you don’t go through my Web site, there’s a good chance your message will be inadvertently blasted into junk mail oblivion before I ever see it.

See you online,

Alan
Wouldn’t it be great if you could just sit down at a computer and do whatever you wanted, not having to learn anything first? Those of you who have already tried the skip-learning, just-doing approach to using your computer probably know all too well the meaning of “hair-pulling frustration.” Simply stated, guessing doesn’t work. So you finally decide to follow the directions, only to discover strange hieroglyphics like “right-click the folder’s icon and choose Properties.” Huh?

Sad but true, you have to know what you’re doing just to understand the directions, assuming you can find some directions. Part I is about all the basic skills and buzzwords you need to follow directions and to find information when you need it. If you can stay awake through these first three chapters, you’ll finally be able to read the hieroglyphics. If all goes well, you’ll keep more of your hair.
On the cover of this book, we promise that even beginners will be able to understand it. As a beginner, you need to know some basic things right off the bat. For example, to understand what Windows XP is, you first have to understand what software is. And to understand what software is, you have to first know what hardware is. Let’s start with first things first.

Getting to Know Your Computer’s Hardware

Your PC (Personal Computer) is a system consisting of many individual components. Not everybody has exactly the same PC or exactly the same components. But regardless of whether you’re using a desktop computer or a notebook, your PC will probably have most of the components shown in Figure 1-1.

Your computer probably has at least one floppy disk drive, into which you can insert a floppy disk. You probably have a CD drive or DVD drive as well, into which you can insert CDs and DVDs. Floppy disks, CDs, and DVDs are often referred to as removable media, because you can stick a disk into these drives, use the disks, and remove them from the drives when you don’t need to use the disks anymore.

Inside your computer is another disk drive called the hard drive. This disk drive also goes by several other names, including hard disk, fixed disk, primary drive, or just C:. Your hard disk is an example of nonremovable media, so-named because you can’t take the hard disk out of its drive. In fact, you can’t even see the hard drive, because it’s inside the system unit, as illustrated in Figure 1-2.
Using Your Mouse

The easiest way to operate your computer (especially if you can’t type worth beans) is with your mouse. Most mice have two buttons; some mice have a wheel between the buttons. The mouse button on the left is called the primary mouse button. The mouse button on the right is called the secondary mouse button, as shown in Figure 1-3. In a nutshell, you use the primary (left) mouse button when you want the computer to do something. You use the secondary (right) mouse button when you want to see your options before you do anything.
The idea is to rest your hand comfortably on the mouse with your index finger lightly on (or near) the left mouse button, as is also shown in Figure 1-3. As you move the mouse around (without holding down either of the mouse buttons), the mouse pointer on the screen moves in the same direction that you move the mouse.

When moving the mouse, keep the front of the mouse aimed toward the screen. Don’t twist or turn the mouse. If the mouse gets out of reach, just pick it up off the table, and set it down in a more comfortable position.

A mouse is an example of a pointing device, a gadget that lets you point to and click things on the screen. If you’re using a notebook computer, your pointing device might not be a mouse. It might be a touchpad or trackball. But it will still have a primary (left) and secondary (right) mouse button. If you have difficulty using your notebook’s pointing device, the best place to look for information is the documentation that comes with your computer.

Some standard terminology describes things you can do with the mouse. You’ll see these terms used in all sorts of instructions — not just in this book. Boring as the terms may be, you might want to spend a little time getting to know them, so you can understand any written instructions you come across.

✦ **Mouse pointer**: The little arrow on the screen that moves in whatever direction you move the mouse.

✦ **Point**: To move the mouse pointer so that it’s touching some item. For example, the phrase “point to the Start button” means move the mouse pointer so that it’s resting on the Start button in the lower-left corner of the screen, as shown in Figure 1-4.
Figure 1-4: Pointing to the Start button

Pointing to an item often displays its screen tip (also called a tooltip), like the words “Click here to begin” in Figure 1-4. Whenever you’re clueless about what some little symbol on your screen represents, point to it to see whether it has a screen tip.

✦ Click: Point to the item and then tap (don’t hold down) the primary (left) mouse button.
✦ Double-click: Point to the item; tap the primary (left) mouse button twice, as quickly as you can.
✦ Right-click: Point to the item; tap the secondary (left) mouse button.
✦ Drag: Point to the item and then hold down the primary (left) mouse button while moving the mouse.
✦ Right-drag: Point to the item and then hold down the secondary (right) mouse button while moving the mouse.
✦ Drop: Release the mouse button after dragging or right-dragging.

Using Your Keyboard

Like the mouse, the keyboard is a means of interacting with your computer. Most of it is laid out like a typewriter. If you already know how to type, you’re in luck. If you don’t know how to type, I can’t help you there. But you can at least take solace in that you need the keyboard only to type text. You can use the mouse for everything else.

Aside from the regular typewriter keys, you need to recognize some additional keys and areas on the keyboard. Figure 1-5 shows an example, although your keyboard probably won’t look exactly like the one in the figure. But you should be able to find all the keys pointed out, even if your keyboard is arranged a little differently from the example in Figure 1-5.

Navigation Keys and Numeric Keypad

The arrow keys and keys labeled Home, End, and so forth are the navigation keys. As you’ll discover throughout the book, you can use those keys to move around in certain types of programs. The numeric keypad contains a set of numbers and math symbols laid out exactly as they would be on a standard adding machine. For people who are already quick with a standard adding machine, the numeric keypad offers a familiar way to type lots of numeric information into the computer.
On some keyboards, the navigation keys aren’t separate; they are combined with the keys on the numeric keypad. In that case, use the Num Lock key on the keyboard to decide which keys you want to use. When the Num Lock key is On, the numeric keypad acts just like an adding machine’s keypad. When the Num Lock key is Off, the navigation keys take over, and the numeric keypad no longer types numbers.

**Function Keys**

The keys labeled F1, F2, F3, and so forth on your keyboard are called *function keys*. The F1 key is the Help key — you can press that key at any time for help. The exact purposes of the remaining function keys depend on what program you happen to be using.

**The Windows and Application Keys**

* Some computer keyboards have a couple of extra keys specifically designed for Windows. One, named the *Windows key*, shows the flying window logo as shown at top left. If your keyboard has that key, you’ll most likely find it between the Alt and Ctrl keys on your keyboard. If your keyboard has an *Application key*, shown at bottom left, that one will likely be near one of the Windows keys on your keyboard.

The Windows and Application keys are entirely optional, so don’t fret if your keyboard doesn’t have them. Anything you can do with one of those keys, you can also do with the mouse or even some other keys. For example, if you have a Windows key on your keyboard, you can tap it to make the Start menu appear. Whether you have a Windows key or not, you can also make the Start menu appear by clicking the Start button or by pressing Ctrl+Esc. Which brings us to that little plus sign. . .
Typing Those $key1 + key2$ Things

Often when working with computers, you’ll see an instruction to press some combination keystroke, in the format $key1+key2$. When you see a combination keystroke like that, it means “hold down $key1$, tap $key2$, and release $key1$.” Here are some examples:

- **Ctrl+Esc** means “Hold down the Ctrl key, tap the Esc key, and release the Ctrl key.”
- **Alt+Tab** means “Hold down the Alt key, tap the Tab key, and release the Alt key.”
- **Shift+Enter** means “Hold down the Shift key, tap the Enter key, and release the Shift key.”
- **@winKey+D** means “Hold down the Windows key, tap the D key, and release the Windows key.”

You’ll learn about useful combination keystrokes as we go through the book. For now, it’s sufficient to know that any time you see a plus sign (+) between two key names, $key1+key2$, that means “hold down $key1$, tap $key2$, and release $key1$.”

That’s about all the hardware you need to know to get started. Let’s talk about the software next.

Getting to Know Your Computer’s Software

Let’s say someone hands you two identical-looking video cassette tapes. You put one tape into the VCR, press Play, and the movie Ben Hur starts playing. You take that tape out, put in the second tape, and press Play, and the movie Pippi Longstocking starts playing. The two cassette tapes look exactly alike. So why does one show Ben and the other Pippi? The cassette tapes are only the medium (hardware) on which information is stored. The movie itself is in the software that’s recorded onto that medium.

Like a movie on a video tape, or songs on a CD, computer software is invisible. You can’t see it or touch it, because it’s just information recorded onto some medium. In the case of programs that are already installed on your computer, that medium is your computer’s hard disk.

What Is Windows XP?

Windows XP is a type of software known as an operating system (abbreviated OS). One thing that’s unique about an operating system is that it’s the only software that a computer is required to have. If you try to start a computer
that has no operating system installed on it, you get nothing. If the computer
has only an operating system and nothing else, that’s fine. But it has to have
an operating system to do anything at all, even start.

The operating system is also your computer’s platform, the foundation upon
which all other programs run. To illustrate what I mean by that, you can’t go
to the store, buy any old graphics program off the shelf, and expect it to work
on your computer. It has to be a graphics program for Windows XP. A graphics
program for some other operating system, like the Mac OS, Linux, or UNIX, just
won’t work on a Windows computer. The reverse is also true. For example, to
get a graphics program for a Macintosh computer, you have to get one that
runs on the Mac OS.

Why Learn Windows XP?

Besides all that technical stuff, the operating system also determines how you
operate the computer. When you first start your computer, everything you see
on your screen is Windows XP. To use your computer, you really need to learn
how to use Windows XP.

It doesn’t matter if your long-term goal is to e-mail pictures to friends, make
your own music CDs, browse the Internet, or write the great American novel.
In order to do anything at all with your PC, you first need to learn to use
Windows XP (assuming, of course, that your computer’s operating system
is Windows XP).

Starting Windows XP

Because Windows XP is your computer’s operating system, you don’t have to
do anything special to start Windows XP. All you have to do is start the com-
puter (also known as booting up). I imagine you already know how to do that.
But, since there is a right way, and lots of wrongs ways, to start a computer,
let’s go through the steps:

**STEPS: Start Windows XP**

1. Turn on any device that’s connected to the computer first (printer,
   modem, monitor, scanner, whatever you have).
2. Push the eject button on the floppy disk drive, just to see whether
   there’s a disk in there. If a floppy disk pops out, remove it.
3. Turn on the main power switch on the computer, and wait.
4. If you see a Welcome Screen similar to the one shown in Figure 1-6,
   click whichever name or picture represents your user account. If you
don’t see the Welcome screen, don’t worry about. Just ignore this step.
When the computer is fully *booted up*, you should see the Windows desktop and taskbar. I can’t say exactly what those will look like on your computer. The desktop is basically the entire screen and may appear as a photo, a solid color, a pattern, or your computer manufacturer’s logo. The taskbar is the colored strip along the bottom of the screen, as in the example shown in Figure 1-7.
If you see a message about an abnormal termination when you first start your computer, make sure you learn the right way to shut down your computer as described near the end of this chapter. If you see a message about an “invalid system disk,” remove any floppy disks or CDs from their drives and then press the Enter key.

The next section briefly describes all those things pointed out in Figure 1-7.

**The Start Button**

Windows XP may be the only program that starts automatically when you first turn on your computer. But it’s certainly not the only program on your system. To start any other program, use the Start button. When you first click the Start button, the **Start menu** opens. The left side of the Start menu provides access to a few of the programs on your computer. The right side lists places (mostly folders) you’re likely to visit often. Figure 1-8 shows an example, though yours might not look exactly like the one in the figure.

![Start menu](image)

**Figure 1-8:** The Start menu

---

A menu, in the computer sense, is like a menu from a restaurant, in that it provides a list of items for you to choose from.

The left side of the Start menu actually shows icons for only a few of the programs installed on your computer: mostly programs that you use a lot or, if your computer is brand new, just some useful programs for beginners. As you’ll see in a moment, you’ll use the All Programs menu to start any program that isn’t listed down the left side of the Start menu.
The Windows Desktop

The Windows desktop gets its name from the fact that it’s roughly equivalent to the desktop of a real desk. Your real desktop is where you do your noncomputer work. The Windows desktop is where you do your computer work. Doing work on a computer usually means opening, and using, some program. Each program you open sits on the desktop, like a piece of paper on a real desktop.

If you’re sitting at your computer now and want to see an example, perform the following steps to open the Calculator program that comes with Windows XP:

**STEPS: Starting Calculator**

1. Click the Start button (in the lower-left corner of the screen).
2. Click the All Programs option. The All Programs menu appears.
3. In the All Programs menu, click Accessories.
4. In the Accessories menu that opens, click Calculator (Figure 1-9).

![Figure 1-9: Click Start; choose All Programs ▶ Accessories ▶ Calculator](image)

A calculator opens up on the desktop, in a window. The calculator hasn’t replaced the desktop. It’s just sitting on top of the desktop, as a real calculator would sit atop a real desktop.

The Taskbar

Usually, you open a program to perform a task. For example, you open Calculator to perform a math task. If you think of each open program as a
task, the taskbar is the tool that lets you manage those tasks. Each program you open has a title bar at the top, which shows the program’s icon (symbol) and usually the name of the program as well. For each open program, you’ll find a corresponding button on the taskbar that shows the same icon and name, as in Figure 1-10.

![Calculator's title bar](image)

**Calculator's title bar**

**Figure 1-10:** Calculator on the desktop and its taskbar button

The taskbar is especially handy when you have several open programs piled up on the desktop at once. To bring any of those open programs to the top of the pile, you just have to click the program’s taskbar button. You’ll learn more about managing open program windows in Chapter 4.

**Tip** You can also make an open program window disappear, and reappear, by clicking its taskbar button.

To close an open program, click the Close (X) button (shown at left) in its upper-right corner.

**The Notification Area**

The Notification Area is to the right of the taskbar. It has some weird little icons that represent services currently running on your computer. Its name comes from the fact that, when Windows or some other program has a suggestion for you, a little message pops up from that area, as in the example shown in Figure 1-11.
Figure 1-11: A sample notification message

When you see one of those notifications, you have two choices.

✦ Read the message, and, if you want to pursue what it’s offering, click the text of the message.
✦ If you want to ignore the message, or reject what it’s offering, click the X button inside the message.

If you don’t understand what a notification means, your best bet would be to close it. The message will come back from time to time. You can try out whatever it’s offering after you’ve learned more. For now, that’s the gist of how some of the items on the desktop work. You’ll be seeing, and using, all of those things in upcoming chapters, as well as each time you use your computer.

Using Icons

The little pictures you see all over the place in Windows are called icons. Every icon is a little emblem, or symbol, for something larger. That something larger could be anything — a program, a folder, a video, a song, a typed document — things you’ll learn about in upcoming chapters. Using small icons to represent larger things helps keep the clutter on your desktop to a minimum. Figure 1-12 shows some examples of icons, in no particular order.
Opening Icons

You can open some icons by clicking them once. But most of the time, you’ll need to double-click an icon to open it. Remember that *double-click* means to point to the icon and then tap the left mouse button twice, as quickly as you can. If you pause too long between the clicks, the icon won’t open.

Shrinking a Big Thing Back to Its Icon

Exactly what does open depends on what the icon represents. If you open an icon by accident, or don’t know what to do with the thing that opens, just close it. Closing an item shrinks it to its original icon. To close, click the Close button (shown at left) in the upper-right corner of whatever it is you want to close. Or, if your hands happen to be on the keyboard, you can press Alt+F4.

Organizing Icons

If you’ve already been using icons for a long time, and in fact they’re getting pretty messy, you can easily whip them into alphabetical order. Just right-click some empty space between any icons (but not on any icon). From the shortcut menu that appears (shown at left), choose Arrange Icons By ➤ Name (see Figure 1-13). The icons will be neatly arranged into (roughly) alphabetical order.

Right-click some empty space between icons; then choose Arrange Icons By > Name

Figure 1-13: Right-click an empty spot and choose Arrange Icons By ➤ Name.

For example, certain built-in Windows XP icons stick to the upper-left corner of your screen, so that they’re always in the same place. The built-in icons have names such as My Computer, Recycle Bin, My Network Places, and Internet Explorer. Any icons other than built-in ones will be alphabetized starting after the last built-in icon.
Working Common Controls

Throughout your work in Windows, you'll be presented with various controls on the screen. A control on the screen is like a control in a car. For example, in a car, the brake is a control you work with your foot. The steering wheel is a control you work with your hands, as are the controls for the radio, windshield wipers, and headlights. In Windows, the controls on your screen are things you work with your mouse or keyboard. In this section we'll look at some examples of controls you're likely to come across in Windows quite often.

Using Scroll Bars

Scroll bars appear on your screen whenever there's more text, or more information, than will fit in the space available. The scroll bar allows you to scroll around and see any text that's not currently visible. There are vertical scroll bars that let you move up and down and horizontal scroll bars for moving left and right. The scroll bar has buttons at either end, and a scroll box within it, as shown in Figure 1-14.

![Scroll box and scroll bar diagram](image)

**Figure 1-14:** Horizontal and vertical scroll bars

The size of the scroll box relative to the size of the scroll bar tells you roughly how much information is currently out of view. For example, looking at the vertical scroll bar in Figure 1-14, you can see that the scroll box occupies about the top 25 percent of the scroll bar. That means that currently you're viewing only the top 25 percent of whatever text is shown to the left of the scroll bar. To scroll through text that's out of view, use the scroll bar to scroll down. To operate the scroll bar using your mouse:

- Click the button at the bottom to scroll down one line.
- Click the button at the top to scroll up one line.
- Click an empty area on the scroll bar, beneath the scroll box, to move down a page.
Click an empty area on the scroll bar above the scroll box to scroll up a page.

If your mouse has a wheel, you can click on the scroll bar; then spin the mouse wheel to scroll up or down.

Drag the scroll box to any place on the bar to go to that part of the list.

Tip
Drag means “hold down the mouse button while moving the mouse.” In a scroll bar you want to 1) Put the mouse pointer on the scroll box, 2) Hold down the left mouse button while dragging the scroll box along the scroll bar; and then 3) Release the mouse button when you get to wherever you want to go.

Working scroll bars with the mouse can be a bit more challenging, because there might be several scroll bars on the screen at the same time. The keyboard will work only one of them. For example, to use the scroll bar in a list box control, you first have to move the focus to that control. Anyway, here are the keys you use to scroll around using the keyboard.

✦ ↑: Scroll down a line
✦ ↓: Scroll up a line
✦ →: Scroll right a little
✦ ←: Scroll left a little
✦ Page Down (PgDn): Scroll down a page
✦ Page Up (PgUp): Scroll up a page
✦ Home: Go to the top
✦ End: Go to the end

Hiding and Showing Details

To keep your screen from getting too cluttered, Windows often hides some information on the screen. There are plenty of examples sprinkled throughout Windows, and I’ll point them out as they arise. But those of you who like to explore on your own should be aware of how these buttons work, so you can recognize them and use them as they appear on your screen.

The button you use to show or hide information usually has some sort of arrow on it, or < and > symbols, sometimes pointing up and down. Figure 1-15 shows some general examples of Show/Hide buttons.

The Show/Hide buttons are simple to use — just click the button. If items are currently hidden, clicking the button will take them out of hiding. If items are currently displayed, clicking the button will put them back into hiding.
A similar capability exists in certain types of lists, where you can hide or show details (list items) under a heading. Again, I’ll point out examples as they arise. But you intrepid explorers out there should keep an eye out for these things. If you don’t notice them, or don’t know how to use them, you’re not seeing all the information that’s available to you. Using the + and – buttons in a list is easy:

✦ If items are currently hidden, click the + sign to expand the list.
✦ If items are currently displayed, click the – sign hide the list.

Figure 1-16 shows a general example.

**Using Dragging Handles**

A dragging handle (sometimes called a sizing handle, or even just a handle) is a control that allows you to move or size an item by dragging. Dragging handles come in various shapes and sizes, but as a rule they tend to look like little non-skid areas, as in the examples shown in Figure 1-17. We’ll point out specific examples as we go through the book. For now, when you see a little nonskid area like one of the examples shown in the figure, know that it’s not just there for decoration. Like everything you see on your screen, it’s a control that serves some purpose.
About Disabled (Dimmed) Controls

As you explore your computer and start noticing controls all over the place, you’ll probably notice that some of them appear to be dimmed, as in the examples shown in the right side of Figure 1-18. If you click one of those dimmed controls, nothing happens. Why? Because the control is currently disabled. In other words, dimmed stands for disabled. It’s important to understand this, especially for beginners, because they often click away madly at disabled controls, thinking the control will somehow wake up and start working. That’s not the way it works.

Figure 1-18: Examples of enabled and disabled controls

A disabled control is not indicative of something that’s broken or needs fixing. It’s simply a control that’s not relevant at the moment. When circumstances change such that the control becomes useful, the control will automatically become enabled. You’ll see many examples of enabled and disabled controls throughout this book. For now, it’s enough to know that when you see a dimmed control, don’t bother clicking it. If it’s dimmed, it’s simply not relevant at the moment. And no amount of clicking the disabled control will wake it up.
The Right Way to Turn Off Your Computer

Before you get any deeper into learning about your computer, now is a good time to learn the right way to shut down your computer when you’re ready to call it a day. There are lots of ways to turn off a computer. But there’s really only one right way and plenty of wrong ways. The right way is to shut down Windows first. Here’s how:

**STEPS: Shutting Down Windows**

1. Click the Start button and choose Turn Off Computer (Figure 1-19).
2. In the box that appears (Figure 1-19), click the Turn Off button.
3. Watch the screen and wait.

![Figure 1-19: Shutting down your computer](image)

1. Click Start
2. Click Turn Off Computer
3. Click Turn Off

**Note**

Your own screen might show different options from those shown in Figure 1-19. Don’t worry about that. For now, it’s sufficient to know the right way to turn off your computer.

Don’t expect the computer to shut down immediately. Windows has some housekeeping to do first, and that will take a few seconds. If you see any messages asking a question, as in the example shown in Figure 1-20, waiting won’t work. You’ll need to respond to the message before the shut down will complete.
The sample message shown in Figure 1-20 is asking whether you want to save the document you’ve recently created or changed. For more information on saving documents, see Chapter 6.

After you’ve responded to any questions that might have appeared on the screen, and Windows has finished its housekeeping, one of two things will happen. If you have the type of computer that Windows can shut down by itself, the monitor will go blank, any fan noise you normally hear will stop, and the computer will shut down. You don’t have to push any buttons to turn off the computer.

If you have the type of computer that Windows can’t turn off by itself, you’ll see the message *It is now safe to turn off your computer* on the screen. In that case, you’ll need to turn off the computer yourself, using its main power switch.

On a computer that doesn’t shut down automatically, you might have to hold the main power button in for three or four seconds before the computer shuts down. That’s to prevent the computer from being shut down accidentally when someone just brushes up against the button.

**Summary**

That about wraps it up for the basic skills you need to start your computer, use your mouse and keyboard, start programs, close programs, and turn off your computer. The part about starting and using programs in this chapter is, admittedly, a bit thin. There’s a lot more you can do with program windows, as you’ll learn in Part 2. But for now, you’re off to a great start and are ready to move to Chapter 2, where you’ll learn some more critical basic skills.

- Your computer hardware is the stuff that you can see and feel.
- The main hardware devices you use to operate the computer are the mouse and keyboard.
- Your computer software is the invisible instructions that tell the computer how to behave and what to do.
- All of the software in your computer is stored on your computer’s hard disk.
- Windows XP is a special type of software known as an operating system (OS).
When you first start your computer, the Windows desktop will appear on the screen, along with the Start button, taskbar, and notification along the bottom of the screen.

To start any program that’s installed on your computer, click the Start button; then click All Programs.

To close any large open object on your screen, click the Close (X) button in its upper-right corner.

To shut down Windows properly before turning off your computer, click the Start button, and choose Turn Off Computer ➔ Turn Off.
You work most of the gadgets in your life through controls. For example, there are controls for your TV, your VCR, your car, your camera, your microwave, and your dishwasher. You work your computer through controls as well. However, most of the computer’s controls aren’t things you work directly with your hands. Instead, they’re things on the screen you work with your mouse or keyboard.

Windows has thousands of controls — some (like the Start button) you’ll see all the time. Others you’ll see rarely. The controls you need to use often will be visible often. Controls that you rarely (if ever) need are a little more hidden away, and you have to go looking for them. Before we get to the details of working all these little controls, let’s step back and take a look at the bigger picture to help us see that there’s some rhyme and reason to the way it all works.

Understanding Objects and Properties

The room you’re sitting in right now is filled with objects (objects is just a fancy name for things). Your chair is an object; your desk is an object; each picture hanging on the wall is an object. Every object in the room has certain properties that further define that object. Properties include size, shape, weight, color, materials, and so forth. Often, you can change an object’s properties without really changing the object. For example, you can paint an object to change its color without actually changing what the object is or what it does.

Most of the little doodads you see on your screen are objects, too. The Windows desktop is an object, as is each icon on the desktop. The Start button and taskbar are objects, too. Like objects in the real world, objects on the computer screen have properties. Each object has properties such as size, shape, and color.
Usually, the quickest way to get to an object’s properties is to right-click the object of interest and then click Properties in the shortcut menu that appears near the mouse pointer, as in the examples shown in Figure 2-1.

**Figure 2-1:** Right-click an object and choose Properties.

When you right-click an object and choose Properties, that object’s Properties dialog box opens. As you’ll see soon, a dialog box is a set of controls that lets you change the properties of whatever object you right-click. (More on dialog boxes in a moment.) First, we need to talk about objects that aren’t visible on your screen and how you can use the Control Panel to set their properties.

## Introducing Control Panel

The objects you see on your screen at any given time aren’t the only objects available to you. In fact, some objects that make up your computer system never appear on the screen. For example, your mouse is an object, and your keyboard is an object. If your computer has a modem, that modem is an object too. But you can’t very well right-click a mouse, keyboard, or modem, because those physical objects exist outside your computer, not on your screen. But most of those physical hardware objects have properties (not in the sense that you can change their size, shape, or color but in the sense that you can change how they behave).

So, if you can’t get to an object or its properties by right-clicking an icon, how can you do so? The answer is the Windows Control Panel. In the real world, control panel refers to all the controls on a specific machine. For example, all the controls for your microwave make up the microwave’s control panel. All the controls you use to drive your car make up the car’s control panel. To open Windows Control Panel:

**STEPS: Open Control Panel**

1. Click the Start button.
2. On the right side of the Start menu, click Control Panel.

When Control Panel first opens, it will either be in Category View or Classic View. Figure 2-2 shows an example of each view. At the left side of each window, you should see an option titled Switch to Category View or Switch to Classic View. You can click that option to switch from one view to the other.
Category View and Classic View

Category View and Classic View both provide access to the same objects and their properties. The only difference between the two is how you get to a specific object’s properties. In Category View, you “drill down” from the general to the specific. That is, first you click whichever category name looks the most promising (for whatever it is you want to do at the moment).

For example, suppose you want to change the properties of a hardware device, like your mouse and keyboard. If you click the category name Printers and Other Hardware, Control Panel shows icons for working with your printer and other devices, as in Figure 2-3.

![Figure 2-3: Control Panel showing icons for printers and other hardware](image)

If you want to back up from wherever you land in Control Panel, click the Back button on Control Panel’s toolbar. Also, you can move, size, and close Control Panel using the same tools and techniques that other windows provide. See the section “Arranging Open Program Windows” in Chapter 4 for more information.

Clicking an icon opens the Properties dialog box for that device. For example, clicking the Mouse icon opens the Mouse Properties dialog box, which provides controls for changing your mouse properties.
Figure 2-3: Clicking Printers and Other Hardware leads to these icons and options.

Figure 2-4 shows Control Panel in Classic View, where you don’t drill down through categories to get to an object’s icon. Instead, all the icons are just shown in plain view. For example, you can see the icons titled Game Controllers, Mouse, Printers and Faxes, Keyboard, Phone and Modem Options, and Scanners and Cameras in both views.

Figure 2-4: Classic View just shows all the uncategorized icons.
Classic View gets its name from the fact that it’s the view used in versions of Windows prior to XP. Category View wasn’t available in Windows until the release of Windows XP. In Classic View, you might have to double-click (rather than just click) an icon to open it. But the results will be the same as clicking in Category View — the Properties dialog box for that object will open.

There is no right view, wrong view, good view, or bad view. There are just different views. Choosing one over the other is simply a matter of personal preference.

Anyway, no matter how you get to an object’s properties, those properties are displayed in a dialog box, which in turn contains controls that allow you to change the object’s properties. Different objects have different properties, and there are tons of them. But there are some definite basic skills and concepts you can learn that will apply to all objects and all dialog boxes.

### Using Dialog Boxes

As mentioned previously, a dialog box is a set of options for you to choose from. You carry on a dialog with the box by making selections from the options it presents. There are many dialog boxes in Windows, but they all have certain things in common, such as a title bar up top and some controls that you use to make your selections. Some controls have a Preview area, which gives you a sneak peek at how changing an option will change the appearance of an object. Figure 2-5 shows a sample dialog box with the various components pointed out.

You can move a dialog box just as you would a window — by dragging its title bar. See the section “Moving a Program Window” in Chapter 4 for more information.

The controls in a dialog box are like the controls in a car or on any other gadget, except, of course, that you don’t work the controls of a dialog box with your hands. You work them with your mouse or keyboard. It’s usually easiest to use the mouse, since most of the time you just have to click a control to operate it. If you use your keyboard, it’s a little trickier because you first have to move the focus to the control you want to operate. Press the Tab key to move to the focus to the next control in a dialog box. Press Shift+Tab to move back to the previous control. The control that currently has the focus will be highlighted in some manner, usually with some sort of border around it or perhaps as selected text (that is, light text against a dark background).

The way you work a control depends on what type of control it is. In the sections that follow, we’ll look at the various types of controls you’ll come across. If you want to follow along on your own computer, use the Taskbar and Start Menu Properties dialog box. To get to it, right-click the Start button and choose Properties.
Using Tabs

Some dialog boxes contain more options than will fit within the box. In that case, the options will be separated into different tabs within the dialog box, as in Figure 2-6. To view the options on a tab, just click the tab. If your hands happen to be on the keyboard, you can press Ctrl+Tab to switch from one tab to the next.

Using Option Buttons

Option buttons (also called radio buttons) let you choose one of two or more mutually exclusive options. The name radio button comes from the older-style car radios. With a radio, you want to listen only to one station at a time. When you push the button on a radio to listen to a station, the button that previously was pushed in pops out, and you hear only the station whose button you pushed. The same thing happens with option buttons in a dialog box. When you choose one option, any previously selected option will be cleared.
For example, if you click the Start Menu tab in the Taskbar and Start Menu Properties dialog box, you’ll see two option buttons named Start Menu and Classic Start menu, as shown in Figure 2-7. The two options are mutually exclusive because you can choose one or the other but not both.

Operating option buttons from the keyboard takes a bit of dexterity. First, press Tab or Shift+Tab to get the focus to the currently selected option. Then press the arrow keys (↑, ↓, ←, →) to select the option you want. When the option you want is selected, press the Tab or Shift+Tab key to move to the previous or next control.

**About the Preview**

Some dialog boxes offer a Preview area that gives you a sneak peek at the effects of choosing an option. For example, when you choose the Start Menu option shown in Figure 2-7, the Preview shows how the Start Menu will look if you stick with that option. If you choose Classic Start Menu, the Preview shows you what your Start Menu will look like if you stick with that option — the Windows XP Start Menu. If you choose Classic Start Menu, the Preview shows you what your Start menu will look like if you stick with that option. (In this book, we’re using the first option, Start Menu.) You’ll see Previews in other dialog boxes as well.

**Using Checkboxes**

Checkboxes are options that can either be selected (checked) or not selected (clear). If you click the Taskbar tab in the Taskbar and Start Menu Properties dialog box, you’ll see several checkboxes, as in Figure 2-8.

Clicking a checkbox reverses its current setting. For example, if the checkbox is currently selected (checked), clicking it clears (unchecks) the checkbox. If the checkbox is clear, clicking it selects (checks) the checkbox.
If you’re using the keyboard, you’ll have to press Tab or Shift+Tab as necessary to move the focus to the checkbox you want to change. Then you can press the spacebar to select or clear the checkmark.

If you want your taskbar to look and act like the examples shown in this book, select and clear the checkboxes on your Taskbar tab to match those shown in Figure 2-8.

Using Spin Boxes

A spin box is a little box into which you can type a number or increase/decrease the number currently shown in the box using buttons. To see an example of a spin box:

1. In the Taskbar and Start Menu Properties dialog, click the Start Menu tab.
2. Make sure the Start menu option (not Classic Start Menu) is selected; then click the Customize button to the right of the Start menu option.

A new dialog box appears, titled Customize Start Menu opens. The control near the middle of the dialog box (Figure 2-9) is a spin box.

Figure 2-9: Example of a spin box

There are three ways to work a spin box:

✦ Click the up arrow at the right of the box to increase the number.
✦ Click the down arrow at the right of the box to decrease the number.
✦ Click inside the box (where the number is displayed). Use the Delete (Del) key to delete the number(s) already shown in the box; then type a new number.

From the keyboard, you first have to use the Tab or Shift+Tab keys to move the focus to the spin box control. Then use the ↑ arrow to increase the number shown or ↓ to decrease it.

Using Drop-Down Lists

A drop-down list is sort of like a menu, where initially only the currently selected option is visible. There are a couple of examples on the General tab of the Customize Start Menu dialog box. When you first look at a drop-down list option, you see only the currently selected option, as in the left side of Figure 2-10. To choose a different option, click the drop-down button at the right side of the control, as in the right side of Figure 2-10. Then click the option you want to select.
When a drop-down list has the focus, you can spin the mouse wheel to select an option from the drop-down menu without actually opening the drop-down menu. This can be a handy way to select an option. But it can be a real “gotcha” if you do it by accident and don’t realize your mistake. To avoid the mistake, it’s a good idea to move the focus away from a drop-down list right after making your selection. Just click outside the drop-down list, or press Tab or Shift+Tab to move to the previous or next control.

To operate a drop-down list from the keyboard, first use Tab or Shift+Tab to move the focus to the control. Once the control has the focus, you have several options. You can type the first letter or letters of the selection you want to jump to that part of the drop-down menu. Or you can use the ↑, ↓ keys to scroll through options. Or you can press Alt+↓ to open the drop-down list, then use the ↓ and ↑ keys to move up and down the list. To selection an option from the list, highlight it and press the Enter key.

**Using List Boxes**

A list box is a list of options to choose from, like a drop-down list. However, the list is in plain view, not hidden. If you’re following along on your own computer and want to see an example of a list box from the open Taskbar and Start Menu Properties dialog box, follow these steps:

1. In the Taskbar and Start Menu Properties dialog box, click the Start Menu tab.
2. Make sure Start menu is selected under the preview area; then click the Customize button just to its right. A new dialog box titled Customize Start Menu opens.
3. In the Customize Start Menu dialog box, click the Advanced tab.

The control labeled Start menu items (Figure 2-11) is an example of a list box control (although not all list boxes contain option buttons and checkboxes).
To operate a list box control using your mouse, first click the control to give it the focus. Then you can move through options using the scroll bar at the right side of the control. (More on using scroll bars in the next section.) To select an item from the list, just click it so it’s highlighted. If the option has a checkbox or option button associated with it, you can work that control in the usual manner as well — by clicking it.

To work a list box from the keyboard, press Tab or Shift+Tab as necessary to move the focus to the list box control. Then you can use the following navigation keys to move around within the list:

✦ ↓: Go to the next item in the list.
✦ ↑: Go to the previous item in the list.
✦ Page Down (PgDn): Move down a page in the list.
✦ Page Up (PgUp): Move up a page in the list.
✦ Home: Go to the top of the list.
✦ End: Go to the end of the list.

The term page refers to the total number if items visible at the moment. For example, suppose the list contains 30 options, but only six are visible at a time. You’re currently viewing the first six items. Each time you pressed Page Down (PgDn) in that control, you’d see the next six items in the list, until you got to the bottom of the list.

The idea is to move the highlighter to the option in the list that you want to choose. If the option you’ve highlighted does not have a checkbox or option button associated with it, just press the Enter key to select the currently highlighted option from the list. Otherwise, use the spacebar to clear or select the checkbox or option button.

**Using Sliders**

A slider control lets you choose a setting along a range of values. A slider is basically a bar along which you can place a little button. Figure 2-12 shows some examples of sliders, with each one’s sliding box indicated by an arrow. Not all sliders are exactly the same. But the way you use them is similar to the way you use a scroll bar. Here are the ways to use a slider control:

✦ Drag the box along the bar (that is, rest the mouse pointer on the box; hold down the left mouse button while moving the mouse left or right). When the box is where you want the setting, release the mouse button.
✦ Click anywhere along the bar to move the box to, or toward, that part of the bar.
✦ If there are buttons at the ends of the bar, click to do whatever the button offers. (Point to the button to see its name.)
Getting Help in Dialog Boxes

The labels that appear next to controls in a dialog box are brief and usually not very explanatory. In many dialog boxes, you can get more information about a given option. Here’s how:

**STEPS: Getting Help in a Dialog Box**

1. Click the Help (?) button near the upper-right corner of the dialog box. (The mouse pointer gains a question mark.)

2. Click the control with which you need help.

A box containing information about the control will appear near the mouse pointer, as in the example shown in Figure 2-13.
To get help with an option using your keyboard, first move the focus to the control with which you need help. Then press the Help key (F1) on your keyboard.

As you’ll learn in Chapter 3, there are many ways to get help while you work in Windows.

**Using Buttons**

Buttons are the easiest controls of all to work, because you just have to click them. Each button has a label that describes what the button does, as in the examples shown in Figure 2-14.

![Figure 2-14: Examples of buttons](image)

A dialog box can contain any number of buttons. Some buttons you’re likely to see often, and their purposes, are summarized here:

- **OK**: Activates all options you choose in the dialog box and then closes the dialog box.
- **Apply**: Activates all options you choose in the dialog box but does not close the dialog box. This button is disabled when there are no new selections in the dialog box to apply.
- **Cancel**: Closes the dialog box without applying current selections. Any settings you changed since opening the dialog box (or since the last time you clicked the Apply button, whichever is most recent) will be cancelled out.
- **Restore Default**: This button, when available, resets all options in the dialog box back to the original factory settings — the settings that were in place when XP was first installed on your computer.

If you’re following along on your own computer, you can click the OK button in the open Customize Start Menu dialog box now to close it. Click the OK button in the Taskbar and Start Menu Properties dialog box to close it as well.

**What’s the Default?**

In any computer documentation you read, you’re likely to come across the term *default* or *default setting*. They both refer to a setting — a choice that’s
already been made for you. For example, as you explore dialog boxes, you’ll notice that all of the controls in all the dialog boxes already have some setting, even if your computer is brand new. Those settings are the defaults.

**Typing Text and Passwords**

A textbox is a control into which you type text. Textbox controls can appear anywhere, not just in dialog boxes. Figure 2-15 shows some examples of textboxes.

A textbox appears whenever you need to type text. But you can type in only one textbox at a time. The cursor (a blinking vertical line) shows where the next text you type will appear. So before you type in a textbox, make sure the cursor is on the box in which you want to type. To move the cursor into a textbox, just click the textbox. Or, if you’re using the keyboard, press Tab or Shift+Tab as necessary to move the cursor to the textbox.

Once the cursor is in the textbox, just type normally. If you make a mistake, you can use the Backspace key to erase characters to the left of the cursor. When you’re done typing in the textbox, press Enter. Or, if there’s a Go button next to the textbox, you can just click that textbox instead.

You can also paste text from the clipboard into a textbox, which can save a lot of typing. See Chapter 8 for more information.

**Changing Text in a Textbox**

You can use the navigation keys to move the cursor through any text that’s already typed into a textbox. The basic keys you’ll use are:

- **Home**: Move the cursor to the beginning of the text.
- **End**: Move the cursor to the end of the text.
- **→**: Move the cursor to the next character.
- **←**: Move the cursor to the previous character.

You can also click the mouse wherever you want to place the cursor.
You can’t use the → key to move the cursor past the last character of existing text. If you need to insert a blank space at the end of a line, press the spacebar, not the → key.

To insert text at the cursor position, just type the new text. For example, let’s say the vertical bar that follows represents the cursor, which I moved into position using the mouse or the → and ← keys:

Alan|impson

Suppose I now type n S (that is, a lowercase n, a blank space, and an uppercase S). That text will be inserted at the cursor position as follows:

Alan Simpson

You can also delete text near the cursor using the following keys:

✦ **Backspace**: Delete the character to the left of the cursor.
✦ **Delete (Del)**: Delete the character to the right of the cursor.

### Changing Chunks of Text

It’s not necessary to change text one character at a time. You can work with chunks of selected text. The first step to using this technique is being able to distinguish selected text from regular unselected text. That’s usually pretty easy because any text that’s selected will be highlighted, usually as white letters against a blue background. Figure 2-16 shows some examples of regular text and selected text.

![Examples of unselected and selected text](http://www.coohards.com)

**Figure 2-16**: Examples of unselected and selected text

In some cases, the text in a textbox will be selected automatically as soon as you move the cursor into the box. In most cases, it won’t be. But it really doesn’t matter; you can select, or unselect, text in a textbox at any time using these techniques:

✦ **mouse**: Drag the mouse pointer through the text you want to select.
✦ **Shift+→**: Select character to right of cursor.
✦ **Shift+←**: Select character to left of cursor.
Let’s look at an example of how you might use text editing to save some typing. Suppose you want to visit a Web site at www.coolnerds.com and need to type that address into the Address bar of your Web browser. Currently, the Address bar contains the address www.microsoft.com as at the top of Figure 2-17. You really need to change only microsoft to coolnerds here, because the rest of the text is the same in both addresses. So, rather than retyping the whole thing or using the Backspace key, you can just drag the mouse pointer through the word microsoft, because that’s the only part you need to change, as in the middle of Figure 2-10. When text is selected, any new text you type is instantly replaced by whatever you type. So, if you just type coolnerds, the entire new address will be typed as at the bottom of Figure 2-17.

![Figure 2-17: Changing just a chunk of text]

The techniques described here are just some of Windows’ standard text editing techniques. You’ll learn more about those techniques in the section “Selecting Text to Change,” in Chapter 7.

**Combo Boxes and AutoComplete**

Some textboxes are actually combo boxes, meaning they’re both textboxes and drop-down menus. The drop-down menu usually contains a history of items you’ve typed into the textbox in the past. As soon as you start typing in the textbox, the menu drops down, showing the first item that matches the letter (or letters) you typed into the textbox, as in the example shown in Figure 2-18.
Figure 2-18: The sample menu that appears when typing in an AutoComplete textbox

If you see, in the menu, the text you were intending to type, you can just click that text in the drop-down menu. That way, you don’t have to type the whole thing. If the drop-down menu has a little sizing handle in its lower-right corner, you can drag that handle to resize the menu to your liking. If it has a scroll bar along its right edge, you can use that to scroll through other options on the menu.

Tip
To delete an item from the AutoComplete drop-down menu, point to it and press the Delete (Del) key on your keyboard.

Typing Passwords

Some textboxes are for typing passwords. When you type a password into a textbox, you don’t see the actual characters you’ve typed. Instead, each character is represented by a black circle. The purpose of the dots is to prevent shoulder surfing, where someone learns your password just by looking over your shoulder.

Passwords are case-sensitive, meaning that uppercase and lowercase letters are not considered to be the same. For example, if your password is meatball, you must type it exactly that way each time it’s required. If you type Meatball or MEATBALL or MeatBall or anything else, it won’t work. Your best bet is to use only lowercase letters in any password you create, so you don’t have to memorize the case of each letter in your password.

Other than the little dots and the case-sensitivity, typing a password is no different from typing anything else. You can even use the techniques described to make changes and corrections in a password textbox. When all you can see is little dots rather than the characters to type, however, it’s pretty tough to edit. If you type your password wrong, you might as well just type it again from scratch.

Summary

In this chapter, we’ve looked at fundamental, universal skills that you probably use each time you sit at your computer. Let’s review the major points we’ve covered:
✦ Most items on your screen are objects, each with its own unique set of properties (characteristics).

✦ Hardware components such as your mouse and keyboard can be considered objects with properties as well.

✦ To tailor an object to your needs, adjust that object’s properties via its Properties dialog box.

✦ There are hundreds of objects and thousands of properties. But you work all these things through a standard set of controls consisting of things such as buttons, checkboxes, and so forth.

✦ On the screen, you can often take a shortcut to an object’s properties just by right-clicking the object and choosing Properties.

✦ Selections you make in a dialog box are not actually applied to the object until you click the OK or Apply button.

✦ If you open a dialog box, then change your mind about any settings you’ve changed, click the dialog box’s Cancel button to close without implementing your changes.
Getting Help When You Need It

This book isn't your only resource for getting help when you need it. You can get a ton of information right on your screen through Windows XP’s Help and Support Center. If you have an Internet connection already and know how to use your Web browser, you can get support online as well. In this chapter, we'll take a look at the various resources available to you for getting the information you need, when you need it.

Using Windows XP’s Help and Support Center

To get to that information, click the Start button and choose Help and Support from the right side of the Start menu. Optionally, you can press the Help key (F1). However, if you’re using a program other than Windows at the moment, pressing F1 is more likely to open the help for that program rather than the help for Windows XP.

If you have a Windows keyboard, pressing Ctrl+F1 will always bring up Windows XP’s Help and Support Center.

Before I show you what Windows XP’s Help and Support Center looks like, a note of warning: Computer manufacturers who sell machines with XP preinstalled are allowed to change the Help and Support Center to promote their own products. This means that when you open the Help and Support Center, it might not look like the example you’re about to see. (That’s OK; it still works. It just looks different.) If you installed Windows XP yourself, or your computer manufacturer didn’t change anything, the Help and Support Center will look something like the example shown in Figure 3-1.
For general information, you can click any text in the window. For example, if you click Windows Basics under Pick a Help Topic, you’ll be taken to a new page that focuses on Windows basic skills. The new page, like most pages in Help, will be split into two panes. The left pane lists topics that you can click; the pane on the right displays the specific help information for whatever topic you click in the left column.

**Searching for Specific Information**

You can learn a lot just by clicking help topics and exploring what’s available. But more often than not, you’ll probably want to search help for specific information on a specific topic. That’s where the Search box comes in. You can type any word or phrase into the Search box and click the green Go button or press Enter to search for that word or phrase. After a brief delay, the lower portion of the screen splits into two columns, with your Search Results in the left column. For example, Figure 3-2 shows the results of typing “folder” as the text to search for.
The search results may be divided into two or three categories, each having its own heading in the left column. Items under the heading Suggested Topics provide specific How-To information relevant to folders and some general articles and tutorials. Use the scroll bar at the right side of the list to scroll through the list. Click any blue text in the list to view that Help topic in the right pane. For example, if you click Create a new folder, the pane on the right will show instructions on how to create a folder, as shown in Figure 3-3.
Figure 3-3: Results of clicking Move a file or folder

Some (but not all) help-text pages will have highlighted and colored text. Here’s what those visual cues mean:

✦ **Highlighted text:** Matches the word or phrase you searched for. Clicking highlighted text does nothing — the highlight is just there to point out where the word you searched for appears in the help text.

✦ **Blue underlined text:** Click any blue underlined text to open the item referred to by the text.

✦ **Green underlined text:** Click any green underlined term to see the definition of that term.

The toolbar above the help text contains four useful buttons. Here’s what each button offers (when you click it):

✦ **Add to Favorites:** If you think you’ll want to refer to this Help page often in the future, click this button to add it to your list of favorites. (You’ll see how to return to favorite pages in the section “Accessing Your Favorites” later in this chapter.)

✦ **Change View:** To reduce the size of the Help window, you can hide the left pane by clicking the Change View button. When you need the left pane, click the Change View button again to bring it back.
You can move and size the Help and Support Center as you would any other program window. See the section “Arranging Open Program Windows” in Chapter 4 for more information.

✦ Print: Brings up the Print dialog box, in which you can click the Print button to print the Help text.

✦ Locate in Contents: Displays a Table of Contents for Help and Support in the left pane. The heading under which the current Help page is listed will be highlighted. As always, you can click any topic listed (provided its text is blue) to follow through on that topic.

The main thing to remember is that in the left pane, you can click any blue text to get help on that topic. The help will show up in the pane to the right.

Using the Help Index

Like a book, the Help and Support Center has an alphabetical index to help you locate specific information quickly. To get to the Index, just click the Index button in the Help and Support Center’s main toolbar (Figure 3-4). The left pane turns into an index, as shown in the Figure 3-4.
There are two ways to work the index.

✦ Type the first letter (or letters) of the word you want to look up. As you type, the index will automatically jump to the word that matches what you typed.
✦ Use the scroll bar at the right side of the index to scroll up and down through the index.

When you get to the word you’re trying to look up, click it to select it; then click the Display button. (Optionally, you can just double-click the word in the index.) In most cases, the right pane will show the help for that topic. But if there are multiple topics for a given term, you’ll see a Topics Found dialog box like the example shown in Figure 3-5. Double-click whichever title you want to pursue.

Figure 3-5: A search has found potential topics of interest.

Getting Around in Help and Support

The toolbar at the top of the Help and Support Center window (Figure 3-6) provides a number of tools to help you get around in the Help and Support Center. Most of the buttons in the toolbar are labeled. The Forward and Home buttons don’t have labels, but it shouldn’t be too difficult to figure out which is which (given that the Forward button points in the opposite direction of the Back button, and the Home button looks like a house). Here’s what each button does:

Figure 3-6: The Help and Support Center’s toolbar

✦ **Back**: After you’ve navigated to another page in Help, the Back button will be enabled. Click it to return to the page you were viewing prior to the current page.
✦ **Forward**: After you click the Back button, the Forward button becomes enabled. Click it to return to the page you just backed up from.
✦ **Home:** Click this button to return to the Help and Support Center’s home page (the page that appears when you first open Help).

✦ **Index:** Displays the Help index in the left pane, as described in the section “Using the Help Index” earlier in this chapter.

✦ **Favorites:** Displays the titles of favorite Help pages in the left column. Use the Add to Favorites button described in the section “Searching for Specific Information” earlier in this chapter to add pages to your collection of favorites.

✦ **History:** Displays a list of help pages you’ve visited recently in the left pane. Double-click any title to redisplay that help page in the right column.

✦ **Support:** Provides descriptions of other forms of technical support available from Microsoft.

✦ **Options:** Provides a few options changing the look and feel of the Help and Support Center.

### Accessing Your Favorites

As mentioned, anytime you come across a Help page that you think you might need to refer to again, you can add that page to your Help Favorites by clicking the Add to Favorites button. That will make it a lot easier to find the page in the future.

To return to a favorite help page, just click the Favorites button in the Help and Support Center’s toolbar. A column titled Favorites will open in the left side of the window, as in Figure 3-7. Here’s how to work that Favorites column, once it’s open:

---

![Figure 3-7: The Help and Support Center’s Favorites pane open on the left](image-url)
To view a favorite help topic, double-click its title, or click its title and click the Display button at the bottom of the column.

To change a page’s title (to put it in your own words, so to speak), click the title, click the Rename button, and type your own title (or use the standard text-editing techniques to change the current title to something else).

To remove a favorite, click its name; then click the Remove button at the bottom of the Favorites bar.

**Troubleshooters**

The Help and Support Center also provides a list of troubleshooters that can help you solve specific problems. If your computer offers the standard Help and Support Center options, you can get to the troubleshooters by clicking Fixing a Problem on the Help and Support Center’s home page. (If you’re on some other page, just click the Home button on the toolbar button.)

If you can’t find the Fixing a Problem option, follow these steps:

**STEPS: Viewing the List of Troubleshooters**

1. If you’re not already in the Help and Support Center, click the Start button and choose Help and Support.
2. In the Help and Support Center’s Search box, type troubleshooters; then press Enter or click the green Start Searching button.
4. Use the scroll bar on the right side of the page to view all troubleshooters. To open a troubleshooter, click its name in the Troubleshooter (see Figure 3-8).

When you click a troubleshooter, you’ll be taken to a set of instructions for diagnosing and solving a problem. Just read and follow the instructions that appear on the screen.

**Closing Help and Support**

When you’ve finished using the Help and Support Center, you can close it as you would any other program window: by clicking the Close button in its upper-right corner. The window will disappear (as will its taskbar button). You can reopen it at any time by clicking the Start button and choosing Help and Support.
Getting Help Online

The Windows Help and Support Center should always be your first resource for getting help with Windows XP. But if you can’t find what you’re looking for there, you can always try Microsoft’s Web site. To do this, you’ll need an Internet connection (see Chapter 9) and a Web browser (see Chapter 10). You’ll also need to know how to use your Web browser. Many of you probably already know how to browse the World Wide Web, so I’ll just go ahead and explain how to use Microsoft’s Web site now. If you’re not an Internet user yet, you can always return to this section after you’ve connected your computer to the Internet.

Microsoft’s Web site includes support for all their products, not just Windows XP. So when you search the site, you’d do well to include the letters XP in whatever you want to search for. Also, if you use multiple words in your search, separate the words by a + sign rather than a blank space. The plus sign tells Microsoft to find articles that contain all the words in the search text, not just any word. Also, avoid using small words like the, a, I, and so forth. Just stick to the important words. For example, to search for copy folder and limit the search to Windows XP articles, you would search for:

XP+copy+folder

Given all of that, here’s how it works:

1. Make sure you’re online and use your Web browser to go to http://search.microsoft.com.
2. In the Search text box that appears, type the word or phrase you’re looking for, using + signs to separate multiple words, as in the example shown in Figure 3-9.

![Figure 3-9: About to search http://search.microsoft.com for “xp+copy+folder”](image)

3. Click the Go button.

After a brief delay, the results of your search will appear on your screen, divided into different categories of information. Figure 3-10 shows an example. As always, you can use the scroll bar at the right side of the page to scroll through all information. Click any hyperlink (blue underlined text) to pursue a topic further. To return to the search results after viewing a page, click the Back button in your Web browser’s toolbar.

![Figure 3-10: Results of a search of http://search.microsoft.com for “xp+copy+folder”](image)
Tip

My own Web site at www.coolnerds.com also offers some handy How-To tutorials and other information for Windows XP users. Stop by any time.

Getting Help with Your Computer

If you’re already online and using the Web, your computer manufacturer’s Web site is also another valuable resource for you to get to know. I can’t tell you exactly where that site is, because I don’t know who manufactured your computer. But you can usually find a link to it somewhere in Help and Support or on the Start menu. Or, if your computer manufacturer happens to one of those listed below, you can use the address shown next to the manufacturer name:

✦ Acer Computers: http://support.acer.com
✦ Dell Computers: http://support.dell.com
✦ eMachines: www.emachines.com/support
✦ Gateway Computers: http://support.gateway.com/support
✦ Hewlett-Packard (and Compaq): http://support.hp.com
✦ Sony Vaio: www.vaio.net
✦ Systemax: http://support.Systemax.com

If all else fails, you can always check the printed documentation that came with your computer. Or take a wild guess, using the address www.manufacturerName.com (where manufacturerName is your computer manufacturer’s company name) as a Web site address. The guess might not work. But it’s worth a try.

Other Sources of Help

Besides the sources of help we’ve just discussed, there are others that you’ve already seen in this book and will see elsewhere. Some sources of help just pop up on the screen as screen tips. But sometimes that’s all you need. Here’s a quick summary of your other sources of help:

✦ Often, just pointing to an item will provide enough information to get you going, as in the examples shown in Figure 3-11.

✦ Right-clicking an item will display a shortcut of things you can do with that item, which is often helpful in itself. The Properties option on that menu (if available) opens the Properties dialog box for that item, which in turn provides more information and more options.

✦ In a dialog box that has a ? button, you can click that button, then click any option with which you need help. (See the section “Getting Help in Dialog Boxes” in Chapter 2.)
In a program, you can choose Help from that program’s menu bar to view help options for that particular program.

Pressing the Help key (F1) usually brings up help that’s relevant to whatever you’re doing at the moment.

We’ll point out even more ways of getting help and information as we progress through the book. But be aware that there’s tons of information available to you every time you sit down at the computer. You simply need to know what you’re looking for and where to look for it.

**Summary**

When you’re sitting there staring at the screen, wondering “now what do I do?” or trying to figure out what some message means, you’re not as helpless as you might think. You can get information at any time through Windows Help and Support, from Microsoft’s Web site, and plenty of other places. Here’s a quick review of the main topics in this chapter.

- To open the Help and Support Center, click the Start button and choose Help and Support, or press the Help key (F1).
- To get help online, start at [http://search.microsoft.com](http://search.microsoft.com).
- Use + signs between keywords when searching for help online (for example, XP+copy+file) to limit the search to articles that contain all keywords.
Your computer manufacturer probably offers support through their Web site. Check the documentation that came with your computer for more information.

The Help key (F1), pointing to items, and right-clicking items are all handy methods of getting instant help, although the help is usually just brief text.
in some ways, a computer is like a stereo or VCR. a stereo plays music, a VCR plays movies, and a computer plays programs. just as there are thousands of CDs and movies for your stereo and VCR, there are thousands of programs you can run (not play) on your computer. there are programs for e-mail, programs for photos, programs to make movies, programs to manage your bank account, programs for all kinds of things. to use them, you have to know where they are and how to work them.

a lot of programs let you create and manage documents — things such as letters, reports, pictures, songs, and movies. like the documents printed on paper in your filing cabinet, all your computer documents are in folders. in a way, your computer is just a filing cabinet with muscle. but i’m getting ahead of myself. i suppose it’s no surprise that Part II is all about using programs and working with documents.
The reason we buy a CD player is to listen to music recorded on CDs. The reason we buy a VCR is to watch movies recorded on videotape. The main reason we buy a computer is to run programs. Thousands of programs are available for Windows XP — for example, programs for doing e-mail, for browsing the Web, for typing documents, for touching up photos, for producing your own movies, for talking toll-free to someone anywhere in the world, and so on. And that’s just to name a few.

If you can think of something a computer might be able to help with, there’s probably at least one program on the market to help you do that job. Not all programs are exactly alike, so there’s no way to come up with a single book to describe them all. (That’s why there are about a jillion computer books on the market.) But some general skills and concepts do apply to most programs. Those skills and concepts are the main topics of this chapter.

Starting Programs

A computer program is a set of instructions that tells the computer how to behave. Your computer already has lots of programs installed on it. We know this because you have Windows XP, which is a program itself. Windows XP comes with lots of little freebie programs for doing some of the things presented as examples at the start of this chapter.

All of the programs currently installed on your computer are accessible from the Start menu. When you first click the Start button, the left column of the Start menu displays a list of programs you’ve used frequently in the past. Or, if your computer is brand new, there are a few sample programs listed down the left side of the Start menu. To view your entire collection of installed programs, click All Programs in the Start menu. That opens up the much larger All Programs menu.
Some items on the All Programs menu are programs, and others are groups of programs. You can tell the groups by their similar icons and the ➤ symbol at the right side of the option. If you point to (or click) a program group, a submenu containing options for programs in that group, and perhaps more groups, opens. For example, if you click the Start button, choose All Programs, and choose Accessories, you end up with something that looks like Figure 4-1. I say “something like” because not everybody has exactly the same programs on his or her computer — just as not everybody who owns a CD player owns exactly the same CDs.

![Figure 4-1: Results of clicking the Start button and choosing All Programs ➤ Accessories](image)

**Tip** If your computer is brand new, you might consider just looking around in all the various program groups available to you. You’ll probably discover that there are a lot more programs on your computer than you realized!

To start a program, you just click its name or icon on the menu. Optionally, if there’s a shortcut to the program in the Windows desktop or in the Quick Launch toolbar, you can click (or double-click) that icon to start the program. Regardless of how you start a program, it will most likely be in its own window on your desktop (more on that in a moment).

You’ll see many examples of starting and using programs throughout this book. To make it easy for you to follow the sequence of menu options that you need to choose to launch a particular program, we’ll use an abbreviated format like this:

Click the Start button and choose All Programs ➤ Accessories ➤ Calculator.
Think of the ➪ symbol as meaning then click. For example, that sample instruction is a short way of saying “Click the Start button; then click All Programs; then click Accessories on the All Programs menu; then click Calculator in the Accessories menu.”

Taking Control of Program Windows

In the olden days of personal computing (the 1970s and 1980s), people used an operating system called DOS. With that operating system, you could run only one program at a time. When you started a program, it filled the entire screen. If you wanted to use some other program, even if just for a moment (like to check your e-mail), you had to save your work, close the program you were in, run the other program, do whatever you needed there, close that program, and reopen the first program. Not a very convenient way to do things.

Microsoft Windows changed all of that by allowing you to open as many programs as you want. Rather than taking over the entire screen, each program you start opens in its own program window (or just window, for short), sort of like one sheet of paper on a regular desktop.

Learning how to control all those open windows on your desktop is an important part of learning to use your computer. After all, if you can’t control what’s visible on your screen, you can’t really get much done with a computer. So let’s take a look at the many ways in which you can manage open program windows on your Windows desktop.

If you want to follow along in this chapter, and try things out on your own computer, you’ll need to open a few programs to use as examples. Follow these steps now:

1. Click the Start button and choose All Programs ➪ Accessories ➪ Paint.
2. Click the Start button and choose All Programs ➪ Accessories ➪ WordPad.
3. Click the Start button and choose All Programs ➪ Accessories ➪ Calculator.

Note If you can’t complete a preceding step because you’re missing a program, don’t fret. You can open Internet Explorer (Start ➪ All Programs ➪ Internet Explorer) or Movie Maker (Start ➪ All Programs ➪ Windows Movie Maker) to use a sample program instead.

Once you’ve completed these steps, you’ll have three open program windows on your desktop. Don’t worry about the purpose of each program or how each is arranged on the screen. We’ll just be using those programs as examples for learning skills that apply to all program windows.
Tools Found in Most Program Windows

If you look at all the open program windows on your computer screen, you'll notice they have certain things in common: a title bar at the top and a menu bar beneath that (see Figure 4-2). Some programs have a toolbar beneath the menu bar. Some programs have a status bar along the bottom of their windows. Each open window will also have its own button in the taskbar. The icon and name of the button match the icon and name in the title bar of the program that the button represents.

The items you see in the program are not there solely for decoration. In general, Windows never puts anything on your screen purely for decoration. Each item in the program window has a specific role:

✦ **Title bar:** Displays the program's icon and name and provides tools for moving and sizing the window. For example, dragging a program's title bar moves the window.

✦ **Menu bar:** Provides access to the tools and features of the program contained within that window. Clicking an option on the menu bar displays a menu.

✦ **Toolbar:** Provides one-click access to the program's most commonly used features. This allows you to get at the feature without having to use the menu bar. Not all programs offer toolbars.
Document area: If the program allows you to work with documents (text, pictures, or video), the currently open document will appear here.

Status bar: The exact role played by the status bar varies from one program to the next. Many programs don’t have a status.

Taskbar button: A program window’s taskbar button allows you to show or hide the window on the desktop. You can right-click a program’s taskbar button for other options.

About the Active Window

Whenever you have two or more programs open on your Windows desktop, only one can be the active window. There are three ways you can tell which window is active at the moment:

- The active window is always at the top of the stack. No other program window will cover or obscure the active window.
- The active window’s title bar is colored more brightly than the other (inactive) windows’ title bars.
- The active window’s taskbar button is pushed in.

For example, in Figure 4-3, the Calculator is in the active window. You can tell because no other program window covers the Calculator (it’s on the top of the stack), Calculator’s title bar is darker than the title bars for Paint and WordPad, and Calculator’s taskbar button looks pushed in.

Figure 4-3: The Calculator is in the active window.
If it’s difficult to imagine how Calculator is on the top of the stack from Figure 4-3, imagine that there were a way to bend back the Windows desktop so it were more horizontal. And imagine that you could lift each program window off the desktop a little. (Don’t try this at home; it can’t be done.) If you could do such a thing, you would see the Windows desktop from an angle; you would see that Calculator’s window is at the top of that stack, that the inactive windows are below that, and that the desktop (as always) is at the bottom, as in Figure 4-4.

Figure 4-4: The active window is always at the top of the stack.

Looking at Figure 4-4, if you were to click Paint’s button in the taskbar, Paint’s window would jump to the top of the stack, and Calculator and WordPad would each move down a level. Remember, the program at the top of the stack is in the active window.

So what difference does it make if a program is in the active window or an inactive window? There are a couple of unique things about the active window:

✦ Anything you type applies to the active window only.
✦ Pointing to a button or other item to see its screen tip works only in the active window. Pointing to an item in an inactive window does nothing.

In other words, before you can really do anything with an open program, you need to make sure it’s in the active window. That’s easy to do, and you can use whichever of the following three methods is most convenient at the moment:

✦ Click any visible portion of the program’s inactive window to make it the active window.
✦ Click the inactive window’s taskbar button.
✦ From the keyboard, hold down the Alt key and press the Tab key until the program’s icon is selected and its name is visible, as in Figure 4-5; then release the Alt key.
It doesn’t matter which method you use; the result will be the same — the program you specify will jump to the top of the stack on your screen and become the active window, ready for either mouse or keyboard input from you.

### Arranging Open Program Windows

Program windows don’t have to be scattered and sized haphazardly around the desktop. You can tidy them up with just a couple of mouse clicks. But you have to right-click the taskbar first. Before you try, I better point out that the phrase doesn’t mean “right-click anywhere you feel like it along the bottom of the screen.” It means “right-click some empty portion of the taskbar.”

When the taskbar is full of buttons, there’s not much empty space to right-click. But you can right-click the current time instead to achieve the same result, as illustrated in Figure 4-6. Anyway, once you’ve right-clicked an appropriate area of the taskbar, you’ll see the shortcut menu shown in the same figure.

To quickly arrange all the program windows currently open and visible on your desktop, choose (click) one of the following options in the shortcut menu:

- **Cascade Windows:** Neatly stacks the open program windows like sheets of paper, with each window’s title bar visible.
**Tile Windows Horizontally:** Arranges windows like tiles (no overlapping), with large windows stretched horizontally across the screen.

**Tile Windows Vertically:** Arranges windows like tiles (no overlapping), with large windows stretched vertically on the screen.

The Paint and Calculator windows are both a little unusual in that you can size them freely. So if you really want to try these options on your own screen, you will do well to try some other open windows. Follow these steps:

1. Close Calculator by clicking its Close button or by right-clicking its taskbar button and choosing Close.
2. Close Paint, again by using its Close button or taskbar button and choosing Close.
3. Click the Start button and choose My Documents.
4. Click the Start button and choose Control Panel.

Now you have three open windows on your desktop again, each with its own taskbar button. Figure 4-7 shows how those three windows arrange themselves when you choose the Cascade option or one of the Tile options.

*Figure 4-7:* Open windows cascaded and tiled on the desktop
If you change your mind right after cascading or tiling windows, you can right-click the taskbar and choose the Undo Cascade or Undo Tile option from the shortcut menu that appears. Or just press Ctrl+Z.

Maximizing and Minimizing Program Windows

There are lots of ways to control the size of most program windows. You can quickly maximize a window so it fills the entire screen. You can also minimize a window so it’s temporarily off the screen. And you can make most program windows any size between those two extremes.

Maximizing and minimizing open program windows is easy. You can use the buttons at the right edge of the title bar, the title bar itself, or the program window’s taskbar button. You can also restore a maximized window to its previous size using the same tools (Figure 4-8). Here’s what each button does:

- **Calculator’s Maximize button will be disabled because Calculator’s window can’t be resized. There are also limits on how small you can size Paint’s window. If you want to try out these techniques, use something other than Calculator or Paint. For example, you could close Paint and WordPad. Then click the Start button and choose My Documents; click the Start button again and choose Control Panel to bring My Documents and Control Panel onto the screen.**

![Figure 4-8: Minimize, Maximize, and Restore buttons and options](image-url)
Minimize: To minimize an open program window, click its Minimize button (shown at left), or click its taskbar button (if it’s currently the active window). Or right-click its taskbar button and choose Minimize. The window disappears, leaving behind only its taskbar button. Click its taskbar button, or right-click its taskbar button and choose Restore to bring the window back to the desktop.

Maximize: To maximize a program window, click its Maximize button, or double-click its title bar, or right-click its taskbar button and choose Maximize. A maximized window fills the entire screen, covering the entire desktop and all inactive program window.

Restore: To restore a maximized window to its previous size, click its Restore button, or double-click its title bar, or right-click its taskbar button and choose Restore. The window shrinks to its previous size (which might be only slightly smaller than the maximized size).

See the Desktop by Minimizing All Open Windows

If you ever want to get to your Windows desktop in a hurry, it’s not necessary to minimize each open window individually. Instead you can:

- Right-click the taskbar and choose Show the Desktop.
- Or, press `+D.
- Or, click the Show Desktop button in the Quick Launch toolbar, as shown in Figure 4-9.

If you don’t see a Quick Launch toolbar on your desktop, right-click the Taskbar and choose Toolbars ➪ Quick Launch from the shortcut menu that appears. If there’s a Show/Hide button symbol (>>) on your Quick Launch toolbar, click that to see other buttons on that toolbar.

Every open program window is instantly minimized, leaving behind a clean desktop. As usual, you can restore any program window by clicking its taskbar button. Optionally, you can restore just the previously open windows, or all program windows, in one fell swoop. Here’s how:

- Right-click the taskbar and choose Undo Minimize All or Show Open Windows.
- Or click the Show Desktop button on the Quick Launch toolbar again.
- Or press `+D again.

Sizing a Window

As mentioned, most program windows can be any size between minimized and maximized. Calculator’s program window is one of a few that has a fixed size. So if you’re going to try out this stuff on your own computer, please don’t try it out on Calculator. Use any other open program window on your desktop instead.
There’s another catch. You can’t size a window while it’s currently maximized or minimized; you can’t see the borders around the window at either of those extreme sizes. So if the window is maximized or minimized, you have to restore it to its previous size first.

Once the program window is at an in-between size, you’ll notice it has a blue (or perhaps some other color) border all the way around it. In some windows, you’ll see a little sizing handle — a nonskid surface of sorts — in the lower-right corner. Once you can see those edges and corners, sizing the window is easy. Follow these steps:

1. Move the mouse to the any edge or corner of the window’s border, or to its sizing handle if available, until the mouse pointer changes to a two-headed arrow, as in one of the examples shown in Figure 4-10.
2. Hold down the left mouse button while moving the mouse in the direction you want to stretch that corner or edge.

If you change your mind while sizing a window, press the Esc key before you release the mouse button to return the window to its original size.

3. When the window reaches the size you want, release the mouse button.

If you want to start with all windows of equal size, right-click the taskbar and choose Cascade Windows.

Moving a Program Window

You can easily move a window to any place on the screen. You simply have to drag the window by its title bar. However, you can’t move a maximized window or minimized window. Here are the exact steps:

✦ If the window you want to move is currently maximized, shrink it a bit (click its Restore button or double-click its title bar).

✦ If the window you want to move is minimized, click its taskbar button to restore it to the screen.

1. Move the mouse pointer to the title bar of the window that you want to move, as in the example shown in Figure 4-11.

![Control Panel](image)

Figure 4-11: To move a window, drag its title bar.

2. Hold down the left mouse button while moving the mouse to drag the window to some new location. Then release the mouse button.

It’s easy — at least once you realize that you can’t move a maximized window and don’t even bother trying to move those!

Working the Menu Bars

As mentioned, many programs have a menu bar stretched across the top. Every program’s menu bar is different, as each program’s menu bar gives you control of that particular program (or the document you’re working on in that
program). But even though the commands (options) on the menus vary, the way you work them doesn’t. You can use the techniques described in this section to work any program’s menu bar.

Each option across the menu bar represents a hidden pull-down menu. To see the pull-down menu, just click an option in the bar. For example, if you click the Edit option in WordPad’s menu bar, you’ll see the Edit menu shown in Figure 4-12.

![Figure 4-12: A sample pull-down menu](image)

To choose an option from a pull-down menu, just click it. Some menu options will lead to a submenu of more options, which you can click in the same manner.

If you open a menu by accident and just want to back out without making a selection, just click some empty space outside the pull-down menu. Or press the Escape (Esc) key.

As with controls in a dialog box, some options on a pull-down menu may be disabled (dimmed) because they’re not relevant at the moment. For example, in Figure 4-12, the options Cut, Copy, Paste, Paste Shortcut, Copy to Folder, and Move to Folder are currently disabled. Clicking those options would have no effect.

The little combination keystrokes (key1+key2) you see on the menu are shortcut keys. If your hands happen to be on the keyboard, you can skip reaching for the mouse and choosing an option from the menu by pressing the shortcut key instead. For example, pressing Ctrl+A at the keyboard is identical to choosing Select All from the Edit menu.

You can also work the menu bar from the keyboard without using shortcut keys. It’s a little tricky, but here’s how it works:

- Look for an underlined letter in the menu option you want to choose. If you don’t see an underlined letter, hold down the Alt key.
- Once you see the underlined letter, hold down the Alt key and type the underlined letter. For example, to open the File menu (where F is the underlined letter), press Alt+F.
Once the pull-down menu is open, you can use the ↓, ↑, →, and ← arrow keys to move around through options. Or type whatever letter is underlined in the option you want to pick.

When the option you want to choose is highlighted, press the Enter key to select that option.

To close a menu without making a selection, press the Escape (Esc) key.

Watch Out for Collapsible Menus!

Some programs use *collapsible menus*, where initially the menu shows only frequently used commands (to keep the menu short). Keep an eye out for those, because you may not be seeing all the options available on the menu. If you see a little show/hide button on the bottom of the menu, as in the example shown in Figure 4-13, click it to expand the menu. Then you’ll see all the commands on the menu. If you like, you can click the show/hide button a second time to collapse the menu to its smaller size.

![Figure 4-13: A collapsible pull-down menu](image)

Using Toggles on Menus

Some options on menus act as *toggles*. A toggle is an option that can have only one of two possible settings: On or Off. When a toggle option is set to On, its option on the menu shows a checkmark, as in the example at left in Figure 4-14. When the option is set to Off, the checkmark isn’t there, as in the right side of the same figure.

Clicking a toggle option in a menu switches the option to the opposite setting. For example, if you open a menu, see a checkmark next to an item, and click that item, the option will be turned off and the checkmark removed. (Had you just closed the menu without clicking the toggle option, the setting would remain on.)
The same is true when the setting is currently turned off. Clicking such an option would turn the setting on and place the checkmark next to the item on the menu.

Getting Help in Programs

Keep in mind that there are thousands of programs available for your computer. The Windows XP Help and Support Center does not contain information on all those programs. In fact, it contains only help that’s relevant to Windows XP. If you need help with some program other than Windows XP, the Help and Support Center for Windows won’t do you much good. It’s better to choose Help from that program’s menu bar. Then choose whichever option seems to offer general help. That will usually be the first option on the menu, as in the examples shown in Figure 4-15.

Closing Program Windows

While it’s often convenient to have multiple program windows on your desktop, you don’t want to get too carried away. Having too many open program windows is like having too many sheets of paper on your real desk. It just becomes clutter. Also, having too many programs open at a time can cause your computer to slow down — a lot. So when you’re finished with a program for the time being, you’ll want to close it.
Just as there are umpteen ways to do everything else, there are lots of ways to close a program window:

✦ Click the Close button in the title bar of the program you want to close.
✦ Or, right-click the taskbar button of the program you want to close and choose Close.
✦ Or, to close the active window, press Alt+F4.

**Saving Your Work before Closing**

If you’ve left behind any unsaved work in the program you’re closing, a dialog box like the one shown in Figure 4-16 will open. It means that you’ve created or changed a document without saving that work. You have three choices in the dialog box:

![Figure 4-16: Warning that you’ve left unsaved work behind](image)

✦ **Yes:** If you choose Yes, the Save As dialog box will open. Navigate to the folder in which you want to save the document, type a file name, and click the Save button.

You’ll learn all the details of using the Save As dialog box in Chapter 6. If you need to save a file now, choose My Documents from the Save In drop-down list at the top of the Save As dialog box. Type a file name into the File Name text box and then click the Save button.

✦ **No:** The program will close without saving your work. There is no way to recover the unsaved work.
✦ **Cancel:** The program and document will remain open.

**Closing Multiple Windows**

You’re not limited to having just one copy of a program on the desktop at a time. You can open multiple instances of most programs. If you’ve ever browsed the World Wide Web, you may have seen an example of multiple program windows in the form of pop-up ads. You get these irritating ads popping up, each in its separate Internet Explorer window.
Many (but not all) programs provide a handy way for you to close all open instances of a program, saving you from the irritating task of closing them one by one. The trick is simple — right-click the program’s taskbar button and choose Close Group, as in Figure 4-17.

![Figure 4-17: Closing all open instances of a program](image)

Summary

This chapter has focused on fundamental, universal skills for managing open program windows on your desktop. Here’s a quick recap of the important points:

✦ To start any program installed on your computer, click the Start button, and choose All Programs; then get to, and click, the name or icon of the program you want to start.

✦ Each program you start will open in its own program window on the desktop. Program windows on the Windows desktop can stack up, like sheets of paper on a real desktop.

✦ When two or more programs are open, only one is in the active window. Only the active window accepts keyboard input and is always on the top of the stack.

✦ To make any program’s window active, click any visible portion of that program window, click the program’s taskbar button, or press Alt+Tab until the name of the program is highlighted.

✦ To quickly arrange open program windows into a neat stack, right-click the taskbar (or current time) and choose Cascade Windows.

✦ The menu bar across the top of a program window provides access to all the tools and features of that program.

✦ To get help in a program, choose Help from its menu bar, or press Help (F1) while the program is in the active window.

✦ To close an open program, click its Close button.
Navigating Your Folders

Windows XP, all your programs, and all information in your computer right now are stored in files on your hard disk. Some files contain programs or components of Windows XP. We can categorize all of those as system files, because they’re the files that make up the entire software component of your computer system.

System files are practically invisible to you. This makes sense, since there are thousands of them, with all kinds of strange, unrecognizable names. The contents of system files would have no meaning to a human, because they all contain computer code — instructions that make the computer behave in certain ways.

There’s no need, ever, for you to open, delete, rename, change, or even see any of the system files. Windows XP takes care of all the system files automatically, behind the scenes, and it’s best if you just stay out of it.

Understanding Documents

While there’s no need for you ever to get involved with system files, there is one type of file you will create and use regularly. Those are documents files (or just documents, for short). Unlike system files, which contain computer code, documents contain information for humans to view. A document might be written text, a photograph, a song, or a video. It really doesn’t matter. All that matters is that the document contains stuff for humans, not computers, to view.

A currently closed document is represented by an icon. Most document icons have a little dog-eared sheet of typing paper as part of their icons, as in the examples shown in Figure 5-1. To open a document, double-click its icon.
When you open a document, the document appears on the screen, but it doesn’t appear all by itself. A document always opens within the document area of some program. For example, a picture might open in the Paint program, as shown in the left side of Figure 5-2. A typed document might open in the WordPad program, as shown in the right side of Figure 5-2.

We use different programs for different types of documents because of the tools that a program offers. For example, the menu bar across the top of Paint’s program window and the toolbar down its left side offer tools specifically designed for working with pictures. The menu bar and toolbars across the top of WordPad’s program offer tools for working with text. Those tools operate on the document currently open in the program.
Exactly what program opens when you open a document depends on many factors, as we’ll discuss in the Chapter 6. But the main thing to remember right now is that unlike programs, which open by themselves, documents always open within some program.

There’s probably room on your hard disk for thousands of documents. As time goes by, your collection of documents will grow. So will your need to keep them organized, so you can find what you want, when you want it. To keep your documents organized, you can arrange them into folders, as you would in a file cabinet.

All about Folders

Like paper files, files on a disk are stored in folders. If you think of a disk as a filing cabinet, a folder is like a manila file folder in the cabinet — it’s a container in which you store documents (files). Figure 5-3 illustrates how the computer terms disk, folder, and document (or file) relate to a filing cabinet.

Figure 5-3: Like folders in a file cabinet, computer folders are containers for storing documents (files).
Like unopened programs on your Start menu, unopened folders and icons are represented by icons. Folders that contain documents usually have a manila file folder image in their icons, like the examples shown in Figure 5-4. To open a folder, just double-click its icon. The contents of the folder appear on the screen, as icons in a program window, which you’ll learn about shortly.

![Figure 5-4: Examples of icons that represent folders](image)

**How Folders Are Organized**

Unlike folders in a file cabinet, folders on a disk are arranged *hierarchically*. In other words, a folder can contain still more folders. I can’t say exactly how all the folders on your PC are organized — that all depends on whether or not you’ve created any folders of your own. But if we just forget about all the system folders and look at the ones most usable to a human being, the hierarchy would look like Figure 5-5.

![Figure 5-5: A sample folder hierarchy](image)

You’ll notice that icons such as Desktop, My Computer, and the various drive icons don’t look like manila file folders. That’s because they’re not document folders. That is, they’re not containers for storing documents. Rather, they’re special folders that contain icons to useful resources other than documents, such as icons for your floppy disk and CD drive. Icons that do show the manila file folder icons are the ones specifically designed for storing your documents.
It’s not necessary to learn what each folder in the hierarchy represents right now. For the moment, stay focused on navigating through the hierarchy, as you’ll learn next. But, just so you know that each icon does, indeed, represent something useful that will be described in the book, here’s a brief summary of the icons shown in Figure 5-5:

- **Desktop (folder):** This special folder contains a copy of every shortcut icon on your Windows desktop (but is not the same as your Windows desktop, because it doesn’t have a background picture or taskbar). This folder is especially handy after you’ve learned to create desktop shortcuts to frequently used programs, folders, and documents, as discussed in the section “Creating your own Shortcuts” in Chapter 24.
- **My Documents:** This document folder is where you can store any document you create or download. If the document is a picture or song, however, you might want to store it in My Pictures or My Music instead.
- **My Pictures:** A good place to store pictures, including any you copy from a digital camera or scanner. See “Using Your My Pictures Folder” in Chapter 15 for more information.
- **My Music:** A good place to store songs you copy from CDs (see “Using Your My Music Folder” in Chapter 16).
- **My Computer:** Provides access to all the disk drives in your computer, including your floppy disk drive, CD drive, and entire hard disk, as well as other resources.
- **Shared Documents:** The same idea as My Documents, except that documents in this folder are accessible to everyone who has a user account on this computer (see Chapter 23), as well as people on the same local area network (see Chapter 28).
- **Shared Pictures:** Same idea as Shared Documents but particularly well suited to storing pictures.
- **Shared Music:** Same idea as Shared Documents but particularly well suited to storing music.
- **3 1/2 Floppy (A):** If there’s a floppy disk in the floppy disk drive, opening this icon will display the contents of the disk. If the floppy drive is empty when you double-click this icon, you’ll see a message asking you to insert a disk. (You can click the Cancel button instead.) See the section “Using Floppy Disks and Zip Disks” in Chapter 21.
- **Local Disk (C):** Represents your entire hard disk, including system folders which are best left alone (see Chapter 20).
- **CD-RW Drive (D):** This could be labeled “CD drive” or “DVD drive,” depending on the type of drive is installed in your computer. But if you insert a disk into that drive and double-click this icon, you’ll see the contents of that disk (See the section “Using CDs and DVDs” in Chapter 21.)
Parent Folder and Subfolders

Figure 5-5 shows the logical arrangement of folders, but it doesn’t necessarily make clear that folders lower in the hierarchy are contained within the folder above them. For example, the My Music and My Pictures folders shown in that hierarchy are actually contained within the My Documents folder.

When one folder contains still other folders, we refer to the containing folder as the *parent*, sort of like in a family tree. For example, in Figure 5-5, My Documents is the parent to My Music and My Pictures. Shared Documents is the parent to Shared Music and Shared Pictures.

The folders within the parent are usually referred to as *subfolders* but can also be called *child folders or children*. In other words, My Music and My Pictures are subfolders of (or children of) the My Documents folder because they’re contained within the My Documents folder.

You’ll never actually see your folders laid out in a hierarchical diagram like the one shown in Figure 5-5. That’s just an illustration of the hierarchical arrangement of files. But if you open a folder that’s the parent of other folders, you’ll see icons for those subfolders within the parent folder.

For example, your My Documents folder is the parent to your My Music and My Pictures folders. So if you open My Documents, you’ll see the icons for those subfolders. To open your My Documents folder, use whichever following method is most convenient for you at the moment.

✦ Click the Start button and chose My Documents from the right side of the menu.
✦ If there’s a My Documents icon on your Windows desktop, double-click that icon.

A window opens, showing you the contents of your My Documents folder. I can’t say exactly what your My Documents folder contains. But since My Music and My Pictures are subfolders of My Documents, and those are built into Windows XP, you should see at least the icons for those two folders. If My Documents contains any documents, you’ll see icons for those documents as well. Notice that the name of the folder whose contents you’re currently viewing, My Documents, appears in the title bar of the window that’s showing you the contents of the folder, as in Figure 5-6.

If you double-click the icon for the My Music or My Pictures folder, that folder will open. The name in the title bar will change to whatever folder you opened, and the large pane will show the contents of that folder.

**Tip**

You can right-click any icon in the main pane to see a shortcut menu of things you can do with the folder or file that the icon represents.
The My Documents folder contains icons for My Music and My Pictures folders. Obviously, there’s more than just a title and some icons in Figure 5-6. All that other stuff you see in Figure 5-6 is part of a program named Windows Explorer (or just Explorer, for short). And as its name implies, it’s a program for exploring the contents of your entire computer.

### Using Windows Explorer

Windows Explorer is a program for exploring the contents of folders on your computer. Any time you open a folder, Windows Explorer is the program that’s showing you the contents of that folder. Thus, no matter what folder you’re viewing at the moment, the menu bar and toolbar will always look the same, because those items belong to Windows Explorer, not to the particular folder you happen to be viewing at the moment.

### Windows Explorer Components

Only icons that appear in the main pane of Windows Explorer are contained within that folder. The title bar, menu bar, toolbar, and Explorer bar, pointed out in Figure 5-7, all belong to the Windows Explorer program. Here’s a quick summary of the general purpose of each of those components:

**Tip**

Don’t confuse Windows Explorer with Internet Explorer. Internet Explorer lets you explore things that exist beyond your computer, on the Internet. Windows Explorer is a program for exploring all the things that exist within your computer.
Explorer’s Title Bar

Unlike most programs, Windows Explorer never displays its own name in the title bar. The title bar in Windows Explorer always shows the name of the current folder — that is, the folder whose contents are visible in the main pane. The title bar also provides all the standard tools and techniques for moving, minimizing, maximizing, restoring, and closing the program, as discussed in Chapter 4. You can also size Windows Explorer by dragging any corner or edge.

Explorer’s Menu Bar

Like many programs, Windows Explorer has a menu bar across the top. The menu bar provides tools (commands) for working with items visible in the main pane of the window.

The menu bar in Windows Explorer works just like any other program’s menu bar. See the section “Working the Menu Bars” in Chapter 4 for all the ways you can use menu bars.

Explorer’s Toolbar

The toolbar, which appears just below the menu bar in Windows Explorer, provides one-click access to some of the more commonly used options on the menu bar. We’ll talk about specific buttons in the section “Navigating through Folders” a little later in this chapter. For now, note that the toolbar might also...
contain some disabled (dimmed) controls. For example, the Back and Forward buttons will be disabled until you’ve moved through some folders and have a place to go back or forward to.

Some buttons on the toolbar will have labels. Some buttons will show only a little picture. To see the name of an unlabeled button, just point to it. The button’s name will appear in a screen tip, as in the example at left.

The Explorer Bar

The Explorer bar contains still more useful tools for navigating through folders and for working with icons contained within the current folder. The exact contents of the Explorer bar will change, depending on what folder you’re viewing at the moment. Options in the Explorer bar are divided into categories. In Figure 5-7, they’re named File and Folder Tasks, Other Places, and Details. You can click any category heading or the show/hide (shown at left) to show or hide the options under that heading.

The Explorer bar is optional and will disappear if you size the window down to where it’s too small to show the Explorer bar. If the Explorer bar never appears in Windows Explorer on your computer, no matter how large you make its window, you can perform the following steps to make the Explorer bar visible:

**STEPS: Turn on the Explorer Bar**

1. From the menu bar in Explorer’s window, choose Tools ➪ Folder Options.
2. In the Folder Options dialog box that appears, click the first option: Show common tasks in folders.
3. Click the OK button in the Folder Options dialog box.

Windows Explorer’s Taskbar Button

As when opening any program, when you open Windows Explorer, you also open a taskbar button. Like the title bar in Windows Explorer, the taskbar button never shows the name Windows Explorer or Explorer. It shows only the name of the currently open folder. For example, when you are viewing the contents of My Documents, both Explorer’s title bar and taskbar button show My Documents.

If you open many folders, each will have its own taskbar button. Eventually, though, Windows may decide to collapse all those separate buttons into one taskbar button, as in Figure 5-8. (It does this to prevent making the taskbar buttons too small to see.) When that happens, Windows Explorer’s taskbar button will show its own name, as well as a number. The number indicates how many folders are currently open.
If you click the Windows Explorer taskbar button, you’ll see a menu of all open folders, also shown in Figure 5-8. Click any folder name to bring that folder to the top of the stack on the screen. Optionally, you can use the taskbar button as follows:

✦ Right-click the Windows Explorer taskbar button, and cascade, tile, or close all the open folders.
✦ Click the Windows Explorer taskbar button; then right-click any individual folder name on the menu to minimize, maximize, restore, or close that folder.

Navigating through Folders

Because all the folders in your system are connected in a hierarchical manner, you can easily get to any folder once you’re in Windows Explorer. There are lots of ways to open the more commonly used folders. For example, if you click the Start button, you’ll see icons on the right side of the menu for opening My Documents, My Computer, and maybe some other folders, as in the example shown in Figure 5-9. Just click any folder name to open that folder. You might also see icons on your Windows desktop titled My Documents or My Computer. You can double-click either of those to open that folder.
Once you’re looking at the contents of any folder, you can navigate to any other folder in the hierarchy. That is, you can get to any folder you want from whatever folder you happen to be in at the moment.

**Opening a Subfolder**

To open a subfolder, you have to get to its parent folder first. Since My Documents is the parent of My Music and My Pictures, you’ll see icons for that folder within My Documents. (You can see them in Figure 5-9.) To open a subfolder, just double-click its icon.

If you double-click the icon for My Music or My Pictures, you’ll open that folder. The title bar will change to show the name of whichever folder you opened, and the main pane will show the contents of that folder. Referring to Figure 5-5, by opening My Music or My Pictures, you moved down the hierarchy — from a parent folder down into a subfolder.

To open a subfolder in a new, separate Explorer window, hold down the Shift key and double-click the folder’s icon. Choosing a different folder’s name from the Start menu will also open that folder in a separate Explorer window.

**Moving Up the Hierarchy**

So, how do you move up the hierarchy? You can always move straight up to the parent of the current folder by clicking the Up button in the toolbar (shown at left with the mouse pointer on it). Clicking the Up button in the toolbar will always take you up to the parent of whatever folder you’re in at the moment. So if you’re in My Pictures and you click Up, you’ll be in My Documents.

Pressing the Backspace key while viewing the contents of the folder will also take you up to the current folder’s parent folder.

Each time you click the Up button, you move to the parent of the current folder. If you click Up enough times, you’ll eventually get to the special Desktop folder, which is at the top of the hierarchy. At that point, the Up button becomes disabled (dimmed), because the Desktop folder has no parent to go to. (This is a perfect example of a control being dimmed and disabled because it’s not relevant at the moment. Refer to Figure 5-5 to see that the Desktop folder has no parent.)

**Jumping across the Hierarchy**

The Other Places category in the Explorer bar also provides some shortcuts to commonly used folders. Just click any folder name to open that folder. This is handy when you want to make a lateral move, like from My Documents to My Computer or vice versa. Figure 5-10 summarizes the navigation methods.
If you can't see Other Places in your own Explorer bar, use the show/hide buttons to collapse the lists you don't want to see and to expand the list you do want to see. Or use the scroll bar to the right of Explorer bar to scroll up and down. If the entire Explorer bar is missing from the left side of the window, see “STEPS: Turn on the Explorer Bar” earlier in this chapter.

Navigating with the Address Bar

If the Address bar is visible in Windows Explorer, you can click its drop-down list arrow to see a list of folders you can jump to, as in Figure 5-11. In the drop-down menu, just click the name of the folder you want to jump to.

**Figure 5-10**: Up button and Other Places

**Tip**

If you can’t see Other Places in your own Explorer bar, use the show/hide buttons to collapse the lists you don’t want to see and to expand the list you do want to see. Or use the scroll bar to the right of Explorer bar to scroll up and down. If the entire Explorer bar is missing from the left side of the window, see “STEPS: Turn on the Explorer Bar” earlier in this chapter.

**Figure 5-11**: The Address bar’s drop-down menu
Showing and Hiding Toolbars

Toolbars can be very useful but very confusing. Most programs have at least the capability to show or hide toolbars, so you can pick and choose the ones you want to see. Some have additional options like Lock the toolbars. To pick and choose toolbars, click the View menu in the program's menu bar; then point to or click the Toolbars option. On the submenu that appears, toolbars that are currently on (visible) have a checkmark next to them. Toolbars that are off (hidden) have no checkmark. Clicking a toolbar name turns it on if it's off or turns it off if it's on.

Sometimes, two toolbars will squeeze onto one row, making one of the toolbars difficult (or impossible) to use. In the following example, the Address toolbar is on the same row as the Standard toolbar, with little room for typing an address.

The little dragging handle to the left of the toolbar name is for moving and sizing the toolbar. If you don't see any dragging handles, the toolbars are currently locked. To unlock them, choose View ➪ Toolbars ➪ Lock the Toolbars from the program's menu bar.

Once you can see the dragging handles, you can point to any one. The mouse pointer turns to a two-headed arrow when you're pointing to the right spot. Hold down the left mouse button and drag down slightly to move the toolbar down a bit, as follows. (You can also drag left and right to narrow/widen a toolbar.)

Once you get your toolbars arranged the way you like, you may want to lock them again to avoid accidentally moving them around. To relock the toolbars, choose View ➪ Toolbars ➪ Lock the Toolbars from the menu again.
If you don’t see an Address bar in your Explorer bar, you might want to add one. The way you do that in Windows Explorer is identical to the way you manage toolbars in all programs. So we’ll give that whole topic its own sidebar as follows, with the knowledge that everything described in that example will work right now in Windows Explorer.

**The Back and Forward Buttons**
As soon as you’ve navigated to another folder in Windows Explorer, the Back button in the toolbar will be enabled. You can click that button to go back to the folder you just came from. Once you’ve clicked the Back button, the Forward button will be enabled, and you can click that button to return to the folder you just backed out of.

**Different Ways to View Icons**
Like many programs, Windows Explorer lets you choose how you want to view the information it’s presenting. As in most programs, those options are on the View menu in the menu bar (Figure 5-12). However, you can also click the Views button in Explorer’s toolbar (also shown in Figure 5-12) to choose a view.

Each view shows the same information — the contents of the current folder. The view affects only how the information is displayed, not what’s displayed. We’ll look at some examples in the sections that follow. Also, icons work the same no matter what view you’re in. For example, double-clicking an icon opens the folder or file that the icon represents. Right-clicking an icon shows you other options for the file or folder that the icon represents.
The Icons View

The icons view shows each file or folder’s icon and name, nothing more. Figure 5-13 shows a hypothetical folder’s contents in Icons view. I suppose this is the typical way to view icons.

![Icons View](image1)

Figure 5-13: Sample icons shown in Icons view

The Tiles View

The Tiles view also shows the icon and name of each file and folder. But the icons are a little bigger. Also, there’s a bit of added information beneath each icon’s name. The exact information shown varies with different types of documents. But information such as the name of the program that opens the file and the size are typical, as in the example shown in Figure 5-14.

![Tiles View](image2)

Figure 5-14: Sample icons shown in Tiles view
The Thumbnails View

The Thumbnails view works well in folders that contain pictures. That’s because documents that contain pictures are displayed as miniaturized thumbnails of themselves rather than as icons. Figure 5-15 shows an example, where several of the files in the folder are pictures. The picture you see where the icon should be is a miniature version of the actual picture inside the file.

![Sample icons shown in Thumbnails view](image)

The Filmstrip View

The Filmstrip view is available only in folders that contain pictures, such as your My Pictures folder, or perhaps the Sample Pictures folder if you have one in your My Pictures folder. Filmstrip view is similar to Thumbnails in that pictures appear as small copies of themselves rather than icons. The main difference is that the icons are arranged in a strip along the bottom of the window. Use the scroll bar below the icons to scroll through all the icons in the folder. When you click, or point to, a thumbnail icon, an enlarged copy of the picture appears in Preview area, as in Figure 5-16.

If you can’t get to the Filmstrip view, even in your My Pictures folder, make sure you’re not using Windows Classic folders. In fact, if you just follow the procedure described under “STEPS: Turning on the Explorer Bar,” a little earlier in this chapter, you’ll enable both the Explorer bar and the Filmstrip view. But no matter what, Filmstrip view is available only in My Pictures and in other folders that contain mostly pictures.
The List View

The List view shows tiny icons, and the full name, of each folder and file. It’s mostly useful for viewing folders that contain hundreds of icons, because it makes it easy to read through their names alphabetically, as in the example shown in Figure 5-17. (It’s unlikely that your computer has a folder that contains that many subfolders right now.)

The Details View

The Details view (Figure 5-18) shows tiny icons and lots of detailed information about each subfolder and file in the current folder. The first column shows the icon and name, and the second column shows each file’s size. (Folders don’t display a size.) The third column shows the file type, which in the case of a document would be the name of the program that opens the file. The last column shows the date and time that the file was last saved.

If there are more columns than can fit in Explorer’s window, you’ll see a horizontal scroll bar beneath the columns. Use that to scroll left and right through the columns.
Working with Columns

The Details view is unique in that all the information is presented in columns with specific headings at the top. The column headings are actually useful tools in themselves. For example, you can sort (or alphabetize) the list by clicking any column heading. The first time you click a heading, items are placed in ascending order based on that column, and the heading shows an up-pointing triangle. Ascending order means A to Z in the case of text or smallest to largest in the case of numbers. Or if you sorted the Date Modified column, ascending order would mean oldest to newest.
**Sorting Columns**
Clicking the same column heading will reverse the items in descending order, the column head showing a down-pointing arrow to indicate the sort order. Descending order means *Z to A* in the case of text, *largest to smallest* for numbers, and *newest to oldest* for dates.

**Sizing Columns**
You can also change the width of any column heading by placing the mouse pointer on the bar at the right side of the column heading. The mouse pointer changes to a two-headed arrow, as in Figure 5-19. When you see that two-headed arrow, hold down the left mouse button and drag left or right to size the column.

![Ascending order](image)
![Descending order](image)

**Figure 5-19:** Using column headings

**Moving Columns**
As illustrated at the bottom of Figure 5-19, you can also move an entire column left or right by dragging the entire column heading. That is, point to the middle of the column heading. Then hold down the left mouse button and drag left or right. Release the mouse button when the column is where you want to put it.

![Drag edge to size](image)

**Tip**
The techniques shown in Figure 5-19 are universal; they work with any column headings in any program, not just with Windows Explorer’s Details view.
Don’t spend too much time customizing a folder’s Details view unless you’re sure the Remember each folder’s view settings option is turned on. Otherwise, you’ll lose all those settings the moment you close the folder. To make Windows remember each folder’s most recent view, choose Tools➪Folder options from the menu bar. In the Folder Options dialog box that opens, click the View tab. Scroll down the list of Advanced Settings, and put a checkmark next to Remember each folder’s view settings. Then click OK.

Choosing Columns in Details View

The columns visible to you in Details view will vary, depending on what folder you’re viewing. For example, when viewing a folder that contains pictures, you may see column headings relevant to pictures. When viewing a folder that contains music, you may see column headings relevant to music, as in Figure 5-20.

![Figure 5-20: Details view column headings in a folder that contains songs](image)

If the columns that appear in Details view aren’t the ones you want to see, you can choose others. From the menu bar in Explorer, choose View➪Choose Details. A dialog box titled Choose Details appears, as in the example shown in Figure 5-21.

Choose the columns you want to see by selecting them. To make a column visible in Details view, select (check) its name. To hide the column in Details view, clear the checkbox next to the column name. Use the scroll bar to scroll through all your options.

The other controls in the dialog box are optional. You can set a width for the currently selected column using the Width of selected column... option near the bottom of the dialog box. But, as described a moment ago, you can also size the column while you’re in Details view. You can move the currently selected item up or down the list by using the Move Up and Move Down buttons. But you can also arrange columns however you wish when you’re in Details view.

When you’ve finished making your selections, click OK to return to the Details view. Use the horizontal scroll bar at the bottom of Explorer’s window to scroll left and right through the columns.
Arranging Icons in Explorer

You can arrange the icons in Explorer’s main pane into any just about any order you wish, as summarized here:

- **Name**: Folders are listed in alphabetical order, followed by files listed in alphabetical order.
- **Size**: Files are listed from smallest to largest size, after folders.
- **Type**: Files are listed in alphabetical order by type, after folders.
- **Modified**: Files are listed from oldest to newest, based on the date and time that you last saved the file.

You may see other options on the menu; it just depends on the particular folder you’re in. For example, if you’re in My Music, you’ll see options for arranging icons by Artist or Album Title. You can get to the sorting options using whichever of the following methods (shown in Figure 5-22) is most convenient:

- Choose View ➪ Arrange Icons By ➪ *option*.
- Right-click some empty space between icons and choose View ➪ Arrange Icons By ➪ *option*, where *option* is any option available on the menu.
Figure 5-22: Two ways to get to the Arrange Icons By menu

You’ll also see some toggles on the Arrange Icons By submenu. As mentioned in the section “Using Toggles on Menus” in Chapter 4, a toggle is an option that can be either on, like Auto Arrange in Figure 5-22, or off, like Show in Groups and Align to Grid in the same figure. Here’s what the toggles offer:

✦ **Show in Groups:** If selected, icons are shown in groups with group headings (particularly useful when viewing many icons arranged by Type).

✦ **Auto Arrange:** If selected, icons will be sorted automatically, so they’re always in order when you first open the folder.

✦ **Align to Grid:** If selected, icons align to an invisible grid as you drop them on the screen. This keeps the icons neatly aligned, even when you move them yourself. (To move an icon, just drag it to some new location within the folder; then release the mouse button.)

**Closing Windows Explorer**

You can close Windows Explorer, and hence the folder you’re currently viewing, as you would any other program window: Click the Close button in its upper-right corner, or choose File ➤ Exit from its menu bar, or press Alt+F4 if it’s in the active window. The window will close and the taskbar button will disappear.

If you have many folders open simultaneously, and their buttons have collapsed into a single taskbar button, you can right-click that taskbar button and choose Close Group.
Summary

There’s a lot more you can do with Windows Explorer than what you’ve learned in this chapter. But most of its other features make sense only after you’ve created and stored some documents on your hard disk. You’ll learn how to do that in Chapter 6. And we’ll resume our discussion of Windows Explorer in Part V. For now, you might want to practice moving up and down the folder hierarchy shown in Figure 5-5. Just open any folder from the Start menu, and navigate up and down through the folders shown in the figure. A little hands-on practice goes a long way toward helping you remember things.

Before we move on, here’s a quick review of the main topics covered in this chapter:

✦ A document, in the computer sense, is like a written document, though it could be a picture, song, or video as well. Each document is stored in its own file. (You’ll learn more about documents in Chapter 6.)

✦ Like documents in a filing cabinet, document files are organized into folders on your disk.

✦ Your hard disk already has some built-in folders, such as My Documents, My Pictures, and My Music, for storing your documents.

✦ You can open many folders right from the Start menu.

✦ When you open a folder, you’re actually opening a program named Windows Explorer (or Explorer, for short), which in turn displays the contents of the folder.

✦ Windows Explorer contains tools that allow you to navigate to other folders on a disk. In fact, you can get to any folder from any other folder.
Working with Documents

Many programs are designed to let you create, view, edit, print, save, and open documents. As mentioned in Chapter 5, a document in the computer sense is much like a document in the real-world sense — it’s basically anything that might otherwise be printed on paper and perhaps stored in a filing cabinet somewhere. Although a computer document might just as well be a song or videotape, it doesn’t have to be something printed on paper.

Understanding the Document Types

Until now, I’ve been referring to types of documents in a very broad sense, such as texts, pictures, music, and videos. In fact, many different types of documents exist within each of those broad categories. There are lots of different types of text documents and lots of different types of pictures.

The reason has to do with the way the computer industry evolves. People come up with new programs, new ways to do things, and even new document formats, always trying to make things better. Some of these things catch on; some don’t. The ones that catch on tend to be supported by many different programs.

The main thing that defines a document’s type is its format, which has to do with the way in which information is stored in the file. Different types of documents are stored in different formats. Any given program will be able to open files in at least one format. Most programs can open files from many formats. There isn’t, however, any program that can open all types of documents.

In This Chapter

Understanding document types
Using a program to create a document
Saving a document
Closing a document
Opening documents
Opening a document in a different program
Changing a document’s type
Working with multiple document windows
Showing/Hiding File Name Extensions

When you double-click a document’s icon, Windows opens both the document and some program that’s capable of displaying that type of document. Or, at least it tries to do that. (More on that in a moment.) But how does Windows know what format the document is in, so it can open the appropriate program? The answer to that question is the file extension.

Every document file has an extension on the end of its file name. The extension is a dot (period) followed by one or more characters. Figure 6-1 shows an example.

Figure 6-1: An icon, file name, and extension

![File name and extension](image)

Figure 6-2 shows an example of some icons in an Explorer window. On the left, file name extensions are visible. On the right, they’re invisible. (Folder names never have extensions, because they’re not files. They’re containers in which you store files.) On your own screen, you might, or might not, see extensions on your document file names. Whether or not file name extensions are visible on your screen is something you get to decide for yourself.

Figure 6-2: Icons with extensions hidden (left) and visible (right)

To choose whether you want to see, or not see, file name extensions, follow these steps:

1. If you’re not already in Windows Explorer, open it now (click the Start button and choose My Documents, since Explorer is the program that shows you the contents of all folders).
2. From Explorer’s menu bar, choose Tools ➪ Folder Options. The Folder Options dialog box opens.

3. In the Folder Options dialog box, click the View tab as in Figure 6-3.

![Folder Options dialog box](image)

**Figure 6-3:** The View tab in the Folder Options dialog box

4. Now you have two choices:
   - If you want to hide file name extensions, choose the Hide extensions for known file types option.
   - If you want extensions to be visible, clear the Hide extensions for known file types option.

5. Click the OK button.

You can repeat Steps 1-5 at any time to either show, or hide, file name extensions.

**Caution**

Never change a file name extension, as doing so might make it impossible to open the file. Keeping file name extensions hidden is an ideal way to keep yourself from accidentally changing a file name extension.

Even when file name extensions are hidden, you might occasionally come across a file that shows its extension anyway. That’s because the option hides extensions only for known files. A **known file** is one for which Windows already knows what program to use to open that file. An **unknown file** is a document that isn’t associated with any program on your computer. An unknown file will always display its file name extension.
Common Document File Types

As mentioned, thousands of different programs are available for Windows, capable of creating hundreds of different types of documents. It wouldn’t make sense to learn them all — most document types are so rare that you may never come across them. Some common document types, however, you’re almost certain to come across eventually. Those types are listed and briefly described in Table 6-1.

<table>
<thead>
<tr>
<th>Extension</th>
<th>General Type</th>
<th>Format</th>
<th>Opens With</th>
</tr>
</thead>
<tbody>
<tr>
<td>MP3</td>
<td>Audio</td>
<td>MP3</td>
<td>Windows Media Player/Other</td>
</tr>
<tr>
<td>WMA</td>
<td>Audio</td>
<td>Windows Media Audio</td>
<td>Windows Media Player/Windows Movie Maker</td>
</tr>
<tr>
<td>JPG, /JPEG</td>
<td>Picture</td>
<td>Joint Photographic Experts Group</td>
<td>Internet Explorer/most graphics programs</td>
</tr>
<tr>
<td>GIF</td>
<td>Picture</td>
<td>Graphics Interchange Format</td>
<td>Internet Explorer/most graphics programs</td>
</tr>
<tr>
<td>BMP</td>
<td>Picture</td>
<td>Bitmap</td>
<td>Most graphics programs</td>
</tr>
<tr>
<td>PPT</td>
<td>Presentation</td>
<td>PowerPoint Show</td>
<td>Microsoft PowerPoint or PowerPoint Player</td>
</tr>
<tr>
<td>WPD</td>
<td>Text</td>
<td>WordPerfect Document</td>
<td>WordPerfect</td>
</tr>
<tr>
<td>PDF</td>
<td>Text</td>
<td>Portable Document Format</td>
<td>Adobe Acrobat Reader</td>
</tr>
<tr>
<td>RTF</td>
<td>Text</td>
<td>Rich Text Format</td>
<td>Microsoft Word/WordPad</td>
</tr>
<tr>
<td>DOC</td>
<td>Text</td>
<td>Document</td>
<td>Microsoft Word/WordPerfect</td>
</tr>
<tr>
<td>MPG, MPEG</td>
<td>Video</td>
<td>Motion Picture Experts Group</td>
<td>Windows Media Player/Others</td>
</tr>
<tr>
<td>WMV</td>
<td>Video</td>
<td>Windows Media Video</td>
<td>Windows Media Player</td>
</tr>
<tr>
<td>HTM, HTML</td>
<td>Text</td>
<td>Web page</td>
<td>Internet Explorer/any Web browser</td>
</tr>
</tbody>
</table>

For a beginner, all this business of multiple document types can seem pretty intimidating. However, when you create a document and save it, the program you’re using at the moment will suggest an appropriate format for you, and
99 percent of the time, you can just use the suggested format. We’ll talk about why you might want to choose another type one percent of the time in the section “Changing a Document’s Type,” later in this chapter. For now, let’s focus on how you go about creating a document in the first place.

Tip: You can look up just about any file name extension at www.filext.com.

Using a Program to Create a Document

As you know, you can start any program installed on your computer from the Start menu. Most programs that allow you to work with documents contain a large document area, where the document you’re working with at the moment is displayed. For example, WordPad is a small word-processing program that lets you create letters, reports, and other textual documents. To open WordPad, click the Start button and choose All Programs ➪ Accessories ➪ WordPad.

When WordPad opens, the large white area you see is a blank document. It is, essentially, an empty sheet of typing paper on which you can type. Surrounding the empty document is WordPad’s program window, which contains all the usual accoutrements of program windows, as discussed in Chapter 4 (see Figure 6-4).

Figure 6-4: The WordPad window, containing a blank document
To type on the blank sheet of paper you see in WordPad, just start typing. In fact, that’s how you create a document in WordPad — you type text. If you’re following along on your own computer right now, feel free to type any text at all into your blank document. Even if you type just one sentence, you will have created a document. You can use that as an example as you learn to save and open documents in the sections that follow.

**Saving a Document**

As you create a new document, it exists in the computer’s Random Access Memory (RAM). RAM is different from a disk in that there are no moving parts, and changes can be made very quickly. Storing an open document in RAM, rather than on the hard disk, is what allows you to quickly and easily make changes to the document.

While RAM is king when it comes to speed, it has one major drawback that disks don’t have: RAM is volatile. That means that the moment the power goes off, everything in RAM instantly disappears, as though it never existed. It doesn’t matter if the power went off intentionally (you turned off the computer) or unintentionally (a power outage). The document disappears either way.

In fact, the document also disappears the moment you close the program that you’re using to create the document. This is not a good thing if you planned on keeping the document around for a while. To keep a document around for a while, you have to save it. When you save a document, you’re taking an exact copy of the document on your screen and sticking it in a file on the hard disk. The hard disk is not volatile. Whatever you put there stays there forever (unless you delete it).

**How to Save a Document**

To save the document you’re currently working on, do whichever of the following is most convenient at the moment:

- Choose File ➤ Save from the program’s menu bar.
- Click the Save button (if available) in the program’s toolbar.
- Press Ctrl+S.

If you’ve created and typed a short document already in this chapter and you’re looking at it right now on your screen, you can use any of the preceding methods to save what you’ve typed so far. If this is the first time you’ve saved the document, you’ll be taken to the Save As dialog box, discussed next.

Cross-Reference

As you’ll learn in Chapter 7, there are lots of ways to edit text in WordPad.
Using the Save As Dialog Box

The Save As dialog box appears anytime you save a new document (as well as when you download a new file or save an e-mail attachment). It does so because it’s up to you to keep your own files organized. You stay organized by using the Save As dialog box to tell Windows where to put the file (in what folder) and what to name the file. This is not unlike choosing a particular manila file folder in a file cabinet to store a document you’re currently holding in your hand.

The Save As dialog box is a mini Windows Explorer in that you can navigate to any folder in your system. Using the Save As dialog box is usually a three-step process as illustrated in Figure 6-5 and summarized here.

1. Specify where to save the file
2. Name the file
3. Click Save

**Figure 6-5**: Three steps to saving a document from the Save As dialog box

The Save As dialog box will close. That’s all there is to it. The document is saved and still open on your screen. Let’s look now at the details behind those brief Steps 1 and 2 in Figure 6-5.

**Step 1: Choosing a Folder to Save In**

Your first job in the Save As dialog box is to tell Windows where you want to store the file. The Save In option shows which folder that will be. If you’re a beginner, the smart thing to do is always choose My Documents as the folder to save things in. That way, you’ll know where every file is. You can organize your documents into smaller subfolders at any time in the future, no problem there.

Often, My Documents will be the default folder anyway. That is, My Documents will already appear as the folder name in the Save In option. If some other folder name appears there instead, you can always change it to My Documents by choosing that folder from the Save In drop-down list. To navigate to any folder in the Save As dialog box, use the navigation tools pointed out in Figure 6-6 as follows:
Figure 6-6: Navigation tools in the Save As Dialog box

✦ **Other Places**: If your Save As dialog box shows icons on the left, you can click one of those icons to quickly jump to the folder that the icon represents.

✦ **Drop-Down List**: Click the drop-down list button on the Save In option to choose a folder to jump to from the menu.

✦ **Folder Icons**: To open a subfolder within the current folder, double-click its icon in the main pane.

✦ **Up button**: To move up to the parent of the current folder, click the Up button in the Save As dialog box.

If you can’t open a folder directly from the Save In drop-down list or other places, you can probably get to a nearby parent. For example, if you created a folder named Vacation 2004 in your My Pictures folder, you could get to it quickly by choosing clicking the Start button and choosing My Pictures. In the My Pictures folder that opens, double-click Vacation 2004 to open that folder.

**Step 2: Naming a Document**

Once you’ve navigated to the folder in which you want to store the document, the next step is to give it a name using the File Name option near the bottom of the dialog box. You’ll want to come up with a name that will make it easy to identify the document just from its icon. The name can be up to 256 characters. But as a rule, stick with shorter names that are easy to type and remember.
The name of the folder that appears in the Save In option is where your
document will be saved when you click the Save button. That name is also
the name of the current folder, in the sense that the larger pane always
shows the contents of whatever folder is selected in the Save In drop-down
list. The file name you enter can contain letters, numbers, spaces,
dergories (_), hyphens (-), and apostrophes (’). Avoid using all
other punctuation marks and special characters.

Often, a default file name will appear in the File Name option already. It will be
a generic name such as Document or Image. You’ll want to replace that with a
more meaningful name. You can use any of the techniques discussed under
“Renaming Files and Folders” in Chapter 19 to enter or change the file name.

If the default file name already typed into the File Name option already has an
extension on the end (a period followed by one or more letters), don’t change
that extension! As you’ll learn later, the file’s extension tells Windows what
type of information is in the file. If you change the extension, Windows will
get the wrong information from the extension, and the file may not open.

To avoid changing the extension, you can click just to the left of the period to
put the cursor there. Drag the mouse pointer to the left to select all the text to
the left of the period, as in Figure 6-7. Then type the new name. The new name
will replace the selected portion of the name, leaving the extension intact.
Finally, be aware that every file within a folder must have a unique name. So don’t try to give two different files the same name. You can make part of each file name the same, as in Vacation01, Vacation02, Vacation03, and so forth.

Once you’ve completed Steps 1 and 2, that’s usually all you need to do. You can ignore any other options in the dialog box and click the Save button. We’ll talk about when, and why, you might want to use the Save As Type option in the Save As dialog box in the section “Changing a Document’s Type,” later in this chapter.

Save Your Work Often!

When you save a document, you’re saving a copy of that document as it exists in RAM at that moment in time. Any changes you make after saving the document are not saved until you save the document again. So when you’re happy with a change you’ve made to a document, you’d be wise to save the entire document right then and there; don’t risk losing the change.

In the long run, the smart thing to do is save a new document at the moment you create it. Don’t wait until you’ve put a bunch of work into it. That way, the document has a name and a place. As you work on the document, use any of the standard Save techniques (summarized again here) to save your work every five minutes or so:

✦ Click the Save button in the program’s toolbar (if available).
✦ Choose File ➤ Save from the program’s menu bar.
✦ Press Ctrl+S.

If you save your work every five minutes, the most work you can lose is five minutes’ worth. On the other hand, if you spend six hours working on a document but never save it, you stand to lose all six hours of work.

Troubleshooting Saves

Normally, when you save a file, it just gets saved, and the Save As dialog box closes. If there’s a problem, you’ll likely see an error message like the example shown in Figure 6-8. You’ll need to fix the problem to proceed. Here are some common error messages, what they mean, and how to solve the problem:
You cannot save in the folder specified . . .: The folder you’ve chosen in the Save In drop-down list can’t be used to store files. Solution: Click OK, and choose My Documents from the Save In drop-down list; then click Save. The document will be stored in your My Documents folder.

Filename already exists. Do you want to replace?: The file you’re about to save has the same name as a file that’s already in the folder. If you choose Yes, you’ll replace that file with the one you’re saving, and the original file will be lost forever. Solution: Choose No, change the file name of this document, and click the Save button again. The document you’re saving will be placed under whatever file name you provide; the original file will keep its original name.

The file name is invalid: There’s an invalid character, such as a punctuation mark in the file name you entered. Solution: Click the OK button, remove the invalid character(s) from the file name, and click Save.

Please insert a disk into drive A: You’ve selected the floppy drive as the place to save the file, but there is no floppy disk in the drive. Solution: You have two choices here. The best would be to click the Cancel button, choose My Documents from the Save In dialog box to save the file to your My Documents folder instead, and click the Save button. Otherwise, insert a floppy disk with sufficient empty space into the drive and wait a few seconds for the Save As dialog box to close.

You have files waiting to be written to CD: You chose your CD-R or CD-RW drive as the place to save the file. Solution: Save the file again; this time, choose My Documents as the Save In folder. To learn how CD and DVD disks work, see Chapter 21.

Closing a Document

Saving a document that’s currently open ensures that all your recent changes get stored to the disk. But saving the document doesn’t close it. The saved program remains open and visible on your screen so that you can do some more work. But there’s no need to keep the document on-screen until you’re completely finished. You can close the document at any time and then reopen it at any time in the future to work on it some more, print it, or whatever.
Closing a document takes it off your screen, freeing up space so that you can work with other programs or documents without the additional clutter. The easy way to close a document is to just close the program that's displaying the document, using whichever of the following methods you feel is most convenient for you:

✦ Click the Close (X) button in the upper-right corner of the program window.
✦ Or choose File ➤ Exit from the program’s menu bar.
✦ Or if the document’s program is the active window, press Alt+F4.

If you’ve made any changes to the document since the last time you saved it, you’ll see a prompt asking if you want to save those changes. Click Yes to save the document as it appears on the screen now. Or click No to abandon any changes you’ve made since you last saved.

If the program you’re using supports multiple document interface (MDI), you can close the document and leave the program open. For more information, see the section “Working with Multiple Document Windows,” near the end of this chapter.

If you’re following along online, go ahead and close your document and WordPad’s program window now. Choose Yes if asked about saving your work. In the next section, you’ll learn how to reopen a document you’ve saved to your hard disk.

Opening Documents

Once you’ve created a saved document, you can open it at any time in the future to view it, change it, print it, or whatever. This is the same idea as going to your file cabinet and retrieving some document you stored there for safekeeping. Your computer document will open on the screen though, contained within the default program for the type of document you’ve opened. (We’ll discuss the meaning of default program a little later in this chapter.)

As with most things, there are several ways to open a document. Choosing one method over the other is simply a matter of deciding which is most convenient at the moment. The sections that follow describe the different methods.

Opening a Recent Document

If the document you want to open is one you’ve worked on recently, you may be able to open it right from the Start menu. To do so, click the Start button, and choose My Recent Documents, as in Figure 6-9; then click the name of the document you want to open.
The document will open, most likely in the same program you used to create it.

To alphabetize the My Recent Documents list, right-click any document name and choose Sort By Name.

## Opening a Document from Its Folder

You can always open a document from whatever folder you put it in. This works for downloaded files and saved e-mail attachments, as well as for documents you created yourself. The trick is simply to open the folder in which the file is contained. You can do that by clicking the Start button and choosing the folder’s name. Or, if the folder’s name isn’t on the Start menu, open the folder’s nearest parent; then navigate down from there.

For example, let’s say you created a folder named 2004 Vacation inside your My Pictures folder. You want to open that folder from the Windows desktop. Click the Start button and choose My Pictures to get to your My Pictures folder. Then double-click the 2004 Vacation folder’s icon in the main pane of Windows Explorer.

If you have no idea what I’m talking about in the preceding paragraph, see “How Folders Are Organized” and “Navigating through Folders” in Chapter 5.

Once you see the icon for the file you want to open, just double-click that icon. The document will open in whatever program is appropriate for that type of document (assuming there is such a program on your computer).
What’s “My Recent Documents”?  

If you don’t see a My Recent Documents option on the right side of your Start menu, just perform the following steps to add that option:

1. Right-click the Start button and choose Properties. The Taskbar and Start Menu Properties dialog box opens.

2. On the Start Menu tab, click the option button next to the Start Menu option (not Classic Start Menu); then click the Customize button. A new dialog box titled Customize Start Menu opens.

3. In the Customize Start Menu dialog box, click the Advanced tab.

4. Make sure the List my most recently opened documents option is selected (checked) as in the following figure.

5. Click the OK button in the Customize Start Menu dialog box.

6. Click the OK button in the Taskbar and Start Menu Properties dialog box.

Click the Start button, and you should see My Recent Documents listed on the right side of the Start menu. For more information on customizing your Start menu, see the section “Personalizing Your Start Menu” in Chapter 24.

Using the Open Dialog Box

If the program you’ll be using to view or edit the document is already open, you can use its Open dialog box to open a document. You can get to a program’s Open dialog box using whichever following method is most convenient:

✦ From the program’s menu bar, choose File ➪ Open.
✦ Click the Open button on the program’s toolbar, if available.
✦ Press Ctrl+O (if the program is in the active window).

The Open dialog box looks a lot like the Save As dialog box and offers the same navigation tools. Opening a document from the Open dialog box is usually a simple two-step process:

1. Navigate to the folder in which the document is contained, so that folder name appears in the Look In drop-down list.

2. In the main pane, double-click the document’s icon. (Or click the document’s icon and then click the Open button.)
Where’s My File?

Suppose you’re in the Open dialog box and you navigate to some folder in which you’re certain you stored a file. But there’s no sign of the file in that folder. What to do? The first thing to remember is that the only document icons visible in the main pane are those whose document type matches that selected in the Files of Type drop-down list. If a file seems to be missing, choose All Files (*.*) or All Documents (*.*) from the Files of Type drop-down list to see all icons. Or choose the file type that matches the type of file you’re looking for.

All of the preceding methods have one thing in common: They will open the document in the default program for that document type. That might be the same as the program you used to create the document, but then again it might not be. So it’s time to get this whole business of the default program for a document squared away so that you’re the one in control of things.

The basic steps are summarized in Figure 6-10. Note that the Open dialog box contains the same navigation tools as the Save As dialog box, described earlier in this chapter. For example, suppose you’re in the Open dialog box and want to jump to your My Documents folder. In that case, choose My Documents from the Look In drop-down list, or just click the big My Documents button at the left side of the dialog box (if available).

1. Get to the document’s folder

2. Double-click the document’s icon

Figure 6-10: The My Recent Documents folder

Once you’ve opened the folder that the document is contained in, you should see that document’s icon in the main pane. If you don’t, take a look at the Files of Type option near the bottom of the Open dialog box. That selection limits
the icons visible in the main pane to files of that type. To see all the files in the current folder, choose All Documents (*.*) from the Files of Type drop-down list.

Tip
To alphabetize the icons in the main pane, right-click some empty space between icons and choose Arrange Icons by ➥ Name. To change your view of the icons, click the View Menu button in the dialog box.

As mentioned, once you see the document’s icon, you can just double-click it to open the icon. Or click the icon and click the Open button in the dialog box. The document will open in the document area of your program.

Opening a Document in a Different Program

As I’ve mentioned a few times, when you open a document, it opens in whatever program is set as the default program for that document’s type. That default program might not be the only program on your computer capable of opening the document. You might have several programs on your computer that can open a certain type of document.

To see which programs are capable of opening a document, get to the document’s icon on the My Recent Documents menu. Or use the method described under this chapter’s “Opening a Document from Its Folder” section to get to the document’s icon through Windows Explorer. When you see the document’s icon, don’t double-click it. Instead, right-click the icon and choose Open With. If two or more programs on your system can open the document, you’ll see their names listed on the Open With menu, as in the example shown in Figure 6-11.

![Figure 6-11: Example of an Open With menu](image)

After you’ve clicked Open With, click the name of the program you want to use to open the document. That document will open in that program.

Be forewarned that if you just take a wild guess at choosing a program to open some document, the document may open but appear only as meaningless gobbledygook on the screen. If that happens, you should close the program.
and document. If the program asks if you want to save any changes made to
the document, you should definitely choose No, because you really don’t want
to save the meaningless gobbledygook version of the document that’s on the
screen at the moment.

Changing the Default Program
If you find that you always have to right-click a particular type of document
and choose Open With to get it to open in the program you want, you can
change the default program. That is, you can change which program opens
automatically when you double-click the document’s icon.

Choosing a new default program for a file type is fairly easy. First, find a docu-
ment that’s the appropriate type. (You may need to make file name extensions
visible for this part.) Once you find a document of the appropriate type, follow
these steps:

1. Right-click the icon and choose Open With.
2. In the Open With menu, click Choose Program. . . The Open With
dialog box shown in Figure 6-12 opens.

![Figure 6-12: The Open With dialog box](image)

3. Click the name of the program you want to use as the new default
program for this type of document.
4. Choose the Always use the selected program to open this kind of file
option, so its checkbox is checked.
5. Click OK.
From now on, whenever you double-click a document that’s of the same type (that is, has the same file name extension) as the one you right-clicked in Step 1, you can still right-click the icon and choose Open With to open the document in any program you want. All you’ve done here is define what program opens when you double-click the icon.

**When Windows Can’t Open a Document**

If you create a document yourself, you can surely open it by using whatever program you used to create the document. But if you download a document from the Internet, or if someone sends you a document by e-mail, there’s no guarantee that you already have a program installed that can open that document.

When you try to open a document for which there is no default program defined, you’ll see a dialog box like the one shown in Figure 6-13.

![Figure 6-13: The options that appear when Windows can’t open a document.](image)

The dialog box is saying, “There is no default program for opening this type of document. What do you want to do about that?” In that example, the document I’m trying to open is named Guidelines.pdf. So what that dialog box is saying, more specifically is, “There is no program installed on your computer that can open a PDF file.” You have three choices on how to handle the situation:

- **Use the Web service to find the appropriate program:** Choosing this option takes you to a Web page where you can learn which program or programs are available for opening this document. (This requires that you also know how to use your Web browser and perhaps how to download and install programs.)

**Tip**

To open a .pdf document, you need a program named Adobe Acrobat Reader. You can get that program for free by visiting [www.adobe.com](http://www.adobe.com) and clicking the Get Acrobat Reader button on their home page. Once you’ve started the installation, be sure to choose the Open button in the File Download dialog box that appears. See the section “Downloading and Installing Programs” in Chapter 25 for more information on downloading and installing programs.
Select the program from a list: If you think one of the programs already installed on your computer might be able to open the document, choose the second option; then choose a program from the Open With dialog box that opens. (This requires that you have enough experience with the programs on your computer to be able to make a reasonable guess about which program will be able to open the document.)

Cancel: If you choose neither option, and just click the Cancel button instead, the dialog box will close and no further attempt will be made to open the document.

Whether or not you’ll be able to get anywhere using the first two options really depends on your experience level. For a beginner, the simple solution might be to simply ask whoever sent you the file what program is needed. If the person who sent you the file is an experienced user, he or she may be able to send you a copy of the document in a format you can open.

Changing a Document’s Type

Once in a while, you may need to change a document’s type yourself. For example, let’s say you send someone a document you create in Microsoft Word, but he or she can’t open the document because he or she does not own Microsoft Word. How can you save the same document in some other format that your recipient can open?

One thing is for sure: Simply changing the file name extension will not work. You never want to change a file’s extension, because if you do, the extension on the file name will no longer accurately describe the format of the data in the file. And possibly, no program will be able to open the document! What you need to do is open the original document; then save a new copy of the same document in a different format. Here’s how:

1. Open the document in the usual manner (by double-clicking its icon, for instance).
2. From the menu bar of the program that opens the document, choose File ➪ Save As. The Save As dialog box opens.
3. Navigate to the folder in which you want to store the converted document (for example, choose My Documents from the Save In Drop-down list).
4. Enter a name for the converted document (do not type a file name extension in the File Name box).
5. Click the Save As Type drop-down list button; then click the file type you want to use for this copy of the document. The exact file types available to you will depend on the program you’re using at the moment. Figure 6-14 shows a couple of examples.
If file name extensions are visible, the extension that appears in the File Name text box will reflect whatever type you choose from the Save As Type drop-down list. As always, you never want to change the extension that appears in the File Name text box.

6. Click the Save button in the Save As dialog box.

![Figure 6-14: Sample Save As Type drop-down lists from a couple of programs](image)

Now you can close the program and open the folder in which you stored the converted document. If you made this conversion to send the document to someone else, make sure you send the converted copy of the document, not the original.

**Why Can’t I Convert to PDF?**

Portable Document Format (PDF) is a popular format for distributing documents over the Internet. This has to do with the fact that a portable document looks the same on all types of computers: Windows, Macintosh, Linux, and so forth. But to create PDF files, you need to purchase and install Adobe Acrobat. Or you can sign up for a service that allows you to do that online at [www.adobe.com](http://www.adobe.com). You can read (view) .pdf files with the free Adobe Acrobat Reader program. But you can’t create or change PDF documents with that reader.
Working with Multiple Document Windows

Some programs provide a multiple document interface (MDI), which allows you to have several documents open at the same time. Each document appears within its own document window inside the program’s window. A document window is similar to a program window, except that it has no menu bar or toolbar. A document window doesn’t need those things, because the program displaying the document already has all the menus and tools needed to edit the document.

For example, take a look at Figure 6-15. There, the open program is named Microsoft Photo Editor (as indicated by that name in the title bar). The menu bar and toolbar for that program appear just under the title bar.

![Microsoft Photo Editor](image)

**Figure 6-15:** Some programs allow you to work with several open documents simultaneously.

Currently, I have four documents (each a photo) open in that program. Three of the documents are plainly visible. The fourth document is currently minimized within the program window and appears near the lower-left corner of the program window. Notice that unlike a minimized program window, which appears on the taskbar, a minimized document window appears within the program’s document area.
Managing document windows isn’t too different from managing program windows. Perhaps the trickiest thing is getting a maximized document unmaximized. If the program does contain a maximized document window, you’ll see the Minimize/Restore/Close buttons for the document just above the upper-right corner of the document, as shown in Figure 6-16. You can click the Restore button (the one in the middle) to shrink the document window a bit.

![Figure 6-16: Minimize, Restore, and Close buttons for a minimized document window](image)

The Windows option on the program’s menu bar will include options for tiling and cascading the document windows within the program. You’ll also see the name of each open document on that Windows menu, as in Figure 6-17. To bring a document window to the top of the stack, just click its name in that Windows menu.

![Figure 6-17: Sample Windows menu from a program’s menu bar](image)

If you minimize a document window, it will most likely end up looking like a tiny title bar. In some programs, however, the document window might shrink to a tiny icon within the program window. Either way, you can always restore the minimized document’s window by double-clicking that icon or bar. Optionally, choose Windows from the program’s menu bar, and click the name of the minimized window to restore it.

You can also move and size document windows as you would a program window. To move a document window, drag it by its title bar. To size a document window, drag any corner or edge, just as you would with a program window.
Summary

This chapter has covered fundamental, universal skills for working with document files. As you gain experience with computers, you’ll discover hundreds of different document types. As intimidating as that might sound, you’ll also discover that the skills you’ve learned in this chapter will apply to just about every document you create or download. To recap this chapter’s content:

✦ Every document file has an extension at the end of its name, which Windows uses to determine which program it should use when you open a document.

✦ You can make file name extensions visible, or invisible, through the Folder Options dialog box.

✦ To save a new document, choose File ➪ Save from the program’s menu bar. Or click the Save button in its toolbar or press Ctrl+S. The Save As dialog box opens.

✦ To keep your documents organized, use the Save As dialog box to specify where you want to save the file and what you want to name it.

✦ To open a recently saved document, click the Start button, and choose My Recent Documents; then click the name of the document you want to open.

✦ You can also open a document from its folder, from its program’s File menu, or by choosing File ➪ Open from the program’s menu bar.

✦ The program that opens when you double-click the icon for a document is the default program for all documents of that type.

✦ To open a document in some program other than the default program, right-click the document’s icon and choose Open With.
Type, Edit, Copy, and Paste

No matter what you do with your computer, there will always be some typing involved. Even if you plan to work with pictures, music, or video, there will be plenty of times when you’ll need to type e-mail messages and such. If you can’t type worth beans, the whole issue of typing can be a real pain. Although I can’t well teach you to type, I can definitely show you how to get things done with minimal typing. For those of you who can type, I can show you techniques that will make your work go more quickly.

There are, of course, hundreds of programs that allow you to type, ranging from the simple little Notepad program that comes with Windows XP to huge, full-blown word-processing/desktop-publishing programs such as Microsoft Word and WordPerfect. Obviously, I can’t cover all those products in a single book or single chapter. But I can, and will, cover standard text-editing techniques. Because such techniques are universal, you can use them virtually anyplace you type text — from tiny text boxes to instant messages, from e-mail messages to entire books.

If you want to follow along on your own computer and try out some of the things described in this chapter, use the WordPad program that comes with Windows XP. WordPad is a simple word processor (as compared with behemoths such as Word and WordPerfect) that lets you type quite fancy documents. To start WordPad, click the Start button and choose All Programs ➪ Accessories ➪ WordPad. WordPad’s program window (and taskbar button) will open, showing you a new, blank sheet of paper to type on.
Typing on a Screen

If there's any one thing that makes typing on a computer different from typing on paper, it's this: On a typewriter, you press the Return key (the equivalent of the Enter key on most computer keyboards) at the end of each line you type. On a computer, you don’t do that. Instead, you just keep typing past the right margin, even past the right edge of the screen, if necessary. As you type, the text will automatically word wrap to the next line. That means it will break the line between two words, not in the middle of a word.

On a keyboard, you don’t press Enter until you get to the end of a paragraph. If you want to insert a blank line before typing the next paragraph, you’ll press Enter a second time. If you’re typing a list of short lines, you’ll need to press Enter at the end of each of those short lines. But other than that, the rule is don’t press Enter until you’ve typed the entire paragraph. Figure 7-1 shows an example where the Enter symbol shows where I pressed the Enter key. (That symbol wouldn’t show up on the screen or in print.)

![Figure 7-1: Press Enter only to end short lines and paragraphs and to insert blank lines.](image)

Now you might think, “What difference does it make if I press Enter at the end of each line?” It makes a huge difference; if you add or delete any text in a paragraph, the text can reformat itself correctly only if the paragraph was
typed correctly. If you press Enter at the end of each line and then go back and make changes to the text, you’re going to have a real mess on your hands!

**Indenting and Aligning Text**

On a computer, pressing the spacebar repeatedly to indent or align text is generally not a good idea (especially if you’re using a proportional font, where each character’s exact width varies). The width of multiple blank spaces becomes somewhat unpredictable, and what you see on a printed page might not match what you saw on the screen.

To indent text, it’s better to use the Tab key. If you don’t see a key labeled Tab on your keyboard, look for the key with two opposing arrows, pointing left and right. You should find it just to the left of the letter Q or thereabout.

![Tip](image)

In some programs, you can outdent the first line of text in a paragraph by pressing Shift+Tab at the start of the paragraph.

To center text, or align text to the right margin, use your program’s text align features. In WordPad, you’ll find buttons for centering and aligning text in the toolbar (see Figure 7-2). If you don’t see similar buttons in a program you’re using, consider searching that program’s Help for the word *align*.

![Text-Align buttons](image)

**Figure 7-2:** Use text-align tools and the Tab key to indent, center, or right-align text.

![Tip](image)

If you’re using WordPad right now and don’t see the formatting toolbar, choose View ➪ Format Bar from WordPad’s menu bar.
Setting Margins

Another common mistake beginners often make is thinking that the margins that appear on the screen represent the margins that will appear on the printed page. That’s usually not the case. If you try to force margins onto the page by indenting every line or pressing Enter at the end of each line, you’ll end up with a real mess on your hands. On the screen, you don’t have to make any allowance whatsoever for margins.

The margins on the printed page will be determined solely by the margin settings in page setup. While I can’t say this is true of every program ever created, it’s almost universally true that you get to those settings by choosing File ➪ Page Setup from that program’s menu bar. While I can’t show the Page Setup dialog box for every program in the world, most will have options similar to those shown in Figure 7-3. (That Page Setup dialog box is the one that appears when you choose File ➪ Page Setup from WordPad’s menu bar.)

![Figure 7-3: WordPad’s Page Setup dialog box](image)

The margin settings are clearly visible in Figure 7-3. As you make changes to the margin settings, the preview document at the top of the dialog box will change to show the current setting. Again, don’t expect the margins to be visible on the screen. Margins are often hidden on the screen because there’s really no need for them on the screen. Showing them would just waste valuable screen space.

**Tip**  
As always, your selections in the dialog box aren’t applied until you click the OK button in that dialog box.
Choosing a Page Orientation

The Orientation option you see in Figure 7-3 refers to how text is printed on the page. The normal mode is Portrait (vertical), so named because it’s the orientation artists use to paint portraits. The Landscape option flips the page sideways, like the way an artist might paint a landscape. The Landscape setting is useful for printing extra-wide tables that won’t fit within the normal Portrait orientation. If you choose Landscape from the dialog box shown in Figure 7-3, the preview document at the top of the dialog box will show you exactly what I mean.

Printing Text

Printing text (or anything else, for that matter) is usually simple. As a rule, you can use whichever of the following techniques is most convenient at the moment:

✦ Choose File ➤ Print from the program’s menu bar.
✦ Click the Print button in the program’s toolbar.
✦ Press Ctrl+P.

See Chapter 8 for a thorough discussion of printing.

Navigating in Text

If you’re lucky enough to type everything perfectly on the first try, you’re a lucky person indeed. Most of us have to go back and fix a bunch of little errors before we can print our text. To make any change to existing text, you first have to get the cursor to where you want to make the change. Some programs might refer to the cursor as the insertion point, so named because it shows, on the screen, where the next text you type will be inserted. Whatever you call it, it usually looks like a small, blinking vertical line.

Before you try these techniques, though, be aware that they work only in text you’ve already typed. You can’t move the cursor freely about the blank page using these techniques. You can only move through text that’s already in the document. To position the cursor using the mouse, just point to where you want to place the cursor and click (tap the left mouse button). The cursor will move to that exact spot the moment you click. You can also use the navigation keys listed in Table 7-1 to move the cursor through existing text.

The specific program you’re using at any given moment might not support all the keys listed in Table 7-1. The keys listed first are the most common of the bunch.
Table 7-1
Universal (or Almost Universal) Keys for Moving the Cursor through Text

<table>
<thead>
<tr>
<th>Key</th>
<th>Where It Moves the Cursor</th>
</tr>
</thead>
<tbody>
<tr>
<td>→</td>
<td>One character to the right</td>
</tr>
<tr>
<td>←</td>
<td>One character to the left</td>
</tr>
<tr>
<td>↑</td>
<td>Up one line</td>
</tr>
<tr>
<td>↓</td>
<td>Down one line</td>
</tr>
<tr>
<td>Home</td>
<td>Beginning of the line</td>
</tr>
<tr>
<td>End</td>
<td>End of line</td>
</tr>
<tr>
<td>Ctrl+Home</td>
<td>Top of document</td>
</tr>
<tr>
<td>Ctrl+End</td>
<td>End of document</td>
</tr>
<tr>
<td>Page Up (PgUp)</td>
<td>Up a page (or screen)</td>
</tr>
<tr>
<td>Page Down (PgDn)</td>
<td>Down a page (or screen)</td>
</tr>
<tr>
<td>Ctrl+←</td>
<td>One word to the left</td>
</tr>
<tr>
<td>Ctrl+→</td>
<td>One word to the right</td>
</tr>
<tr>
<td>Ctrl+↑</td>
<td>Up one paragraph</td>
</tr>
<tr>
<td>Ctrl+↓</td>
<td>Down one paragraph</td>
</tr>
<tr>
<td>Ctrl+Page Up (PgUp)</td>
<td>To top of previous page</td>
</tr>
<tr>
<td>Ctrl+Page Down (PgDn)</td>
<td>To top of next page</td>
</tr>
<tr>
<td>Alt+Ctrl+Page Up (PgUp)</td>
<td>To top of visible text</td>
</tr>
<tr>
<td>Alt+Ctrl+Page Down (PgDn)</td>
<td>To bottom of visible text</td>
</tr>
</tbody>
</table>

**Tip**
To add a blank space to the end of your text, press the Spacebar. To end the line of text, press Enter.

Selecting Text to Change

As you’ll learn throughout this book, the concept of select, then do is almost universal in Windows programs, especially when it comes to working with text. The term select in this context means highlight. As an example, Figure 7-4 shows where I’ve selected some text and then changed the font, size, and alignment using buttons in WordPad’s toolbar. Notice how only the selected text gets the changes.
The most common text-selection methods are:

✦ Drag the mouse pointer through the text you want to select.
✦ Hold down the Shift key while pressing any of the navigation keys listed in Table 7-1.

The following methods are also widely available. But I can’t guarantee that every program ever created will support all these methods. (If in doubt, search the Help option in the program you’re using at the moment):

✦ **Select one word**: Double-click the word.
✦ **Select one sentence**: Hold down the Ctrl key and click the sentence.
✦ **Select one line**: Move the cursor into the white space to the left of the line; then click.
✦ **Select one paragraph**: Triple-click the paragraph.
✦ **Select multiple paragraphs**: Drag through all of them. Or click where you want to start the selection. Then hold down the Shift key and click to where you want to extend the selection.
✦ **Select a rectangular chunk of text**: Hold down the Alt key and drag the cursor through the text.
Why Can’t I Change This Text?

Not every program that displays text is an editor. Just because you can see text in a program doesn’t mean you can change text in that program. Some examples of programs that show text, but don’t let you edit it, are your Web browser, as well as any viewer or reader program like Adobe Acrobat Reader.

If you want to use text from some other document in a document you’re working on yourself, you can (usually) select text in your browser, viewer, or reader. Then copy and paste that text into WordPad or whatever program you’re using at the moment to create your document. Once you’ve pasted the text into your document, you can edit it as much as you want. It’s not different from text you’ve typed yourself, once it’s in your editing program.

If you make a mess of things while selecting text and need to start over, just click any text within your document to deselect all the currently selected text. Or press the ↑, ↓, ←, or → key by itself (without holding down the Shift key).

If you use Adobe Acrobat Reader, dragging the mouse pointer through a chunk of text might not select text immediately. Instead, you may end up only scrolling through text. Click the Select Text button (shown at left) in that program’s menu bar first. Then drag the mouse pointer through the text you want to select. (If you don’t see that button, choose View ⇬ Toolbars ⇬ Basic from Acrobat Reader’s menu bar.

Changing Text

There are lots of ways to change text in most programs. For tiny corrections, you can use the following keys:

✦ **Backspace**: Deletes the character to the left of the cursor.
✦ **Delete (Del)**: Deletes the character to the right of the cursor.
✦ **Insert**: Switches between Insert and Overwrite modes.

**Tip**

Most keys on your keyboard can autotype, which means rather than tapping a key a bunch of times, you can just hold the key down for a second or two. The key will start behaving as though you were tapping away at it madly. Release the key when you’re done. If you overdo it, press Ctrl+Z to undo the change.

The Insert key acts as a toggle, which means you don’t tap it repeatedly to do something. Tap it once to switch from Insert more to Overwrite mode or from Overwrite mode to Insert mode. Here’s the difference between the two modes:
✦ **Insert mode:** Any new text you type is inserted into existing text, without changing any of that text.

✦ **Overwrite mode:** Any new text you type replaces text that’s already at the cursor position.

**Deleting and Replacing Large Chunks of Text**

To delete or replace a large chunk of text, select the text you want to get rid of by using any of the techniques described in “Selecting Text to Change” earlier in this chapter. To delete all the selected text, press the Delete (Del) key. To replace all the selected text with something new, just start typing the new text. The selected text will disappear instantly, and the new text will take its place. If you make a mistake, press Ctrl+Z to undo the change.

**Styling Text**

Most word-processing programs will allow you to change the style of your text. The buzzwords for text style are things like **font** (the design of the letters); **weight** (**boldface** and **italic** are examples of weights); **effects** (**underline**, **strikethrough**); **size** (generally measured in **points**, where 1 point is equal to about \( \frac{1}{72} \) inch); and, of course, **color**. Some examples of these buzzwords are illustrated in Figure 7-5.

![Figure 7-5: Examples of fonts, sizes, and weights](image-url)
Notepad, a simple text editor, doesn’t allow you to change fonts. You need to use WordPad or some other word-processing program if you want to style your text.

To change the font of text in your program:

**STEPS: Change the Style or Color of Text**

1. Select the text you want to stylize and then . . .
   - Choose options on the program’s formatting toolbar (if available).
   - Or choose Format ➪ Font from the program’s menu bar. In the dialog box that opens, make your selections; then click OK.

Figure 7-6 shows the formatting toolbar and Font dialog box from the WordPad program. Other programs will have similar, or perhaps more, options to choose from.

![Figure 7-6: Formatting options in WordPad](image)

If your computer is new, you’ll be limited to choosing from among those fonts that come with Windows XP. However, literally hundreds, if not thousands, of fonts are available for Windows XP. If you go to [www.google.com](http://www.google.com) and search
for free Windows fonts, you’ll find many examples. But before you download any fonts from a Web site, make sure you read the instructions for installing the fonts at that site. There’s really no general technique I can provide here that applies to all fonts from all manufacturers.

If you just want to boldface, italicize, or underline a selected chunk of text, you can use the shortcut keys that follow:

- **Ctrl+B**: Boldface
- **Ctrl+I**: Italic
- **Ctrl+U**: Underline

**Copying, Moving, and Pasting Text**

Any place you can type text, you can also paste text. That boils down to this: If there’s a chunk of text somewhere on your screen that you want to include in some document you’re currently working on, you’d be crazy to retype it all. It’s better to just copy and paste (or cut and paste) the text from its current location into your document. The basic procedure works like this:

**STEPS: Copy and Paste Text**

1. Select the text you want to copy.
2. To copy the selected text, use whichever following method is most convenient for you:
   - Press **Ctrl+C**.
   - Right-click the selected text and choose Copy.
   - Choose **Edit ➪ Copy** from that program’s menu bar.
3. In the document you’re writing, put the cursor where you want the copied text to appear. (You can just click the appropriate spot.)
4. Paste the text you copied in Step 2 using whichever following method is most convenient at the moment:
   - Press **Ctrl+V**.
   - Right-click near the cursor and choose Paste.
   - Choose **Edit ➪ Paste** from that program’s menu bar.

You can use a similar technique to copy pictures and paste them into text, provided that the program you’re using at the moment allows it. Most programs, including WordPad, do. Notepad, on the other hand, does not. To really appreciate the value of copying and pasting, it helps to look at some examples, as we’ll do in the sections that follow.
Copying from One Document to Another

To start our copy-and-paste examples, let’s say you’re working on a paper and doing your research on the World Wide Web. You want to copy chunks of text from various Web pages to use as your source material. Here’s what you do:

Chapter 10 describes the World Wide Web and related topics.

**STEPS: Copy Text from a Web Page to Your Documents**

1. In your Web browser, select the text you want to copy.
2. Press Ctrl+C or choose Edit ➤ Copy from your Web browser’s menu bar.
3. In your document (the one you’re writing), click where you want to put the copied text, so the cursor shows where the next text will appear.
4. Press Ctrl+V or choose Edit ➤ Paste from your word-processing program’s menu bar. The copied text appears where you pasted it, as in Figure 7-7.

![Image of copy and paste process]

Figure 7-7: Copying text from a Web page to a WordPad document
You can use the same basic technique to copy from just about any document to another. But don’t expect it to work with every single document you come across. For example, people who create .pdf documents (the kind you open with Adobe Acrobat Reader) can lock their documents to prevent copying. If a document is locked, you’ll likely see a message asking for a password when you try to copy. The only person on the planet who knows that password is the person who created and locked the document.

Copy and Paste a Picture

Most modern programs let you include pictures with your text. Exactly how fancy you can get with your pictures depends on the program you’re using. For example, if you’re working in Notepad, it’s just flat-out impossible to paste a picture into your document. If you’re using WordPad, you can paste a picture into your document. But you can’t make text flow around the picture. If you’re using a more sophisticated word processor such as Microsoft Word or WordPerfect, you can put a picture into your document, make text flow around the picture, and do a whole bunch of other fancy stuff.

Of course, I shouldn’t be digressing into other products such as Microsoft Word and WordPerfect. After all, this is a book on Windows XP, not on word processing. But we can illustrate by using an example with Microsoft Internet Explorer and WordPad, two programs built into every copy of Windows XP.

Twenty-first Century Term Papers

My daughter, who is in high school, has developed a very fancy technique for doing her term papers. First, using Microsoft Word, she sets up a document that will print on index cards. Then she searches the Web for pages on her topic. As she browses through Web pages, she copies chunks of text, and each page’s URL, to a separate index card. When she has enough information, she prints the index cards.

Next, she starts out with a new, blank document and starts copying chunks of text from the index cards into her new document, in roughly the order she wants them to appear in the finished product. When that step is finished, she has her rough draft (albeit a completely plagiarized rough draft).

Finally, she creates the paper by adding, changing, and deleting text in the rough draft to make the text her own. Or, in some cases, she may use a quote directly and copy the Web-site information into her bibliography. And of course, Microsoft Word takes care of any misspellings or grammatical errors automatically. The whole process takes about $\frac{1}{10}$th the time I had to spend writing those awful papers in high school!
STEPS: Copy a Picture into a Document

1. In Internet Explorer, right-click the picture you want to copy and choose Copy, as in the left side of Figure 7-8.

2. In the document you’re typing, click the spot where you want to paste the picture.

3. Press Ctrl+V, or right-click near the cursor and choose Paste, or choose Edit ➪ Paste from that program’s menu bar.

In Step 3, you can just as easily paste the picture into a graphics program. There, you can crop it, touch it up, resize it, save it to your hard disk, or whatever. See Chapter 15 for more information on working with pictures in graphics programs.

In WordPad, that’s about all you can do. If you’re using a fancier word-processing program, try right-clicking the picture in that program to see what your other options are. Or search that program’s Help for picture or graphic.
Move a Chunk of Text within a Document

You can use cut and paste to move a chunk of text within a document or from one document to another. The only difference is that when you cut, rather than copy, the original text is deleted right after the copy is made. So when you paste the text, only the pasted copy remains. Here are the steps:

Caution: You can copy text from any document you want. But you can only cut text from documents that you have the ability to edit. If Cut won’t work, try Copy.

**STEPS: Move Text**

1. Select the text you want to move.
2. Press Ctrl+X, or right-click the text and choose Cut, or choose Edit ➤ Cut from the program’s menu bar.
3. Move the cursor to where you want to place the text you just cut.
4. Press Ctrl+V, or right-click and choose Paste, or choose Edit ➤ Paste from the program’s menu bar.

The text appears at wherever you placed the cursor in Step 3.

Adding Special Characters to Text

Your keyboard has all the letters, numbers, and punctuation marks you need to type just about anything. But once in a while, you may need to use a special character, like a copyright or trademark symbol, in your text. Many programs have this capability built into them. But there’s one program you can use with just about any program. The program’s name is Character Map, and here’s how you use it to insert a special character into text you’re currently typing:

**STEPS: Insert a Special Character**

1. In your document, position the cursor where you want to insert the special character(s).
2. Click the Start button and choose All Programs ➤ Accessories ➤ System Tools ➤ Character map. The Character Map program opens as in Figure 7-9.

**What’s Character Map?**

Character Map is an optional Windows XP component and therefore might not be installed on your system. If you can’t find Character Map, you can install it using the techniques described in the section “Installing Missing Windows Components” in Chapter 25. In the Windows Components Wizard described there, you’ll find Character Map under Accessories and Utilities ➤ Accessories.
3. If you don’t see the character you want:
   • Use the scroll bar to the right of the characters to see additional characters.
   • Or choose a different font from the Font drop-down list (Figure 7-9 is displaying the font named Symbol).

   **Tip** If it’s hard to see a character in Character Map, click the character to magnify it.

4. To select a character to use, click it; then click the Select button. You can repeat this step to select as many characters as you need.

5. Click the Copy button.

6. In your document, click where you want to place the special character(s).

7. Press Ctrl+V, or right-click near the cursor and choose Paste, or choose Edit ➪ Paste from that program’s menu bar.

The character is inserted into your document at the cursor position.

**Saving Your Text**

The moment you start typing text into a blank sheet of paper in a program, you’ve created a document. As discussed in Chapter 6, just because it’s a document and on your screen doesn’t mean it’s been saved. If you plan to revisit the document, you’ll need to save it. You can use all the standard techniques described under “Saving a Document” and “Closing a Document” in Chapter 6 to save your work and close your document. If in doubt as to where you save the document, go for the most obvious and simple solution — your My Documents folder.
When working on a lengthy document, remember what I say in Chapter 6 — save your work often!

Likewise, you can open your document at any time by using any of the techniques described in “Opening Documents” in Chapter 6. There’s nothing to it.

**Summary**

In this chapter, you’ve learned fundamental, universal techniques for creating, editing, printing, and saving text. I may be stretching it a bit when I say *universal* here. Hundreds of programs are available for Windows XP that allow you to type and edit text. And there’s no way to test them all. But take it from a guy who has used a whole bunch of those programs: These techniques will almost certainly work in any program you use. If in doubt, try it out.

If all else fails, choose Help from the program’s menu bar, and search for whatever word or phrase describes what you want to do. Before we move on to Chapter 8, here’s a quick recap of the main skills you’ve acquired in this chapter.

✦ When typing paragraphs, don’t press Enter at the end of each line (only at the end of each paragraph).

✦ To print text, press Ctrl+P, or choose File ➪ Print from the program’s menu bar, or right-click the text and choose Print. If a Print dialog box opens, click its Print or OK button.

✦ To change text, you must first move the cursor (or insertion point) to where you want to make the change. You can click the spot or use the navigation keys on the keyboard.

✦ To style, delete, copy, or move text, you first need to select the text so your program knows which text to work with.

✦ If you need to get text from one program window to another on your computer, don’t retype. Use copy and paste instead.

✦ To add a special character to your text, click the Start button and choose All Programs ➪ Accessories ➪ System Tools ➪ Character Map.
If your computer has a printer attached, you can print any document currently open and visible on your screen. Even though tens of thousands of programs allow you to print documents, and hundreds of makes and models or printers exist, the way you go about printing a document is almost always the same.

Faxing is similar to printing, the main difference being that the document prints on someone else’s fax machine as opposed to on your printer. In this chapter, you’ll learn fundamental, universal skills that you can apply to printing and faxing just about any document, from any program.

**Printing a Document**

Although I can’t say that I’ve used every one of the thousands of programs available from Windows XP, I have used a lot of them. So far, they all support the first three options listed here:

- Click the Print button in the program’s toolbar.
- Choose File ‹ Print from the program’s menu bar.
- Press Ctrl+P.

If you use the first method, the document will likely just start printing within a few seconds. Using either of the other methods is likely to bring up the Print dialog box, where you can choose options to specify exactly how
you want to print the current document. I can’t say exactly what that Print
dialog box will look like. It depends on the program you’re using and your
printer’s capabilities. Figure 8-1 shows a couple of sample Print dialog boxes.
The one on the left belongs to Microsoft Internet Explorer; the one on the right
to Microsoft Word 2002.

Don’t expect any document to start printing immediately. There’s always
some prep work that needs to be done, and that will take a few seconds.

Figure 8-1: Examples of two Print dialog boxes

Many programs offer a Print Preview option, which allows you to get a
sneak peek at what the printed document will look like. Try choosing File ➤
Print Preview from your program’s menu bar to see whether it offers this
feature. Use buttons in the Print Preview window to view the document at
different magnifications. To change margins and such, close the Print Preview
window, and choose File ➤ Page Setup from that program’s File menu.

Common Printing Options

As you can see in Figure 8-1, you have a whole lot of options to choose from
before you start printing. Here’s a quick overview of the options you’re likely
to come across and most likely to use:

✦ Select Printer: If you have access to multiple printers (as when you’re
connected to a network), choose the printer you want to use.
✦ **Page Range**: Choose which pages you want to print, ranging from All (the entire document), the current page (the page visible on your screen), Selection (only the text and pictures you selected in the document prior to getting here), or Pages (define a specific page, like 1, or a range of pages, like 2–5, to print only pages 2, 3, 4, and 5).

✦ **Manual Duplex**: Print pages back to back on printers that don’t have the capability to do that automatically. (*Duplex* is nerd word for *back to back.*) When you choose this option, odd-numbered pages will be printed first. You’ll then be prompted to reinsert those pages, so the remaining pages can be printed on their backs.

✦ **Number of Copies**: Specify the number of copies to print.

✦ **Collate**: If this is selected, and you print multiple copies, pages are collated. If you print multiple copies, and clear the Collate option, you’ll get multiple page 1s, followed by multiple page 2s, and so forth.

After you’ve made your selections in the Print dialog box, click the Print button, or OK button, to start printing. Or you can choose additional options that are unique to your printer, as discussed next.

**Tip**

If your Print dialog box has a ? button in its upper-right corner, you can click that button; then you can click any option in the dialog box for more information.

**Choosing a Print Quality and Such**

The general options that appear in the Print dialog box are almost universal. Depending on the make and model of your printer, you might have some other options to choose from. For example, you might be able to control the print quality of a document, opting for a quick draft or a time-consuming but better-quality job. To get to those settings, click the Properties button in the Print dialog box. The Properties dialog box for your printer opens. I can’t say exactly what yours will look like. But Figure 8-2 shows an example from an HP R80 OfficeJet printer. The figure shows options on both of the tabs in that dialog.

Here’s a description of what each option in the sample dialog box offers:

✦ **Orientation**: Portrait prints in the normal vertical orientation; Landscape prints horizontally across the page.

✦ **Page Order**: Front to Back prints pages from lowest page number to highest. It keeps printed pages in correct order if those printed pages come out of the printer face up. Back to Front prints pages from last to first, which keeps them in order if the printed pages come out face up.

✦ **Pages per Sheet**: If you specify a number greater than one, multiple pages are reduced to fit on the page. For example, choosing 2 prints two document pages on each piece of paper, making each document half its actual size.

✦ **Paper Source**: If your printer has more than one paper-feeder, use this option to choose which one you want to use. For example, if you
can keep regular paper in one printer bin, and envelopes in a second bin, choose the second bin whenever you want to print envelopes.

✦ **Media:** Lets you specify the type or quality of paper you’re printing on, such as Plain Paper or Premium Photo Paper.

✦ **Quality Settings:** Lets you choose a print quality. The higher the quality, the longer the job takes (and probably the more ink that gets used). Use Draft or Normal for printing day-to-day documents. Use High when printing a prized photo on photographic paper.

✦ **Color:** Lets you print a color document in black and white, to conserve color ink. It might also speed up the whole process on some printers.

After you’ve made your selections in the Printer Properties dialog box, click OK to return to the Print dialog box. There you can choose additional options. Or click its Print or OK button to start printing.

Figure 8-2: Sample Printer Properties dialog box

**Stopping the Printer, Managing Print Jobs**

As mentioned, a document rarely starts printing right away, because there’s some work to be done first. Part of that organization involves sending the document to the *print queue* as a *print job*. If there are other print jobs waiting to be printed, your document gets in line and waits to be printed. You can use the print queue to manage print jobs. For example, you can stop a printing document or clear out all documents waiting to be printed, via the print queue.
Initially, all you see of the print queue is a tiny printer icon in the notification area. When you point to it, the screen tip shows the number of documents waiting to be printed, as in Figure 8-3. If you double-click that tiny icon, the print queue will open, as in the example shown in the same figure.

Figure 8-3: Double-click the printer in the Notification Area to open the print queue.

The print queue shows the names of any documents waiting to be printed. To pause or cancel a specific print job, right-click its line in the print queue and choose one of the following options from the shortcut menu that appears:

- **Pause**: Stops printing the document until you restart it.
- **Restart**: Restarts the paused print job.
- **Cancel**: Cancels the print job so it doesn’t print and removes the job from the print queue.
- **Properties**: Provides detailed information about the print job. You can also set the document’s priority. The higher the priority, the more likely the print job is to butt in line ahead of other documents waiting to be printed.

You can get to the same options by using the Document command in the print queue’s menu bar. Whatever option you choose is applied only to the selected (highlighted) print jobs. To select one print job, just click it. To select additional print jobs, hold down the Ctrl key while clicking them. If you want to control multiple print jobs, make sure you select them all before making a selection from the Document menu in the print queue.

**What Print Queue?**

If you’re printing to a shared printer connected to another computer in your local network, things won’t work quite as described here. The file you printed will be sent to the print server’s print queue. The print server is the computer to which the shared network printer is physically attached via a cable. To cancel a network print job, you have to go to the print server computer, open its print queue, and cancel the print job there.
How Do I Stop This Thing?

Don’t expect a paused or canceled print job to stop right away. It may print several more pages, even after you’ve canceled a print job. That’s because the print queue sends chunks of a document to the printer’s buffer. That buffer, in turn, holds information waiting to be printed. Canceling a print job prevents any more data from being sent to the buffer. But the printer won’t stop printing until its buffer is empty (unless, of course, you just turn the printer off).

You can use commands on the print queue’s menu bar to manage all the documents currently in the queue, as follows:

✦ **Printer ➤ Pause Printing**: Pauses the current print job and all those waiting in line. To resume printing, choose the same options to clear the checkmark that appears next to the Pause Printing option.

✦ **Printer ➤ Cancel All Documents**: You guessed it — cancels the current print job and all those waiting to be printed.

You can close the print queue as you would any other window — by clicking the Close button in its upper-right corner or by choosing Printer ➤ Close from its menu bar. To get help with the print queue while it’s open, choose Help from its menu bar.

That covers the main options for printing documents. You can also manage printers (as a whole) and fax devices using the Printers and Faxes folder, described in the next section.

Managing Printers and Faxes

You can manage your printers and faxes using the Printers and Faxes folder, available in Control Panel. To open the folder:

**STEPS: Open the Printers and Faxes Folders**

1. Click the Start button and choose Printers and Faxes, if available. If you don’t see a Printers and Faxes option on your Start menu, choose Control Panel instead and complete Steps 2 and 3 as follows.

2. If Control Panel opens in Category view, click Printers and Other Hardware. Otherwise, ignore this step.

3. Double-click the Printers and Faxes icon. The Printers and Faxes folder opens.

Within the Printers and Faxes folder, you’ll see an icon for each printer and fax device to which you have access from this computer. If you click a specific
printer’s icon, the Explorer Bar at the left side of the folder will show options for working with that particular printer (see Figure 8-4). If you click some empty space just outside an icon, so that no icon is selected, the Explorer bar will show the options shown in the right side of the same figure.

The Explorer bar options are largely self-explanatory. The options here are available if you select (click) a printer in the main folder:

✦ **See what’s printing**: Open the print queue for the selected printer.
✦ **Selecting printing preferences**: Lets you change the selected printer’s default settings, to be used for all future print jobs.
✦ **Pause printing**: Pauses all print jobs in the selected printer’s print queue.
✦ **Share this printer**: If your computer and printer are on a network, this option shares the printer so that other computers in the network can use it.
✦ **Delete this printer**: Removes the printer’s icon from the folder.
✦ **Set printer properties**: Lets you change the selected printer’s properties.
✦ **Go to manufacturer’s Web site**: Brings a limousine to your front door so you can visit the printer manufacturer’s Web site. (Yeah, sure.)

![Printer Tasks](image1.png)

![Printer Tasks](image2.png)

**Figure 8-4**: Explorer bars available in the Printers and Faxes folder
These options are available when no printer icon is selected:

✦ **Troubleshoot printing**: Opens the Printing Troubleshooter in Windows’ Help and Support Center.

✦ **Get help with printing**: Supposedly takes you to a Web site where you can get help with printing. But personally, I’ve never come across anything very helpful there.

The *Add a printer*, *Install a local fax printer*, and/or *Send a fax* options you might see are discussed later in this chapter.

### Changing the Default Printer

The *default printer* is used to print a document when you don’t specify a printer. For example, if you just click the Print button in a program’s toolbar to print, without going to the Print dialog box first, the document will be printed to the default printer. In the Printers and Faxes folder, the default printer is marked with a check, as in Figure 8-5.

![Figure 8-5: Setting the default printer](image)

To change the default printer, right-click the icon for the device you want to use as the default, and choose *Set As Default* from the shortcut menu that appears, also shown in Figure 8-5.

### Using a Different Printer for One Job

If you have access to multiple printers from your computer, you’re not limited to using the default printer. You can send any document to a specific printer (or fax device) from the Print dialog box without changing the default printer. To do so, get to the Print dialog box from your program (that is, choose *File* ➤ *Save* from the program’s menu bar, or press Ctrl+P). When the Print dialog box opens, click the icon that represents the printer you want to use, as in the top half of Figure 8-6. Or choose the printer you want to use from the drop-down list, as in the example shown in the bottom half of the same figure.
After you’ve chosen your printer (or fax device), you can choose additional options if you wish. To start printing (or faxing), click the Print or OK button in the same Print dialog box.

Installing a Printer

If you have a printer, but it’s not installed yet, your absolute best bet would be to install it according to the instructions that came with the printer. Trying to install something via guessing is almost guaranteed to turn into a real hair-pulling exercise in frustration.

If following the directions just isn’t an option, wing it and hope for the best. The best scenario to use depends on how the printer connects to the computer, as discussed in the sections that follow.

Traditional Cable or USB?

If you have the choice of connecting your printer to the computer using either a traditional parallel/LPT type cable or a USB/FireWire cable, I recommend opting for the traditional LPT cable (even though it might seem a tiny bit quicker with the USB/Firewire cable). It’s really best to reserve your USB and FireWire cables for things that you need to plug and unplug often, like digital still and video cameras. If you run out of USB/Firewire ports and start plugging/unplugging the printer often to make room for temporary devices, the likelihood of printer problems will surely rise. You don’t need problems.
USB, IEEE 1394 Firewire, or Infrared Connection

If your printer connects to your computer via a USB port, an IEEE 1394 (a.k.a. FireWire) port, or through an infrared connection, the installation procedure should go like this:

1. Close all open programs on your Windows desktop, so you have a nice clear desktop to work with.
2. Plug the printer into the wall; connect the printer to the computer with its USB or FireWire cable. If it’s an infrared printer, aim the infrared beam toward the infrared receptor on the computer.
3. Turn on the printer, and wait a few seconds.

You should see a message in the Notification Area that tells you the device is connected and ready to use. You’re done. The printer is installed and ready to go.

Figure 18-5 in Chapter 18 and Figure 25-4 in Chapter 25 show examples of various ports found on computers.

Parallel and Serial Port Connections

If your printer is a typical plug-and-play printer that connects to the computer via an LPT port or COM port, the best approach would be as follows:

1. Save any unsaved work, shut down windows, and turn off your computer.
2. Plug the printer into the wall; connect the printer to the computer’s LPT or serial port, turn on the printer, and turn on the computer.
3. When Windows restarts, look for the Found new hardware wizard to appear, and follow the instructions it provides.

For more information on installing new hardware, see Chapter 25.

It’s tough to say what will happen beyond this point. The printer may well just install and be ready for use without your taking any further action. An icon for the printer will be created in the Printer and Faxes folder and will be available for selection in your Print dialog box.

Printing the Screen

If you were around in the olden days of computers with text screens, you might remember a time when you could print whatever was on the screen just by pressing the Print Screen (PrtScn) key. (This was a so-called screen dump.) It doesn’t work that way in Windows. You can print the screen directly to the printer. But you can capture the screen, paste it into a graphics program, and print it from there. Here’s how it works:
STEPS: Print the Screen

1. Get the screen to look the way you want.

2. To capture the entire screen, press the Print Screen key. To capture only the active window, dialog box, or message, press Alt+Print Screen.

3. Open your favorite graphics program. (If you don’t have one, you can use Paint in a pinch. Click the Start button and choose All Programs ➪ Accessories ➪ Paint.)

4. Press Ctrl+V or choose Edit ➪ Paste from the graphics program’s menu bar.

A snapshot of the screen (or whatever you captured) opens in your graphics program. If you view it at 100% magnification, it might look more like a hole through your graphics program or something hovering over it. If your graphics program allows it, shrink it a bit to get a closer view.

In some graphics programs, you can spin your mouse wheel to change the image's magnification. In others, you have to choose some option from the program’s View menu, such as View ➪ Zoom.

To print the screen, print the picture as you would any other document (choose click the Print button in the program’s toolbar, or press Ctrl+P, or choose File ➪ Print from your graphics program’s menu bar). To save the image as a file, perhaps to include it in some other document later, save it as you would any other file. That is, click the Save button on the toolbar, or press Ctrl+S, or choose File ➪ Save from the menu bar, as discussed under “Saving Documents” in Chapter 6.

If you plan to use the screenshot as a picture in a Web page, save it as a JPEG or Portable Network Graphics (PNG) file (if possible), using the Save As Type option in the Save As dialog box.

Troubleshooting Common Printer Problems

Here are some common printer problems and what you can do about them:

✦ My pages come out in the wrong order: Change the Page Order option to the opposite settings. For example, if it’s currently set to Front to Back, change it to Back to Front. See “Choosing a Print Quality and Such,” earlier in this chapter, for more information.

✦ The printer doesn’t print: If you recently paused all printing, open the print queue and choose Printer ➪ Pause Printing to clear the checkmark from that option and resume printing. There are lots of other possibilities though — the printer is turned off, it’s out of
paper, out of ink, not connected to the printer, not properly installed, and more. You have to check all those things. Refer to the instructions that came with your printer for details.

✦ The printer won’t stop/start: Make sure you’re giving it enough time (See “Printing a Document” and “Stopping the Printer, Managing Print Jobs” earlier in this chapter.)

✦ The wrong document/page printed: You probably chose File ⇩ Print from the wrong program’s menu bar. Click the document you want to print, to make sure it’s in the active window. Then press Ctrl+P to print that document.

✦ The same document prints over and over again: You may have clicked the Print button too many times. Open the print queue and cancel any print jobs you don’t want.

✦ My document supposedly printed, but I don’t see the pages: If your computer is on a network, the document may have printed to some other printer. Check the other printers. See “Choosing a Default Printer,” earlier in this chapter, for more information.

✦ My printed pages suddenly look blotchy: Most likely, you’re printer is about to run out of ink. You’re just getting the last few sputters.

✦ My pictures don’t look so hot: Try printing on photographic paper, on a higher-quality print setting, if possible. See “Choosing a Print Quality and Such,” earlier in this chapter, for more information.

✦ The printer suddenly went bonkers: If you suddenly start getting gobbledygook from your printer, turn it off. On your computer, open the print queue and cancel all documents waiting to be printed. To play it extra safe, shut down the computer as well. Then start the printer first, start the computer second, and try again.

Be sure to try the Troubleshoot printing option in the Printers and Faxes folder, as another potential resource for fixing a problem.

Faxing Documents

If you need to send documents to fax machines (because the recipient doesn’t have a computer), you can fax files directly from your computer to a fax machine. You can also fax a file to another computer. But as a rule, you’ll want to avoid that and use e-mail attachments for sending documents to other computers. Similarly, if someone is going to send you a document, have the person send it as an e-mail attachment, not as a fax. The reasons are described in the sidebar to follow.

You don’t need a fax machine to send and receive faxes with your computer. But you do need some kind of connection to the outside world. The usual setup is to use a faxmodem that connects your computer to a phone line. If your computer has such a device installed, you can follow the instructions in “Using a Faxmodem,” later in this chapter, to set up faxing and to fax documents.
Can’t Edit a Faxed Document

FAX is short for facsimile, because it works by sending a facsimile copy (a photocopy) of the document through the phone lines. When you send that photocopy to another computer, it gets, quite literally, a photograph of the original document.

For example, let’s say you fax a WordPad document or Microsoft Word document to some other computer user. You are sending a photo of that document. When the recipient opens the document, it will be in a graphics program. This, in turn, makes it impossible to edit the document using Microsoft Word, WordPad, or any other word-processing program.

If e-mail isn’t an option, the only other choice is to use Optical Character Recognition (OCR) software to convert the photocopy to some sort of editable text. Many scanners and faxmodems come with OCR software as part of the package. You can also check out XP-compatible software at the Windows Catalog site at www.WindowsCatalog.com. See the section “Learning about Hardware and Software for Windows XP,” in Chapter 25, for more information.

If you don’t have a faxmodem, you can have one installed or buy one and install it yourself if you’re comfortable with that sort of thing. You can find faxmodems at any computer or large office-supply store. To shop around online, go to any Web site that sells such things (for example, www.amazon.com, www.cdw.com, www.tigerdirect.com) and search the keyword faxmodem.

Caution Even if your computer came with a modem, there’s no guarantee that it’s a faxmodem. To learn more about your modem, see the documentation that came with your computer, or visit your computer’s manufacturer’s Web site.

As an alternative to using a faxmodem, you can use the Internet to send and receive faxes. If you want to explore that route, skip straight to the section titled “Faxing without a Faxmodem,” later in this chapter.

Using a Faxmodem

If you have a faxmodem installed on your computer, you need to jump through some hoops to configure Windows XP to work with that device. The first step in the process is to install Windows XP Fax Services (but only if they’re not already installed). To see if the Fax Services are already installed:

✦ Click the Start button and choose All Programs ➤ Accessories ➤ Communications.
  - If you see Fax Services on the Accessories submenu, the service is installed. You can go to the section titled “Configuring Fax Services,” later in this chapter, right now.
  - If you don’t see the Fax Services option on the Communications submenu, you’ll need to use the Windows Components Wizard to install Fax Services. (See the section “Installing Missing Windows Components,” in Chapter 25.)
With Fax Services installed, the next step is to configure Fax Services to work properly with your faxmodem.

**Configuring Fax Services**

Before you use Fax Services for the first time, you’ll need to fill it in on some facts about your system. You’re going to be filling in a lot of blanks along the way. So make sure you have a few minutes so you can complete the whole process. Here’s the whole shebang:

1. Click the Start button and choose All Programs ➪ Accessories ➪ Communications ➪ Fax ➪ Fax Console.

2. On the first page of the Fax Configuration Wizard that opens, click the Next button.

3. On the Sender Information page that opens, fill in the blanks to describe yourself. What you type will appear as your return address on all your fax cover pages. Then click Next.

4. On the Select Device... page that opens next, click your faxmodem. Also:
   - If you want to be able to send faxes from this computer, make sure the Enable Send checkbox is selected (checked).
   - If you also want this computer to receive faxes, make sure the Enable Receive check box is selected (checked).
   - If you chose Enable Receive in the previous step, you may also choose “Manual answer” if you want to manually answer incoming fax calls. Or choose *Automatically answer after* to have the computer receive faxes automatically. Then specify the number of rings to wait before answering.

5. Click the Next button.

6. If you have a TSID, enter that information on the next page. If you don’t have a TSID, type your business name and fax number. Then click Next.

7. If you have a CSID, enter that information on the CSID page. If you don’t have a CSID, type your business name and fax number. Then click Next.

8. On the Routing Options page that opens:
   - Choose *Print it on* if you want to print each incoming fax as soon as it arrives. Then choose the name of the printer to use.
   - Every fax you receive will be stored in the Inbox of your Fax Console. If you want to create and store an additional copy of each fax you receive, choose the Store a copy in a folder option; then choose an easily accessed folder like My Documents or perhaps a new subfolder within My Documents named My Faxes.
9. Click the Next button. On the last wizard page, you can review the options you selected, and click Back if you discover any mistakes. Otherwise, click the Finish button, and you’re done.

You won’t need to go through that ritual ever again. The Fax Console, described next, is ready for use.

Using the Fax Console
With all your ducks in a row now, you can fire up the Fax Console at any time using either of the following methods:

**STEPS: Opening the Fax Console**

1. Do one of the following:
   - Click the Start button and choose All Programs ➤ Accessories ➤ Communications ➤ Fax ➤ Fax Console.
   - Open the Printers and Faxes folder, and double-click the Fax icon in that folder.

   To add a shortcut to Printers and Faxes to your Start menu, see the section “Personalizing Your Start Menu” in Chapter 24. To create a desktop shortcut to Fax Console, right-click the Fax Console icon on the Fax menu, and choose Send To ➤ Desktop (Create shortcut). See Chapter 24 for all the details on creating shortcuts.

When the Fax Console opens (see Figure 8-7), you’ll see several folders down the left pane. Click any folder name to see its contents. If you haven’t sent or received any faxes yet, all the folders will be empty, as in Figure 8-7. But once you get going with faxes, here’s what each folder will contain:

- **Incoming**: Contains faxes currently being received.
- **Inbox**: Contains faxes that have been received.
- **Outbox**: Contains faxes waiting to be sent.
- **Sent Items**: Contains faxes that have been successfully sent.

---

**TSID, CSID, Huh?**

If you’re as clueless about TSID and CSID as I was the first time I saw them, here’s what you need to know. A TSID (Transmitting Subscriber Identification) is required only on special complex routing software, such as when using the Internet or a large corporate network for faxing. A CSID (Called Subscriber Identification) is similar but is displayed on the receiving fax machine. This allows the recipient to verify that the fax was sent from your computer and isn’t a forgery sent from some other computer. But the bottom line is that, if nobody ever hands you a TSID or CSID to use for faxing, you probably don’t need one.
The Fax Console is sort of like “Faxes Central,” in the sense that every fax you send and receive will end up there (unless you opt to print incoming faxes but not have them sent to the console). So anytime you need to look at a received fax, review faxes you’ve sent in the past, and so forth, the Fax Console is the place to go. As in any program, there are plenty of options in the menu bar and toolbar that you can use to manage faxes.

Like most programs, the Fax Console has its own Help, which you can get to by pressing F1 while Fax Console is the active window or by choosing Help from the Fax Console’s menu bar. To close the Fax Console, click its Close button or choose File ➪ Exit from its menu bar.

**Sending a Fax**

The easiest way to send a fax from your computer is to use the Send Fax Wizard. There are lots of ways to start that wizard. Use whichever method here is most convenient at the moment:

- If you’re in the Fax Console, click the New Fax in its toolbar, or choose File ➪ Send a Fax from its menu bar.

Tip To create a desktop shortcut to the Send a Fax option on the menu, right-click that option on the menu and choose Send To ➪ Desktop (create shortcut). See the section “Creating Your Own Shortcuts” in Chapter 24 for more information.

- From the Windows desktop, click the Start button and choose All Programs ➪ Accessories ➪ Communications ➪ Fax ➪ Send a Fax.

- If you want to fax the document you’re currently creating in a program that supports faxing, choose File ➪ Send To ➪ Recipient Using a Fax Mode. If that option isn’t available, choose File ➪ Print from that
program’s menu bar. In the Print dialog box that opens, choose Fax
the “printer” to use; then click OK.
✦ From Control Panel’s Category view, click Printers and Faxes; then
click Send a Fax under Printer Tasks.

The first page of the Send Fax Wizard opens. The rest is largely self-explanatory.
When you click Next on the first Wizard page, the Recipient Information page
opens as in Figure 8-8. Fill in the blanks to describe to whom you’re sending
the fax; then click Next.

![The Recipient Information page of the Send Fax Wizard](image)

Figure 8-8: The Recipient Information page of the Send Fax Wizard

The Address Book referred to in the Wizard might be Windows Address
Book (WAB). If you use Microsoft Outlook to manage contacts, the Wizard
will use the Outlook’s Contacts folder as your address book.

The second Wizard page, titled Preparing the Cover Page, lets you create a
cover page. If you select the checkbox, you can choose a cover-page template
for the page (Confident, FYI, Generic, or Urgent styles); then you can fill in a
brief subject line and note. After that, click Next.

The third Wizard page, titled Schedule, lets you choose when you want to send
the fax and with what priority. Make your selections and click Next.

The last Wizard page lets you review your options and preview the fax. If you
want to make any changes to the fax, use the Back button in the Wizard. If you’re
ready to send the fax, click the Finish button. The Fax will be sent. Or, if you
opted to send the fax at a later time, the fax will be sent to your Outbox in the
Fax Console and sent at whatever time you specified.
Receiving Faxes

Exactly what happens when you receive a fax depends on how you configured Fax Services, as described earlier in this chapter. If you opted to receive faxes automatically, the fax program will answer the phone after the specified number of rings. If you opted for Manual answer, you can use whichever method that follows is most convenient:

✦ From the Fax Monitor that appears on your screen when the fax arrives, click Answer now.
✦ From the Fax Console, click the Receive Now button on the toolbar. Or choose File ➪ Receive Fax Now from its menu bar.

Faxing without a Faxmodem

You can bypass the whole faxmodem/phone-line business and use the Internet to send and receive faxes. This isn't really a Windows XP thing per se. It's a service you subscribe to on the Internet. But once you’ve established an account, you can certainly use Windows XP to send and receive faxes with that account. Exactly how you do that depends on which service you use. To learn more about these services, visit either of the following Web sites:

- **eFax**: [www.efax.com](http://www.efax.com)
- **Venali**: [www.venali.com](http://www.venali.com)

If you use Microsoft Office, you may be able to sign up for a fax service right from an Office application. For example, if you open a document in Microsoft Word and choose File ➪ Send To ➪ Recipient Using Internet Fax Service (Figure 8-9), you can work your way to the Office Marketplace, which may provide more offerings by the time you read this.

![Figure 8-9: Using, or getting more information about, Internet fax services from Word 2003](image)
More on Faxing

Faxing with a computer is actually a large topic — one that could fill a small book as opposed to part of a chapter in a book. But if I were to get into things that deeply here, I would have to cut back on quite a few of the other umpteen zillion topics I need to cover. To supplement the basics you’ve learned here, use the Help menu in the Fax Console. Or take a look at the fax articles at Microsoft’s Knowledge Base by following these steps:

2. In the Search the Knowledge Base box that appears on the Web page, type 306550 and press Enter or click the green Go button.
3. Click the View Results Only tab. Then click whichever article title best describes the task you’re trying to accomplish.

Remember that most of the articles at the Knowledge Base are specifically about faxing with a faxmodem. To learn more about a given Internet fax service, you’ll need to use the Web site for that service, not Microsoft’s Web site.

Summary

As mentioned, there are hundreds of makes and models of printers on the market and thousands of programs that can print documents. But despite the countless possibilities, some things are so common that you can safely assume they’re true for whatever printer you own and whatever program you’re using. Likewise, there are lots of ways to send and receive faxes with a computer and lots of different faxmodems on the market. But again, the skills you’ve picked up in this chapter should be enough to at least get you started. Here’s a quick recap of the main points made in this chapter:

✦ To print the document that’s currently open and visible on your screen in some program, click the Print button in the program’s toolbar, or choose File ➤ Print from that program’s menu bar, or press Ctrl+P.
✦ When you print a document, you create a print job, which in turn is sent to the print queue before the printer actually goes to work.
✦ To manage current print jobs, double-click the little printer icon in the notification area to open the print queue.
✦ To manage printers and fax devices as a whole, use the Printers and Faxes folder in Control Panel.
✦ To print a snapshot of your screen, first press the Print Screen (PrtScn) key, or press Alt+Print Screen to capture only the active window. Then open your favorite graphics program and choose Edit ➤ Paste from its menu bar, or press Ctrl+V. Use the Print and Save options on that program’s menu bar to print the image or to save it as a file on your hard disk.
If your computer has a faxmodem installed, you can use the Windows XP Fax Services to send and receive faxes.

To manage all faxes, open the Fax Console (click the Start button and choose All Programs ➪ Accessories ➪ Communications ➪ Fax ➪ Fax Console).

To send and receive faxes without a faxmodem, use an Internet service such as eFax (www.efax.com) or venali (www.venali.com).
Using the Internet

The Internet — home to every bit of knowledge known to humankind, all just a few mouse clicks away. No more paper mail, stamps, and two-week waits. Letters and pictures arrive anywhere in the world instantly, without costing a cent. No more long-distance bills or plain-old voice phones. Now you can see whom you’re talking to, talk all day, and Ma Bell will never even know it. Best of all, it’s legal!

If only there were a way to use all that Internet stuff without having to learn anything first. If only . . . Time to face up to the awful truth — it takes more than an Internet account to use the Internet. Or, put another way, if you don’t know what you’re doing online, you might as well be offline. So guess what Part III is about . . .?
As just about everyone knows, the Internet is an enormous collection of computers connected by cables. The two most widely used services that the Internet provides are e-mail and the World Wide Web. Plenty of other lesser-known services are available, however, such as instant messaging and file-sharing, and you’ll learn about them in this part of the book.

Nobody actually owns the Internet, other than perhaps the American taxpayers who paid for it during the Cold War. On the Internet, there is no censorship — anything goes on the Net. Nobody polices the Internet looking out for your best interests. You need to protect yourself from any threats out there. It’s the Wild, Wild West of the twenty-first century. And if you’re easily shocked, you’ll no doubt find some things pretty shocking out there.

What Is the Internet?

The Internet consists of millions of computers throughout the world, all connected by cables. In networking diagrams, the Internet is always displayed as a cloud, as in Figure 9-1. The cloud is a good symbol for the Internet; just as a cloud is made up of millions of tiny water droplets, the Internet is made up of millions of computers.

You connect to the Internet through a device called a modem (or router) and an ISP (Internet Service Provider). A modem or router is a gadget that connects your computer to a phone line or cable. An ISP is a company that provides the connection between your modem and the Internet.
Your ISP might be MSN, America Online, Comcast, Juno, or any of several hundred other companies. In a sense, it really doesn’t matter, because there is only one Internet. ISPs all basically work the same way. They rent a large amount of bandwidth, say $10,000 or $100,000 a month worth. The lightning bolt in Figure 9-1 represents that expensive high-bandwidth connection. The ISP sells smaller chunks of that bandwidth to lots of customers, with the intent of making a profit.

**What Is Bandwidth?**

Bandwidth, measured in kilobytes per second (Kbps or Kb), is a measure of how much information at a time can be sent through the line that connects your computer to your ISP. For example, a dial-up account tops out at about 48 to 50 kbps. That’s roughly 48,000 to 50,000 bits per second (bps). That sounds like a lot. Since any given file can contain millions of bits, however, it’s really not that fast.

The lower the bandwidth, the longer the wait for things you’ve requested from the Internet. For consumers, accounts generally cost anywhere from $10.00 to $20.00 a month for a 56K dial-up account, to maybe $30.00 or $40.00 a month for a broadband connection. Here’s the difference:

- **Dial-up:** Connection to your ISP goes through a standard modem and traditional telephone lines. (Your phone line is busy if anyone tries to call while you’re online.) The maximum speed of a dial-up account is usually in the 48 to 50 Kbps range. Even though your modem may be rated at 56K, the phone lines can’t move traffic quite that quickly.

- **Broadband:** Connection to your ISP is through cable (the type used by cable TV companies), or special Digital Subscriber Lines (DSL) owned by the phone companies, that can move data at faster than 50 Kbps. You connect to a broadband account using a modem or router. You can get just about any connection speed you want.
A typical broadband cable account moves data at about 750-1,000 Kbps. So wait times are brief. What might take several minutes to accomplish with a dial-up account takes only a few seconds with a broadband account.

**Clients and Servers**

Most of the computers on the Internet at any given time are *clients*. That is, they are consumers of what the Internet has to offer. Your computer is most definitely a client.

Other computers on the Internet are *servers*. Servers provide the services that clients are using. Nobody sits at a server and does work. Rather, the server just sits online and answers requests coming from clients. For example, a *Web server* is a computer that holds a Web site people visit. All day and night, the Web server sends its Web pages to whoever happens to request those pages. That’s the Web server’s only job.

**Online and Offline**

The term *online* means connected to the Internet and ready to use its services. The term *offline* means not connected to the Internet. (That is, the cable connecting your modem to your ISP is not active at the moment.) When you’re online, you have access to *remote resources* and *local resources*. When you’re offline, you have access to *local resources* only.

A *resource* is anything useful. *Remote resources* are things that are not on your computer, but instead are on other computers. You need to be online to access remote resources. Local resources are things that are in your own computer, such as your hard disk, floppy disk, CD drive, and all your files. You have access to local resources any time your computer is turned on. You don’t have to be online to access local resources.

With a dial-up account, you have to make some small effort to get online. I can’t say exactly what that effort will be, because it depends on your ISP. But the typical scenario is that you open some program, and the modem starts to howl and make weird noises. Then you type your user name and password, which identify who you are and verify that you really are that person, because presumably you’re the only person in the world who knows that password.

Once you’re online, you can use the Internet (for example, do e-mail, browse the Web). To go offline, you might have to close the program you initially started. Or you may be able to right-click the little connectoid icon in the notification area (if available) and choose Disconnect. At that point, you’re offline and can no longer use the Internet.

With a broadband account, there’s no such logging in and out. If the computer is on, and the modem is on, you’re online. If the computer is off, or the modem is off, you’re offline. No dialing, no weird phone noises, no signing in. Contrary to popular belief, this is not a bad thing. It’s a good thing, and we’ll talk about why it’s not dangerous to be online all the time in Chapter 13.
Downloading and Uploading

One thing people do a lot of on the Internet is download stuff. The term download means to copy something from some other computer to your own computer. The term upload means the opposite: to copy something from your computer to some other computer on the Internet. To upload, you need to have some sort of space on the Internet to which you can copy files. (More on that later in this part of the book.) For now, it’s sufficient to know the difference between downloading and uploading.

If you envision the Internet as a cloud, it’s easy to keep the terms straight. Download means to copy something down from the cloud onto your computer. Upload means to copy something from your computer up to the cloud.

Getting an Internet Account

Most people who buy a computer just sort of stumble into their first Internet account by double-clicking some icon on their screen. AOL and MSN sell lots of Internet accounts through that method. If you want to be more choosy, you need to do a little homework. If you look up Internet Service Provider in your local yellow pages, you’ll probably find you have lots of companies and account types from which to choose.

For broadband accounts, many people go through their local phone company. That way, the charges just get added to the phone bill, and you don’t have an extra monthly bill to pay. Or, if you already have cable TV, you can probably get a fast cable account through your cable provider. Again, they’ll tack the additional charges onto your cable bill so you don’t have another monthly irritant to contend with.

Although some tools in Windows XP are designed to help you set up an Internet account, the truth is that people rarely need them or use them. The typical scenario is more like this: You choose an Internet Service Provider, and you set up an account with them; then one of three things happens:

✦ Your ISP comes to your house and sets everything up for you (that’s ideal).
✦ Your ISP sends you some sort of instructions, and you follow those instructions to set up your account.
✦ Your ISP sends you some program that you run on your computer, and the program sets up your account.

Because hundreds of ISPs are available, and they don’t all follow a standard set of rules, I can’t give you any more details than those, other than to tell you that your ISP is motivated to make setting up your account as easy as possible, because they’d rather not pay a whole staff of people to sit on the phone lines and talk their customers through the set-up procedure.
Your Network Connections Folder

When you have an Internet account, there’s a little icon called a *connectoid* (connection ID) that represents your connection in your Network Connections folder. If you don’t have an Internet connection yet, but *do* have an account, you might be able to get connected to your ISP through this folder. As I mentioned earlier, however, it’s rarely necessary to do this, because your ISP will try to simplify the process as much as possible.

To get to your Network Connections folder, you can use either or these methods:

✦ Click the Start button and choose All Programs ➪ Accessories ➪ Communications ➪ Network Connections.

or . . .

1. Click the Start button and choose Control Panel.
2. If Control Panel opens in Category view, click Network and Internet Connections under Pick a category. Otherwise, skip this step.
3. Open the Network Connections icon.

Depending on how your Start menu is set up, you might be able to take one of the following shortcuts instead:

✦ Click the Start button and choose Network Connections.

✦ Or click the Start button, and choose My Network Connections; then click View Network Connections under Network Tasks in the Explorer bar.

See “Personalizing your Start Menu” in Chapter 24 if you’d like to add Network Connections or My Network Places to your Start menu.

Exactly what you see in your Network Connections folder depends on what kind of network connections you have. If you have a dial-up account, your connectoid will most likely be represented by some icon under Dial-Up. If you have a broadband account, it will more likely be listed under LAN or High-Speed Internet, as in the example shown in Figure 9-2, where the bottom icon represents my Internet connection.

Your Network Connections folder won’t look exactly like the example shown, unless by some peculiar coincidence you happen to have exactly the same equipment in your computer as I do. (Not likely, since there are thousands of products on the market that allow you to connect to the Internet.) But let me briefly explain what each icon represents.

I have several computers in the house, all connected together in a *local area network* (LAN). The top icon represents this computer’s connection to that LAN. (The only reason I know this is because I installed the CNet PRO200WL modem that the icon represents, and I did so to connect that computer to my LAN.)
I know the bottom icon represents my Internet connection, because I use the RCA USB Cable Modem that the icon represents to connect to the Internet. The part of that icon that reads “Enabled, Shared, Firewalled” means that the modem is on and working (Enabled). The Shared part tells me that the modem is accessible to all the computers in my LAN. That’s so all the computers can be online at the same time with only one Internet account (and one monthly bill). The Firewalled part means that the connection is protected from hackers, a topic we’ll discuss in Chapter 13.

**Putting a Connectoid in the Notification Area**

Like most things computerish, connectoids have properties that define their characteristics. The exact properties provided by a connectoid will vary with your hardware. There’s rarely any need to mess with those properties. If your Internet connection is working, you probably don’t want to go in there and start messing around with things. But there is one option that’s almost universal and sure to be harmless. To get to it, right-click the icon for an icon and choose Properties. The Properties dialog box for that connection device will open, perhaps looking something like the example shown in Figure 9-3.

**Why Is Your Internet Connection Local?**

Earlier, I said that stuff that’s in your computer is local and that stuff outside your computer is remote. So you might wonder why my Internet connection in Figure 9-2 has the name Local Area Connection 4. First of all, I didn’t make up that name. That’s just the automatic name assigned by Windows.

But the reason my cable modem is considered local is because it’s connected to my computer by a cable. That is, the cable modem itself is a local device I can manipulate directly from my computer. Everything beyond that modem is a remote resource.
The harmless universal option is the one that reads Show icon in notification area when selected. If you choose that option, the notification area near the lower-right corner of your screen will show a miniconnectoid icon whenever you're online. Pointing to that icon will likely display information about your connection. Right-clicking that icon will provide a quick shortcut to certain features of your modem, as in the example shown at the bottom of Figure 9-3. Double-clicking the icon will open a Status dialog providing more information and options.

If you have a dial-up modem, the notification area icon will likely give you the option to disconnect from the Internet and go offline. With a broadband account, you can go offline by right-clicking the notification area and choosing Disable, though few people actually bother. Once you know what the threats are and how to protect yourself from them, you can do as I and millions of other folks do, and just leave your computer on and online 24 hours a day, seven days a week, 365 days a year. (More on that in Chapter 20.)

**Troubleshooting a Network Connection**

Before you try to troubleshoot your Internet account, the first thing you need to realize is that much of the information you need is available only from your Internet Service Provider. Windows XP does contain some network troubleshooting tools that might be able to help. But your best resource when it
comes to troubleshooting an Internet connection will always be your ISP, because only they know the specifics of the service they provide.

1. Nonetheless, the Network Troubleshooter just might be able to help. To get to it:

2. Open your Network Connections folder using any of the methods described previously.

3. Under See Also in the Explorer bar, click Network Troubleshooter (see Figure 9-4).

![Network Troubleshooter](image)

**Figure 9-4:** The Network Troubleshooter is accessible from the Explorer bar in Network Connections.

4. Most of the options that appear on the first page of the troubleshooter are for fixing local area networking problems, which can be confusing. For a single computer attached to the Internet through a dial-up, the Modem Troubleshooter is likely to be your best bet. Click that option.

5. On the first page of the Modem Troubleshooter (Figure 9-5), click whichever option best describes the problem you’re having; then click Next.

From this point on, the troubleshooter will ask questions; you provide answers and click Next. The exact pages that follow depend on the choices you make along the way. If the troubleshooter can’t help you resolve the problem, your best bet is to call your ISP.
Summary

Getting your computer connected to the Internet is largely a matter of setting up an account with an Internet Service Provider (ISP) and doing whatever they tell you to do to make the connection work. The main points made in this chapter include:

✦ The Internet is a collection of millions of computers throughout the world, all connected by cables.
✦ Some computers on the Internet act as servers, in that they provide the very services the Internet offers.
✦ Other computers, like yours and mine, are clients, in that they use those services as consumers.
✦ Bandwidth is a measure of how quickly information can get from your ISP to your computer. Low (or narrow) bandwidth means slower traffic and more wait time. Broadband offers higher speeds and less wait time.
✦ Your Network Connections folder holds the icon that represents the modem (or router) you use to connect to the Internet.
✦ The Network Connections folder also provides access to the Network Troubleshooter, which can help with a problematic Internet connection.
✦ When it comes to troubleshooting a network connection, your ISP is your best resource, because only they know the specifics of the service they provide.
Browsing the World Wide Web

The Internet offers many services, including the wildly popular World Wide Web (the Web). The Web provides an easy point-and-click interface to a vast amount of information, free software, technical support, and just plain fun. Even if you haven't actually been on the Internet yet, you've undoubtedly seen Web-site addresses — those www.whatever.com things — in ads, letterhead, or elsewhere. In this chapter, you'll learn how to get to those addresses and much more about using the Web.

I mention in Chapter 9 that most of the computers on the Internet are clients, while others are servers. Server computers that serve up Web pages to Internet clients are called Web servers. Each Web server is host (home) to one or more Web sites. A Web site is one or more pages of information that has a unique address on a Web server. That address is often called a URL (for Uniform Resource Locator). Most URLs look something like www.something.tld or http://something.something.tld, where something can be any name and tld is one of the top-level domains shown in Table 10-1.

When you first enter a Web site, you’re taken to that site’s home page. From that page, you’ll find links to other pages within the same site or even links to pages in other Web sites.
Table 10-1
Examples of Top-Level Domains and URLs of Web Sites

<table>
<thead>
<tr>
<th>Top Level Domain</th>
<th>Type</th>
<th>Example URL</th>
</tr>
</thead>
<tbody>
<tr>
<td>.com</td>
<td>Commercial</td>
<td><a href="http://www.amazon.com">www.amazon.com</a></td>
</tr>
<tr>
<td>.edu</td>
<td>Education</td>
<td><a href="http://www.sdsu.edu">www.sdsu.edu</a></td>
</tr>
<tr>
<td>.gov</td>
<td>Government</td>
<td><a href="http://www.fbi.gov">www.fbi.gov</a></td>
</tr>
<tr>
<td>.org</td>
<td>Nonprofit organization</td>
<td><a href="http://www.redcross.org">www.redcross.org</a></td>
</tr>
<tr>
<td>.net</td>
<td>Network</td>
<td><a href="http://www.comcast.net">www.comcast.net</a></td>
</tr>
<tr>
<td>.mil</td>
<td>Military</td>
<td><a href="http://www.army.mil">www.army.mil</a></td>
</tr>
</tbody>
</table>

Using Microsoft Internet Explorer

To use the Web, you need two things: an Internet connection and a Web browser. The latter is a program that lets you access the World Wide Web. Several makes and models of Web browsers are on the market, including Microsoft Internet Explorer, MSN Explorer, America Online, and Netscape Navigator. If you’ve already been browsing the Web, you’ve probably been using one of those Web browsers.

In a sense, all Web browsers are the same. You type some URL and press Enter. The Web browser fetches the Web page at that URL from the Internet and displays it on your screen. All browsers access the same Web and Internet, and they generally work with whatever Internet connection is available.

The main Web browser that comes with Windows XP is called Microsoft Internet Explorer, often abbreviated IE or MSIE. Internet Explorer’s icon looks like a blue lowercase e, as in the example shown at left. Since Internet Explorer is a Web browser, your computer has to be online to use it. So if you have a dial-up account and want to start IE, you may need to get online before opening Internet Explorer. Just go ahead and connect to the Internet in whatever way you normally do. Don’t disconnect or go offline before starting Internet Explorer. (Broadband users don’t have to do anything before starting Internet Explorer.)

When you’re online, you can start Internet Explorer using whichever of the following methods is available and most convenient at the moment:

✦ Click the Launch Internet Explorer Browser button (e) in the Quick Launch toolbar.
✦ Double-click the Internet Explorer icon on your desktop.
✦ Click the Start button and choose Internet Explorer from the left side of the Start menu.
✦ Click the Start button and choose All Programs ➪ Internet Explorer.
Assuming you’re online, Internet Explorer will open and take you to your default home page. That’s just the fancy name for the first Web page you see when you open your Web browser. As we’ll discuss later in this chapter, you can make any Web page you want your default home page.

Tip
You can move and size Internet Explorer’s program window as you would any other. When open, Internet Explorer will also have a taskbar button.

Getting to a Web Site

To get to a Web site, you type its URL into Internet Explorer’s Address bar. When you click the URL that’s already in the Address bar, that URL is automatically selected (highlighted), as in the example shown in Figure 10-1.

![Internet Explorer's Address bar](image)

**Figure 10-1:** Internet Explorer’s Address bar, with the URL selected.

Any new text you type will automatically replace the selected text. So it’s not necessary to press Backspace or Delete before typing a new URL.

Tip
If the URL starts with http://www, you don’t have to type the http:// part.

Using AutoComplete

Internet Explorer will remember URLs you’ve typed in the past. When the URL you’re typing now matches ones you’ve typed in the past, a history menu will drop down, showing those previous URLs. When that happens, you can:

✦ Ignore the menu and keep typing. Each new character you type will reduce the number of items in the menu to those that match what you’ve typed so far.
✦ Click any item URL in the history menu to put it into the Address bar.
✦ Point to an item in the history menu and press Delete (Del) to delete that item.

You can empty the history menu at any time by clicking the Clear History button in Internet Explorer’s Internet Options dialog box, as discussed later in this chapter.
The AutoComplete feature is optional. To turn it on or off, choose Tools ➪ Internet Options from Internet Explorer’s menu bar. Click the Advanced tab. Under the Browsing category in the list that appears, you can click the checkbox next to Use Inline AutoComplete to turn this feature on (checked) or off (not checked).

**Changing a URL**

If you want to change the current URL rather than replace it, don’t type anything. Instead, point to the place within the selected URL where you want to type changes. Then click the spot to put the cursor there. When you see the cursor, you can start making your changes using standard text-editing techniques.

**Copy and Paste a URL**

When somebody sends you a URL via some sort of text message, like certain e-mail messages and discussion boards, the text won’t be a hyperlink. That is, it won’t be colored or underlined, and clicking it will do nothing. When that happens, it’s not necessary to retype the URL into your browser’s Address bar. You can use standard copy and paste to copy it. Here’s how:

1. Start with the mouse pointer just outside the URL; hold down the left mouse button, and drag the mouse pointer through the URL. Make sure the whole URL, and nothing but the URL, is selected, as in the example that follows.

```
http://oposite.stsci.edu/psinfo/spacecraft/Primer/Top_Findings.html
```

2. Press Ctrl+C or right-click the selected text and choose Copy.

3. Click in your Web browser’s Address bar, or drag the mouse pointer through the URL that’s currently in the Address bar, so all text is selected.

4. Press Ctrl+V to paste. The URL you copied replaces the selected text in the Address bar, as in the following example.

```
http://oposite.stsci.edu/psinfo/spacecraft/Primer/Top_Findings.html
```

5. Press Enter or click the green Go button.

That’s all there is to it.
See the section “Changing Text in a Textbox” in Chapter 2 for standard text-editing techniques.

Once you’ve entered a valid URL and pressed Enter or clicked the Go button, the icon near the upper-right corner will spin to let you know the page is coming. The status bar at the bottom of the screen will present messages to inform you of the browser’s progress. When the Done message appears in the left side of the status bar at the bottom of the browser, the page is fully loaded.

Tip: If you don’t see the Address bar or status bar in Internet Explorer, choose View ➪ Toolbars; then choose the name of any unchecked toolbar you want to see.

Weird Ways to the Web

There are a couple of other ways to get to a Web site besides using Internet Explorer’s menu bar. As you may recall from Part I of this book, Windows Explorer is the program that lets you explore the contents of your own, local computer. Internet Explorer is the program you use to explore resources on the Internet, outside your computer.

If you happen to be in Windows Explorer, and its Address bar is visible, you can type a URL right into the Address bar and press Enter. Windows Explorer will magically turn into Internet Explorer. Clicking the Back button in the toolbar will take you back to Windows Explorer. (If you don’t see an Address bar in Windows Explorer, choose View ➪ Toolbars ➪ Address bar from its menu bar.)

You can also place an Address bar in your taskbar and just type any URL there. First, right-click an empty area of the taskbar or the current time and choose View ➪ Toolbars ➪ Address. An Address bar appears on the Windows taskbar. If you can see only its label, you’ll need to unlock the taskbar and widen the bar, as in Figure 10-2. Or you can drag it up to the desktop and make it a free-floating toolbar. See the section “Personalizing Your Taskbar” in Chapter 24 for details.

Figure 10-2: An Address bar in the Windows taskbar

Once the Address bar is in place, you can type any URL and press Enter or click the Go button to go to a Web site. Your Web browser will open to display the Web page.

Tip: To copy the URL that’s currently in your Address bar to an e-mail message, or any other document, click the URL so the whole URL is selected; then press Ctrl+C. Click where you want to paste the URL; then press Ctrl+V or right-click the spot and choose Paste.
Navigating the Web

When you’re at a Web site, you may not have to do much more typing of URLs. After you’re at a page, you can click any hyperlink (also called a link) to go to whatever page the link represents. Hyperlink text can be anything — it need not be a URL. But it will most likely be underlined and either blue or magenta. Blue indicates a link to a Web page you’ve never visited. Magenta identifies pages you’ve already visited.

A picture, or even a portion of a picture, can be a hyperlink too. You can’t tell just by looking whether a picture is a hyperlink or not. You have to point to it. If the mouse pointer changes to a hand, as in any of the examples shown in Figure 10-3, it’s a hyperlink. The hand means click here to go. If the status bar in your Web browser is turned on, the URL that the hyperlink will take you to appears in the lower-left corner of your browser window, as shown in the same figure.

Figure 10-3: Pointing to hyperlinks, and Internet Explorer’s status bar

Using Hyperlinks

When you know the mouse pointer is touching a hyperlink, you just click (tap the left mouse button) to follow the hyperlink (that is, to go wherever the hyperlink points you). When you get to the new page, you can click the Back button in your Web browser to return to the page you just left. More on the Back button a little later in this chapter.

Opening a Page in a New Window

If you want to keep the Web page you’re viewing at the moment visible on the screen, and also go to a linked page, don’t click the hyperlink. Right-click it instead and choose Open in New Window from the shortcut menu that opens (see Figure 10-4). The Web page will open in a new Internet Explorer browser window, which you can move and size independently of the first.

For example, when you have two browser windows open, you can right-click the current time and choose Tile Windows Vertically to put the browser windows side by side. Or choose Cascade Windows from that same menu to stack the browser windows like sheets of paper.
Right-clicking a hyperlink

If you open lots of separate Internet Explorer program windows, their taskbar buttons may combine into one button. You can click that one large taskbar button to see a menu of all open Web pages. Click any page in the menu to bring that Web page to the top of the stack.

If you get lots of pop-ups, and want to close all open Web pages in one fell swoop, right-click Internet Explorer’s taskbar button and choose Close Group. See “Closing Multiple Windows” in Chapter 4 for an example.

Other Hyperlink Tricks

There are quite a few items on the shortcut that opens when you right-click a hyperlink. First, let me point out that in the menu, the word page means the Web page you’re currently looking at. The word target refers to whatever the hyperlink points to. For example, if clicking the hyperlink displays a video, target refers to that video. If clicking the hyperlink takes you to a Web page, target refers to that Web page you’d land at. So with that in mind, here’s what the options in the shortcut menu (shown in Figure 10-4) offer:

✦ **Open:** Opens the resource that the link refers to. (It’s usually another Web page, but it could be a movie, song, picture, or file you download — anything.)

✦ **Open in New Window:** As mentioned previously, opens the resource in a new, separate Internet Explorer window.

✦ **Save Target As:** Rather than showing you the resource, this option opens the Save As dialog box so you can download the resource to your own hard disk. (That is, you can download the resource. More on downloading later in this chapter.)

✦ **Copy:** You can select text on a Web page and copy that. Or you can right-click a picture on a Web page and copy that. But you can’t copy a hyperlink. So this option is disabled on hyperlinks.

✦ **Copy Shortcut:** Creates a shortcut to the target resource, which you can then paste to the Windows desktop or into any folder (right-click the spot and choose Paste Shortcut).
Cut and Paste: You can’t edit other peoples’ Web pages (and they can’t edit yours). So the Cut and Paste options are disabled, as they would allow you to edit the page.

Add to Favorites: Creates a favorite to the target resource. See the section “Tracking Favorite Web Sites,” later in this chapter.

Properties: Shows general information about the link, including the URL that the hyperlink points to.

Other Navigation Tools

The Standard toolbar in Internet Explorer, shown in Figure 10-5, provides some handy tools to help with your browsing. (If the standard buttons aren’t visible, choose View ➪ Toolbars ➪ Standard buttons from Internet Explorer’s menu bar.) Looking at the first few buttons, going left to right, you have:

- Back: After you’ve navigated from one page to another, you can click the Back button to return to the previous page.
- Forward: After you’ve clicked the Back button at least once, you can click the Forward button to return to the page you just backed out of.
- Stop: If a page is taking too long to load, or you think you clicked the wrong link, clicking the Stop button will stop the download and make it easier to navigate back to the preceding page or another page.
- Refresh: Redownloads the current page from the Web server so you can see recent changes to that page.
- Home: Takes you to your default home page.

The Back and Forward buttons are session-specific. A session begins when you first open your Web browser and ends when you close the browser. So when you first open your browser, both Back and Forward will be disabled, because you haven’t been to any other pages yet in this session. But as you navigate around, the Back and Forward buttons will let you easily move among those pages you’ve visited during the current session.

Behind the Scenes

As you browse the Web, you might get the impression that you’re viewing Web pages from afar — on computers outside your own on the Internet. That’s true to some extent. But here’s how it really works. When you type a URL and press Enter, your Web browser sends a tiny packet of information to the Web server that says “Send your Web page to me.” The Web server obeys and sends its Web page across the net, right into your modem and computer.
As the Web page arrives, your Web browser writes it a file in your Temporary Internet Files folder. What you see on your screen is that downloaded file. In other words, by the time you see the whole Web page, you’re looking at a copy on your computer. You’re not even connected to the Web server any more.

When you click the Back button to return to a page you were just at, Internet Explorer doesn’t bother to download that page all over again. Instead, Internet Explorer just pulls the cached copy out of your Temporary Internet Files folder file and shows that on your screen. That’s much quicker than downloading it from the Web server again. It also reduces Internet traffic a lot, because there are millions of peoples navigating around through Web pages every minute of every day.

**Refreshing a Page**

The one drawback to using cached copies of Web pages is that if the original page changes while you’re viewing your cached copy, those changes won’t be reflected in the copy you’re viewing. It’s pretty unlikely that a Web page is going to change dramatically during one of your browser sessions. But if you suspect a page you’re viewing at the moment might be out of date, click the Refresh button in the toolbar. That tells Internet Explorer, “Go get the current copy of this Web page off the Internet, and replace my cached copy with the new copy.”

**Printing a Web Page**

To print the Web page you’re currently viewing, use any of the standard techniques for printing documents. That is, press Ctrl+P, or click the Print button in Internet Explorer’s toolbar, or choose File ➪ Print from Internet Explorer’s menu bar.

**Tip**

To copy chunks of text and pictures from Web pages to a new document that you can edit and print independently, see the section “Copying, Moving, and Pasting Text” in Chapter 7.

Some Web pages are divided into frames — multiple sections that you can scroll through independently. Some frames might contain ads or a table of contents, or something else you don’t particularly want to print. If you want to print the contents of just a single frame within a page, anywhere in the text within that frame first, you can press Ctrl+P or choose File ➪ Print, or right-click the text and choose Print to bring up the Print dialog box. When the Print dialog box opens, click its Options tab to reveal the options shown in Figure 10-6.

To print only the frame you clicked in, choose the Only the selected frame option. You could also choose All frames individually to ensure that each frame’s content is printed on a separate page.
Be careful of the Print all linked documents option. It prints the current Web page, plus all the Web pages that this page provides links to. It could end up being a heck of a lot of pages if the current page contains a lot of links. As an alternative, you can choose the Print table of links option, which will print just the hyperlinks in the page without printing the actual pages to which those links refer.

If some text is cut off at the right margin, even after printing individual frames, try narrowing the margins by choosing File ➪ Page Setup from Internet Explorer’s menu bar. Set the left and right margins to some small number, like 0.5.

Revisiting Previous Sites

Internet Explorer keeps track of all the sites you’ve visited in the current session and previous sessions. As mentioned, when you type a URL into the Address bar, URLs of sites you’re recently visited appear in the drop-down menu. You can also view a history of recently visited sites using any method that follows:

✦ Choose View ➪ Explorer Bar ➪ History from Internet Explorer’s menu bar.
✦ Press Ctrl+H.
✦ Click the History button in the Standard buttons toolbar, shown with the mouse pointer on it in Figure 10-7.

The History bar appears at the left side of Internet Explorer’s program window as in Figure 10-7.
Using the History Bar

Using the History bar is simple. Click any heading to expand or hide the items beneath that heading. For example, in Figure 10-7 I click the Today heading and Google favorite. I’m pointing to a page icon that reads Google and can see the URL in the tooltip. Clicking that favorite takes you to the Web page.

Notice the little toolbar near the top of the History bar. If you want to rearrange the list, click the View button. On the menu that appears, click a new sort order, such as By order visited today.

To search through your history list for Web pages that contain some keyword, click the Search button. Under Search For in the box that opens, type any word or phrase; then click Search Now. The resulting list of pages will contain your search text. You can use the View button to rearrange those results. To get back to seeing all items in the history, click the View button and choose any view.

Closing the History Bar

To close the History bar, do any of the following:

✦ Click the X in the upper-right corner of the History bar.
✦ Click the History button in Internet Explorer’s toolbar.
✦ Press Ctrl+H.

Closing the History bar doesn’t change its contents in any way. It just gets the History bar off the screen and out of your way. You can reopen the History bar at any time.
Getting Rid of Cookies, Files, and History

So while you’re browsing around the Web, Internet Explorer is keeping track of where you’ve been in a couple of ways. For one, it’s keeping track of every URL you’ve been to and putting it your history list. For another, it’s putting a copy of every Web page you visit in the Temporary Internet Files folder on your hard disk, making a copy of every Web page you visit. It’s also keeping track of many, if not all, of the pages you’ve visited in your Temporary Internet folder. And there’s a third way Internet Explorer can keep track of your doings: through cookies.

The name *cookies* comes from an old story where some kids decide to explore some spooky forest or something. To make sure they can find their way back, they leave a trail of cookie crumbs. This turns out to be a bad idea, because animals eat the crumbs. But that part’s not relevant to cookies on the Internet. The idea of leaving a trail behind is the only part that matters.

An Internet cookie is a tiny text file in a folder named Cookies on your hard disk, placed there by some Web site to act as sort of a crumb trail to your computer. Some cookies are *session cookies*, also called temporary cookies. Session cookies exist only for the duration of the current browsing session. As soon as you close your Web browser, all session cookies vanish. A *persistent* cookie stays on your hard disk, even after you close your Web browser.

Some cookies, which go by the highly technical name of *unsatisfactory cookies*, are put on your computer by third-party Web sites. These Web sites are often advertisers who track the type of Web sites you visit, sending you ads according to your browsing habits. In other words, they invade your privacy. You can regain your privacy at any time by deleting your history, your temporary files, your cookies, or any combination thereof. Here’s how:

1. From Internet Explorer’s menu bar, choose Tools ➪ Internet Options.
2. On the Internet Options dialog box that opens, click the General tab as in Figure 10-8. The rest is fairly obvious:
   - To delete cookies, click the Delete Cookies button; then click OK.
   - To delete temporary Internet files, click the Delete Files button; then click OK.
   - Optionally, you can click the Settings button to specify how Internet Explorer handles temporary files (though the default settings are usually fine).
   - To clear your history of visited sites, click the Clear History button.
   - Optionally, use the Days to keep pages in history button to adjust how long a history list you want Internet Explorer to maintain.
3. Click OK after making your selection(s) in the dialog box.
Figure 10-8: The General tab of the Internet Options dialog box

Changing your Default Home Page

As you may recall, the first Web page you come to when you open Internet Explorer is referred to as your default home page. Most likely, you’re going to want to change your default home page to something you really do need to visit often. For example, if you search the Web a lot using Google, you might want to make Google your default home page. To define a new default home page:

1. In Internet Explorer, go to the page you want to make the new default (for example, www.Google.com).
2. Once you’re at the page, choose Tools ☐ Internet Options from Internet Explorer’s menu bar.
3. Click the General tab as shown in Figure 10-8; then click the Use Current button.
4. Click OK in the Internet Options dialog box.

From now on, whenever you open Internet Explorer, you’ll first be taken whatever page you navigated to in Step 1.

Tracking Favorite Web Sites

As you follow links and explore the Web, you’re sure to find sites you’ll want to revisit. You can make the return trip easier by adding the site to your Favorites while you’re there. Here’s how:
1. While viewing the page you want to add, choose Favorites ➪ Add To Favorites from Internet Explorer’s menu bar. You’ll see the Add Favorite dialog box, shown in Figure 10-9.

2. Type a name for this favorite item or accept the suggested name.

3. Click the OK button.

As a shortcut, you can go to the page you want to add to Favorites and then press Ctrl+D. Internet Explorer adds the page to your Favorites list without displaying the Add Favorite dialog box.

![Add Favorite dialog box](image)

**Figure 10-9:** The Add Favorite dialog box

---

**Viewing Your Favorite Sites**

To return to a favorite site, you need not retype its URL. Instead, you can just use any of the following techniques to view your collection of favorites; then click the site you wish to visit:

- In Internet Explorer, click the Favorites button in the toolbar to view the Favorites bar.
- Press Ctrl+I.
- Choose View ➪ Explorer bar ➪ Favorites from Internet Explorer’s menu bar.
- Click Favorites in Internet Explorer’s menu bar; then click the name of the site you wish to visit.
- Click the Start button and choose Favorites from the right side of the Start menu.

If your Start menu doesn’t offer a Favorites option, see “Personalizing Your Start Menu” in Chapter 24.

If you use one of the first three options, the left side of Internet Explorer’s program window will display your favorites, as in Figure 10-10.

![Favorites window](image)

If your Start menu doesn’t offer a Favorites option, see “Personalizing Your Start Menu” in Chapter 24.

Items in the list with manila file folder icons are folders. Clicking a folder opens it, so you can see the favorites within the folder. Clicking a folder a second time closes it again. All the other icons represent favorite Web sites. Clicking a favorite takes you straight to that Web site.
To move an item in the favorites list, just drag it to some location. That is, point to the item you want to move, hold down the left mouse button, drag the item to its new position, and release the mouse button.

**Organizing Your Favorites**

As your collection of favorites grows, you might want to organize it into folders. That way, you won’t be faced with a huge list of favorites each time you open your Favorites bar. To organize your favorites, click the Organize button at the top of the Favorites bar. Or choose Favorites ➪ Organize Favorites from Internet Explorer’s menu bar. Either way, you’ll be taken to the Organize Favorites window shown in Figure 10-11.
The left side of the dialog box provides instructions, buttons, and information. The right side shows you your current folders (all with folder icons) and favorites.

Creating a Favorites Subfolder

The first step to creating a subfolder is to make sure you’re at the right level within the hierarchy. For example, if you want to create a folder at the same level as the folders you first see, you have to make sure the highlighter is either on a closed (not expanded) folder icon or on a specific favorite icon, as on the left side of Figure 10-12. On the other hand, if you want to create a subfolder within an existing folder, you need to open that parent folder first. For example, if you want to create a subfolder within an existing folder, you first have to open that parent folder by clicking it. On the right side of Figure 10-12, I’ve opened the Computer Stuff folder. So if I were to create a folder there, it would be a subfolder within Computer Stuff.

Assuming you’re in that Organize Favorites window, here are the steps to creating a new folder for your favorites:

1. If you want to create a subfolder within a folder, open that folder by clicking its name. Otherwise, make sure the highlighter is on a closed folder or favorite icon.

2. Click the Create Folder button. A folder named New Folder appears, its name selected and ready to be edited.

3. Type a name for the folder, and press Enter.

That’s all there is to it.

Moving, Changing, and Deleting Favorites

To move a favorite or folder icon in Organize Favorites, you can just drag it and drop it wherever you want to place it. If you want to move an item into a folder you’ve created, you can just drag the item and drop it right onto the folder’s icon. Or you can click the item you want to move and click the Move to Folder button. In the Browse for Folder dialog box that opens, click the
name of the folder to move the favorite to. If you’re trying to pull the favorite out of a folder back up to the first list, click Favorites at the top of the folder list. Click the OK button.

To change the name of a favorite or folder, click the item; then click the Rename button. Or right-click the item and choose Rename. The name will be selected (highlighted). Type the new name, or edit the existing name using any of the standard text-editing techniques. To edit, you’ll need to position the cursor by clicking the spot where you want to put the cursor or by pressing the ← or Home key to move the cursor to the left. Press Enter when you’re done.

To delete a favorite or folder, click its name; then click the Delete button, or press the Delete (Del) key on your keyboard. Optionally, you can right-click the item and choose Delete. If asked “Are you sure . . .?” choose Yes.

If you delete a favorite or favorite folder by accident, you can get it back by restoring it from the Recycle Bin. See “Using the Recycle Bin” in Chapter 19 for details.

Starting Your Favorites Collection

If you’re new to the Web and want to visit some useful Web sites that you might want to add to your favorites, here’s a few to help you get started. Not everyone will want to add all of these to his or her favorites, of course. But you’re likely to find some sites you’ll want to revisit:

✦ www.Dictionary.com: Look up a word in a dictionary or thesaurus, or translate text from one language to another.
✦ www.fandango.com: Find out what movies are playing in your local theaters, their start times, and so forth.
✦ www.OnlineConversion.com: Convert all types of measurements, such as feet to meters or gallons to ounces.
✦ www.USPS.com: The United States Postal Service, including a Calculate Postage option to figure out the cost of shipping an item.
✦ www.WindowsCatalog.com: A catalog of hardware and software products for Windows XP.
Closing Up Favorites

To close the Organize Favorites window, just click its Close button. To close the Favorites bar, click the Close (X) button in its upper-right corner. Or click the Favorites button in Internet Explorer’s toolbar, or press Ctrl+I.

Choosing and Creating Favorites Folders on-the-Fly

The Organize Favorites window is good for organizing favorites you’ve already created. You can also create folders, and put new favorites into folders, on-the-fly. For example, let’s say you’re at a Web page you want to add to your favorites. Choose Favorites ➪ Add to Favorites from Internet Explorer’s menu bar, and the Add Favorite dialog box opens. If you click the Create In button in that dialog box, you’ll see the extra options shown in Figure 10-13.

Figure 10-13: The Create In options visible in Add Favorite

To put the favorite you’re about to save into an existing folder, just click the name of the folder and click OK. If you want to create a new folder, you have to think about where you want to put it. If you want to put it at the same level as Links and any other folders, click Favorites at the top of the list first. But if you want to create a subfolder within one of your existing folders, click the parent folder’s name first. Then click New Folder button, type a folder name, and click OK.

Creating Desktop Shortcuts to Web Pages

You Favorites folder isn’t the only place you can store links to favorite Web sites. You can put a shortcut icon to a Web site right on your Windows desktop. That way, to revisit the site, you don’t even need to open your Web browser. Just double-click the site’s icon on your desktop and you’re on your way. The first step is to get to the Web site using Internet Explorer. Then do whichever of the following is most convenient at the moment:
Choose File ➪ Send ➪ Shortcut to Desktop from Internet Explorer’s menu bar.

Drag the tiny icon in the upper-left corner of Internet Explorer’s program window out to the desktop and drop it there (see Figure 10-14).

Figure 10-14: Create a desktop shortcut by dragging.

When you’re at the Windows desktop, you can just double-click that new icon to open your Web browser and get to the Web page that the icon represents.

General Browsing versus Secure Browsing

Browsing the Web is usually a very anonymous endeavor. When you visit a Web page, the Web server that sent you a page has no idea who you are, where you are, what type of computer you have, or anything else. All the Web server can do is hand the Web page off to the Internet and assume it will get to you. You are completely anonymous to the Web site.

When you shop online, you need to enter some personally identifiable information, such as your name, address, e-mail address, and maybe even credit-card information. In other words, you need to enter some information that you don’t necessarily want to make public. While it’s extremely unlikely that any information you transfer over the Internet would ever become public, a highly knowledgeable Internet nerd could grab some information off the Internet and dig around it looking for credit-card information and such.

To be absolutely sure that it’s impossible (not just remotely possible) for your credit-card information to be lifted off the Internet, legitimate businesses use a technology know as Secure Sockets Layer (SSL) to encrypt sensitive information as it crosses the Internet. In the unlikely event that someone does get a hold of that encrypted information, it won’t do them any good. They’ll only see a bunch of meaningless gobbledygook, and there’s no way to decipher that information into anything useful. Only the Web site that you’re dealing with can make sense of the encrypted information.

To alert you to when you are entering, or leaving, a secure site, Internet Explorer displays a couple of little messages on your screen. First, let me point out that the URL for a general, anonymous Web site usually begins with the letters
http://, where http stands for Hypertext Transfer Protocol. The URL of a secure site, where it’s safe to send sensitive information, usually starts with the letters https://, where the s stands for secure.

When you leave a general http:// site and are about to enter a secure https:// site, Internet Explorer shows the Security Alert message at the left side of Figure 10-15. What the message is really saying is, “You’re about to enter a secure site, so if they ask you for sensitive information, like a credit card, it’s safe for you to provide that.” When you leave a secure (https://) site and are about to go to a regular http:// site, the Security Alert on the right of that same figure appears. The purpose of the second message is really just to tell you “You’re not on a secure Web site anymore. So if you’re asked for sensitive information like a credit-card number, there’s a remote possibility that someone could intercept and use that information.”

![Security Alert](image)

Figure 10-15: Security alerts for entering (left) and leaving (right) a secure connection.

When you start shopping online, setting up special accounts, and so forth, you’ll see the two security alerts often, because there are lots of unsecured, general-information type pages (http://) on the Web and lots of secured ones (https://) too. If you get sick and tired of seeing these same two messages over and over again, just click the In the future, do not show this warning option before you click the OK or Yes button.

When you start downloading files from the Web, you’re likely to come across other types of security warnings. We’ll discuss those in the downloading section later in this chapter.

### Searching the Web

The World Wide Web contains just about all public knowledge. You can find anything on the Web, you just need to know how to look for it. Internet Explorer offers you several ways to search for information on the Internet. Perhaps the handiest is the built-in Search Explorer bar. To use it, click the Search button on the Standard Buttons toolbar, or press Ctrl+E, or choose View ➤ Explorer Bar ➤ Search from the menu bar. (You can use all of the same techniques to close the Search bar.)
It’s difficult to say exactly what your Search bar will look like. The default in Internet Explorer is called the Search Assistant, shown on the left in Figure 10-16. But your Search bar might look completely different. For example, it might be a bar titled Search Companion, or it might be a bar for a specific search engine, such as the example on the right side of Figure 10-16.

Changing the Default Search Bar

If you don’t want to leave your default Search bar to chance, here’s how to change it. Make sure the Search bar is open. If you don’t see a Customize button at the top of the Search bar, skip the rest of this paragraph and move on to the next. Otherwise, click that Customize button. In the dialog box that opens, click Use Search Assistant; then click Resent; then click OK. Close Internet Explorer. The next time you start the Internet Explorer and open the Search bar, you’ll see the Search Assistant (you don’t need to read the rest of this sidebar).

If you see Search Companion at the top of the Search bar, but no Customize button, click Change Preferences in the bar. Then click Change Internet search behavior, choose With Classic Internet Search, and click MSN as the default Search engine; then click OK. Close Internet Explorer. When you reopen Internet Explorer and open the Search bar, you’ll see the Search Assistant.

Figure 10-16: The default Search bar (left) and one of many other Search bars (right)
To search the Web using the Search Assistant, first choose a category that narrows down the type of information you’re looking for, as follows:

✦ **Find a Web page**: Use this to search the World Wide Web for pages that contain some word or phrase. This is similar to using a search engine such as Google to search the Web.

✦ **Find a person’s address**: Helps you find a person’s mailing address or e-mail address. Searches the Bigfoot and InfoSpace directory services on the Internet.

✦ **Find a business**: Helps you locate a business by name or category, using the InfoSpace directory service.

✦ **Find a map**: Searches the Encarta and Mapquest Web sites for a map of any address or landmark you specify.

✦ **Look up a word**: Lets you look up any word in the encyclopedia, dictionary, or thesaurus, using Encarta on the Internet.

✦ **Find a picture**: Searches [www.corbis.com](http://www.corbis.com) for pictures and photographs. These are not freebies. You’ll find a lot more pictures if you use the Find a Web page option to search for pictures.

✦ **Previous searches**: Use this option when you want to search within a previous search to try to narrow those search results by more keywords.

When you click a category, the options beneath the categories will change to reflect your selection. But for the sake of example, let’s say you choose the Find a Web page option. The next step is to type the word or phrase you’re looking for.

The more specific you are when entering your search text, the better off you’ll be. For example, if you search for just the word Mustang, you’ll get links to about a zillion Web pages that have the word mustang in them, including Web pages about the horse breed, the car, and any other page that happens to contain that word. However, if you search for Ford Mustang, that will narrow it down considerably. If you search for 1966 Ford Mustang convertible, that will narrow it down even more. The more specific you can be, the better results you’ll get.

Once you’ve typed the word or phrase you want to search for, click the Search button. After a brief delay, you’ll see a message indicating how many relevant Web pages were found, followed by titles of Web pages. The right pane shows the same information, but with a little snapshot of each page, so you can get a sneak peek before you decide whether or not to visit the site. As usual, you can click any underlined text or any Web-site preview picture to visit that site.

At the bottom of the first page of links, you’ll see a Next >> button (see Figure 10-17) that you can click to get to more found links.
Spelling counts big-time in searches. The search is based on exactly the characters you type into the Find a Web page containing text box. If a search results in nothing, click the New button and check your spelling. If you don’t find what you’re looking for, you can click the New button at the top of the Search bar and try a different search. If you don’t find anything, check to make sure your spelling is correct.

Searching without the Search Bar

The World Wide Web is home to many search engines. These are Web sites that regularly scan the entire World Wide Web for new pages and then create an index to those pages, similar to the index in the back of a book. Since the Web contains billions of pages, the index is enormous — somewhere along the lines of an index for a million different books. There are lots of search engines to choose from, including www.google.com, www.altavista.com, www.yahoo.com, www.infoseek.com, www.lycos.com, and www.hotbot.com, just to name a few.

Quite a few search engines actually use Google as their index source. Google is one of the more popular search engines on the Internet. People often use its name as a verb, as in “I googled <some word or phrase>.” In English, that translates to “I went to www.google.com and searched for <some word or phrase>.” To get to Google, just type its URL (www.google.com) into your Web browser’s Address bar and press Enter.
Once you get to Google’s home page, type the word or phrase you’re looking for into the Search box; then click the Google Search button. After a few seconds, you’ll see the results of your search, as in the Example shown in Figure 10-18, where my search resulted in 86,900 matching Web pages. Each underlined title is a hyperlink that you can click to visit the referenced page. If there are multiple results, you’ll find links for accessing other pages at the bottom of the current page.

In Google’s search results, you can use the tabs above the links to narrow the search results to certain types of results. For example, clicking the Images tab takes you to pictures that relate to the search text. Clicking the News tab displays news articles that relate to the search text.

If your searches keep producing thousands, or millions, of pages and you want to try to get things narrowed down, you can use Google’s Advanced Search. Just return to Google’s home page at www.google.com, click the Advanced Search link near the top of the page, and fill in the blanks on the form that appears.

**Downloading from the Web**

*Downloading* means copying a file from the Internet to your own PC. There’s tons of stuff you can download — programs, updates to existing programs, documents, music, video — you name it. Exactly how you do a download really depends on what you’re downloading from where. (Things can just never be simple, ya know?)
Downloading and Installing Programs

As you learn in Part 1 of this book, programs are tools you use to open, edit, and create documents. All the programs currently installed on your computer are accessible from your All Programs menu. When you download a program from the Internet, it’s not sufficient to just download a file. You also have to install the program. The installation process configures the program to run on your system and adds a startup icon for the program to your All Programs menu (and possibly a shortcut icon to your desktop).

Chapter 25 of this book talks about general issues to take into consideration before installing any program. I briefly summarize those issues as follows; refer to Chapter 25 for details:

✦ Consider creating a Restore Point before installing any new software (program) or hardware. The advantages to doing so are discussed in the section “Playing It Safe with Installations” in Chapter 25.

✦ Close all programs currently open (except your Web browser in this case), and save any work, if prompted. It’s not necessary to close little programs whose icons appear only in the notification area.

✦ Just downloading a program isn’t enough to get it working on your computer. You have to install the program as well, as explained shortly.

✦ Be careful of free programs. Many such programs make their money from advertising revenues they generate by allowing pop-up ads on your screen. Lots of irritating, never-ending pop-ups.

To download a program, start with some link on some Web page that gives you access to the program. There are plenty of sites that let you download software; www.tucows.com and www.microsoft.com/downloads are two that pop into mind right off the bat. Or let’s say you need to download and install Adobe Acrobat Reader, so you go to www.adobe.com, find, and click the link shown at left.

Once you’ve clicked the link that begins the download process, you’ll need to follow any instructions that appear on the screen. I can’t help you much with that, because there’s no standard set of rules that all Web sites follow. But it should be a simple matter of filling in some blanks and answering some questions.

When you’re downloading a program, you might come across a dialog box similar to the one shown in Figure 10-19. Be aware that the message isn’t telling you that there’s a problem with the file. It’s just telling you that the type of file you’re downloading could contain something bad, like a virus or worm. The dialog box is basically asking you to make a judgment call. Eventually, you’re likely to come to a dialog box like the example shown in Figure 10-19:
The basic rule of thumb for making the judgment call is where the program is coming from. If it’s from a controlled Web site like www.tucows.com, or any legitimate software company like Adobe, Corel, Macromedia, Microsoft, and so on, it’s probably safe. If you were offered this program through some unrestricted pop-up or junk e-mail, its source is much more dubious. You could still Save the file, then scan it for viruses before opening (assuming you have anti-virus software, as discussed in Chapter 13). If you’re familiar with the company that’s providing the program, you can choose Open and just install the program. Anyway, here’s how the buttons in the dialog box work:

**Tip**

If file name extensions are visible, a program you’re downloading will likely have a .exe extension. That stands for executable. That means the file is a program containing instructions that the computer can execute. Most documents don’t contain executable code. See the section “Showing/Hiding File Name Extensions” in Chapter 6 for information on showing/hiding file name extensions.

✦ **Open**: If you choose Open when downloading the program, the program will be installed automatically. There won’t be any leftover files you need to delete.

✦ **Save**: The installation program will be saved to your hard disk. To install the program, you need to open (double-click) that downloaded file and follow its instructions. When the download is complete, you can delete the file you downloaded.

✦ **Cancel**: If the dialog box in Figure 10-19 popped-up at you for no apparent reason (that is, you weren’t downloading anything), some advertiser might be trying to sneak a program onto your computer. Click Cancel to prevent any unwanted downloads.

If you choose Open, there’s nothing left to do but follow instructions on the screen until the download is complete. At that point, the program will be installed and accessible from your All Programs menu.
If you choose Save rather than open, a Save As dialog box (perhaps titled as File Download) like the one shown in Figure 10-20 will likely open. Even if the dialog box is titled File Download, it works just like the Save As dialog box discussed in Chapter 6. Your job is to choose a folder for the downloaded file. When you’re downloading a program, there’s no need to change the file name or Save As Type. But you should at least look at the file name so you know what to look for when the download is complete.

![Save As dialog box](image)

**Figure 10-20:** The Save As dialog box appears when you’re downloading files from the Web.

If you’ve already created a folder for storing all downloaded files, you can choose that folder name from the Save In drop-down list. For example, I chose a folder named Recent Downloads in Figure 10-20. Optionally, you can choose Desktop from the Save In drop-down list to put the icon right on your desktop. You won’t need to keep the downloaded file for long, so the desktop is a handy place to put it.

Once the download has finished, you’ll need to get to the icon for the file you downloaded. For example, the icon at left represents the downloaded file from Figure 10-20. Double-clicking that icon will begin the installation process. Just follow the instructions on the screen. When the installation is complete, you don’t need the file you originally downloaded anymore. Opening that file again would just start the installation process over. You need only to install a program once, not every time you wish to use it. So you can go ahead and right-click that icon and choose Delete to get rid of it.

When the installation is done, you’ll be able to start the program by clicking the Start button, choosing All Programs, and looking around for the startup icon for that program. Also, any documents that refused to open before should open now. For example, if you downloaded and installed Adobe Acrobat Reader, double-clicking a .pdf document file’s icon should open the document in Acrobat Reader without any problems.
Downloading Documents

Documents are different from programs in that you never have to install a document. You don’t start documents from the All Programs menu either. Rather, you store documents in document folders such as My Documents, My Pictures, or My Music. Opening a document automatically opens the program required to view that document (assuming you have an appropriate program installed on your computer for opening that type of document).

Document downloads can begin like program downloads, where you click some link that offers the document. Many .pdf documents can be downloaded this way. You can also download just about anything visible on your screen. For example:

✦ To copy a picture you see on a Web page, right-click the picture and choose Save File As.
✦ To save the entire Web page you’re currently viewing, choose File ➤ Save As.
✦ To download the picture, song, or video that a link points to, right-click that link and choose Save Target As (the word target means the file that this hyperlink leads to).

Tip
If you’re unable to copy a picture by right-clicking and choosing Copy, you can also take a picture of the entire screen with the picture visible. Then paste the screenshot into a graphics program and crop out whatever you don’t want. See “Editing Pictures with Paint” in Chapter 15 for more information.

When you download a document, you might see the options shown in Figure 10-21. The options in that dialog box have a slightly different meaning than they do when downloading a program, because it’s never necessary to install a document. So here’s what the buttons do:

![File Download](image)

**Figure 10-21**: This dialog box often appears when you’re downloading a document from the Internet.

✦ **Open**: Opens the document in an appropriate program so you can see the document, but does not save a copy of the document to your computer. If you want to save the document, you have to choose File ➤ Save As from that program’s menu bar; then use the Save As dialog box to specify a folder and file name for the document.
When you open streaming media and protected content, the file will play on your screen, but there won’t be any way to save it. The Save As option on the File menu will be disabled.

✦ **Save:** Displays the Save As dialog box, so you can specify a folder and file name for the documents you’re downloading. The document probably won’t appear on the screen. But once the download is complete, you can open the downloaded document as you would any other document — by double-clicking its icon.

Unlike programs, which have a .exe file name extension, a document will have some other extension. That extension, in turn, defines the format of the file and the programs that can open the file. See the section “Understanding Document Types” in Chapter 6 for more information.

**Copying Text from Web Page**

To copy chunks of text from a Web page, it’s not necessary to download anything. Just copy and paste any text from the page into a word-processing program such as WordPad or Microsoft Word. For example, Figure 10-22 shows Internet Explorer on the left, currently viewing some Web page. I selected some text in that page by dragging the mouse pointer through the text.

![Figure 10-22: Example of copying and pasting text from a Web page (left) into WordPad (right)](image_url)
A Note on Zip Files

Some of the files available for download on the Web are compressed (or zipped), so they’ll download more quickly. These files typically have the extension .zip on their file names. Before you can use such a zipped file, you need to extract its contents. See Chapter 22 for details.

On the right of that figure is Microsoft WordPad. To put the selected text into the WordPad document, press Ctrl+C in the browser or right-click the selected text and choose Copy. Then, to paste the selected text, click anywhere in the WordPad document. If there’s already text in the WordPad document, click exactly the spot where you want to paste the selected text. Once the cursor is in the WordPad document, you can just press Ctrl+V (Paste), or right-click near the cursor and choose Paste to paste the selected text into the document.

The WordPad document is no different from a WordPad document you create from scratch. You can edit, save, print, and open the WordPad document using all the standard techniques for any document on your computer.

See the section “Typing on a Screen” in Chapter 7 for more information on WordPad.

Playing Online Music and Video

The Internet is home to a fair amount of streaming media, which is basically music you can listen to, or videos you want to watch, without actually downloading or saving anything. When you click a link that plays music or a video, you may see the dialog box shown in Figure 10-23.

What happens next depends on a lot of things. But here are the most common scenarios:

✦ If you choose Yes, the song or video will play in the Media bar at the left side of Internet Explorer’s program window. Use the play controls (see Figure 12-24) to control volume and such.
If you choose No, the song or video will play in some other player, either one provided by the Web site itself or Windows Media Player (discussed in Part IV of this book).

In some cases, the music or video will play in some other player no matter which option you choose, because the Web site you’re viewing always uses its own player.

Figure 10-24: Internet Explorer’s media bar and play controls

You can show or hide the Media bar at any time by clicking the Media button in Internet Explorer’s menu bar (shown at left). Or choose View ➪ Explorer Bar ➪ Media from Internet Explorer’s menu bar. Exactly how the bar looks depends on what you’re viewing at the moment. In the example shown in Figure 10-24, the Media bar is currently playing a video — a movie preview of *The Cat in the Hat* movie from WindowsMedia.com (which you can get to by clicking More Media in the Media bar). Here’s how you use the options in the Media bar:

- **Undock player**: Click this button to make the player into a larger window you can size yourself. To redock the player, click the Close (X) button in the upper-right corner of the Media window that opens.

- **Play Controls**: When a song or video is playing, these buttons (going left to right) work the same way a VCR or CD player’s buttons work. Going left to right, those buttons are:
✦ **Play/Pause**: When a song or video is playing, shows two vertical bars (||), which stand for Pause. After clicking the button, a right-pointing triangle replaces the bars, and clicking that button resumes playback.

✦ **Stop**: Stops the song or video currently playing and rewinds it to the beginning.

✦ **Next Track/Previous Track**: When playing a CD, allows you to go to the next or previous song on the CD.

✦ **Mute**: Click to mute all sound. Click a second time to turn sound back on.

✦ **Volume**: Drag the slider left to decrease volume. Drag it right to increase volume.

To change how Internet Explorer plays music or video, click the Media Options drop-down list and point to Settings, as in Figure 10-25. Clicking the More Media option takes you to the WindowsMedia.com Web site, where you can find music and video clips to play. Clicking the Radio Guide option takes you to a Web site where you can find radio stations that broadcast over the Internet.

![Figure 10-25: Options for playing music or video from the Web](image)

The Settings submenu offers the options summarized as follows. Note that the first two options are **toggles**. If the option has a checkmark next to it, the option is currently On. No checkmark means the option is currently Off. Clicking an option changes it to the opposite state: from On to Off or vice versa. Here’s what all the options on the Settings submenu do:

✦ **Play Web media in the bar**: If selected (On), music and video clips will play in the Media bar (if the Web site you’re visiting doesn’t have its own player). If not selected, music and video will play in Windows Media Player or some other program (see Part IV).

✦ **Ask for preferred types**: If selected (On), the dialog box shown in Figure 10-23 appears when you play a new media type, asking whether you want to play it in the Media bar or elsewhere. If this option is Off, the dialog box doesn’t open and the song or video just plays in whatever player you chose in the past.

✦ **Reset preferred types**: Clicking this option erases any selections you’ve made in the concerning which types of media files play where.

There’s not much to see when playing music; there’s no drawback to playing music via the Media bar. But the video window in the Media bar is tiny. So you might not want to play videos in the Media bar.
As mentioned, you’ll learn a lot more about music and video in Part IV of this book. For now, knowing that the Media bar in Internet Explorer is just for listening to music and watching video is sufficient.

**Troubleshooting Web Browsing**

Once your computer is connected to the Internet, Web browsing is fairly easy and straightforward. There are a couple of fairly common problems, though, that you’ll want to know how to handle, summarized as follows:

**Page not Found Error**

If you attempt to go to a Web page and only get a *Page not Found* error message, you have typed the site’s URL incorrectly. Note that when typing a URL, you always use forward slashes (/), not backslashes (\). In other words, a URL like `http://www.microsoft.com/downloads` will work just fine, while typing `http:\www.microsoft.com\downloads` will produce a *Page not Found* error. Also, note that URLs never contain blank spaces.

Tip: You’ll also get a *Page not Found* error if you’re not online when you attempt to go to a Web page.

... *Do you wish to debug?* Errors

Once in a while, you’ll come across an error message that says there is something wrong with the page you’re trying to view. The message will read, *Do you wish to debug?* You should always answer No, because only the person who created the Web page can actually debug (fix) it.

People who create Web pages are supposed to fix everything before they put the pages online. If this were a perfect world, you would never see the *Do you wish to debug?* message, because all the errors that need debugging would already be fixed. But, it’s not a perfect world so this happens.

Typically, clicking the No button will just tell Internet Explorer to do the best it can with the stuff that is working in the page. And hopefully, you won’t even notice any difference. If it’s a more serious problem than that, there’s really nothing you can do about it. Only the site’s *Webmaster* (the person in charge of the Web site) can fix such errors.

Tip: If you get those *Do you want to debug?* errors often, downloading and installing the Java Virtual Machine can help. Go to `http://java.sun.com`, and click the link to download the free Java VM. Follow the instructions on the screen (click Yes at the Security Warnings).
Using the Internet Explorer Troubleshooter

For tougher Web-browsing problems, try the Internet Explorer Troubleshooter. Here’s how:

1. Click the Start button and choose Help and Support.
2. In the Help and Support Center, click Fixing a Problem.
3. In the left pane of Help and Support, click E-mail and messaging problems.
4. Click Internet Explorer Troubleshooter.

If your computer manufacturer changed the Help and Support Center so that you don’t see the Fixing a Problem option, type Internet Explorer Troubleshooter into the Search box and press Enter. Then click Internet Explorer Troubleshooter under Suggested Topics in the left pane.

On the first page of the troubleshooter, click the item that best describes the problem you’re having; then click the Next> button. Just follow along in that manner until you get to your solution.

Internet Explorer Help and Support

There’s tons of information available to you to learn more about Internet Explorer and fix problems. Whether you’re online or not, you can always start Internet Explorer and use its built-in Help. Just choose Help ➤ Contents and Index from Internet Explorer’s menu bar. Then use the Contents, Index, or Search tabs in the Help window that opens to locate topics of interest to you.

If you are online, you can get more information from Microsoft’s online Help and Support. For an overview of support options and access to Microsoft’s Knowledge Base, choose Help ➤ Online Support from Internet Explorer’s menu bar. If the Web site you’re taken to is too confusing, go to www.microsoft.com/ie and have a look around there.

Tip

If you’re looking for general information, tips, or techniques for browsing the Web, go to www.microsoft.com/ie, click Using Internet Explorer in the left column, and start browsing from there.

Summary

This chapter has been something of a whirlwind tour of the World Wide Web and the Internet Explorer browser that comes with Windows XP. The techniques presented here represent the most important everyday skills you need to use the Web successfully. To recap:
To browse the World Wide Web, connect to the Internet and start your Web-browser program (Internet Explorer, if you don’t have a preference).

Every site on the World Wide Web has a unique address, or URL, often in the format http://www.whatever.com.

To go to a specific Web site, type its address (URL) into the Address textbox near the top of the Web browser window and press Enter.

You can browse the Web by clicking hyperlinks — hot spots that appear on the various pages you visit.

To keep track of your favorite Web pages, add them to your Favorites list. That is, visit the Web page and choose Favorites ➤ Add To Favorites from the menu bar.

To revisit a favorite page at any time, open the Favorites menu and click the name of your favorite page.

To search for specific information on the Web, use a search engine. Click the Search button on the Standard Buttons toolbar to begin your search.

To download a file means to copy it from a computer on the Internet to your own PC.

For more information on using Internet Explorer to browse the Web, choose Help ➤ Contents and Index from Internet Explorer’s menu bar. Or visit the Internet Explorer Web site at www.microsoft.com/ie.
Sending and Receiving E-mail

It seems that just about everyone knows what e-mail is these days. The $e$ stands for *electronic*. With e-mail, you type a letter or message on your computer, send it to the recipient’s e-mail address, and it ends up in the recipient’s e-mail inbox a few seconds later. You can attach things like pictures and other files to the message so the recipient gets those too. It’s a lot faster than the postal service and doesn’t cost a cent.

To use e-mail, you need an Internet connection and an e-mail address. All e-mail addresses follow the format *someone*@$somewhere.tld*, where *someone* is your username and *somewhere.tld* is a domain name. For example, my e-mail address is *alan@coolnerds.com*. You also need an e-mail client, a program capable of sending and receiving e-mail. If you’re already doing e-mail, you already have all those things.

**Introducing Outlook Express**

Windows XP comes with an e-mail client named Outlook Express. If you’re already sending and receiving e-mail, it’s not necessary to know anything about Outlook Express. You can skip this chapter, keep doing e-mail the way you have been, and not miss out on anything. On the other hand, if your ISP requires that you use Outlook Express as your e-mail client and they’re offering a POP3 account (Post Office Protocol 3, the traditional means of doing Internet e-mail), you’ll need to get the information shown in Table 11-1 from your ISP so you can set up Outlook Express. Note that the second column of Table 11-1 shows only examples of how that information might look. You need to fill in the third column with the actual information provided by your ISP.
Table 11-1
Information You Need to Set Up Outlook Express for POP3 E-mail

<table>
<thead>
<tr>
<th>Information Needed</th>
<th>Example</th>
<th>Write Your Information Here</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your e-mail address</td>
<td><a href="mailto:somebody@somewhere.com">somebody@somewhere.com</a></td>
<td></td>
</tr>
<tr>
<td>Your e-mail username</td>
<td>Somebody</td>
<td></td>
</tr>
<tr>
<td>Your e-mail password</td>
<td>********</td>
<td></td>
</tr>
<tr>
<td>E-mail account type</td>
<td>POP3 or HTTP</td>
<td></td>
</tr>
<tr>
<td>Outgoing (SMTP) mail server</td>
<td>smtp.somewhere.com</td>
<td></td>
</tr>
<tr>
<td>Incoming (POP3) mail server</td>
<td>mail.somehere.com</td>
<td></td>
</tr>
</tbody>
</table>

You can also use Outlook Express with MSN and Hotmail accounts. The only information you’ll need for such accounts are your e-mail address (must end in @msn.com or @hotmail.com) and your e-mail password.

Setting Up Your E-mail Account

If you’ve decided you’re going to use, or at least try out, Outlook Express, and you feel confident that you have the information you need from your ISP, you can set up your e-mail account in several ways:

1. Click the Start button and choose All Programs Outlook Express.

2. If you see a message asking if you want to make Outlook Express your default e-mail client, you can choose Yes if you think Outlook Express will be the only program you’ll use for e-mail. Otherwise, click No.

3. If you’ve never used Outlook Express, the Internet Connection Wizard will open automatically to help you set up an account. If you see the Internet Connection Wizard, skip to Step 5.

4. When Outlook Express opens, you can set up a new account by choosing Tools Accounts from its menu bar. In the Internet Accounts dialog box that opens, click the Add button and choose Mail.

5. Answer all question presented by the Wizard, clicking the Next button at the bottom of each page, until you get to the page with the Finish button.

Be sure to read the information on each Wizard page carefully, and type your answers accurately. Any misinformation or simple typographical errors will
start to haunt you the minute you try to send or receive any e-mail messages. There’s just no margin for guessing, sloppiness, or error when it comes to setting up your e-mail account.

Once you’ve set up your e-mail account, the Folders pane will display a set of folders for your account. The exact folders that appear will vary with different types of accounts, as in the example shown in Figure 11-1. The most common, and most useful, folders are summarized as follows:

- **Inbox**: Every e-mail message that you receive initially appears in your Inbox. If messages don’t arrive automatically, click the Send/Reciv button in Outlook Express’s toolbar to bring your Inbox up to date.
- **Outbox**: On some e-mail accounts, gathers up e-mail messages waiting to be sent. To send messages waiting in the Outbox, click the Send/Reciv button.
- **Sent Items**: Maintains a history of all e-mail messages you’ve sent.
- **Deleted Items**: Contains messages you’ve deleted from your Inbox (or any other folder) but haven’t completely removed from your hard disk yet.
Sending E-mail with Outlook Express

Once Outlook Express is open, you can use any of the following techniques to get started on sending an e-mail message to someone:

✦ Click the Create Mail button on the Outlook Express toolbar.

Tip To add a fancy background to your message, click the down-arrow button on the Create Mail button; then click a stationery name.

✦ Choose Message ➪ New Message from the Outlook Express menu bar.
✦ Press Ctrl+N when a mail folder is open.

A New Message window for composing your e-mail message appears onscreen. To compose your message, fill in the address portion of the window as explained in the following steps.

1. Type the recipient’s e-mail address next to To: If you want to send the message to several people, you can type several addresses separated by semicolons (;).
   • Optionally, to send carbon copies of the message to other recipients, put their e-mail addresses in the Cc: box. Again, you can separate multiple e-mail addresses by semicolons.
   • Optionally, to send blind carbon copies of the message to other recipients, type their e-mail addresses into the Bcc: box, again separating multiple addresses with semicolons.

Tip A blind carbon copy sends the e-mail message to the recipient with all other recipients’ names hidden. This protects the privacy of other recipients and makes the e-mail look as though it was sent to the recipient directly. If you don’t see a Bcc: box at the top of the New Mail Message window, choose View ➪ All Headers from Outlook Express’s menu bar.

2. In the Subject: box, type a brief subject description of the message. This part of the message appears in the recipient’s Inbox and is visible prior to opening the message.

3. Type your message in the larger editing window below the address portion. You can use all the standard typing and editing techniques described in Chapter 7. Figure 11-2 shows an example of a simple text message typed in the New Message window.

If you want to add any fonts, pictures, or hyperlinks to your e-mail message, read on the following. Otherwise, you can skip to the “Send the Message” section.
Composing Fancier E-mail Messages

E-mail messages can be plain text or rich text (also called HTML). Plain text messages contain only plain text. Rich text messages can include fonts, pictures, and hyperlinks, like the example shown in Figure 11-3.
To compose a rich text e-mail message, use formatting buttons in the toolbar, just above the message text. If you don’t see a formatting toolbar, choose Format ➪ Rich Text (HTML) from the New Message window’s menu bar. You can type your text normally. Then apply formatting using the “select, then do” method described in Chapter 7 and summarized in the sections that follow.

**Tip** If you’ve installed Microsoft Word, Microsoft Excel, or Microsoft PowerPoint on your computer, you can use the Spelling button in Outlook Express’s toolbar to correct misspellings in your e-mail message.

### Using Fonts and Alignments

As an example of using fonts and alignments in an e-mail message, suppose you want to put a large, centered heading at the top of your message (or anywhere in your message). Type the line of text and press Enter. Then select the same line of text using any of the text-selection techniques described in Lesson 7 (for example, just drag the mouse pointer through the text you want to format). Then choose your font, size, color, and the Center button in the toolbar, as illustrated in Figure 11-4.

![Figure 11-4: Text selected and formatted using buttons on the toolbar](image)

### Typing a List

Numbered and bulleted lists are useful ways of organizing text. For example, you might want to show some numbered steps or a list of points or options in your text. To do so, type each item in the list, pressing Enter once at the end of each line, as at the top of Figure 11-5.

Next, select all the lines of text (and only those lines) as in the center of Figure 11-5. An easy way to do this is to simply start with the mouse pointer just outside the last item in the list; then drag the mouse pointer up and to the left so that all items (and only the items) you want to put into list form are selected (highlighted).

Click the Formatting Numbers or Formatting Bullets button in the New Message toolbar. Optionally, to indent or outdent the list, click the Decrease Indentation or Increase Indentation button in the toolbar. The bottom part of Figure 11-5 shows the selected list after clicking the Formatting Numbers and Increase Indent buttons in the toolbar.
You can insert a small photo or picture into the body of your e-mail message, like the baby picture shown back in Figure 11-3. You’ll have to make sure you’re using the Rich Text (HTML) format. Then . . .

**Inserting a Picture**

You can insert a small photo or picture into the body of your e-mail message, like the baby picture shown back in Figure 11-3. You’ll have to make sure you’re using the Rich Text (HTML) format. Then . . .

- **Tip** Use Insert Picture to insert small pictures only. As described later in this chapter, you can attach large pictures and photos to messages.

1. Move the mouse pointer to about where you want to place the picture.
2. Do one of the following:
   - Click the Insert Picture button in the New Message toolbar (shown at left).
   - Choose Insert Picture from the New Message menu bar.
3. In the Picture dialog box that opens, click the Browse button and navigate to the folder that contains the pictures you want to insert. Then double-click the picture’s icon, or click the picture’s icon and click the Open button.
4. If you want the picture to appear to the left of text (like the baby picture in Figure 11-3), choose from the Alignment drop-down list. Or choose Right to make the picture align to the right of adjacent text.

5. If you want to put a border around a picture, enter a thickness (in pixels) in the Border Thickness option (the number 1 will put a nice thin border around the picture).

6. If you chose the Left or Right alignment option, use the Horizontal and Vertical options to put some space between the text and the picture (a setting of 5 is usually plenty).

7. Click the OK button.

The picture lands in your e-mail message. If you want to change any of the options you initially chose, right-click the picture and choose Properties. If you change your mind and want to delete the picture, click the picture and press Delete (Del).

**Inserting a Hyperlink**

A hyperlink is clickable URL. If you simply type a URL into a message, Outlook Express will automatically make it into a hyperlink. Optionally, you can copy a URL from your Web browser’s address bar or a Web page and paste it into your e-mail message. (The latter saves a lot of time and possible typographical errors.)

If you want to create a “Click here” type of link, where plain-English words rather than a URL are visible in your message, follow these steps instead:

1. Type the text you plan to use as a URL (for example, the words “Click here”).

2. Select the text that will act as a hyperlink.

3. Click the Create a Hyperlink button (shown at left) in the New Message toolbar, or choose Insert Hyperlink from the New Message menu bar.

4. In the Hyperlink dialog box that opens, type (or paste) the URL of the Web site into the URL text box, as in Figure 11-6.

5. Click OK in the Hyperlink dialog box.

![Hyperlink dialog box](image)
The text you selected in Step 1 will be colored and underlined as a hyperlink. The recipient of your e-mail message need only click that link to visit the site.

**Attaching Files to E-mail Messages**

An e-mail message isn’t a document — it’s, well, a *message*. The main difference is that unlike documents, which are stored in regular document folders like My Documents and Shared Documents, e-mail messages are stored in your e-mail client’s folders.

If you want to send someone a document via e-mail, attach the document to the message. The document can be anything: something you typed, a photograph, a song, a video, and so on. But there is one big catch: Most ISPs won’t let you attach anything more than 1 or 1.5MB worth of files to a single message. (One megabyte equals roughly 1,000K). Songs and videos tend to be larger than that, so they’re not always good candidates for e-mail.

**A Shortcut for E-mailing Photos**

Here’s a handy shortcut for e-mailing pictures that will automatically shrink large photos to a more manageable size for your recipients. The shortcut method works with Outlook Express, Outlook, and a few other e-mail clients. But it doesn’t work with all e-mail accounts. So whether or not this option will work for you depends on the program you use as your e-mail client.

Here’s how the shortcut works. Let’s say you’re browsing around your folders and haven’t even opened your e-mail client. You come across a document file you want to e-mail (we’ll use a photo as an example, but the method works with any type of document file). Rather than opening your e-mail client, just right-click the file’s icon and choose Send To ➪ Mail Recipient as follows.

To attach multiple files to an e-mail message using the shortcut method, select the files you want to send; then right-click any one of them and choose Send To ➪ Mail Recipient. If the attachment is a large picture (or pictures), you’ll be given the option to make your picture(s) smaller. Click OK and choose any size (640x480 is plenty big). If no sizing options appear, it just means that all photos you’ve attached are already smaller than 640 pixels wide and 480 pixels tall.
Many people use Zip files (Chapter 22) to compress one or more large files into a single, smaller file that’s easier to e-mail. You can also use the Send a File or Photo option in Windows Messenger (Chapter 12) to send someone a file of any size.

Attached documents don’t appear in the body of the e-mail message. They just follow the message along on the Internet to the recipient’s e-mail Inbox. The file names and sizes of the attachments will appear just above the text, as in Figure 11-7.

**Figure 11-7:** Two photos attached to an e-mail message

### Sending the Message

Once your message is addressed, composed, and ready to go, just click the Send button in the upper-left corner of the New Message to send the e-mail. If Outlook Express is configured to send mail immediately, and you’re online, the message will be sent to recipient, and a copy will be added to your Sent Items folder.

### How E-mail Works

Here’s a quick rundown of how e-mail works. Let’s say you send an e-mail to somebody@somewhere.com (a hypothetical e-mail address). When you send the message, your e-mail client hands it off to your modem, which in turn sends it to your ISP’s **outgoing mail server**. That mail server is a program that has only one job in life — to accept e-mails coming in from all of the ISP’s customers and then hand them right off to the Internet.

Once the Internet gets the message you sent, it looks at the domain name in the recipient’s address and transfers the message over to the **incoming mail server** at the recipient’s domain. In the somebody@somewhere.com example, the Internet would hand the message off to the **incoming mail server** for somewhere.com.

The incoming mail server is a program that stores all of the e-mail messages pouring in from the Internet. Then, like a postal worker, it puts each message in the appropriate customer’s Inbox. So the next time somebody@somewhere.com checks her e-mail, the message is sitting in her Inbox, waiting to be read.
If you’re not online, or Outlook Express isn’t configured to send messages immediately, the message will be placed in your Outbox. Click the Send/Recv button in Outlook Express’s toolbar to send the message from your Outbox to the recipient.

To set options in Outlook Express, choose Tools ➪ Options from its menu bar. The option to send messages immediately when you click the Send button is on the Send tab. If you clear, rather than select, that option, all newly sent messages will be sent to your Outbox until you click the Send/Recv button in Outlook Express’s toolbar.

Reading Your E-mail with Outlook Express

E-mail messages that people send to you are initially stored on your ISP’s mail sever computer. To see them, you need to get them from that server to your own computer. Depending on how Outlook Express is configured, you might, or might not, have to click the Send/Recv button to retrieve your mail. Either way, all new messages will be added to your Inbox. So you need to click the Inbox folder (see Figure 11-8) to see your messages.

Outlook Express’s program window and taskbar button are no different from any other program’s. So you can do the following:

✦ Move, size, minimize, and maximize Outlook Express’s program window using all the standard techniques described under “Taking Control of Program Windows” in Chapter 4.
✦ Choose Help ➪ Contents and Index from Outlook Express’s menu bar, or just press F1, to get help with the program.
✦ Sort message headers, and arrange column headings, using the standard column-heading methods described under “Working with Columns” in Chapter 5.
✦ Drag the bar that separates any two panes to size the panes.

The Inbox is split into two panes. The top pane shows message headers — who sent it, the Subject, and the date and time that you received the message. Headers for new messages you haven’t read yet are in boldface. Click any message (once) to see its contents in the lower preview pane.
To see the contents of a message in more detail, double-click the message header. The message opens in a new window, as in the example shown in Figure 11-9. Items in the toolbar provide quick access to the most commonly used menu commands, summarized as follows.

- **Reply:** Click to send a reply to the sender (only). Then type your reply and click Send.
- **Reply All:** Click to reply to everyone who received this message. Type your reply and click the Send button.
- **Forward:** If you think a friend should see this e-mail, click the Forward button, type the new recipient’s e-mail address, and click Send to pass the message along.
- **Print:** To print the message, click the Print button.
- **Delete:** If you never want to see this message again, click the Delete button. Remember, though, that deleting isn’t the same as closing. When you delete a message, you say goodbye to it forever. When you close a message, you just get it off the screen, but it stays in your Inbox.
- **Previous:** Displays the previous message from the header list.
- **Next:** Displays the next message in the header list.

**Figure 11-8:** Inbox, message headers, and one message
To close the open message and get back to your Outlook Express window, click its Close (X) button at the right side of its title bar. Or you can size and arrange the preview window and Outlook Express so you can see both on the screen at the same time.

**Tip**
To reply to, or forward, a message that isn’t open, right-click the message header and choose one of the Reply or Forward options on the shortcut menu that appears.

### Opening Attachments

Before I tell you how to open an attachment, be advised that e-mail attachments are how the vast majority of viruses and worms are spread. As discussed under “Viruses, Worms, and Trojan Horses” in Chapter 13, you should open an attachment only if you know whom it’s from and what it is. So please don’t practice what you learn here with the first e-mail attachment that comes along. Send an e-mail and attachment to yourself, and practice with that.

### Checking Your Attachment Security

Outlook Express had some serious virus protection built into it, in the form of “you can’t open this attachment because it’s the type of file that could contain a virus.” That’s different from the kind of virus protection discussed in Chapter 13, which is a little more choosy. Virus-protection programs usually only block attachments that do contain a virus. (More on that topic in Chapter 15.)
Before you try to open any attachments, you’ll want to check, and possibly change, Outlook Express’s security settings. Here’s how:

1. From the menu bar in Outlook Express, choose Tools  Options.
2. In the Options dialog box that opens, click the Security tab.
3. To be warned when some program attempts to send e-mail through Outlook Express, choose “Warn me when other applications try to send mail as me.”
4. To block all potentially unsafe e-mail attachments, choose “Do not allow attachments to be saved or opened that could potentially be a virus” (see Figure 11-10).
5. Click the OK button.

Figure 11-10: Virus-protection options in Outlook Express’s Options dialog box

Viewing (Opening) an Attachment
Recall that all new incoming e-mail messages are stored in your Inbox. While viewing your e-mails, you can tell which ones have attachments by the little paper clip icon that appears next to message headers. When you click such a message, a large paper clip will also appear above the message text, as in Figure 11-11.

Assume that you’ve clicked the message header for a message that has a file attached. You know who sent you this attachment, the message looks legitimate, and you feel it’s safe to open the attachment. You can use any of the following techniques to open an e-mail attachment in Outlook Express:

- Click the message header; then double-click the paper clip icon to the left of that message header.
- Click the message header; then click the large paper clip in the lower preview pane.
- Double-click the message header; then double-click the attachment file name just above the body of the message that opens.
Figure 11-11: Paper clips indicate e-mail attachments.

Windows will attempt to open the attachment as a regular document. If you have a program that can open the attached document, the document will open. If you’d like to print the attachment, choose File ➪ Print from that program’s menu bar. If you’d like to save the attachment as a document on your own hard disk, choose File ➪ Save As from that program’s menu bar. When the Save As dialog box opens, make sure you navigate to My Documents or some other folder before clicking the Save button.

Sometimes, when you open an attachment, all you get is a blank message with another attachment. So you have to double-click the attachment there to open its attachment. You may have to repeat this several times — it all depends on how many AOL users forwarded it to each other before you got it.

If the attachment is a Zip file, it will have a .zip extension. A zip file is actually one or more files compressed into a single file for fast transport across to the Internet. If you receive a Zip file, you’re probably better off saving it (as discussed in a moment) than trying to open it. After you’ve saved the Zip file, you can extract its contents, as discussed in Chapter 22.”

If you don’t have an appropriate program for the document you’re trying to open, you’ll see the Windows cannot open this file dialog box, described under “When Windows Can’t Open a Document” in Chapter 6. There are a couple of solutions to the problem. You can reply to the sender, asking him or her to send the file to you in a different format, or ask the sender if he or she knows of a suitable program that you can download and install for free.

Saving Attachments
Attachments are generally saved with e-mail messages, which means you can’t use them as freely as documents stored in regular folders like My Documents and such. If you want to keep an e-mail attachment around, and use it as a normal document, you need to save the attachment.

Saving an attachment isn’t the same as opening it. That is, saving an attachment won’t trigger any viruses. So if you have anti-virus software, you can save any suspicious attachments first. Then scan them for viruses before you open them. (If the scanning program finds a virus, just delete the infected file; do not open it!) To save an attachment:

1. In Outlook Express, open the e-mail message to which the file is attached by double-clicking its message header.

2. Click the large paper clip icon in the preview area. Then:
   - To save a single attachment, click its name. In the dialog box that opens, click Save it to disk; then click OK. In the Save Attachment As dialog box that opens, navigate to the folder in which you want to save the attachment.
   - To save all attached files, click Save Attachments (Figure 11-12). In the Save Attachments dialog box that opens, navigate to the folder in which you want to save the attachments.

3. Click the Save button in the dialog box.

Figure 11-12: An e-mail message with multiple attachments
I Can’t Save or Open Any Attachments!

As mentioned, Outlook Express’s built-in virus protection blocks any file that could contain a virus, not just files that do contain viruses. As such, you may not be able to open some perfectly innocent files, like photos.

When Outlook Express blocks an attachment, clicking the large paper-clip icon in the preview area reveals only disabled (dimmed) options, as in the example that follows:

If you open the e-mail message, you won’t see the usual file names above the body of the message. Instead, you’ll see a bar that reads “OE removed access to the following unsafe attachments in your e-mail” (where OE stands for Outlook Express), as in the example that follows:

If you’re sure the attachment is safe, and you do want to open it, you can repeat steps 1-n4 in the section “Checking Your Settings,” earlier in this chapter. But clear, rather than select, the Do not allow attachments to be saved or opened . . . option in Step 4 to turn off virus protection. Don’t forget to turn that option back on if you want to continue to use it in the future.

Once you’ve saved the attachment, it will be just like any document you created yourself. So you can use Windows Explorer to navigate to the folder in which you placed the attachment(s). Then double-click any attachment’s name to open it. You can also delete the original e-mail message and attachment if you wish. The copy on your hard disk is its own separate file and won’t be affected by anything you do in Outlook Express any more.

Managing E-mail Messages

As time goes by, your collection of e-mail messages will grow. To manage those messages, you can organize them into folders, delete the junk mail or any messages you don’t need any more, and so forth. You do most of these managerial tasks in the list of message headers in Outlook Express’s program window.
Selecting Messages

In the list of message headers, you can work with individual messages or groups of messages. To work with multiple messages, you first need to select the messages you want to work with. You can use the same techniques you use to select multiple icons (described in more depth under “Working with Multiple Files and Folders” in Chapter 19). For example, you can:

1. First, click any message header to select only that message. Then:

   - To select more message headers, hold down the Ctrl key while clicking additional messages you want to select.
   - To extend the selection through a group of messages, hold down the Shift key and click the header to which you want to extend the selection.
   - To select from the currently selected message to the end of the list, press Shift+End.
   - To select from the currently selected message to the top of the list, press Ctrl+Home.
   - To select all message headers, press Ctrl+A or choose Edit ➪ Select All from Outlook Express’s menu bar.

   You can also use Ctrl+Click to unselect selected messages. For example, suppose most of the messages in your Inbox are junk mail and you just want to get rid of them without even opening them up. You can click the first message header, then press Ctrl+A to select all the message headers. Next, hold down the Ctrl key and click the messages you don’t want to delete, as in Figure 11-13. Pressing the Delete key in that figure would delete all the selected messages.

   ![Figure 11-13: A quick way to select most (but not all) messages](image.png)
You can use a spam filter (see Chapter 13) to help keep junk e-mail messages from ever reaching your Inbox.

## Deleting Messages

Deleting messages is simple. If you want to delete a single message, you can just right-click its message header and choose Delete. Optionally, you can select the headers of the messages you want to select, as in the example shown in Figure 11-13. Then use whichever of the following techniques is most convenient to delete the selected messages:

- On your keyboard, press the Delete (Del) key, or Ctrl+D.
- Click the Delete button in Outlook Express’s toolbar.
- Choose Edit ➤ Delete from Outlook Express’s menu bar.
- Right-click any selected message and choose Delete.

The message isn’t permanently deleted from your hard disk. It’s just moved into your Deleted Items folder. So if you ever delete an e-mail message by accident, here’s how you can get it back:

1. Click the Deleted Items folder.
2. If you want to undelete several messages, you may select them all first.
3. Right-click the message (or any selected message) and choose Move to Folder ➤ Inbox.

There are a couple of disadvantages to using the Deleted Items folder. For one, the messages in that folder are still on your hard disk, taking up space. Each message is a trivial amount of disk space. But when you have thousands of them stored in there, it adds up. So once in a while, it would be good to empty the Deleted Items folder. Once you do, there will be no way to recover any messages that were there. So you want to make sure there’s nothing important in the Deleted Items folder. To empty the folder:

- Choose Edit ➤ Empty ‘Deleted Items’ Folder from Outlook Express’s menu bar.
- Or right-click the Deleted Items folder and choose Empty ‘Deleted Items’ Folder (see Figure 11-14).

The term *permanently delete* always means just that — to forever remove the item from your hard disk. There’s no changing your mind after you’ve permanently deleted an item.
You’ll have one last chance to change your mind, in the form of a dialog box that asks “Are you sure you want to permanently delete these message(s)?” Click Yes only if you’re certain you’re willing to part with the selected messages forever.

**Grouping Messages into Folders**

You’re not limited to using the folders that first appear when you open Outlook Express. You can create as many folders as you wish. For example, I keep a number of subfolders under Inbox to store messages that I might need to refer to later, as in Figure 11-15. When I get an order-confirmation message from a Web site where I’ve purchased something, that message goes into my Orders folder until the package arrives. You can also organize your messages by the person or company that sent you the message, by project if you work online — whatever makes sense for your situation.

**Keep Your Messages to Yourself**

If you have one computer in a household with several users, having one e-mail address for everyone can get very old, very fast. It’s not necessary to pay extra to your ISP to set up extra e-mail accounts. Nor is it necessary to try to set up and manage multiple e-mail identities. The best way to handle the multiple-users problem is to create a *user account* for each family member (see Chapter 23).

Once you’ve set up a user account for a family member, you can then set up a free MSN or Hotmail e-mail account for each member and a separate .NET Passport for each user (Chapter 12). That way, each family member has his/her own e-mail account, My Documents folder, personal settings, and so forth. And best of all, it keeps everybody’s e-mail entirely separate. (If you’re the administrator, however, you can always spy on people and see what they’re up to.)
Before you create a folder, you need to decide which folder will be its parent. For example, if you want to create subfolders for your Inbox, as in Figure 11-15, Inbox will act as the new folder’s parent. Once you’ve decided on a parent folder, use whichever technique that follows is most convenient to create a new folder:

1. If you’re not already in Outlook Express, go ahead and start that program. Then do whichever of the following is easiest for you:
   - Right-click the folder that will act as the parent and choose New Folder.
   - Choose File ➤ Folder ➤ New (or press Ctrl+Shift+E). In the Create Folder dialog box that opens, click the folder that will act as parent to the new folder.

2. Type the name of the new folder and then press Enter or click the OK button (if you’re in the Create Folder dialog box).

If you change your mind about a folder’s name, right-click that folder, choose Rename, type your new name, and press Enter. You can also delete a folder. But be aware that if there are any messages in that folder, you’ll delete those as well. Aside from that, deleting a folder is pretty much the same as deleting anything else: right-click the folder you want to delete and choose Delete.
Moving Messages into Folders
An easy way to move a message from your Inbox to one of your subfolders is to simply drag the message header so that the mouse pointer is sitting right on top of the folder in which you want to put the message. Then release the mouse button.

Optionally, you can right-click any message and choose Move to Folder. Or, to move a bunch of messages into a subfolder, select their message headers first. Then right-click any selected message and choose Move to Folder. In the Move dialog box that opens, click the folder in which you want to put the selected message(s); then click OK.

Marking Messages as Read or Unread
As mentioned, headers for any new messages you receive will be shown in boldface. When you click a message header to view its contents in the preview pane, or double-click a message to open it, the bold text turns to regular text, indicating that you’ve read the message. (Actually, you have to leave the highlighter on the message header for a few seconds before the boldface goes away.)

You can manually mark a message header as “read” or “not read” by right-clicking the message header and choosing Mark as Read or Mark as Unread. Or select a group of messages first; then right-click any one of them, and choose a Mark As . . . option.

Tip
A boldface folder name with a number to the right contains unread messages. The number indicates how many unread messages are in the folder.

For example, suppose you read an important message, but can’t deal with it right away. You want to make its header bold again to call attention to it next time you open Outlook Express. To make the read message look like an unread message, just right-click its header and choose Mark as Unread.

Using Windows Address Book
Windows XP provides the handy Windows Address Book (WAB), a program that lets you store and manage peoples’ names and addresses. You also can use the Address Book to fill in the e-mail addresses of your recipients automatically when you compose a new message or when you reply to or forward a message. Before we look at the Address Book, let’s look at a couple of ways you can add contacts (peoples’ names and addresses) automatically from Outlook Express.

Tracking Names and Addresses Automatically
It’s not entirely necessary to manually add names and addresses to your Address Book. You can automatically add peoples’ names and addresses using
any of the following techniques. You can have Outlook Express automatically add the name and e-mail address of anybody you reply to in an e-mail message by following these steps:

1. Make sure you’re in Outlook Express’s program window.
2. Choose Tools ➤ Options from Outlook Express’s menu bar.
3. In the Options dialog box that opens, click the Send tab.
4. Select (check) Automatically put people I reply to in my Address Book.
5. Click the OK button in the Options dialog box.

A slightly less automated technique (but one that still saves you some typing) is to add the e-mail address of the person who sent you a message. There are a couple of ways to do that. In Outlook Express’s list of message headers, right-click the message header and choose Add Sender to Address Book, as near the top of Figure 11-16. Or, if the message is already open and you’re reading it, right-click the name next to From and choose Add to Address Book from that submenu, as in the lower half of the same figure.

![Figure 11-16: Two ways to add a contact to Windows Address Book without typing](image)

If a Properties dialog box opens, just click its OK button. Later, you can go back and add information if you like, as discussed in a moment.
Opening Windows Address Book

You can open Windows Address Book at any time to view, change, delete, or print information. From Outlook Express, you just have to click the Addresses button (shown at left), which appears in Outlook Express toolbars. Or press Ctrl+Shift+B, or choose Optionally. You can start Windows Address Book without going through Outlook Express. Just click Start in the lower-left corner of your screen and choose All Programs ➤ Accessories ➤ Address Book. Either way, your Address Book will open, looking something like Figure 11-17. In that example, I’ve already added one contact whose name, e-mail address, and phone numbers appear across the top of the main pane.

![Windows Address Book](image)

**Figure 11-17:** Windows Address Book is open.

The Shared Contacts folder at the left side of the window contains names and addresses accessible to all users of your computer. The Main Identity’s Contacts folder contains names and addresses added by the current user or identity only. Unless someone has already set up an identity for you, you want to click consider yourself Main Identity and use that folder exclusively.

Creating and Managing Identities

Identities are optional in Outlook Express. And if you ask me, they’re way too complicated a solution to having multiple e-mail accounts on your computer. If you really want to create Outlook Express identities, you’ll have to look to your ISP for specific instructions. They’re the only ones who can tell you exactly how to set up identities for the e-mail service they provide.

If you want my opinion on the matter, I’m not a big fan of the identities approach to handling multiple e-mail accounts. I prefer the alternative described in the sidebar titled “Keep your messages to yourself,” earlier in this chapter. It would be no big loss to just dispense with the view of the folders either. To do so, choose View ➤ Folders and Groups from Outlook Express.
Managing Contacts

Your address book will grow. Keeping it up-to-date and organized is going to take some management on your part: things like adding contacts, changing and deleting contacts, putting together groups of people so you can send them all an e-mail, like a family newsletter or something. Let’s start with adding and changing contacts.

Adding and Changing Contacts

You may (or may not) have already added some contacts to your Address Book from Outlook Express. You can add contacts at any time. And you can change contact information at any time. It’s simple:

✦ If you want to add a contact to Windows Address Book, click the New button in its toolbar, and choose New Contact.

✦ If you want to change or add information to an existing contact (such as one that was added automatically), right-click the contact’s line in the main pane of the Address Book and choose Properties.

If you add a contact, you’ll come to a Properties dialog box similar to the one in Figure 11-18, but all the text boxes will be empty. If you right-click an existing contact and choose Properties, you’ll come to the same dialog box. But you have to click the Name tab to see the options shown in Figure 11-18.

![Figure 11-18: The Name tab of the Properties dialog box for a contact](image)

The rest is easy. Fill in the blanks with whatever information you want. For example, click the Home tab and type the home address and telephone number. Or click the Business tab and type a Business address and phone number. (You can do both.) You can fill in additional information, if appropriate, on the other tabs. Then click OK.
If you click the Home or Business tab, you can then fill in street addresses and telephone numbers. Amazingly, after you fill in a street address, you can click the View Map button on either of those tabs to see an instant map of the address and some surrounding area. You can zoom in and out from the map, print, save, or e-mail the map, and see a map of nearby motels. Very handy!

Deleting Contacts

Deleting a contact permanently removes that contact’s information from your Address Book and your hard disk. There’s no changing your mind after you delete a contact. So be careful with what you delete. Other than that, deleting a contact is pretty much the same as deleting anything else. Use whichever method is most convenient at the moment:

✦ In Address Book’s main pane, right-click the contact you want to delete and choose Delete.
✦ Click the contact you want to delete and click the Delete button in Address Book’s toolbar, or press the Delete key.

Optionally, you can select multiple contacts using any of the techniques you’d use for selecting multiple icons in Windows Explorer. Then delete them all in one fell swoop by clicking the Delete button in the toolbar or by pressing the Delete key.

Cross-Reference See the section “Working with Multiple Files and Folders” in Chapter 19 for all the different ways you can select multiple icons.

Printing Contacts

You can print the contents of your Address Book in a variety of formats. If you want to print information for just one contact, click that contact’s line in Address Book’s main window. If you want to print information for all contacts, you can click any contact in the list. If you want to print information for several contacts, select those contacts first. You can select multiple contacts using any of the standard techniques for selecting icons in Explorer.

Next, click the Print button in Address Book’s toolbar or choose File ➪ Print from Address Book’s menu bar. A Print dialog box opens. To print all contacts, choose All. Otherwise, choose Selection to print only the currently selected contacts. Then choose a print style, Memo, Business Card, or Phone List. Then click the Print button and wait a few seconds.

Creating Groups and Mailing Lists

There may be times when you want to send sort of a form letter to a group of people. They might be people in your family, co-workers on a project, or members of a group. When it comes time to send a message to all these folks, you
probably won’t want to type all their e-mail addresses individually. It’s easier to just send the message to the group as a whole, especially if you have to do it often.

To send a message to a group, you have to define who is in the group. To do so, click the New toolbar button in Address Book and choose New Group. Or choose File ➪ New Group from Address Book’s menu bar. A Properties dialog box opens. On the Group tab, give the group a name of your own choosing. For example, in Figure 11-19, I name my group My Mailing List, though you’re welcome to think up something better than that.

Next, click the Select Members button. In the Select Group Members dialog box that opens, click any name in the left column; then click the Select ➪ button to add that person to the group. You can select any number of names in the left column first, using any standard technique for selecting multiple icons. Then click the Select ➪ button to add them all to the right column. If you change your mind about an address in the right column, right-click that name and choose Remove. Once the right column contains the names of everyone you want in your mailing list, click the OK button. The contact names appear under Group Members, as in the example shown in Figure 11-19.

Click the OK button in the Select Members dialog box; then click the OK button in the Properties dialog box for the group. You’ll be returned to the Address book, where you’ll see the group name added with all the individual names. If you ever want to change the group, just right-click its name in the Address Book and choose Properties.

**Using the Address Book to Send E-mail**

You can send an e-mail message to anyone in your address book, including all members of a group. Start your e-mail message in the normal manner, but
don’t type anything in the To: portion of the mail. Use the Address Book button instead. Here are the specific steps:

1. If you haven’t already done so, start Outlook Express.
2. Click the Create Mail button in Outlook Express’s menu bar to create a new, blank e-mail message.
3. Click the Address Book button to the left of “To:” The Select Recipients window opens.
4. To add a group or contact name to the “To:” portion of the e-mail message, click the person name or group name; then click the To: button. You can use the same technique to add names or groups to the Cc: and Bcc: portions of the message. In Figure 11-20, I’ve opted to send the message to people in the My Mailing List group only.

![Select Recipients Window]

**Figure 11-20:** About to send an e-mail message to all members of the My Mailing List group

5. Click the OK button to return to your message. The recipient addresses (or group name) appear above the subject line.
6. Type the Subject and main body of the message; then click the Send button.

That’s it. The e-mail message will be sent to all intended recipients.

### Customizing and Configuring Outlook Express

Outlook Express has a ton of optional settings, all accessible via its Options dialog box. To get to the dialog box, choose Tools ➪ Options from Outlook.
Express’s menu bar. As you can see in Figure 11-21, the dialog box offers many tabs and many options. I think most are self-explanatory. If not, you can always press F1 or use Outlook Express’s Help to get more information. In the sections that follow, we’ll look at some of the main options available to you.

![Figure 11-21: The General tab of Outlook Express’s Options dialog box](image)

**General Options**

The General tab of the Options dialog box offers options that apply to Outlook Express as a while. For example, you can choose whether to play a sound when new messages arrive, whether to check for new messages automatically and how often to check, and whether to put e-mail addresses of people you reply to in your Address Book automatically.

**Read Options**

The Read tab in Options, shown on the left side of Figure 11-22, contains options for that let you control how Outlook Express gets new messages from your ISP’s Web server. You can choose whether to mark previewed messages as read and how long to wait before marking them. You also can choose the font used to display your messages.

**Receipt Options**

A “read receipt” is a message that you get, automatically, as soon as someone opens an e-mail message you’ve sent. Use read receipts when you need to know that your recipient has received your message. Secure receipts require a digital signature, described later in this chapter.
The Send tab offers options that control how the messages that you write are sent. As you can see in the left side of Figure 11-23, you can choose whether or not to save copies of sent messages to your Sent Items folder, to send messages immediately when you click the Send button (as opposed to just putting them in your Outbox). The Mail Sending Format option defines the format of each new e-mail message you create. If you want to be able to use fonts and pictures in your e-mail messages, choose HTML as your Mail Sending Format.

The Compose tab in Outlook Express’s Options dialog box, shown on the right in Figure 11-23, lets you choose options for formatting e-mail messages. For example, you can choose a default Compose Font for all new messages. You can choose a custom stationery to use as a background for your messages. And finally, you can choose whether or not to include your business card with each message you send. (You’ll need to add yourself to your Address Book for this option to work.)

The News options in Outlook Express are for working with Usenet newsgroups, not with e-mail. Most people use their Web browsers for newsgroups these days, which makes Outlook Express’s options irrelevant. For e-mail, stick to the Mail options in the dialog box.
Automatic Signature Options

Outlook Express can automatically insert a signature at the bottom of every e-mail message you send, saving you the time and trouble of doing so. To create an automatic signature, click the Signatures tab in Outlook Express’s Options dialog box, shown in the left side of Figure 11-24.
Click the New button to create a signature. Initially, the signature is named Signature #1. You can change that name to My Signature or whatever you want, using the Rename button. Once you’ve created a new, empty signature, the Edit Signature options are enabled, and you can type a signature in the Text box. It can be as simple or as complex as you want, but it can contain only text (no pictures or fonts).

As an alternative to typing a signature, you can choose the File option; then use the Browse button to specify the file that contains the signature information. The file must either be a text (.txt) file or an HTML file. A text file is one you create and save using a text-only editor like Notepad (which comes with Windows XP). And an HTML file is one you create using Hypertext Markup Language (HTML) and may contain fonts, pictures, hyperlinks, and such.

Note

HTML is a large topic and is beyond the scope of this book. You can learn what HTML is about from the World Wide Web Consortium (W3C) Web site at www.w3C.org. A brief introduction to the topic is available at http://www.w3.org/MarkUp/Guide.

Once you’ve defined a signature, you need to choose Add signatures to all outgoing messages under Signature Settings near the top of the dialog box to add the signature to all your messages. You can choose whether or not you want that signature added to your replies and forwarded messages as well.

If you don’t opt to add the signature to all outgoing messages, you can manually insert the signature anytime you’re in the New Message window or when you’re typing a reply or forwarding a message. Just move the cursor to where you want to insert the signature. Then choose Insert Signature from the menu bar above the message.

**E-mail Spelling Options**

Outlook Express’s Spelling options, shown in the right side of Figure 11-24, let you choose how to handle spell-checking in your messages. Outlook Express doesn’t have its own built-in spell checker. Instead, it uses the Microsoft Office spell-checker, if available, on your computer. If you don’t have Microsoft Office (or at least, Microsoft Word, Microsoft Excel, or Microsoft PowerPoint), spell-checking won’t be available to you as an option in Outlook Express.

**E-mail Security Options**

The Security tab in Outlook Express’s Options dialog box, shown at left in Figure 11-25, offers the Virus Protection options described earlier in this chapter, as well as more advanced features. The Internet Explorer security zone options define what’s acceptable in e-mail messages. Your options are:

✦ **Internet zone (Less secure, but more functional):** Allows objects that are generally secure, such as Java applets and signed ActiveX controls to be opened and executed in e-mail messages.
- **Restricted sites zone (More secure):** Severely restricts allowable e-mail content by preventing access even to objects whose security risk is minimal.

![Image of Outlook Express Options dialog box]

**Figure 11-25:** The Security and Connection tabs from Outlook Express’s Options dialog box

- **Tip:** For more information on Internet security zones, open Internet Explorer (Chapter 10) and choose Help ➤ Contents and Index from Internet Explorer’s menu bar. In the Help window, click the Search tab, and search for the word zone.

**About Virtual Business Cards (vCard)**

A vCard is a virtual (electronic) business card. To create one, you need to add yourself to your own Address Book. Then click your own address information in Address Book’s main pane and choose File ➤ Export ➤ Business Card (vCard) from Address Book’s menu bar. In the Export dialog box that opens, choose a folder in which to store the card (My Documents will do fine) and click Save. When writing a message in the New Message window, or replying to a message, you can add your vCard to the message by choosing Insert ➤ My Business Card.

If you receive a message with a vCard attached, the vCard appears in your message as a Rolodex card icon with a big V on it. You can then click or right-click the vCard icon and choose Open or Delete from the shortcut menu that appears. For more information, choose Help ➤ Contents and Index from Outlook Express’s menu bar. Then search for vCard.
Warn me when other applications try to send mail as me provides an alert when some program (not you) attempts to send e-mail without your knowing it. That’s exactly how most viruses spread themselves from computer to computer — by e-mail copies of themselves to people in your Address Book, using your e-mail client as the sending program. Selecting this option won’t prevent you from picking up a virus. But it will help you realize when you’ve picked one up, so you can start taking steps to remove the virus (see Chapter 13).

As mentioned in the section “Checking Your Attachment Security,” earlier in this chapter, the Do not allow attachments... option on the Security tab puts extremely tight controls on the types of attachments you can open. If you select this option, Outlook Express will block access to any attachment that could contain a worm or virus. But unlike an anti-virus program, this option can’t discriminate between those files that actually do contain a virus and those that don’t.

The Secure Mail options all concern digital signatures, a technology that allows you to verify your identity in e-mail transactions. Click the Tell me more button to learn more about digital IDs. Use the Get Digital ID button to create a digital ID. Use the Digital IDs button to manage existing digital IDs (if any).

**Connection Options**

The Connection tab of Outlook Express’s Options dialog box, shown at the right in Figure 11-25, provides options for automatically connecting to your ISP when you request mail. If you don’t have a dial-up Internet account, the Dial-Up options will be disabled. That’s because the dial-up options make no sense with broadband accounts, which don’t use traditional phone lines to provide your connection.

**Maintenance Options**

The Maintenance tab in Outlook Express’s Options dialog box provides a few options for automatically managing e-mail message. The first option, Empty messages from the Deleted Items folder on exit, keeps your Deleted Items folder from becoming huge. If you select that option, all messages in your Deleted Items folder will be deleted automatically as soon as you close Outlook Express. The disadvantage to choosing that option is that it limits your ability to undelete an accidentally deleted message. Once a message has been removed from your Deleted Items folder, it no longer exists on your hard disk and hence cannot be retrieved.

The Compact messages in the background option, if selected, tells Outlook Express to compress and compact older messages to conserve disk space. Options beneath that apply only to newsgroup messages, not e-mail.
Troubleshooting E-mail

Troubleshooting e-mail can be a tricky proposition, because there are so many players involved. But by far and away, the best resource for fixing e-mail problems is your Internet Service Provider (ISP); they’re the only ones who know the specifics of the e-mail service you’re using. You can either call them for advice or visit the Support page they provide on their Web site.

There’s also an E-mail Troubleshooter built into Windows XP, which can help with problems at your end. To get to the E-mail troubleshooter:

1. Click the Start button and choose Help and Support.
2. Click Fixing a Problem.
3. Click E-mail and messaging problems.
4. Click E-mail Troubleshooter.

If your computer manufacturer has removed the Fixing a Problem option from your Help and Support Center, type e-mail troubleshooter in the Search box in Help and Support. Then click the Go button or press Enter. Under Suggested Topics, click E-mail Troubleshooter.

On the first page of the troubleshooter that opens, click whichever option best describes the problem you’re having; then click the Next button. Follow this procedure to work your way through the problem.

If the Troubleshooter can’t help, and your ISP isn’t providing much help either, here are some other resources where you can find out more about Outlook Express:

✦ Choose Help Contents and Index from Outlook Express’s menu bar. Then use the Contents, Index, and Search tabs in the Help window to look up the information you need.

✦ Use your Web browser to visit the main Outlook Express Web site at http://www.microsoft.com/windows/oe.

✦ If you have a .NET Passport (Chapter 12), visit http://groups.msn.com/TheOutlookExpressClub.

Summary

I could spend another 100 pages rambling on about Outlook Express. It’s that big a topic. But as I mention at the start of this chapter, I don’t want to dedicate too many pages in this book to that topic. One reason is that e-mail isn’t really a Windows XP thing. It’s an Internet thing and a service provided to you.
by your ISP. Exactly how you do your e-mail is entirely up to your ISP. Windows XP plays almost no role. Outlook Express is just one of many possible e-mail clients. Whether or not it’s required, or even an option, with your particular e-mail address is entirely up to your ISP. Here’s a quick recap of what you’ve learned in this chapter:

✦ E-mail is a service of the Internet and is provided by your ISP. Different ISPs offer different types of services.

✦ Outlook Express is an e-mail client — a program for sending and receiving e-mail messages. Outlook Express is optional and isn’t even supported by all ISPs.

✦ Regardless of the program you use for e-mail, all new e-mail messages you receive end up in your e-mail Inbox.

✦ If you use Outlook Express as your e-mail client, you use the Create Mail button in its menu bar to write new e-mail messages.

✦ Windows Address Book (WAB) is a handy program for storing contact information (peoples’ names and addresses). It’s integrated with Outlook Express, so you can use it to create mailing lists and address new messages.

✦ All options for configuring and customizing Outlook Express are in its Options dialog box, which you can get to by choosing Tools † Options from Outlook Express’s menu bar.

✦ When it comes to troubleshooting e-mail problems, your best bet is to go straight to your ISP. Only they know the specifics of the e-mail service they provide.
If you’ve been using XP for a while, you may have noticed a small message popping up in the Notification Area, inviting you to set up a .NET Passport. Some of you may have already followed through on that and created your passport. Others may have totally ignored the message. It really doesn’t matter, because you can set up a .NET Passport at any time. I suppose the real question for many is “What is a .NET Passport, and why would I want one?” This chapter aims to resolve those questions.

For starters, a .NET Passport is basically a type of Internet account that provides access to services that go beyond what an ISP can provide. These added services include things such as live toll-free voice and video conversations with anyone anywhere in the world, the ability to transfer files of any size, and Remote Assistance, where you can give a trusted expert access to your computer to fix some problem. That’s just a start.

What Is a .NET Passport?

Everyone who has a .NET Passport has a unique user name. Rather than force everyone to make up some name, .NET Passport lets everyone use his or her e-mail address as a user name. The two advantages to that approach are 1) It’s easy to remember your own user name, because it’s the same as your e-mail address; and 2) No two people have the same e-mail address. So by using e-mail addresses, the uniqueness of each person’s user name is guaranteed.

In order to set up a .NET Passport, you need to know your own e-mail address, and you need to know how to send and receive e-mail using that e-mail address. Using your e-mail address as your .NET Passport user name will not affect the way you do e-mail. Even after you’ve set up your .NET Passport, you’ll continue to do e-mail exactly as you always have in the past.
Don’t be afraid to use your existing e-mail address as your .NET Passport user name, even if your e-mail address ends in @aol.com, @earthlink.com, or anything else. Your .NET Passport won’t change or interfere with your e-mail account in any way.

You’ll also have to think up a password. The password has to be at least six characters and should not contain any blank spaces. Also, passwords are case-sensitive, meaning that uppercase and lowercase letters are not treated the same. So when you create your password, use all lowercase letters so you don’t have to remember the case of each letter.

If you have a favorite password you use for all your accounts, you can use that one, which is easier than trying to remember a bunch of different passwords for a bunch of different accounts. Before you even get started, I suggest that you write down your e-mail address and password. It might sound a little goofy at first, but you’d be amazed at how many people set up their .NET Passports and two days later can’t get into their own accounts because they’ve forgotten their user name, password, or both.

✦ My .NET Passport User Name (my e-mail address, too):
  ______________
✦ My .NET Passport password: ________________________

Creating Your .NET Passport

Creating a .NET Passport for yourself is fairly easy. Your best bet will be to start right off by associating your .NET Passport account with your Windows XP user account. If you’re not sure what a Windows XP user account is, don’t worry about it. We’ll get to all of that in Chapter 23. For now, you can just click the Start button and look at the name that appears at the top of the Start menu. That name is the name of your Windows user account. Then follow these steps:

Creating E-mail Accounts for Other People

When setting up your own .NET Passport, you want to use your own e-mail address as your user name. If you want to create new e-mail addresses for other members of your family, to keep their e-mail separate from your own, you can create a new e-mail address on the fly while creating their .NET Passports. However, it would be best to create a separate Windows XP user account for each family member first. Then associate each new e-mail address and .NET Passport you create with each family member’s user account. See Chapter 23 for more information on creating using accounts.
You need only set up your .NET Passport once, not each time you intend to sign in to your account. If you've already created a .NET Passport, skip the steps presented here and go to the section titled “Opening Windows Messenger, Signing In,” later in this chapter.

1. Click the Start button and choose Control Panel.

2. Open the User Accounts icon.

3. Click the icon that represents your own user account (or whatever user account you're currently logged in to).

4. In the next window that opens, click *Set up my account to use a .NET Passport*. If you see *Change my .NET Passport* rather than *Set up my account to use a .NET Passport*, you have (or somebody else has) already set up the user account to have a .NET Passport. You can close all open windows and go to the section “Starting Windows Messenger,” later in this chapter. If you don't see any options for .NET Passport, you've clicked someone else's user account, not your own. Click the Back button, and go back to Step 3.

5. Read the first page of the .NET Passport Wizard that opens; then click the Next button.

6. The next Wizard page asks whether you already have an e-mail address. Assuming you do, choose Yes, and click Next.

7. The next Wizard page asks if you've already registered your e-mail address with a .NET Passport. Assuming you haven't, click *No, I want to register my e-mail address with Passport now*, and click Next.

8. The next Wizard page informs you that you'll be taken to a Web page where you'll be guided through the rest of the steps required to set up your .NET Passport. Click Next.

9. On the Web page that opens, shown in Figure 12-1, type your e-mail address and password exactly as you wrote them in this book earlier in this chapter. Follow all the instructions on the page carefully. Scroll down and click the I Agree button.

Assuming you did everything correctly, you'll come to a Registration is Complete page. There you can click the Continue button to return to the .NET Passport Wizard. In the Wizard, make sure the *Associate my Passport with my Windows user account* option is checked; then click Next. On the last Wizard page, click the Finish button, and you'll be returned to the User Accounts window. You can close the User Accounts window and close Control Panel as well.
If there were any problems along the way, you won’t get to the Registration is Complete page. Instead, you’ll see a description of the problem and be given some choices as to how to proceed. But once you’ve set up your .NET Passport, you’ll be able to sign in to your .NET Passport account at any time, as described in the sections that follow.

Opening Windows Messenger, Signing In

Probably the main reason most people set up a .NET Passport is so they can use the Windows Messenger program that comes with Windows XP. As you’ll learn in this chapter, Windows Messenger provides access to all sorts of .NET Passport services. To start Windows Messenger, use whichever technique is available and most convenient at the moment:

✦ Click the Start button and choose All Programs ➪ Windows Messenger.

✦ Double-click the little Windows Messenger icon in the Notification Area (shown at left).

If you’re not already signed in to your account, you’ll see your .NET Passport account user name, which is the same as your e-mail address. Click the Click here to sign in option beneath that and follow any instructions that you see on the screen. Eventually, you’ll be taken to the Windows Messenger program. The main window of that program, as it’s often called, will look something like the example shown in Figure 12-2.
Windows Messenger is similar to other programs in that it has its own title bar, menu bar, and taskbar button (when open). So you can move and size the window using all the techniques described in the section “Taking Control of Program Windows,” in Chapter 4. Before you get started using Windows Messenger, there may be a couple more things to attend to.

E-mail Address Not Verified

When you first start using Windows Messenger, you’re likely to see the E-mail Address Not Verified message near the top of the program window. E-mail verification involves guaranteeing that you do, indeed, own the e-mail address you specified. How do you verify such a thing? It’s easier than you might think. .NET Passport sends an e-mail message to the e-mail address you gave as your user name.

Sign Me in Automatically

In some situations, you’ll see an option that reads Sign me in automatically at a .NET Passport prompt. If you choose that option, you’ll be able to sign in to your account without typing your user name and password. This is perfectly safe if you’re the only person who uses this computer. But on a public computer, or a computer you share with other people, choosing that option will allow other people to sign in to your .NET Passport. As a rule, that isn’t a good idea.
Your job is to keep an eye out for that e-mail message every time you check your e-mail. All you have to do is check your e-mail as you always do (ignore the Go to my e-mail inbox option in Windows Messenger for now). Eventually, you should get an e-mail message from Microsoft Passport with Please verify your e-mail address in the Subject line. When you get that message, open it and follow the instructions it provides. Once you do that, you’ll have verified that you are, indeed, the owner of the e-mail address, and the E-mail Address Not Verified message in Windows Messenger will disappear.

A New Version of Windows Messenger Is Available

Windows Messenger has gone through quite a few revisions since it was initially packaged into Windows XP. So there’s a good chance that when you open Windows Messenger for the first time, you’ll see a message that reads A new version of Windows Messenger is not available. Click here for more information. You’ll be given the option to update (for free) your current copy of Windows Messenger. Choose Yes and click OK.

This chapter is based on Version 5.0 of Windows Messenger. To see what version you’re using, choose Help ➤ About Windows Messenger from Windows Messenger’s menu bar. Windows XP users should stay away from MSN Messenger and stick with Windows Messenger.

Then you’ll get the standard security warning that appears whenever you download and install any program. Just click Yes and follow the instructions on the screen until the update is complete. After you’ve finished this whole hullabaloo with e-mail verification and updates, everything will be ready to go, and you can forget all about setting up your account and verifying your e-mail address. From here on out, you can just sign in and use Windows Messenger as described in the sections that follow.

Instant Messaging with Windows Messenger

Instant messaging is a lot like a telephone, in that your conversation takes place in real time. Unlike the phone, which costs money, all communications via Windows Messenger are free. It doesn’t matter where in the world the other person is located. Also, with the phone, you’re limited to voice communications. With Windows Messenger, you can type messages back and forth or use voice. Throw in a Web cam, and you can see each other during the conversation as well.

There are some limitations to instant messaging, however. The person you want to communicate with also needs to have a computer, an Internet connection, a .NET Passport, and either the Windows Messenger program or MSN Messenger. Windows Messenger comes with Windows XP and is only for Windows XP. People using other versions of Windows, or a Macintosh computer, will need to download and install MSN Messenger from http://messenger.msn.com.
Setting Up Your List of Contacts

A contact in Windows Messenger is any person with whom you plan to do instant messaging. To create a contact, you just need to know that person’s .NET Passport user account name (which is the same as his or her e-mail address). Then follow these steps:

1. Choose Tools ☞ Add a Contact from Windows Messengers’ menu bar (or click Add A Contact in the lower half of the window). The Add a Contact Wizard starts.

2. Choose By e-mail address or sign-in name and click the Next > button.

3. Type the complete e-mail address of the person you plan to communicate with and click the Next> button.

4. What happens next depends on whether the person you added already has a .NET Passport. The Wizard will present your options. Just follow the instructions on the screen.

5. Click the Finish button on the last Wizard page.

You can repeat Steps 1-5 to add as many contacts as you wish. Each contact you create will appear in the main pane beneath the menu bar. For example, in Figure 12-2, I set up three contacts: Alan, David, and one whose name still appears as an e-mail address.

The first time you have a conversation with someone, his or her e-mail address in Windows Messenger is replaced by his or her display name. You need to make contact before that name will show on your screen though, because that name comes from the other person’s computer.

Starting a Conversation

Windows Messenger lists your contacts in two groups: those currently online (and therefore available for instant messaging) and those not online. For example, in Figure 12-2, my contacts named Alan and David were both online. (Click the Online or Not Online heading to show/hide items under each heading.)

If your contacts are shown in groups other than Online/Not Online, choose Tools ☞ Sort Contacts By ☞ Online/Offline from Windows Messenger’s menu bar.

You can start a conversation with anybody who is currently online by sending an instant message. Just double-click the online contact’s name, or right-click the name and choose Send An Instant Message to get started.

A Conversation window opens, like the example shown in Figure 12-3. The Conversation window is separate from Windows Messenger’s main window and has its own separate taskbar button. You can move and size the Conversation window like any other program window and independently of the main window.
To send a message to someone, type in the lower portion of the window near the Send button. Type your message; then press Enter or click the Send button. Whatever you typed moves up into the Conversation area and also appears in the Conversation area of whomever you’re talking to. Figure 12-3 shows the Conversation window with a conversation between two people just getting started.

![Conversation window with a conversation in progress](image)

Figure 12-3: The Conversation window, with a conversation in progress

While typing in the Conversation window, you can use all the standard text-editing techniques described in Chapter 7. But one difference in the Conversation window is that when you press Enter, you don’t start a new paragraph. Instead, you send the message (the same as clicking the Send button). If you want to start a new line or paragraph without sending the message, press Shift+Enter or Ctrl+Enter (once or twice).

### Adding Emoticons

Emoticons (emotion icons) are little symbols you can use to express emotions in your typed messages. To add an emoticon to your message, just make sure the cursor is positioned where you want to place the icon in your text. Click the Emoticons button; then click the icon you want to insert. You can edit emoticons like text. For example, to delete an emoticon from your message, move the cursor just to the right of that icon, and press the Backspace key.

If you don’t have an Emoticons button just above where you type your text, choose View ➪ Show Toolbar from the Conversation window’s menu bar.
You can also type emoticons using special combinations of keystrokes. For example, typing :D or :d displays the happy-face emoticon. Typing :-(( or :(( types the sad-face emoticon and so forth. Table 12-1 lists the emoticons and the optional keys you can use to type them.

<table>
<thead>
<tr>
<th>Emoticon</th>
<th>Name</th>
<th>To type</th>
</tr>
</thead>
<tbody>
<tr>
<td>👍</td>
<td>Happy</td>
<td>:-D or :d</td>
</tr>
<tr>
<td>😞</td>
<td>Sad</td>
<td>:-(( or :((</td>
</tr>
<tr>
<td>😂</td>
<td>Wink</td>
<td>:-)) or :)</td>
</tr>
<tr>
<td>🌟</td>
<td>Angel</td>
<td>(A) or (a)</td>
</tr>
<tr>
<td>😡</td>
<td>Angry</td>
<td>:-@ or :@</td>
</tr>
<tr>
<td>😎</td>
<td>Cool</td>
<td>(H) or (h)</td>
</tr>
<tr>
<td>🤨</td>
<td>Confused</td>
<td>:-S or :s</td>
</tr>
<tr>
<td>😢</td>
<td>Crying</td>
<td>:'(</td>
</tr>
<tr>
<td>😶</td>
<td>Embarrassed</td>
<td>:§ or :-§</td>
</tr>
<tr>
<td>😮</td>
<td>Surprised</td>
<td>:-O or :o</td>
</tr>
<tr>
<td>😈</td>
<td>Tongue out</td>
<td>:-P or :p</td>
</tr>
<tr>
<td>😯</td>
<td>Watchu Talking About?</td>
<td>:-</td>
</tr>
<tr>
<td>😊</td>
<td>Smile</td>
<td>:-)) or :)</td>
</tr>
<tr>
<td>😞</td>
<td>Crying (animated)</td>
<td>:'(</td>
</tr>
<tr>
<td>🤢</td>
<td>Sick</td>
<td>+o(</td>
</tr>
<tr>
<td>🤫</td>
<td>Secret</td>
<td>:-*</td>
</tr>
</tbody>
</table>

Continued
<table>
<thead>
<tr>
<th>Emoticon</th>
<th>Name</th>
<th>To type</th>
</tr>
</thead>
<tbody>
<tr>
<td>😛</td>
<td>Lips sealed</td>
<td>:-#</td>
</tr>
<tr>
<td>😛</td>
<td>Nerdy</td>
<td>8-</td>
</tr>
<tr>
<td>😨</td>
<td>Doubtful (animated)</td>
<td>:^)</td>
</tr>
<tr>
<td>😨</td>
<td>Boring (animated)</td>
<td></td>
</tr>
<tr>
<td>😞</td>
<td>Eye roll (animated)</td>
<td>8-)</td>
</tr>
<tr>
<td>⭐</td>
<td>Star</td>
<td>(*)</td>
</tr>
<tr>
<td>🐌</td>
<td>Thumbs down</td>
<td>(N) or (n)</td>
</tr>
<tr>
<td>🌟</td>
<td>Thumbs up</td>
<td>(Y) or (y)</td>
</tr>
<tr>
<td>🌸</td>
<td>Rose</td>
<td>(F) or (f)</td>
</tr>
<tr>
<td>🌸</td>
<td>Wilted rose</td>
<td>(W) or (w)</td>
</tr>
<tr>
<td>😘</td>
<td>Kiss</td>
<td>(K) or (k)</td>
</tr>
<tr>
<td>❤</td>
<td>Love</td>
<td>(L) or (l)</td>
</tr>
<tr>
<td>💔</td>
<td>Broken heart</td>
<td>(U) or (u)</td>
</tr>
<tr>
<td>😛</td>
<td>Bat</td>
<td>:-[ or :[</td>
</tr>
<tr>
<td>🐶</td>
<td>Dog</td>
<td>(&amp;)</td>
</tr>
<tr>
<td>🐱</td>
<td>Cat</td>
<td>(@)</td>
</tr>
<tr>
<td>🤾</td>
<td>Dude hug</td>
<td>()</td>
</tr>
<tr>
<td>🤾</td>
<td>Girl hug</td>
<td>()</td>
</tr>
<tr>
<td>🖐️</td>
<td>Hands across (girl)</td>
<td>(X) or (x)</td>
</tr>
<tr>
<td>Emoticon</td>
<td>Name</td>
<td>To type</td>
</tr>
<tr>
<td>----------</td>
<td>-----------------------</td>
<td>---------</td>
</tr>
<tr>
<td><img src="handsacross.png" alt="Hands across (guy)" /></td>
<td>Hands across (guy)</td>
<td>(Z) or (z)</td>
</tr>
<tr>
<td><img src="messenger.png" alt="Messenger" /></td>
<td>Messenger</td>
<td>(M) or (m)</td>
</tr>
<tr>
<td><img src="brightidea.png" alt="Bright idea" /></td>
<td>Bright idea</td>
<td>(I) or (i)</td>
</tr>
<tr>
<td><img src="coffee.png" alt="Coffee" /></td>
<td>Coffee</td>
<td>(C) or (c)</td>
</tr>
<tr>
<td><img src="time.png" alt="Time" /></td>
<td>Time</td>
<td>(O) or (o)</td>
</tr>
<tr>
<td><img src="birthday.png" alt="Birthday" /></td>
<td>Birthday</td>
<td>(^)</td>
</tr>
<tr>
<td><img src="party.png" alt="Party" /></td>
<td>Party</td>
<td>&lt;:O)</td>
</tr>
<tr>
<td><img src="gift.png" alt="Gift" /></td>
<td>Gift</td>
<td>(G) or (g)</td>
</tr>
<tr>
<td><img src="music.png" alt="Music" /></td>
<td>Music</td>
<td>(B)</td>
</tr>
<tr>
<td><img src="telephone.png" alt="Telephone" /></td>
<td>Telephone</td>
<td>(T) or (t)</td>
</tr>
<tr>
<td><img src="picture.png" alt="Picture" /></td>
<td>Picture</td>
<td>(P) or (p)</td>
</tr>
<tr>
<td><img src="movie.png" alt="Movie" /></td>
<td>Movie</td>
<td>(~)</td>
</tr>
<tr>
<td><img src="mail.png" alt="Mail" /></td>
<td>Mail</td>
<td>(E) or (e)</td>
</tr>
<tr>
<td><img src="beer.png" alt="Beer" /></td>
<td>Beer</td>
<td>(B) or (b)</td>
</tr>
<tr>
<td><img src="martini.png" alt="Martini" /></td>
<td>Martini</td>
<td>(D) or (d)</td>
</tr>
<tr>
<td><img src="moon.png" alt="Moon" /></td>
<td>Moon</td>
<td>(S)</td>
</tr>
</tbody>
</table>

**Tip**

To see the complete set of emoticons, including animated ones, go to [http://messenger.msn.com/Resource/Emoticons.aspx](http://messenger.msn.com/Resource/Emoticons.aspx). To see all other add-ons and some more freebies, go to [http://messenger.msn.com](http://messenger.msn.com).

**Choosing a Message Font**

You can choose a font, size, and color for the text you type. Just click the Font button above where you type your message. In the *Change My Message Font* dialog box that opens, choose the Font, Style, and Size you want to use. Use
the Effects options to choose Strikeout font, underline, and/or a color. Then click OK.

In Figure 12-3, the line that starts with *Alan* is Comic Sans MS, Regular, 14 point size. The *Not really* message is in Monotype Corsiva, Regular, 14 point size.

**Pasting to the Conversation Window**

As you know, anywhere you can type, you can also paste. The typing area of the Conversation window is no different. For example, you can select (drag the mouse pointer through) any chunk of text from a document, Web page, e-mail message or whatever, and press Ctrl+C to copy it. Then either right-click in the typing area of the Conversation and choose Paste, or click the exact spot in the typing area where you want to paste the copied text and press Ctrl+V.

You can’t paste a picture to the typing area — only text. If you try to paste a picture, Paste will be disabled on the shortcut menu, and pressing Ctrl+V will do nothing. But you can always send a picture as a file, as described later in this chapter.

If you use Microsoft Internet Explorer as your Web browser, you can copy and paste a hyperlink from a Web page into your message. In Internet Explorer, right-click the hyperlink you want to copy and choose Copy Shortcut. Then right-click in the typing area of your Conversation and choose Paste. The actual URL will show. But it will be hot (meaning that the recipient can get to the site just by clicking the link in the message you send).

**When Someone Contacts You**

Just as you can add contacts to your copy of Windows Messenger, your friends can add you to their list of contacts. If you’re online and signed in to your .NET Passport when someone else adds you to his or her list of contacts, you’ll see the dialog box shown in Figure 12-4. If the person is someone you’re interested in conversing with, choose the first option. If it’s some knucklehead you can do without, choose the second option. Then you can decide whether or not you want to add that person to your own list of contacts, and click OK.

![Figure 12-4: Someone is adding you as a contact in his or her copy of Windows Messenger.](image)
Once you’ve allowed someone to contact you via Windows Messenger, you’ll be alerted when that person sends you an instant message, via the Notification Area message shown in Figure 12-5. The taskbar button for the conversation window will also change color and blink. Click that taskbar button to open the Conversation window and have your conversation.

Figure 12-5: Yoo-hoo — someone wants to have an instant message conversation.

Inviting Others to Join In

Up to five people can join in on an instant message, provided you’re typing messages back and forth (only two people when you get voice or video involved, however). To invite someone to join your conversation, click *Invite Someone to this Conversation* under *I want to...* in the sidebar. Or choose *Actions ➪ Invite Someone to this Conversation* from the Conversation Window’s menu bar. In the Add Someone... dialog box that opens, click the name of the person you want to add. Or click the Other tab, and enter the new person’s .NET Passport user name (usually the same as the person’s e-mail address). Click OK.

Inviting Others to Get Lost

If anyone starts being a pain in a conversation, you can prevent that person from sending you more messages. To block anyone in the current conversation, click the Block button in the toolbar; then click the name of the person you want to block. There are other ways to block people, as you’ll learn under “Managing Your Contacts,” later in this chapter. But the Block button on the toolbar is a quick and easy way to kick someone out of the current conversation.

Ending a Conversation

To end a conversation, just close the Conversation window. The Windows Messenger window will remain open, so you can still start or accept other conversations. To go offline entirely, so nobody can reach you, choose File ➪ Sign Out from the menu bar in Windows Messenger.
Your **Do Not Disturb Options**

If you stay online, but don’t actually use your computer for about 10 minutes, Windows Messenger will automatically change your status to *Away*, like David’s status back in Figure 12-2. You can set your own status message at any time. Whatever you choose will appear next to your name in all the Windows Messenger programs that have you as a contact.

To change your status:

✦ Choose File ➪ Status from Windows Messenger’s main window, as in the top part of Figure 12-6. Then click the status message you want to display next to your name.

✦ Or right-click the little Windows Messenger icon in the Notification Area and choose My Status, as in the bottom part of Figure 12-6; then click the status message you want to display.

![Windows Messenger](image)

**Figure 12-6:** Change your status from Windows Messenger’s File menu or its Notification Area icon.

If you find that Messenger has changed your status to *Away* automatically and you want to change that, just use either of the preceding techniques to change your status to Online (or to whatever you want). If you want Windows Messenger to stop showing you as *Away* after 10 minutes of inactivity, you can disable or change that setting using its Options dialog box, described in the section “Configuring Windows Messenger,” later in this chapter.
If you want to see (who is online) without being seen, set your status to Appear Offline. You’ll be able to see who is online. But everyone else will think you’re offline.

Regardless of your status, you can still see who is online at the moment by opening Windows Messenger. If you want to disconnect altogether, right-click the same Windows Messenger icon in your Notification Area and choose Sign Out. You won’t be logged in to your .NET Passport anymore. All your contacts will see you as Not Online.

To get back online to communicate with your contacts, you’ll need to right-click the Windows Messenger icon in your Notification Area and choose Sign in . . . from the menu that appears.

Transferring Files and Photos

While you’re in a conversation with someone, you can send files to each other. Unlike e-mail, which tends to put a limit on the size of the file you can attach to a message, there really is no size limit on transferring files in a conversation. Of course, the larger the file, the longer it will take to transfer, especially if either party in the conversation is using a dial-up connection.

**STEPS: Send/Receive Files in a Conversation**

1. If you haven’t already done so, start a conversation with the person to whom you want to send a file.
2. Click *Send a File or Photo* under *I want to...* in the Conversation window’s sidebar.
3. The Send a File... dialog box that opens is the same as an Open dialog box, in the sense that you first have to get to the folder that contains the file(s) you want to send. For example, to send a picture from your My Pictures folder, choose My Documents from the Look In drop-down list; then double-click My Pictures in the main pane.
4. Double-click the file you want to send.
5. The recipient gets an invitation to accept the file. If the recipient clicks Accept, the file will be transferred.

Assuming you’re the sender of the file, there’s nothing left to do. The file is transferred and that’s the end of it.

If someone sends you a file using this method, you’ll be given the option to Accept or Decline the transfer. When you choose Accept, the file will be copied to your computer; then you’ll see a message like the one shown in Figure 12-7.
Figure 12-7: This person has received a file transferred by someone in a conversation.

The big chunk of underlined text is the path to the transferred file. The C:\Documents and Settings\Alan\My Documents\My Received Files is the path to the My Received Files folder in Alan’s My Documents folder. Vacation 2003 001.jpg is the name of the file. The whole path is a hyperlink. So if you just click that, the file will open in whatever program is appropriate for that file type.

Tip If you miss the opportunity to click the link in the message, choose File ➤ Open Received Files from Windows Messenger’s menu bar to open the folder where all your received files are stored.

If you don’t have a program capable of opening the file you’ve received, you’ll get the Windows Cannot Open This File message described in the section “When Windows Can’t Open a Document,” in Chapter 6. You’ll either need to send the file in a format you can open or to download and install (if possible) a program capable of opening that file type.

You can also get to your My Received Files folder at any time (even when you’re not using Windows Messenger) by opening your My Documents folder and double-clicking the My Received Files icon (shown at left) in My Documents. When you open (double-click) the My Received Files folder’s icon, you’ll see all files you’ve received through Windows Messenger file transfers. (You can then move those files to more appropriate folders, using any of the techniques described in Chapter 19.)
Toll-Free Talking

If you’re not a big fan of typing messages, you can communicate with other Windows Messenger users by voice. But you’ll need one extra piece of computer hardware to do that — a microphone (and speakers, to hear what the other person is saying). If you don’t have a microphone for your computer, you can buy one at any computer store. Microphones that you wear on your head are generally better than the ones you just set on your desktop, because having the microphone close to your mouth helps cancel out all the background sound in the room.

Telex Communications makes several USB microphone headsets that you might want to check out next time you’re shopping online or at a computer store. USB is good, because it means you just have to plug it into your computer to use it. There’s no complicated installation to go through. The first time you use your microphone, you’ll need to run the Audio Tuning Wizard to get the best performance from Windows Messenger. Here’s how:

1. Open Windows Messenger, if it isn’t already open, by double-clicking the Windows Messenger icon in the Notification Area or by clicking the Start button and choosing All Programs ▶ Windows Messenger.

2. From the menu bar in the Windows Messenger window, choose Tools ▶ Audio Tuning Wizard.

3. Follow the instructions that appear on each page of the Wizard. Click the Next button after completing each page.

4. When you get to the Wizard page that asks which microphone and speakers you want to use, you probably won’t need to change the Speakers option. But you should definitely click the drop-down list for the Microphone option and choose whichever microphone description best describes the microphone you’ll be using. For example, in Figure 12-8, I selected Telex USB microphone as my Microphone; that’s the type of microphone I have plugged in to my computer.

![Audio and Video Tuning Wizard](image)

**Figure 12-8:** Choosing your microphone in the Audio Tuning Wizard
After you’ve installed a microphone and have run the Audio Tuning Wizard, you’re ready to talk online. This is easy to do:

✦ If you’re already having a conversation with someone in the Conversation window and want to switch to voice, click Start Talking in the Conversation window.

✦ If you’re not already in a typing conversation with someone, open Windows Messenger normally. Then right-click the name of the Online contact you want to talk to and choose Start a voice conversation. The contact will receive a message that you’re ready to talk and will reply if ready.

The recipient will get a text message that shows your name followed by . . . 

**would like to have a voice conversation with you. Do you want to Accept (Alt+T) or Decline (Alt+D) the invitation?** You’ll then get some feedback as to whether the recipient accepted or declined. Assuming the person accepted, you can just start talking.

To adjust the volume of the other person’s voice, drag the Speakers slider left or right under the Stop Talking heading (see Figure 12-9). If the other person has trouble hearing you, try increasing the volume of your microphone by using the Microphone volume control slider. (That person could, however, turn up his or her speakers.)

**Figure 12-9:** Volume controls under Stop Talking (upper left) appear in a voice conversation.

When you’re ready to end a voice conversation, click Stop Talking in the Conversation window. It’s easy!
Twenty-First Century Toll-Free Videophone

You can update your toll-free Windows Messenger voice communications to voice plus live video, provided you have a Web cam. A Web cam is a small, inexpensive digital video camera that doesn’t record video. Rather, it just sits on top of your computer monitor and shows your face live to the person with whom you’re conversing in Windows Messenger.

Video communications work best with broadband Internet connections, such as cable or DSL. You can still use a Web cam with a dial-up account and modem, but the picture won’t be as smooth as, say, regular TV. The video will look a little jerky, like pictures sent from astronauts in the early days of the space program. But not a big deal — you can still see and hear each other.

If you’ve never seen or heard of a Web cam, you can check out some available products at any computer store or large office-supply store. Optionally, you can go to any online store that sells computer stuff and search for Web Cam. You don’t need anything particularly fancy, though. Any USB Web Cam compatible with Windows XP will do. A few models have built-in microphones, which saves you from having to install both a microphone and the camera.

Once you’ve installed a Web cam, you can start a video conversation with someone in the same way that you start a voice conversation. That is, if you’re already in a typing conversation with someone, you can just click Start Video to turn on your Web cam. If you’re not already in a conversation with someone, open Windows Messenger, right-click any contact who is online, and choose Start a Video Conversation. The recipient will get an invitation that he or she can accept or decline. If the recipient accepts, you’ll automatically get both voice and video once the connection is made.

Once you’re in a voice and/or video conversation, as in Figure 12-10, you can use the Speakers and Microphone sliders to adjust the volume of your conversation. If you’re having a bad-hair day, and don’t particularly want to be showing it off on your Web cam, you can click the Stop Camera button on the right side of the Conversation window to keep talking without sending your video image.
Using Remote Assistance

Remote Assistance is a special feature of Windows Messenger where you can have a typing, voice, and/or video conversation going on. But you can also turn control over to a trusted expert. The expert can then see your screen on her screen. And she can work your computer using her own keyboard or mouse. This is why we use the term *trusted expert*. You wouldn’t want to turn your computer over to a crook or knucklehead.

Unfortunately, there aren’t any free experts floating around, helping people with their computers. The only trusted expert you’re going to be able to get is someone you know and who (you can hope) knows a lot about computers. It could be your son or daughter, brother-in-law, or computer guy at the office — anyone with a Windows XP computer and an Internet account.

Remote assistance is definitely slow if either party has a dial-up account. Leave the video off, and maybe even the voice up, to free up bandwidth for all the other activity involved in controlling your computer from afar.

Starting a Remote Assistance Session

Starting a Remote Assistance session is a lot like starting any other conversation. First, your trusted expert needs to be online. If you’re already in a Conversation window with the person, click *Ask for Remote Assistance* in the sidebar of the Conversation window. Otherwise, in Windows Messenger’s main window, right-click the online contact who’ll be your trusted expert, and choose Ask for Remote Assistance. Either way, a Conversation window opens, and an invitation is sent to the recipient.

If the recipient accepts the invitation, you’ll get some feedback to that effect. Then it will take a while to get your screen over to the expert’s screen.
Eventually, you’ll get a dialog box confirming the invitation. Click Yes to chat with the expert. When the expert attempts to take control of your screen (by clicking Take Control), you’ll see the dialog box shown in Figure 12-11.

Assuming you click Yes to give control to your expert, you won’t notice too much change on your screen. There will be a large chat area for Remote Assistance, as on the right edge of Figure 12-12. And you can use that to converse by typing, voice, and/or video while the expert has control. The other change will be that Casper the Ghost will be working your screen. Well, it might seem like a ghost. It’s actually your trusted expert working your computer with her mouse and keyboard.

![Figure 12-11: Are you ready to turn control of your computer over to this trusted expert?](image1.png)

![Figure 12-12: What you see while getting Remote Assistance from a trusted expert](image2.png)
Ending a Remote Assistance Session

You’ll be able to see everything the expert is doing. If you think she’s getting into places you don’t want her to be, tap the Escape (Esc) key at the upper-left edge of your keyboard. That will instantly cut off the expert’s control of your computer. If you totally want to disconnect from the expert (not even be able to chat), click Disconnect in the Remote Assistance window. Or close that Remote Assistance window.

You’ll be lucky to find such a trusted expert somewhere. Unfortunately, there are no businesses out there that provide free trusted experts you can contact on the fly when you have a question or problem. And truthfully, very few people have any compu-nerdy friends or relatives to call upon. But if you have someone in mind, Remote Assistance is the way to go for fixing problems without taking the computer anywhere.

Working in Teams

Windows Messenger’s Application Sharing is a feature that allows two people to view the same program, and same document, on their screens at the same time, even if they’re thousands of miles apart. Application Sharing is another one of those high-bandwidth applications that really work best if all parties are using broadband accounts. Using Application Sharing with a dial-up modem will require some patience, because things will be very slow indeed.

Many programs in Microsoft Office have a Collaborate option on their tools menu, which you can use to schedule and start online meetings right on the spot.

To use Application Sharing, get into a conversation with the person (or persons) you want to team up with as described under “Starting a Conversation,” earlier in this chapter. Then open the document you want to share. The appropriate program will open as well.

In your Conversation window, click Start Application Sharing under I want to... in the sidebar, or choose Actions ➔ Start Application Sharing from the menu bar in the Conversation window. The recipient receives an invitation to share the application. If she clicks Accept, both of you will see a little Sharing Session window, like the example shown in the upper-left side of Figure 12-13. It may take a few seconds for the Connected message to show and the buttons to be enabled. So you may need to be patient there.

If you’re the person who started Application Sharing, you’ll also see the Sharing window, shown in the lower right of Figure 12-13. That window might be covering the small one. But you can move it around by dragging its title bar. Either person in the conversation can open the Sharing window by clicking the App Sharing button in the smaller Sharing Session window.

The word application is synonymous with program. App is slang for application.
The next step is to choose the document (or program) you want to share. If you forgot to open that document first, you can do so right now. If the document you plan to share is a photo, and you both have high-speed Internet connections, you can choose *Share in True Color*. But choosing that option does slow things down. If it’s not really necessary for the other person to see the entire document in photographic-quality color, you can leave that option unselected to speed up the sharing.

Next, click the name of the document (or program) you want to share with the other person; then click the Share button. The document and program open up on your screen and also open up on the recipient’s screen. You can both see the same program and same document on your screens at the same time.

At first, the other person will be able only to see the document (not to make and changes to it). If you want to allow the other person to make changes to the document, click the Allow Control button. The other person can then request control of the program by choosing Control ➪ Request Control from a window that appears only on his or her side of the conversation. When that person requests control, you’ll see a message on your screen informing you of the request. You have to click its Accept button to allow the other person to take control.

If both of you are working on the document, and you get sick of the other person’s requests for control, choose either, or both, options beneath the Prevent Control button that now appears. If you choose the *Automatically accept requests for control* option, you’re basically allowing the other person to take control whenever desired, so you don’t have to be bothered clicking Accept anymore. The *Do not disturb . . .* option is the same idea. But if you don’t select *Automatically accept . . .*, all requests for control will just automatically be denied, and only you will have control of the program.
While you’re in an Application Sharing session, things will really slow down if you both try to work the mouse pointer at the same time. If you can resist the temptation to touch the mouse while the other person has control of the program, you’ll save time.

To stop sharing a document or program, click its name in the Share Programs list; then click the Unshare button. If you’re sharing several programs, click the Unshare All button to stop sharing all of them. To close the Sharing dialog box, click its Close button. (To reopen it, click the App Sharing button in the Sharing Session dialog box.) To terminate the Application Sharing session altogether, either member of the conversation window can click the Close button in the Sharing Session dialog box.

Remember that any changes made to the document during your sharing session will be saved only on your computer and only if you save the document.

### Using the Whiteboard

I guess everyone knows what a blackboard is. A whiteboard is the same idea. But on a whiteboard you write with Dry-Erase Markers rather than chalk. The Whiteboard in Windows Messenger is similar to a whiteboard in a classroom. But you draw on this Whiteboard with your mouse. You can also paste pictures to your virtual Whiteboard. To use the Whiteboard in a Windows Messenger conversation, first start the conversation as described earlier in this chapter. You can have up to five people in the conversation.

Then click **Start Whiteboard** under *I want to* . . . in the Conversation window’s sidebar, or choose **Actions** ➪ **Start Whiteboard** from the Conversation window’s title bar. The Sharing Session window described in the previous section will open. A few seconds later, the Whiteboard pops up on your screen, as well as on the screens of everyone else in the conversation. (Not immediately though, so be patient.)

If you’re already in an Application Sharing session, you can just click the Whiteboard button in the Sharing Session dialog box to open the Whiteboard.

The Whiteboard is its own program window, with its own title bar, menu bar, and taskbar button. It also offers several tools around its border, pointed out in Figure 12-14 and summarized as follows:
**Drawing tools:** Point to any tool to see its name. Click any tool to use it. Going from left to right, top to bottom, the tools are:

- **Selector:** The normal mouse pointer. Use it to move (drag) items on the Whiteboard or to change/delete an item by right-clicking it.
- **Eraser:** Click this tool; then drag a rectangle around anything you want to erase in the Whiteboard. (Careful, there is no *undo* in Whiteboard!)
- **Text:** To type text on the Whiteboard, click this tool; then click the Font Options button that appears in the program window. Choose a font, style, size, and color; then click OK. On the Whiteboard, click where you want to place the text, and type your text. When you’re done, click the Selector tool in the Drawing tools to get back to a normal cursor. To change or delete a chunk of text, use the normal Selector tool to right-click the text. Then choose an option from the shortcut menu that appears.
- **Highlighter:** To highlight something on the Whiteboard, click this tool, click a line width, and click a color. Then drag the mouse pointer through whatever you want to highlight.
- **Pen:** To draw freehand, click this tool, click a line width, and click a color. To draw, drag the mouse pointer around on the Whiteboard.
- **Line:** To draw a straight line, click this tool, click a line width, and click a color. In the Whiteboard, point to where you want to
start the line, and drag the mouse pointer in the direction you want to extend the line. Release the mouse button when the line is the desired length and angle.

- **Unfilled Rectangle:** To draw an empty rectangle, click this tool, click a line width, and click a color for the line. Drag out your rectangle on the Whiteboard.

- **Filled Rectangle:** Same technique as previously, but no need to select a line width, because the rectangle you draw will be a solid shape.

- **Unfilled Ellipse:** To draw an empty circle or ellipse, click this tool, click a line width, and click a color for the line. Then drag out your ellipse on the Whiteboard.

- **Filled Ellipse:** Same technique as previously, but no need to select a line width, because the ellipse you draw will be a solid shape.

- **Zoom:** To zoom in on the Whiteboard, click this tool. Click it again to zoom out.

- **Remote Pointer On:** Kind of the same idea as a laser pointer on a real whiteboard. All viewers should click this button to make the remote pointer visible. Then anyone can drag the pointer to call attention to any item. Click the same button again to turn the Remote Pointer off.

- **Lock Contents:** To prevent other people in the Conversation window from messing with your beautiful artwork, click this button. The drawing tools on all their Whiteboards will be disabled (dimmed), so they can’t change the drawing. Click this button a second time to unlock the Whiteboard.

- **Unsynchronize:** Any conversation member can use the Pages buttons to insert new pages and scroll through existing pages. Normally, if one member scrolls to a new page, everyone’s Whiteboard scrolls to the same page. Click the Unsynchronize button to prevent that so you can create and scroll through pages independently. Click this button a second time to get back in synch with other conversation members.

- **Select Area:** To paste a snapshot of some portion of your screen into the Whiteboard, click this button. The mouse pointer turns to crosshairs, and the Whiteboard temporarily disappears. Drag a rectangle around the portion of the screen that you want to copy to the Whiteboard. When you release the mouse button, the Whiteboard will reappear, containing a snapshot of the area you lassoed.

  **Tip:** To move a pasted snapshot, click the Selector tool in the Drawing tools area, and drag the item to its new location. To change or delete one, click the Selector tool in the Drawing tools, and click the item to select it. Then right-click the item to see your options for changing or deleting it.
• **Select Window:** To paste a snapshot of an entire program window into the Whiteboard, size and position that window on your desktop so it will fit. Then click the Select Window button. The mouse pointer changes to crosshairs in a rectangle. To take a snapshot, click the title bar of the subject window.

✦ **Line widths:** Available after clicking any tool that draws lines. Click any line width to select it.

✦ **Colors:** The large square at left shows the currently selected color. Click any color square to the right to draw in that color.

✦ **Pages:** Use these buttons to scroll through multiple-page Whiteboards. Click the rightmost button to create a new Whiteboard page.

### Pasting into the Whiteboard

You can use the Select Area tools described previously to paste a copy of anything currently visible on your screen into the Whiteboard. For example, if your My Pictures folder is showing pictures in Filmstrip or Thumbnails view, you can use the Select Area tool in the Whiteboard to drag a frame around an image to paste it into the Whiteboard.

To copy a picture that’s in some open document, like a Web page, you can right-click the picture and choose Copy. Then choose **Edit** \( \Rightarrow \) **Paste** from the Whiteboard’s menu bar. To copy a snapshot of text from some document to the clipboard, first select that text in its current program window by dragging the mouse pointer through the text. Then press Ctrl+C or right-click the selected text and choose Copy. Then choose **Edit** \( \Rightarrow \) **Paste** from the Whiteboard’s menu bar.

To move or change a pasted picture or chunk of text, first click the Selector tool in the Drawing tools area. Then drag the item to some new location on the Whiteboard, or right-click the picture to see your other options. Note that the text will be a snapshot of the original text, treated as a unit. You can’t edit the pasted text, because it will be treated as a single unit — like a picture — in the Whiteboard.

### Erasing from the Whiteboard

You can erase material from the Whiteboard in a few ways:

✦ To erase the entire Whiteboard at once, choose **Edit** \( \Rightarrow \) **Clear Page** from the Whiteboard menu bar or press Ctrl+Delete. Then choose Yes when asked for confirmation.

✦ To delete an object from the Whiteboard (such as a chunk of text or picture), click the Selector tool in the Drawing tools. Then right-click the item you want to delete and choose Delete.

✦ To erase a drawn object or block of text, click the Eraser tool in the Drawing tools. Then drag a rectangle around the items you want to
erase. (To undo the deletion, choose Edit ➪ Undelete from the menus or press Ctrl+Z.)

✦ To delete individual letters that you typed using the Text tool, click the Text tool in the Drawing tools. On the Whiteboard, select the letters that you want to erase, and press the Delete (Del) key.

**Saving a Whiteboard**

To save a Whiteboard, choose File ➪ Save from the Whiteboard’s menu bar. Navigate to the folder in which you want to place the board (My Documents will do just fine), type a file name, and click OK. To reopen that Whiteboard in a future Whiteboard session, choose File ➪ Open from the Whiteboard’s menu bar. Navigate to the folder in which you saved the Whiteboard and double-click its icon.

**Closing a Whiteboard Session**

To close a Whiteboard session, just close the Whiteboard’s program window by clicking its Close button or by choosing File ➪ Exit from the Whiteboard’s menu bar. If you haven’t already saved the Whiteboard, you’ll be given one last chance to do so. The Sharing Session dialog box will remain open. To fully end the Whiteboard session, click its Close button.

**Managing Your Contacts**

Windows Messenger’s main window shows all the contacts you’ve added through the Add a Contact option. There are two ways to view those contacts: You can group them simply as either Online or Offline, as in the example shown in Figure 12-2, or you can choose Tools ➪ Sort Contacts By ➪ Groups to see contacts organized into groups such as Coworkers, Family, Friends, or any other group name you wish, as in the example shown in Figure 12-15. You can still easily tell which contacts are online and offline by the colors of their icons and the statuses to the right of their names.

**Grouping Contacts**

When viewing contacts by groups, you can click any group name to show, or hide, the contacts within that group. Initially, all your contacts will be in the All Contacts group at the bottom of the list. To group your contacts, follow these steps:

In the All Contacts list, right-click the contact you want to group and choose Copy Contact To and the name of the group to which you want to add the contact. The contact is copied to that group.

**Tip**

The All Contacts list always contains all your contacts. There’s no way to move a contact out of the All Contacts list and into a group.
If you copy a contact to a group, but later change your mind, there are a couple of ways to deal with the problem. First, make sure you can see all members of the group in which the contact is currently stored. Then right-click the contact’s icon within the group. Since you’re not in the All Contacts list, you’ll see a couple of other options that aren’t availing in that list:

✦ **Move Contact To:** To move the contact from the current group to another, click this option, and click the group to which you want to move the contact.

✦ **Remove Contact from Group:** To remove the contact from the current group, click this option. The contact will remain in All Contacts and in any other groups to which the contact is a member.

**Creating Groups**

You’re not limited to the few sample groups that first appear in Windows Messenger. You can create whatever groups you wish. To create a new group, click **Add a Group** under *I want to...*, or choose **Tools ➪ Manage Groups ➪ Add a Group** from Windows Messenger’s menu bar. A group named *New Group* appears, with its name selected. Type a new name, and press Enter.

If you make a mistake, right-click the group name and choose Rename Group. Edit the name, or type a new name. Then press Enter.

Once you’ve created a group, you can use the **Copy Contact To** and **Move Contact To** options described previously to add contacts to your new group.
Deleting Groups
To delete a group, first remove all contacts from the group. To remove a contact, right-click its icon within the group. Then move the contact to a different group, or delete it from the current group. After the group is empty, right-click its name and choose Delete Group.

Deleting a Contact
To delete a contact from all groups, first open your All Contacts group. Within the All Contacts list, right-click the contact you wish to delete. (Or click the group name and press the Delete key.) You’ll see a dialog box asking if you’re sure you want to complete the deletion. If you choose Yes, you’ll permanently delete the contact from all groups. If that isn’t your intention, choose No.

Configuring Windows Messenger
Like most programs, Windows Messenger has an Options dialog box that you can use to control how the program behaves. You get to that Options dialog box the same way you do in many other programs — by choosing Tools ➪ Options from Windows Messenger’s menu bar. In the sections that follow, we’ll look at how you can use those options to control how Windows Messenger starts, your degree of privacy, and more.

Choosing Your Display Name and Font
Even though you add contacts to Windows Messenger via your contacts’ e-mail addresses, your contacts’ names usually appear in your list of contacts. Each user gets to choose a Display Name. When you choose Tools ➪ Options from Internet Explorer’s menu bar, the first choice you come to (on the Personal tab) is your Display Name, as shown in Figure 12-16.

The My Message Text options on the Personal tab let you choose a general font for all your instant messages. To ensure that emoticons are visible in your messages, choose the Show graphics . . . checkbox. The last option lets you choose whether or not you want to participate in Microsoft’s quality control and improvement program. Click More Information if you want to learn what that’s about.
To Autostart or Not to Autostart

After choosing Tools ➤ Options to get to Windows Messenger’s Options dialog box, click the Preferences tab to see the options shown in Figure 12-17. Your general options are:

✦ **Run Windows Messenger when Windows starts:** If selected, this ensures that the Windows Messenger icon appears in the Notification Area when you first start your computer. If you disable this option, Windows Messenger won’t start automatically and won’t appear in the Notification Area. You’ll need to click Start and choose All Programs ➤ Windows Messenger when you want to run the program.

✦ **Allow Windows Messenger to run in the background:** Generally, you want to choose this option to allow Windows Messenger to run as a background process, using minimal resources while idle but ready for action at a moment’s notice.

✦ **Show me as Away when inactive for *x* minutes:** Select this option if you want Windows Messenger to automatically change your status to Away after a period of inactivity. If you choose this option, you can then specify how long a period of inactivity is required to change your status to Away.

✦ **Allows Windows Messenger to receive ink:** If selected, this option allows people with Web-enabled mobile devices to send you handwritten messages, often referred to as ink.
Showing/Hiding Message Alerts

Also on the Preferences tab of Windows Messenger’s Options dialog box are some options for controlling how you receive alerts. Your options are:

✦ **Display alerts when contacts come online**: If this is selected, you’ll see a little message in the Notification Area each time one of your contacts signs in to his or her .NET Passport. (You must also be signed in yourself.) Clearing this option prevents the Notification Area message from being displayed.

✦ **Display alerts when an instant message is received**: If this is selected, you’ll see a message in the Notification Area whenever someone invites you to join an instant-messaging session. If you clear this option, the Notification Area message won’t be displayed.

✦ **Block alerts and set status to *Busy* when running full-screen programs**: If you use your computer to watch DVDs or other movies in full-screen, you may not want to be disturbed by message requests at that time. Choosing this option will show your status as *Busy* to other contacts whenever you’re watching something in full-screen mode.

✦ **Play sound when contacts sign in or send a message**: If you select this option, you’ll hear a little sound whenever a contact signs in or sends you a message. You can then click the Sounds button to get to the Sounds and Audio Devices dialog box. From that dialog box, you can click the Sounds tab. Then scroll down to Windows Messenger in the Program Events list, and choose your own sound effects for various events (Contact OnLine, New Alert, New Mail, and New Message).
Choosing Where to Put Received Files

Anytime someone sends a file during a Windows Messenger conversation, that file is stored in a folder named My Received Files folder in your My Documents folder. You can change that default folder to anything you want. For example, in Chapter 13, I talk about the option of putting all downloaded files in a Recent Downloads folder, so you can scan just those files for viruses rather than having to scan your entire hard disk.

To change where Windows Messenger stores your received files, click the Browse button under File Transfer on the Options dialog box. In Figure 12-18, I chose my My Received Files folder. It’s listed under Alan’s documents in that figure, because I’m currently signed in to the user account named Alan.

Maintaining Your Privacy

People vary a lot in how they use instant messaging. Some people use it in a very public manner, chatting with strangers in chat rooms, making information about themselves available to other people, and so forth. Other people don’t want any public exposure at all. They want to use instant messaging to converse with people they know, and that’s it. You can have it either way. It’s all a matter of knowing which settings to choose. The Privacy tab in Windows Messenger’s Options dialog box, shown in Figure 12-19, provides your privacy options.

Blocking Known and Unknown Contacts

When you first open the Privacy tab, you’ll see two lists: the My Allow List and the My Block List. People in the My Allow List can see when you’re online and can send you instant messages. People on the My Block List can’t see when you’re online and cannot send you messages. To move a contact from one list to the other, click the contact name. Then click the << Allow or Block>> button to move the contact to the opposite list.
The boldfaced item **Other .NET Messenger Users** refers to umpteen million people in the world who have a .NET Passport and are not my contacts. When **Other .NET Passport Users** is in your Allow List, anyone can add you to his or her list of contacts and send you messages. If you move **Other .NET Messenger Users** to your Block List, only the people in your My Allow List can see when you’re online and can contact you.

If you send an instant message to someone, but they don’t receive it, ask that person to add you, or **All other users**, to his or her My Allow List. If you can’t receive a message from someone, check your own My Allow List.

**See Who Has You as a Contact**

If you’re curious who has you listed as a contact in Windows Messenger programs, click the View button next to **Which people have added me to their contact lists?** option on the Privacy tab. In the dialog box that opens, you can right-click any person and choose Properties to see his or her e-mail address.

If you want to be alerted anytime someone adds you as a contact, choose the **Alert me when other people add me to their contacts lists** option. Choosing the **Always ask me for my password when opening .NET Passport-enabled Web pages** disables the ability to sign in automatically.

Selecting the last option, **Don’t download any tabs to my computer**, prevents Web sites from adding tabs to your Windows Messenger contacts. See the section “Using Alternatives to Sign-ins and .NET Alerts,” later in this chapter, for information on tabs.
Showing/Hiding Your Phone Number

When you right-click a contact in your Windows Messenger list and choose Properties, you see some basic information about that person in a Properties dialog box. That information might, or might not, include the contact’s phone number. You can choose whether or not to make your own phone number visible to your contacts by clicking the Phone tab in Windows Messenger’s dialog box. To make phone numbers visible to your contacts, choose a Country/Region Code from the drop-down list. Then type any phone numbers you want to make visible. To prevent contacts from seeing your phone numbers, leave all the options empty.

Windows Messenger Phone Calls

The Phones tab in Windows Messenger’s Options dialog box allows you to set up alternative communications services that can work with Windows Messenger. There are two types of services you can add, though neither is free, nor simple:

✦ **SIP Communications Service:** Session Initiative Protocol (SIP) is a technology used by some corporations to allow employees to place telephone calls over the Internet. If your company has this capability, your network administrator can configure your copy of Windows Messenger to work with SIP.

✦ **Exchange Instant Messaging:** Companies that have Microsoft Exchange 2000 installed can configure instant messaging so that members of a local network can communicate with another with Windows Messenger.

Both services require products and expertise that go beyond Windows XP and the scope of this book. To learn more about SIP and making telephone calls through Windows Messenger, choose Help ➤ Help Topics from Windows Messenger’s menu bar. Then click the Search tab and search for SIP or Exchange. However, network administrators need to be aware that the options for configuring SIP, Exchange, and other basic information about your Internet connection are on the Accounts and Connection tabs in Windows Messenger’s Options dialog box.

Voice Conversations versus Telephone Calls

Anyone with a computer, sound card, speakers, and a microphone can have voice conversations using the techniques described under “Toll-Free Talking,” earlier in this chapter. Those voice conversations always involve two or more computers (no telephones) and are always free of charge.

Telephone conversations are different in several ways. For one thing, there’s a standard telephone, a cell phone, or some other noncomputer communications device involved in the conversation. For another, telephone calls are never free of charge. In fact, you can’t even use Windows Messenger to make phone calls unless you sign up with a Serial Information Protocol (SIP) Communications Service.
Using an Alternative to Sign-ins and .NET Alerts

You can use your .NET Passport as an alternative sign-in for Web sites that require signing in. For example, let’s say you have an account with eBay (www.ebay.com). Each time you visit that site, you have to go through the whole sign-in rigmarole. As an alternative to constantly signing in, you can use your .NET Passport to sign you in automatically.

To do so, first go to www.ebay.com and click the Sign In option. At the Sign-in page, scroll down to where you can see the alternative sign-ins, as in the upper-left corner of Figure 12-20. After you click the button, you’re taken to the .NET Passport sign-in sheet shown in the lower portion of that figure. Type your .NET Passport name and password, and optionally choose the Sign me in automatically option to automate your sign-in for future sessions.

You want to use only automatic sign-in on your own personal computer, though. If you’re using a public computer, or anyone else’s computer, you won’t want to enable that automatic sign-in, as doing so allows people who don’t know your password to sign in as you.

Some Web sites (eBay isn’t one of them) will add a tab to the left side of your Windows Messenger window when you set up your alternative sign in. When you add such a site to Windows Messenger, you’ll be able to take a quick shortcut to the Web site, and sign in, just by clicking the site’s tab in Windows Messenger.

Web sites can only add tabs if you’ve disabled the Don’t download any tabs to my computer option on the Privacy tab shown in Figure 12-19.
You can also use Windows Messenger to receive .NET Passport Alerts. Like alternative sign-ins, alerts are actually provided by third-party companies. Using eBay as an example once again, you can set up eBay alerts such that you receive a message as soon as someone outbids you on an item you’re gunning for.

To enable .NET Alerts, click the Bell tab at the left side of Windows Messenger’s program window. (If you don’t see the tabs down the side of the window, choose Tools ➪ Show Tabs ➪ Microsoft .NET Alerts from Windows Messenger’s program window.) The first time you click the Bell tab, you’ll see the option to sign up for your free alerts. Just click the Sign Up Now button and follow the instructions on the screen. From there, you’ll see a list of companies offering .NET Alerts. Click any company name to learn more about the types of alerts they offer and to choose the types of alerts you’d like to receive.

**Signing Off, Closing, and Terminating**

Closing Windows Messenger doesn’t automatically take you out of your .NET Passport account. Instead, the program window just closes, but the Notification Area icon remains. To sign out altogether, so that nobody can send you messages or alerts, do either of the following:

- Choose File ➪ Sign Out from Windows Messenger’s menu bar.
- Right-click that little messenger icon in the Notification Area (Figure 12-21) and choose Sign Out.

![Figure 12-21: Signing out of your .NET Passport](image)

Once you’re signed out, you cannot use any .NET Passport features. To sign back in, double-click the Windows Messenger icon in the Notification Area. Or right-click that icon and choose Sign In.

The gray pop-up ads that you might get, which show Messenger Service in their title bars, aren’t related to your .NET Passport or Windows Messenger. To get rid of those, see the section “Blocking Messenger Pop-Ups” in Chapter 13. Terminating your .NET Passport won’t disable those pop-ups.
Still More .NET Passport Stuff

There’s even more to .NET Passport than you’ve learned in this chapter. But these other features take place through the Internet or your Web browser and aren’t directly related to Windows Messenger. Here are more resources you can visit and take advantage of using your .NET Passport:

✦ **Create your own Web site:** Your .NET Passport entitles you to create an MSN Group, which is much like a Web site where you can post text, pictures, and such. For more information, visit [http://groups.msn.com](http://groups.msn.com).

✦ **Meet people:** Stop by a chat room, where you can meet new people and debate hot topics. Visit [http://chat.msn.com](http://chat.msn.com) to get started.

✦ **Play games online:** Want to show off your gaming skills online? Stop by [http://zone.msn.com](http://zone.msn.com) to get started.

✦ **Free extras:** Add some style to your instant messages using the Cool Extras available from [http://messenger.msn.com/Resource](http://messenger.msn.com/Resource).

✦ **MSN on your cell phone or PDA:** For information on extending Windows Messenger’s reach to your cell phone, PDA (Personal Digital Assistant), or wristwatch, take a look at [http://mobile.msn.com](http://mobile.msn.com).

✦ **.NET Passport help and support:** For general information, troubleshooting, and other .NET Passport support, swing by [http://messenger.msn.com/Help](http://messenger.msn.com/Help).

Summary

Here’s a quick recap of the main points covered in this chapter:

✦ A .NET Passport is a free account that provides Internet services that go beyond basic e-mail and Web browsing.

✦ Windows Messenger is a program that allows you to communicate with other people in real time, by typing, talking, or videophone.

✦ You can also send and receive files of any size using Windows Messenger.

✦ Remote Assistance is a Windows Messenger feature that allows you to turn control of your computer over to a trusted expert on the Internet.

✦ To personalize Windows Messenger, choose Tools ➤ Options from its menu bar.

✦ To sign out of your .NET Passport, right-click the little Windows Messenger icon in the Notification Area and click Sign Off.
Keeping It Safe

Using the Internet isn’t an entirely risk-free adventure. Sadly, there are people in the world who get perverse pleasure from ruining other peoples’ fun. The Internet provides ample opportunity to do that. Threats on the Internet take many forms, from relatively harmless, but irritating, spam (junk e-mail) to viruses and worms — programs designed to do bad things and make copies of themselves to boot.

Contrary to popular belief and hard-sell TV commercials, a dial-up Internet account is no safer than a broadband account. Millions of computers (including my own) are on, and online, 24 hours a day, seven days a week, yet never victimized by any bad things online. And millions of people with dial-up accounts get all the bad things. The difference has nothing to do with the type of account you have or how fast your connection is. The only thing that can protect you is knowing what the threats are and how to defend yourself against them.

Viruses, Worms, and Trojan Horses

The most widely know threat on the Internet is the computer virus. Computer viruses aren’t like viruses that humans and animals catch. Computer viruses are programs written by human beings. What makes a virus different from most other types of programs is that a virus is able to replicate itself. That is, a virus is a program that can e-mail copies of itself to other peoples’ computers (via the Internet). The virus might do other bad things as well, such as erase files from your hard disk, perform attacks on other computers without your knowing it, or just play pranks on you.

A worm is very similar to a virus in that it’s a program designed to do bad things, and you don’t want it on your computer. A worm can also replicate itself. It just
tends to do so using techniques other than e-mail. For example, a worm might slowly infect one file after the next on your computer, until things get so out of hand you can’t even start or shut down the computer.

A Trojan horse is a potentially bad program. A Trojan horse doesn’t replicate itself and most likely won’t do any harm to your computer. For example, a program capable of digging lost passwords out of files is considered a Trojan horse. On the one hand, such a program can be a lifesaver if you save some document using a password, then forget the password. On the other hand, allowing such a program onto a corporate network could be bad news for corporate security, because people could use it to break into other peoples’ password-protected files. In other words, whether or not the program is bad depends on how you intend to use it.

The majority of viruses are spread through e-mail attachments. I see them go by all the time. For example, Figure 13-1 shows a bunch of e-mails I’ve received, all of which contain viruses. Note that just because they’re sitting in my e-mail Inbox doesn’t mean that my computer is infected by the virus. For the virus to take effect, I would have to open one of the infected attachments.

Of course, I wouldn’t dream of opening any of those e-mail messages or their attachments. I’ll just delete every one of those without so much as taking a peek at them. But this book isn’t about me. The question is, “What can you do to avoid opening virus-infected e-mail attachments?” A simple, free, low-tech solution to the problem is to ask yourself these three questions before you even consider opening an e-mail attachment:

1. Do I know, personally, who sent this e-mail attachment to me?
2. Was I expecting that person to send me this attachment?
3. Does the e-mail message itself describe what’s in the attachment?
If the answer to any of the preceding questions is “no,” your best bet is to just delete the e-mail message and forget about it. Getting rid of worms and viruses is no small feat. So there’s no point in even taking a chance on a suspicious e-mail attachment.

Just knowing whom the e-mail message is from isn’t enough to guarantee its safety. Here’s why. Let’s say your friend Mabel picks up a virus from an e-mail attachment. She opens it, and her computer is infected, but she has no way of knowing this. While Mabel is innocently clicking around, the virus is busy sending copies of itself to people in Mabel’s Address Book. Mabel doesn’t know this — even if she’s sitting there staring right at the screen while the virus is doing its thing. The virus will give no hint of its evil intent.

If your e-mail address is in Mabel’s address book, there’s a good chance the virus will eventually send a copy of itself to you. When you get the e-mail with Mabel’s return address, you have no way of knowing that she unwittingly sent you the virus. The moment you open the attachment, your computer is infected too. And your computer will then start sending copies of the virus to people in your Address Book. You won’t know it, either. The virus just spreads from computer to computer, its hapless victims madly sending copies to each other without having a clue that they’re sending and receiving viruses.

Some viruses are attached to e-mail messages intended to look real. For example, the first message header in Figure 13-1 looks like a typical bounce-back message (that is, a notification you receive when you send an e-mail that doesn’t reach the intended recipient). But I know the one in the figure is a fake, because the e-mail message (in the lower pane) refers to an e-mail address I’ve never sent e-mail to. Since I never sent an e-mail to that address, the message must be a fake, and the files attached to it are likely viruses.

Here’s another example of where just knowing whom a message is from offers no protection at all. The e-mail messages in Figure 13-2, all from Support@microsoft.com, are all viruses too. How do I know, or why do I believe this? Three reasons:

✦ I haven’t sent an e-mail to Support@microsoft.com lately, so I’m not expecting anything from them.
✦ A legitimate software company like Microsoft, Adobe, Corel, or any other would never send unsolicited e-mails that contain attachments, even if the attachments were safe.
✦ The body of the first e-mail message, shown in the lower-half of Figure 13-2, tells me nothing about what’s in the attachment.

The fact of the matter is that none of the messages in Figure 13-2 are really from Support@microsoft.com. They’re not from Microsoft at all. The return address in each of those messages is bogus. So I would just delete every one of those messages without even wasting my time to look at their contents.
The Virus Protection feature of Outlook Express (Chapter 11) will prevent you from opening any attachment that could contain a virus. If your e-mail address ends in @msn.com or @hotmail.com, your e-mail will be scanned for viruses automatically, and any viruses will be destroyed before they even reach your computer.

### Installing Anti-Virus Software

The low-tech technique of avoiding opening suspicious e-mail attachments isn’t enough to protect you from all viruses, worms, and Trojan horses. That technique just protects you from e-mail viruses, the most common. But just about any file you download could be a virus, worm, or Trojan horse. To protect yourself from all forms of viruses, you need to install *anti-virus software*. Windows XP doesn’t come with any sort of anti-virus program built into it. That’s something you need to purchase and install separately.

Of course, if you bought your computer with software already installed, there may already be anti-virus software installed on your computer. To find out for sure, you’d need to learn about the software that came with your computer. And you can get that information only from that particular computer manufacturer. But then again, if you have anti-virus software installed already, that program might display an icon in your notification area. Likewise, since all programs currently installed on your computer are accessible from your All Programs menu, you could fire up your anti-virus program by clicking its icon on the Start menu.

Some popular anti-virus program manufacturers include Symantec (Norton Anti-Virus) at [www.symantec.com](http://www.symantec.com); McAfee (VirusScan Online) at [www.mcafee.com](http://www.mcafee.com); and Trend Micro (PC-cillin) at [www.trendmicro.com](http://www.trendmicro.com).

If you don’t already have anti-virus software, it’s not too tough to get it. It’s just not free. If you’re looking for a reliable program you can buy and install without even getting up from your chair, consider McAfee’s VirusScan, available from [www.mcafee.com](http://www.mcafee.com).

### Using Anti-Virus Software

Unfortunately, I can’t teach you how to use your anti-virus program. There are just too many of them out there to even make an attempt. But as with any programs, you can learn to use your anti-virus software from its built-in help, the
Make sure the anti-virus software scans all incoming e-mail attachments and all files you download. Also, be aware that new viruses and worms hit the Net all the time, some able to sneak past your anti-virus software. Your best protection there is to make sure your anti-virus software is always up to date. Most anti-virus programs keep themselves up to date automatically. But you should learn to use that feature so you know that your program is up to date at all times.

**Scanning Downloaded Files**

Simply downloading an e-mail attachment or file that contains a virus or worm isn’t enough to infect your computer. You have to open the attachment or file. One thing you can do, especially if you download a lot of free stuff, is store all downloaded files (and saved e-mail attachments) in one folder. For example, you can click the Start button and choose My Documents. Then, in your My Documents folder, choose File ➪ New ➪ Folder from the menu bar in My Documents. A new, empty folder named New Folder appears. Type some new name, like Recent Downloads, and press Enter.

Just creating an empty folder isn’t enough, though. You also have to remember to store all dubious files in that folder, and scan them, before you open any of them. As far as saving goes, that’s just a matter of choosing My Documents from the Save As or File Download dialog box’s Save In drop-down list and double-clicking the Recent Downloads folder. When the folder name Recent Downloads appears next to Save In, click the Save button in the dialog box to save the file to that folder.

You certainly don’t want to have to scan your entire hard disk for viruses every time you save an e-mail attachment or download a file. That takes too long. But you should be able to get your anti-virus software to scan only your Recent Downloads folder. For example, in McAfee VirusScan (the anti-virus program I use), I just click Scan my Computer for Viruses. Then, in the next window that opens, I choose that folder under Location to Scan (Figure 13-3); then I click the Scan button.

If your anti-virus software detects a virus in a file, you should just delete that file and forget about it. See if you can find a clean copy of the same file somewhere. Any file that passes that test is OK, which means you can open it or move it to a more permanent folder.

---

**Caution**

If you download free music and video from the Gnutella network (or anywhere else, for that matter), you should direct all files you download to your Recent Downloads folder. Scan them before opening them or moving them to a more permanent home.
Hackers and Crackers

A second threat is on the Internet, though rare compared to viruses are hackers and crackers. These are people (or more likely computers) that sneak stuff into your computer through open ports in your Internet connection. Hacking in real life isn’t at all like it is in movies. In movies, some good-looking young kids take two or three guesses at some password and magically have access to the entire computer. In real life, it doesn’t work that way at all. Nobody can break into your computer and steal things or even look around.

The kind of hacking that takes place on computers is almost always done by computers, not humans. Some human programmer creates a program that just wanders around the Internet looking for open ports, sneaking some virus-type program onto a computer’s hard disk without the owner knowing it. This is a slow and tedious way to infect multiple computers and therefore isn’t done much. But it is done, and you need to have some protection.

The type of program you use to protect your computer from hackers is called a firewall. It actually works on a very simple principal. Normally, your computer will just accept anything that comes in off the Internet, under the assumption that if there’s something coming in from the Internet, you must have requested it. That’s the very assumption that allows hackers to sneak things onto your computer.

A firewall is a program that keeps track of what you’ve requested from the Internet. As information from the Internet comes streaming into your modem, the firewall takes a look at everything coming in. If the information is something you requested, the information rides in normally. If the information is not something you requested, the firewall rejects the information, so it never reaches your computer. Figure 13-4 illustrates the basic concept.
Hackers versus Crackers

The press and the general public use the terms *hacker* and *cracker* interchangeably, despite the fact that doing so irritates the daylights out of computer programmers. In the programming world, *hacker* is a slang term for *programmer*. The vast majority of programmers in the world never write any code that would damage a computer or replicate itself, and they don’t like being put in the same category as those who know just enough programming to take some existing virus and tweak it into something else (not at all impressive to a real programmer).

Programmers refer to people who do bad things with their programming skills as *crackers*, not hackers. *Cracker* has its origins in the idea of a safecracker, one who breaks into safes. But these programmers don’t break into safes. They break into computers and networks where they don’t belong, stealing corporate secrets or just wreaking random havoc.

Fortunately, you don’t have to go out and buy a firewall, because there’s one built into Windows XP. Chances are, it’s been protecting your computer from hackers since the day you installed or purchased XP. But it certainly can’t hurt to take a look and make sure it’s running. First, you have to open your Network Connections folder. You can do so using any of the following techniques:

✦ Click the Start button and choose Control Panel. If Control Panel opens in category view, click Network and Internet Connections. Then open the Network Connections folder.

✦ Click the Start button and choose My Network Places. Then click *View network connections* under Network Tasks in the left column.

✦ If you see a little Notification icon that represents your Internet connection, right-click that icon and choose Open Network Connections.
If you create a local area network that shares an Internet connection, enable the firewall on the connection to the Internet only and only on the computer physically connected to the modem or router. Adding a firewall to any other connection will prevent your local area network from functioning normally.

Once you’re in the Network Connections folder, right-click the icon that represents your Internet Connection and choose Properties. Make sure the first checkbox has a checkmark in it, as in Figure 13-5, and click OK. That’s all it takes.

Perhaps an even easier way to enable your firewall would be to go to www.microsoft.com/security/protect, choose Windows XP, next to Get Started, click the Go button, and click the Let us do it for you link. I say “perhaps” because Microsoft might move that Web page between now and the time you read this book.

Dealing with Pop-Up Ads

Pop-up ads are uninvited messages or Web pages that pop up on your screen while you’re online. These ads aren’t harmful to your computer, but sure can be harmful to your sanity. Plus, they eat up bandwidth, which means they cause all your other Internet stuff to slow down. If you have a dial-up connection to the Internet, the last thing you need is a bunch of idiotic pop-up ads eating up your bandwidth and slowing things down even more.
There are several ways for pop-up ads to find their way to your computer. Free software is one of the greatest offenders. Programs that you download and install for free often generate income for the program’s creators through advertising revenues. While you’re using the program, it just keeps popping ads up on your screen, hoping that you’ll eventually respond to one. If you do respond to one, the program creator gets a little commission. The idea, of course, is to get thousands of copies of the free software out there to make thousands of little commissions.

You can use a pop-up blocker, described in the next section, to block those ads. But blocking them isn’t the perfect solution, because the ads aren’t blocked until they reach your computer. By that time, they’ve already consumed some of your bandwidth, causing everything else to slow down. If you have a dial-up account, which works with minimal bandwidth to begin with, you really can’t afford to waste any of it on pop-up ads. So if you suspect that some freebie program is causing you to get flooded with pop-ups, you might consider uninstalling that program or at least keeping it closed when you don’t absolutely need it.

**Blocking Pop-Ups**

Even if you do avoid free software, you’re bound to get some pop-up ads while you’re browsing the Web. There’s no way to make all those just go away, because any Web page can open another Web page the moment you open or close the first page. But you can use a pop-up blocker to get rid if them. I use the Google toolbar to block pop-ups. It works, and it’s free.

I know I just said a lot of free software causes pop-ups. But Google doesn’t need to make money from advertising. Their goal in giving away the toolbar for free is to increase the size of their customer base, not drive it away with pop-up ads.

Getting the Google toolbar is simple. Using your Web browser, go to www.google.com and just look around on their opening page for a link to their toolbar. If you don’t see a link to the toolbar on their home page, click Services & Tools on their home page; then scroll down to and click Google Toolbar. Choose your Language, click the Download Google Toolbar button, and choose Open in the File Download dialog box that appears. Then just follow the instructions on the screen.

Once the bar is installed, you’ll see it in your Web browser. Figure 13-6 shows the Google toolbar added to Microsoft Internet Explorer. To make sure the toolbar blocks pop-ups, click the Options button in the Google toolbar. The Toolbar Options dialog box, also shown in Figure 13-6, opens. Just make sure the Popup Blocker option on the Options tab is selected; then click OK.

The Google toolbar will block pop-ups only while it’s open and visible in your Web browser. In Internet Explorer, you can choose View ➤ Toolbars ➤ Google from the menu bar to either show or hide that toolbar. Also, if you see a button named Site Popups Allowed, click that to turn it off and block the pop-ups.
The other convenience of having the Google toolbar handy is that you don’t have to go to www.google.com to use their search engine. Just type whatever word or phrase you want to search for right into the toolbar; then click the Search Web button to the right.

Blocking Messenger Pop-Ups

If you get those dull text-only pop-up ads that show Messenger Service or Windows Messenger in the title bar, like the example shown in Figure 13-7, those are coming from the Internet through your Alerter service. That service is used in large corporate client/server networks so network administrators can send messages to users. If your PC isn’t part of such a company network, you can turn off the Alerter service and get rid of those pop-ups forever. Here’s how:

The steps that follow are a delicate operation with no margin for error. Follow the steps carefully. If you don’t see a Run option on your Start menu, see “Personalizing your Start Menu” in Chapter 24.
Figure 13-7: A bogus Windows Messenger pop-up ad, designed to look like a real message

STEPS: Block Messenger Pop-Ups

1. Click the Start button and choose Run.
2. Type services.msc and click OK. The Services window opens.
3. In the Services program that opens, scroll down to Messenger.
4. Right-click Messenger as in Figure 13-8 and choose Stop.

The Messenger option in the Services window has nothing to do with the Windows Messenger described in Chapter 11. The name is just a coincidence. The Messenger item in the Services window is just the portion of the Alerter service that allows these pop-up messages to be displayed on your screen.

Figure 13-8: Right-clicking Messenger in the Services window

5. Double-click the word Messenger to open the Messenger Properties dialog box.
6. In that dialog box, choose Disabled from the Startup type: drop-down list.
7. Click the OK button to close the dialog box.

8. Close the Services window by clicking its Close button or by choosing File ➪ Exit from its menu bar.

And that will be the end of those Messenger pop-ups.

**Extortion Pop-Ups**

You should ignore any ad that tells you your computer is at risk and that you need to do something right away about it. The pop-up message shown in Figure 13-7 is a perfect example, as is the equally bogus ad shown in the following figure.

Both of these ads are bald-faced lies, designed to raise your anxiety to extort money from you. As to the first ad, your computer will never make public any personal information about you or your bank account or credit cards. On the second ad, it’s not possible to broadcast IP addresses over the Internet, so your computer is not doing that now and never will. Even if it were possible to broadcast over the Internet, the information wouldn’t help anybody anywhere attack your computer. Everything in these ads is a lie.

If an add raises your anxiety level one iota, close the ad and forget about it. Don’t buy anything from a pop-up ad, or junk e-mail either, for that matter. Any product that promises to make your computer safer, fix your computer with one mouse click, double the speed of your computer or Internet connection, or make your computer crash proof is dubious at best.
Dealing with Spam (Junk E-Mail)

Junk e-mail isn’t harmful to your computer, but it sure can be harmful to your sanity. There’s really nothing built into Windows XP, per se, for dealing with junk e-mail. This is something you need to do through your e-mail client (the program you use to send/receive e-mail messages). There are hundreds of e-mail clients out there, so I can’t tell you specifically how to work yours. But if your e-mail client has the ability to block junk e-mail, you should be able to find information on that by searching that program’s help for spam or block.

For example, let’s say you use Outlook Express (Chapter 11) as your e-mail client, and you have a POP3 mail account. You get a junk e-mail message from someone and don’t want to get any more. To block future e-mails from that sender, click the message header; then choose Message ➤ Block Sender. Choose Yes from the dialog box that appears. Future messages from that sender will be blocked. If you make a mistake, or change your mind, choose Tools ➤ Message Rules ➤ Blocked Senders List from Outlook Express’s menu bar. Then click the person you no longer wish to block and choose Remove.

Blocking junk e-mail message one sender at a time can be a long, tedious, never-ending battle. If you want to beef up your spam-killing abilities, you can install a third-party spam filter. I use McAfee SpamKiller for this task. (I know I sound like a McAfee ad in this chapter. Honest, I have no affiliation with them. I’ve just been using their products for a long time and am comfortable with them.)

A spam filter will let you filter out messages by the sender’s address, the specific words in the message Subject, or even the words within the body of the message. For example, you can block all messages that have mortgage or loan or debt or ink cartridge or prescription or free any other word you can think of. I use SpamKiller because it allows me to control, from one computer, all my family’s e-mail accounts.

Adware and Spyware

Adware and spyware are types of programs that don’t do any harm to your computer. But they do keep track of your browsing preferences and then send that information to advertisers, who in turn use it to tailor ads to your tastes. Once again, there’s nothing built into Windows XP to deal with this problem. But there is a third-party program you can download and install for dealing with these programs. (And it’s not a McAfee product this time.) It’s called Ad-Aware, and you can learn more about it from www.lavasoft.de. There are pay versions and free versions.

To download the free version of Ad-Aware to take it for a spin, follow these steps:
The Ad-aware file is 1.7MB, which will take several minutes to download on a dial-up account. Be sure to leave yourself time to wait for the download to complete.

1. Using your Web browser, go to www.tucows.com (a safe place to get all kinds of free and free-trial version programs).

2. Scroll down to the bottom of Tucows’s home page to the Search Software Library box.

3. Type Ad-Aware next to for and choose Windows from the in drop-down list; then click the Go button.

4. On the next page that appears, scroll down past the first items and ads, and you should see Ad-aware 6.1 (the version number may be different) in the list. Click XP to the right of that item.

5. On the next page that appears, choose Win XP under Download.

6. On the next page, choose a Country and State. On the last page, click any Mirror Name.

7. In the File Download dialog box that opens, click Open. Then follow the instructions on the screen to complete the download and install the program.

Once you’ve completed the download and installation, you can run Ad-Aware as you would any other program installed on your computer, from the All Programs menu. That is, click the Start button and choose All Programs \(\rightarrow\) LavaSoft 6 \(\rightarrow\) Ad-Aware 6 (the 6 might be a later version number by the time you read this, but don’t worry about that). When Ad-Aware opens, click the Scan Now button; then click Next. Wait for all objects to be scanned.

When the scan is complete, you’ll see the number of spyware/adware items detected, if any. Click the Next button. To delete all the items lists, click the Next button; then click OK. You can close the Ad-Aware window.

You may want to scan your system once a week, once a month, or whatever you’re comfortable with. For more information on Ad-Aware, click the Help button in its main program window. Or click the Start button, and choose All Programs \(\rightarrow\) LavaSoft Ad-Aware 6 \(\rightarrow\) Ad-Aware 6 User Manual.

Parental Controls

The no-censorship nature of the Internet makes it a very risky place for kids, indeed. If you’ve spent much time at all on the Internet, you’ve probably come across some materials that are definitely not kid-friendly. Keeping kids from gaining access to that stuff is no small feat. Even a perfectly innocent Internet search can produce links that lead to adult material. For example, a search for Ford Escort wouldn’t likely turn up anything too dicey. But a search for Escort can lead to a variety of escort services whose sites are certainly not appropriate for kids.
The Smart Parent Web site, www.SmartParent.com, is specifically designed to help educate parents on the best ways to safeguard children on the Internet. There you’ll find lots of resources on programs you can download and install, services you can sign up with, and more. But perhaps more important, you’ll have a solid, reliable resource for chatting with other parents in the same boat, to ask questions and to deal with the problem in the most effective way possible.

**Keep XP Up-to-Date**

The whole business of Internet security is something of a cat-and-mouse game between the legitimate software vendors and the *evildoers* (to borrow George Bush’s term.) The good guys keep coming up with new and better ways to block the evildoers. But the evildoers just keep coming back and find new ways around the protections. And so it goes, on and on.

Keeping your copy of Windows XP up-to-date is a good way to make sure you always have the latest-and-greatest security in place. It’s also free and easy to do. Just enable automatic updating. Here’s how:

**STEPS: Keep XP Secure Automatically**

1. Click the Start button and choose Control Panel.
2. If Control Panel opens in Category view, click Performance and Maintenance. Otherwise, ignore this step.
3. Open the System icon. The System Properties dialog box opens.

   ![Tip]

   Here’s a shortcut to the System Properties dialog box. Right-click the My Computer icon on your desktop or Start menu and choose Properties.

4. Click the Automatic Updates tab in the System Properties dialog box that opens.
5. In the System Properties dialog box, make sure the first option, *Keep my computer up to date...*, is selected (checked).
6. Under Settings in that same dialog box, choose *Download the updates automatically and notify me when they are ready to be installed*, as in Figure 13-9.
7. Click the OK button.
Figure 13-9: The Automatic Updates tab of the System Properties dialog box

That’s all there is to enabling the automatic update capability. Now all you have to do is keep an eye out for a notification message like the one shown in Figure 13-10. Don’t expect it to appear right away. Some updates are huge and take a long time to download, especially if you’re using a dial-up account. But all of that time-consuming stuff will take place in the background without your having to wait around. When you see the message shown in Figure 13-10, just click it and follow the onscreen instructions to install the update.

Figure 13-10: An update has been downloaded and is ready to install.

You don’t have to worry about viruses and such in the files you download from Microsoft or from any other legitimate software company.

Installing Declined Updates

If you miss the opportunity to install an update, you can complete the installation at any time. Follow the preceding steps to return to the Automatic Updates tab of the System Properties dialog box. Then click the Declined Updates button. If the button is disabled (dim), there aren’t any declined updates waiting to be installed on your computer.
Getting Everything Up-to-Date

You can get your computer completely up-to-date manually, though be forewarned that it will take a long time even with a broadband connection to the Internet. It’s the kind of thing you have to do almost as an overnighter. Start the process just before you go to bed at night, and leave the computer on, and online, overnight. (It might be several nights with a dial-up account. And if you use your voice phone line for your Internet connection, you won’t be able to use the phone during that time. So this might not be a good approach if you’re using a dial-up modem.)

All the updates are available at any time if you don’t want to wait for them to download automatically. Of all the available updates, the Service Packs are probably the most important, because they have all the security patches that have been added over several weeks.

STEPS: Update Windows XP Manually


2. On the page that opens, click Scan for Updates and wait for the scan to complete.

3. If there are any critical updates to be installed, you’ll see instructions for performing the update. Follow the instructions on the screen. (Windows Service Pack 1, or SP1, should be your first update.)

   Note A critical update makes your computer more secure. Windows XP and Driver Updates are more general and not related to Internet security.

4. Optionally, click Windows XP or Driver Updates; then click the Add button for any updates you want to install.

5. In the left column, click Review and Install Updates.

The items you select will be listed on the page that opens. Click the Install Now button and follow the instructions on the screen.

Tip If you have Microsoft Office, you can use Office Update at www.OfficeUpdate.com to update Office programs. See http://office.microsoft.com for details. Or choose Help Office on the Web from the menu bar in any Office program.

Summary

Keeping your computer safe and secure online is all about knowing what the threats are and how to avoid them. In this chapter, you’ve learned all the threats and the different ways of dealing with them. To summarize:
Viruses, worms, and Trojan horses are bad programs spread through files and e-mail attachments.

To avoid picking up viruses spread through e-mail attachments, be very, very choosy about the e-mail attachments you open.

To get complete protection from all viruses, consider installing and learning to use anti-virus software.

To protect your computer from hackers (or crackers), make sure XP’s Internet Connection Firewall is enabled.

To block pop-up ads, consider downloading and installing a blocker like the Google toolbar.

Some e-mail clients and services have built-in tools for blocking spam (junk e-mail). For heavy-duty protection, purchase and install a third-part spam filter.

Adware and spyware are programs designed to spy on your Web-browsing habits to better target ads displayed on your computer. You can use LavaSoft’s free Ad-Aware program to delete adware and spyware.

Parents who want to keep their kids safe online can get plenty of information and support from www.SmartParent.com.

Using XP’s Automatic Updating will also help keep your computer more safe and secure.
Fun with Multimedia

Downloading music, burning CDs, e-mailing pictures, making DVDs — people talk about this stuff like they talk about boiling water. Everybody knows how to boil water. What, ya kiddin’? Have you ever tried to guess your way through getting pictures out of a digital camera or scanning some prints into your computer? Ever tried to download a song from the Internet for free, or make a CD you can play in your car, just by clicking whatever looks relevant on your screen? If so, you might wonder who’s kidding whom.

What’s up with all that MP3, CD-R, CD-RW, DVD+RW, MPEG, and JPEG stuff anyway? And, by the way, thanks for sending me that Zip file attachment. Was I supposed to do something with that? Such are the questions on the minds of the uninitiated everywhere.

Well, prepare to be initiated, as we bravely head into Part IV, which I actually have the nerve to title “Fun with Multimedia.”
Understanding Your Camera and Scanner

Cameras and scanners are devices for getting pictures into your computer. A digital camera stores its pictures electronically rather than on film. When you copy pictures from the camera, each photo becomes a file on your computer’s hard disk.

A scanner is a photocopy machine attached to a computer. Each image you scan is stored in a file on your hard disk, just like a photo from a digital camera. As you’ll learn in this chapter, you can use XP’s Scanner and Camera Wizard to get pictures from your camera, scanner, or even a photo CD.

Tip

Don’t be alarmed if a picture ends up being sideways on your screen. As you’ll learn in Chapter 15, you can easily rotate it to the correct orientation after you’ve copied it to your hard disk.

About Pictures

Every picture on your computer is a document. As such, it’s stored as a file in a folder somewhere — exactly where, of course, is up to you. A couple of folders on your hard disk, however, are especially well suited to storing pictures:

- **My Pictures**: Contained within My Documents, this folder includes options for working with pictures. You can use both the Thumbnails and Filmstrip views, where each picture appears as a tiny copy of itself rather than as a generic icon.

- **Shared Pictures**: Same as My Pictures. But on a network or computer with multiple user accounts, everyone has access to the pictures.
in the Shared Pictures folder. Only you have access to pictures in your My Pictures folder, however.

Any subfolders contained within My Pictures or Shared Pictures will offer the same tools and options that the parent does. Thus, you can organize pictures into folders within My Pictures or Shared Pictures without losing the special capabilities of those folders. For now, though, the important skill to have is the ability to open your My Pictures or Shared Pictures when you need it. Use whichever of the following methods is most convenient at the moment:

✦ Click the Start button and choose My Pictures.
✦ In your My Documents folder, double-click the icon for your My Pictures folder.
✦ If you’re in some other folder, you may be able to click My Pictures or Shared Pictures in the Explorer bar (Figure 14-1) to hop to that folder.

Figure 14-1 shows an example of a My Pictures folder. In that example, My Pictures contains several subfolders. Each subfolder contains a group of pictures. Your My Pictures folder won’t look like the example, but don’t worry about that. As long as the title bar shows My Pictures or Shared Pictures, you’re in the right folder.

![My Pictures folder](image)

**Figure 14-1:** A sample My Pictures folder

The Scanner and Camera Wizard you’ll learn about in this chapter will help you organize your pictures into subfolders like that. You can also create your own folders, using the Make a new folder option under File and Folder Tasks in the Explorer bar.
See “Creating Your Own Folders” in Chapter 19 for the goods on creating your own folders.

Viewing Picture Icons

As discussed in Chapter 5, any time you view the contents of a folder, Windows Explorer is the program providing the view. So when you’re viewing the contents of your My Pictures or Shared Pictures folder, you have access to all the tools described in Chapter 5. For example, you can choose a view for displaying icons. In My Pictures or Shared Pictures, you’re likely to find Filmstrip or Thumbnails to be most useful. To choose a view, use whichever of the following methods is most convenient at the moment:

✦ Click View in Explorer’s menu bar; then click the view you want to use.
✦ Click the Views button in Explorer’s toolbar; then click the view you want to use.
✦ Right-click some empty space between icons in the main pane, and choose View from the shortcut menu; then click a view name.

You’ll learn more about your My Pictures folder in the next chapter.

If you need a reminder on the different views available to you, see the section “Different Ways to View Icons” in Chapter 5.

Types of Pictures

You might think a picture is a picture and therefore all pictures are the same type of file. I wish it were that simple. But the fact is that pictures come in many different formats. As with any file, the picture’s file name extension describes the format of the information in the file. Table 14-1 lists many of the picture types available.

<table>
<thead>
<tr>
<th>Filename Extension</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>.iff</td>
<td>Amiga</td>
</tr>
<tr>
<td>.art</td>
<td>AOL Art file</td>
</tr>
<tr>
<td>.dxf</td>
<td>Autodesk Drawing Interchange</td>
</tr>
<tr>
<td>.gif</td>
<td>CompuServe Graphics Interchange</td>
</tr>
<tr>
<td>.cgm</td>
<td>Computer Graphics Metafile</td>
</tr>
</tbody>
</table>

Continued
<table>
<thead>
<tr>
<th>Filename Extension</th>
<th>Format</th>
</tr>
</thead>
<tbody>
<tr>
<td>.cmx</td>
<td>Corel Clipart</td>
</tr>
<tr>
<td>.cdr</td>
<td>CorelDraw Drawing</td>
</tr>
<tr>
<td>.lbm</td>
<td>Deluxe Paint</td>
</tr>
<tr>
<td>.cut</td>
<td>Dr. Halo</td>
</tr>
<tr>
<td>.eps, .ai, .ps</td>
<td>Encapsulated PostScript</td>
</tr>
<tr>
<td>.fpx</td>
<td>FlashPix</td>
</tr>
<tr>
<td>.img</td>
<td>GEM Paint</td>
</tr>
<tr>
<td>.hgl</td>
<td>HP Graphics Language</td>
</tr>
<tr>
<td>.jpg, .jif, .jpeg</td>
<td>Joint Photographic Experts Group</td>
</tr>
<tr>
<td>.kdc</td>
<td>Kodak Digital Camera</td>
</tr>
<tr>
<td>.pcd</td>
<td>Kodak Photo CD</td>
</tr>
<tr>
<td>.pic</td>
<td>Lotus PIC</td>
</tr>
<tr>
<td>.pct</td>
<td>Macintosh PICT</td>
</tr>
<tr>
<td>.mac</td>
<td>MacPaint</td>
</tr>
<tr>
<td>.drw</td>
<td>Micrografx Draw</td>
</tr>
<tr>
<td>.msp</td>
<td>Microsoft Paint</td>
</tr>
<tr>
<td>.psp</td>
<td>Paint Shop Pro</td>
</tr>
<tr>
<td>.pic</td>
<td>PC Paint</td>
</tr>
<tr>
<td>.psd</td>
<td>Photoshop</td>
</tr>
<tr>
<td>.pbm</td>
<td>Portable Bitmap</td>
</tr>
<tr>
<td>.pgm</td>
<td>Portable Greymap</td>
</tr>
<tr>
<td>.png</td>
<td>Portable Network Graphics</td>
</tr>
<tr>
<td>.ppm</td>
<td>Portable Pixelmap</td>
</tr>
<tr>
<td>.raw</td>
<td>Raw File Format</td>
</tr>
<tr>
<td>.sct, .ct</td>
<td>SciTex Continuous Tone</td>
</tr>
<tr>
<td>.ras</td>
<td>Sun RasterImage</td>
</tr>
<tr>
<td>.tif, .tiff</td>
<td>Tagged Image File Format</td>
</tr>
<tr>
<td>.tga</td>
<td>Truevision Targa</td>
</tr>
<tr>
<td>.gem</td>
<td>Ventura/GEM Drawing</td>
</tr>
<tr>
<td>.clp</td>
<td>Windows Clipboard</td>
</tr>
<tr>
<td>.emf</td>
<td>Windows Enhanced Metafile</td>
</tr>
<tr>
<td>.wmf</td>
<td>Windows Meta File</td>
</tr>
<tr>
<td>.rle</td>
<td>Windows or CompuServe RLE</td>
</tr>
</tbody>
</table>
File name extensions are visible only when *Hide extensions for known file types* is turned off. See the section “Showing/Hiding File Name Extensions” in Chapter 6 for specifics.

Don’t let all the different file types intimidate you. Some are so rare that you may never come across them. When saving a file, you’ll rarely be presented with so many options. The simple rule is, if in doubt, choose JPEG, which works with everything, even e-mail. If JPEG isn’t an option, you can use Windows Bitmap (.bmp), which is also widely supported.

### Copying Pictures from a CD

If you get pictures developed onto a CD, you’ll be able to view and print them right from the CD. But if you want to be able to change them in any way, you’ll need to copy them to your hard disk first. That’s because the pictures will most likely be on a CD-ROM (the ROM stands for Read Only Memory). You can’t change the contents of a CD-ROM in any way. So you can’t change a picture on a CD-ROM.

**Tip**

You don’t need a digital camera to take digital photos. You can have your regular film developed and delivered to you on CD or use a disposable camera such as the Kodak PLUSDigital.

You can copy the pictures from the CD-ROM to your My Pictures folder or any folder on your hard disk for that matter. Once the pictures are in a folder on your hard disk, you can edit, print, and view the photos freely without the CD. To copy the pictures, you can use any method described in Chapter 21, the main chapter in this book on CDs. Or you can use the built-in Scanner and Camera Wizard described in the steps that follow.

### STEPS: Copy Photos from a CD

1. Put the photo CD-ROM into your CD-ROM drive and wait a few seconds. Then:

   - If it’s a Kodak Picture CD, you’ll most likely see a slideshow of your pictures, of the Kodak Photo CD program, or the Kodak Picture CD program will open. If either happens, skip the remaining steps and go to the sidebar titled “Using a Kodak Picture CD.”
• If you see the dialog box asking what you want to do with the CD, click *Copy pictures to a folder on my computer*.... Then go to Step 2. Otherwise, you’ll automatically be taken to Step 2.

If absolutely nothing happens within a minute of inserting the CD into its drive, you can access the disk directly from its icon in My Computer. See the section “Using CDs and DVDs” in Chapter 21 for more information.

2. The Scanner and Camera Wizard opens. Click the Next button on the first page of the Wizard. The Choose Pictures to Copy page opens. Initially, all pictures are selected for copying, as in Figure 14-2. If there are any pictures you don’t want to copy, clear their checkmarks. Then click Next.

![Figure 14-2: Choosing pictures to copy from a CD](image)

3. The next page asks what you want to name the group of pictures and where you want to put them. Type a brief, descriptive name of your own choosing, like 2003 Christmas or Mandy’s New Do. The name you enter will be the name of the folder in which the pictures are stored. Click Next.

4. The next Wizard page shows you the program’s progress. Nothing to do there but wait. When all the pictures have been copied, the Other Options page opens.

5. On the Other Options page, choose Nothing; then click Next. On the last Wizard page that opens, click Finish.

The folder on your hard drive will open. You can remove the CD now and put it someplace for safe keeping. From now on, you’ll do all your work on the copies in the folder on your hard disk. The CD will just be a backup of your original photos, in case you ever want to recopy an original photo to your hard disk.
Using an a Kodak Picture CD

When you insert a Kodak Picture CD into your CD drive, you’ll most likely see a slide show of the pictures on the CD. Clear the checkmark next to Show Opening Slideshow, or press the Spacebar on your keyboard. You should come to the main program for managing a Kodak Photo CD. Here’s how to proceed:

1. Click the first option, My Pictures (shown as follows), on the main menu.

2. Click the Save As option on the next page that appears.

3. Click the Select All button near the upper-left corner of Kodak’s program window, as follows.

4. Under Choose picture size, I recommend that you choose Large (for printing), since this will give you the best originals to work with.

5. Click the Save button in the Kodak program, shown as follows.

In the Save As dialog box that opens, navigate to the folder in which you want to store the pictures. For example, to put the pictures in your My Pictures folder, click the large My Documents icon at the left side of the Save As dialog box; then double-click the icon for your My Pictures folder.

Change the file name to whatever you want to name this group of pictures. Click the Save button in the Save As dialog box. When copying is done, you’ll see a dialog box telling you how many pictures were copied. Click its OK button. Then you can close the Kodak program (large X near its upper-right corner) and remove the CD. Keep the CD in a safe place as a backup of your original photos. From now on, you can work with the copies of the photos in a subfolder within your My Pictures folder.
The folder that the pictures are in is a subfolder of your My Pictures folder. So, if you click the Up button in Explorer’s toolbar to go to this folder’s parent, you’ll end up in My Pictures. To return to the photos, double-click the new folder’s icon.

We’ll talk about techniques for viewing, printing, and editing pictures in Chapter 15. For now, it’s time to talk about getting pictures from a digital camera.

### Getting Pictures from a Digital Camera

If your digital camera is a recent model supported by Windows XP, and that camera connects to your computer with a USB or FireWire cable, you can use the Scanner and Camera Wizard to get pictures from your camera to your hard disk. Here’s the basic procedure:

**STEPS: Get Pictures from a Digital Camera**

1. Connect the camera to the computer via the USB or FireWire cable.
2. Turn on the camera, and wait a few seconds. Little messages in the notification area will appear as Windows gets ready to copy from the camera. Then you might see a dialog box asking what you want to do. Click *Copy pictures to a folder on my computer...*, and click OK.
3. The first page of the Scanner and Camera Wizard opens. Click the Next button.
4. The next Wizard page, titled Choose Pictures to Copy, displays a copy of each picture currently in the camera, similar to the example shown in Figure 14-2. If you don’t want to copy a picture, clear its checkmark. Click Next.
5. The Picture Name and Destination page appears next. Under option 1, you should give the pictures a meaningful name — something that describes the whole group of pictures. Something like Vacation 2003 or Christmas 2003 might be good. In Figure 14-3, I name my pictures 2004 Wildflowers Tour as an example.
6. Under *Choose a Place*, you can leave that setting unchanged to place all the pictures in a subfolder within your My Pictures folder.

**Tip**

The backslash (\) separates a folder name from its parent folder’s name. For example, My Pictures\2004 Wildflowers Tour means A folder named 2004 Wildflowers Tour contained within the My Pictures folder.
7. If you want to have Windows remove the pictures from the camera when it has finished copying them, choose the *Delete pictures from my device after copying them* option, as in Figure 14-3. Then click Next.

![Figure 14-3: What to name the group of pictures and where to put them](image)

8. The next Wizard page just keeps you informed of how the copying is going. When all the photos have been copied, the Other Options page appears. Choose Nothing; then click the Next button (you can publish photos to the Web or order prints online at any time).

9. On the last Wizard page, click the Finish button.

A folder will open, showing you all the copied images in Filmstrip view, as in the example shown in Figure 14-4 (not the name of the folder in the upper-left corner of the window). You can turn off and disconnect the camera now. All of its pictures are now safely stored on your computer’s hard disk. If you didn’t tell Windows to delete all the pictures from the camera, you can do so using controls on the camera.

We’ll talk about techniques for viewing, printing, and editing pictures that you got from your camera in Chapter 15. For now, it’s time to talk about getting pictures from a scanner.
Scanning Documents

A scanner is like a photocopy machine attached to a computer. Unlike a photocopy machine, which copies a document directly to paper, a scanner copies a document to a file on your hard disk. The document will be a picture, which is fine in most cases. But if you scan text with hopes of editing it with WordPad or some other word-processing program, it won’t work. You’ll have to convert the scanned document to text first, using Optical Character Recognition (OCR) software. Many scanners come with such software. You can also purchase and install OCR software yourself.

To see Windows XP-compatible OCR products, go to www.WindowsCatalog.com. On the home page, click the Software tab. In the left column, click Utilities • Scanner. To shop online, go to any site that sells software (for example, www.TigerDirect.com, www.cdw.com) and search for OCR software.

Exactly how you install and use your scanner depends on its make and model. Most of that information will have to come from the printed documentation that came with the scanner. But assuming the scanner is XP-compatible, and is properly installed, you can use the Camera and Scanner Wizard, described in a moment.

If your scanner has a document feeder, and you intend to scan multiple documents, load the documents to be scanned into the feeder. If you’re just scanning one thing, go ahead and put it in the scanner. Make sure the scanner is turned on and ready to go; then execute the following steps:
STEPS: Scan Documents

1. Open your My Pictures folder.

2. Under Picture Tasks in the Explorer bar, click **Get pictures from scanner or camera**. The Scanner and Camera Wizard opens.

   If you don’t see **Get pictures from scanner or camera**, make sure your camera or scanner is connected and turned on. If all’s well there, see the section “Troubleshooting Cameras and Scanners,” later in this chapter.

3. After a brief delay, the Camera and Scanner Wizard opens. Click the Next button on the first page of the Wizard.

4. The second page of the Wizard, titled “Choose Scanning Preferences,” opens. Choose whichever option best describes how you want the scanned image to look, summarized as follows:

   - **Color picture**: All colors, identical to the original.
   - **Grayscale**: Black, white, and shades of gray only. No color.
   - **Black and White picture or text**: Black and white only, no color or grays. Useful when original is only black text on white paper.
   - **Custom**: Depends on the settings defined under the Custom Settings button. The exact options available to you will depend on the make and model of your printer. Click the Custom Settings option to see your options. Click OK after choosing your options.

5. If you loaded multiple pages into the scanner’s document feeder, choose Document Feeder from the Paper Source drop-down list. Then choose a page size, if necessary. If you’ll just be scanning one item, choose Flatbed. Click Next.

6. Click the Preview button. Wait as your scanner scans the image. If the scanned image doesn’t fill the preview area, or if you want to scan only a portion of the image, drag the sizing handles so that

---

**Adjusting Resolution (DPI)**

For many scanners, the Custom Settings option will allow you to adjust the resolution of the scan. Resolution is measured in dots per inch (DPI). The basic rule of thumb is the higher the DPI, the bigger, and more detailed, the resulting picture. Large, detailed documents are great to use as originals for editing purposes. But smaller sizes are preferred when you’ll be e-mailing files or using them on a Web site.

High resolution is really good when you’re scanning something very small, like a postage stamp. High resolution will help capture the tiny details and pave the way toward clear, sharp enlargements.

---

**Note**
only the area you want to scan is framed, as in Figure 14-5. After you’ve framed the area, you may click the Stretch button (shown at left) to hide everything outside the framed area.

![Scanner and Camera Wizard](image)

**Figure 14-5**: An image scanned to, and framed within, the Preview area

7. Click the Next button to get to the Picture Name and Destination page of the Wizard. Type the name of your choosing to identify the picture (or group of pictures).

8. Choose a format from the *Select a file format* drop-down list. If in doubt, always choose JPEG (or JPG).

9. Click the Next button, and wait as the image is scanned. When the Other Options page appears, choose Nothing, and click the Finish button in the Wizard.

Remove the document(s) from the scanner and return them to safekeeping. The scanned document is a photo, so you’ll be able to open, view, and print it using techniques described in Chapter 15.

**Copying Pictures from a Web Page**

If you browse the Web using Internet Explorer (Chapter 10), and you come across a picture you’d like to keep, you can easily copy it to your hard disk. Here’s how:

**STEPS: Copy a Picture from a Web Page**

1. Right-click the picture and choose Save Picture As, as in the example shown in Figure 14-6.
2. In the Save Picture dialog box that opens, navigate to your My Pictures folder, if you’re not taken there automatically.

Tip: The Save Picture dialog box works exactly like the Save As dialog box discussed under “Saving a Document” in Chapter 6.

3. Optionally, change the file name to something that will help you better identify the picture by name.

4. Click the Save button in the Save Picture dialog box.

You’ll find the file in your My Pictures folder (or in whatever folder you navigated to in Step 2). It will most likely be a JPEG, GIF, or PNG image, since they’re the most widely used formats on the Web. You’ll learn more about using your My Pictures folder in Chapter 15.

If right-clicking a picture doesn’t get you to a menu, you can take a snapshot of the entire screen. Then paste the screenshot into a graphics program like Paint and crop out the parts you don’t want. See the sections “Printing the Screen” in Chapter 8 and “Editing Pictures with Paint” in Chapter 15.

Installing Cameras and Scanners

If you tried getting pictures from a camera or scanner using the preceding techniques and couldn’t get it to work, there are a few possibilities. First, eliminate the obvious ones: Is the camera/scanner turned on? Is the camera/scanner connected to the computer? If those things are OK, the most likely
scenario is that the device does not connect to the computer through a USB or FireWire cable and hence needs to be installed.

The first step in installing any device to your computer is this: Follow the instructions that came with the camera or scanner. There are hundreds of makes and models of these things on the market, and they’re not all the same. While the general techniques described here and in Windows Help and Support might help, there’s no substitute for following specific instructions for your specific device.

If you’ve been through that procedure and still can’t get things to work, or for some reason you were unable to complete the installation procedure by following the manufacturer’s instructions, the next step is to grab a software disk that came with your camera or scanner and put it into the appropriate drive. Then follow these steps:

1. Click the Start button and choose Control Panel.
2. If Control Panel opens in Category view, click Printers and Other Hardware. Otherwise, skip this step.
3. Open the Scanners and Cameras icon. The Scanners and Cameras folder opens. If you have a scanner or camera installed on your computer, each will be represented by an icon, something like the example shown in Figure 14-7.

![Figure 14-7: The Scanners and Cameras folder](image)

A device that connects through a USB or FireWire port won’t appear in Scanners and Cameras, even when it’s working perfectly. That’s because such devices are installed and uninstalled on-the-fly and hence don’t need a permanent icon in Scanners and Cameras.

4. Under Imaging Tasks in the Explorer bar, click Add an imaging device. The first page of the Scanner and Camera Wizard opens. Read the first page; then click Next.
5. The next wizard page asks what device you want to install. Here’s how that works:
   - If you inserted a disk from your camera or scanner already, click the Have Disk button.
   - If you don’t have a disk for your device, click your device manufacturer’s name in the left column; then (if possible) click your specific make and model of printer in the right column. Click Next.
From this point on, you have to read and follow the instructions that appear on the screen as you go through the Wizard. If you still can’t get your device installed, you’ll probably have to use the software that came with the device to get pictures from that device. Only the instructions that came with your camera or scanner can tell you how to install and use that software.

Troubleshooting Cameras and Scanners

Lots of things can cause a camera or scanner not to work. If the problem is that you can’t find the Get pictures from scanner or camera option under Picture Tasks in the Explorer bar, try these possibilities:

✦ Make sure you’re in your My Pictures or Shared Pictures folder or some subfolder within one of those. The Get pictures... option never appears in other folders.

✦ Make sure the Explorer bar is visible and the Picture Tasks category is open. (See the section “The Explorer Bar” in Chapter 5.)

✦ Make sure your scanner is properly installed as per the manufacturer’s instructions. Also, try using XP’s installation to help. (See the section “Installing Cameras and Scanners,” earlier in this chapter.)

For beginners, the most common problem with scanners and cameras is assuming that all makes and models of these things are the same. They’re not the same. You really need to learn the specifics of your exact camera or scanner. And the only places to get that information are the printed documentation that came with the device and the manufacturer’s Web site. Trying to hack things together through sheer guesswork is likely to turn into a frustrating experience!

Summary

That should be enough to get you started working with pictures. You’ll learn more about working with pictures in Chapter 15. For now, here’s a quick recap of the most important points made in this chapter:

✦ Every picture is a document file. Like all files, pictures are stored in folders.

✦ Windows XP comes with two built-in folders, My Pictures and Shared Pictures, for storing pictures.

✦ You can view and print photos on a CD. But if you wish to change them, you need to copy them to your hard disk first.

✦ If your digital camera or scanner is XP-compatible, you can use the Scanner and Camera Wizard to get pictures right from your My Pictures folder.

✦ To copy a picture from a Web page, right-click the picture and choose Save Picture As.
Playing with Pictures

Your computer can display and print all sorts of pictures, ranging from simple drawings to photographs and animations. The computer biz sometimes uses fancy terms such as digital image and graphic image to describe pictures, but basically a picture is a document stored in its own file on a computer disk.

As with any document, you can’t just open a picture by itself. You need some sort of program to view a picture on your screen. Programs you use to create and edit (change) pictures are generally referred to as graphics programs or graphics editors. A graphics program like Windows Picture and Fax Viewer (which comes with Windows XP) lets you look at pictures, but not change them. A graphics editor like the Paint program that comes with Windows XP lets you create, view, and edit (change) pictures.

Before we get into the programs, you need to get to the folder where your pictures are stored. So we’ll start this chapter with that.

Using Your My Pictures Folder

As when storing all documents, you store pictures in folders. Windows XP already has a couple of built-in folders especially well suited for storing pictures. Your My Pictures folder (which you’ll find in your My Documents folder) is the easiest one to get to. There’s also a folder named Shared Pictures, which is the same idea as My Pictures. However, on a network or computer with multiple user accounts, pictures in the Shared Pictures folder are available to everyone, whereas pictures in your My Pictures folder are private, in the sense that only you can get to them.
There are lots of ways to get to your My Pictures folders. Use whichever method is available and convenient at the moment:

✦ Click the Start button and choose My Pictures.
✦ Click the Start button, choose My Documents, and double-click the My Pictures icon in your My Pictures folder.
✦ If you’re already in a folder and see My Pictures listed under Other Places in the Explorer bar, click that option.

The contents of your My Pictures folder are displayed in the Explorer window that you learn about in Chapter 5, as in the example shown in Figure 15-1. You can choose a view (for example, Filmstrip or Thumbnails) from the View menu or the Views button in the toolbar.

![Figure 15-1: A sample My Pictures folder](image)

If your My Pictures folder contains subfolders, you can double-click any subfolder’s icon to open it and see the pictures it contains. The Explorer bar at the left side of the window contains a section titled Picture Tasks. Here’s a quick overview of what each of those offers:

✦ **View as slide show**: Clicking this option makes the screen go blank and displays each picture in the folder, one at a time, in slide-show fashion. Moving the mouse or pressing the spacebar during the slide show displays a little toolbar that lets you start/stop the show, navigate to the previous or next picture, or close the slide show and return to the folder and normal screen.
Order prints online: Lets you send pictures to an Internet service that will print them for you and mail them to you. This isn’t free, of course. If you have a printer, you can print them yourself for free.

Print pictures: See the “Printing Pictures” section that follows.

Copy all items to CD: Allows you to copy all (or selected) pictures to a CD. See Chapter 21 for skills and concepts required to make this work.

The same options are also available in your Shared Pictures folder, as well as in any subfolder contained within My Pictures or Shared Pictures. When you’re in your My Pictures folders, you can quickly switch to Shared Pictures, if you like, by clicking Shared Pictures under Other Places in the Explorer bar. It works the other way, too. If you’re in your Shared Pictures folder, you can click My Pictures in the Explorer bar to go to your My Pictures folder.

Tip

If your computer is connected to a network, or other people have user accounts on the same computer, you may want to share some photos with other users. Put those photos in the Shared Pictures folder. Keep the private ones in your My Pictures folder.

Printing Pictures

You can print any picture, or group of pictures, right from the Explorer bar, provided you’re in My Pictures, Shared Pictures, or a subfolder of either of those. First, get to the folder that contains the pictures you want to print and perform the steps that follow:

STEPS: Printing Pictures from a Folder

1. Open your My Pictures folder, or navigate to the folder that contains the pictures you want to print.

2. In the Explorer bar, under Picture Tasks, click Print Pictures. The first page of the Photo Printing Wizard opens. Click the Next button.

3. The Picture Selection page of the Wizard opens, with all pictures selected (checked) to be printed. If there are any pictures in the folder that you don’t want to print, clear their checkmarks.

Tip

You can select the pictures to print before clicking the Print option. Use any of the techniques described in the section “Working with Multiple Files and Folders” in Chapter 19 to select the pictures you want to print.

4. When all the pictures you want to print are selected, click Next. The Printing Options page appears.

5. On the Printing Options page, select the printer you want to use. Optionally, click the Printing Preferences button to get to the printer’s properties to choose additional options unique to your printer, such as a print quality. Then click Next.
6. In the Layout Selection page of the Wizard that opens, choose a layout from the Available Layouts list, as in the Example shown in Figure 15-2. Use the scroll bar at the right side of the list to see your options. Also, specify the number of times to print each picture; then click Next.

![Figure 15-2: The Layout Selection page of the Photo Printing Wizard](image)

7. Printing should start within a few seconds. On the last Wizard page, click the Finish button to close the Wizard.

**Making a Working Copy of a Picture**

On your hard disk, you’re free to make changes to your pictures. But before you do, know that it’s always a good idea to keep a copy of the original picture on disk. Use other copies for touchup work, sizing, or any other changes. That way, if you ever manage to make a mess of things, you always have the original picture to work from. You can use any of the techniques described in Chapter 19 to move and copy pictures (since each picture is a file). But if you just want to make a quick copy of one picture:

1. Right-click the icon for the picture you want to copy, and choose Copy.

2. Right-click some empty space near the icon you just right-clicked, and choose Paste.

Optionally, you can point to the picture, hold down the Ctrl key, drag the picture a slight distance so the mouse pointer is touching some empty space between icons, and release the mouse button.
The new file will be named Copy of *OriginalName*, where *OriginalName* is the same as the file you copied. If you want to rename the copy, right-click it, choose Rename, and type a new name, or edit the existing name.

**Tip** If you make first few characters of each file’s name the same, they’ll be near each other when you arrange icons into alphabetical order by name. (Choose View ➪ Arrange Icons By ➪ Name from Explorer’s menu bar.)

**Rotating a Picture**

If you hold a camera sideways when you take a picture, that picture will likely show up sideways on your screen. If the picture is in your My Pictures folder (or any other folder on your hard disk, for that matter), you can rotate it. It’s better to rotate a copy of the original picture rather than the original itself. So if you haven’t already done so, you can make a copy. To rotate the copy:

1. Right click the icon of the picture you want to copy.
2. Choose Rotate Clockwise to rotate the picture 90 degrees to the right or Rotate Counter Clockwise to rotate 90 degrees to the left.
3. You might see a message recommending that you work with copies. Assuming you are working with a copy, click Yes to proceed.

That’s it. If you rotate a picture the wrong direction, just rotate it the opposite direction twice to straighten things out.

**Recording Details About Your Photos**

If you’re a serious camera buff, you can record details about each photo as part of the file’s properties. Right-click any single photo’s icon and choose Properties. Or, if you want to assign the same properties to several photos, select the appropriate icons first. Then right-click any selected photo and choose Properties. Either way, the Properties dialog box for the picture(s) will open.

[Cross-Reference] See “Working with Multiple Files and Folders” in Chapter 19 for more information.

In the Properties dialog box, click the Summary tab. I can’t say exactly what properties you’ll see; it depends on the type of file(s) you’re working with. But if you’re working with a JPEG image, you’ll probably see the items shown in Figure 15-3. If the properties don’t appear in a list, as shown in the figure, click the Advanced >> button in the dialog box to switch to that view.

The properties listed under Image are facts about the picture that you can’t change. But you’re welcome to fill in the blanks on other items, such as Title, Subject, Keywords (for searching), and so forth. Later, when looking through pictures, or after performing a search for all pictures on your hard drive, you can display that information in Details view.
For example, let’s suppose you do a search for all pictures. When the search is complete, you can switch to Details view, choose the details you want to see, and arrange columns as suits your needs. You can click any column heading to sort the pictures on that column. Figure 15-4 shows an example, with the Title, Dimensions, Subject, and Author properties visible.

See the section “The Details View” in Chapter 5 for information on using columns in Windows Explorer. See the section “Searching for Lost Files” in Chapter 20 for information on searching for files.
Using Windows Picture and Fax Viewer

As with any document, you can double-click the icon for any picture to open it. In many cases, the Windows Picture and Fax Viewer, shown in Figure 15-5, will open to display the picture. Buttons along the bottom of the viewer provide some simple options for working with pictures. You can point to any button to see its name. Here’s what each button does:

- **Previous Image/ Next Image**: If several pictures are open, lets you view the next or previous image.
- **Best Fit**: Displays the picture at the largest size possible within the window.
- **Actual Size**: Shows the picture at its actual size.
- **Start slide show**: Starts a slide show of pictures in the folder. Move the mouse or press the spacebar to bring the slide show toolbar to the screen. Click the Close button in that toolbar to end the slide show and return to your program.
- **Zoom In**: Clicking this button magnifies the picture. To zoom in on a particular part of the picture, click the Zoom In button; then click the part of the picture you want to magnify. Each click increases the magnification slightly.
- **Zoom Out**: Does the opposite of Zoom In.
- **Rotate Clockwise**: Rotates the picture 90 degrees to the right.
- **Rotate Counter Clockwise**: Rotates the picture 90 degrees to the left.

![Figure 15-5: A picture open in Windows Picture and Fax Viewer](image)
✦ **Delete:** Deletes the image file from your disk.

The Delete button does not just remove the picture from the Image Preview window — it actually deletes the file from your hard disk!

✦ **Print:** Starts the Photo Printing Wizard so you can print the picture.

✦ **Edit:** Closes the picture and the viewer and opens the picture in a program that allows you to edit the picture.

✦ **Help:** Brings up the Help for Windows Picture and Fax Viewer (also called Image Preview), where you can learn more about the program.

If double-clicking a picture doesn’t open it in the viewer, try right-clicking the picture’s icon and choosing Open With ➪ Windows Picture and Fax Viewer.

As with any program window, you can close Windows Picture and Fax Viewer by clicking the Close (X) button in its upper-right corner.

### Editing Pictures with Paint

Windows XP doesn’t come with any fancy graphics programs for touching up photos. But it does come with a simple little drawing program named Paint, which lets you do some rudimentary things with pictures. Paint is also limited in terms of the types of pictures it can open. If a picture can be opened in Paint, you’ll see that program in the picture’s Open With menu. For example, to open a compatible picture in Paint, right-click the picture’s icon in My Pictures (or whatever folder it’s in), choose Open With, and click Paint, as in Figure 15-6.

![Figure 15-6: Right-click a picture’s icon and choose Open With ➪ Paint.](image-url)
Opening Paint

To open Paint with a new, empty document inside, click the Start button and choose All Programs ➪ Accessories ➪ Paint. The large white area in Paint’s document window is like a sheet of paper on which you can draw. If you want to work with a photo in Paint, it might be best to shrink that sheet of paper to a really tiny size first. That will prevent the photo from having a large white margin around it.

To shrink the sheet of paper in Paint, use whichever of the following techniques seems easiest to you:

✦ Choose Image ➪ Stretch/Skew from Paint’s menu bar. Under Stretch, set the Horizontal and Vertical settings each to 1; click OK.
✦ Move the mouse pointer to the lower-right corner of the paper until the mouse turns to a two-headed arrow. Then drag that corner up, and to the left, until the white square is tiny.

Copy and Paste a Picture into Paint

Once Paint is open, you can copy and paste a picture into it, provided you can get the picture open and visible on your screen. For example, suppose you’re browsing the World Wide Web and come across a picture you want to copy and work with. You’d like to open it in Paint, so you can crop it, size it, or whatever. Here’s how you do that:

**STEPS: Copy and Paste a Picture into Paint**

1. When you can see the picture on your screen, right-click it and choose Copy, as in the left side of Figure 15-7.
2. From Paint’s menu bar, choose Edit ➪ Paste.

A copy of the image will be visible in Paint, as in the right half of Figure 15-7.

Can’t Open in Paint

Paint can open pictures stored in .bmp, .jpeg, .gif, .tif, and .png formats. It cannot, however, open other types of pictures. If Paint won’t open a picture, try double-clicking the picture’s icon to see if any program can open the picture. Or right-click the picture’s icon, choose Open With, and click some other program that appears on the menu. If you can’t open the picture in any program, you don’t have the right program for that picture type. If that happens, see the section “When Windows Can’t Open a Document” in Chapter 6.
Cropping a Picture in Paint

Often, when you take a picture, things don’t turn out exactly as you planned. Sometimes there’s too much background and not enough of the main subject. Cropping is a technique that lets you get rid of extra background. To do this, you first need to get the picture open and visible in Paint. Then follow these steps:

**STEPS: Crop a Picture in Paint**

1. With your picture open in Paint, click the rectangular Select tool in Paint’s toolbar (shown at left with its screen tip visible).

2. Move the mouse pointer to the upper-left corner of where you want to start cropping. Then hold down the left mouse button and drag a rectangle around the area you want to keep, as in Figure 15-8. If you make a mistake, press the Escape (Esc) key and try again.

   **Tip**

   Like many programs, Paint supports *undo*. If you make a mistake, choose Edit ⊕ Undo from Paint’s menu bar, or press Ctrl+Z, to undo your most recent action.

3. From Paint’s menu bar, choose Edit ⊕ Copy To. A dialog box titled Copy To opens. Despite the slight title difference, it’s no different from the standard Save As dialog box described earlier.
4. In the Copy To dialog box, navigate to the folder in which you want to store the cropped picture. Type a new file name for the cropped image; then click the Save button in the dialog box.

![Figure 15-8: The portion of picture to keep is selected (inside the white frame).](image)

The cropped image will be saved in a separate file, while the uncropped original image remains on the screen. To open the cropped image, choose File ➪ Open from Paint’s menu bar. In the Open dialog box, navigate to the folder in which you stored the cropped copy, and double-click that picture’s icon. The cropped image opens, replacing the uncropped original, as in the example shown in Figure 15-9.

### Sizing a Picture in Paint

Pictures from digital cameras and scanners can be huge. For example, a picture of Aunt Matilda’s smiling face might be so huge on the screen that you see Aunt Matilda’s left nostril only. Not too flattering, and not a particularly good thing to print, or to e-mail to your friends.

Once you have a picture open in Paint, you can easily change its size. For example, you might want to make a copy of some huge photo that’s only 50% the original size. Then use that smaller copy for e-mailing and printing.
It’s best not to resize the original of a picture, because you may lose picture quality when enlarging a photo. It’s better to keep the original and work with a copy. Also, you can always shrink a large picture without losing picture quality. But when you enlarge a small picture, you often lose quality. The enlarged photo might be *pixilated*, a fancy term for *blotchy*.

**STEPS: Resize a Picture in Paint**

1. With your picture open and visible in Paint, choose Tools ➤ Stretch/Skew from Paint’s menu bar. The Stretch and Skew dialog box opens.
2. Under Stretch, set the Horizontal and Vertical options to some percentage size. For example, to make the picture half its current size, enter **50** in the Horizontal and Vertical text boxes under Stretch.
3. Click the OK button in the Stretch and Skew dialog box.

The picture will resize to your specifications. If you’re not happy with the results, press Ctrl+Z or choose Edit ➤ Undo from Paint’s menu bar. The picture will return to its previous size.

**Printing and Saving a Picture in Paint**

To print a picture currently open in Paint, use the standard technique. That is do either of the following:

- Choose File ➤ Print from Paint’s menu bar.
- Press Ctrl+P.
When the Print dialog box opens, you can choose options as appropriate for the picture (for example, if your printer lets you choose a paper type and print quality, as discussed in the section “Printing a Document” in Chapter 8).

To save the newly resized picture under a new file name, choose File ➪ Save As from Paint’s menu bar. In the Save As dialog box that opens, navigate to the folder in which you want to store the picture, and enter a file name. Optionally, you can choose a file type from the Save As Type drop-down list. Click OK, and the picture is saved.

For more information on saving documents, see the section “Saving a Document” in Chapter 6.

Fancier Graphics Editing

Paint doesn’t really offer anything in terms of touching up photos. But there are plenty of graphics programs on the market that do. Many computers, digital cameras, and scanners come with graphics software that’s better than Paint. If your computer is new, and you don’t know what graphics programs are installed on it, you can take a quick peek. Right-click the icon for any picture and choose Open With. Every program capable of opening the picture will be listed on the submenu. Click any program’s name to open the picture in that program.

Once you’ve opened a program, choose Help ➪ About from that program’s menu bar, if available. That will usually show you the manufacturer, name, and version of the program. It might also contain a link to the manufacturer’s Web site. Without an Internet connection, you can learn more from the Help menu for that program, as well as from any printed documentation that goes with the program.

If you have Microsoft Office, you might have Microsoft Digital Photo Editor installed. If so, you should be able to find it on the All Programs menu or when you right-click a picture’s icon and choose Open With. If you have Office, but not Microsoft Photo Editor, you can use Add/Remove Programs in Control Panel to add the editor as an Office component.

See the section “Installing New Software” in Chapter 25 for more information.

To window shop for graphics programs, use your Web browser to visit www.WindowsCatalog.com. On the home page, click the Software tab. In the left column, click Desktop Publishing, Graphics, and Visual Design. Then click any category name that looks interesting for examples of available products.
Summary

This chapter has taught you some tools and techniques for working with pictures in Windows XP. Here’s a quick summary of the main points:

✦ To print pictures from a folder, navigate to that folder and click Print Pictures in the Explorer bar.

✦ To create a working copy of a picture, right-click its icon and choose Copy. Then right-click some empty space outside that icon and choose Paste.

✦ To rotate a picture, right-click its icon and choose one of the Rotate options on the shortcut menu.

✦ The Windows Picture and Fax Viewer lets you view, but not change, several different types of pictures.

✦ Microsoft Paint, which also comes with XP, lets you crop and resize pictures.

✦ For more sophisticated graphics editing, such as photo touchup, you need a real graphics editor.
Music and video are examples of what’s called multimedia in the computer biz. Audio files can contain any kind of sound, ranging from tiny sound effects to entire songs from CDs. Video files can be anything from a small video clip to a movie you created yourself. If your computer has a DVD drive, you can watch DVDs.

Multimedia files (also called media files or digital media) are documents. As such, they don’t open by themselves. They open in some program, called a media player. Windows XP comes with a built-in media player, cleverly named Windows Media Player. This chapter is about using Windows Media Player 9 to listen to music and watch videos.

Introducing Windows Media Player 9

As when starting any program, you can start Windows Media Player from the Start menu, although the default Quick Launch toolbar also has a button for launching Media Player. So you can start Media Player at any time using whichever method is available:

✦ Click the Start button and choose All Programs ➤ Windows Media Player.
✦ Click the Media Player button in the Quick Launch toolbar.
It’s difficult to say exactly what you’ll see when Media Player first opens. If this is the first time you’ve opened Media Player, you might see a message asking whether you want to scan your hard disk for media files. If that happens, you can click the Yes button, following any additional instructions that appear on the screen until you get to Media Player’s program window.

If this is the first time you’ve opened Media Player, you might also see a Wizard screen that describes what Media Player is about and provides some options for configuring Media Player. If you’re confused by all the options, you can just click the Next button on each Wizard page and click Finish on the last page. You can change your mind about any options you choose in the Wizard by choosing Tools ➪ Options from Media Player’s menu bar.

When Windows Media Player finally opens, you’ll probably see its program window, including the toolbar and menu bar shown at the top of Figure 16-1. If you don’t see the menu bar and toolbar, click the Show menu bar near the upper-right corner of the window, magnified in Figure 16-1 with the mouse pointer touching it. That will bring the menu bar and title bar into view.

Media Player is also unique in that it supports the use of skins. A skin is a whole different interface for a program. That is, a skin radically changes the appearance of a program on the screen, without changing that program’s capabilities. Skins are no big serious thing, just an amusement really. If Media Player opens in a skin (like the sample Ducky skin shown in Figure 16-1), you can easily switch to the Full Mode (the normal program window) by right-clicking the skin and choosing Switch to Full Mode. But even in full mode, it’s tough to say exactly what Media Player will look like, because there are two different versions floating about. This brings us to . . .

Figure 16-1: Windows Media Player in Full Mode and in Skin Mode
Upgrading Windows Media Player

Windows XP ships with Version 8 of Windows Media Player. Since then, Microsoft has released a new and improved Version 9. In this book, we’re going to focus on Version 9. If you use automatic updating, or have already updated Media Player, you already have Version 9. If not, you can update for free. (More on that in a moment.)

If you’re not sure which version of Media Player you’re currently using, go ahead and start Media Player on your computer. Then choose Help ➤ About Windows Media Player from its menu bar. If you’re using Version 9, you’ll see the larger dialog box shown at right in Figure 16-2, with the large 9 Series under the logo and title. If you see that, you’re already using Version 9; you can skip to the section “Using the Features Taskbar,” later in this chapter.

If you’re using Version 8 of Media Player, you’ll see an 8.000.something number in the dialog box that opens, as on the left side of Figure 16-2. In that case, you should click the OK button. Then continue reading the next paragraph for info on upgrading the Media Player 9. It’s worth taking the time to get the new, upgraded version. And it won’t cost you a cent.

Figure 16-2: Windows Media Player Version 8 (left) and Version 9 (right)

If you connect to the Internet through a dial-up account, be forewarned that upgrading to Media Player 9 might take 30 minutes or more. It would be best to start the whole job when you know you can leave the computer running and online for at least that long. Also, make sure that you are online before you start the upgrade.

To start the actual upgrade, open Windows Media Player (if it isn’t open already), and choose Help ➤ Check for Player Updates from Media Player's menu bar. Initially, you may be taken through a procedure that just installs some preliminary software. If you don’t see a screen offering Windows Media Player 9 upgrades after the procedure run, choose Help ➤ Check for Player Updates a second time to begin the actual Media Player 9 download. If asked whether you want to Open or Save the file, choose Open.
Don’t be alarmed by any security messages that pop up along the way. They are generic messages that always appear when you download programs. You don’t have to worry about files from Microsoft, or any other legitimate software company, being infected with viruses or worms. That stuff spreads through e-mail attachments and junk programs you download for free.

When the upgrade is complete, Windows Media Player 9 will open on your screen.

If you don’t want Media Player to go to the WindowsMedia.com Web site every time you open it, choose Tools ➪ Options from Media Player’s menu bar. In the Options dialog box that opens, click the Player tab, clear the checkmark next to Start Player in Media Guide, and click OK. The program will load more quickly, especially if you’re using a dial-up account.

### Using the Features Taskbar

The Features taskbar provides access to the main features of Media Player. If it’s fully visible, you’ll see all the buttons shown in the left side of Figure 16-3. If you don’t see the Features taskbar, click the Show Taskbar button midway down the left side of Media Player’s program window. If you don’t see all the buttons in the Features taskbar, click the little Show/Hide button at the bottom to see other buttons.

![Figure 16-3: The Features taskbar in Windows Media Player 9](image)

As with any program window, you can double-click Media Player’s title bar, or click its Maximize button, to size it to full-screen. See the section “Arranging Open Program Windows” in Chapter 4 for details.

The first step in getting anything done in Windows Media Player is usually to click the appropriate button in the Features taskbar, depending on what you want to do at the moment:
✦ **Now Playing:** Lets you control the music you’re listening to now, with an optional visualization. The visualization is a pattern of colors that changes with the music. You’ll also be able to choose any playlist you want to listen to.

✦ **Media Guide:** Takes you to the WindowsMedia.com Web site, where you can buy CDs or individual songs, watch video clips, and more. See the section “Digital Media on the Web,” later in this chapter, for more information.

✦ **Copy from CD:** Lets you copy songs from a music CD to your hard disk and Media Library.

✦ **Radio Tuner:** Lets you listen to radio stations that broadcast over the Internet.

✦ **Copy to CD or Device:** Lets you copy any selection of songs to your own custom audio CD or to a portable diskless player.

✦ **Premium Services:** Describes numerous online services that you can use in conjunction with Media Player to download music and movies from the Internet. Nothing free here either, except trial runs.

✦ **Skin Chooser:** Lets you pick a new skin for Media Player and download new skins from a Web site.

You’ll learn more about the major features summarized here later in this chapter and in Chapter 17.

### Using the Play Controls

Before I tell you how to actually play something, I better tell you about the Play controls — mainly so that you don’t blast your eardrums out the first time you play a song or video. In Full Mode, Media Player’s Play controls are along the bottom of the program window. Most work like the controls on a stereo or VCR. As usual, you can point to any button in the Play controls to see its name. Figure 16-4 points out the locations of the various controls. Here’s what each does and how it works:

![Figure 16-4: Windows Media Player’s Play controls](image)

✦ **Play/Pause:** Click to play the current song/video or to pause the current song if it’s playing.
Stop: Stop playing the current song/video and rewind to beginning.

Rewind: Rewind playing song/video.

Seek bar: Jump to any part of the video or song by dragging the sliding box or clicking any place along the bar.

Fast Forward: Play the song/video faster.

Previous: Go to previous song in playlist (you’ll find out what a playlist is in just a few moments).

Next: Go to next song in playlist.

Mute: Turn off all sound. Click again to restore sound. If you get no sound from a playing song or video, click this button to make sure the speakers aren’t muted.

Volume: Adjust the volume of the song/video. Drag the sliding bar to the left to lower the volume before playing your first song or video. After something is playing, you can drag the slider to the right to increase the volume.

Shuffle: Turns shuffle on and off. When on, songs from the current playlist are played in random order. When off, songs from the current playlist are played in the order they’re listed. (You’ll learn about playlists later in this chapter.)

Color: Changes Media Player’s color scheme. Each click cycles to another scheme.

Skin mode: Switches from Full Mode to Skin Mode using the currently selected skin. To return to full mode, press Ctrl+1, or right-click the skin and Switch to Full Mode.

Closing Windows Media Player

As with any other program, you can maximize, minimize, move, and size Media Player’s program window. Like most programs, Windows Media Player also has a taskbar button when it’s open. You can close Windows Media Player using any of the usual methods:

Click the Close button in the upper-right corner of Media Player’s program window.

Choose File ➪ Exit from Media Player’s menu bar.

Right-click Media Player’s taskbar button and choose Close.

If Media Player is in the active window, press Alt+F4.

If Media Player was playing a song when you closed it, the music will stop too. If you want to get Media Player off your desktop, but have it still play music, minimize its program window; don’t close it.
We’ll get back to Media Player in just a moment. Before we do, we need to talk about Media Files in general.

Using Your My Music Folder

If you’ve been reading along in this book, you probably recall seeing a folder named My Music inside your My Document folders. There’s also a folder named Shared Music. Use My Music for songs you want to keep to yourself (or if you’re the only person who uses this computer). Use Shared Music for songs you want to share with other people who use the same computer or other people in your local area network. To open your My Music folder, use whichever method is most convenient at the moment:

✦ Click the Start button and choose My Music.
✦ Open your My Documents folder and double-click the My Music folder’s icon.

To get to the Shared Music folder from My Music, just click Shared Music under Other Places in the Explorer bar. If your computer is new, both folders might be empty or nearly empty. But if you’ve already started building a media collection (a topic we’ll discuss in Chapter 12), you’ll likely see folders representing different artists, as in Figure 16-5.

![Figure 16-5: A sample My Music folder that already contains music](image)

If you double-click an artist’s folder, like Santana, that folder will reveal albums and songs by that artist that you’ve copied to your Media Library, as in Figure 16-6.
If you double-click an album folder in Figure 16-6, you'll see an icon for each song on that album, as in Figure 16-7.

Depending on what you happen to be viewing at the moment, and whether or not you select and individual song, you'll see different options under Music Tasks in the Explorer bar, as summarized here:

- **Play All/Selection**: Clicking this option plays all the songs in the folder or plays all the selected songs or folders.
✦ Copy to audio CD: Starts the process of creating a new custom audio CD from the selected songs or folders. See Chapter 17 for details on creating custom audio CDs.

✦ Shop for music online: Takes you to the WindowsMedia.com Web site, where you can purchase CDs.

Choosing the Play All (or Play Selection) option would most likely open Windows Media Player to play the media files. But there’s no guarantee that Media Player will open, because it depends on what type of file you’re trying to play and what program is currently set as the default player for that file type. Let’s start with the issue of file types that Windows Media can play.

**Types of Media Files**

Media files are documents and come in many formats. Windows Media Player can read a lot of file formats, but not all of them. For example, there are many video files on the Internet that are stored in .ram and .mov formats, which Media Player can’t read. You need to use RealOne (www.real.com) to read .ram files and Apple QuickTime (www.QuickTime.com) to play those videos. But Windows Media Player can read all the media file types listed above Real Audio Movie and QuickTime Movie in Table 16-1.

<table>
<thead>
<tr>
<th>File Type</th>
<th>File Name Extensions</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows Media File</td>
<td>.asf, .asx, .dvr--ns, .wpl, .wm, .wmx, .wmd, .wmz</td>
<td>Various media types, often sent as streaming media across the Internet</td>
</tr>
<tr>
<td>Windows Media Audio</td>
<td>.wma, .wax</td>
<td>Preferred audio format for Windows XP</td>
</tr>
<tr>
<td>Windows Media Video</td>
<td>.wmv, .wvx</td>
<td>Preferred video format for Windows XP</td>
</tr>
<tr>
<td>CD audio</td>
<td>.cda</td>
<td>Format used by music CDs played in stereos</td>
</tr>
<tr>
<td>Windows video file</td>
<td>.avi</td>
<td>General purpose video, sometimes compressed with DivX¹</td>
</tr>
<tr>
<td>Wave sound</td>
<td>.wav</td>
<td>Best for tiny sound effects, bad for recorded music</td>
</tr>
<tr>
<td>Motion Pictures Experts Group</td>
<td>.mpeg, .mpg, mpe, .m1v, .mp2, .mpv2, .mp2v, .mpa</td>
<td>The most widely used format for video and DVD</td>
</tr>
<tr>
<td>MP3 audio</td>
<td>.mp3, .m3u</td>
<td>The most widely used format for storing recorded music</td>
</tr>
<tr>
<td>Musical Instrument Digital Interface (MIDI)</td>
<td>.mid, .midi, .rmi</td>
<td>Contains synthesized music only, cannot contain recorded sound</td>
</tr>
</tbody>
</table>

*Continued*
If you’re new to all of this, all those file types might be intimidating at first glance. But there are a couple of simple rules you can follow when given a choice of choosing one file format over another:

✦ **Music:** The MP3 and .WMA formats are widely used and work great in Windows XP and Media Player.

✦ **Video:** The MPEG and .WMV formats are also widely used and also work great in Media Player.

So if you can remember those four main formats, MP3, MPEG, .WMA, and .WMV, you’ll be ahead of the game in terms of knowing what to look for in media files.

---

File name extensions are visible only when the Hide extensions for known file types option in Folder Options is turned off. For details, see the section “Showing/Hiding File Name Extensions” in Chapter 6.

### Searching Your Hard Disk for Your Media Files

Even if your computer is brand new, chances are there are a few sample media files you can play around with to learn. If you want to search your hard disk now to see the media files you already have, follow these steps:

1. Click the Start button and choose Search.
2. Under What do you want to search for? click Pictures, music, or video.
3. On the next page, select the Music and Video checkboxes.
4. Click Use Advanced Search Options; then choose Local Hard Drives under Look In. At this point, the Search Companion pane should look like Figure 16-8.

   You can choose any drive or folder you want under Look In in Step 4. Choosing Local Hard Drive (or Local Hard Drives, in case you have more than one) ensures that your entire hard disk (or disks) will be included in the search.
5. Click the Search button and wait a few seconds.

6. When the search is complete, click Yes, finished searching.

The resulting search will include all files currently on your hard disk that contain music or video. There’s more to a media file, though, than the file name and icon, as discussed next.

In the Search Results main pane, you can get to the folder that contains a file by right-clicking the file name and choosing Open Containing Folder. The folder will open in a new, separate Explorer window.

Media files that will play in Windows Media Player when you open them all have the document-icon look (the dog-eared sheet of typing paper) with Media Player’s logo on top, as in the example at left. If some other program, such as Music Match, is currently configured as your default media player, that program’s icon will appear in place of Media Player’s icon.

Opening a Media File

You open a media file in Explorer the same way you open any document. You can double-click the icon, in which case the file will open in the default player for the type of media file you double-clicked. Or you can right-click the media file, choose Open With, and click the name of the program you want to play (or edit) the file with.
The default player is, simply, the program that opens automatically (by default) when you double-click a media file. If your media files open in some other program, you can close that program, right-click the same icon, and choose Open With ➪ Windows Media Player. Or make Windows Media Player the default for that type of file, as in the sidebar that follows.

Once the media file starts playing, you can use the Play controls described earlier to control the volume of the sound, pause playback, rewind, and so forth. Use the Now Playing feature, described later in this chapter, to watch a video or a music visualization.

You’re not limited to playing files currently on your computer’s hard disk. You can play any standard music CD or DVD as well. You can also play sound and video clips available from the Web. We’ll look at some examples in the sections that follow.

### Playing Music CDs

A music CD contains only music stored in .cda format. That includes all CDs that you buy from a record store and play on a stereo or CD player. Playing a music CD is usually pretty simple:

**Caution** Playing a music CD is not the same as copying a music CD. When you play a music CD, you hear the music. But nothing gets copied from the CD to your computer’s hard disk.

### STEPS: Playing a Music CD

1. If you want to be able to see song titles, and you have a dial-up account, connect to the Internet so Media Player can download media information.
As discussed in the section “Where Media Information Comes From” in Chapter 17, you need to be online to get media information, such as song titles, from the Internet. That information isn’t stored on most CDs.

2. Insert the music CD, label-side up, into your computer’s CD drive, and wait a few seconds.

3. If you see a dialog box like the one in Figure 16-9, click **Play audio CD using Windows Media Player**, and click OK. Otherwise, ignore this step.

**Figure 16-9:** Dialog box that might open when you insert a music CD into your CD drive.

---

**Make Media Player the Default for Music CDs**

You can choose how your CD drive reacts when you insert a music CD into your CD drive. Click the Start button and choose My Computer to open your My Computer folder. In My Computer, right-click the icon for your CD drive (typically drive D:) and choose Properties. In the Properties dialog box that opens, choose **Music CD** (not **Music Files**) from the drop-down list. Choose **Select an action to perform**; then click **Play audio CD using Windows Media Player**, as shown in the following figure.

After you’ve made the change, click the OK button in the dialog box. The next time you put a music CD into your computer’s CD drive, Windows Media Player will open automatically and start playing the CD.
4. In Windows Media Player, click the Now Playing button in the Features taskbar.

5. Use the Play Controls in Media Player to adjust the volume, pause playback, mute the speakers, skip songs, and so forth.

After you have some music playing, you can learn about the Now Playing feature in Media Player.

**Playing a Video**

Video files come from all kinds of sources. Some are simply streaming video that comes from the Internet and you watch in Windows Media Player. As a rule, you can’t save these as files. You can only watch them. Beyond streaming video, there are all sorts of videos stored in files and all sorts of ways to create them. People can e-mail them to you. People can send them to you on a CD or other disk. You can download videos (in files) from many Web sites and file-sharing networks, such as Gnutella. There’s even a sample video that comes with Windows XP that you can play around with.

**Tip**

In Internet Explorer, the best and quickest way to download a video is usually not to open it at all, but rather to right-click and choose Save Target As. See Chapter 10 for details.

Icons for video files don’t look much different from other icons. But if you’re in Thumbnails view, MPEG and .wmv movies will show the first frame of the video, as in the examples shown in Figure 16-10. To open a video, double-click its icon, or right-click its icon and choose Open With Windows Media Player.
Windows Media Player will open to play the video. Click the Now Playing button in Media Player’s Features taskbar. You can use the Play controls, discussed earlier in this chapter, to adjust the volume, mute the speakers, pause, fast forward, and so forth. Use Now Playing features described later in this chapter to watch the video full-screen and such.

To avoid having your screen saver kick in and replace a playing movie, choose Tools ➪ Options from Media Player’s menu bar. In the Options dialog box that opens, click the Player tab. Clear the checkmark next to Allow screen saver during playback, and click OK.

Watching a DVD

If your computer has a DVD drive, you can also watch DVDs with Windows Media Player. (You can’t play a DVD in a CD drive.) DVDs on a computer play just as they do on a regular TV. To watch a DVD:

1. Insert a DVD disk, label-side up, into your computer’s DVD drive, and wait a few seconds.
2. If you see a dialog box like the example shown in Figure 16-11, click Play DVD using Windows Media Player. Otherwise, skip this step.

![Figure 16-11: Options like these may appear when you insert a DVD into your computer’s DVD drive.](image)

3. Click the Now Playing button in Media Player’s Features taskbar so you can see the movie. Like a video file, a DVD plays in the large visual pane of Media Player, as in the example shown in Figure 16-12.
To make Windows Media Player the default player for DVDs, open My Computer, right-click the icon for your DVD drive, and choose Properties. Click the AutoPlay tab and choose DVD Movie from the drop-down list. Choose Select an action to perform, click Play DVD Video using Windows media Player, and click OK.

Watching a VCD

A VCD (video CD) is similar to a DVD but contains less content or lower-quality content. Playing a VCD is similar to playing a DVD. However, if the VCD doesn’t do anything when you insert it into the CD, you’ll need to give it a little kick from within Windows Media Player:

**STEPS: Play a VCD**

1. From Media Player’s menu bar, choose Play ➪ DVD, VCD, or CD Audio.

2. Click the drive that contains the VCD.

3. If the video doesn’t start playing, double-click a VCD segment in the playlist pane to play it.
Use the Play controls to control playback. Click the Now Playing button in the Features taskbar to watch the video.

**Digital Media on the Web**

As mentioned earlier in this chapter, the Media Guide button in Windows Media Player takes you to the [WindowsMedia.com](http://WindowsMedia.com) Web site, where you play music and video samples, buy music by the CD or song, and just play around in general. But let me preface that with some warnings for newbies (beginners) who haven’t done this sort of thing before:

- Digital media files are large and take time to cross the Internet. Don’t expect much instant gratification here, especially if you’re using a dial-up account. The progress indicator near the lower-left corner of Windows Media Player, shown at left, keeps you apprised of progress.

- When you see a link that offers a download in multiple speeds, dial-up users should always choose 56K. Broadband users can choose any speed.

- The Back, Forward, Stop, and Refresh buttons in Media Guide (Figure 16-13) work the same way they do in Internet Explorer. See Chapter 10 if you’re new to browsing the World Wide Web.

- At any time, your Web browser might pop open and cover up your Windows Media Player. You can use the taskbar buttons to switch back and forth between the two windows.

- When a video is playing, you need to click Now Playing to see it. To return to the Web from there, click the Media Guide button. See “Using the Now Playing Feature,” later in this chapter, for details.

- If you’re looking for a Napster-type service, where things are free and anything goes, WindowsMedia.com isn’t that place. Gnutella is, however. (See “Downloading Free Stuff from the Internet,” later in this chapter.)

As far as music and video go, things get a little more complicated when you start viewing and downloading from the Web. First, you need to be aware that there’s a difference between streaming media and media files. Second, you need to understand digital licenses.
Streaming Media

There are two ways digital media is delivered over the Internet. One is streaming, which is like radio or TV. The music or video plays, but it's not saved in any format. It just plays, it's over, and that's it. Saving streaming media isn’t an option, and that’s kind of the whole point. If you don’t want people making copies of your stuff, send it to them in streaming format so they can’t save it.

Media files are things you download from the Internet and put on your hard disk. That’s what download means: to copy a file from some other computer to your own computer. With downloading, you don’t just watch once. You get to keep your own copy. But exactly what you can do with that copy depends on whether or not the file is protected, as discussed next.

Downloading Licensed Content

When you go through traditional Web sites like WindowsMedia.com, downloading usually means buying. And what you get is the song or video, plus a digital license. The digital license allows you to keep a copy and play it on your computer, but only on your computer. You can’t make copies to share with anyone else. That’s why it’s also called protected content.

How long you keep the license varies. If it’s something you got for free, the license might expire after 30 days or whatever, at which point you can’t use the file any more. If you purchase protected content, you’ll more likely get to keep it forever. But still, you can’t make copies or play it on any computer but the one it’s on.

Whether or not you can copy protected content to a music CD or portable music player depends on the specific song you’re downloading and from whom you’re downloading it. Since this all happens on the Web, there’s no way for me to tell you exactly what to expect. I can provide only a general example, like the one in Figure 16-14.

Figure 16-14: Example of purchasing a song online
In the example, I’ve put a song from Liquid Audio (one of the content providers available through WindowsMedia.com) into my shopping cart. The little icons under Permissions correspond to the legend, which in turn tells me I can export the song to a portable player or burn it to a CD.

**How to Download**

Exactly how you purchase and download media depends on the Web site you’re using. The process is usually to add items to your shopping cart, pay for them, and start downloading. If you see a prompt like the one in Figure 16-15 at the start of a download, always click the Save button, as that’s the only option that actually saves the file to your hard disk.

![Figure 16-15: Choosing whether to open or save a downloaded file](image)

When you click the Save button, a Save As . . . type dialog box will open. Use the standard techniques described in the section “Using the Save As Dialog Box” in Chapter 6 to navigate to your My Music folder (or to any folder of your choosing), and save the file normally. Once the file is downloaded, you can open it as you would any other document.

**Tip**

When downloading files from legitimate companies doing business on the Web, you needn’t be worried about viruses or worms. E-mail attachments and free stuff are the things you need to be concerned about.

**Managing Digital Licenses**

The digital licenses you get with protected media are critical. If you lose it, or accidentally delete it, you’re out of luck. You won’t be able to play the file ever again. For this reason, if you’re going to be purchasing music online, you’ll want to know how to back up your digital licenses. It’s not too tough:

**STEPS: Backing Up Digital Licenses**

1. In Windows Media Player, choose Tools ➤ License Management from the menu bar. You’ll see the dialog box shown in Figure 16-16.
2. What you do next depends on what you want to do:

- If you want to back up to a floppy disk, put a formatted floppy into the floppy drive and click the Change button. In the Browse for Folder dialog box, click My Computer, then the icon for your floppy drive (A:).

- If you want to burn the licenses to a CD later, put them in a folder that you normally back up so they’ll be copied next time you do a backup.

3. Click the Backup Now button and follow any instructions that appear on the screen.

Should you ever lose your licenses and need to get them back, you can repeat Step 1; then click the Restore from Backup button in the dialog box.

If you ever move the protected computer to another computer, a different hard disk, or a recently reformatted drive, you’ll need to make a backup of the licenses to a floppy or CD. Then restore the licenses onto the new computer or hard disk.

**Downloading Free Stuff from the Internet**

There’s nothing built into Windows XP that lets you download free music from the Internet. So I can’t spend a whole lot of time in this topic. I can, however, get you in the ballpark and tell you how to keep it safe. For starters, the free downloads you may have heard about are available on the Gnutella network, which is a file-sharing service (also called a peer-to-peer or p2p network) on the Internet.

To use Gnutella, you need a *Gnutella client*, a program that lets you share and download files from the Internet. There are several freebies around that you can download and start using right away, including LimeWire (www.LimeWire.com), Morpheus (www.Morpheus.com), iMesh (www.iMesh.com), and Kazaa (www.Kazaa.com).
Before you grab one of those though, keep in mind that freeware (free software) often earns money through ad revenues. And it gets those revenues by displaying pop-ups on your screen. You can block the pop-ups. But they don’t get blocked until they reach your computer, which means they’re eating up bandwidth even though you don’t see them. *(Eating up bandwidth translates to slowing everything down.*) So if you’d rather part with a few bucks than lose speed to pop-ups, consider purchasing a pop-up free program like LimeWire Pro (*www.LimeWire.com*).

Whatever program you get, you should learn to use it before you start downloading. In particular, you’ll want to know what files you’re sharing. It’s illegal to share copyrighted music, so you want to know what files you’re sharing at all times.

You’ll need to know the folder that your downloads are being stored in. Ideally, you should configure the program to put all downloaded files in a Recent Downloads folder, as discussed in Chapter 13. Nobody owns Gnutella; there’s no censorship or monitoring. So there’s no guarantee that what you downloaded is what you thought you downloaded. As for the no-censorship part, parents should be aware of that and consider blocking all adult material if your Gnutella client allows it.

When choosing an audio file to download, try to stick to MP3 and WMA formats, as you can add those to Windows Media Player’s Media Library. The *bit rate* of a song is basically a measure of its quality. If you want to stick to CD quality or better, only download songs with bit rates of 128 Kbps or better.

When downloading video, try to stick with .WMV and MPEG formats. Other file formats can be *iffy*. Many shared video files in .avi format are compressed using DivX. To play those, you need to download and install the DivX codec from *www.DivX.com*.

If you plan to add the song to Windows Media Player’s Media Library, it would be best to move it to its permanent folder beforehand. Moving songs around after they’re in Media Library can be *iffy* as well. Also, consider checking and correcting any media information attached to the file before adding the file to Windows Media Library. See “Media File Hidden Properties” in Chapter 17 for more information.

Finally, you’ll need to choose Tools ➤ Search For Media Files from Media Player’s menu bar to add downloaded songs to your Media Library. Your Gnutella client won’t update Windows Media Player’s Media Library.

Good luck, and remember that the only places you’re going to get information about the Gnutella client you chose are the Help within that program or the Web site from which you downloaded the program.
Using the Now Playing Feature

When you have a song, video, or DVD playing in Media Player, you can use the Now Playing button in the Features taskbar to watch the video or a visualization of the music that’s playing. The main areas of Now Playing are pointed out in Figure 16-17. (I cut off the Play controls at the bottom of the window, because they’re the same in all views.) As usual, you can point to any button to see its screen tip. Here’s what each button is for:

![Figure 16-17: Tools available in the Now Playing feature of Windows Media Player](image)

- **Playlist**: Shows album art and song titles from the current CD or playlist. Use the scroll bar at right to scroll through other titles. Double-click any song to play it, or right-click any song title for other options. To choose a different disk drive or custom playlist, use the drop-down list at the top of the playlist.

- **Visualization or Video**: If you’re watching a video or movie, it appears in this large pane. If you’re listening to music, a visualization plays here. A visualization is a pattern of shapes and colors that changes in response to changes in the music.

- **Options**: Clicking the Now Playing Options button displays a menu of options that apply to the Now Playing feature you’re in. They’re all entirely optional and safe to play around with. Your options are:
  - **Visualizations**: Enables you to choose a different visualization, turn off visualizations, or visit a Web site where you can download more visualizations.
• **Info Center View:** Replaces the visualization with information about the current CD or playlist. You can choose to have it show always or only when there’s media information worth showing.

• **Plug-Ins:** Takes you to a Web site where you can download plugins that extend Media Player 9’s capabilities. Things include audio special effects, DVD decoders (for watching DVDs in Media Player), MP3 creation tools (see Chapter 10), and more.

• **Enhancements:** Replaces half the visualization/video pane with sound and video enhancement tools, such as a graphic equalizer, color chooser, video settings, and other fun toys. To hide enhancements, click this button and click Show Enhancements (to clear its checkmark).

✦ **Previous, Next, Current Visualization:** The Previous and Next buttons let you choose a visualization by cycling through them (as an alternative to clicking the Options button and choosing a visualization by name). The name of the visualization currently playing appears to the right of the buttons.

✦ **Maximize/Restore Visual:** Click once to hide the playlist and expand the visualization/video into its space. Click a second time to get things back to the Normal view.

✦ **Full Screen On Off:** Click once to expand the visualization/video to full screen. Some controls will initially appear, but fade away. To get back to the Normal view, press any key on your keyboard, or move the mouse around a little. Then click the button again. (In full-screen view, the button’s tooltip reads *Exit Full Screen* when you point to it.)

✦ **Playlist Options:** Not much offered when playing an audio CD. But when working with custom playlists, you may find these options useful for customizing the playlist without switching to the Media Library feature.

### Radio Tuner and Premium Services

The Radio Tuner and Premium Services buttons on the Features taskbar both take you to Web sites. I can’t really tell you what you’ll see when you click one of those buttons. But things should be self-explanatory once you get there. Once you get to the Web site, you should be able to figure out what’s going on just by reading the information presented on the Web page that opens.

✦ **Radio Tuner:** Takes you to a Web site where you can listen to radio stations that broadcast over the Internet. (This doesn’t work too well with dial-up Internet accounts.) On the page that opens, you’ll be able to check out radio stations by category (for example, Top 40, Country, Rock) and search for radio stations by keyword.

✦ **Premium Services:** Takes you to a Web site where you can explore optional premium services that work with Media Player so you can rent movies, buy music, and do other things.
Playing with Skins

Skins in Media Player are entirely optional and really exist only for amusement. Skins don’t change what Media Player does. They just change the way it looks on the screen. To see available skins:

**STEPS: Change Media Player’s Appearance**

1. If you haven’t already done so, open Media Player. Click the Skin Choose button at the bottom of the Features taskbar.
2. In the left panel, click the name of any skin to see what it looks like, as in Figure 16-18.

3. If you find a skin you like, click the Apply Skin button.

Media Player instantly changes to the requested skin. Exactly how you use that skin depends on the skin. In most cases, you can figure out which control is which just by pointing to each one to see its name. To move the skin around on your desktop, point to some neutral area on the skin (not on a button or other control), hold down the left mouse button, and drag the skin around.

To return to Full mode, use whichever of the following techniques is convenient and works with the current skin:

✦ Right-click the Skin and choose Switch to Full Mode.
✦ Point to buttons until you find one that switches to Full Mode, and click that button.
Press Ctrl+1 (that’s the number 1 up in the number keys — not the letter l).

You can also make Media Player show a large anchor window in the lower-right corner of the screen whenever Media Player is in a skin. You can abandon the skin Media Player is in by clicking the button and choosing Switch to Full View. To show the anchor window and button:

1. From Media Player’s menu bar, choose Tools  Options.
2. In the Options dialog box that opens, click the Player tab.
3. Make sure the Display anchor window when in skin mode option is selected (checked).
4. Click OK.

The anchor will be visible only when Media Player is in a skin.

**Downloading Skins**

The skins that first appear when you choose Skin Chooser are just some samples that come with Media Player 9. You can download other skins from Microsoft Web site. Here’s how:

1. If Media Player is currently in a skin, switch to Full Mode.
2. Click the Skin Chooser button in Media Player’s Features taskbar.
3. Click the More Skins button.

In the Web page that opens, scroll through your options. There are several pages of skins to choose from, so don’t limit yourself to the first page that opens. When you find a skin you like, click it. The standard File Download dialog box with the standard warnings opens. Anything you download from this site is sure to be safe, so you can just click the Open (or Yes) button to proceed. When the download is complete, you can click the Close button if you want to download more skins. If you want to apply the new skin immediately, click the View Now button.

**Using Mini Mode**

In addition to skins, Media Player 9 offers mini mode, where the Play controls rest on your Windows taskbar while the rest of Media Player stays hidden from view. To activate mini mode, follow these steps:

1. Right click an empty area of the Windows taskbar (or the current time in the lower-right corner of your screen) and choose Toolbars, as in Figure 16-19.
2. If the Windows Media Player option doesn’t have a checkmark next to it, click that option. If Windows Media Player is already selected (checked), press Esc to leave the setting unchanged.

The mini mode Play controls will only be visible when Windows Media Player is open but minimized. You can minimize Media Player’s program window as you would any other — by clicking its Minimize button or by clicking its taskbar button until the window disappears from the desktop. Once the window is minimized, you’ll see the play controls in the taskbar, as in Figure 16-19.

![Figure 16-19: Play controls in the Windows taskbar in mini mode](image)

If the taskbar is unlocked, you can move the play controls by dragging the handle just to their left. To get out of mini mode, click the tiny Restore button in the lower-right corner of the Play controls in the taskbar.

If you don’t see any dragging handles on your Windows taskbar, right-click the current time, and choose Lock the Taskbar to clear its checkmark and unlock the taskbar.

Summary

Whew! There’s a load of information about music and videos for ya. Here’s a quick recap of the main issues discussed in this chapter:

✦ Windows Media Player is a program that can play multimedia files (music and video).

✦ Music and video are stored in document files, just like text and pictures. Your My Music folder is specifically designed to store music.

✦ A music CD is the type you buy in a music store and usually play in a stereo.

✦ You can play, copy, and create your own music CDs in Windows Media Player.

✦ You can download music and video from the Internet, using either a pay service like WindowsMedia.com or a Gnutella client like LimeWire.

✦ Skins are an optional feature of Windows Media Player that let you radically change the appearance of the program, just for fun.
Windows Media Player can do more than play music, video, and DVDs. You can use Windows Media Player to build up and maintain a collection of media files. For example, let’s say that you have some favorite CDs you want to protect. You can copy all the songs from those CDs to your computer’s hard disk and then put the original CDs you copy someplace safe, where they won’t be used or damaged.

Then you can play the music directly from your computer. Or you can create your own custom audio CDs and use those for day-to-day play in your home stereo, car, or portable player. If you buy blank CD-R disks in quantities, you can get them for about 25 cents a piece (no big deal if you scratch up or lose one of those). Plus, the CDs you create can contain any combination of songs you like. You don’t have to just make an exact copy of a given CD. You can make party CDs, mellow CDs, or whatever you like.

### Media File Hidden Properties

Before we get to the specifics of building a Media Library, burning CDs, and such, a little background will help make an otherwise confusing experience a little more palatable. The first thing you need to remember is that all media files are document files. Media files stored in MP3, MPEG, WMA, and WMV format all have some Summary properties (also called metadata), which are very useful for cataloging and managing music and video. Some of those summary properties contain media information, such as the artist, title, and genre of a song.
Normally, you don’t see the media information, because the summary properties are rarely displayed on the screen. But every media file of the types mentioned has summary properties. Here’s how you get to them, assuming you’re currently looking at the icon for a media file:

1. Right-click the file’s icon and choose Properties.
2. In the Properties dialog box that opens, click the Summary tab.
3. If the options appear in Simple view, as in the example on the right in Figure 17-1, click the Advanced button to switch to Advanced view, as in the left half of the same figure.

**Figure 17-1:** A media file’s Summary properties in Advanced (left) and Simple (right) views

In the Advanced view of the Summary properties, you can add or change information. Different types of files will have different properties. As far as Windows Media Player is concerned, the main properties that form the media information are as follows:

- **Title:** The title of the song or video contained within the file.
- **Artist:** The musicians who perform the song (audio only).
- **Album:** The title of the album on which the song is published (audio only).
- **Genre:** General category such as Rock, Disco, Jazz, or Classical (for audio).
- **Author:** The person who created the video (video only).

That media information isn’t hidden at all in Media Player. In fact, it’s all in plain view when you’re viewing your Media Library, as in the example shown
in Figure 17-2. Note the column headings Title, Artist, Album, and Genre, each providing media information from a file’s Summary properties.

![Figure 17-2: Column headings in Media Player show media information from media files on a hard disk.](image)

**Tip**

In Windows Explorer, you can use Details view and the Choose Details option to view media information. For more information, see the section “The Details View” in Chapter 5.

As you’ll learn later in this chapter, you can use all that media information to sort, search, group, and categorize all your media files. But before we get to that, we need to talk about where media information comes from.

### Where Media Information Comes From

You might think that media information comes straight from the CD you copied. But it doesn’t really work that way with music CDs. (Again, I’m using the term *music CD* to refer to the type of CD you buy in the music store and play in a regular stereo or CD player.) While the CD certainly contains all the music on the album, the only text on the CD is the artist and album name (often referred to as the CD’s *tag* or *tag information*).

When you first insert a music CD into your computer, Media Player doesn’t know what songs are on the CD. So instead of song titles, it may just show generic names like Track 1 for the first song, Track 2 for the second song, and so forth. However, if you’re online when you insert the CD, and wait a few seconds, the song titles will magically appear, as you saw in Chapter 16.

What causes this bit of magic is a thing called the Compact Disk Data Base (CDDB). This is an enormous database on the Internet that has the name of every song title on just about every CD ever recorded by the music industry. While the CD you inserted doesn’t contain song titles, it does contain just enough information for Media Player to find the CD in the CDDB and display its song titles. (Of course, this can happen only while you’re online, because the database is on the Internet.)
In Figure 17-2, you may have noticed a column titled Media Information, with the word *Found* listed for each song. The word *Found* in this context means that Media Player was able to get the media information for that song from the Internet. If you see Not Found in that column, Media Player was unable to get the information from the CDB.

Media Player might not be able to get media information for a given song or album for several reasons. If you’re not online when you insert a CD, you will certainly prevent media information from appearing. However, it’s also possible that the album just doesn’t exist in the CDB. Or, if you’re working with a single song you downloaded from the Internet, the song might not contain enough information for the CDB to accurately identify it. Also, the Media Player can only update songs stored in .WMA or .MP3 format.

Finally, there are also some settings in Media Player that determine to what extent Media Player can look for information on the CDB, so you need to be aware of those settings and make selections according to what you want done, as described next.

**Getting Media Player to Fill in the Blanks**

If you want Windows Media Player to be able to find media information on the Internet, you might need to make some selections in Media Player’s Options dialog box. Here’s how:

1. If you haven’t already done so, start Windows Media Player. Then choose Tools ➤ Options from Media Player’s menu bar.
2. In the Options dialog box that opens, click the Media Library tab to see the options shown in Figure 17-3.

![Figure 17-3: Media Library tab in Media Player’s Options dialog box](image-url)
As you can see, you have a whole lot of options for grabbing song titles and other media information from the Internet. Here’s what each option offers:

✦ **Monitor Folders**: Lets you choose which folders contain music that should be watched for new media files. By default, Media Player monitors only your My Music folder (which includes all subfolders within My Music). If you want to keep track of new media files, put them in My Music, or click the Monitor Folders button and use the Add button in the dialog box that opens to add more folders.

✦ **Audio files and Video files**: Lets you set a cut-off point for adding files to your Media Library. The default settings of 100 and 500 are sufficient to keep out small sound effects and tiny video clips.

✦ **Automatically add purchased music to my library**: If selected, this option ensures that if you purchase and download music online from a Web site, the purchased songs will automatically be added to your media collection in Media Library.

✦ **Delete item from your computer when deleted from Media Library**: As a rule, you want to leave this unselected. If you select this, deleting items from your Media Library will also delete the corresponding media file from your hard disk.

✦ **Update my music files (WMA and MP3)**: This item must be selected if you want Media Player to be able to find media information for songs. Once you select it, you can choose from the following options to determine how and when media information is updated using the options here.

  • **Only add missing information**: If selected, Media Player will fill in blank media information only; it will not change existing media information. Use this option if you manually change media information and don’t want Media Player to replace your manual changes.

  • **Overwrite existing information**: Choose this option if you’re willing to allow Media Player to fill in missing information and also to replace existing information. If you don’t want Media Player to change information you’ve manually entered into a song’s properties, clear this option.

  • **Find media information for music copied with another program**: If you select this option, Media Player will update songs that you copy with programs other than Windows Media Player.

  • **Rename and rearrange music using media information**: If selected, this option ensures that any song whose media information is changed will cause Media Player to rename and re categorize the song accordingly.

If in doubt about how to choose settings in the dialog box, just go with the default settings shown in Figure 17-3. Choosing those options alone isn’t sufficient to guarantee you’ll get all the benefits of the CDDB. You also have to adjust your Media Player privacy and security settings as described next.
Media Player Privacy Settings

Clicking the Privacy tab in Media Player’s Options dialog box reveals some options that determine how much information Media Player transmits across the Internet. If you want Media Player to be able to get media information online, you must select the first three options, as shown in Figure 17-4. Other settings on that tab aren’t as critical. For detailed information on privacy settings, click the 

Click here for more information about privacy

link near the top of the dialog box.

![Figure 17-4: Privacy tab in Media Player’s Options dialog box](image)

After making your selections in the Options dialog box, click its OK button. You don’t need to go through that rigmarole every time you want to copy CDs. Just once is sufficient.

Copying Music CDs to Your Media Library

A good source for music for your Media Library is the CDs you already own, as well as any you purchase in the future. If you record at the highest quality, you can store about 200 songs per gigabyte. Dollar-wise, a gigabyte is about $1.50 worth of hard-disk space. How much hard-disk space you’re willing to use for music is entirely up to you. But given how inexpensive hard-disk space is these days, even using 10GB to store 2,000 songs is no big deal.

If you don’t know how much hard-disk space you have available, open My Computer, right click the icon for your hard drive (C:\), and choose Properties. See the section “Discovering How Much Hard Disk Space You Have” in Chapter 20 for more information.

It’s not really possible to run out of disk space. No matter how much you use, you can always add more. For example, you can probably get an 80GB drive for about a hundred bucks. And that drive has enough room to store about 16,000 high-quality songs.
If you just want to copy a music CD to a blank CD, it’s not necessary to use Windows Media Player. You use Windows Media Library only when you want to create a collection of digital media on your computer’s hard disk (see Chapter 16).

Preparing to Copy Music

Before you haul off and rip a CD (nerd slang for copy the contents of a CD to your hard disk), you’ll want to choose some options by following these steps:

1. If Windows Media Player isn’t open, go ahead and open it.
2. Choose Tools ➪ Options from Media Player’s menu bar.
3. In the Options dialog box that opens, click the Copy Music tab to see the options shown in Figure 17-5.
4. Make your selections in the dialog box, using the sections that follow as your guide; click OK.

![Figure 17-5: The Copy Music tab in Media Player’s Options dialog box](image)

Choosing a Location and Name for Songs

By default, all songs you copy from CD will be placed in your My Documents folder. If you want to change that, click the Change button and navigate to the folder you want to use. For example, if several people have user accounts on this computer, you might want to use Shared Music instead. That way, everyone will be able to play the music from his or her user account or computer.
To choose your Shared Music folder, click the Change button; then click My Computer ➪ Shared Documents ➪ Shared Music. Click the OK button in the Browse For Folder dialog box. The folder name will likely be something like C:\Documents and Settings\All Users\Documents\My Music (because the All Users folder in Documents and Settings is where all shared documents reside).

If you do change the folder, and want to make sure the files’ media information is updated automatically, make sure you add the folder you selected to the monitored folders on the Media Library tab, as discussed under “Getting Media Player to Fill in the Blanks,” earlier in this chapter.

By default, files you copy from music CDs will be named using just the track number and song title. For example, if the first song is titled *Smooth*, its file name will be *01 Smooth* on your hard disk. To change that, click the File Name button to open the File Name Options. You’ll see a list of media information *details* such as Song title, Artist, and Album, which you can use to define the file name of each song you copy.

You can use any combination of the details listed to form each song’s file name. Use the Separator option to choose a character to separate portions of names. To change the order of details, click any name to select it. Then click the Move Up or Move Down button to move it within the list.

For example, let’s say you want to name each song in the format *song title-artist-album*. For example, if you copy the song titled *Smooth* from Santana’s Supernatural album, its file name on your hard disk will be *Smooth-Santana-Supernatural*. To meet that goal, select only the details you want to include in the file name. Then put them in the order you want them to appear, and choose – (Dash) as the separator, as in Figure 17-6. Click OK after making your selections.
Choosing a File Format

Under Copy Settings on the Copy Music tab, the Format drop-down list lets you choose which format you prefer to use among the following:

✦ **Windows Media Audio**: Songs are copied to Windows Media Audio (.wma) format files and compressed to conserve disk space. You can choose the amount of compression using the Audio Quality slider in the same dialog box.

✦ **Windows Media Audio (variable bit rate)**: Same as the preceding format, but the amount of compression varies with the complexity of the information being stored. However, the usual result is a better-quality recording and smaller file.

✦ **Windows Media Audio Lossless**: Same as the preceding format, but files are not compressed at all. The copied file’s audio quality is the same as that on the original CD. The files are also huge. Files in this format are not widely supported and are generally used only by audiophiles and professionals. Files in this format can also be used to create HighMAT CDs (High-Performance Media Access Technology) See [www.HighMAT.com](http://www.HighMAT.com) for more information.

Rippin’ MP3s

If you’re an MP3 fan and want to use Media Player to copy music CDs to MP3 format, rather than WMA format, you’ll need to purchase and install an MP3 Creation Pack. To get to some products, choose Tools ➪ Plug-ins ➪ Download Plug-ins. After you’ve completed the purchase and installation, you’ll see MP3 as an option in the Format drop-down list, as in the example shown here:

![Screen capture of Media Player with MP3 format selected](image)

There are a few stereos and CD players that can play MP3 files directly. The advantage of this approach is that rather than putting 80 minutes of music on a CD, you can put nearly 12 hours of music on one CD! To create an MP3-CD, you don’t use Windows Media Player at all. Instead, you just gather a bunch of MP3 songs and copy them directly to a CD-R using the standard CD-copying techniques described in Chapter 20.

If you already have a bunch of WMA files copied to your hard disk and want to convert them to MP3 format, you’ll need some file-conversion software. For examples of conversion software you can purchase, see [www.wma-mp3.com](http://www.wma-mp3.com).
Copy Protect Music

If you choose this option, you’ll be able to play only copied music on the current computer. If you copy the song to another computer or try to play it on another computer, it won’t play. This can be a big disadvantage if you have more than one computer. The purpose of the option, though, is to protect you from accidentally breaking any laws by sharing copyrighted music.

Not that it’s easy to share copyrighted music. It’s not like anyone can just come off the Internet and help themselves to your files. To share music on the Internet, you need to jump through quite a few hoops. So if you’re not worried about accidentally sharing copyrighted material over the Internet, you can leave this option turned off.

Copy CD when Inserted

If selected, this option tells Windows Media Player, “As soon as you see a music CD in the CD drive, just start copying it.” You can use this to copy several CDs in rapid succession. If you turn on the Eject... option described next, it’ll be like factory work. You insert a CD, wait for it to eject, put in the next CD, wait for it to eject, and so on, for as long as you can stand it. (Of course, you can use your computer for other things during that time, though I wouldn’t recommend actually playing any CDs while copying them, as that might give Media Player too much to do and slow things down.)

Eject CD when Copying Is Completed

If selected, this tells Media Player to eject the CD from the drive when it’s finished copying. If you’re near the computer when that happens, you can hear it. So you’ll know as soon as the CD is ready.

Audio Quality

The Audio Quality slider lets you fine-tune the format you selected from the drop-down list (unless you chose the Lossless quality, in which case no compression is allowed). The basic rule is that the higher the quality, the larger the file. I always go for the highest quality, as shown in Figure 17-5. I figure that hard-disk space is too inexpensive to quibble over a few megabytes. I’ll treat my ears to the best. (Not Lossless though, as that’s a difficult format to work with.) Feel free to choose whatever quality you want.

Tip

If you need more exact specifications on music qualities and disk usage, click the Help button in the Options dialog box. In the Contents tab of the Help window that opens, expand the books Using the Player, Copying Music from CDs, and click the book titled Compressing copies of CD tracks to use less disk space. If you need to widen the Contents pane, drag the bar that separates it from the main pane to the right.

Digital or Analog?

Some CD drives and sound cards let you copy and create digital music CDs, while others support only analog. What your particular computer offers depends on your computers CD drive, sound card, and a couple of little cables.
that connect the two inside your computer. Quality-wise, it really doesn’t seem to matter much if you use digital or analog; it’ll probably sound the same either way. But if you at least want to know what your options are, follow these steps:

1. If you’re still in Media Player’s Options dialog box, click the Devices tab. Otherwise, choose Tools ▶ Options from Media Player’s menu bar; then click the Devices tab.

2. Click the icon that represents the CD drive you use to copy music; then click the Properties button. The Properties dialog box for that drive opens, as in the example shown in Figure 17-7.

3. To copy in Digital, select Digital under the Copy option. You can also choose Error Correction, which allows Media Player to correct any flaws in the CDs (such as crackles and pops caused by scratches) to be corrected.

4. Click OK after making your selections.

All the settings we’ve described up to now need only be set once. They will then be applied to all CDs you copy in the future. Just make sure you click OK in any open dialog boxes to save your settings and close the dialog boxes before copying your first CD.

**Copying a Music CD**

With all your settings in place, you’re ready to start copying music CDs to your hard disk. The procedure is pretty straightforward:

1. If you have a dial-up modem, make sure you’re online (so Media Player can get media information from the Internet).

2. Insert the CD you want to copy into your CD drive.

3. If you see a message asking what you want to do with the CD, you have two choices. If you want to start copying right away, click *Copy music from CD using Windows Media Player*; then click OK. If you want
a moment to choose specific songs to play, click *Play CD in Windows Media Player*; then click OK. If nothing happens after you insert the CD, start Windows Media Player yourself from the All Programs menu or Quick Launch toolbar.

**Note** If some program other than Windows Media Player opens in Step 3, close that program and start Windows Media Player from your All Programs menu.

4. If you disabled copy protection, you’ll see a dialog box asking if you want to reconsider. Make your selections and click the Next> or Finish> button as appropriate.

5. In Windows Media Player’s features taskbar, click Copy From CD.

6. If songs from the CD don’t show up, use the Playlist drop-down list to choose your CD drive as shown in Figure 17-8.

![Figure 17-8: Choose your CD drive from the Playlist drop-down list.](image)

7. If song titles don’t appear right away, wait a few seconds. It can take a while with a dial-up account.

**Tip** If the wrong titles appear, or no titles appear, you can click Find Album Info in the toolbar above the column headings. A wizard will open to help you find the correct song titles. Be aware, though, that the CDDB doesn’t contain information for every CD created, just for most of them. If you want to change any media information before copying, use the techniques described under “Editing Media Information in Media Library,” later in this chapter, to make your changes.

8. If you can hear the music playing, click the Stop button in the Play controls before copying. The CD will copy faster and more reliably if the drive doesn’t have to worry about playing at normal speed while trying to copy at a higher speed.
9. Make sure that all songs you want to copy have a checkmark next to them, as in Figure 17-9. Clear the checkmark for any songs you don’t want to copy.

![Figure 17-9: Ready-to-copy songs from a music CD](image)

10. Click the Copy Music button in the toolbar, and wait.

As each song is being copied, the Copy Status column will keep you apprised of progress. When all songs show *Copied to Library* in the Copy Status column, the CD has been copied. If you set up Media Player to eject automatically, the CD will eject, and the main pane in Windows Media Player will go blank. Otherwise, you can eject the CD yourself. You won’t need to play the original CD anymore. Keep it as a pristine backup in case you ever accidentally lose the copy that’s now on your hard disk.

**Finding Copied Songs**

You’ll find the songs you copied from a CD in two places:

- In your My Music folder (or whatever folder you chose as the location for copied media), as discussed in the section “Using Your My Music Folder” in Chapter 16.
- In Windows Media Player’s Media Library, which we’ll discuss next.

You may want to copy several CDs before you start exploring Media Library, as it’s a little easier to understand why it’s valuable once you get a real collection of songs started. When you find a song, you can just double-click it to play it. There’s no need to put the original CD back in the drive.
Using Your Media Library

The Media Library button in Media Player’s features taskbar takes you to your collection of songs. The examples you’ll see here are from my own collection of nearly 5,000 songs. It’ll take a while to make your own media collection that large. But you can better appreciate Media Library’s value when there are lots of songs to manage. So I’ll use that large collection as an example.

Keeping Your Media Library Up-to-Date

Songs you copy from CD using Windows Media Player are added to your Media Library automatically. But songs you download from file-sharing networks (like Gnutella) and songs you copy using other means aren’t necessarily added to Media Library by default. To ensure that Media Library contains all the media currently on your hard disk, follow these steps:

1. If you haven’t already done so, open Windows Media Player.
2. Choose Tools ➪ Search for Media Files from Media Player’s menu bar. The Add to Media Library . . . dialog box shown in Figure 17-10 opens.
3. Make your selections from the dialog box; then click OK. If you want to search your entire hard disk for media files, use the selections shown in Figure 17-10.
4. Wait for the search to complete; then click the Close button.

Now when you view your Media Library, as discussed next, it should include all the media files from your hard disk.
Managing Your Media Collection

Whenever you want to work with your media collection, click the Media Library button in Media Player’s features taskbar. The screen will split into two panes, with categories on the left and individual songs on the right. The songs that appear in the right pane depend on the category you click. For example, if you click All Music, the right pane lists every song in your collection.

When All Music is selected in the left pane, you can sort songs by Title, Artist, Genre, Album, or any other column heading. Just click the appropriate column heading once to sort into ascending order (A-Z or smallest to largest). You can also drag column headings left and right to arrange the columns to your liking.

Tip
To widen or narrow the panes, drag the narrow bar that separates the two panes to the left or right.

Cross-Reference
See the section “Working with Columns” in Chapter 5 for more information on moving, sizing, and arranging items with columns.

When you click the + sign next to the All Music category name, the Artist, Album, and Genre categories appear. When you click the + sign next to one of those, all artists, albums, or genre will be listed. From there, choose any subcategory of songs to work with. For example, in Figure 17-11, I click Al DiMeola under Artists. So now the right pane shows all songs by Al DiMeola.

Figure 17-11: Media Library with Al DiMeola selected in the left pane

Clicking the + sign next to Al DiMeola in Figure 17-11 displays all albums for that artist. So if, for example, you want to see songs only from the Casino album in the right pane, click that album title.

It works the same way for the Album and Genre categories. For example, if you click the + sign next to album, you’ll see a list of all the albums you created.
Clicking an album name shows all songs on that album. Clicking the + sign next to Genre shows all genres in your collection. To see all songs in a given genre, click a genre name. For example, in Figure 17-12, I expand the Genre list and click Disco, so now the right pane includes all songs in the Disco category.

![Figure 17-12: Now showing all songs from the Disco genre](image)

If you want to play an entire category of songs, just right-click the category name and choose Play. To watch a visualization of the music, click the Now Playing tab.

### Editing Media Information in Media Library

There’s no guarantee that Media Player will be able to find media information for every song you copy or download to your PC. Sometimes you just have to go in there and manually type the correct information. But that’s easy to do. When you see something incorrect in Media Library, just right-click the incorrect information, choose Edit, type the correct information, and press Enter.

In Media Library, the Media Info column shows *Found* for songs that got their media information from the Internet and *Not Found* for songs that weren’t found on the Internet.

If you want to make the same change to several songs, it’s not necessary to do them one at a time. To make the same change to several song titles, click the first song title in the list. Then press Shift+End, or hold down the Shift key and click the last item in the list, so all the titles are selected as in Figure 17-13. Optionally, you can click the first song you want to change; then hold down the Ctrl key as you click other songs for which you want to make the same change.
Once you’ve selected all the songs you want to change, right-click within the appropriate column for any selected song and choose Edit. For example, to assign all selected songs the same Artist name, right-click the Artist column for any selected song and choose Edit. Type the correct information and press Enter. You may see a dialog telling you that the change will be made to all the selected songs. Just click Yes, and all the selected songs will receive the same change.

As opposed to right-clicking and choosing Edit, you can right-click and choose Advanced Tag Editor. That will take you to a dialog box where you can enter lots of media information for the selected song(s). You can also right-click and choose Find Album Information to try to look up the album yourself online.

Creating Custom Playlists

Custom playlists are a great way to organize your music by mood or style or favorite artist or whatever tickles your fancy. You can create playlists of any length to play on your computer. For example, you can put 12 hours or more worth of music into a single playlist and just let it play all day long.

Playlists are also a great way to create custom audio CDs. Choose any combination of songs up to 74 or 80 minutes in length (depending on which type of CD you plan to burn to), and just copy the playlist to a CD. You can then play that CD in any stereo or CD player.
Creating a custom playlist is pretty easy. First, follow these steps to create a new, blank playlist:

1. In Windows Media Player, click the Media Library button in the features taskbar.

2. From the toolbar near the top of the window, click Playlist and choose New Playlist, as in Figure 17-14.

3. In the dialog box that opens, replace New Playlist with whatever you want to name this playlist. (I’m going to create a playlist named Party Animals CD for this example.)

4. Click OK.

To see your new playlist name, click the + sign next to My Playlists in Media Library’s left pane. When you click the playlist name, its contents appear in the right pane. Initially, a new playlist will be empty.

To add songs to your playlist, go back up to your Artist, Title, and Genre categories, and click any name that will get you to the songs you want to use. For example, for the Party Animals CD, I might start off by clicking the Disco genre to see what crazy songs I can get from there.

To add songs to a playlist through a dialog box rather than Media Library, right-click your playlist’s name in the left column and choose Edit.

When you get to a song you want to add to your playlist, right-click its title in the main pane and choose Add to Playlist. In the dialog box that opens, click the playlist to which you want to add the song; then click OK.

If the purpose of this playlist is to burn a custom audio CD, you’ll want to get about 73 to 79 minutes worth of music into your playlist, so as not to add more than the CD can handle. To see how your playlist is progressing, and how many minutes of music you’ve added, click the playlist name under My Playlists, as in the example shown in Figure 17-15. The contents of the playlist appear in the right pane, as well as the total minutes of music in the list, as in Figure 17-15.
An hour is 60 minutes (duh). So 1:14.38 is 60 minutes plus 14.38 minutes, or 74.38 minutes (a bit too much for a 74-minute CD, but an easy fit on an 80-minute CD).

To arrange songs in your playlist, just drag them up and down the list. That is, point to any song title and hold down the left mouse button while moving the mouse pointer up or down the list. Release the mouse button to drop the song back into the list at the current location.

**Creating Playlists Automatically**

The preceding technique is just one way to create a playlist. You can also create playlists automatically by specifying *criteria* that define songs that need to be added to the playlist. The criterion could be a specific genre, artist, or whatever. You can even mix and match criteria. Here’s how you create an Auto Playlist:

1. In Windows Media Player, click the Media Library in the features taskbar.
2. In the toolbar near the top of the window, click the Playlists button; then choose New ➪ New Auto Playlist.
3. In the *Auto Playlist name* box, type a name for this playlist.
4. Click the first + sign; then choose a criterion, such as Artist, Genre, or whatever.
5. Click right next to the new entry (where it says “click to set”).
6. Repeat Steps 4-5 to add multiple criteria.
7. Optionally, you can choose options next to the last two + signs to further restrict or expand the criteria. In Figure 17-16, I’ve specified criteria for a new Auto Playlist named Good Dance Music, which will contain songs from the Dance genre that are at least 128 K.

![Figure 17-16: Defining a new Auto Playlist named Good Dance Music](image)

8. Click the OK button.

Windows Media Player will create the playlist, highlighting its name in the left column, along with umpteen sample auto playlists. Don’t let all the sample Auto Playlists intimidate you. They’re just examples. Many of them will be empty, because they don’t really specify any criteria. If you want to make one of the sample Auto Playlists more useful, you can right-click its name and choose Edit. Then change the criteria for that playlist and click OK.

To get rid of a sample Auto Playlist, right-click it and choose Delete. If a dialog box opens asking what you want to do, choose *Delete from Media Library only* in the dialog box that opens (if one does) and click OK.

If you’re already playing songs in a playlist, you can temporarily add a song to that playlist while it’s playing. As you’re navigating around in Media Library looking at songs, just right-click any song title and choose Queue-It-Up. When you go back to Now Playing, you’ll see any song(s) you’ve added at the bottom of the playlist on the right side of the Now Playing window.

### Creating a Custom Audio CD

Before you create a custom audio CD, make sure you understand the difference between different media types. This topic is discussed in some detail in Chapter 20. But as far as creating CDs to play is concerned, you need to be aware that there are three different types of blank CDs to which you can write data:

- **Audio CD-R (80 minutes):** Store up to 80 minutes of music on a single CD that can be played on any computer or stereo.
Data CD-RW (74 minutes): Store up to 74 minutes of music on a single CD that can be played on any computer or stereo.

CD-RW: Can be played only on computers with CD-RW drives and on the rare stereo that has the ability to read this type of CD. (Very few stereos can read CD-RW disks!)

For maximum flexibility, you’ll want to stick with CD-R disks. Be aware that CD-R’s are WORM (Write Once, Read Many), which means that as soon as you burn anything to that disk, even if it’s just one song, that’s it. You cannot add songs later or change the contents of the CD in any way. You can’t unburn a log, and you can’t unburn a CD-R either! So make sure you gather up 70 to 80 minutes of songs to copy before you even begin the process. Making a custom playlist first, as described previously, is a good way to approach the process.

STEPS: Create a Custom CD from a Playlist

1. Insert a blank CD-R into your CD drive, and wait a few seconds.

2. If you see a dialog box asking what you want to do with the blank CD, choose Select media to Copy to CD using Windows Media Player, and click OK. Then skip to Step 4.

   Caution: Not all CD drives can burn CD-Rs. If you have any problems burning CDs, first make sure you have a CD-R drive installed on your computer!

3. If Windows Media Player isn’t already open, go ahead and open it now. Click Copy to CD or Device in the features taskbar.

4. Click the drop-down list under Items to copy in the left pane, and click the playlist you want to copy to CD, as in Figure 17-17.

   Figure 17-17: Choosing a playlist to copy to CD
5. Make sure that each song you want to copy has a checkmark next to it. If necessary, scroll through the list to make sure all items will fit. When you see Ready to Copy in the Status column, the song is ready to go. If you see Will not fit, you can clear the checkmarks from any song you wish to remove from the list.

6. Make sure that Items on the preceding Device drop-down list in the right pane shows the drive you’re about to copy to (D: in Figure 17-18). Assuming it’s a blank CD, you’ll see There are no items on the CD or device, because it’s blank.

7. Click the Copy button near the upper-right corner of Media Player and wait.

As the songs are being copied, you’ll see each go through a three-step process, where each song is inspected, converted (to .CDA format, which is required on all music CDs), and finally copied. When the Status column shows Complete for every song in your playlist, you’re done. You can remove the CD from its drive and play it in any computer, stereo, or CD player.

Copying Music to Portable Players

The technique you use to copy songs to blank CDs will also work for copying songs to portable music devices (commonly referred to as MP3 players). These are tiny, diskless stereos you can wear on your arm or attach to a belt. Joggers swear by them because no matter how much you jump around, the music won’t skip. That’s because there’s no CD or moving parts in the player.
Exactly how much music you can store in a portable player depends on your player. You’ll be able to get that information only from the instructions that came with your player. You’ll no doubt get software and instructions for copying music to the player as well.

With an XP-compatible portable player, you can use Windows Media Player to copy songs to the device. Just connect the device to your computer as per the device manufacturer’s instructions. In Windows Media Player, go through the same steps you would when burning a CD. But rather than choosing your CD drive under Items on Device in the left column, choose your portable player, as in Figure 17-19.

![Figure 17-19: First step in copying music to a portable player](image)

If there are already songs on the player that you need to erase, you can use the delete button (X) to delete them. If you want to delete them all, select them all first. To do so, click any song in the list; then press Ctrl+A. Click the Delete (X) button in the toolbar.

The rest is the same as copying to a CD. That is, choose your playlist under Items to Copy in the left pane. Then click the Copy button in the toolbar to copy the songs to the player. Make sure all the songs will fit, and clear the checkmarks next to any that won’t. Then click the Copy button.

To see a list of XP-compatible portable players, go to [www.WindowsUpdate.com](http://www.WindowsUpdate.com). On the page that opens, click the Hardware tab. Then, in the left column, click Sound ➔ Portable Media Players. You won’t see much in the way of pictures. But if you print the list, you’ll be able to take it to the store with you to make sure you buy a product that works with Windows Media Player.

### Copying Vinyl LPs

There’s nothing built into Windows Media Player to help you copy from vinyl LPs. You can use Windows Movie Maker to copy those, but it’s not the easiest approach in the world, because Windows Movie Maker really wasn’t designed for that task. If you have lots of LPs to copy, it might be worth it to spend $20
or so to get a program that does it right. Two products you might want to look into are:

✦ **Microsoft Plus! Digital Media Edition**: Available wherever software is sold, this product adds several capabilities to Windows XP, including special tools for copying LPs.

✦ **PolderbitS Sound Recorder**: A favorite among music buffs, download and try this one for free (two-week trial period) from [www.PolderbitS.com](http://www.PolderbitS.com).

**More on Media Player 9**

If this book were a couple thousand pages, I could go on and on about Media Player 9 here. But alas, this isn’t a book about Windows Media Player 9 per se. It’s a book about Windows XP, and there are lots of other things that I need to cover. But there are plenty of resources available to you for learning more about Windows Media Player, including:

✦ **Media Player’s Help**: Choose Help ➤ Help Topics from Media Player’s menu bar. Click the Contents tab; then click any + sign to expand a category or - sign to shrink a category. Click any book or page to see help on that topic in the right pane. To size the two panes, drag the bar that separates them left or right.

✦ **Media Player Web Site**: Choose Help ➤ Getting Started from Media Player’s Web site, or go to [http://windowsmedia.com/9series](http://windowsmedia.com/9series) using your Web browser.

**Summary**

When it comes to playing music, there’s a whole heckuva lot you can do with Windows Media Player. Here’s a quick recap of the most important points from this chapter:

✦ Music files in WMA and MP3 format contains hidden *media information*, which Media Player uses to organize and categorize songs.

✦ Media information is rarely stored on music CDs. That information usually comes from the Internet.

✦ The Media Library feature in Windows Media Player provides access to all music on your computer’s hard disk, organized by artist, album, and genre.

✦ To build up your collection of songs, copy music CDs to your hard disk using Windows Media Player.

✦ You can create custom playlists from your media collection and copy those playlists to blank CDs and portable MP3 players.
Making Home Movies

Every movie or TV show you’ve ever seen is a collection of scenes organized into a story. Windows Movie Maker is a program that lets you create professional-grade videos in a similar manner — by combining your favorite scenes from home movies or even video you download from the Web. Your movie can contain full audio, additional background music, narration, and a number of special effects to add a creative touch to your production. You get to be cameraman, director, and producer all wrapped into one.

The movies you create are stored in Windows Movie (.wmv extension) files. Just about anybody who has a Windows PC will be able to play them. If you have the right equipment, you can also copy your movies to video tape, DVD, and CD.

Introducing Windows Movie Maker 2

Windows XP originally shipped with a program named Windows Movie Maker, which has since been updated to Windows Movie Maker 2. I’ll be writing about Windows Movie Maker 2 in this chapter. So let’s make sure that you’re using that program. Here’s how:

1. Click the Start button and choose All Programs ➪ Windows Movie Maker.

Gotcha

If you don’t see Windows Movie Maker on the All Programs menu, point to Accessories to see whether it’s on that submenu. If not, point to Entertainment and see whether it’s on that submenu.

In This Chapter

Introducing Windows Movie Maker 2
Getting content for your movie
Creating the movie
Creating the final movie
Managing collections
2. From the menu bar in Windows Movie Maker, choose Help ➪ About Windows Movie Maker. Then take a look at the About Windows Movie Maker dialog box that opens and:

- If you’re using Version 1, as shown at the left of Figure 18-1, click OK and go to the section titled “Upgrading to Movie Maker 2” later in this chapter.

- If you’re already using Movie Maker 2, as on the right side of Figure 18-1, click OK and go to the section titled “Taking Control of Movie Maker 2,” later in this chapter.

![Figure 18-1: The About dialog box for the original Movie Maker (left) and Movie Maker 2 (right)](image)

If you see a message indicating that your screen resolution is set to 800x600 or lower, you’ll probably want to increase that resolution to 1024x768. See Chapter 24 for the steps.

**Upgrading to Movie Maker 2**

If you’re reading here, you’ve started Windows Movie Maker, discovered you have Version 1, and have clicked OK to close the About . . . dialog box. Upgrading to Version 2 will get you a lot of cool stuff, and it won’t cost you a penny, just a little time to download and install the program. To get to the download Web page, choose Help ➪ Windows Movie Maker on the Web from Movie Maker’s menu bar. Or use your Web browser to go to [www.microsoft.com/windowsxp/MovieMaker](http://www.microsoft.com/windowsxp/MovieMaker).

On Movie Maker’s home page, look around for, and click, *Windows Movie Maker 2 Download*. You’ll be taken to a page that describes Movie Maker 2. As you scroll down the page, you’ll come to the Download Instructions. Or under Download at the right side of that page, choose your language and click the Go button. When the File Download dialog box opens, click its Open button; then follow the instructions on the screen.
Taking Control of Movie Maker 2

Producing a movie is very much a step-by-step process. More accurately, it is a task-by-task project. For example, the first task is to get some video to work with. Then the video needs to be organized into scenes (clips). You need to be able to watch clips, edit out junk you don’t want, and maybe add narration or background music. Then the scenes need to be arranged into a movie and so on. To provide all the tools you need for every task, Movie Maker provides several different panes of information.

Like most program windows, Movie Maker 2 has its own title bar, menu bar, and toolbar at the top, as well as its own taskbar button. So you can move and size its window like any other. There’s a limit, however, to how small you can make the window.

Windows Movie Maker Panes

When the Movie Tasks pane is open in Movie Maker, the program might look something like the example shown in Figure 18-2. The panes pointed out in that figure are described in the following sections.

Figure 18-2: Windows Movie Maker 2, with its Movie Tasks pane open
Movie Tasks Pane
Options in the Movie Tasks pane provide quick access to all the tools and dialog boxes you need to make a movie. To show or hide the task pane, click the Tasks button in the toolbar, or choose View Tasks from Movie Maker’s menu bar.

When the Movie Tasks pane is open, it shows a list of numbered tasks, such as Capture Video, Edit Movie, and so forth. They allow you to step through the process of producing your movie in a task-by-task manner. You can click any of those headings to show or hide tasks beneath the heading. Use the scroll bar at the right edge of the pane, when visible, to scroll up and down through the list. To get started with a task, just click the task name.

To hide the Movie Tasks pane, click the Close (X) button near its upper-right corner.

Storyboard/Timeline
The Storyboard/Timeline, also called the work area, is where you create your movie. I like to think of it as the creative area rather than the work area, because this is about having fun and making things. But anyway, as you’ll learn later, you create a movie by dragging clips (scenes) from the Contents pane into the work area, arranging them into whatever order you need to present a story or present a coherent movie.

The Storyboard/Timeline is where you create your movie. You’ll be able to add background music, special effects, and narration to the Storyboard/Timeline as well. I’ll get to the details of it all in a moment. For now, look at other major components of Movie Maker.

Collections Pane
A Movie Maker collection is like a folder, in that it’s a container in which you store things. But you don’t store files in a collection. You store video clips. You can also edit the clips there, doing things such as getting rid of junk you don’t want in your movies and compiling small clips into individual panes.

The Collections pane, shown in Figure 18-3, shows you all your collections at once, so you don’t have to use the Collections drop-down list to see their names. To make the Collections pane visible, click the Collections button in the toolbar, or choose View Collections from Movie Maker’s menu bar. Once the Collections pane is open, you can drag its right border left or right to size it.

Contents Pane
The contents pane, also shown in Figure 18-3, shows the contents of whatever collection is currently selected in the Collections pane or the Collections drop-down list. For example, in Figure 18-3, I’ve selected the Video Transitions collection in the Collections pane and the Collections drop-down list in the Collections pane. Each of the large icons in the Contents pane represents one transition from the Video Transitions collection.
The Contents pane in Figure 18-3 shows its icons in Thumbnails view. If you prefer, you can show those icons in Details view, where only textual information about each item appears. Use the Views button on the toolbar to choose Details or Thumbnails view for the Contents pane. Use the Arrange Icons By on the Views button to change the order of icons in the Contents pane.

Monitor

The monitor is where you can watch clips, transitions, or your entire movie so far as a work in progress. The first frame of the currently selected clip (if any) appears in the Monitor. To select a clip, click its name in the Contents pane. Once you’ve selected a clip, you use the Play controls shown in Figure 18-4 and summarized as follows to watch the clip, split it, or to take a snapshot of the current frame:

Tip

The Video Transitions and Effects are really just special effects, not pictures. When you play a transition, you see it played out on generic photos. But when you actually use a transition in your movie, those generic pictures aren’t included.
Figure 18-4: The Play controls in Movie Maker 2

- **Name of this clip**: Shows the name of the clip you’re currently viewing in the monitor. Matches the name of the clip selected in the Contents pane.

- **Full screen**: Expands the monitor to full-screen while a clip is playing. Click anywhere on the full-screen view to return to Movie Maker.

- **Seek bar**: The handle moves along this bar as the clip is playing. You can drag that handle to the left or right to zoom to a particular spot in the video. This works best if you click Play, then Pause, then drag the handle while the clip is paused.

- **Play/Pause**: When the clip is paused or not playing, click this button to play the clip. When the clip is playing, click this button to pause it at the current position without rewinding.

- **Stop**: While the clip is playing, you can click this button to stop playback and rewind the clip to the beginning.

- **Previous frame**: When the clip is paused, click this button to move one frame at a time to the left.

A video is actually a collection of still images, in the same way that movie film is a series of tiny pictures. Each picture in the video is a frame.
✦ **Next frame:** When the clip is paused, click this button to move one frame at a time to the right.
✦ **Fast Forward:** Moves the seek bar to the end of the clip.
✦ **Split:** When a clip is paused, click this button to break it into two clips at the current frame.
✦ **Take photo:** When a clip is paused, click this button to copy the current frame to a still photograph.

You’ll have plenty of chances to try out the tools as we progress through this chapter. But before you can make a movie, you really need to have some content (video, pictures, or music) to work with.

## Getting Content for Your Movie

Before you can really start making movies, you need some content to work with. That content can be video from your home camcorder or from the Internet. It can include still photos you might want to add to a movie, as well as any songs you want to use as background music or theme music.

## Getting Video from Your Camcorder

To get video from a videotape into your computer, you don’t import the video. Rather, you **capture** it. This means that you connect a digital camera, VCR, TV, or even stereo to your computer and play the video or music you want to capture. While it’s playing, Movie Maker will capture it — that is, Movie Maker will copy all the sound and video playing into a file on your hard disk. You then work with the file on the hard disk.

### Connecting the Camera

The first step to capturing content is to get the device connected to the computer. How you do this depends on what kinds of plugs are available on the device and what kinds of plugs are available on your computer. There are four main types of connections used for this sort of thing, shown in Figure 18.5.

![Figure 18-5: Four common plug types for connecting computers and cameras](image)
Stereo devices have two Audio Out plugs: one for the left speaker (L) and one for the right (R). Mono devices have only a single Audio Out plug.

USB: Provides high-speed plug-and-play connections between just about any device and a computer. Some, but not all, newer video cameras have USB ports. You need a USB cable that can connect the USB port on the camera to the USB port on the computer. You don’t need to connect anything except the one USB cable. (The USB plug on the camera may be smaller than the plug on the computer.)

IEEE 1394 (FireWire): Provides a high-speed connection between a digital video camera and the computer. Not many video cameras, or computers, have FireWire ports. If your camera has a FireWire port but your computer doesn’t, you can add a FireWire port to the computer. You don’t need to connect anything except the FireWire cable. (The FireWire plug on the camera may be smaller than the FireWire plug on the computer.)

RCA Jacks: These are available on just about every video camera, TV, VCR, and stereo. Computers rarely have matching jacks. But you can purchase hardware that can act as a bridge to the computer, as illustrated in Figure 18-6.

A/V (Composite video): Some video cameras may have a single A/V or A/V Out plug instead of separate Video and Audio jacks. As with RCA jacks, you can usually connect an AV/Out port to a device that acts as a bridge to the computer.

The two best resources available to you for specifics on connecting your video camera to your computer are the printed manuals that came with each of those devices. I can talk only in generalities here, because there are hundreds of different makes and models of computers and video cameras!

If your computer and camera both have FireWire ports or USB ports, it’s a simple connection. You just need one cable to connect the two plugs on each end to the two devices. For example, connect the USB port on the camera straight to the USB port on the computer, and forget about any other plugs. Do likewise for FireWire. You need only to connect the FireWire port on the camera to the FireWire port on the computer. Ignore all other plugs.

If your camera has only RCA and/or A/V ports, and you don’t have matching ports on your computer, you can buy a device that acts as a bridge between the camera and computer. Dazzle (www.dazzle.com) makes a several products along these lines. Their DVC 80 and DVC 150 products have RCA Video and Audio In jacks and also an S-Video In jack, on one side. You connect your camera to those. On the other side of the bridge, there’s a simple USB port that connects to the USB port on your computer.
The Dazzle DVC 80 has a standard USB 1.0 port. The DVC 150 offers a high-speed USB 2.0 port, which you can connect to either type of USB port on the computer. The Dazzle DVC 150 also provides capabilities not built into Windows XP, such as the ability to output your finished movie to videotape, CD, VCD, SVCD, and DVD. Check it out under Home Video at www.dazzle.com.

You can connect just about any camera using one of those bridges. For example, if your camera has standard RCA ports, connect the Video Out and Audio Out ports to the Video In and Audio In ports on the bridge, as at the top of Figure 18-6.

S-Video provides better quality than standard RCA video. So if you have a choice, go with S-Video. (You can use one or the other, but not both at the same time.)

If your camera has S-Video, don’t use the RCA Video port at all. Rather, use an S-Video cable to connect the S-Video Out on the Camera to the S-Video In on the bridge. Connect the Audio Outs on the camera to the Audio Ins on the bridge normally, as in the middle of Figure 18-6.
If your camera has a Composite A/V or A/V Out port, you’ll need a cable that connects to that port on one end, then splits into three ports on the other end, as at the bottom of Figure 18-6. If you take the camera and bridge to a Radio Shack and tell them what you plan to do, they can probably hand you the cable right there and show you how to connect the two devices. The small plug on the single side of the cable will be divided into three bands, as in the example at left. One band is video; the other two are audio.

Using the Video Capture Wizard

You get video from a video camera, TV, or VCR by capturing it. The video actually plays on your computer screen, at normal speed, and your computer also captures a copy in a file as it’s going by. It all happens in real time; if you’re going to copy an entire 30-minute tape, it will take 30 minutes to copy it.

The first step is to turn the camera on in VCR mode (not Camera mode) and put the tape you want to capture into the VCR. Rewind the tape to the beginning. Or, if you’re not going to capture the entire tape, wind the tape to a few seconds before the spot where you want to start capturing. (It’s always better to capture a little too much than not enough.)

Tip

Think of a captured video as a piece of material. If you cut it too long, you can always cut it shorter. But if you cut it too short, you’ve got a problem.

Turn the camera off, and set it aside for a moment. Start up your computer if it isn’t already on. If your computer is already on, close all open program windows, so you can work from a clean desktop. Then connect everything starting from the computer and working your way out to the camera. Connect the camera last. Don’t turn the camera on until it’s connected to the computer. Then keep an eye on the screen for a while, to see if Windows detects your camera. (That might take a few seconds.)

If Windows can detect your camera, Windows Movie Maker might start automatically. Or you might be given the option to start Movie Maker. Either method is OK. If Windows Movie Maker doesn’t start within a minute or so, automatically, go ahead and start it yourself. Click the Start button and choose All Programs ➪ Windows Movie Maker (or All Programs ➪ Accessories ➪ Windows Movie Maker).

The Video Capture Wizard might automatically open as well. If so, you’re ready to start capturing as described in a moment. If the Record dialog box doesn’t open automatically, just go ahead and open it using whatever method is most convenient:

✦ Choose File ➪ Capture Video from Windows Movie Maker’s menu bar.
✦ Click Capture from video device in the Tasks pane.
✦ Press Ctrl+R.

Depending on the camera you’re using, the Video Capture Wizard might present anywhere from one to four pages of options. We’ll look at each page of the Wizard in the sections that follow. Remember that after you complete a page of
the Wizard, you need to click Next to move onto the next page. If you click Next too soon, just click Back to return to the previous page. Don’t be alarmed if some pages don’t appear. The Wizard is smart enough to present only the options needed for your particular camera.

The Video Capture Device Page
The first page of the Video Capture Wizard is titled “Video Capture Device” and might look something like Figure 18-7 when it first opens. This page is asking where the video and audio feed that you plan to capture will be coming from.

![Figure 18-7: The Video Capture Device page of the Video Capture Wizard](image)

The exact options available to you will depend on your computer and camera. Under Available Devices, you need to click the icon that represents your camera or the plug to which the camera is connected. Click whichever icon represents your device. As a rule, once you click an icon under Available Devices, you can leave all other settings as they are and click the Next button.

The Captured Video File Page
The second page of the Wizard, titled “Captured Video File,” asks what you want to name the video you’re about to capture and where you want to put it. Think up a brief but descriptive name, and type it under Enter a file name for your captured video. Under Choose a place to save your captured video, choose My Videos (unless, for whatever reason, you want to put the video in some other folder). Then click Next.
The Video Setting Page
The third page of the Wizard lets you choose a quality for your captured video. The general rule of thumb is, the better the quality, the better the video looks and sounds, but the larger the resulting file. You always want the best quality your machine can handle. The simple solution is to choose *Best quality for playback on my computer (recommended)*. Click Next to get to the fourth and final Wizard page.

The Capture Video Page
The fourth Wizard page, titled “Capture Video” (Figure 18-8), is where the actual capture takes place. Before you do anything else, take a look at the checkboxes near the bottom of the dialog box, and make selections as appropriate for your goals:

![Video Capture Wizard: ATI Rage Theater Video Capture](image)

**Figure 18-8:** The Capture Video page of the Video Capture Wizard

✦ **Create clips when wizard finishes:** Choose this option to have Movie Maker automatically divide the video into smaller scenes. Doing so will make it easier to edit your movie.

✦ **Mute speakers:** Choose this option if you don’t want your computer speakers to play the video while it’s being captured.

✦ **Capture time limit (hh:mm):** If you want to capture a fixed amount of video (for example, exactly 30 minutes), choose this option and set your time limit.
Then you’re finally ready to capture. Press the Play button on your video camera to get the tape going, and click Start Capture in the dialog box. Whatever video plays in the monitor on your screen will also be captured into Movie Maker.

When you’ve finished capturing video, just click the Stop Capture button in the dialog box; then stop the playback on the camera as well. Click the Finish button to complete the Wizard, and wait for the file to be split into clips (if you chose the Create clips... option in the Caption Video page of the Wizard).

The video you captured will be added to your Collections under whatever file name you gave the movie near the start of this process. When you click the collection’s name in the Collections pane, or choose the collection’s name from the drop-down list on the toolbar, you’ll see an icon or icons that represent the captured video. To play a captured video or clip from the video, click its icon in the Contents pane, and click the Play button under the Monitor, as illustrated in Figure 18-9.

You can repeat the procedure to capture more content. Or you can just start building your movie from the content you captured. Before we get to that, though, let’s look at another means of getting content into Movie Maker.

![Figure 18-9: How to view a clip in a collection](image-url)
Importing Video from Files

If you already have video stored in files on your hard disk, there’s no need to capture that video. It’s already been captured to a file. To get video from a file on your hard disk into Movie Maker, import the video. In addition to importing video, you can import music, such as songs you copied from an audio CD or downloaded from the Web. Those you can use as background music. You can also import still photos and include those in your movie production: The types of files you can import are summarized here:

✦ **Video**: .asf, .avi, .m1v, .mp2, .mp2v, .mpe, .mpeg, .mpg, .mpv2, .wm, and .wmv.
✦ **Still pictures**: .bmp, .dib, .emf, .gif, .jfif, .jpe, .jpeg, .jpg, .png, .tif, .tiff, and .wmf.
✦ **Audio**: .aif, .aifc, .aiff .asf, .au, .mp2, .mp3, .mpa, .snd, .wav, and .wma.

If you just want to practice and play around with Movie Maker to get your feet wet, you can use any sample video already on your hard disk. Chances are that you probably already have at least one sample video in your My Videos folder. To find out, follow these steps:

1. Click the Start button and choose My Documents to open your My Documents folder.
2. Double-click the My Videos folder in My Documents to open that folder. Explorer shows the contents of your My Videos folder.

If there are any videos in that folder already, you’ll see their icons. If you use the Thumbnails view, as in Figure 18-5, each video’s icon will be represented by the first frame of that video.

If you don’t have any videos in your My Videos folder, or if you think you have more video files elsewhere on your hard disk, you can use the Search Companion (Chapter 20) to search your entire hard disk for Video files. Then you can use any of the techniques described in the section “Moving and Copying Files” in Chapter 19 to move or copy found videos to your My Videos folder.

Be aware that Movie Maker doesn’t actually store copies of your video files. It simply creates pointers to your video files and uses those pointers to create your movie. If you import some videos into Movie Maker and later move those files, Movie Maker might lose track of them. So it’s in your best interest to put all video files you’ll be using to make movies into a permanent folder where you don’t need to move them after you’ve imported them into Movie Maker.

If your computer is on a network and you want videos to be accessible to all computers in the network, put them in your Shared Videos folder rather than in your My Videos folder.
Once you know where the file you want to import is located, and its file name, you can follow these steps:

**STEPS: Import a File into Movie Maker**

1. If you haven’t already done so, start Windows Movie Maker.

2. From Movie Maker’s menu bar, choose File ➤ Import into Collections. (Optionally, you can click Import Video under 1. Capture Video in the Tasks pane.)

3. A folder opens (most likely your My Videos folder). If the file you want to import is in some other folder, navigate to that folder. For example, to import a photo, you can navigate to your My Pictures folder. To import a song to use as background music, navigate to your My Music folder.

4. Click the icon of the file you want to import. Optionally, you can select multiple files using any of the techniques described under “Working with Multiple Files and Folders” in Chapter 19.

5. If you want Movie Maker to automatically divide the video into smaller clips, make sure the Create clips for video files option in the dialog box is selected (checked).

6. Click the Import button and wait a moment.

Once the file is imported, it will be stored in its own collection with the same name as the file you imported. To view the imported video, or a clip from it, click the collection name, click a clip, and click the Play button as shown in Figure 18-9.

You can capture and import as many clips as you wish. Your movie can contain clips from any number of collections. To create your movie, add clips to the Storyboard/Timeline, as discussed next.

**Creating the Movie**

A movie is a collection of clips. This is as true in Movie Maker as it is in real movies. In a real movie or TV show, scenes aren’t shot in the order you see them at the theater. Instead, they shoot all the scenes based on location, set, costumes, who’s in the scene, and so forth. All scenes are assembled into a story that (one hopes) makes sense.

In Movie Maker, you assemble your movie in the Storyboard/Timeline (also called the workspace), near the bottom of the Movie Maker window. There are two ways to view the contents of the workspace. Figure 18-10 shows examples of the two views and points out buttons that appear above the Storyboard/Timeline. The name and purpose of each button is summarized as follows:

- **Timeline**: Shows the first frame of each scene and the size of the clip relative to the overall movie and other clips.
✦ **Storyboard**: Shows each scene as the first frame in each clip only.

![Storyboard](image)

*Tip* To change the height of the Storyboard/Timeline, drag its upper border up or down.

![Timeline and Storyboard views](image)

**Figure 18-10**: Timeline view (top) and Storyboard view (bottom) of a movie

✦ **Movie (project)**: To create your movie, add clips to the Storyboard/Timeline in the order you want them to be played. A work-in-progress movie is referred to as a *project*, to differentiate it from a finished movie.

✦ **Audio Levels**: Lets you adjust relative volume of audio from a video and any background music or narration you add.

✦ **Narrate**: Lets you add narration starting at the current Playback Indicator position.

✦ **Zoom in**: Magnifies the timeline (disabled in Storyboard view).

✦ **Zoom out**: Shrinks the timeline so you can see more scenes (disabled in Storyboard view).

✦ **Playback indicator**: (Timeline view only): Shows the current position within the window. Drag the handle atop the indicator left/right to move through the movie. Point to the handle at top to see how many minutes into the movie the Playback Indicator is resting.

✦ **Rewind**: Rewinds the project to the beginning.
Next, we’ll look at how you use the tools and buttons to create a movie.

Arranging Your Scenes

You create a movie by copying clips from the Contents pane to the Storyboard/Timeline. Clips are played in the order in which they appear in the Storyboard/Timeline. You can add any clip from any collection to the Storyboard/Timeline using whichever technique of the following techniques is most convenient for you:

- Drag the clip from the Contents pane to where you want it to appear in the Storyboard/Timeline and drop it there.
- Right-click the clip that you want to add to the movie and choose Add to Storyboard or Add to Timeline.
- Click the clip you want to add to the movie and choose Clip ➤ Add to Storyboard or Add to Timeline from Movie Maker’s menu bar.
- Click the clip you want to add and press Ctrl+D.
- Select several clips using Ctrl-Click, Shift-Click, or Edit ➤ Select All (Ctrl+A). Then drag any selected clip to the Storyboard/Timeline.

A copy of the clip appears in the Storyboard/Timeline. The clip isn’t removed from the Contents pane. (That’s so you can use the same clip in multiple movies.) If you change your mind about a clip after adding it to the Storyboard/Timeline, you can do any of the following to back up:

- In the Storyboard/Timeline, right-click the clip you want to remove and choose Delete.
- In the Storyboard/Timeline, click a clip to select it. Then drag it left or right to move it within the movie. Or right-click the clip and press Ctrl+X to cut it. Then right-click the frame to the right of where you want to replace the clip and press Ctrl+V.
- To select multiple clips to move or delete, click one clip in the Storyboard/Timeline. Then hold down the Ctrl key while clicking other clips you want to select.
- To select a range of adjacent clips, click the first one; then hold down the Shift key and click the last one you want to select. Or move the mouse pointer past the last clip in the movie; then drag the mouse pointer to the left through clips you want to select.
✦ To select all clips in the movie, right-click any click in the Storyboard/Timeline and choose Select All.

✦ To clear the Storyboard/Movie, choose Edit ▶ Clear Storyboard or Edit ▶ Clear Timeline from the menu bar, or press Ctrl+Delete (Del).

✦ To undo your most recent action, choose Edit ▶ Undo from Movie Maker’s menu bar, or press Ctrl+Z.

You can add as many, or as few, clips to the Storyboard/Timeline as you wish.

Tip When dragging video clips to the Timeline, make sure you drag them to the bar titled “Video,” not the bar titled “Audio/Music or Title Overlay.”

Previewing Your Movie

Once you’ve dragged one or more clips to the Storyboard/Timeline, you can preview the entire movie at any time. If you use the Timeline view, you’ll be able to see the Play Indicator move through the movie as the movie is playing in the Monitor. The Play and Rewind buttons that follow refer to the buttons in the Storyboard/Timeline shown in Figure 18-10.

✦ Play/Pause: Click the Play button in the Storyboard/Timeline to play the movie starting at the current Play Indicator position. Or choose Play ▶ Play Storyboard/Timeline from Movie Maker’s menu bar, or press Ctrl+W (Watch). When the movie is playing, the Play button becomes a Pause button with a symbol on it. Click the Pause button to stop playback without rewinding the movie.

✦ Rewind: Click the Rewind button in the Storyboard/Timeline to move the Player Indicator to the first frame of the movie. Or choose Play ▶ Rewind Storyboard/Timeline from the menu bar, or press Ctrl+Q (Quit).

✦ Play Indicator: To move rapidly through the movie, drag the little box atop the Playback Indicator left or right. Or click a spot to the left or right of that little box to move the Play Indicator to that position.

If the movie is already playing, and you want to start over from the beginning, click the Pause button in the Storyboard/Timeline — then the Rewind button just to its left, then the Play button.

Tip The various controls in the Monitor also work while you’re viewing your movie.

Trimming Scenes

If a scene in your movie runs longer than you’d like, you can trim it from the front, back, or both. You need to drag the clip into the Storyboard/Timeline first. Then make sure you’re in Timeline view. Click the scene you wish to trim; then click the Play button to start playing the scene. Click the Pause button in
the Monitor when the scene is at about where you want to trim. You can then use the Previous Frame and Next Frame buttons to zero in on the exact frame where you want to set a **trim point**.

To trim all frames to the left of the current frame (within the selected clip), choose Clip ➪ Set Start Trim Point. Or, to trim off all frames to the right of the current position, choose Clip ➪ Set End Trim Point. Play the entire movie (or at least from before the trim point) to verify that you like the shortened scene. If you don’t like the results, click the scene again in the Timeline and choose Clip ➪ Clear Trim Points. Then you can start over with new trim points if you like.

**Tip**

As you’ll learn in the section “Managing Clips,” later in this chapter, you can also delete trash from any clip by splitting the clip into two parts and deleting anything you don’t plan to use.

**Overlapping Scenes**

It’s OK to make scenes in the Timeline overlap one another. Doing so will automatically produce a fade transition, where one scene (or song, or photo) will automatically fade out as the other is fading in. How long the fade transition lasts depends on how much overlap there is.

**Tip**

If the clips in the Timeline are too small to see, keep clicking the Zoom (+ magnifying glass button) in the Timeline to zoom in until you can see both clips well. Use the horizontal scroll bar under the Timeline to scroll left and right.

To make two scenes overlap, make sure you’re in Timeline view. Then click the scene to the right of the one you want to overlap it with. Drag that scene slightly to the left. Or choose Clip ➪ Nudge Left to move the scene just a tiny bit to the left. Then drag the Play Indicator to the left of the whole overlap and click the Play button in the Storyboard/Timeline to see (or hear) the transition. If the transition is too short, you can nudge the scene on the right a little more to the left. If the transition is too long, nudge the scene on the right a little to the right.

The two scenes (clips) will partially overlap, as at the bottom of Figure 18-11. The word *Fade* appears in the transition bar where the scenes overlap. (Click the + or - sign to the right of the word *Video* to show/hide the Transition bar.) When you play the movie, the first scene on the left will slowly fade out as the scene on the right slowly fades in.

**Spicing Up Your Movie**

After you’ve dragged some clips to the Storyboard or Timeline, you can start spicing things up with some special effects, music, still photos, and titles. Let’s start with some titles.
Adding Titles and Credits

Titles are textual information that you insert anywhere into a movie. For example, you can add titles to the beginning of the movie or credits to the end. You can even overlay textual information onto video as its playing. The process is easy:

1. If you plan to insert titles into, or between, clips in the movie, click the scene in the Storyboard/Timeline where you want to insert text.

2. Choose Tools ➪ Titles and Credits from Movie Maker’s menu bar, or click Make titles or credits under 2. Edit Movie in the Tasks pane.

3. Choose where you want to place the text from the options that appear, such as at the beginning of the movie; before the selected clip; on the selected clip; after the selected clip; or credits at the end of the movie.

4. In the top box, add the main title. Optionally, add a subtitle in the lower box.

5. To choose a font and colors, click Change the text font and color. Choose your Font, Color, Transparency, Size, and Position.

To overlay text onto the video as it’s playing, set the Transparency to 100 percent.
6. Optionally, click *Change the title animation* and choose an option from the list that appears. To see how a title will look when played, click the Play button in the Monitor.

7. When you’re happy with your title, click *Done, add title to movie*.

In Storyboard/Timeline view, each title will be presented as its own scene within the movie. (They’re easiest to spot in Storyboard view.) To see the title play out within the context of the movie, just play the movie, using the Rewind and Play buttons in Storyboard/Timeline view, or the Play Indicator in Timeline view.

### Making Photos from Videos

You can convert any single frame from a video clip to a regular still photo. This is true whether you plan to use that photo in your movie or not. The picture you create is no different from a picture you take with a regular still camera.

To get started, you need to click a clip in the Contents pane; then click the Play button in the Monitor to start playing the clip. When you get near a frame you want to copy to a photo, click the Pause button in the Monitor to pause the video. Use the Previous Frame and Next Frame buttons in the Monitor to get to the exact frame you wish to convert to a photo. Then click the Take Picture button below the Monitor (see the following).

In the Save Picture As dialog box that opens, navigate to the folder in which you want to store the picture (for example, My Pictures), type a file name, and click Save. A copy of the picture is stored in the folder and also in a collection. If you don’t intend to use the photo in a movie, you can delete it from the Contents pane by right-clicking and choosing Delete. A copy of the photo will remain in whatever folder you place the photo.
Adding Still Photos to Your Movie

If you have some photos you’d like to add to your movie, you can add those as well. The images can be any pictures stored in .bmp, .dib, .emf, .gif, .jif, .jpe, .jpeg, .jpg, .png, .tif, .tiff, .wmf format. But before you start importing still pictures, you’d do well to set default duration for pictures. Here’s how:

1. From Movie Maker’s menu bar, choose Tools ➪ Options.
2. In the Options dialog box that opens, click the Advanced tab.
3. Set the Picture Duration to however long you want the picture to be still within the movie (usually three to five seconds is sufficient).
4. Click OK in the dialog box.

Now you’re ready to import a picture. Here’s how:

1. From Movie Maker’s menu bar, choose Tools ➪ Import into Collections (or press Ctrl+I).
2. In the Import File dialog box that opens, navigate to the folder that contains the picture you want to insert.
3. Click the picture you want to insert (or select multiple pictures); then click the Import button.

The picture is added to the current collection, looking just like a video clip (though its name is the same as the name of the file you imported). To make the picture part of your movie, drag it down to wherever you want it to appear in the Storyboard/Timeline. When you play the entire movie, the photo will appear for its specified duration.

Tip

A movie doesn’t have to contain video clips. You could create a movie containing just still photos along with background titles, special effects, background music, and/or narration. Then save the whole thing as a movie, and you’ll have a nice slideshow of your favorite photos to show off to your friends.

Adding Video Effects

A video effect is a special effect applied to a single scene within your movie. That single scene can be any video clip, title, or picture within the Storyboard/Timeframe. Adding a video effect is simple:

1. Select (click) the scene within the Storyboard/Timeline to which you want to add a video effect.
2. Choose Tools ➪ Video Effects from Movie Maker’s menu bar. Or, in the Collections pane, click Video Effects. A list of video-effect names, such as Blur, Ease In, and so forth, appears.
3. To see an example of an effect, click the effect name and click the Play button in the Monitor. The effect will be played out against a generic picture.
4. When you find an effect you like, click its name; then press Ctrl+D to add the effect to the currently selected scene. Or drag the effect name to the scene to which you want to apply it.

5. You can repeat Step 4 to add as many effects as you wish to the current scene.

In Storyboard view, any scene to which you’ve applied a video effect will show two colored stars rather than a single gray star (see Figure 18-12). To see the effect, click the scene name to which you applied the effect; then click the Play button in the Monitor. If you change your mind, right-click the scene in the Storyboard/Timeline and choose Video Effects. In the dialog box that opens, click the name of the effect you want to remove under Displayed Effects. Click the << Remove button; then click OK.

Figure 18-12: Titles, video effects, and transitions in Storyboard view

Using Transition Effects

A transition effect is a special effect that takes place between scenes in the movie. It provides a segue from one scene to the next. You can place a transition effect before a scene, after a scene, or both. By default, each transition lasts 1.25 seconds. If you want to change that, choose Tools ➪ Options from Movie Maker’s menu bar. On the Advanced tab of the Options dialog box, change the Transition Duration to some other number of seconds (one to three seconds is usually sufficient). Then click OK.

You might find it easiest to add transition effects in Storyboard view. So if you’re in Timeline view, click Show Storyboard. Then follow these steps:

1. Choose Tools ➪ Video Transitions from Movie Maker’s menu bar, or click Video Transitions in the Collections pane. (Optionally, choose View ➪ Thumbnails to see a large icon for each transition.)

2. To see the transition played out against a generic picture, click its name; then click the Play button Monitor.

3. When you find a transition you like, drag it to the small box before, or after, the scene to which you want to apply the transition.
As an example, I’ve added transitions before, and after, the clip named Alec Soldier 2 in Figure 18-13. To see a transition played out in your movie, play the entire movie. Or, in TimeLine view, move the Playback Indicator just to the left of the transition; then click the Play button in the Storyboard/Timeline. To delete a video transition, right-click its little box in the Storyboard and choose Delete.

**Adding Narration or Background Music**

You can insert audio clips into your movie in much the same way you insert video clips and still photos. For example, you could import into Movie Maker a favorite song that you copied from a CD or downloaded from the Web. Then use that song as background music for the whole movie. Or add little short clips of music to individual scenes, like they do in theater movies. The first step is to import the music in Movie Maker. Here’s how:

**Caution**

Try to finalize the video portion of your movie before adding background sound or narration. If you add those things, but later remove a bunch of video from the movie, the audio may get chopped up as well.

1. From Movie Maker’s menu bar, choose File Import Into Collections.
2. In the Import File dialog box that opens, navigate to the folder that contains the song you wish to import (for example, My Music).
3. Double-click the name of the song to import.

The file is imported into the collection, its icon just a large musical note. To add the music clip to your movie, right-click it and choose Add to Timeline or Add to Storyboard. You’ll see the song in the Audio/Music bar of the Timeline. If you click the + sign next to Video, you’ll also see the audio that’s already built into the video on the Audio bar, as in Figure 18-13.

![Figure 18-13: Adding background music to a movie](image)

406 Part IV ✦ Fun with Multimedia
If the song runs much longer than the movie, drag its right edge in the Audio/Music bar to line up with the end of the movie, as in the same figure. To prevent a song from ending too abruptly, right-click the Audio/Music bar and choose Fade Out. (You can also right-click and choose Fade In to have the music fade in gradually.)

Video cameras record sound as well as video. So both the original sound from the video and the background music you add will play when you play the movie. To adjust the relative volume of the original audio and background music, click the Audio Levels button in the Storyboard/Timeline, or choose Tools  Audio Levels from Movie Maker’s menu bar. In the Audio Levels dialog box that opens (also shown in Figure 18-13), drag the slider bar to the left to make the original audio louder or to the right to make the imported music louder.

You can also narrate a movie with your own voice. You’ll need a microphone or headset plugged into your sound card to do this. Also, you might want to write up a quick script and practice delivering it, so you’re not constantly stumbling over words while you’re trying to narrate. Aside from that, adding narration is pretty easy. The narrative will actually be stored in a clip, which you can then add to the movie as you would background music.

To get started on narration, get your microphone into position or your headset on. If you’re in Storyboard view, click the Show Timeline button to switch to Timeline view. In the Timeline view, drag the Play Indicator to where you want to start narration (or just click the Rewind button to get to the beginning of the movie to narrate the whole thing).

Next, choose Tools  Narrate Timeline from Movie Maker’s menu bar. In the Narrate Timeline pane that opens, talk into your microphone to test it. Adjust the slider as you’re talking to make sure your voice reaches up to near the yellow part of the spectrum, but isn’t so loud as to keep you in the red part of the spectrum.

It helps a lot to see the movie as you’re talking. So when you’re ready to go, click the Start Narration button in the pane. Start talking, synchronizing your narration to whatever scene is currently playing in the movie.

To stop narrating, click the Stop Narration button. A dialog box titled “Save Windows Media File” opens. If you made a mess of things (as is often the case on the first few tries), you can click the Cancel button in that dialog box to start over. Otherwise, if you’re happy with the narration, type a file name (perhaps one that matches the title of your movie), and click the Save button. Then click the word Done under the Stop Narration button.

The icon for the narration sports a musical note, like an imported song. The narration is also added to the Audio/Music bar, just like an imported song. You can also use the Audio Levels dialog box described earlier to adjust the relative volume of the original video and your narration.

To remove an imported song or narration from the movie, click its name in the Audio/Music bar in the Timeline; then press Delete (Del), or right-click it and choose Delete.
Saving a Project (Work in Progress)

As you may recall, a movie that’s still a work in progress is referred to as a project. It’s not always possible to create a movie in one sitting. So you may want to save the work you’ve accomplished so far at any given time. In fact, it would be a good idea to save your work often, so a power outage or some other mishap doesn’t cause you to lose all that work. Saving a project is easy. Follow these steps:

1. Choose File ➪ Save Project from Movie Maker’s menu bar. The Save Project As dialog box opens.
2. Navigate to the folder in which you want to store the movie (for example, My Videos).
3. Type a file name for your movie.
4. Click the Save button.

That’s all there is to it. To save your work from time to time as you’re working on your movie, just click the Save button in the toolbar, or choose File ➪ Save project from Movie Maker’s menu bar again, or press Ctrl+S. You won’t need to enter a file name or anything. The current project will just be saved to whatever file name you provided the first time you save it.

To resume work on your movie at any time, open Windows Movie Maker normally. Then choose File ➪ Open Project from Movie Maker’s menu bar. Double-click the icon for the project you want to reopen. The project will be placed in the Storyboard/Timeline. Of course, if Movie Maker isn’t already open, you can double-click the project file’s icon to open both the project and Movie Maker.

Tip

To make Movie Maker automatically open with your latest project already loaded, choose Tools ➪ Options from Movie Maker’s menu bar. Click the General tab, choose (check) Open last project on startup, and click OK.

Creating the Final Movie

At some point, you movie will be complete and you’ll be ready to take the final step of converting your project into a finished movie file. The file you create will have a .wmv (Windows Movie) extension, which can be played by anyone who has Windows Media Player on his or her computer. Creating the final movie is easy:

**STEPS: Create the Movie File**

1. Choose File ➪ Save Movie File from Movie Maker’s menu bar. The first page of the Save Movie Wizard opens.
2. Click My Computer to save the movie to a file; then click Next.
3. On the second Wizard page, type a file name for the movie (this can be the movie’s title). Then use the Browse button to choose a folder in which to save the movie (for example, My Videos). Click Next.
4. On the third Wizard page, choose a Quality setting for your movie. For your first go around, your best bet is to just choose the first option: *Best quality for playback on my computer (Recommended)*; then click Next.

5. The last page of the Wizard opens, and Movie Maker starts making your movie. How long that takes depends on the length of the movie. When the last Wizard page opens, you can choose *Play movie when I click finish* to watch the movie in Windows Media Player.

6. Click the Finish button.

If you opted to watch the movie after clicking Finish, the movie will open and play in Windows Media Player. The movie file itself will be stored in whatever folder you chose in Step 3. For example, if you chose My Videos, the movie will be in that folder.

If you gave the movie file the same name as the project, you’ll be able to tell them apart by their icons and file name extensions. The project — the stuff that appears in Movie Maker’s Storyboard/Timeline — has a Movie Maker icon and the .MSWMM (Microsoft Windows Movie Maker) file name extension, as on the left of Figure 18-14. The finished movie will have a Media Player icon and a .wmv (Windows Movie) extension, as on the right of that same figure. If you plan to distribute copies of the movie, distribute only the .wmv file.

![Image of icons for a saved project (left) and a completed movie (right)](image)

**Figure 18-14:** Icons for a saved project (left) and a completed movie (right)

**Tip**

File name extensions are visible only if the *Hide extensions for know file types* option in Folder Options is turned off. See “Showing/Hiding File Name Extensions” in Chapter 6.

**Trying Other Quality Settings**

You can choose a quality setting for your movies. Here’s the trade-off: The higher the quality of the movie, the larger the resulting file. Disk-storage space is cheap, so I always make a super-high-quality copy of my movies and use that to make videotapes and DVDs. If you need a small version of the movie for e-mailing to people, you may want to make a lower-quality copy of the movie that can fit within the allowable limits.

**Tip**

Most ISPs limit the size of e-mail attachments to 1 or 1.5MB, which isn’t much video.
To really experience what quality means in terms of file size, and how the video looks, you can make extra copies of a movie from a single project. For example, in the same project you just created a movie from, you can choose File ➪ Save Movie File again. This time, when you get to the Wizard page that asks for a file name, give this copy of the movie the same name as the first movie, but add some text that will help you identify this as the high-quality version of the movie. For example, you might name the movie something like My first movie (Max Quality). When you get to the Quality Settings page of the Wizard, click Show more choices. Then click on Other Settings and choose the highest-quality setting available, Video for local playback (2.1 Mbps), as in Figure 18-15.

![Movie Setting Wizard](image)

**Figure 18-15:** There are many qualities to choose from under Other Settings.

**Tip**

The quality of a movie is measured in **bits per second** (bps). **Kbps** stands for **kilobits per second** or roughly 1,000 bits per second. **Mbps** stands for **Megabits per second** or roughly a million bits per second. Hence, 1 Mbps is of slightly higher quality than 999 Kbps.

When the ultra-high-quality copy of the movie is finished, you can create a low-quality version for comparison. Again, choose File ➪ Save Movie File from Movie Maker’s menu bar. When you get to the page where you name the file, add something to the file name to make this copy stand out as the low-quality version of the movie. For example, you might name it My First Movie (Low Quality). On the Movie Setting page of the Wizard, choose Show more choices; then choose Best fit to file size, and try setting the size to 1MB (one megabyte, the maximum attachment size for many ISPs). Click Next, and let Movie Maker create the movie.
It may not even be possible to squeeze a large movie down to a 1MB file. If you plan to e-mail movies to people, you should think in terms of making small movies that are just a couple of minutes in length.

If you then open the folder in which you saved all the movies, you’ll see the icon for each one. If you Tiles or Details view, you’ll be able to see their file sizes as well, as in Figure 18-16. To see how the movie looks, just double-click its icon to play it in Windows Media Player.

![Figure 18-16: A saved project (.MSWMM file) and three finished movies at different-quality settings (.wmv files)](image)

### Copying Movies to Tape and DVD

Recall that when you choose File ➪ Save Movie File, the first page of the Save Movie Wizard asks where you want to save the movie. The My Computer option lets you choose any folder on your hard disk. The other options on the first Wizard page provide these options:

- **Recordable CD:** If you use a blank CD-R or CD-RW disk, you can choose the Recordable CD option to write the movie to a CD rather than to your hard disk. (As you’ll learn in Chapter 21, however, you can just as easily copy the completed movie from your hard disk to a blank CD.)

- **E-mail:** The E-mail option on the Wizard will prepare a low-quality copy of the movie, small enough to e-mail. (This might not work with all e-mail systems, though.) As an alternative to going this route, you can also just attach a finished movie to an e-mail message.

  **Tip**  
  E-mail a copy of the movie to yourself first to see how it will look to the intended recipients.

- **The Web:** If you have your own Web site, to which you can upload files, you can use this option to create the movie and simultaneously upload it to the Web server. Alternatively, you can just upload the finished movie from your hard disk to your Web server using whatever method that Web server requires (for example, an FTP program).
DV camera: If you have a digital video camera that connects through a FireWire port, you can choose this option to copy the movie to a blank Mini-DV tape. Make sure you put a blank tape in the camera first, so you don’t overwrite any existing footage.

Windows Movie Maker doesn’t have anything built into it to copy movies to DVD. But if your computer has a DVD burner, chances are you already have software for that job. For example, my Sony DVD burner came with Sonic’s My DVD program (www.sonic.com/products/mydvd), which allows one to copy movie files (.wmv) to DVD or VCD.

A DVD can hold 4.7GB of data, which is enough for a couple hours of ultra-high-quality video. A CD only holds about 1/2GB (650–700MB), which is still a fair amount of disk space. See Chapter 21 for more information about DVDs and CDs.

Getting movies from the computer to VHS tape is a tougher nut to crack, because you have to get video and audio out from the computer and in to the VCR. Few computers have Video Out and Audio Out jacks. So you’re likely to need a bridge. Once again, Dazzle’s DVC 150 can be that bridge. (The DVC 80 won’t allow you to copy from the computer to tape.) The bridge setup with the DVC 150 looks something like Figure 18-17.

![Figure 18-17: Using a bridge to copy a finished movie to VHS videotape](image)

Things get weirder still, because you want to capture the movie to tape as it’s playing on the computer. To do that, open your My Videos folder (or whatever folder you put the finished movie in), right-click finished movie (.wmv file) that you want to copy to tape, and choose Open With > Windows Media Player. In Media Player, click the Play button to start the movie playing; then click the Full Screen button in Media Player’s program window, shown at left. When you’re in full-screen mode, press Ctrl+P to pause playback; then press Ctrl+Shift+B to rewind to the beginning.

Put a blank tape into the VCR. Hit the Record button on the VCR (or the Play and Record buttons, if that’s what your VCR requires) to start taping. On the computer, press Ctrl+P to start the movie playing. The movie should copy to the VHS tape as it’s playing. You’ll need to watch the entire movie. When copying is complete, stop the VHS tape, and close Windows Media Player. To test the results, just rewind and play the VHS tape normally in any VCR.
Closing Windows Movie Maker

You can close Windows Movie Maker using the same techniques you use to close any other program window. That is, click the Close button in its upper-right corner, or choose File ➪ Exit from Movie Maker’s menu bar. If you made any changes to the current project, you’ll be asked if you want to save those changes. Assuming you don’t want to lose your work, choose Yes.

Managing Collections

I stuck this section near the end of this chapter, because everything in this chapter is entirely optional. You don’t really need to manage your clips to create a movie — you just have to add clips to the Storyboard/Timeline to make a movie. But if you import lots of videos, stills, and music into Movie Maker, you’re likely to end up with a lot of collections and a lot of clips — so many that it becomes difficult to find specific clips when you’re trying to make a movie.

Managing clips involves things such as renaming clips and deleting junk clips you’ll never use in any movie, perhaps combining multiple small collections into one larger collection. You can also split one clip into two or, in some cases, combine multiple short clips. We’ll look at the latter techniques first.

Splitting a Clip

Let’s say you have a rather lengthy clip in one of your collections that you prefer to treat as two separate clips. Perhaps you just want to get rid of some stuff in the clip, or maybe you want to show part of the clip at the beginning of the movie and part of the clip at the end of the movie.

To split one clip into two, follow these steps:

1. In the Collections pane, click the collection that contains the clip you want to split.
2. In the Contents pane, click the clip you want to split into two clips. The first frame of that clip appears in the Monitor.
3. Click the Play button under the monitor, and watch it play. When you get near the place where you want to split the clip, click the Pause button.
4. Optionally, use the Previous and Next buttons in the Monitor to zero-in on the exact frame where you want to make the split.
5. Click the Split button under the monitor (see Figure 18-18).
The one clip will now be two. The first half of the clip will retain the original name. The second half of the clip will have that same name followed by (1). Click either clip; then click the Play button to see the clip play.

To rename one of the clips, right-click and choose Rename. If one of the clips is just trash you’d never use in any movie and you just want to get rid of it, right-click the useless clip and choose Delete. But only delete a clip if you’re certain you’ll never use it in any movie you create.

### Combining Clips

Sometimes when you import video, Movie Maker might split clips in a manner that doesn’t reflect how you intend to use the clips. For example, I imported a music video that really needs to be played as one long scene, because there’s music that goes along with that video. Rearranging the clips would also rearrange the music, which just wouldn’t make sense. So rather than deal with the piece as three separate clips, I’m more inclined to combine them into a single clip that I can treat as a unit.

You should only combine clips that are adjacent to one another in the Contents pane. If in doubt, switch to Details view and click the Name column heading until the triangle in that heading is pointing up. That way, the clips will be listed in the order in which they were captured or imported. Then, in the Contents pane, click the first clip to be combined. Hold down the Ctrl key, and click adjacent clips to combine with it. For example, in Figure 18-19, I’ve selected three adjacent clips in one of my collections.
To combine the clips, choose Clip ➪ Combine from Movie Maker’s menu bar, or right-click any selected clip and choose Combine. (Or press Ctrl+M.) The selected clips will be combined into a single clip that has the same name as the first clip you selected. To verify, just click the clip’s name in the Contents pane, and click the Play button in the Monitor.

**Moving, Renaming, and Deleting Clips and Collections**

The collection and clip names that appear in Movie Maker aren’t set in stone. You can change the name of any clip, or any collection, to something more meaningful for you. To do so, just right-click the collection or clip name you want to change and choose Rename. Type the new name and press Enter.

If you have any junk clips that you wouldn’t use in any movie and therefore just want to get rid of, you can do that. But be careful not to accidentally delete anything you might need in the future. There is Recycle Bin for Movie Maker clips and collections. So once you delete an item, that’s the last you might ever see of it. Anyway, to delete a clip or collection, right-click it and choose Delete.

If you do delete a clip or collection accidentally, you can undo the deletion, but you need to do so before you do anything else (and definitely before you close Windows Movie Maker). To undo the deletion, choose Edit ➪ Undo Remove Clip or press Ctrl+Z.

**Tip**

Ctrl+Z is sort of the universal undo keystroke in Windows XP. Try using it right after you’ve accidentally done anything, in any program. But don’t count on it always being available.

To move a clip from one collection to another, first open the collection that the clip is currently contained within. If you just want to move one clip, point to its
name in the Contents pane, hold down the left mouse button, drag the clip so that it’s right on top of the collection into which you want to move the clip (over in the Collections pane), and release the mouse button. The clip will disappear from its current collection. But when you click the name of the collection into which you moved the clip, you’ll see it listed in the Contents pane of that collection.

To move multiple clips, you can use the Ctrl+Click or Shift+Click method to select multiple clips first. Or, to move all the clips within a collection, right-click some empty space within the Contents pane and choose Select All (or press Ctrl+A or choose Edit ➪ Select all). Then drag any selected clip and drop it onto the name of the collection to which you want to move the clips. All those clips will disappear from the current collection and land in the collection to which you just dropped them.

**Summary**

Movie Maker 2 is one of those huge, built-in programs one could easily write an entire book about. But what you’ve learned in this chapter will certainly let you create just about any movie imaginable. There’s plenty of additional information available to you at all times. For starters, you can choose Help ➪ Help Topics from Movie Maker’s menu bar at any time for help. And there are lots of videos, demos, tutorials, FAQs (Frequently Asked Questions), and freebies at the Movie Maker Web site (choose Help ➪ Windows Movie Maker on the Web from Movie Maker’s menu bar, or use your Web browser to visit [www.microsoft.com/windowsxp/moviemaker](http://www.microsoft.com/windowsxp/moviemaker)). Now let’s get back to the main points you’ve learned in this chapter:

✦ Windows Movie Maker is a program for creating your own custom movies from video, photos, and music.

✦ To get video from a videotape into the computer, use Movie Maker to *capture* the video as it’s playing on your computer screen.

✦ To get video, music, or photos from files already on your hard disk, choose File ➪ Import into Collections from Movie Maker’s menu bar.

✦ To view the clips in a collection, choose the collection’s name from the drop-down list, or click the collection name in the Collections pane. Clips within that collection appear in the Contents pane.

✦ To watch a clip, click its icon in the Contents pane; then click the Play button in the Monitor.

✦ To add a clip to your movie, drag the clip to the Storyboard or Timeline.

✦ Use the Video Effects and Video Transitions collections to add special effects to your movie.

✦ When you’ve finished creating your movie, save it to a movie file (.wmv) by choose File ➪ Save Movie File from Movie Maker’s menu bar.
Look at the title of this part, “Getting Organized, Staying Organized.” Maybe I should have just titled it “Borrrrrr–ing.” I mean, really, who isn’t going to read that title and wonder, “What on earth does being organized have to do with computers? And why would I want to waste one precious moment of time finding out?” Answer to question 2: So you don’t spend all your precious time with a fish-like stare, hoping whatever it is you’re thinking about will suddenly appear on your computer screen all by itself.

Which brings up the question, “Why can’t the computer just keep stuff organized for me?” As I say back in Part I, your computer is kind of like a file cabinet with muscle. I don’t say anything about brains. As a nonliving object, your computer’s IQ is equal to that of all other nonliving things. You know, like rocks, fence posts, and car tires: IQ=0. If you hope to find things you’ve saved on your computer, you’ll have to be the brains of the operation. The only way to do that is to face the drop-dead boring concepts set forth in Part V’s title.
Managing Files and Folders

Although all the technical stuff about computers is daunting enough, that’s not all there is to it. Many problems stem from just being plain disorganized. Being disorganized, in turn, boils down to not being able to find the document you want, when you want it.

In Chapter 5, you learned that documents are things such as pictures, text, songs, and movies stored in files and that you use folders to store and organize files in much the same way you use folders in a filing cabinet. You open and navigate through folders using a program named Windows Explorer (commonly referred to as Explorer, for short).

The simplest way to get to the Windows Explorer program is to just open your My Documents folder by clicking the Start button and choosing My Documents (or by double-clicking the My Documents icon on your desktop, if you have one). When you open your My Documents folder, you see the title bar, menu bar, and toolbar for Windows Explorer, followed by the contents of your My Documents folder. The title bar in Windows Explorer always shows the name of the folder whose contents you’re currently viewing.

Tip

Windows Explorer is the program for exploring local resources — stuff on your computer. Internet Explorer is the program for exploring remote resources — stuff outside your computer that you can access via the Internet.

Unlike a file cabinet, where each folder contains only documents, a computer folder can contain documents, more folders, or both. For example, your My Documents folder probably contains at least three folders: My Music, My Pictures, and My Videos. You might also have some documents in your My Documents folder. It’s easy to tell
folders and documents apart — icons that represent folders always sport a little manila file folder, as is also pointed out in Figure 19-1. Before we go any further here, let’s review some basic facts about program windows in general and Windows Explorer:

✦ Unlike most programs, Windows Explorer never shows its own name in its title bar. It shows only the name of the folder whose contents you’re currently viewing.

✦ To change the appearance of icons in the folder, choose View from Explorer’s menu bar. Or click the Views button in the toolbar and choose a view (for example, Thumbnails, Tiles, Icons, List, Details).

✦ To rearrange icons, choose View ➤ Arrange Icons By (or right-click an empty space within the folder and choose Arrange Icons By); then choose an order.

✦ To hide or show toolbars in Explorer, choose View ➤ Toolbars. Click the name of the toolbar you want to show or hide.

✦ To move Explorer’s window (when it’s not maximized), drag it by its title bar.

✦ To size Explorer’s window (when it’s not maximized), drag any corner or edge.

✦ If you size the window down too much, the Explorer bar will disappear. Enlarge the window to make it reappear.

✦ If the Explorer bar never appears, choose Tools ➤ Folder Options from Explorer’s menu bar; click Show common tasks in folders, and click OK.

✦ If the Explorer bar doesn’t show general tasks like those in Figure 19-1, choose View ➤ Explorer bar from the menu bar, and click whatever bar’s name is checked in the menu that opens.

✦ To hide or show lists in the Explorer bar, click any heading (File and Folder Tasks, Other Places, Details).

✦ To open a folder whose icon appears in the main pane, double-click that folder’s icon. To get back to the folder you just left, click the Back button in Explorer’s toolbar.

✦ To go to the parent of the current folder, click the Up button in Explorer’s toolbar.

As you may recall from Chapter 5, a folder that contains other folders is referred to as the parent of the folders it contains. For example, Figure 19-1 shows you the contents of a folder named My Documents. Within My Documents are four folders: My Music, My Pictures, My Videos, and Recent Downloads. Because those folders are contained within the My Documents folder, we can refer to them as subfolders or children of the My Documents folder.
Creating Folders

Given that Windows already has folders for storing documents, why would you want to create your own folder? The answer is simple: for the same reason you probably have more than four or five folders in your filing cabinet — you just need more folders to organize your stuff. For example, suppose you have 1,000 photos. Do you really want to open your My Pictures folder and have to scan through 1,000 file names every time you want to find a particular photo? How will you remember all those file names?

Creating new folders within My Pictures lets you group your photos however you wish. For example, you can create a folder for each major photo event, as in the example shown in Figure 19-2. (If you import photos from a digital camera, it might do that for you.) Each folder can contain any number of photos.

You don’t have to stop there, though, because you can put folders in folders. For example, you can create a folder for each year, moving all the folders for each year into the appropriate Year folder. So, when you’re thinking “I need a photo,” you open My Pictures. There, you see a folder for each year. Then you might think “I’m looking for photos from Christmas 2002.” So you open the 2002 folder, and there’s the folder for all your 2002 Christmas photos, as in the bottom of Figure 19-3.
Figure 19-2: Contents of a sample My Pictures folder with subfolders of photos

Figure 19-3: Groups of photos further broken down by year
Then again, maybe organizing photos by year might not do the trick for you. Perhaps you’d rather organize by event. For example, you might have a folder for birthday photos, Christmas photos, vacations, and so forth, as in the top of Figure 19-4. So when you’re thinking, “I need a photo,” you open My Pictures. Then you think, “I’m looking for photos from a vacation.” So you open your Vacations folder, and there you find folders for different vacations, as in the bottom of the same figure.

Exactly how you organize your files and folder is entirely up to you, just like creating manila file folders in your filing cabinet. There’s no right way or wrong way. The one good and right way is whatever organization method makes it easy for you to find the files you need, when you need them. The goal is simply to get organized, and stay organized, so you don’t waste all your time searching around for files.
Creating Your Own Folders

Creating a folder is simple. But you need to think about where you want to put the folder. For example, it wouldn’t make much sense to put a folder full of photos in your My Music folder or in some random folder. The only place that makes sense for a folder full of photos is within your My Pictures folder or some subfolder within My Pictures.

The term *directory* means the same thing as *folder*. But *directory* is kind of an old, outdated term.

To tell Windows where to put the folder, navigate to that folder before you create the folder. For example, if you’re going to put the folder in My Pictures, open your My Pictures folder. If you want to put the folder inside some folder in My Pictures, open that folder. In other words, you need to open the folder that will be the parent to the new folder you’re about to create. Here are the exact steps for creating a folder:

**STEPS: Create a New Folder**

1. Open My Documents. Then navigate to the folder that will be the new folder’s parent (if My Documents will be the parent, you’re already there).
2. Do whichever is most convenient at the moment:
   • Choose File ➪ New ➪ Folder from Explorer’s menu bar.
   • Right-click some empty space between icons in the folder and choose New ➪ Folder.
   • Click Make a new folder under File and Folder tasks in the Explorer bar.

3. A new folder named New Folder appears, its name selected and ready for editing.

4. Type the new folder name and press Enter.

To quickly whip all your folders into alphabetical order, choose View ➪ Arrange Icons By ➪ Name, or right-click some empty space between folders and choose Arrange Icons By ➪ Name.

If you need to move some existing files into a folder, you can use any of the techniques described in the section “Moving and Copying Files,” later in this chapter, to do so.

Creating a Folder on-the-Fly

As you know, whenever you create and save a document or download one, the Save As dialog box opens. There, you tell Windows where to put the file and what to name it. Suppose that you’re already in the Save As dialog box, when you think “Darn, I should have created a new folder for this, because I’m going to have more documents like this one.” It’s not too late, though, to create a new folder. You can create the new folder on the spot, right there in the Save As (or File Download) dialog box. Here’s how:

1. In the Save As dialog box, first navigate to the folder that will be the parent of the folder you’re about to create.

2. Click the Create New Folder button in the toolbar of the Save As dialog box (the mouse pointer is resting on that button in Figure 19-5).

3. A new folder named New Folder appears in the main pane. Type a new name, and press Enter.

4. Double-click the folder you just created. Its name appears in the Save In drop-down list, indicating that this is where your file will be saved.

5. Type a file name in the usual manner; then click the Save button.

When you get back to Windows Explorer and navigate to the parent folder you selected in Step 1, you’ll see that it contains the folder you created in Step 3. Opening that folder will reveal the file you saved in Step 5.
Renaming Files and Folders

The name you give to a file or folder isn’t set in stone. You can change the name of a file or folder at any time. However, it’s important to understand that you never want to change the extension on a document file, as doing so will make it impossible to open the document in the future. I’ll show you an easy way to change only the file name, not the extension, in the steps that follow:

You can’t rename a file on a CD-ROM or DVD, unless you have special software installed. See Chapter 21 for more information.

**STEPS: Rename a File or Folder**

1. Right-click the icon of the folder or file you want to rename and choose Rename from the shortcut menu that opens.

2. The name is selected, and the blinking cursor appears.

3. If you’re renaming a document, and file name extensions are visible, make sure you don’t change the extension. To play it safe, you can put the mouse pointer just to the left of the period that starts the extension and drag the mouse pointer through everything to the left, so that the extension is no longer selected, as in Figure 19-6.

File name extensions are visible only if the *Hide extensions for known file types* option in Folder Options is turned off. See the section “Showing/Hiding File Name Extensions” in Chapter 6 for details. One of the advantages of keeping file name extensions hidden is that you don’t have to worry about accidentally changing a file’s extension. When the extension is hidden, it’s not even possible to change it!

4. Type a new name, or use any of the standard text-editing techniques to change the name.
5. Press Enter.

If renaming an item gets it out of alphabetical order, just right-click some empty space between icons and choose Arrange Icons By ➪ Name.

**Tip** If you change your mind right after renaming a folder, press Ctrl+Z to undo the change.

### Working with Multiple Files and Folders

In a moment, we’ll talk about deleting, moving, and copying files and folders. But before we do, be aware that it’s not necessary to work with only one file, or one folder, at a time. You can select multiple files (or folders), then move, copy, or delete them all in one fell swoop. There are lots of ways to select multiple files. Choosing one method or the other is generally a matter or whatever is most convenient at the moment.

If you’ll be selecting multiple icons from a folder that contains many icons, it might help to start by choosing a view and sort order that makes it easy to see all the icons you want to select. You can use any view you wish and any sort order you wish. Again, it’s just a matter of deciding what’s most convenient for you at the moment.
For example, if you choose View ➪ List from Explorer’s menu bar (or click the Views button in the toolbar and choose List), you’ll be able to see many icons at a time. If you choose View ➪ Arrange Icons By ➪ Type, all the files of a certain time (for example, all pictures) will be clumped together within the folder.

Selecting Multiple Icons by Dragging

If the icons you want to select are adjacent to one another within the folder, perhaps the easiest way to select them will be to drag the mouse pointer through them. It’s a little tricky, though, so pay close attention to these steps:

**STEPS: Select Multiple Icons by Dragging**

1. Position the mouse pointer so it’s near the first icon you want to select, but not actually touching that icon, or any other icon, as in the top of Figure 19-7.

2. Hold down the left mouse button, and drag the mouse pointer through the name or icon of each item you want to select.

3. When all the items you want to select are highlighted, as in the bottom of Figure 19-7, release the mouse button.

The selected items are highlighted. If you need to unselect one or more selected items, hold down the Ctrl key and click the items you want to unselect. Or, to start over, just click some empty space between icons to unselect all currently selected icons and to get back to your starting point.

**Figure 19-7:** Selecting multiple icons by dragging the mouse pointer through them
When using single-click navigation, it’s important to move the mouse pointer to some neutral place between icons after selecting icons. If you leave the mouse pointer resting on an icon, doing so will sound as a new select, thereby unselecting the currently selected icons and selecting only the one the mouse pointer happens to be resting on.

Selecting All Icons in a Folder

If you want to select all the icons within the current folder, that’s easy. You can use whichever of the following methods is most convenient at the moment:

✦ Choose Edit ➪ Select All from Explorer’s menu bar.
✦ Press Ctrl+A.

All the icons will be selected. You can unselect individual icons using Ctrl-select or Shift-select, described as follows. To unselect all icons, click any empty space between icons.

Selecting Multiple Icons Using Ctrl and Shift keys

If you want to select multiple icons that aren’t near each other, you can use the Ctrl and Shift keys in combination with the mouse. But exactly how you do it depends on the navigation method you’re currently using. To see (and optionally change) your current navigation method, follow these steps:

1. Open your My Documents folder or any other folder (it doesn’t really matter, because the setting you choose will apply to all folders and all document icons).
2. Choose Tools ➪ Folder Options from Explorer’s menu bar.
3. Under Click items as follows on the General tab (Figure 19-8), choose one of the following options:
   • Single-click to open an item (point to select): Lets you open a folder or document by clicking its icon once. To select an icon, point to it (rest the mouse pointer on it for a second). If you choose this option, you can also choose to show all icon titles with or without underlines.
   • Double-click to open an item (single-click to select): Requires that you double-click a folder or document icon to open it. To select an icon, click it once.

The single-click option requires split-second timing on selecting icons. If you’re a beginner, or have trouble selecting icons using that method, you would probably be better off using the double-click method.

4. Click the OK button to close the dialog box.
I'll use the terms *Ctrl+select* and *Shift+select* in the sections that follow. It's important to understand, though, that the definition of *select* depends on which option you chose previously. Here are specific definitions for the two navigation methods:

**Single-click to open method:**

- **Select:** Point to the icon (rest the mouse pointer on it for a second).
- **Ctrl+Select:** Hold down the Ctrl key, and point to the icon for a second.
- **Shift+Select:** Hold down the Shift key, and point to the icon for a second.

**Double-click to open method:**

- **Select:** Click the icon you want to select.
- **Ctrl+Select:** Hold down the Ctrl key; then click the item you want to select.
- **Shift+Select:** Hold down the Shift key; then click the item you want to select.

**Selecting Multiple Icons with Ctrl+Select**

To select multiple icons that aren’t adjacent to one another within a folder, follow these steps:

1. Select the first icon you want to select.
2. Hold down the Ctrl key while selecting additional icons.
3. Release the Ctrl key when you’re done selecting.
Figure 19-9 shows an example where I’ve selected multiple icons using Ctrl+select. Note that you always select the first icon without holding down the Ctrl key. You hold down the Ctrl key only when you want to start selecting more icons without unselecting the first one.

You can also use Ctrl+select to deselect a single selected icon without deselecting them all. Just Ctrl+select any selected icon a second time.

Selecting Multiple Icons with Shift+Select
You can also use the Shift key to select multiple icons. Unlike the Ctrl key, which selects one icon at a time, the Shift key lets you select a range of icons. The steps are fairly straightforward:

1. Select the first item without holding down any keys.
2. Hold down the Shift key, and select the last item you want to select.
3. Release the Shift key.

![Selecting multiple icons with Ctrl+select](image)
For example, in Figure 19-10, I select the first icon without holding down any keys. Then I use Shift+select to select the last item. Because I use the Shift key, both icons — and all the icons in between — are selected.

If you need to unselect a few of the selected icons, Ctrl+select those you want to unselect. To unselect all selected files and start over, click any empty space between icons.

**Inverting a Selection**

You can invert the current selection in a folder, thereby unselecting icons that were selected and selecting the icons that weren’t selected. This can be handy when you want to select most, but not all, of the icons in the folder.

For example, suppose you want to select all the pictures in a folder, but none of the folders or documents. Rather than painstakingly selecting each picture, you can first select the items you don’t plan to select, as in the top of Figure 19-11. Then choose Edit ▶ Invert Selection from Explorer’s menu bar. All icons except the one(s) you originally selected will be selected, as in the bottom of Figure 19-11.

**Figure 19-10:** Selecting multiple icons with Shift+select
Deleting Files and Folders

There’s no rule that says you have to keep a file or folder forever. You can delete a file or folder at any time. But deleting can be dangerous and isn’t something you want to experiment with. You need to be aware of some facts first:

✦ The term *delete* means get rid of it forever. It’s not the same as closing something, which merely takes it off your screen.

✦ You should delete an item only if you know exactly what it is and you’re absolutely certain you will never need it again for the rest of your life.

✦ When you delete a folder, you also delete *all* the files and subfolders within that folder. Don’t delete a folder unless you’re sure you won’t need anything in the folder for the rest of your life.

You can’t delete files on a CD-ROM or DVD, unless you have special software installed. See Chapter 21 for more information.
So the bottom line is, think hard before you delete anything, and never, ever delete something just for experiment. Given that, here’s the quick and easy way to delete a single file or folder:

✦ Right-click the item you want to delete and choose Delete.

You don’t have to delete icons one at a time, though. You can also use this method to delete any number of items within a folder:

1. Select the icon(s) you want to delete by using any of the methods described previously in this chapter.
2. Do whichever of the following is most convenient at the moment:
   - Press the Delete (Del) key.
   - Choose *Delete the selected items* under File and Folder Tasks in the Explorer bar.
   - Right-click any selected icon and choose Delete.
3. You’ll see one of the dialog boxes shown in Figure 19-12.

![Confirm Multiple File Delete](image)

*Figure 19-12:* One of these confirmation dialog boxes will appear when you delete files or folders.

4. If you’re sure you want to delete the files, go ahead and click Yes.

The selected items disappear.

**Using the Recycle Bin**

Notice that the top dialog box in Figure 19-12 is asking “Are you sure you want to send these items to the Recycle Bin?” That dialog box appears when you delete a file or folder from your computer’s hard disk. When you delete a file or folder from your hard disk, it isn’t truly deleted right away. Instead, it’s moved to a special folder called the Recycle Bin. The Recycle Bin, in turn, is a safety net that allows you to recover any files you deleted by accident.
Actually, if you realize your mistake right after deleting a file or folder on your hard disk, you can press Ctrl+Z to undo the deletion and bring the files back, without going through the Recycle Bin.

However, the Recycle Bin only stores files that you delete from your hard disk — not files you delete from floppies, Zip disks, or any other removable media. Files from removable media are permanently deleted right on the spot, and there’s no way to change your mind. When a file is about to be permanently deleted, you see a dialog box that appears at the bottom of Figure 19-12. As soon as you click Yes in that dialog box, the deleted files and folders are gone forever!

Another name for a hard disk is a fixed disk. That’s fixed as in can’t be removed, not fixed as in previously broken. The opposite of that is a removable disk, such as a floppy disk, CD, DVD, or Zip disk, which you can remove from the drive and replace with another disk.

Leaving deleted files and folders in the Recycle Bin has only one drawback — the files and folders there take up just as much space on your hard disk as they did before you deleted them. So if you’re looking to get back some disk space, you’ll have to empty the Recycle Bin, which is roughly equivalent to emptying your real trashcan into an incinerator, from which there’s no hope of ever getting the trash back. Keep in mind that once you empty the Recycle Bin, that’s it. In other words, once you empty the Recycle Bin, there’s no way (in Windows XP) to get those files back.

To see which files and folders are currently in your Recycle Bin, double-click the Recycle Bin icon (shown at left) on your Windows desktop. When the Recycle Bin opens, it really won’t look much different from any other folder (Figure 19-13). It has all the accoutrements of any program window (a title bar, a menu bar, a taskbar button, or an Explorer bar). The icons in the main pane represent files and folders you’ve deleted from your hard disk.

If you have Symantec’s Norton Utilities installed on your computer, your Recycle Bin may be named Norton Protected Recycle Bin. To restore the original Windows XP Recycle Bin, go to www.symantec.com/techsupp/consumer.html, choose Norton Utilities as your Product, choose your Version, and click Continue. Use the next page that opens to search for the term Recycle Bin; then click the article titled “How to remove the Norton Protected Recycle Bin and/or the Windows Recycle Bin” in the list of articles that opens.

**Restoring Accidentally Deleted Files and Folders**

Before you do anything else in the Recycle Bin, you should look through every single item in the bin. If you come across any file that really shouldn’t be deleted, right-click that item and choose Restore (Figure 19-13) to put it back into its original folder. Optionally, you can select multiple icons using any of the techniques described earlier; then right-click any one of the selected icons and choose Restore to restore them all (or click Restore the Selected Items under Recycle Bin Tasks in the Explorer bar).
Giving Files and Folders the Axe

When you feel confident that the Recycle Bin contains only folders and files that you'll never need again, for the rest of your life, empty the Recycle Bin. To empty the Recycle Bin:

✦ Click Empty the Recycle Bin under Recycle Bin Tasks in the Explorer bar.
✦ Or choose File ➪ Empty Recycle Bin from Recycle Bin’s menu bar.

Everything within the Recycle Bin will disappear and head up to software heaven, from which there is no return. The disk space that was consumed by those files will be recovered, making room for new files.

Caution Never use the Recycle Bin as temporary storage for a file or folder you don’t plan to delete. That would be like storing important paper documents in your trash can. Just too darn risky!

When you’ve finished with the Recycle Bin, you can close it as you would any other window — by clicking the Close (X) button in its upper-right corner. And that about covers it for deleting files. If there’s one point that I must stress one more time, it’s that you never want to delete a file just because you don’t know what it is. The only time you want to delete a file is when you know exactly what it is and are 100 percent sure you’ll never need the file again.

Tip You can also delete a file by dragging its icon and dropping it right onto the Recycle Bin’s icon. And you can empty the Recycle Bin without opening it. Just right-click its icon and choose Empty Recycle Bin. (Yes, those are two tips, although the second one is dangerous if you don’t know what’s in the Recycle Bin!)
Moving and Copying Files

Keeping files organized often requires moving and copying files. Whenever you move or copy a file, there’s a source and a destination involved. The difference is as follows:

✦ **Source**: Where the file or folder is currently located.
✦ **Destination**: Where you want to put the file or folder.

The source can be any folder on your hard disk, a floppy disk, a CD, or whatever. (Likewise for the destination.) But techniques for copying files to CDs and DVDs are somewhat different from the general techniques we’ll describe in this chapter. Chapter 21 talks about how you get files from your hard disk to CDs and DVDs.

Move versus Copy

The terms *move* and *copy* in the computer sense have the same meanings that they do in regular English. For example, when you move a file from one location to another, you remove it from its current location and place it in a new location. For example, if you move a file from your My Documents folder to your My Pictures folder, you still have only one copy of that photo — the one now in your My Pictures folder.

When you copy a file, you end up with two exact clones of the file. For example, if you copy a file from your My Documents folder to a floppy disk, you’ll have two copies of the file: the one still in your My Documents folder and the one on the floppy. We can say that the copy on the floppy is a backup of the one in the My Documents folder. If you somehow mess up the copy in your My Documents folder, it’s no big deal. You can just grab a copy of the original from the floppy disk.

Undeleting Files and Folders

Even though there’s no way to recover a permanently deleted file in Windows XP, that doesn’t mean it’s entirely impossible. You can purchase and install a third-party undelete program that provides one last, slim hope of restoring deleted files from removable media and even files that have been emptied from the Recycle Bin. But those deleted files won’t hang around forever. Eventually, new files you save will replace the deleted ones. And once that happens, the deleted files no longer exist and nothing can bring them back.

Still, if you can jump on the problem shortly after an accidental deletion, there’s a good chance you’ll be able to undelete. As an example of a third-party undelete program, check out the RecoverMyFiles program at [www.recovermyfiles.com](http://www.recovermyfiles.com). Or try out the free trial version by going to [www.tucows.com](http://www.tucows.com) and searching for RecoverMyFiles.
Here’s another way to think about it, using a real-world example. If you remove a paper document from one folder in your file cabinet and put it in another folder, you move the document to a new location. If you take a paper document out of the file cabinet and make a photocopy of it, you make a copy, in that you have two versions of the same document.

There are lots of ways to move and copy files. As usual, there’s isn’t a right way or a wrong way. The result is always the same. Choosing one method over another is simply a matter of deciding what’s most convenient at the moment or what’s easiest for you to remember.

### Moving Files to a Subfolder

One of the most common reasons to move files is when you create a new, empty subfolder within some existing folder. Then you want to move some files into that new subfolder. For example, let’s say you have songs by various artists in your My Music folder. Several of the songs are by the artist Sarah Brightman. You’d like to create a subfolder named Sarah Brightman and move all of her songs into the Sarah Brightman folder.

The first step, of course, is to create the new, empty Sarah Brightman folder. You can use any technique described earlier in this chapter to create the new folder. Next, you need to select all the songs that you want to move. In this case, select all the songs by Sarah Brightman, as in Figure 19-14. (Use the Ctrl+Select method described earlier in this chapter to select multiple nonadjacent files.)

When the files you want to move are selected, just drag any selected icon so that it’s covering the destination folder’s icon. That is, point to a selected file, hold down the left mouse button, drag the ghost image (semitransparent image) of the selected icon that appears when you start dragging, so that the mouse pointer is right smack on top of the destination folder and the destination folder looks highlighted, as in Figure 19-15. Then release the mouse button.

**Tip**

If you just want to move a single file into a subfolder, there’s no need to select anything. Just drag the file’s icon so it’s right on top of the destination folder’s icon, and release the mouse button.

As soon as you release the mouse button, all the selected icons disappear, as in Figure 19-16. That’s because the files are no longer in the My Music folder; you moved them to the Sarah Brightman folder. If you open (double-click) the Sarah Brightman folder, you’ll see the files inside that folder.

**Tip**

If you wanted to copy (rather than move) the files to the subfolder, you could drag using the right mouse button rather than the left mouse button. Once the mouse pointer is smack on top of the destination folder, release the right mouse button and click Copy Here in the little menu that appears.
Moving and Copying across Any Folders

The whole business of dragging a file to a subfolder works fine when you can see both the destination folder and the files to be moved in the same Explorer window. But what about when you want to move or copy files when you can’t see the files and folders at the same time? There are a couple of ways to deal with that. One is the drag-and-drop method, which we’ll discuss next.
Moved files are no longer in the open folder. They’re in the destination folder now. Open (double-click) the destination folder to see its contents.

Figure 19-16: Moved files have disappeared; they’re in the Sarah Brightman folder.

**Moving and Copying by Dragging**

When you can’t see both the source folders and destination folders at the same time, you can just open both folders. Then select and drag files from one folder to the other. I think this is best illustrated by an example. So we’ll work through the steps involved by using an example of moving or copying files from the My Pictures folder to the Shared Pictures folder. An easy way to do this is by right-dragging the items to the destination folder (where *right-dragging* means holding down the right mouse button, rather than the usual left mouse button, while moving the mouse). Here are the steps:

**STEPS: Move or Copy Folders by Dragging**

1. Open My Documents; then navigate to the destination folder.
2. Open My Documents again; then navigate to the source folder.
3. Size and position the two open windows so you can see the main pane of each one. For example, in Figure 19-17, My Pictures will be the source folder (upper left), and Shared Pictures will be the destination folder (lower right).
4. If you want to move or copy multiple items from the source to the destination, select the items using any technique described earlier in this chapter.
5. Point to the item you want to move (or any selected item) and hold down the right (secondary) mouse button.
Figure 19-17: My Pictures is the source folder; Shared Pictures is the destination folder.

6. Keep the right mouse button held down while moving the mouse pointer into some empty area within the destination folder; then release the right mouse button. Then:

- To move the files to the destination click, click Copy Here in the little menu that appears (see Figure 19-18).
- To copy the items to the destination folder, click Move Here in the little menu that appears (see also Figure 19-18).

The icons will be copied or moved to the destination folder.

Tip
To quickly size your open windows, right-click the current time in the lower-right corner of your screen and choose Cascade Windows. Then move one of the folders down, and to the right, by dragging its title bar.

Dragging with the right mouse button, as in the preceding steps, is actually optional. But if you drag using the left mouse button, you won’t get the choice to move or copy. Windows will just decide for itself what to do as follows:

- If you drag the files to a new folder on the same drive (for example, from My Pictures to Shared Pictures, both of which are on your hard
disk), the files will be moved, on the assumption that you’re reorganizing the files.

✦ If you drag files to a window for a different drive (for example, floppy disk, Zip disk, or CD), the files will be copied, on the assumption that you’re making backup copies.

If you start dragging icons, but change your mind, just press and release the Esc key (before you release the mouse button) to cancel the operation.

![Figure 19-18: The menu that appears after right-dragging items](image)

If you do drag using the left mouse button, the mouse pointer will show a little + sign in the destination folder if Windows intends to copy the file. If Windows intends to move the file, there won’t be a + sign. But you can still choose whether to move or copy the file, though, so long as you do so before you release the mouse button. Here’s how:

✦ To copy the files, hold down the Ctrl key, release the mouse button, and release the Ctrl key.

✦ To move the files, hold down the Alt key, release the mouse button, and release the Alt key.

Then again, you can move and copy files and folders without any dragging at all. You can use cut and paste, or copy and paste instead, discussed next, if those techniques are easier for you.

**Tip** The terms *create, rename, select, delete, restore, move, and copy* are all official buzzwords that you can locate in Windows Help and Support Center when you need a quick reminder or reinforcements on techniques described in this chapter.
Using Cut and Paste to Move or Copy Files

As an alternative to dragging things around to move or copy them, you can use simple cut and paste (to move) or copy and paste (to copy) the files.

**STEPS: Move/Copy Files with Cut and Paste**

1. Open My Documents, and navigate to the folder that contains the items you want to move or copy.

2. If you intend to move or copy multiple items, select those items using any technique described earlier in this chapter. Then do one of the following:
   - To move the items, press Ctrl+X or right-click any selected file and choose Cut.
   - To copy the items, press Ctrl+C or right-click any selected item and choose Copy.

3. Navigate to the destination folder (wherever you want to put the files).

4. Choose Edit ➪ Paste from that folder’s menu bar. Or right-click some empty space within the destination folder and choose Paste.

**Move/Copy Files Using the Explorer Bar**

There’s still more ways to skin this move/copy cat. The first steps are the same. Select the item (or items) you want to move or copy. Then choose one of the following options under File and Folders Tasks in the Explorer bar:

- Move the selected items.
- Copy the selected items.

A dialog box named Copy Items or Move items opens, like the example shown in Figure 19-19. That box gives you a really wide range of destinations to choose from. You need to zero-in on your destination folder. Any name that has a + sign next to it is hiding some subfolders. Click the + sign next to any folder name to see its subfolders.

When you see the name of the folder to which you want to move/copy the files, click it to select it. Then click the Copy or Move button in the dialog box to copy or move the files. The files are moved or copied into whatever folder name you highlighted in the list, and the dialog box closes.

**Making a Copy in the Same Folder**

Sometimes it’s helpful to have two copies of the same file in a single folder. For example, let’s say you have a file named January Newsletter. When February rolls around, you want to use January’s newsletter as the starting
point for your new newsletter. Rather than altering January’s newsletter directly, you can keep that one and use a copy as the starting point for the new newsletter.

![The Copy Items dialog box](image)

**Figure 19-19:** The Copy Items dialog box

To do so, right-click the file you want to copy (January Newsletter in this example) and choose Copy. Then right-click any empty space between icons and choose Paste. Or, using the keyboard, select the item(s) you want to copy and press Ctrl+C. Then click some empty space within the same folder so that no items are selected, and press Ctrl+V.

You can also make a copy of a file within the same folder by dragging. Point to the item you want to copy, hold down the Ctrl key, drag (using the left mouse button) to some empty space within the same folder, and release the mouse button.

Either way, a copy of the file will appear. Its name will be *Copy of...* followed by the original name. If you don’t see the copied file, choose View ➤ Arrange Icons By ➤ Name. Then scroll to where you can see the files name that starts with *Copy...*. To rename to copied file (for example, to change its name from Copy of January Newsletter to February Newsletter, just right-click its name and choose Rename, as described earlier in this chapter).

**Undoing a Move or Copy**

If you complete a move or copy operation and then change your mind, you can undo the action as long as you don’t do any more moving or copying (you can only undo one move/copy operation — the one you performed most recently).

To undo a move or copy, just press the universal Undo key, Ctrl+Z. Or right-click within the source folder or destination folder (or Desktop, if that was your
source or destination), and choose Undo Move or Undo Copy. Or choose Edit ➪ Undo from the source or destination window’s menu bar. You may see a prompt asking if it’s OK to delete the files. Choosing Yes will delete only the copied file(s), which is OK, since that’s what’s actually required to undo the copy.

Summary

We’ve covered a lot of ground in this chapter, and the things described here are the most common things people do to manage files. There’s a whole lot more coming up, though, including things such as copying files to CDs and floppies, finding lost files, combining files from multiple folders into one folder, and more. But first, here’s a quick recap of the most important points covered in this chapter:

✦ To create a new folder, go the folder that will be the new folder’s parent. Then choose Make a new folder from the Explorer bar, or choose File ➪ New Folder from the menu bar, or right-click some empty space between icons and choose New ➪ Folder.

✦ To rename a file or folder, right-click its icon and choose Rename.

✦ To perform the same operation on multiple items within a folder, first select the items you want to delete/move/copy by using any of the techniques described earlier in this chapter.

✦ To delete an item, right-click it and choose Delete.

✦ To delete multiple items, first select the items you want to delete. Then press Delete (Del), or click Delete the selected items under Folder and File Tasks in the Explorer bar, or right-click any selected item and choose Delete.

✦ Files and folders that you delete from your hard disk are initially just moved to the Recycle Bin.

✦ Files and folders you delete from removable media such as floppies and Zip disks are not sent to the Recycle Bin and cannot be recovered without special software.

✦ To restore an accidentally deleted file, open the Recycle Bin on your Windows desktop. Then right-click the item you want to restore and choose Restore.

✦ To permanently delete files in the Recycle Bin and reclaim the hard-disk space they’re using, choose Empty the Recycle Bin from the Explorer bar in Recycle Bin.

✦ To move a file or folder means what the name implies — to take it from one place and put it in some other place instead.

✦ To copy a file or folder means to make an exact duplicate of it, as you can with a photocopy machine.

✦ The source folder in a move or copy operation is the folder in which the files are currently stored. The destination folder is the folder to which you want to move or copy the files.
To move a file to a new folder, just drag its icon to the destination folder's icon or to an open copy of the folder.

To copy a file to a new folder, hold down the Ctrl key and drag the file to the destination folder's icon or to an open copy of the folder.

You can also move files by using Cut (Ctrl+X) and Paste (Ctrl+V). You can copy files using Copy (Ctrl+C) and Paste (Ctrl+V).
Everything in your computer, so to speak, is actually stored on your computer’s hard disk. That includes Windows XP, all your installed programs, every document you create or download, and all the built-in folders Windows provides for storing your documents, such as My Documents, Shared Documents, My Music, and so forth.

Although few people realize it, a hard disk is home to hundreds of folders and tens of thousands of files, even on a brand-new computer. If you lose something in all of that, finding it again in the future is no small feat. In this chapter, you’ll learn how to go looking for lost items. You’ll also learn techniques for exploring and maintaining your computer’s hard disk.

**Searching for Lost Files**

Contrary to popular belief, computers don’t eat files. Windows will never rename a file, delete a file, or move a file on its own. But that doesn’t mean you won’t ever lose track of a file. As mentioned a few times in this book, whenever you save a file — be it one you created yourself or one you downloaded — you have to tell Windows where to save the file and what name to give it.

Even if you do remember to do all that, there’s no guarantee that you’ll remember where you put a file six months from now. Sometimes, you just forget where you put things. (I usually forget where I put my keys or glasses within a few seconds of putting them someplace.) When things get lost on your computer, it’s time to enlist the help of the Search Companion.
Using the Search Companion

The Search Companion is a tool offered by Windows Explorer to help you find lost files. To find a file you first need to know something about it. That something can be any combination of characteristics listed here. The more things you know, the easier it will be to find the file:

✦ When you saved/downloaded the file.
✦ All, or part, of the file name.
✦ Some word or phrase in the document (if it’s a document that contains text).
✦ The size of the file.

After you think of something unique about the file that will help Windows find it, you can follow the steps here to search for the file (you can also use the same techniques to search for folders).

✦ Click the Start button and choose Search.
✦ In Windows Explorer, click the Search button in the toolbar, or choose View ➪ Explorer Bar ➪ Search.

The Search Companion opens in the left side of Explorer, covering the usual Explorer bar. Most likely, the bar will look like the example shown in Figure 20-1. You can customize the Search Companion, as you’ll learn later, so yours might look slightly different.
Believe it or not, there are tens of thousands of files on your computer’s hard disk. That’s true even if you’ve never saved a document or downloaded a file in your life, because everything in your computer is on your hard disk. That includes Windows XP and all your installed programs. And those alone make up tens of thousands of files.

We know that everything in your computer is on the hard disk because there simply is no place else in the computer to store things!

Narrowing down your search to the fewest possible matching files is an important part of performing a search. Too broad a search will result in hundreds, if not thousands, of files, which doesn’t do you much good when you’re trying to locate one file.

Anyway, the first step in finding a lost file or folder is to choose one of the following options:

✦ **Pictures, music, or video:** If you know for certain that the file you’re looking for is a picture, a song (music), or video, choose this option. On the next page, choose the exact type of file to search for, either Pictures and Photos or Music or Video.

✦ **Documents (word processing, spreadsheet, and so on):** If the file you’re looking for is some other type of document, such as a file that contains text, an Excel worksheet, or a database, choose this option.

✦ **All files and folders:** If the file you’re looking for doesn’t match any of the preceding descriptions, as when you’re looking for a folder or some program file you downloaded from the Internet but haven’t installed yet, choose this option.

Once you install a program, you should find its startup icon on the All Programs menu. There’s no need to use the Search Companion to go looking for it.

Depending on which of the preceding options you chose, you’ll get a series of additional options. I can’t say exactly which you’ll see, because the Search Companion tries to spoon-feed options to you, based on your previous selections. But as you work your way through the Search Companion, you’ll often see a *Use advanced search options* option. Clicking that will reveal the missing options that the Search Companion is hiding from you. I wish I could make it simpler for you. But once you’ve conducted a few searches, you’ll get the hang of it all.

Anyway, let’s look at the various options that might appear in the Search Companion and how you can use them.

E-mail messages aren’t files or folders. They’re, well, *messages*. And the Search Companion can’t help you find messages. Only the Find option in your e-mail client program can help with that.
Telling Companion About the File Name

If you can remember anything about the file’s name, that would be great. You can fill in the All or part of document name option (Figure 20-2) with whatever information you know. For example, if you’re looking for a letter you wrote to Wilma Wannabee six months ago, there’s a good chance the name Wilma might be in the file name. So you could type that under All or part of file name.

Figure 20-2: Enter all or part of the file name (if you know it) with this option.

If you’re searching for a song, entering any word from the song title, or even the artist’s name, here will help, too.

If, by chance, you happen to know the file’s type and extension, you can enter that, although you’ll have to use the following format:

*.

Here ext is the extension you’re looking for. For example, if you’re looking for a JPEG image (or all JPEG images), you could enter *.jpg. If you’re looking for a document you created in WordPad or Microsoft Word, you could enter *.doc.

If you don’t have a clue what the file name is, or what the extension is, leave this option blank. Guessing here isn’t likely to help.

Tip: If at any time in the Search Companion you change your mind about a previous selection, just click the Back button near the bottom of the Search Companion to return to the previous page and change your selection.

Telling Companion About the File’s Contents

If the file contains written text, and you can remember some word or phrase used in that document, you can enter that in the option shown in Figure 20-3. For example, if you’re looking for a letter you wrote to Hank Higglebottom, the letter might start with Dear Hank. Or if the letter was about an upcoming reunion, you could search for documents that contain the work reunion. Any word or phrase in the file (not necessarily in the file name) will do.

Figure 20-3: If you can think of a word or phrase within the file (not in the file name), enter that here.
Telling Companion Where to Look

The Look In drop-down list, shown in Figure 20-4, tells the Search Companion how much area to search. Most likely, if the file is lost, you’ll want to choose Local Hard Drives (C:). That will be your entire hard disk or even all your hard disks in the (unlikely) event that you have more than one. That choice will certainly cover the most ground and therefore increase your chances of finding the file.

If you think the file is in a specific folder, you can replace Local Hard Drives (C:). But don’t do this unless you’re really sure you can narrow the search to a specific folder on your hard drive.

Telling Companion When You Last Used the File

If the file is one you saved or downloaded recently, you can greatly increase your chances of finding it by giving the Search Companion some clue as to the age of the file. If you don’t see the When was it modified? option, shown in Figure 20-5, you may find it after clicking Use more advanced search options.

If the document you’re looking for is one you definitely worked on within the last week, you should choose the Within the last week option. Optionally, you can choose Specify Dates; then choose Modified Date (the last time you changed and saved the file), Created Date (the date you created the file), or Access Date (the last time you opened the file). Then you can specify a range of dates. For example, if you’re looking for all files you created today, and today’s date is 12/15/04, you’ll choose Specify Dates ➪ Created Dates, and you’ll set the from and to dates both to 12/15/04.

If you really don’t have a clue as to when the file was last saved, last opened, or created, set this option to Don’t Remember.
Telling Companion the Size of the File

It’s unlikely that you’ll ever know, offhand, what the size of the file was. So the options shown in Figure 20-6 are of dubious value. You don’t have to know the exact size, however. For example, let’s say you just downloaded a file and it took a really long time. By virtue of the fact that it took a long time, you can assume the file is large. Likewise, multimedia files, like music and video, tend to be large, while documents that contain only a little text tend to be small. So you can try to narrow the search based on those factors.

If you really have no clue about the file’s size, it would be best to leave this option set to Don’t remember.

More Advanced Options

The More advanced options settings, shown in Figure 20-7, are really a long shot. You should definitely choose Search system folders, Search subfolders, and Search hidden files and folders, because a lost file could be in any one of those. The Case sensitive option isn’t likely to help, unless you think you know the exact upper/lowercase letters of any text you’re searching for. The Search tape backup option would only make sense if you had a tape backup on your computer (not likely).

Starting the Search

Once you’ve answered as many questions as you can, you’re ready to begin the search. Just click the Search button at the bottom of the Search Companion;
then wait a while. You’ll get some feedback in the Search Companion as the search progresses. Any files that match your search criteria will start to appear in the main pane to the right. When the search is complete, you’ll see the files (if any) that matched your search, as the options shown in Figure 20-8.

What you do from here depends on what you’ve got:

✦ If you’ve found what you’re looking for, click Yes, finished searching in the Search Companion.

✦ If you haven’t found what you’re looking for, you can click one of the options to change your search criteria and try again.

Let’s say you’ve completed your search and you click Yes, finished searching. Even though the window is titled “Search Results,” you’re actually in Windows Explorer. As such, you can choose a View, such as Thumbnails, Icons, or Details, using the Views button in the toolbar or the View option on the menu bar.

In Details view, you can sort the results on any column heading. For example, to put the files in alphabetical order by name, click the Name column heading until its little triangle is pointing up. To change the width of a column, drag the bar at the right edge of the column heading. Or scroll over to the right and click the Date Modified heading to order files by the date they were last modified. To add columns to the Details view, choose View ➪ Choose Details from the menu bar.

Figure 20-8: A completed search, with options on the left and found items on the right
At this point, you can do anything you want with any of the files you found. For example:

✦ If scroll bars are visible in the search results window, use them to scroll up and down, left and right.

✦ To open the folder that the file is contained within, click a file name, and click *Open the folder that contains this item* in the Explorer bar. Or right-click the file’s name and choose Open Containing Folder.

✦ To move the file to a different folder, use any technique described in Chapter 19. For example, you can click a file name or select multiple files. Then click *Move this File* or *Move the Selected Items* in the Explorer bar.

✦ To open a file, double-click its name. Or right-click the file name and choose Open With ‡ and the name of the program you want to use to open the file.

Exactly what you do with the found files is entirely up to you. However, having to go searching for a file in the first place implies that you didn’t know where it was. So you might want to move it to a folder that makes sense. For example, if it’s a song, move it to My Music. If it’s a video, move it to My Videos. When you’ve finished working with the Search Results window, just close it as you would any other program window, by clicking the Close button in its upper-right corner.

### Using Search to Gather Up Like Files

Search is good for more than just finding lost files. It’s also a good way to organize your stuff. For example, let’s say you’ve downloaded a bunch of songs or videos from the Internet, but they’re in some weird folder other than the simple My Music or My Videos folder. Or maybe you just want to gather up all your .zip files (compressed files) and put them all together in one folder. Whatever it is you want to gather up, just start a new search and specify what you’re looking for, as in the examples shown in Figure 20-9. (Make sure you choose Local Drives... in *Look In* to search your hard disk, or multiple hard disks, as in the examples.)

After specifying the criteria that define the files you’re looking for and clicking the Search button, the main pane will show all the files. Then choose *Yes, finished searching*. Browse through all the files to make sure you know what you got. If you want to move all those files into one folder, choose Edit ‡ Select All from the menu bar or press Ctrl+A. Then click *Move the Selected Items* in the Explorer bar.
In the Move Items dialog box that opens (see Figure 20-10), navigate to and click the name of the folder to which you want to move the files. (Or navigate to the parent folder and click Make New Folder to create a new folder within that folder.) Once you’ve highlighted the name of the folder to move, click Move, and all the files will be moved.

If you attempt to move a file into the folder in which it’s already located, you’ll see an error message stating that the source and destination are the same. You need to select only those files that aren’t already in the destination folder and move those. If you click the In Folder heading and widen the column, the files will be grouped according to their current folder. Select only those that aren’t in the destination folder, and move them.

**Customizing the Search Companion**

When you first open the Search Companion (by clicking the Start button and choosing Search), you’ll see an option at the bottom that reads Change Preferences. Clicking that option will reveal the options shown in Figure 20-11. Your options are fairly self-explanatory, but here’s a quick review of what each offers (when you click it):
Figure 20-10: About to move all selected files to a folder named My Videos

Figure 20-11: Search Companion options you can change

Clicking Learn more about Search Companion, at the bottom of the bar, will take you to help options for quick reminders or learning more about Search Companion.

✦ With/Without an animated character: Remove the little animated character from the bottom of the Search Companion. (Or add it if you’ve already removed it.)
With a different character: If you do use an animated character, choosing this option will allow you to choose a different character (like Courtney shown in Figure 20-11).

With Indexing Service (for faster local searching): Choosing this option tells Windows to maintain an index of all files and uses that for searching. You won’t see any difference, but searches will take less time.

Change files and folders search behavior: Selecting this option disables step-by-step searches, so that when you start a search, all options are immediately visible.

Change Internet search behavior: You can use the Search Companion to search the Internet as well as your own computer. Choosing this option will allow you to specify a search engine to use.

Show/Don’t Show balloon tips: Turning off balloon tips just turns off the little tips you see on the screen occasionally when using the Search Companion.

Turn AutoComplete off/on: Turning off AutoComplete just prevents Search Companion from guessing what you’re about to type based on things you’ve typed in the past.

If your preferences don’t seem to take effect right away, try closing the Search Results window and restarting it from scratch.

Folder and File Tips and Tricks

In a moment, we’ll be taking a look at some of the more technical aspects of your computer’s hard disk and some techniques for getting the most from it. But before we do, let’s take a look at some optional fun things you can do with files and folders.

Choosing Your Own Folder Icon

The default icon for a folder (the icon that appears automatically when you create a folder) isn’t set in stone. Often, you can choose your own icon. This can be handy when you want a particular folder to stand out, visually, from the crowd. For example, if there’s a folder you use often, and you want its icon to stand out from other folders, you might give it a different icon. To change a folder’s icon, follow these steps:

1. Right-click the icon of the folder you want to change and choose Properties.

2. In the Properties dialog box that opens, click the Customize tab.

3. At the bottom of the Customize tab, click Change Icon. The Change Icon... dialog box, shown in Figure 20-12, opens.
4. Use the horizontal scroll bar beneath the sample icons to scroll through all your options.

5. When you find an icon you like, click it. For example, in Figure 20-12, I chose a folder icon with a checkmark on it. Even that slight change helps the folder stand out.

6. Click OK in the Change Icon dialog box; then click OK in the Properties dialog box.

Near the top of the Change Icon dialog box, under Look for icons in this file, you’re likely to see %SystemRoot%\system32\SHELL32.dll. If you change that to %SystemRoot%\system32\moricons.dll and press Enter, you’ll see a different set of icons to choose from.

You can also create your own custom icons, but there’s nothing in Windows XP that will allow you to do that. You’ll need a third-party icon editor for that. Some examples include IconCool Editor (www.iconcool.com), Icon Maker (www.icon-maker.com), IconXP (www.aha-soft.com), or Buddy Icon Grabber (www.icongrabber.com-http.com). Or you can go to www.tucows.com and search for icon to view a larger selection of programs.

Creating Shortcuts to Favorite Files and Folders

If you have a folder or file that you use frequently, but it’s buried deep within some other folders, you’re likely to get tired of navigating to it over and over again. In that case, you can create a desktop shortcut to the file or folder. The desktop shortcut will be an icon on your Windows desktop. Double-clicking
that icon on the desktop will open the folder or file straightaway, without your having to dig through folders.

To create a desktop shortcut to a favorite file or folder, follow these steps:

1. Navigate to the folder that currently contains the item to which you want to create a shortcut.
2. Right-click the item to which you want to create a shortcut and choose Send To ➪ Desktop (Create Shortcut) as in Figure 20-13.

![Figure 20-13: Creating a desktop shortcut to a folder after right-clicking its icon](image)

That’s all there is to it. You won’t notice anything until you get back to the Windows desktop. (Click the Show Desktop button in the Quick Launch toolbar, or right-click the current time and choose Show Desktop.) The shortcut icon will look like the original icon, but will have a little curved arrow on it, indicating that it’s just a shortcut to the item.

See “Creating Your Own Shortcuts” in Chapter 24 for more information on creating shortcuts.

**Making Views Stick**

As you know by now, you can use the View button on Explorer’s menu bar, or its View menu, to change how icons look within the folder. Normally, the view you chose only lasts while the folder is open. If you close the folder, and reopen it later, it opens in its default view (that is, the view that Windows thinks
is best for that folder). If you want to make the views you choose stick, you need to tell Windows to remember each folder’s previous view. Here’s how:

1. Open My Documents (or any folder, for that matter).
2. Choose Tools ➪ Folder Options from Explorer’s menu bar. The Folder Options dialog box opens.
3. In the Folder Options dialog box, click the View tab.
4. Scroll down to and select (check) the *Remember each folder's view settings* option, as in Figure 20-14.
5. Click OK.

![Figure 20-14: The View tab of the Folder Options dialog box](image)

**Managing Your Hard Disk**

OK, it’s time to get into some technical stuff regarding what’s really going on behind the scenes on your computer’s hard disk. First, your computer’s hard disk (also called a *hard drive*, *fixed disk*, or *primary drive*) lives inside the system unit, so you never actually see it. All drives on your computer have a short, one-letter name followed by a colon (:). The name of your hard disk is C:. If your computer has multiple hard disks, they may be named D:, E:, F:, or anything up to Z:.

While you can’t see your hard drive directly, you can see its icon in My Computer. To open My Computer:
Click the Start button and choose My Computer.

Or double-click the My Computer icon on your desktop (if you have one).

Your My Computer folder will open. I can’t say exactly what you’ll see in that folder, as it depends on what kinds of disk drives you have in your computer, as well as other things. But if you scroll down, you’ll see an icon for every disk drive in your system, perhaps looking something like the example shown in Figure 20-15. In that example, the hard disk is named Local Disk (C:). (The other icons represent other disk drives, which you’ll learn about in Chapter 21.)

![My Computer](image)

**Figure 20-15:** Examples of icons for disk drives in My Computer

If you don’t see the Hard Disk Drives and Devices with Removable Storage headings in your My Computer folder, choose View ➤ Arrange Icons By ➤ Show in Groups from the menu bar in My Computer.

### Discovering How Much Hard-Disk Space You Have

One thing that you definitely want to know about your computer is how much space is available on your hard disk. Beginners often waste a lot of time and money by constantly moving files to floppy disks and other removable media, in an effort to conserve hard-disk space. You really don’t need to worry about that until you really understand how much storage space you have.

For starters, you need to understand that the storage capacity of a drive is measured in bytes, where one byte equals roughly the amount of space needed to store a single character of text, like the letter x. For example, it takes three bytes to store the word *cat* and six bytes to store the word *banana*. Most drives can store millions or billions of bytes.
Because most disks store huge numbers of bytes, nobody ever bothers with saying things like “I have 20,545,642,321 bytes of hard disk space available.” It’s much easier to round these big numbers off to the nearest thousand, million, or billion. And we use some short names and abbreviations for those words, too, as shown in Table 20-1.

<table>
<thead>
<tr>
<th>Bytes</th>
<th>Name</th>
<th>Abbreviation</th>
<th>Word</th>
<th>Spoken Slang</th>
</tr>
</thead>
<tbody>
<tr>
<td>1,000</td>
<td>Thousand</td>
<td>KB or K</td>
<td>Kilobyte</td>
<td>kay</td>
</tr>
<tr>
<td>1,000,000</td>
<td>Million</td>
<td>MB or M</td>
<td>Megabyte</td>
<td>meg</td>
</tr>
<tr>
<td>1,000,000,000</td>
<td>Billion</td>
<td>GB or G</td>
<td>Gigabyte</td>
<td>gig</td>
</tr>
<tr>
<td>1,000,000,000,000</td>
<td>Trillion</td>
<td>TB or T</td>
<td>Terabyte</td>
<td>tee</td>
</tr>
</tbody>
</table>

The numbers in Table 20-1 are rough. A kilobyte is actually 1,024 bytes. A megabyte is 1,048,576 bytes (1,024 x 1,024). But if you just remember that each new word adds another 1,000 to the previous number, that’s close enough.

Every disk has an overall capacity, which is the number that describes how many bytes the disk can hold. Your hard disk already has lots of files on it — most of the files that make up Windows XP and your installed programs. Each of those files takes up space. Every document on your hard disk also takes up space, used space. Any space that isn’t already used is yours to do with as you please. We call that free space or available space. To find out the capacity of your hard drive, and how much hard disk space you have available (free space), follow these steps:

**STEPS: Find Out How Much Hard Disk Space You Have**

1. If you haven’t already done so, open your My Computer folder (click the Start button and choose My Computer).
2. Right-click the icon for your hard disk and choose Properties.
3. If the General tab isn’t visible automatically, click the General tab.

The pie chart that appears (Figure 20-16) shows you, at a glance, how much hard disk space is currently being used and how much is still available. Most likely, you’ll have billions of bytes (gigabytes) of each. What that works out to in terms of things in the real world is something you really have to be flexible in estimating. But Table 20-2 shows some examples of what one gigabyte (1GB) represents in terms of what you can store, with some empty columns you can fill in for yourself if you like.
Table 20-2
How Many Things You Can Store in One Gigabyte of Disk Space

<table>
<thead>
<tr>
<th>Familiar Thing</th>
<th>How Many Times Your Free Space Equals</th>
<th>How Many You Can Store</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type, double-spaced pages</td>
<td>500,000 x</td>
<td></td>
</tr>
<tr>
<td>Photos</td>
<td>2,500 x</td>
<td></td>
</tr>
<tr>
<td>CD-Quality songs</td>
<td>200 x</td>
<td></td>
</tr>
</tbody>
</table>

For example, if you fill in the Free Space in the third column with the amount of gigabytes available on your hard disk, and multiply that by the number in the second column, that’ll give you a rough estimate. For example, if you have 30GB of space left, that comes out to $200 \times 30$, or enough space for about 6,000 CD-quality songs.

If you did need more hard disk space, adding a second hard drive is usually inexpensive. In fact, hard disk space is one of the least expensive things on Earth. A 60GB hard disk would probably cost you about $90$ to $100$. Ain’t nothing else you can buy 60 billion of for that kind of money. I’ll bet 60 billion grains of dirt cost more than $100$. Sixty gigabytes worth of floppy disks would probably cost you about $30,000$ and fill a two-car garage.

Figure 20-16: The General tab of a hard drive’s Properties dialog box
Maintaining Your Hard Disk

Besides being cheap, your computer’s hard disk is virtually maintenance free. You don’t ever have to touch the actual disk or do anything to it. But there are some things you can do in Windows XP to avoid wasting disk space and keep your hard drive working at its highest possible speed and efficiency. We’ll take a look at those things in this section.

Recovering Wasted Hard Disk Space

Because hard disk space is cheap and plentiful, some programs take liberties in creating temporary files that aren’t really essential to the proper functioning of your computer. Your Web browser is a good example, because it keeps copies of every Web page you’ve visited recently (and even not so recently) sitting around in a folder known as your temporary Internet cache. Other programs may occasionally create temporary files of their own and let them hang around the hard disk longer than is really necessary.

With time, these things can build up and start using up a fairly significant amount of disk space. Plus, they all add up to just more files for Windows to keep track of behind the scenes, which means slightly less performance (speed-wise) from your hard disk.

Even if you’re not running low on hard disk space, it can’t hurt to do some occasional spring cleaning and unload some unnecessary junk. By occasionally, I mean maybe once a month at most. But you can do your spring cleaning whenever you feel like it. It’s easy to do and usually takes only a few minutes. Here’s the procedure:

**STEPS: Clean Up Your Hard Drive**

1. Open My Computer (if it isn’t already open).
2. Right-click the icon for your hard drive and choose Properties.
3. On the General tab, click the Disk Cleanup button.

Wait while Windows analyzes the disk and figures out how much space it will be able to free up. When the Disk Cleanup dialog box shown in Figure 20-17 opens, you can scroll through the list of files to delete to see what kinds of temporary files are available to delete. There’s absolutely nothing in the list that’s required to make your computer work properly. And none of the documents you created or downloaded will be included in the list. Basically, the list only shows junk you can get rid of.

Recycle Bin will be one of the items in the list. If you haven’t looked in the Recycle Bin option, you can click that option; then click View Files to see
what’s in there. If you find any files you might have deleted accidentally, you’ll want to restore them (as described in the previous chapter) before allowing Disk Cleanup to delete them permanently.

Anyway, if you want to clean up all the junk, you can select all but the last two options. Those last two options don’t actually delete anything. The Compress Old Files option, if selected, will just tell Windows to shrink down any files you haven’t used in a long time, so they take up less space. They automatically uncompress when you open them. But opening the file will take a little longer than usual. (No big deal if it’s a file you rarely use.)

The Catalog Indexer option, if selected, keeps the index of files we originally discussed in Chapter 19 up to date with the current state of affairs on your disk — after all the junk has been deleted. No harm in choosing that option. It won’t really change the contents of your disk in any way. It will just make your Search Companion searches go a little faster.

Once you’ve selected the items you want to delete, just click the OK button. You’ll see an *Are you sure?* prompt. Click Yes and wait a while as Windows does its cleaning. The dialog box will close automatically when the job is complete.

Because the temporary files are eating up so little disk space, percentage-wise, you probably won’t notice any dramatic change in the amount of free space available after you clean the drive. But still, it’s better not to have too much extra junk hanging around for no reason. Running Disk Cleanup once a month or every couple months is probably sufficient for keeping any significant about of junk from accumulating on your hard drive.
Scanning the Disk for Errors

Your hard disk spins at a walloping 7,200 to 10,000 RPM, all the while the head that reads and writes data to the drive is zipping across its surface not more than a few molecules’ distance away from its surface. With so much activity, it’s not unusual for an occasional little hiccup to occur. These usually go by unnoticed. But they, too, can accumulate in the form of bad links and bad sectors. If enough of them accumulate, the speed at which you’re able to move data to and from the disk can diminish.

If you scan your hard disk for errors two to four times a year (or whenever your hard disk seems to be running slowly), you can clean up the little blemishes and get the disk back to running at peak performance. Scanning the disk takes a few minutes, and you can’t use the computer for anything else while the program is running. So you might want to plan on doing a scan when you can leave the computer unattended, but running, for a while. Doing the scan is easy.

STEPS: Scan Your Hard Disk for Errors

1. Open your My Computer folder if it isn’t already open (click the Start button and choose My Computer).
2. Right-click the icon for your hard drive and choose Properties.
3. In the Properties dialog box that opens, click the Tools bar.
4. Under Error checking, click Check Now.
5. For maximum cleanup, select (check) both checkboxes.
6. Click the Start button.
7. If you see a message indicating that the disk check couldn’t be performed because the program needs exclusive access to the disk, that’s normal. Choose Yes to proceed.
8. Click OK in the dialog box.
9. Close all open programs and save any unsaved work.
10. Click the Start button and choose Turn Off Computer ➤ Restart.

You can go catch up on your phone messages and paper mail or anything else you’ve been neglecting since you got your computer. This is going to take some time (maybe a half-hour or more). The screen will initially be blue when the computer restarts and will display the progress of the scan. When the scan is complete, Windows will boot up normally, and everything will be normal.

Defragmenting Your Hard Drive

Whenever you delete a file, Windows makes the space it was using available to new files you save. If a file you’re about to save is too big for one of the empty spaces available, Windows might divide up the file into several different old
deleted files’ old space. While this is not problem, it can get to a point where you have a lot of little chunks of files spread all over the disk.

When that happens, the drive head has to move around a lot more to read and write files. You might even be able to hear the drive chattering when things get really fragmented (spread out). This puts some extra stress on the mechanics of the drive and also slows things down a bit.

To really get things back together and running smoothly, you can defragment (or defrag for short) the drive. When you do, Windows takes all the files that are split up into little chunks and brings them all together into single files again. It also moves most files to the beginning of the drive, where they’re easiest to get to. The result is a drive that’s no longer fragmented, doesn’t chatter, and runs faster.

Defragmenting is one of those things you don’t really have to do too often. Two to four times a year is probably plenty. It could take an hour or more, during which time you don’t want to use the computer. So you have to plan ahead a little on this one.

For the ultimate in hard drive performance tuning, do the maintenance tasks in the order described in this section. First, clean up the hard disk to get rid of any unnecessary junk. Then do your error-checking to fix any little blemishes. Then defragment what’s left so everything is perfectly arranged for quick and easy access by your computer.

**STEPS: Defragment Your Hard Disk**

1. Open your My Computer folder.
2. Right-click the icon for your hard drive (C:) and choose Properties.
3. In the Properties dialog box that opens, click the Tools tab.
4. Click the Defragment Now button. The Disk Defragmenter program opens.
5. Click the Analyze button. The program will analyze your hard disk to see how much it’s fragmented.
6. When the analysis is done, you’ll see a dialog box like the one in Figure 20-18, telling you either that you should, or need not, defragment the drive.

Figure 20-18: Sample message displayed after a defrag analysis
When it says you don’t need to defragment, that doesn’t mean you can’t or shouldn’t. It just means the drive’s not badly fragmented. But you can still defragment it and make it unfragmented!

7. To defrag the drive, click the Defragment button. Otherwise, you can click Close to skip it.

This is the part that could take an hour or more, during which time you can’t use the computer. You may hear a lot of disk chatter as defrag is doing its things. That’s because the drive head is moving things around to get everything into a better position. You can see a graphical presentation of this as it’s proceeding on the screen, as in the example shown in Figure 20-19.

![Figure 20-19: Defrag in action](image)

Defrag will defragment all the fragmented files and move a lot of files to the beginning of the disk, where they can be accessed in the least time with the least effort. Some files won’t be moved. That’s normal. If Windows decides to leave them where they are, it’s for good reason. When defrag is finished, you can just close any open dialog boxes and the Disk Defragmenter program window.

**Exploring Your Hard Disk**

You’ve seen several examples of folders on your hard disk in previous chapters. My Documents, My Pictures, My Music, and My Videos are all examples of such folders. Windows automatically creates those folders for you so you have places to store your documents. But those aren’t the only folders on your hard disk, not by a long shot. There are lots more.
Like all disks, folders on your hard disk are organized in a hierarchical manner, with folders inside of folders. The hierarchical organization lets you find things by drilling down from the general to the specific. The highest-level folder is called the root folder (or root directory), and its name is simply a backslash (\). For example, C:\ refers to the root folder of drive C:

The root folder contains several folders. Each of those folders, in turn, contains more folders. And so it can continue, many folders deep. While no two hard disks will be exactly alike, the typical arrangement of folders on a new installation of Windows XP would likely look something like Figure 20-20.

The diagram shown in Figure 20-20 is just a representation of how the folders are arranged. You won’t actually see a folder arrangement like that on your screen. And your folders probably won’t match those exactly. But you can browse around and see what's available on your hard drive by using the folder list in Windows Explorer. You can open, or close, the folder list in Explorer at any time by clicking the Folders button in Explorer’s toolbar or by choosing View ➪ Explorer Bar ➪ Folder from its menu bar.

Figure 20-20: Sample hierarchical arrangement of top-level folders on a hard disk
If you’re starting from the Windows desktop, you can follow these steps to start exploring your hard disk:

1. Open My Computer (click the Start button and choose My Computer).
2. Double-click the icon for your hard drive, usually Local Disk (C:).
3. Click the Folders button in My Computer’s toolbar, or choose View ➪ Explorer bar ➪ Folders.

   **Tip**

   To change the width of the Folders list, drag to the left or right the bar that separates the folder list from the main pane on its right. You can use the + and – signs that appear next to a folder name to show/hide subfolders within the folder.

4. In the folder list, click the icon for your hard drive (usually Local Disk C:).
5. If you see a + sign next to that icon, click it to expand it and to see the subfolders contained within it.

   **Tip**

   You can right-click any folder name in the Folders list to get to the usual options (Rename, Delete, Copy, and so forth).

The pane on the right always shows the contents of whatever icon you click in the Folders list. When you click the icon for your hard disk, you actually see folders in C:\, the root folder of drive C:. If you click the + sign next to the drive’s icon, you’ll see those same folders listed beneath the drive’s icon, as in Figure 20-21.

To view the contents of any folder or drive, click its name in the Folders list. The contents appear in the main pane on the right. As always, you can choose a view for the main pane by using the Views button in the toolbar or the View menu. To arrange icons in the main pane, choose View ➪ Arrange icons by from the menu bar, or right-click any space between icons, or click any column heading in Details view.

   **Tip**

   You can use the Folders list to move and copy files. Click the name of the source folder in the Folders list to view its contents in the main pane. Then right-drag any item from the right pane to the destination folder’s icon in the Folders list. Release the mouse button and choose Move Here or Copy Here from the menu that appears.

**A Note on User Accounts, Documents, and Settings**

Before we dig any deeper into the folders on your hard disk, you first need to understand a little about user accounts. We cover those in depth in Chapter 23. But for now, it’s sufficient to know that your computer currently has at least two user accounts on it. One is named All Users, and that account actually contains things accessible to all other user accounts on the computer.
A second user account has the same name as your user name. To see what your user name is, click the Start button and look at the top of your Start menu. If Windows came preinstalled on your computer, your user name is probably something generic, like Owner or Administrator. If someone set up a user account for you, your user name might be the same as your first name. On my computer, my user name is Alan.

A document, as you know, is something you create or download from the Internet. Examples include things such as typed text documents, pictures, photos, songs, and video clips. A setting is a personal preference, like the picture that covers your Windows desktop or the specific screen saver that pops up when your computer has been idle for a while.

So now, given all of that, here’s what the three highest-level folders in the root folder of your hard drive represent:

- **Documents and Settings**: Contains a subfolder for the All Users account, another subfolder for your user account, plus another folder for each additional user account you create. In Figures 20-20 and 20-21, the subfolder named Alan contains documents and settings for me. The subfolder named All Users contains documents and settings available to everyone who has a user account on the computer.
Program Files: Most programs you installed will automatically be put in your Program Files folders. Each program will usually be placed in its own subfolder within the Program Files folder. Windows and your programs manage all files and subfolders within Program Files automatically. There’s really nothing in there for normal humans. And unless you have some specific need to go in there, it’s best just to stay out of the folder.

Caution Never move, copy, delete, or rename a folder or file within the Program Files or Windows subfolders. Doing so could have disastrous consequences that would require reinstalling Windows or whatever program(s) you damage.

Windows: The Windows folder (perhaps named WINNT on some computers) contains all the files and subfolders that make up your Windows XP operating system. These are sometimes called system folders and system files, because they contain the computer’s operating system (Windows XP). Windows manages these subfolders and files on its own — there’s no reason for you to get involved in that at all. Just stay out of this folder, unless you really know what you’re doing and have some reason to go in there.

Simple Names and Paths

Every folder and file has a path that describes its exact location within the computer. Most of the time, Windows hides the lengthy, technical-looking path from you and instead shows only the simple name of the folder. For example, My Documents, Shared Documents, My Pictures, and Shared Pictures are all examples of simple names.

What the Heck Is a Processor?

Every computer has a microprocessor (or processor, for short) that is, in essence, the actual computer. The processor isn’t in or on any disk drive. It’s its own separate piece of hardware. If you looked at it, you wouldn’t see much, because it’s small enough to easily fit on your thumbnail. But if you looked at it with a really powerful microscope, you’d see that it contains millions of microscopically small switches and wires.

It’s called the processor because it’s the thing that actually processes (performs) your every request. When you tell the computer to do something, via your mouse or keyboard, it’s the processor that first gets that command and carries out your wishes. Examples of processors include the Intel Pentium, The Intel Celeron, and the AMD Athlon.

The speed of a processor is measured in how many instructions it can perform in one second. That’s usually expressed in Megahertz (MHz) or Gigahertz (GHz). 1 MHz equals one million (1,000,000) instructions per second. 1 GHz equals one billion (1,000,000,000) instructions per second.
A path is much longer than a simple name. The path tells the processor exactly how to get to a given file or folder, starting with the drive and working down through folders and subfolders. For example, the path to a file named MyStuff.doc currently stored in your Shared Documents folder would look like this:

C:\Documents and Settings\All Users\Documents\MyStuff.doc

When the processor receives the instruction to open the file at that location, it can follow the path to the file without even the slightest chance of a mistake. The path tells the processor, “Go to the hard drive (C:\), and look in its root folder (\). From the root folder, drill down through the folders named Documents and Settings, All Users, and Documents. In that last folder, you’ll find a folder named MyStuff.doc. Open that folder up and put it on my screen.”

We humans don’t need quite so much detail. It’s just easier for us to think of MyStuff.doc in Shared Documents than it is to think of C:\Documents and Settings\All Users\Documents. So Windows just shows us the simple names for folders. You can see their names in the Folders list even when your hard disk’s subfolders are hidden, as on the left side of Figure 20-22. So there’s really no need to go digging around through the hard drive to get to those folders. But if you do expand subfolders under your hard drive’s icon, the folders will be visible there as well, as in the right side of Figure 20-22.

Figure 20-22: Hard drive subfolders hidden (left) and expanded (right)
If you don’t see simple folder names in your Folder list, you need to change one little setting. Choose Tools ➪ Folder Options from Explorer’s menu bar. In the Folder Options dialog box, click the View tab. Make sure Display simple folder view in Explorer’s Folders list is selected (checked); then click OK.

So I guess the next question is, “What’s the advantage of digging down through folder names to on the hard drive to get to those folders?” The answer is, “There is none.” The simple names are always displayed in the Folders list as a convenience to you — so you don’t have to go digging. If you want to go digging, you can. But there really is no need to, unless you plan to go digging through some other user’s documents. But let’s hold off on that tidbit of info until we get to Chapter 23, where we’ll discuss user accounts in depth.

A good general advantage to the Folders list is this: You can view the contents of any folder with minimal digging around. You just click the name of the folder, or even disk drive, whose contents you want to view in the Folders list. The contents appear in the main pane right away. (You may have to click the + sign next to some folders that aren’t expanded just to see the names.)
Viewing the Path

Windows hides paths from you because the average computer user really never needs to see them. The average computer user can get by with only knowing about My Documents, My Pictures, and so forth. But there’s no rule that says you’re not allowed to view the paths to files and folders. In fact, there are a couple simple settings in Windows Explorer that you can use to make the current folder’s path visible in Explorer’s title bar or Address bar whenever you want. Personally, I prefer to always see the simple name in the title bar. Then use the Address bar as sort of an optional thing for viewing paths on an as-needed basis.

To make the Address bar in Windows Explorer display the path to the current folder, follow these steps:

1. From Explorer’s menu bar (in any folder), choose Tools ➪ Folder Options.
2. In the Folder Options dialog box, click the View tab.
3. Select (check) the Display the full path in the address bar option.
4. Click OK.

If the Address bar isn’t visible in Explorer, you’ll need to make that visible too. To turn the Address bar on, or off, choose View ➪ Toolbars ➪ Address bar from Explorer’s menu bar. You should see the Address bar just under the toolbar, as in the example shown in Figure 20-21 (where it’s showing C:\ because the main pane is showing the contents of the root folder on drive C:).

Summary

That’s should be enough information about your computer’s hard disk to hold you over for quite some time. Here’s the standard recap of the main points covered in this chapter:

✦ When you lose a file or folder on your hard drive, you can use the Search Companion to go looking for it.
✦ To start the Search Companion, click the Start button and choose Search. Or click the Search button in the Windows Explorer toolbar.
✦ To change the icon for a folder, right-click the folder’s icon and choose Properties. Then click the Customize button in the Properties dialog box that opens.
✦ To create a desktop shortcut to a folder, right-click the folder’s icon and choose Send To ➪ Desktop (Create Shortcut). The same technique works for documents and programs on the All Programs menu.
✦ To make Windows Explorer remember each folder’s previous view, choose Tools ➪ Folder Options from its menu bar. Click the View tab and select (check) the Remember each folder’s view settings option.
To view the icons that represent disk drives in your computer, click the Start button and choose My Computer.

To clean up, scan, or defragment your computer’s hard drive, right-click the drive’s icon in My Computer and choose Properties. Use buttons on the General and Tools tab for hard disk maintenance.

A folder or file’s path describes the item’s exact location.
Using Floppies, CDs, and DVDs

In addition to your computer’s hard disk, you can use files stored on removable media. The disk drives for removable media are plainly visible on the front of your computer (or perhaps the sides, if it’s a notebook computer). These are called removable media because you can put disks into the drives and remove them from the drives.

You may already be familiar with some types of removable media, such as floppy disks, CDs, and DVDs. If not, don’t worry about it. You will be by the time you finish this chapter.

One of the first things you need to understand about removable media is that it’s virtually impossible to copy your entire hard disk to a single floppy disk or CD. That’s because the capacity of removable disks is generally much less than the capacity of your computer’s hard disk.

For example, if you envision various types of disks as filing cabinets, your hard drive would be several rows of filing cabinets, as in Figure 21-1. A DVD would be a good-sized filing cabinet. A CD would be a decent-sized cabinet. A floppy disk, whose capacity is so limited, wouldn’t even count as a whole filing cabinet. Its capacity is more along the lines of one manila-file folder inside a cabinet. Hence, the floppy in Figure 21-1 doesn’t even get a whole filing cabinet as its picture.
Table 21-1 lists the capacities of various types of removable media in terms of bytes, the usual method for specifying how much information a disk can hold. (Recall that a byte is the amount of storage space required to store one character, like the letter *a* or the letter *q*.)

### Table 21-1
**Capacities of Various Types of Removable Disks**

<table>
<thead>
<tr>
<th>Name</th>
<th>Capacity</th>
<th>Bytes</th>
<th>Bytes (English)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVD</td>
<td>4.7GB to 9.4GB</td>
<td>4,700,000,000 to 9,400,000,000</td>
<td>4.7 billion to 9.4 billion</td>
</tr>
<tr>
<td>CD</td>
<td>650MB to 700MB</td>
<td>650,000,000 to 700,000,000</td>
<td>650 million to 700 million</td>
</tr>
<tr>
<td>Zip/Jaz</td>
<td>100MB to 1,000MB</td>
<td>100,000,000 to 1,000,000,000</td>
<td>100 million to 1 billion</td>
</tr>
<tr>
<td>Floppy</td>
<td>1.4MB</td>
<td>1,400,000</td>
<td>1.4 million</td>
</tr>
</tbody>
</table>

**Figure 21-1**: Relative storage capacities of different types of disks

Table 21-1 lists the capacities of various types of removable media in terms of bytes, the usual method for specifying how much information a disk can hold. (Recall that a byte is the amount of storage space required to store one character, like the letter *a* or the letter *q*.)

### Table 21-1
**Capacities of Various Types of Removable Disks**

<table>
<thead>
<tr>
<th>Name</th>
<th>Capacity</th>
<th>Bytes</th>
<th>Bytes (English)</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVD</td>
<td>4.7GB to 9.4GB</td>
<td>4,700,000,000 to 9,400,000,000</td>
<td>4.7 billion to 9.4 billion</td>
</tr>
<tr>
<td>CD</td>
<td>650MB to 700MB</td>
<td>650,000,000 to 700,000,000</td>
<td>650 million to 700 million</td>
</tr>
<tr>
<td>Zip/Jaz</td>
<td>100MB to 1,000MB</td>
<td>100,000,000 to 1,000,000,000</td>
<td>100 million to 1 billion</td>
</tr>
<tr>
<td>Floppy</td>
<td>1.4MB</td>
<td>1,400,000</td>
<td>1.4 million</td>
</tr>
</tbody>
</table>
Why Use Removable Disks?

When it comes to using a computer, in general, the idea is to use your hard disk to store Windows, all your installed programs, and all your documents. In other words, the idea is to use your hard disk to store everything. I suppose this might lead one to wonder why there’s a need to have removable disks. In general, you use removable disks for distribution and backups only, as summarized here:

✦ **Distribution:** To copy files to send somebody through regular mail or to copy files from one computer to another when e-mail or a network transfer isn’t possible. CD-R and DVD-R disks can be used to make disks that play in regular (noncomputer) stereos and DVD players.

✦ **Backup:** To make extra copies of important files on your hard disk, in case a serious hard disk crash (or incompetent file deleting) destroys the original files.

Exactly how you use removable disks depends on what type of disk you’re using. But we can break it down into two basic categories:

✦ **Magnetic media:** Floppy disks, Zip disks, Jaz disks (and even your hard drive) are examples of magnetic media, in that they use magnetism as the means of storing data. (Your hard disk is a magnetic disk, too.)

✦ **Laser media:** CDs and DVDs are laser media, in that they use laser light as the means of storing and retrieving data.

The techniques for using the two different media types are the same in some ways but different in other ways. So we’ll look at each type of media in the sections that follow.

Since Zip disks and Jaz disks are virtually the same thing, I’ll lump them together for the rest of this chapter and just refer to both types as Zip disks.

Each disk drive in your computer has an icon in My Computer. In your My Computer folder, drives that support removable disks are listed under Drives with removable media, as in the example shown in Figure 21-2. When it comes to disk drives, not all computers are created equally. If your computer happens to have a CD drive, a DVD drive, a floppy drive, and a Zip drive, your My Computer folder might show icons similar to those shown in Figure 21-2. (You can open My Computer by clicking the Start button and choosing My Computer.)

Like your hard disk, which is named C:, disk drives that support removable media have one-letter names. For example, your floppy disk drive is named A:. A second floppy (which is rare) would be B:. Additional drives could be named D:, E:, F:, and so forth, up to Z:. 
Figure 21-2: Some examples of icons that represent disk drives that support removable media (under the second heading)

If you double-click the icon for a drive that supports removable media, and no disk is in that drive at the moment, you’ll just get an error message similar to the one shown in Figure 21-3. There’s nothing to do there but click the Cancel button. However, if you insert a disk into the drive and double-click the drive’s icon, Windows Explorer will show you the contents of that disk. As always, folders on the disk (if any) will be represented by icons that look like manila file folders. Files on the disk will be represented by other icons.

Figure 21-3: Error message that appears when you attempt to read the contents of an empty disk drive

Using Floppy Disks and Zip Disks

Just about every desktop PC has a floppy disk drive. Relatively few have Zip drives (although anybody can purchase a Zip drive and connect it to a computer). Floppies and Zip disks are similar in that they’re both magnetic media. That is, they use magnetism to store data. The only real difference between a floppy disk and a Zip disk is in the capacity of the disks. Floppies can hold very little information. A single Zip disk can store the equivalent of anywhere from 100 to 1,000 floppy disks.
Viewing the Contents of Floppy and Zip Disks

To use a floppy disk or Zip disk, you first need to insert one into the floppy or Zip drive, respectively, of your computer. Make sure that you insert the disk correctly, as indicated by the arrow in Figure 21-4.

![Figure 21-4: Always insert floppy and Zip disks top-side up, with the sliding door first.](image)

After you’ve inserted the disk into its drive, wait a moment to see if a window opens on your screen automatically. If such a window does open, it will be Windows Explorer. If that happens, skip the paragraph and steps that follow.

If nothing happens after you insert the disk (as is usually the case with floppy disks), follow these steps to view the contents of the floppy disk:

1. Open your My Computer folder (click the Start button and choose My Computer).
2. Double-click the icon that represents the drive into which you just inserted the disk.

Windows Explorer will open and show you the contents of the disk. Folders and files will be displayed using the standard icons — manila file folder icons for folders, other icons for files. If the disk is empty, the main pane in Windows Explorer will be empty. If the disk hasn’t been formatted yet, you’ll need to format it before you can use it at all.

Formatting a Disk

Magnetic disks often need to be formatted before you can use them for the first time. That’s not to say you need to format every disk. Nor do you need to format a disk each time to you intend to use it. To the contrary, you format unformatted disks only (not preformatted disks, nor disks that already contain files). And even if you do need to format a disk, you need only do that once.
Never format your hard disk. Never format a floppy or Zip disk that already has information on it. If you do format such a disk, the information on the disk will be permanently erased, and there will be no way to undo that mistake.

It’s easy to tell if a magnetic disk is already formatted or not. When you attempt to view the contents of a disk that hasn’t been formatted, you’ll see an error message similar to the one shown in Figure 21-5.

![Figure 21-5: Error message indicating an unformatted floppy or Zip disk in the drive](image)

The first three options are largely informative, and there’s rarely any reason to change those. If in doubt, leave them alone. The Volume Label option is yours to do with as you please. You can type a brief label there (up to 11 characters). That label will appear next to the drive’s icon in My Computer whenever you insert the disk into the drive.

Select the Quick Format option only if you’re reformatting (erasing) a disk that already contains data. The Enable Compress option will be available only on certain types of disks and only if you choose NTFS from the File System option near the top of the dialog box. The Create an MS-DOS startup disk option, available only on floppies, will create an Emergency boot disk. Such a disk allows an expert to start the computer from the floppy disk drive even if the hard disk is damaged. If you select that option, you won’t be able to put anything else on the floppy disk.

After choosing your options (or leaving them all alone, as is the more likely scenario), click the Start button. You may see a repeat of the warnings I’ve been giving you (that the entire disk will be erased). Assuming you understand that and are ready to proceed, click the OK button. Then just wait as Windows formats the disk. When formatting is done, you’ll see a message to that effect. Click the OK button in that message box. Then click the Close button in the Format dialog box. This time, when you double-click the drive’s icon, you’ll see an empty Explorer window on your screen. (It’s empty because the disk is formatted but still blank.) You can move or copy a file (or files) to the disk by using techniques described in the next chapter.
Copying Files to Floppy and Zip Disks

Copying files to Zip and floppy disks is virtually identical to copying files from one folder to another. You just have to know how much stuff you’re about to copy to the disk, because the capacity of the disk will be limited (very limited, in the case of a floppy). To see exactly how much space is currently available on a Zip or floppy disk, follow these steps:

**STEPS: Copy Files to a Floppy or Zip Disk**

1. If you haven’t already done so, insert the disk you want to copy files to and open My Computer.
2. Right-click the icon that represents the drive into which you just inserted the disk and choose Properties.
3. In the Properties dialog box that opens, the numbers next to Free Space show you how much space is available on the disk. For example, a brand new floppy disk with no files on it yet will offer about 1,457,664 bytes, or roughly 1.38MB, of space.
4. Click OK in the Properties dialog box to close that dialog box.

The next step is to open the source folder — the folder that currently contains the files you want to copy to the disk. Presumably, this will just be some folder on your hard disk that you can navigate to by opening your My Documents folder and by using the standard Windows Explorer techniques to navigate to the folder.

**Finding the Combined Sizes of Multiple Files**

Once you can see the icons for the items you intend to copy to the disk, you need to select those icons. Use any technique described in the section “Working with Multiple Files and Folders” in Chapter 19 to select the files and folders you wish to copy. To see how many bytes it’s going to take to store those files, follow these steps:

1. Right-click any selected icon and choose Properties.
2. In the Properties dialog box that opens, look at the number next to Size on Disk.
3. Click the Cancel button in the dialog box.

Figure 21-6 shows an example where I select several pictures in my My Pictures folder and am currently looking at their combined sizes. Since the total is less than 1.4MB, I could fit these files on a single floppy.

If you selected more files than there’re room for on the disk, you’ll need to select fewer files and try again. After you’ve selected the files you want to copy
(but not more than can fit on the disk), use whichever technique given here is most convenient to copy the files to the disk:

✦ Click Copy the Selected Icons in the Explorer bar; then click the icon of the drive in which the floppy or Zip disk is located (Figure 21-7).

✦ Right-click any selected icon and choose Move To. Then click the name of the disk drive to which you to copy the files.

✦ Drag any selected item to drive’s icon in the Folders list.

✦ Drag any selected icon to the drive’s icon in your My Computer folders.

✦ In My Computer, open the icon that represents the floppy or Zip drive; then drag any selected icon into the Explorer window that opens.

Tip
Here I’m assuming you want to copy the files to the floppy or Zip disk, because that’s usually the case. The only time you need to move files to a floppy or Zip disk is when you’re running seriously low on disk space (have less than 1GB of hard disk space left). If you do want to move the files to the disk, you can click Move the selected items in the Explorer bar, or drag the items to the drive’s icon using the right mouse button rather than the left.

Figure 21-6: Viewing the combined sizes of multiple selected files in a folder
Copy Files from a Floppy or Zip Disk

To copy files from a floppy or Zip disk to a folder on your hard disk, follow these steps:

1. Insert the disk that contains the files you want to copy into the floppy or Zip drive of your computer.

2. If the disk’s contents don’t appear automatically, click the Start button and choose My Computer. Then double-click the icon that represents the drive into which you just inserted the disk.

3. In the Explorer window displaying the contents of the disk, select the files or folders you wish to copy using any of the standard selection techniques (as discussed in the section “Working with Multiple Files and Folders” in Chapter 19).

4. Do whichever is most convenient for you at the moment:

   • Click Copy the selected items in the Explorer bar. Then click the name of the folder to which you want to copy the items. For example, in Figure 21-8, I’m about to copy some files to my My Pictures folder.

   • If you specifically want to copy the files to your My Documents folder, right-click any selected icon and choose Send To ➪ My Documents.

   • Navigate to, then open, the folder to which you want to copy the files. Then drag any selected file into that folder.

Once the files are copied, you can remove the disk from its drive and store it as a backup. When you open the folder to which you copied the items, you’ll
see their icons. If you don’t see the icons, choose View ➪ Refresh from that folder’s menu bar to bring Explorer up to date with the folder’s current contents. If the items are out of order, choose View ➪ Arrange Icons By ➪ Name from the menu bar, or right-click any empty space between icons and choose Arrange Icons By ➪ Name.

![Copy Items](image)

**Figure 21-8:** About to copy files from a floppy or Zip disk to the My Pictures folder

### Write-Protect a Floppy

If you copy files to a floppy disk, and want to protect that floppy disk from accidentally being erased or reformatted, you can **write-protect** the disk. When the disk is write-protected, you can still open and view the files on the disk. You can still copy the disk, but you cannot change or delete the files on the disk.

To write-protect a disk, just slide the little write-protect tab, shown in Figure 21-4, to the opposite side, so you can see through the little hole that appears. If you change your mind and do want to change the contents of the disk, just slide the tab back to the previous position, where the hole is covered.

### Cloning a Floppy Disk

You can make an exact copy of any floppy disk that already contains data. You’ll need the original disk and a blank, formatted floppy disk. Then you need to follow these steps:

1. Insert the original disk (the one you want to copy) into your computer’s floppy disk drive.
2. Open your My Computer folder.
3. Right-click the icon that represents your floppy disk drive and choose Copy Disk.
4. Click the Start button in the Copy Disk dialog box that opens.
5. Click OK when it asks you to insert the source disk (since you already put that disk in the drive in Step 1); then follow the instructions on the screen.

Using CDs and DVDs

CDs and DVDs have grown rapidly as *distribution media* and are used to distribute all kinds of media. Vinyl phonograph albums are virtually nonexistent these days. Most programs you buy these days are delivered on CDs. And DVD disks are rapidly replacing VHS tapes for distributing movies. When you buy a CD or DVD with information already on it, you're really getting a CD-ROM or DVD-ROM disk. The *ROM* stands for *Read-Only Memory*, which means that a computer (or CD player or DVD player) can read (or play or copy the contents of) the disk. But nothing can *change* the contents of a CD-ROM or DVD-ROM disk.

Using Prerecorded CDs and DVDs

To use a CD that already contains data, your computer needs to have a CD drive installed. Most computers do have a CD drive installed. If your computer has a DVD drive installed, you can also play DVDs. Most DVD drives are *downwardly compatible* with CD drives, meaning if your computer has a DVD drive, you can most likely use that drive to play both CDs and DVDs.

To insert a CD or DVD disk into the drive, click the little button on the front of the drive. Then place the CD or DVD, label-side up, in the little tray that opens. Press the same button on the drive or gently push the disk tray. The disk will disappear into the drive. Next, wait a few seconds. What happens next depends on what's on the disk and how your computer is currently configured to deal with that type of disk. But the most likely scenarios are as follows:

✦ If you inserted a music CD, Windows Media Player (or some other multimedia program) will open and start playing the music.
✦ If you inserted a DVD that has a movie on it, Windows Media Player (or some other multimedia program) will open and display the DVD’s main menu.

See Chapter 16 for information on playing CDs and DVDs in Windows Media Player.
If the CD you inserted contains a program, an installation program will start. You need to follow the instructions on the screen to install the program.

As an alternative to one of the preceding scenarios, you might see a dialog asking you what you want to do next, as in the example shown in Figure 21-8. Your job is to click the option you want; then click the OK button.

Then again, absolutely nothing might happen.

What you do next is really up to you. If some program opened to play the CD, and it’s the program you were expecting, there’s really nothing else to do, other than maybe change the volume of the music or expand the program that’s playing a movie to full-screen. How you do that depends on what program is playing the CD. If it’s Windows Media Player, you can use the techniques described in Chapter 17 to do all of that.

To eject a CD or DVD from its drive, push the little button on the drive door again. Or right-click the drive’s icon in your My Computer folder and choose Eject.

If some unexpected program opened and started playing the CD, you can close that program by clicking its Close button. Then you can view the contents of the disk as described under the “Exploring the Contents of a CD or DVD” section that follows. If nothing happened after you inserted the CD or DVD, you can also use the techniques that follow to view the contents of the CD or DVD.

Exploring the Contents of a CD or DVD

CDs and DVDs are disks. As such, they store their information in files and folders — just like any other disk. Each file and folder will be represented by an icon. If you chose the Open folder to view files option in Figure 21-8, you will see the files and folders on that disk in an open Explorer window. If you chose Take no action from that dialog box, if nothing happened after you inserted the disk into the drive, or if some program opened and you closed that program, you can still view the contents of the disk in Windows Explorer. Here’s how:

**STEPS: View Files on a CD or DVD**

1. Open your My Computer folder.
2. Right-click the icon that represents the drive into which you inserted the disk and choose Open.

The contents of the CD appear in a standard Windows Explorer folder. You can do all the things you’d expect in Windows Explorer. For example, you can choose a view (such the Thumbnails or Details) from the View menu or Views button. You can arrange the icons by choosing View → Arrange Icons By. You can move and size Explorer’s window. You can open any file or folder on the disk by double-clicking its icon (or by right-clicking a document icon and choosing Open With).
Copying Files from CDs and DVDs

You can copy files and folders from CDs using any of the techniques described in Chapter 19. For example, let’s suppose someone sends you a CD containing a bunch of pictures he or she took. If you just want to look at the pictures, you can leave them in the CD and just browse through them using the Thumbnails or Filmstrip view in Windows Explorer. But if you want to touch them up in a graphics program, you’ll want to copy them to your hard disk first — perhaps to your My Pictures folder or to a new subfolder you create within My Pictures. To copy files from a CD or DVD:

If you’re trying to install a program from a CD, copying files in this manner won’t help. Programs need to be installed on your computer, not copied to your computer. See Chapter 25 to learn about installing programs.

If you want to copy songs from an audio CD (the type you buy in a music store), don’t use this method. Instead, use Windows Media Player, as described in Chapter 17.

Copying movies from DVDs usually doesn’t work. Most movies are copy-protected, so that the copies don’t play correctly. Also, there’s nothing to be gained by copying a movie from a DVD to your hard disk (only a few giga-bytes of storage to be lost).

**STEPS: Copy Files from a CD or DVD**

1. Insert the CD or DVD disk into the appropriate drive and wait a few seconds. What you do next depends on what happens after a few seconds:
• If some program opens to play the disk, close that program.
• If a dialog box appears on the screen asking what you want to do, click Open folder to view files using Windows Explorer. Click OK.
• If nothing happens, open your My Computer folder, right-click the drive’s icon, and choose Open.

2. Select the files and/or folders you want to copy using any technique described in the section “Working with Multiple Files and Folders” in Chapter 19. Then do whichever is most convenient for you:
   • Click Copy the selected items in File and Folder Tasks in the Explorer bar. Then navigate to and click the icon that represents the destination folder.
   • If you specifically want to copy the selected items to your My Documents folder, right-click any selected icon and choose Send To ➪ My Documents.
   • Right-click any selected item and choose Copy. Then navigate to the destination folder and choose Edit ➪ Paste from its menu bar.
   • Open your My Documents folder, and navigate to and open the destination folder. Drag any selected item to the open destination folder.

Tip
You can’t move files from a CD-ROM or DVD-ROM, because that would require removing the files from their current location on the disk. That would require changing the disk, and you can’t change the contents of a Read-Only Memory (ROM) disk.

In short, copying files from a CD or DVD is much like copying files from a folder or magnetic disk. You select the items you want to copy and use whichever copy method is most convenient for you. Copying files to CDs and DVDs is an entirely different matter.

Copying Files to CDs
You can’t copy files to a CD using just any CD-ROM or DVD drive. Your computer needs to have a CD burner installed. You also need appropriate blank media (blank disks) for the drive. Copying files to a CD is often referred to as burning the CD, because a laser actually burns the information onto the disk.

Tip
Many DVD burners can also burn CD-R and CD-RW disks.

There are two types of CD burners, and two types of blank CD disks, on the market:

✦ CD-R: Allows you to burn data to blank CD-R disks. You can use the resultant disk in any computer that has a CD drive installed. If you
create an audio CD using a CD-R disk, you can also play that audio CD in any standard stereo.

✦ CD-RW: Allows you to burn data to a blank CD-R or CD-RW disk. The resulting disk will work only in computers that have a CD-RW disk drive installed. The disk will not play in a stereo, unless it happens to be one of the rare stereos specifically designed to read CD-RW disks.

CD-R disks are Write Once, Read Many (WORM), meaning you get only one shot at burning the CD. Once you copy anything to a CD-R disk, that’s it. You can’t copy anything else to it or change its contents in any way. This is true even if you use a CD-RW drive to burn the CD-R disk.

As is often the case, there are several ways to copy files to blank CD disks.

**General Method for Copying to CDs**

The general methods for copying files to CDs described here will work with any CD burner.

1. Insert a blank CD-R or CD-RW disk into your CD drive and wait a few seconds. Then:
   - If you see a dialog box asking what you want to do with the disk, click *Open writable CD folder using Windows Explorer* and click OK. Then skip to Step 2.
   - If nothing happens within a few seconds of inserting the blank disk, open your My Computer folder. Then right-click the drive’s icon and choose Open.

2. Navigate to the source folder (the folder that contains the files you want to copy) using Windows Explorer.

   **Tip** If you want to copy files across several folders to a CD, you can use the Search Companion to find all the files. See Chapter 19 for more information on using the Search Companion.

3. Select the items you want to copy using any method described in the section “Working with Multiple Files and Folders” in Chapter 19. Then do whichever of the following is most convenient:
   - Right-click any selected item and choose Send To CD Drive.
   - Right-click any selected icon and choose Copy. Then click in the Explorer window that represents the blank CD and choose Edit Paste from its menu bar.
   - Drag any selected icons to the folder window that represents the blank CD and drop them in there.
If you see a dialog box about copying the Thumbs.db file, click the Skip button. Thumbs.db is a hidden file that contains thumbnails used by Windows Explorer. But it’s not necessary to copy that file to the CD. You’ll still be able to view the contents of the disk using Thumbnails view in the future.

4. Each item to be copied will appear as a temporary file — an icon with a little down-pointing arrow added to its icon, in the example shown in Figure 21-9. The arrow indicates that the file is waiting to be copied (it hasn’t actually been copied to the CD yet).

5. Optionally, if you want to see how much data you’ve selected so far, right-click any selected file and choose Properties, as described in the section “Finding the Combined Sizes of Multiple Files,” earlier in this chapter.

Caution

The Free Space measurement under Details in the Explorer bar is the amount of space available on the disk now, before you copy the temporary files to the disk.

6. Optionally, if you have room and want to copy more items to the CD, you can repeat Steps 2-5 until you’ve reached the capacity of the CD.

7. When icons representing all the folders and files you want to copy are visible under Files waiting to be copied in the CD’s Explore window, click Write these files to the CD under CD Writing Tasks in the Explorer bar of the CD’s folder window.

8. In the first page of the CD Writing Wizard that opens, you can type a new name for the CD, as opposed to using the date that appears. This should be a brief label, as it will appear next to the CDs icon in My Computer in the future, when you looking at the CD. Then click Next.

Figure 21-9: Windows Explorer folder containing temporary files waiting to be copied to a CD
9. Wait while the Wizard burns the data to the CD. Then click the Finish button on the last page of the CD Burning Wizard.

To view the contents of the disk, use the same technique you use to view the contents of any CD or DVD, as described earlier in this chapter. Close the window containing the icons that were waiting to be burned to the CD.

Deleting All the Files on a CD-RW Disk

You can wipe clean a CD-RW disk to which you’ve already copied data. This is often useful for making backups of files. For example, suppose you copied your entire My Documents folder to a CD-RW disk last month. You’ve added and changed a lot of files since then and would like to make a new backup. You can delete the old My Documents folder on the CD-RW first. Then you can copy your current My Documents folder to the disk. To wipe clean a CD-RW disks, follow these steps:

Files you delete from CD-RW disks are not copied to the Recycle Bin. Once you erase a CD-RW disk, there’s no way (in Windows) to recover the deleted files.

1. Insert the CD-RW disk into your CD-RW drive. Then:
   - If a dialog box appears asking what you want to do, choose *Open folder to view files using Windows Explorer*, then go straight to Step 3.
   - If a program opens and starts playing the CD, close that program and complete the next item.
   - If nothing happens after you insert the CD, open your My Computer folder, right-click the icon for the CD-RW drive, and choose Open.

2. In the Explorer window that opens, click Erase the CD-RW and follow the instructions on the screen.

Using Third-Party Programs to Burn CDs

The techniques for burning CDs, and erasing CD-RW disks, you’ve learned so far are ones that all Windows XP owners can use. That’s because they’re capabilities built into Windows XP. Many computers that have CD-R and CD-RW drives also have preinstalled, specialized CD-burning software, such as Roxio’s Easy CD Creator ([www.roxio.com](http://www.roxio.com)) or Nero ([www.nero.com](http://www.nero.com)).

Many of these third-party programs support a technology referred to as *packet-writing*, which lets you copy files to CD-RW disks freely, as though the disk were a Zip disk or giant floppy disk. Packet-writing also lets you delete files from a CD-RW individually as on a magnetic disk (by right-clicking the file’s icon and choosing Delete). Some may require that you *format* a blank CD, much like formatting a floppy disk, before using packet-writing capabilities.
If you have third-party CD burning software installed on your computer, you can certainly use it as an alternative to the techniques described here. You’ll have to learn to use that software first, of course, if you don’t already know how. You can get information from the manual that came with that software, or from the Help within the program. Also, you can visit the program manufacturer’s Web site.

Copying Files to DVDs

Windows doesn’t have any built-in capabilities for copying files to DVDs. But most DVD burners come with their own built-in software for creating DVDs. For
example, I recently purchased and installed a Sony DVD burner. It came with a program called My DVD that makes it easy to burn DVDs. Your DVD burner may have come with the same, or similar, software.

If you don’t know anything about your DVD burner or the software that came with it, there’s really not much I can tell you here that will help. There are just too many different makes and models of DVD burners and programs on the market for me to venture a guess. You’ll need to refer to the manual that came with your DVD burner or computer for specifics.

You really need to be aware that there are several different types of DVD drives and different types of blank DVD disks. The type of blank DVD you purchase needs to match the capabilities of your DVD burner. For example, the Sony DVD burner I mentioned a moment ago is a DVD±RW/DVD±R/CD drive (model DRU-510A), which can read and copy to CDs as well as all of the DVD disk types summarized in Table 21-2. (As with CDs, WORM stands for Write Once, Read Many.)

<table>
<thead>
<tr>
<th>Type</th>
<th>Storage Type</th>
<th>Can Be Read By</th>
</tr>
</thead>
<tbody>
<tr>
<td>DVD-R</td>
<td>WORM</td>
<td>Any DVD player</td>
</tr>
<tr>
<td>DVD+R</td>
<td>WORM</td>
<td>Any DVD player</td>
</tr>
<tr>
<td>DVD-RW</td>
<td>Read/Write</td>
<td>Computer DVD-RW drives only</td>
</tr>
<tr>
<td>DVD+RW</td>
<td>Read/Write</td>
<td>Any DVD player</td>
</tr>
</tbody>
</table>

1 "Any DVD player" includes noncomputer DVD players that connect to a television.

### Changing the Default Behavior of CDs and DVDs

When it comes to CDs and DVDs, the phrase *default behavior* or *default action* refers to whatever happens on your screen, automatically, after you insert a CD or DVD disk into its drive. Since there are many different types of CDs and DVDs, there are many possible default actions. For example, when you insert an audio CD into your CD-ROM drive, the CD might just start playing in Windows Media Player. In that case, we’d say that playing songs in Windows Media Player is the default action for audio CDs.

You can override the default action, so nothing happens after you insert a CD or DVD disk, by holding down the Shift key as you insert the disk into the drive. Optionally, you can change the default action of any disk type, so that you don’t have to override that action or put up with some undesired program opening every time you insert a particular type of CD or DVD.
You can set different default behaviors for different disks based on the contents of the disk you insert. That is, you can set a different default behavior for disks that contain mostly music, mostly pictures, or even nothing (blank disks), as follows:

✦ **Music files:** Defines what happens when you insert a disk that contains mostly music in WMA, MP3, and other popular formats.

✦ **Pictures:** Defines what happens when you insert a disk that contains mostly pictures.

✦ **Video files:** Defines what happens when you insert a disk that contains mostly video files in the popular MPEG and WMV formats.

✦ **Mixed content:** Defines the default behavior of disks that contain many different types of files.

✦ **Music CD:** Defines what happens when you insert an audio CD — the kind you can play in a stereo.

✦ **DVD movie:** Defines what happens when you put a movie stored on DVD into the drive.

✦ **Blank CD:** Defines what happens when you insert a blank CD into your CD or DVD drive.

Once you’ve told Windows what type of CD you’re referring to, you can choose an action for that type of CD. For example, you might tell Windows that whenever you insert a Music CD, you want Windows to start copying songs from the CD using Windows Media Player. Or you might tell Windows to open the folder and display its contents in a folder. Or you might tell Windows not to take any action when you insert that type of CD.

You can even tell Windows to prompt you for an action. For example, you can tell Windows to “Ask me what I want to do each time I insert a . . .” certain type of disk. That’s a lot of options. But since they are options, you can change them at any time. So it’s not like you’re making any lifelong commitments here. But anyway, here are the general steps for choosing a default action for a newly inserted CD or DVD disk:

**STEPS: Change the Default Action for CDs and DVDs**

1. Open your My Computer folder (click the Start button and choose My Computer).

2. Right-click the icon that represents your CD or DVD drive and choose Properties.

3. In the Properties dialog box that opens, click the AutoPlay tab.

4. In the drop-down list at the top of the dialog box, choose the type of CD for which you want to define a default action (for example, Music files or Blank CD or DVD movie). Then:
• If you want to define a default action for the disk (or no action), choose Select an action to perform; then click the action you want Windows to perform, as in the example shown in Figure 21-10.

• If you want Windows to ask you what you want to do each time, choose Prompt me each time to choose an action.

5. Optionally, repeat Step 4 to define default actions for other types of disk.

6. Click OK in the dialog box.

The next time you insert a CD or DVD of the appropriate type into the drive, you'll see the default action take place within a few seconds. It always takes a few seconds for the drive to get up to speed and Windows to analyze the contents of the disk.

Troubleshooting CDs and DVDs

Using CDs and DVDs is generally trouble-free if you use the techniques and methods described in this chapter. But things can go wrong, of course. Often, fixing a problem is a simple matter of changing some setting in the drive’s Properties dialog box. If problems do arise, you can use the Windows CD or DVD troubleshooter to step through the problem and find a quick solution, if possible.
To get to the Troubleshooters on most computers, click the Start button and choose Help and Support. Then click Fixing a Problem. If you can’t find the Fix a Problem option on in your Help and Support Center, follow these steps instead:

1. Click the Start button and choose Help and Support.
2. In the Search textbox, type troubleshooters and press Enter.
3. Under Suggested Topics, scroll down to and click List of Troubleshooters.
4. In the main pane on the right, click one of the following:
   - To troubleshoot a DVD drive, click Digital Video Discs (DVDs).
   - To troubleshoot a CD drive, click Drives and network adapters.
5. Follow the instructions on the screen to work your way through the Troubleshooter.

The manual that came with your CD or DVD drive, or that came with your computer, is also another good resource for information about the specific make and model of drive in your computer.

**Summary**

Floppy disks, Zip disks, CDs, and DVDs are examples of removable media. These media are often used for distribution (such as music and programs you buy on CDs). They can also be used to copy files from one computer to another when e-mail or some other type of network transfer isn’t possible. You can also use removable disks to make backup copies of important files on your hard disk. The main points to know about removable media are as follows:

✦ Floppy, Zip, and Jaz disks are examples of magnetic removable media.

✦ To see the contents of a removable disk, insert the disk into the appropriate drive in your computer. Then double the drive’s icon in your My Computer folder.

✦ You can move and copy files to and from magnetic removable disks using the same techniques you use to move and copy files between folders on your hard disk.

✦ You can delete files from a magnetic disk by right-clicking any icon and choosing Delete.
CDs and DVDs are examples of laser media.

You can copy files from a CD or DVD using the same techniques you use to copy files from floppies and Zip disks.

Copying files to a CD or DVD usually involves burning the files to the disk.

Once you’ve burned a -R disk (CD-R or DVD-R) you cannot change its contents; you cannot add more files to it.

Windows XP doesn’t come with DVD-burning software built in. You generally have to use whatever program came with your DVD burner or computer.
A zip file — also called a compressed folder — is a means of packing one or more files into a single, smaller, compressed file. Zip files are a common means of sending files via e-mail, because the compressed file is smaller than the original (in terms of bytes) and, therefore, transfers more quickly over the Internet. Some files you can download from the Internet might also be delivered to you as a zip file, again to make the file smaller and quicker to download.

Beyond compression, though, zip files can just make multiple files more convenient to work with. For example, when I write a chapter like this one, the resulting chapter ends up being quite a few files. All the text is in one file, and each picture is in its own separate file.

When it comes time to submit a chapter to the publisher, I could send in each file individually. But what a pain! It’s much easier to zip all the files up into one file named “Chapter 22” and send just that one zip file as an e-mail attachment. The acquisitions editor who receives that chapter can then easily forward the single Chapter 22 file to the copy editor, tech editor, and whoever else needs to see the chapter. There’s no need for anyone to fumble around with a bunch of separate files along the way.
Programs for Managing Zip Files

There are basically two ways to work with zip files. One way is to use the capabilities built into Windows XP. Those are the methods we’ll be describing in this chapter. As an alternative, you can use a third-party zip program, such as the ever-popular WinZip. If you’re already familiar with such a third-party program and are happy with it, you can continue using that program.

But you have to realize that it’s one method or the other — not both. As soon as you install a third-party zip program on your computer, Windows’ built-in capabilities vanish! If you want to try out the built-in capabilities, you need to uninstall your third-party program. The term **uninstall** means to remove from your computer. So it’s not something you want to take lightly. Make sure that you understand what uninstall means (as discussed in Chapter 25) before you actually uninstall any program.

Having two or more programs for managing zip files on your computer could cause compatibility issues that render some zipped files useless. So Microsoft was wise to ensure that its own built-in zip capabilities go into hiding when some other zip program is on the system.

Making Zip Files in Windows XP

Like so many things in Windows, compressing files is one of those **select, then do things**. You select the files you want to compress, using any of the techniques described in the section “Working with Multiple Files and Folders” in Chapter 19. Then you right-click any one of them and send them to a compressed folder.

Windows doesn’t **move** the selected files into the compressed file. The files you compress don’t disappear into the compressed file. Rather, the compressed file
contains copies of the selected files. It works that way because the usual reason to create a zip file is to send the files to someone via a network — usually as an e-mail attachment, since that’s an easy way to do it. You rarely want to send people your one-and-only original file. You usually want to send them copies and retain your originals.

Let’s work though the specific steps for selecting some files and compressing them into a single zip file. We’ll use an example of sending a chapter that consists of one Microsoft Word document and several pictures.

**STEPS: Create a Zip File**

1. Open your My Documents folder and navigate to the folder that contains the files you want to compress into a zip file.

   To select files from multiple folders, use the Search Companion (Chapter 20) to locate the files you want to copy. Then select the appropriate files in the Search Results window.

2. Select the files you want to compress. For example, in Figure 22-1, I’ve selected all the icons in the folder except one.

3. Right-click any selected icon and choose Send To ➪ Compressed (zipped) file, as is also shown in Figure 22-1.

   As usual, the combined sizes of all the selected items appear under Details in the Explorer bar (3.40 megabytes in Figure 22-1).

![Figure 22-1: Several files selected and about to be zipped](image)
4. After a brief delay, an icon representing the zip file will appear in the
folder (usually below the existing file names).

The icon for a zip file looks like a manila file folder with a zipper on it,
like the example shown at left. The file name of the zip file will be the
same as the name of the file you right-click in Step 3. But you can easily
change that by right-clicking the zip file’s icon, choosing Rename, and typing
your own name or editing the existing name. Whether or not the .zip filename
extension is visible depends on the Hide extension . . . setting in your Folder
Options dialog box.

To view the size of the resulting zip file, do any of the following:

✦ Point to the file and look at its tooltip.
✦ Switch to Details view or Tiles view in Explorer.
✦ Click the zip file’s icon and look under Details in the Explorer bar.
✦ Right-click the file and chose Properties.

Zipping the files provides no guarantee that the resulting file will be small
enough to send as an e-mail attachment. The size limit of an e-mail attachment
varies from one ISP (Internet Service Provider) to the next. And the only way to
determine your attachment-size limit is from your ISP. For example, the 3.40MB
of selected files in Figure 22-1 compress to a single zip file that’s 1.258MB (see
the bottom of Figure 22-2). That’s still too big for an e-mail service that allows
only attachments of 1.0MB, but small enough to clear a 1.5MB or larger limit.

Figure 22-2: The last icon represents the zip file.

Tip If you can’t compress your files into a single zip file that’s small enough,
consider creating two or more zip files, each containing fewer files.
E-Mailing a Zip File

To e-mail a zip file, you need to attach the zip file to an e-mail message. However, before you can do that, you have to know how to send e-mail messages in general. Unfortunately, exactly how you go about doing that depends on your e-mail client (the program you use to send and receive e-mail). When it comes to e-mail and attaching files, there is no one rule fits all. You really have to learn how to e-mail from the company that provides your e-mail service (most likely your ISP).

Even though I can’t tell you exactly how to attach files to e-mail messages in your particular e-mail program, I can point out some general techniques that might work, as they apply to particular types of e-mail. But I can’t make any promises here. The only people who can tell you how your e-mail works are the people from whom you got your e-mail account.

If you can send and receive mail, you can probably learn how to attach files by searching your e-mail client’s Help for attach.

Shortcut for Attaching Files to E-mail

If you use standard POP3 e-mail, and either Outlook Express or Microsoft Outlook as your e-mail client, you can use the shortcut described here to send an e-mail attachment to someone. This actually works with some other e-mail clients as well. It’s worth a try. There’s a point at which you should bail out if it doesn’t work, as I point out under Step 2:

STEPS: Attach a File to an E-mail Message

1. Right-click the icon that represents the zip file (or any other file) you want to send and choose Send To ➪ Mail Recipient. Then:
   - If a Choose Profile dialog box opens, choose the name of the program you want to use to send the e-mail; click OK.
   - If a Wizard appears offering to set up Outlook Express as your e-mail client, click the Cancel button, and don’t proceed with this process. You’ll need to learn the correct way to attach files to e-mail messages in your own e-mail client.

   Caution: Don’t attempt to guess your way through the Outlook Express Wizard. You cannot provide the information required by the Wizard by guessing. You stand about as much chance of guessing correctly as you do at guessing to complete a stranger’s phone number!

2. A blank e-mail message, similar to the one in Figure 22-3, appears. As you can see in the Attach line, the file you right-click in Step 1 is already attached to the message.
3. Fill in the To: portion with the recipient(s) e-mail address(es).

4. Optionally, change the Subject line and main body of the message to something more meaningful to the reader.

5. Click the Send button.

6. If your e-mail client isn’t configured to send messages immediately, click the Send/Receive button or whatever button you usually click to send and receive messages.

That’s all there is to it. The message and file are on their way to the recipient(s).

**Attaching Files without the Shortcut**

As mentioned, the shortcut doesn’t work with all e-mail clients, and there are no hard-and-fast rules that apply to e-mail attachments. As a general rule of thumb, the standard method is to create a new, regular e-mail message. Then look around the program for an Attach or Attach files or Insert Attachment option, as in the examples shown in Figure 22-4.

If all else fails, and you can’t figure out how to attach a file to an e-mail message with your e-mail account, you’ll have to (dare I say it?) read the instructions. Look for the word *Help* where you’re typing your e-mail message and click that. Or open the Help menu for your e-mail program and search the word *attach*. Or ask your ISP for information on using the e-mail service that came with your account.
When someone sends you a zip file as an e-mail attachment, or you download a zip file from the Internet, you first need to save the file to your hard disk. Then you need to decompress the file to get at the real files and folders inside it. If someone sent you a zip file as a file attachment, you’ll see the attachment’s file name in the Attach line or box of the e-mail message. Figure 22-5 shows an example where the attached file is clearly a zip file, as indicated by the zippered folder icon and .zip file name extension.

**Tip**

File name extensions are visible only if the Hide extensions . . . option in the Folder Options dialog box is turned off. See “Showing/Hiding File Name Extensions” in Chapter 6 for details.
When you download a zip file, you’ll see a similar icon and a .zip file name extension on the file you’re downloading. The file’s type will be Compressed (zipped) folder.

Your first step is to get the zip file to your hard disk. If it’s an e-mail attachment, you need to Save (not Open) the attachment. In Outlook Express, you can right-click the file name and choose Save As. Or click the message header, click the large paper clip icon above the message preview, and choose Save Attachments, as in Figure 22-6. If you’re downloading the zip file, as at the bottom of Figure 22-6, click the Save button.

When the Save As dialog box appears, navigate to the folder in which you want to save the zip file. If you created a Recent Downloads folder, you can put the file in that folder, as in Figure 22-7. (Don’t forget that most viruses are spread by e-mail attachments and file downloads. If in doubt, scan the file for viruses.) Take a look at the file name, or change it if you like, so you know what to look for when you want to decompress the file. Then click the Save button.

Before you use the files within the zip files, you should extract them. That means to take the compressed files (or file) from the zip file and to make them normal uncompressed files. Here are the steps:

**STEPS: Extract Usable Files from a Zip File**

1. Open your My Documents folder and navigate to the folder in which the zip file is stored.
2. Right-click the zip file’s icon and choose Extract All as in Figure 22-8.
3. On the first page of the Extraction Wizard that opens, click Next.
4. To place the extracted files in a folder within the same folder as the zip file, click the Next button. Or, if you prefer, you can click the Browse button and choose a different folder for the extracted files. Then click the Next button.
5. On the last Wizard page, make sure that Show extracted files is selected (checked); then click the Finish button.
Figure 22-6: Examples of ways to save a zip file to your hard disk

Figure 22-7: Saving a zip file in my Recent Downloads folder
The extracted file(s) open in Windows Explorer on your screen. Those are normal files that you can open by double-clicking. If you click the Up button in Explorer’s toolbar, or choose View ➤ Go To ➤ Up One Level from Explorer’s menu bar, you’ll be taken to the parent of the files, where you’ll see the icon for the uncompressed file. Its icon will be a normal folder icon, as in Figure 22-9. You can delete the zip file once you have the extracted files on hand. You won’t really need the zip file anymore, unless you just want to keep it as a backup.

Next, I opened the original bitmap file in a graphics program and saved it as a JPEG file. (Choose File ➤ Save As from the graphics program’s file menu. Choose JPEG from the Save As Type drop-down list in the Save As dialog box.) When I looked at the JPEG image, it was about 1,200KB — much smaller than the compressed bitmap image.
Never attempt to change a file’s type just by changing its file name extension. It won’t work, and you’ll make the file unreadable. To make the file readable again, you’ll need to rename it, giving it back its original extension.

Realize that we’re talking strictly about the sizes of the files, in bytes, here, not the size of the picture as it appears on the screen. If you look at the bitmap and JPEG images side by side on the screen, they’re identical. Yet in terms of disk storage, the bitmap image is 55 times larger than the JPEG.

This brings me to another point. Many file types are already compressed. And adding them to a zip file does little to shrink them further. Some examples of file types that are already compressed include MP3 and WMA music files, MPEG and WMV movies, and, of course, the aforementioned JPEG images. None of these files needs to be decompressed for use. They’re already small because the compression is built in.

Compressing files that are already in a compressed format won’t buy you much. For example, the bitmap format used in my previous example isn’t compressed at all. Recall that compressing a bitmap image reduced it from 55,000KB to 18,000KB — a difference of 37,000KB. When I compress the JPEG version of that same picture, the JPEG shrinks from 1,200KB to 1,100KB — a mere 100KB difference. So I guess the moral of the story is that it’s better to know the file types and actual sizes of your files than it is to ignore actual sizes and just assume that zipping a file is the only way to make it smaller.

Of course, when it comes to e-mailing multiple files to people, zip files still offer the benefit of combining multiple files into one file (kind of like ordering a bunch of products and having them all shipped to you in one box rather than in many little boxes). And that’s convenient whether the files shrink a lot, or a little, in the process.

**Summary**

Alrighty then; let’s do a quick recap of the main points in this chapter:

✦ Zip files, also called compressed folders, are a means of combining and compressing one or more files into a single, smaller file.

✦ You can compress files using Windows XP or a third-party zip program, but not both.

✦ To compress files, select their icons in Windows Explorer, right-click, and choose Send To ➤ Compressed (zipped) folder.

✦ When you receive a zip file as an e-mail attachment, or download one from the Internet, you’ll probably find it easiest to save it to your hard disk first.

✦ To extract the files from a zip file, right-click the zip file’s icon and choose Extract All.
Here’s a part title that really scores big in the originality department; I’ll probably get sued or something. Other phrases like “personalizing your computer” or “customizing your computer” are just too many syllables. Besides, people have been using that expression for ages. Like at the end of an argument: “Fine, have it your way.” (Followed by the unspoken “ya moron” or worse.)

Anyway, after you get the hang of how to work a PC and can actually get it to do what you want, tweaking it out can be fun — maybe give the screen a little personality, so it doesn’t look exactly like everyone else’s; add some new programs; maybe even let other people use the PC (as long as they stay away from your stuff). Most of these things are easy to do. So what the heck, go ahead and have it your way.*

*Not spoken in aforementioned argumentative tone.
The whole idea behind a personal computer (or PC for short) is that it’s supposed to be personal. Unlike a terminal on some large corporate network, where you’re just one of many users on a network, you are in complete control of your PC; you get to decide how things look on the screen. You get to decide how you want to organize your documents. You get to decide what programs you do and don’t want on your computer.

When two or more people use the same PC, some of the personal parts of PC get lost in the shuffle. For example, let’s say Sally is one user, and she has everything on her screen set up just the way she likes. She has her own My Documents folder that she keeps organized and so forth. Then user Bob comes along, plops down at the same computer, and starts changing things the way he wants them. Sally gets back on the computer and finds that Bob has totally messed things up for her. Sally is not happy with Bob. Sally wants to keep things her way.

One solution is to give each user his or her own separate PC. That way, nobody steps on anybody else’s toes. You can, however, see the downside to that approach right away — it costs a lot of money to give each person a separate PC. The other solution is to give each person one user account on the same PC. When you do that, each user has his or her own desktop, My Documents
folder, and so forth. It’s the next best thing to each person having a PC. Best of all, it doesn’t cost a penny.

What’s a User Account?

You might wonder how Windows XP will know who is using the computer after you define multiple user accounts. Here’s how that works. If you’re currently the only person on this computer who has a user account, you’re probably taken straight to the Windows desktop after you start your computer. After you add one or more user accounts, it won’t work that way anymore. Instead, when the computer first starts up, you’ll be taken to a Welcome screen, like the example shown in Figure 23-1.

![Figure 23-1: The Welcome screen for a computer with multiple user accounts](image)

Each one of those user names on the Welcome screen represents a user account. As mentioned, each user account will have its own desktop and its own My Documents folder (and subfolders). You could also set up each user account to have its own separate e-mail and .NET Passport, as if each user account were an entirely separate PC.

However, unlike having separate PCs, all of the user accounts will have access to the Shared Documents folder and all of its subfolders. For example, if you put a bunch of songs in the Shared Music folder, anybody who logs onto the computer can play the songs, create CDs from the songs, and so forth. But that same wouldn’t be true if you put those songs in your My Music folder. Anything in your My... folders will be invisible and inaccessible to other users. Figure 23-2 illustrates the concept.

When you start creating user accounts, Windows will ask whether you want the user to be an administrator or limited user.
Each user account has its own desktop and My . . . folders, but everyone has access to Shared . . . folders.

**Administrators versus Limited Users**

When two or more people share a computer, and each person has a user account, one or more persons usually play the role of administrator. The administrator has limitless power over the computer, in that she can look at other peoples’ stuff (as in spying on what kinds of things the kids are up to), create (and take away) user accounts, install new hardware and software, make system-wide changes (things that affect all user accounts), and so forth.

A limited user can still use the computer normally. However, a limited user can’t do certain things. For example, a limited user can’t see other peoples’ documents and can’t make big changes to the computer that might affect other users. Only the administrator can do the big things. That’s because the administrator is (presumably) the most knowledgeable user and, therefore, gets to be the person in control. Table 23-1 summarizes the differences between administrator and limited-user capabilities.
Table 23-1

Differences Between Administrators and Limited Users

<table>
<thead>
<tr>
<th>Capability</th>
<th>Administrator</th>
<th>Limited User</th>
</tr>
</thead>
<tbody>
<tr>
<td>Install programs and hardware</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Create and delete user accounts</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Change other peoples’ user accounts</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Change your own user account type</td>
<td>Yes</td>
<td>No</td>
</tr>
<tr>
<td>Change your own user account picture</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>Create, change, or remove your own password</td>
<td>Yes</td>
<td>Yes</td>
</tr>
<tr>
<td>See other people’s documents</td>
<td>Maybe</td>
<td>No</td>
</tr>
</tbody>
</table>

Private Documents versus Shared Documents

You no doubt notice that I write *maybe* as to whether or not an administrator can see other peoples’ documents. That’s because there’s no rule that says there can be only one administrator user account on the computer. You can have any number of administrator accounts and/or limited accounts. How you set up your user accounts is entirely up to you.

An administrator can always look at the documents created and stored by limited users. That is, there’s no way limited users can keep an administrator from peeking at their files. So what about two different administrator accounts? If you create an administrator account for yourself, you can make its documents *private*, which means nobody else on the computer can see your documents — not even other administrators.

Password-Protecting a User Account

Recall that the Welcome screen, shown in Figure 23-1, displays an icon for each person who has a user account on the computer. Now imagine that you’re the user named Owner, and you’re also the only administrator of the computer. All other users have user accounts. Suppose that the user named Wilbur is sitting alone at the computer, looking at the Welcome screen. Wilbur decides he wants to be administrator for a while. So, rather than clicking his own user account icon, he clicks yours.

Can the computer *see* that it’s really Wilbur sitting at the computer and keep him from logging into your account? Of course not, because computers don’t have eyes or brains. They’re just machines that wouldn’t know a human being from a golf ball. So the computer assumes you are logging in, displays your desktop, and grants all administrative powers. Wilbur then has free reign over your user account and all your administrative privileges. As far as the computer is concerned, Owner, not Wilbur, is controlling the keyboard.
To prevent this from happening, you need to *password-protect* your user account. That is, you need to think of a password and write it down. After you password-protect your account, only you can get into your user account. Clicking your user account icon in the Welcome screen won’t take you, or anybody else, to the desktop or into your account. Instead, a prompt will appear, asking for the password. Only a person who knows that password can type it and get to the desktop. Anybody taking a wild guess will be rejected and locked out of your account.

You never want to forget your own password; presumably, you’re the only person on the planet who knows it. If *you* forget the password, there’s nobody else to ask!

So those are some things to consider when planning user accounts for a personal computer. It boils down to how much power you want to allow each user (person) and how much privacy you want for your own account. To keep everyone — even other administrators — out of your account, you can make your account private and password-protected. You’ll get to choose your options as you create the account. Optionally, you can go in and change those choices at any time.

### The Guest Account

Windows XP has a built-in *Guest account*, which you can activate while you’re setting up accounts. That account isn’t ascribed to any one person. Rather, it’s a catch-all account for anyone who doesn’t have a user account.

For example, let’s say you’re having a houseguest who wants to be able to use the computer once in a while. You don’t want to create a user account for your guest, so you just let the person use the Guest account. Like a limited user, a guest won’t be able to make any substantial changes to the overall computer system but will be able to do the day-to-day things that a regular computer user needs to do. As described in the section “Activating/Deactivating the Guest Account,” later in this chapter, whether or not you even have a Guest account is entirely up to you.

### How to Create a User Account

Creating a user account is a simple — a wizard will take you through the whole procedure. Think of the name you want to give the account first (just the person’s first name will do), and think about whether or not you want make this person an administrator or limited user. Then follow these steps:

**STEPS: Create a New User Account**

1. Click the Start button and choose Control Panel.
2. In Control Panel, open the User Accounts icon. Icons for user accounts currently defined on your computer appear in the User Accounts window, as in Figure 23-3.
3. Click Create a New Account.
4. As instructed, type the new user’s name; click the Next button.
5. Choose whether you want to make this new user an administrator or limited user; click Create Account. The new user account name and picture appear in the User Accounts window.

While you’re in the User Accounts window, you can use the Back and Home buttons in its toolbar to navigate through screens. Use options under Learn about in the Explorer bar to get more information on any page.

6. Close the User Accounts window by clicking the Close (X) button in its upper-right corner.

Don’t worry about the account picture, password, or privacy settings. You can change those at any time. If this is your first experience with user accounts, take a moment to get familiar with the new account.

**Logging on to a New Account**

When you first create a new user account, it’s really little more than a placeholder. Windows doesn’t actually create that user’s My . . . folders until the user (or you) logs into the account. To really get the job done and to make it easier to configure the account additionally, you should log in to the account. Here’s a quick and easy way to do that:

1. Click the Start button and choose Log Off from the bottom of the Start menu.
2. Click the Switch User button.
3. Click the name or picture of the new user account you just created; then wait.

It takes a minute or two to get a new account all squared away. You don’t have to do anything except be patient. Eventually, you’ll be taken to the Windows desktop. Right off the bat, you’ll notice something about this desktop — it might not look exactly like yours.

When you create a new user account, the new user’s desktop is a clone of what a desktop looks like when you first install Windows or when you buy a new computer with Windows XP preinstalled. That’s because every user account has its own desktop. Since this is a new user account, it gets a fresh desktop.

If you peek into the My Documents, My Pictures, or My Music folders in this new user account, you won’t see any of your documents either. The new user has his or her own My . . . folders, separate from yours. If you click the Start button, you’ll notice some differences there, too. This user will have access to all the programs you do. But any customizing you’ve done on your Start menu won’t be visible in the new user account.

**Getting Back to Your Own User Account**

To get back to your own user account, and perhaps do more work on this new account, or create more accounts, follow these steps:

1. Click the Start button; click Log Off.
2. Click the Log Off button.
3. Click your own user account name or picture.

You’ll be taken back to your own user account, where things will be just as you left them.

**Changing a User Account**

From this point on, each user can actually manage his or her own account. But as the all-powerful administrator, you’re free to manage their accounts for them. For starters, you might want to change the picture that Windows gave to the account. Like everything else that has to do with managing user accounts, you’ll make changes in the User Accounts window. Follow these steps to change an existing user account:

**STEPS: Change an Existing User Account**

1. Click the Start button and choose Control Panel.
2. Open the User Accounts icon.
3. Click the name or picture of the account you want to change. You’ll see options like those in Figure 23-4.

![Figure 23-4: Options for changing some other person’s user account]

What happens from here depends on which option you choose. But I think you’ll find them all self-explanatory. For example, if you click Change the Picture, you’ll be taken to a page of pictures to choose from, as in Figure 23-5. Use the scroll bar to the right of the pictures to scroll through them all. Then click the picture you want to use, and click the Change Picture button.

![Figure 23-5: Choosing a picture to represent a user account]

Other options that an administrator can change for any user account include:

- **Change the name**: Change the user’s name.
- **Create a password**: Password-protect the user account.
- **Change the account type**: Change the account from administrator to limited, or vice versa.
- **Delete the account**: Delete the user account. Do not take this lightly; read the following section first.
Deleting a User Account

When you delete a user account, you delete all the documents, e-mail messages, and settings within the account. If your computer came with a generic Administrator or Owner account, and you want an account with your own name, it would be better to change the name on that existing account. You won’t lose any files or settings that way.

Using Your Own Pictures for User Accounts

The pictures that you see in Figure 23-5 are just some freebies from which you can choose. You can actually use any picture you like. But it has to be something that looks OK at a tiny size. If you just pull in any old photo you have sitting around, it might look like little more than a random blob when reduced to that tiny size.

If you really want to use a personal picture for your user account, you should prepare a picture ahead of time. You’ll need a graphics program and the ability to use it. Open a photo, as in the example that follows, and crop out a perfect square. Then shrink the perfect square to about 50x50 pixels, as in the tiny photo to the right that follows. Save that tiny photo as a JPEG image.

Go back to the User Accounts window, and click the user account you want to change; then click Change the picture. Rather than choosing one of the little freebie sample pictures, click the Browse for more pictures link. Navigate to the folder in which you placed the picture, double-click the picture’s icon, and you’re done.

Deleting a User Account

When you delete a user account, you delete all the documents, e-mail messages, and settings within the account. If your computer came with a generic Administrator or Owner account, and you want an account with your own name, it would be better to change the name on that existing account. You won’t lose any files or settings that way.
If you really want to delete an account, you can go ahead and click the Delete the account option. You’ll be given the option to Keep Files or Delete Files. The Keep Files option will move the My Documents folder from the old account to a new folder on your own desktop. While you’ll still lose e-mail messages and settings from the previous account, at least you won’t lose your documents!

You can’t delete your own account. If there is only one administrator account on the computer, you cannot delete it because at least one account on the computer must be an administrator account. In that case, you’ll be forced to create a new administrator account or change a limited account to an administrator account and then log into that other administrator account. From this other administrator account, you can delete the original administrator account.

**Tip**  
If you want to add a .NET Passport to a user account, you need to log in to the account first. That is, click the Start button, and choose Log Off ➪ Switch User. Then click the account to which you want to add or change a .NET Passport. When you get to the Welcome screen, click Start, choose Control Panel, and open User Accounts. Click the account name to which you just signed in. You’ll see an option to add, or change, the .NET Passport for that account.

**Activating/Deactivating the Guest Account**

The Guest user account, as mentioned, is sort of a catch-all account for guests, people who want to borrow the computer for a short time. Allowing such people to use the Guest account prevents them from accessing any other user accounts.

The Guest account is built into Windows XP, so you don’t need to create it. Instead, you can just activate it, thereby making it an option on the Welcome screen, or deactivate it so it’s not accessible at all. To activate or deactivate the Guest account:

1. Click the Start button and choose Control Panel.
2. Open the User Accounts icon.
3. Click the picture that represents the Guest account.
4. To activate or deactivate the account, click the button that appears.

You won’t see any change on your screen, and you won’t be logged in to the account. But next time you see the Welcome screen, an icon for the Guest account will be available.

**Keeping Your Documents Private**

As mentioned earlier in this chapter, limited users can see only their own documents and shared documents. Administrators, on the contrary, can see
everything. That means when there are two or more administrator accounts on a computer, each administrator can see the other’s folders. If you want to hide the contents of your My . . . folders from other users, follow these steps:

1. Open your My Computer folder; click the Start button and choose My Computer.
2. Double-click the icon that represents your hard disk (typically Local Disk C).
3. Double-click the Documents and Settings folder.
4. Right-click the folder icon whose name matches the name of your own user account and choose Properties.
5. In the Properties dialog box that opens, click the Sharing tab.
6. Select (check) the Make this Folder Private option, as in Figure 23-6.

![Figure 23-6: Hiding an administrator's documents from other administrators](image)

7. Click OK.
8. If you haven’t already password-protected your user account, you’ll see a prompt inviting you to create one. You can click Yes to create a password for your account.

Signing Into, and Out of, User Accounts

As mentioned near the start of this chapter, after you’ve defined two or more user accounts on your system, you’ll see the Welcome screen each time you start your computer. You just have to click your own user-account picture (and possibly enter a password, if you password-protected your account). Then you’ll be taken to your own desktop.

When you’ve finished using the computer, you can either shut it down, as usual, or just log off so that you’re no longer signed in to your account but the computer is still running. Logging off is similar to shutting down, in that you’ll want to save any unsaved work, and close any open programs, before you log
off. If you forget to save your work, Windows will prompt you to save it before it logs you off. To log off from your account, follow these steps:

**STEPS: Log off from Your Account**

1. Click the Start button; click Log Off near the bottom of the Start menu (Figure 23-7).

2. In the Log Off Windows box that appears (also shown in Figure 23-7), click the Log Off button.

   ![Log Off Windows box](image)

   ![Log Off button](image)

   **Figure 23-7:** Logging off from a user account

It will take Windows a few seconds to get everything closed and squared away. Then your desktop will disappear, and you’ll be taken to the Welcome screen. At that point, anybody else who has an account on this computer can click his or her user-account picture and log in.

**Switching Users**

It’s always best to log off from your account if you won’t be using the computer for a while. Leaving your account open and a bunch of programs and documents on the screen while you’re away from the computer is just a bad
policy. You greatly increase the likelihood of losing some work when you leave things lying around on the desktop.

If, however, some other user comes along and just wants to borrow the computer for a few minutes — to check e-mail or whatever — you probably won’t want to go through the hassle of closing everything, logging out, and logging back in when the other user is done. In that case, you can click Switch User in the Log Off Windows box shown at the right side of Figure 23-6. Clicking the Switch User button will take you back to the Welcome screen, where the other user can sign in and do whatever needs to be done.

When that person is done using the computer, he or she should log off, using the Log Off button (not Switch User) in the Log Off Windows box. When he or she does, the Welcome screen will appear, and you can click your own account picture to get back to where you were before you switched user accounts.

You really don’t want to use Switch User for any situation other than the preceding one, where you’ll be leaving your account only for a few minutes, then coming right back. There are a couple reasons for this:

✦ Each open user account needs to store data in RAM (random access memory). The more stuff you cram into RAM, the slower your computer runs.

✦ Leaving user accounts open by using Switch User rather than Log Off complicates things immensely for the computer. The more complicated things are at any given moment, the more likely the computer is to hang (freeze up) or to generate some fatal error (a problem that requires restarting the computer without even getting a chance to save any unsaved work you left behind).

So the bottom line is: If you want to keep things running fast, and running safely, don’t use the Switch User button. Always log off from your account (or shut down the computer) whenever you plan to be away from your account for more than a few minutes.

Allowing/Preventing Switch User

It’s somewhat unfortunate that Microsoft put the Switch User button where they did. When most people see it, they assume it’s the best button to push to get to some other user account. It’s not. The Switch User button should be used only for those brief, temporary user-account switches described previously.

As the administrator of the computer, you might seriously consider disabling the Switch User button if other computer users insist on leaving their user accounts open. The last thing you need, as an administrator, is more headaches, and Switch User is one of the leading causes of administrator headaches. To enable or disable fast user switching, as it’s called, follow these steps:
1. Click the Start button and choose Control Panel.

2. Open the User Accounts icon.

3. On the first page of the User Accounts window (the Home page), click *Change the way users log on or off*.

4. Make sure the first option, Use the Welcome screen, is selected (otherwise; the normal Welcome screen will be replaced by an old-style log-in dialog box).

5. Use the second option to choose whether or not you’re going to allow users to click the Switch User button.

6. Click the Apply Options button to return to the User Accounts home page.

**Snooping through User Accounts**

If you have an administrator account, you have access to all limited user’s documents, as well as the documents of other administrators who haven’t made their folders private. The quickest way to get to those other peoples’ documents is though My Computer. That is, click the Start button and choose My Computer. You’ll see a folder for each user account, as well as one for the Shared Documents folder, as in the example shown in Figure 23-8.

![Figure 23-8: Icons for Shared Documents and multiple users’ My Documents folders](image)

Each of those folders represents a single user’s My Documents folder. It wouldn’t help much if they were all labeled My Documents, so here they’re labeled according to the user’s name. For instance, the folder named Wilbur’s Documents is Wilbur’s My Documents folder. You can open these folders as you would any others. For example, double-clicking the Wilbur’s Documents folder opens his My Documents folder to reveal his documents and his My Music, My Pictures, and other folders.
If you double click the folder icon for another administrator who has made his or her documents private, you won’t see anything but the ever-famous Access Denied message used in movies and TV shows. You can’t view, change, move, copy, or rename documents in another administrator’s private folders.

You can also use the Folders list to navigate through all users’ folders (excluding, of course, other administrators’ private folders). Open your My Computer folder; then click the Folders button in Windows Explorer (or choose View ➪ Explorer Bar ➪ Folder). Click the + sign next to the My Computer icon; then click the icon for your hard drive, usually labeled Local Disk, C:. Then click the + sign next to the Documents and Settings folder. Each subfolder under Documents and Settings contains all the documents, and all the settings, for a user account, as in the example shown in Figure 23-9.

![Figure 23-9: The Documents and Settings folder contains a subfolder for each user account.](image)

Gotcha

When you rename a user account, you really change only the name that appears in the Welcome screen and at the top of the Start menu. The folder for that user always retains the original name. Confusing, yes. But changing folder names after the user has already created documents can cause a lot of problems. So at the folder level, Windows locks in whatever name you originally gave the account.

Expanding a single user’s folder displays all folders for that particular user. For example, Figure 23-10 shows the result of clicking the + sign next to Wilbur’s folder and the + sign next to Wilbur’s Documents folder. Here’s what each subfolder within a user account represents:
Each user’s subfolders contain documents and settings unique to that user. As always, you can click any folder name in the Folders list to see that folder’s contents in the main pane to the right.

- **Cookies**: Contains that user’s Internet cookies (tiny files used to store information that can be used by Web sites).
- **Desktop**: Contains the user’s unique, personal desktop shortcut icons.
- **Favorites**: Contains the user’s Internet favorites.
- **Start Menu**: Contains icons that appear on the user’s own Start menu (minus icons that appear on all users’ Start menus).
- **username’s Documents**: This icon is the user’s My Documents folder.
  - **username’s Music**: The user’s My Music folder.
  - **username’s Pictures**: The user’s My Pictures folder.

You’ll also see a subfolder named All Users under Documents and Settings. That folder contains shared folders and files — the things that all user accounts can access. If you click the + sign next to the All Users folder, you’ll see icons for these folders:

- **All Users Desktop**: Contains shortcut icons that appear on all users’ desktops.
- **All Users Favorites**: Contains icons that appear in all users’ Favorites menu.
- **All Users Start Menu**: Contains icons that appear on all users’ Start menus.
- **All Users Shared Documents**: The Shared Documents folder, which contains documents accessible to all users.
  - **All Users Shared Music**: The Shared Music folder.
  - **All Users Shared Pictures**: The Shared Pictures folder.

Figure 23-10: Each user’s subfolders contain documents and settings unique to that user.
You can freely move and copy files among user accounts using all the standard techniques described in Chapter 19 (except, of course, any private administrator folders, which you can’t even get to). For example, you can open Wilbur’s My Pictures folder, select all the icons in that folder, and press Ctrl+C to copy them. Then navigate to some other user’s My Pictures folders, or the Shared Pictures folder, and press Ctrl+V to copy the selected pictures into the Shared Pictures folder. The fact that the folders and files all belong to different user accounts is irrelevant. As an administrator, you have the power to do as you please!

Summary

User accounts are one of those computer things that many computer users find totally perplexing. I hope this chapter has shed some light on why a person might want to create user accounts and how to go about creating them. The main points are summarized as follows:

✦ User accounts are the next best thing to giving each family member a personal PC.
✦ Each user who has an account has a desktop and folders to do with as he or she pleases, without stepping on anyone else’s toes.
✦ Everything you need to create and manage user accounts is in the User Accounts window, which you can open from Control Panel.
✦ As an administrator, you have access to all users’ documents and settings.
✦ An administrator can use all the standard techniques to move and copy files among separate user accounts.
Personalizing Your Desktop

The Windows desktop is like your real, wooden desktop, in that it’s the place where you do all your work. As you learned in Chapter 4, you control what’s visible on your Windows desktop by moving and sizing open program windows. No matter how many open program windows are piled up on the desktop, you can quickly get to the desktop by clicking the Show Desktop button in the Quick Launch toolbar or by right-clicking the current time in the lower-right corner of your screen and choosing Show Desktop.

In addition to those all-important basic skills for managing open program windows on your screen, you can customize the appearance of the desktop itself. For example, you can change the picture that covers the desktop, change the size or appearance of the taskbar, create your own desktop shortcut icons, and more. Figure 24-1 points out the names of the major components of the Windows desktop — the things you’ll be learning to customize in this chapter.
Some General Tips on Customizing

Personalizing (or customizing) your screen involves changing settings in dialog boxes. Every setting is displayed in some type of control that allows you to change the setting. There are many dialog boxes in Windows. While they’re all different in some ways, they’re also alike in some ways. Figure 24-2 shows a sample dialog box and points out some features commonly found in dialog boxes. Use the figure as a resource while reading the following facts about dialog boxes in general.

✦ The name of the dialog box you’re currently working in appears in the dialog box’s title bar.
✦ As when moving a program window, you can move a dialog box by dragging its title bar. Unlike program windows, dialog boxes do not have taskbar buttons and cannot be sized, minimized, or maximized.
✦ Some dialog boxes contain tabs. You can click any tab to view the options on that tab.
✦ If the dialog box in which you’re working has a preview area, the preview will provide an example of how the new setting will affect the actual screen if you decide to keep the new setting.
Most dialog boxes contain some text that describes what its settings are about. If you see a Help (?) button in a dialog box, you can click that button; then click any option for more information about that option. Or press the Help key (F1) on your keyboard.

If an option is dim, it’s currently disabled, because it’s not relevant at the moment. Don’t bother clicking a dimmed option; it won’t do any good.

Do not play around with settings in dialog boxes or make changes just for the sake of making changes. Before you change a setting in a dialog box, you should know what you’re changing and why.

Before you change an option, notice what is currently selected in that option. That way, if you make a change but decide you don’t like it, you can return it to the previous setting.

Nothing you choose in a dialog box is a lifelong commitment. You can open a dialog box and change the settings within it at any time.

Options you choose in a dialog box aren’t actually applied to the computer until you click the OK or Apply button in the dialog box.

To bail out of a dialog box without changing any settings, click its Cancel button or the Close button in its upper-right corner. (Settings you’ve already applied, by clicking the Apply button, won’t be cancelled.)
If you have multiple user accounts on your computer, all the settings described in this chapter will apply only to the user account to which you’re currently logged in. That’s because each user gets to have a desktop, which is defined by the settings that user chooses.

Dialog boxes for customizing Windows XP are in Control Panel, which you can get to by clicking the Start button and choosing Control Panel. In addition, you can often get to a dialog box by right-clicking the item you want to customize and choosing Properties from the shortcut menu that appears.

Cross-Reference To review basic skills and buzzwords related to Control Panel and dialog boxes, see Chapter 2

Creating Your Own Desktop

To customize the appearance of your Windows desktop, you use the Display Properties dialog box. The term display is a general term for what you see on your screen. There are two ways to get to the Display Properties dialog box. Use whichever is most convenient at the moment:

- Right-click the Windows desktop and choose Properties.
- Click the Start button and choose Control Panel. If the Control Panel opens in Categories view, click Appearance and Themes. Double-click the Display icon.

The Display Properties dialog box will open, initially showing you options on the Themes tab, as in Figure 24-3.

![Display Properties dialog box](image)

Figure 24-3: The Display Properties dialog box offers settings for changing your Windows desktop.
Choosing a Theme

The Themes tab in Control Panel lets you choose a color scheme and overall look and feel for your desktop. When you choose an option from the Themes drop-down list, the preview (under the heading Sample) gives you a sneak peek at how that theme will look if you apply it to your desktop.

You can also use any theme in the list as the starting point for creating your own theme. Just choose the theme you want to use as your starting point and change settings on other tabs in the dialog box to your liking. When you find a combination of settings you like, come back to the Themes tab and click the Save As button. Give your theme a file name and click OK.

Tip

The Brightness and Contrast controls on your monitor work like those on a TV. You can't work those with the mouse or keyboard, though. You have to use controls that are right on the monitor, according to the instructions that came with your particular make and model of monitor or notebook computer.

Changing the Picture on Your Desktop

You can have your desktop display any picture in your My Pictures folder or no picture at all. To choose a picture, click the Desktop tab in Display Properties. The preview at the top of the dialog box shows the currently selected picture.

The list under Background provides more pictures, including all pictures you currently have in your My Pictures folder and any subfolders within My Pictures. Use the scroll bar at the right side of the list to scroll through all the picture names. Click any picture name to see it in the preview.

Tip

Once you've clicked a picture name, you can use the ↑ and ↓ keys on the keyboard to go from picture to picture.

To use a picture not listed under Background, click the Browse button. Then navigate to the folder in which the picture is contained, click its icon, and double-click the picture you want to use. If the picture you chose is smaller than your desktop, you can choose one of the following options from the Position dialog box to choose how you want the picture displayed:

✦ Center: The picture is centered on the desktop, surrounded by whatever color you choose from the Color drop-down list.
✦ Tile: The picture is repeated like tiles to fill the entire screen.
✦ Stretch: The picture is stretched to cover the entire desktop.

Gotcha

If the picture you're displaying on your desktop is as large as, or larger than, the desktop, the Center and Tile options will have no effect.
The Color option lets you choose a color for the desktop. The color will only be visible, though, if you choose (None) as the background picture or if you center a small picture on the desktop.

**Choosing Icons to Display on the Desktop**

To choose some icons for your Windows desktop, click the Customize Desktop button on the Desktop tab in Display Properties. A new dialog box titled Desktop Items will open. Select (check) the name of any icons you want to place on your desktop.

If you want to change the emblem displayed by the My Computer, My Documents, My Network Places, or Recycle Bin icons, first click the icon you want to change just above the Change Icon button. Then click the Change Icon button and choose a different icon. To return to the original default icon, click the Restore Default button.

If your desktop is already cluttered with more icons than you need, you can click the Clean Desktop Now button. A Wizard will appear to help you move old icons you haven’t used in the last 60 days into a folder named Unused Desktop Shortcuts. If you use this option and find that it has deleted too many icons, double-click the Unused Desktop Icons folder on your desktop. Within that folder, right-click any icon you want to redisplay on the desktop and choose Restore.

Click OK after making your selections in the Desktop Items dialog box. You’ll be returned to the Display Items dialog box.

**Choosing a Screen Saver**

A *screen saver* is a moving image that automatically appears on your screen after the computer has been sitting idle for a while. Originally, screen savers were created to prevent monitor *burn-in*, a condition caused by leaving an unchanging display on the screen for a long period of time (many hours). Burn-in isn’t really a problem on modern monitors. But a screen saver can still be a fun thing to have and certainly can’t hurt anything.

To choose a screen saver, first click the Screen Saver tab in the Display Properties dialog box. Then choose any picture name from the Screen saver drop-down list. The preview at the top of the dialog box will show you how the selected screen saver will look when it actually appears on your screen.

The My Pictures Slideshow screen saver actually shows all the pictures in your My Picture folders in a slideshow fashion. If you want to display pictures from some other folder, first choose My Pictures Slideshow as your screen saver. Then click the Settings button. In the dialog box that appears, use the Browse button to navigate to the folder that contains the pictures you want to display. Use other options in that dialog box to refine how the pictures are displayed. Then click OK.
To see what the screen saver will look like in real life, where it covers most or all of the screen, click the Preview button and let go of the mouse. After watching the screen saver, just move the mouse to return to the dialog box. After you’ve chosen a screen saver, you can click the Settings button to refine how the screen saver behaves.

The Wait option specifies how long the computer must sit idle (with no mouse or keyboard activity) before the screen saver kicks in. If you select the *On resume, display welcome screen* option, turning off the screen saver will take you to the Welcome screen described in Chapter 23, rather than to your desktop. When the actual screen saver does kick in on your computer, simply moving the mouse or pressing a key will turn the screen saver off and bring back your regular screen.

If the time delay for the Turn Off Monitor power option is less than the time delay for the screen saver, you’ll never see the screen saver. That’s because the monitor will turn off before the screen saver can appear!

The Power button on the Screen Saver tab provides a shortcut to the Power Options dialog box, used mainly to conserve batter power on laptop computers running on batteries. The Turn Off Monitor option in that dialog box specifies the amount of idle time required before the monitor shuts itself off. If you want your screen saver to play without the monitor going blank, set the Turn Off Monitor option to Never.

**Fine-Tuning Your Color Scheme**

As mentioned earlier in this chapter, you can choose an overall color scheme for your screen using the Themes tab in Display Properties. You can further refine the general appearance of program windows and buttons, colors, and the size of text on the screen using options in the Appearance tab. When you make a selection from the *Windows and buttons*, *Color scheme*, or *Font Size* drop-down list, the preview area on the Appearance tab will show you what to expect if you apply the new setting.

Clicking the Effects button on the Appearance tab takes you to the Effects dialog box, where you can pick and choose special effects. If you use a notebook computer, or some other flat screen, and the text on your screen looks blocky, the Effects tab can help. Click the Effects button and choose the *Use the following method to smooth edges of screen fonts* checkbox. Then choose Clear Type as the method. If, after reviewing the fonts on your screen, you don’t like the result, you can return to the Effects dialog box and try the Standard method of smoothing screen fonts.

Clicking the Advanced button on the Appearance tab takes you to the Advanced Appearance dialog box. There you can control colors and sizes of individual items such as icons, menus, and scroll bars. As you try out different options in the Advanced Appearance dialog box, the preview will show how the current selections will look on your actual desktop. Click OK in the Advanced Appearance dialog box after making your selections.
Choosing a Screen Resolution and Color Depth

While your screen looks like a smooth picture from where you’re sitting, it’s actually a collection of tiny lighted dots called *pixels*. The resolution of your screen determines how many pixels are visible, expressed as the number of pixels across the screen, and the number of pixels down. You can also choose a *color depth*, which determines the number of colors your screen can show.

To choose a screen resolution or color depth, click the Settings tab in the Display Properties dialog box. Use the Screen Resolution slider (Figure 24-4) to adjust the resolution. With Windows XP, a minimum of 800 × 600 pixels is recommended, though you’ll be able to get more stuff on the screen at a higher resolution, such as 1024 × 768. Be aware, however, that the higher the resolution, the smaller everything will look on your screen. Your best bet is to try both 800 × 600 and 1024 × 768 and to stick with whichever is most comfortable for your eyes.

![Figure 24-4: The Settings tab of the Display Properties dialog box](image)

Some notebook computers and flat monitors have their own separate dialog boxes for screen resolution and color depth. If changing those settings in the Display Properties dialog box has no effect on your screen, refer to the manual that came with your computer or monitor for instructions on changing its settings.

With Color Depth, bigger is generally better. The full range of options available to you depends on your computer’s video card and monitor. As a rule, you want to choose Highest (32 bit) for the best display. However, 24 bit and 16 bit are also acceptable.
Why Is My Screen All Whacky?

The first time you switch from one screen resolution to another, the image on your monitor might be off center, as in the example at left below. Or the image might be too tall, too wide, too short, or too narrow, like in the center example. To fix that, you need to adjust the Width, Height, Horizontal Center, and Vertical Center adjustments on your monitor.

You can’t adjust the previously mentioned monitor settings using either mouse or keyboard. You must use the controls that are right on the monitor itself or on your notebook computer. The only place to get information on using those controls is in the manual that came with your monitor or computer. Once you find the right controls, you should have no problem sizing the desktop so that it fills the screen as in the example above on the right.

Tip
Screen resolution and color depth are the only settings in this chapter that apply to all user accounts. That’s because those options affect the video hardware directly, and hardware is oblivious to user accounts. All users have access to exactly the same hardware and hardware settings.

Using the bit number as an exponent of 2 tells you the number of different colors the screen can display. For example, 32 bits of color \(2^{32}\) gives you 4,294,967,296 different colors, ideal for viewing photographs and video. A lower resolution such as \(2^{16}\) (16,777,216 colors) \(2^{16}\) (65,536 colors) can make photos look blotchy.

Saving Display Properties Settings

If you make any changes to the settings in any of Display Properties tabs, remember that you can save those settings under any name of your choosing. Just click the Appearance tab in Display Properties; then click the Save As button. You can accept the default file name, My Favorite Theme, or enter a new name. Once you’ve saved a theme, its name will be visible in the Theme drop-down list on the Themes tab, so you can easily apply the entire theme just by selecting its name.

When you’ve finished changing settings, click the OK button in the Display Properties dialog box. All your settings will be applied, and the dialog box will close. If you want to make further changes, just reopen the Display Properties dialog box again by right-clicking the desktop and choosing Properties or by opening the Display icon in Control Panel.
Arranging Icons on Your Desktop

You can move icons around the desktop just by dragging them. You can delete any icon on your desktop by right-clicking the icon and choosing Delete. If your icons get all out of order and difficult to find, you can quickly rearrange them. Just right-click the Windows desktop and choose Arrange Icons By ➤ Name. Built-in icons such as My Documents, My Computer, and Recycle Bin are always listed first near the upper-left corner of the screen. Remaining icons will be listed in alphabetical order, as in the example shown in Figure 24-5.

![Figure 24-5: Shortcut menu that appears when you right-click an empty spot (not on an icon) on the Windows desktop](image)

Personalizing Your Start Menu

The Start button, as you know, is the gateway to every program currently installed on your computer. The Start menu also provides easy access to commonly used folders such as My Documents, My Computer, Control Panel, and any others you care to add. As a rule, you want the Start menu to contain items you use frequently, so you can get to those items without navigating through too many submenus.

The Windows XP menu is split into two columns (Figure 24-6), with icons for programs on the left and icons for folders on the right. The left side of the menu is split into two groups. Icons above the horizontal line are pinned to the menu, meaning that they never don’t change unless you change them. Beneath the horizontal line are icons that represent programs you use frequently. Those latter icons might change at any time to reflect programs you’ve been using frequently in the last few days.
You can customize your Start menu in many ways, by choosing which folders are accessible from the menu, which programs are pinned to the Start menu, and even the size and number of icons on the menu. The dialog box you use to adjust those settings is named Taskbar and Start Menu Properties.

Controlling What You See on the Start Menu

Earlier, I mentioned that you can usually get to an object’s properties just by right-clicking the object and choosing Properties. Or you can take the longer route through Control Panel. In this case though, you don’t actually right-click the Start menu itself. Rather, you can use whichever of the following techniques is easiest for you:

✦ Right-click the Start button and choose Properties.
✦ Click the Start button and choose Control Panel. If Control Panel opens in Categories view, click Appearance and Themes. Then open the Taskbar and Start Menu button.
Options for customizing the taskbar and options for customizing the Start menu share the Taskbar and Start Menu Properties dialog box. Once you’ve opened that dialog box (using either of the preceding techniques), you need to click the Start Menu tab to get to options for personalizing your Start menu.

You’ll initially be presented with two options: Start Menu (which displays the two-column Windows XP Start menu) and Classic Start Menu (which displays an old-fashioned Windows 98 style menu). To access the settings described here, select the first option, Start Menu. Then click the Customize button just to the right of that option. The Customize Start Menu dialog box will open next. There are two tabs in the dialog box labeled General and Advanced, as shown in Figure 24-7.

![Customize Start Menu screen](image)

Figure 24-7: The two tabs of the Customize Start Menu dialog box

The General tab of the Customize Start Menu dialog box provides the options described as followed:

- **Large Icons/Small Icons:** Choosing Large Icons displays icons at the size you’ve seen throughout this book. Choosing Small Icons displays smaller icons that are harder to see. But you can get more icons on the menu at the smaller size.

- **Number of items on Start menu:** Specifies the maximum number of items displayed on the left side of the menu. If you set this too high for your screen resolution and icon size, Windows will display a *Some items will not fit* message each time you open the Start menu. To get rid of that message, you need to decrease the number of items selected here. The Clear List button clears all of the unpinned icons from the left side of the Start menu.

- **Internet:** If you want to pin the icon for your Web browser to the top of the Start menu, choose this option. Then choose your favorite Web browser from the drop-down list to the right.
**E-mail:** If you want to pin the icon for your e-mail client to the Start menu, choose this option. Then choose the name of your e-mail client or service from the drop-down list to the right.

The Advanced tab of the Customize Start Menu dialog box provides options that define the general behavior of the Start menu and the items visible on the right side of the menu. Items outside the list box are as follows:

- **Open submenus when I pause on them with my mouse:** If you select this option, you can open any submenu simply by pointing to the option on the menu rather than clicking it. Items on the menu that have a ➤ to the right, such as All Programs, My Recent Documents, and Favorites, all have submenus.

- **Highlight newly installed programs:** Selecting this option for starting any new program you install will be highlighted on the All Programs menu. That makes it much easier to find the appropriate icon after you’ve installed a new program.

- **List my most recently opened documents:** If selected, adds a My Recent Documents option to the right side of the Start menu. This makes it easy to open any document you’ve recently worked on. Rather than digging around for the document, you just click the Start button, choose My Recent Documents, and click the name of the document you want to open. The Clear List button empties the list of documents, allowing you to rebuild the menu from scratch.

The list of Start Menu Items in the center of the Advanced tab lets you choose which folder names you want to make available on the right side of the menu. For most items, you’ll be given three options:

- **Display as link:** Choosing this option tells Windows to open the corresponding folder when you click the menu option. This is the most natural method, once you’re familiar with working in folders.

- **Display as menu:** Choosing this option tells Windows to show items within the folder as options on a menu, without opening the folder. This option is a reasonable alternative for folders that contain few icons but is unwieldy for folders that contain many icons.

- **Don’t display this item:** As it says, choosing this option will prevent the option from being displayed at all on the right side of the Start menu.

The Start Menu Items list contains mostly specific items you can choose to show, or hide, on the right side of the Start menu. But as you scroll through the list, you’ll also find some options that define the overall behavior of the Start menu rather than specific items. Those items are summarized as follows:

- **Enable dragging and dropping:** If selected, this allows you to rearrange icons on the Start and All Programs menus simply by dragging them into position. You also need to select this option if you
want to be able to create desktop shortcuts by right-clicking options on the Start and All Programs menus. I recommend that you select (check) this option.

✦ Scroll Programs: If you select this option, the All Programs menu won’t fan out across the screen when you open it. Instead, you’ll have to scroll through the menu using buttons at the top and bottom. I would recommend that you clear (not select) this option.

After making your selections from the Customize Start Menu dialog box, click its OK button, and click the OK button in the Taskbar and Start Menu Properties dialog box. Click the Start button to see the effects of your changes on the Start menu.

Pinning Items to the Start Menu

As mentioned, some items on the left side of the Start menu tend to change to reflect the programs you’ve run the most in recent days. That can be a good thing or a bad thing, depending on how you use your computer. If there are any items that you want to appear on the left side of the menu at all times, you can pin those items to the menu. To do so, just right-click the item you want to pin and choose Pin to Start Menu.

You can also pin any program name from the All Programs menu to the Start menu. Click the Start button, choose All Programs, and work your way to the icon you want to pin. But don’t click that icon to open the program. Instead, right-click the program’s icon and choose Pin To Start Menu.

You’re not limited to pinning program icons either. If you have a folder you’re using often, you can pin its icon to the Start menu as well. To pin a folder’s icon to the Start menu, just navigate to the parent of the folder using Windows Explorer. Then, once you see the icon for the folder you want to add to the Start menu, drag its icon to the Start button and drop it there. You won’t notice any immediate change. But the next time you click the Start button, you’ll see an icon for the folder pinned near the top of the Start menu.

Unpinning, Renaming, and Removing Start Menu Items

The left side of the Start menu is very flexible. For example, if you pin an item to the Start menu, but later decide you don’t need it there, you can unpin it. Just right-click the icon you want to unpin and choose Unpin From Start Menu. Or, if you don’t see that option on the shortcut menu, choose Remove From This List instead. To get rid of an icon that isn’t pinned to the Start menu, right-click the item and choose Remove From This List.

Removing a program’s icon from the Start menu doesn’t delete the actual underlying program. It only removes the program’s icon from the menu. To uninstall a program, see the section “Uninstalling Programs” in Chapter 25.
To add or remove icons from the right side to the Start menu, use the Start Menu Items list described in the section “Controlling What You See on the Start Menu,” earlier in this chapter.

If you want to change the name of an item on the Start menu, right-click the item and choose Rename. Then edit the existing name or type a new name, and press Enter.

Rearranging Start and All Programs Menu Items

You can rearrange icons on the left side of the Start menu just by dragging any item up or down and dropping it wherever you want to place it. The same technique works on the All Programs menu as well. But on the All Programs menu, you can quickly whip icons into alphabetical order by following these steps:

1. Click the Start button and choose All Programs.
2. Right-click any icon on the All Programs menu (or a submenu that you can get to from All Programs) and choose Sort By Name from the shortcut menu that opens (see Figure 24-8).

If you can’t move items around on the Start or All Programs menus, make sure Enable dragging and dropping is selected in the Customize Start Menu dialog box is selected (checked) as described in the section “Controlling What You See on the Start Menu,” earlier in this chapter.

Figure 24-8: Use the Sort By Name option on any All Programs submenu to alphabetize its options.
On the All Programs menu, program folders (groups) are always listed first. Program groups all have a similar icon and a \( \rightarrow \) to the right. Icons that represent programs have the program’s logo as their icon and no \( \rightarrow \) character to the right.

**Personalizing Your Taskbar**

The taskbar at the bottom of your screen provides many useful items, including the Start button, the Quick Launch toolbar, the general taskbar area, which contains a button for each open program window, and the Notification Area. Options for personalizing your taskbar are in the Taskbar and Start Menu Properties dialog box, which you can get to by using whichever of the following techniques is most convenient:

✦ Right-click the Start button and choose Properties.
✦ Click the Start button and choose Control Panel. Then click Appearance and Themes (if available) and open the Taskbar and Start Menu icon.

The Taskbar and Start Menu Properties dialog box opens on your screen. Click the Taskbar tab to reveal the options shown in Figure 24-9. The two preview taskbars let you see how the options you choose will affect the real taskbar. Your options are summarized as follows:

![Figure 24-9: The Taskbar tab of the Taskbar and Start Menu Properties dialog box](image)

✦ **Lock the taskbar**: If you select this option, you’ll lock the taskbar, which will prevent you from accidentally moving or resizing it. If you want to move or resize the taskbar, you first need to clear this option to unlock the taskbar.
✦ **Auto-hide the taskbar:** If you selected this icon, the taskbar will automatically slide out of view when you’re not using it, to free up the little bit of screen space it takes up. After the taskbar hides itself, you can rest the tip of the mouse button on the thin line at the bottom of the screen to bring the taskbar out of hiding.

✦ **Keep the taskbar on top of other windows:** Selecting this option ensures that the taskbar is always visible and can’t be covered up by open program windows. To ensure that the taskbar is always visible, select (check) this option, and clear the *Auto-hide the taskbar* checkbox.

✦ **Group similar taskbar buttons:** Choosing this option allows the taskbar to combine multiple open documents or pages for a program into a single taskbar button. Taskbar buttons that represent multiple documents will display a number next to the program name on the button. You can open any document by clicking the taskbar button and clicking a document name. To close all open documents or pages in one fell swoop, right-click the button and choose Close Group. Figure 24-10 shows an example where four Web pages are currently open in Internet Explorer.

Figure 24-10: Click or right-click a taskbar button that represents two or more open documents or pages.

✦ **Show Quick Launch:** Select this option to make the Quick Launch toolbar visible on the taskbar. Clear this option to hide the Quick Launch toolbar. (More on the Quick Launch toolbar later.)

✦ **Show the clock:** Choose this option to make the current time visible in the lower-right corner of the screen. Clear this option to hide the current time.

**Tip**

When the current time is visible, you can double-click the time to change the current time and date. Right-click the current time to see handy shortcuts for organizing open program windows.
✦ **Hide inactive icons:** If this is selected, Windows will hide inactive Notification-Area icons, thereby saving space on the taskbar. Clearing this option will make all notification icons visible. (More on the Notification Area later.)

**Moving and Sizing Taskbar Items**

When the taskbar is unlocked, you can move and size the taskbar and size the Quick Launch toolbar as well. A quick way to lock or unlock the toolbar is to right-click the current time and choose Lock the Taskbar. The option works as a toggle, locking the taskbar if it’s unlocked or unlocking it when it’s locked.

You can tell if the taskbar is currently unlocked by the dragging handles at the top of the bar and within the bar. Also, the Lock the Taskbar option won’t be checked if the taskbar is unlocked, as in the top of Figure 24-11. When the taskbar is locked, no dragging handles are visible and the Lock the Taskbar option on the shortcut menu has a checkmark next to it, as in Figure 24-11.

![Drag handles Unlocked](image1)

![Locked](image2)

**Figure 24-11:** An unlocked taskbar (top) shows dragging handles.

**Tip**

You may find it easiest to close all open program windows before fiddling with the taskbar. That way, you won’t have any taskbar buttons in the way to confuse matters.

When the taskbar is unlocked, you can do any of the following:

✦ To move the entire taskbar, point to an empty portion of the bar and drag the entire bar to any edge of the screen.

✦ To size the taskbar, point to the thin bar at the top of the taskbar until the mouse pointer turns to a two-headed arrow. Then hold down the left mouse button and drag that edge up or down (Figure 24-12).
To change the width of the Quick Launch toolbar, drag the handle to the right of the bar left or right (also shown in Figure 24-12).

If you drag one of the dotted handles up or down, the taskbar will split into two rows, as in the bottom of Figure 24-12).

![Figure 24-12: A two-headed arrow appears when you point to a dragging handle.](image)

If you accidentally drag a dotted dragging handle up or down and want to get back to a single-row taskbar, drag the same dotted handle up a notch. Then drag the very top of the taskbar down a notch.

If you drag the top of the taskbar right off the bottom of the screen, the taskbar will seem to disappear. But if you look closely, you’ll see that the thin gray bar is still visible along the bottom edge of the screen. If you rest the tip of the mouse pointer right on that bar, you’ll see the two-headed arrow again, indicating that you can drag the top of the taskbar straight up to make the taskbar wider again.

Once you have the taskbar arranged the way you like, you’ll be wise to lock it. That way, you don’t have to worry about inadvertently rearranging it just by being a little klutzy with the mouse.

### Using the Quick Launch Toolbar

The Quick Launch toolbar is a handy place to store icons for programs and folders you use often. If there are more buttons on the taskbar than will fit in the size allotted, you’ll see a little >> symbol on the Quick Launch toolbar. You can click the >> symbol to see other icons on a menu. Then click any icon on the menu that opens to open the program.

To add an icon to the Quick Launch toolbar, right-drag any shortcut icon from the desktop, All Programs menu, or a folder right onto the Quick Launch toolbar. Then release the mouse button and choose Create Shortcuts Here.

**Tip**

The term *right-drag* means to drag using the right mouse button rather than the left mouse button.
To move an icon on the Quick Launch toolbar left or right, point to the icon you want to move and drag it left or right. The mouse pointer will turn to an I-beam, like the example at left. When the I-beam is where you want to place the icon, release the mouse button.

To delete an icon from the Quick Launch toolbar, right-click the icon and choose Delete.

**Personalizing the Notification Area**

At the right side of the taskbar, you’ll see icons for running processes. A process is slightly different from a regular program, in that a process runs in the background, meaning it has no program window or taskbar button. Examples of programs that run as processes include things such as anti-virus software, Windows Messenger, and perhaps others.

To see what program any icon in the Notification Area represents, point to the icon and look for the tooltip. If that doesn’t help, try double-clicking the icon or right-clicking it to see what other options are available to you. For example, you can often close a program running as a process by right-clicking its icon in the Notification Area and choosing Close or Exit.

By default, Windows XP hides inactive icons to prevent them from hogging up space on the taskbar. To view the icons currently hidden, just click the button at the left side of the Notification Area.

**Tip** If you want Windows XP to stop hiding Notification-Area icons, clear the Hide Inactive Icons checkbox shown in Figure 24-9.

To choose which icons are visible in the Notification Area, right-click the current time and choose Customize Notifications. In the Customize Notifications dialog box that opens, you can click on any icon’s name; then choose one of the following options (shown in Figure 24-13) to decide how to show the icon:

- **Hide when inactive:** This is the normal behavior for Notification-Area icons, where they’re visible only when the process the icon represents is running.
- **Always hide:** Keeps the icon from ever showing, even when the process is running.
- **Always Show:** Ensures that the icon is always visible, whether its corresponding process is running or not.

The Restore Defaults button changes all icons in the list to their original default settings, as shipped with Windows XP.
Optional Taskbar Toolbars

Windows XP comes with extra, optional toolbars you can add to the taskbar or allow to float freely on the desktop. To view their names, and show one, right-click the current time in the lower-right corner of your screen, choose Toolbars; then click the name of the toolbar you want to display. Your options are:

- **Address**: Displays an Address bar like the one in your Web browser. Typing a URL into the bar will open your Web browser and the page at the URL.

- **Windows Media Player**: Adds a set of Play Controls to the taskbar. But this toolbar will be visible only if you open, then minimize, Windows Media Player.

- **Links**: Displays the Links toolbar from Microsoft Internet Explorer.

- **Language bar**: Displays the optional language bar, but only if your computer has voice recognition or some similar software installed to activate voice recognition.

- **Desktop**: Shows all desktop shortcut icons from your Windows desktop in a condensed toolbar format.

- **Quick Launch**: Shows (or hides) the Quick Launch toolbar described earlier in this chapter.

When you first open one of these optional toolbars, you might see only its label in the taskbar. If the taskbar is unlocked, you can drag the handle to the left of that label toward the left to increase the size of the toolbar. For example, Figure 24-14 shows the Address toolbar widened on the taskbar.
If the taskbar is unlocked, you can also drag the toolbar’s handle straight up to the desktop. There, the toolbar will turn into a small window that you can move and size like any program window. Figure 24-14 also shows the optional Desktop toolbar, floating freely on the Windows desktop.

![Figure 24-14: Address toolbar on the taskbar, Desktop toolbar floating freely](image)

Once you’ve dragged an optional toolbar off the taskbar and onto the desktop, you can’t really drag it back onto the taskbar, which is a little unnerving at first. But there is a simple solution. Click the little Close button in the upper-right corner of the free-floating toolbar. Then right-click the current time, choose Toolbars, and click the toolbar’s name again. The toolbar will reappear on the taskbar.

### Creating Your Own Shortcuts

You can create a desktop shortcut to any program, document, or folder you wish. Doing so makes it easy to find the icon when you need it. The easiest way to create a desktop shortcut icon is as follows:

1. Get to the icon to which you want to create a shortcut. This can be any program icon on the All Programs menu or any folder or document icon in Windows Explorer.

2. Right-click the icon to which you want to create a shortcut and choose Send To ➤ Desktop (create shortcut).

**Tip**

As an alternative to Steps 1 and 2 above, you can right-drag any selected icon(s) to the desktop and choose Create Shortcut(s) Here. To create a shortcut to the Web page you’re currently viewing in Internet Explorer, choose File ➤ Send ➤ Shortcut to Desktop from Internet Explorer’s menu bar.

You’ll see the icon on the desktop when the desktop is visible. The shortcut will likely be named Shortcut to... followed by the name of the original icon. But you can rename the shortcut, if you want, by right-clicking its icon and choosing Rename. Of course, you can just double-click the shortcut item to open the object that the shortcut represents.
Handy Folder Shortcuts

If you create desktop shortcuts to favorite folders, you can use those to quickly jump to a folder from the Open or Save As dialog box. When the dialog box opens, choose Desktop from the Look In or Save In drop-down list, as in the example shown here. Then double-click the shortcut icon for the folder you want to open.

You can copy shortcut icons from the desktop into your My Documents folder as well. Since My Documents is often the folder selected automatically in the Open and Save As dialog boxes, you won’t even have to switch to the desktop. Just double-click the shortcut icon in the My Documents folder.

Shortcut icons look almost exactly like the original icon, except that shortcuts have a little curved arrow on them, as in the examples shown in Figure 24-15. The curved arrow is important, because it allows you to discriminate between a shortcut icon and the real thing. For example, you wouldn’t want to delete your Shared Pictures folder, as doing so would delete all the pictures within that folder. But when you delete a shortcut icon, you delete only the shortcut. The folder, document, or program that the shortcut icon represents will not be deleted.
Once the shortcut icon is on the desktop, you can copy it to the Quick Launch toolbar and/or Start menu as well, just by dragging it to the Start button or Quick Launch toolbar and dropping it there.

You can also right-click just about any icon and choose Copy Shortcut. Then navigate to wherever you want to create a shortcut to that item and choose Edit ➪ Paste. Or right-click some empty spot and choose Paste. The icon will be pasted and will also remain in the Clipboard. You can paste the same icon to as many locations as you wish.

Accessibility for Sensory and Motor Impairments

If you have a sensory or motor impairment that makes it difficult to see the screen, hear computer sounds, or operate the mouse and keyboard, you can further customize your desktop to better suit your needs. The Accessibility Wizard provides the easiest tool for configuring your desktop in this manner. The Wizard just asks you questions and adjusts things according to your answers. So you can get started without first learning about all the different programs and options described in a moment.

If several people share your computer, be sure to set up a separate user account for the person with disabilities. That way, those settings will be turned on automatically each time that user logs in to Windows.

**STEPS: Activate Tools for Sensory and Motor Impairments**

To use the Accessibility Wizard, follow these steps:

1. **Click the Start button and choose All Programs ➪ Accessories ➪ Accessibility ➪ Accessibility Wizard.**
2. **On the first page of the Wizard that appears, click the Next button.**
3. **Follow the instructions on each page of the Wizard, followed by clicking the Next key. Then click Finish on the last Wizard page.**

Windows will activate the accessibility features according to how you answer the questions the Wizard poses. You might see some additional icons in the Notification Area. You can point to any icon to see its name and double-click the Notification Area to get to optional settings for that feature.

The names of the features that the Wizard might or might not activate (according to how you answer its questions) are summarized here:

- **High Contrast:** Improves screen contrast using alternative colors and font sizes.
- **SoundSentry:** Replaces visual warnings with sounds.
- **ShowSounds:** Tells programs to display captions for program sounds and speech.
✦ **ToggleKeys:** Emits a sound when you press an on/off key, such as Caps Lock, Num Lock, or Scroll Lock, so you can hear when these keys are pressed.

✦ **StickyKeys:** Allows you to type combination keystrokes such as Ctrl+P by pressing one key at a time (for example, to press Ctrl+P, press the Ctrl key twice; then press the P key).

✦ **FilterKeys:** Delays or prevents autotype, whereby a character is typed repeatedly when you hold the key down for a brief time.

✦ **MouseKeys:** Allows you to perform mouse functions using the keyboard.

✦ **SerialKeys:** Lets you use alternative input devices rather than a keyboard and/or mouse.

### Activating/Deactivating Accessibility Utilities

After you’ve run the Accessibility Wizard to set up a basic work environment, you might find that you want to fine-tune some of the features or turn specific features on and off as needed. All those features and settings are in a single dialog box named Accessibility Options. To open that dialog box, follow these steps:

1. Click the Start button and choose Control Panel.
2. If Control Panel opens in Categories view, click the Accessibility Options category name.
3. Open the Accessibility Options icon.

The dialog box is divided into five tabs, as shown in Figure 24-16. Each tab offers the option to turn a feature on or off, as well as to adjust settings used by the feature. As in any dialog box, the idea is to choose your options from the various tabs, based on your needs, and click OK.

![Figure 24-16: The Accessibility Options dialog box](image-url)
As an alternative to working your way through the dialog box, you can use the following keyboard shortcuts to turn some of the features on or off right from the keyboard:

✦ **FilterKeys**: Hold down the Shift key on the right for eight seconds.
✦ **High Contrast**: Hold down the left Alt and Shift keys, and tap the Print Screen (PrtScn) key; then release all keys.
✦ **Mousekeys**: Hold down the left Alt and Shift keys; tap the Num Lock key.
✦ **Stickykeys**: Tap the Shift keys five times in a row.
✦ **Toggle keys**: Hold down the Num Lock key for five seconds.

### Accessibility Utilities for Everyone

There’s more to accessibility than the features offered by the Wizard and Accessibility Options dialog box. Windows also offers three utility programs that could be useful to anyone, but are likely to be especially useful in the case of visual or motor impairments. Those three programs are described as follows:

✦ **Magnifier**: Shows the screen area around the mouse pointer magnified at the top of the screen. Click Start and choose All Programs ➪ Accessories ➪ Accessibility ➪ Magnifier to turn this feature on. Click Exit in the dialog box, or right-click the Magnifier taskbar button and choose Close to turn off Magnifier.

✦ **Narrator**: Reads text from the screen aloud. To turn this feature on, Click the Start button and choose All Programs ➪ Accessories ➪ Accessibility ➪ Narrator. To turn it off, click the Exit button in the Narrator dialog box, or right-click the Narrator taskbar button and choose Close.

✦ **On-Screen Keyboard**: Lets you type text by clicking keyboard buttons in the screen. To turn this feature on, click the Start button and choose All Programs ➪ Accessories ➪ Accessibility ➪ On-Screen Keyboard. To close the On-Screen keyboard, click its Close button or right-click its Taskbar button and choose Close.

As an alternative to activating the preceding features using the Start menu, you can pop up the Utility Manager using whichever of the following methods is most convenient for you:

✦ Hold down the Windows key on the keyboard, tap the letter U, and release the Windows key.

**Tip**
The Windows key isn't available on all keyboards. If it is available, it will show a Windows logo and is usually positioned down by the Alt and Ctrl keys.

✦ Click the Start button and choose All Programs ➪ Accessories ➪ Accessibility ➪ Utility Manager.
The Utility Manager displays the current status of the Magnifier, Narrator, and On-Screen keyboard utilities as in the example shown in Figure 24-17. To start or stop a utility, click its name and click the Start or Stop button. At the same time, you can choose other options for that utility, such as *Start automatically when I log in* or *Start automatically when Utility Manager starts*.

![Utility Manager](image)

**Figure 24-17**: The Utility Manager

When you start Magnifier or Narrator from Utility Manager, you’ll see a dialog box for adjusting its settings. Each will also have its own taskbar button, which you can click to get to the dialog box or right-click and choose Close to close the utility.

**About SerialKeys**

Windows XP also supports the use of alternative input devices through its SerialKeys feature. But SerialKeys doesn’t do anything on its own. It simply allows you to connect an alternative input device to Windows. For more information on alternative input devices, visit Microsoft’s Accessibility Web page at [www.Microsoft.com/Enable](http://www.Microsoft.com/Enable). There you’ll also find accessibility options for other programs, such as Microsoft Office and Internet Explorer, as well as step-by-step tutorials for getting the most from accessibility options.

**Summary**

Everyone who uses Windows XP gets to design a unique work environment by customizing his or her desktop, Start menu, taskbar, and Accessibility Options. Here’s a quick summary of the major points covered in this chapter:

- To customize the desktop, right-click the Windows desktop and choose Properties. Or open the Display Properties dialog box via Control Panel.
- To personalize your Start Menu, taskbar, or Notification Area, right-click the Start button and choose Properties. Or open the Taskbar and Start Menu icon in Control Panel.
To create a desktop shortcut to a frequently used program, folder, or
document, right-click that item’s icon and choose Send To ➪ Desktop
(Create Shortcut).

To configure accessibility options for sensory or motor impairments,
click the Start button and choose All Programs ➪ Accessories ➪
Accessibility ➪ Accessibility Wizard.
Expanding Your System

As mentioned early on in this book, Windows XP is computer software. Specifically, Windows XP is your computer’s operating system. Every computer needs an operating system to work, because the operating system pulls together the various components that make up a computer system. The operating system also determines how you, the user, operate the computer.

Windows XP is also your computer’s platform — that term comes from the fact that there are other programs that can run on top of Windows XP. We generally refer to those other programs as application programs, applications, or apps for short. There are literally thousands of optional application programs you can purchase, install, and use with Windows XP. There are also thousands of hardware devices you can purchase, install, and use with Windows XP.

Learning About Hardware and Software for Windows XP

If the whole concept of buying optional hardware and software is new to you, it wouldn’t hurt to just browse around a large computer store or even around one of the large office-supply chain stores just to see what kinds of things are available to you. You can also check out many Windows XP-compatible programs (software) and hardware devices online. Just use your Web browser to go to www.WindowsCatalog.com. When you get to the home page, click the Software tab to view some available programs, or click the Hardware tab to see examples of devices.

After you’re on either of those pages, you can click any category name in the left column. Then click any sub-category name on the next page that appears. You’ll see a listing of Windows XP-compatible products you can purchase and install. (Don’t worry about accidentally
spending any money at WindowsCatalog.com. The Web site is just for looking; you can’t actually purchase anything directly from WindowsCatalog.com.)

Adding hardware to your computer is a two-step process, the second step being the biggie. The two steps are 1) Install the new program or device. 2) Learn how to use the new program or device. The information you need for both steps might be in a manual that came with the product. In the case of software that you download from the Internet, however, the Help that came with that program, or the Web site from which you downloaded the program, will be your only sources of information.

Most companies that produce hardware and software strive to follow certain standards that make installing their products the same as installing anyone else’s products. But it’s not really a great idea to just assume that you already know how to install a particular device or program by some sort of birthright. You should always try to refer to whatever instructions you can find. Nonetheless, if you must wing it, you’ll usually find that the general techniques described in this chapter work just fine.

### Playing It Safe with Installations

When you install new hardware or software, there’s always a slight risk that the product won’t be 100 percent compatible with everything else that’s in your computer. Unfortunately, you won’t know if there’s a problem until after you install the program. By then, the installation procedure has already made some sweeping changes to your system.

### Setting a Restore Point

To play it safe with hardware and software installations, you can set a *restore point* just before you install the product. A restore point is a way of telling Windows to remember exactly how everything is set up right now. Windows then makes a copy of all the *system files* — files created and managed by your computer, as opposed to document files that you create and manage yourself. If you discover problems after installing a new hardware or software product, you can uninstall the product (as described later in this chapter). Then tell Windows to back to those previous system files, where everything was working just fine.

Just before you’re about to install a new product on your computer, you’ll do well to set a restore point. Doing so is quite easy.

### STEPS: Create a Restore Point

1. Click the Start button and choose All Programs ➤ Accessories ➤ System Tools ➤ System Restore. The System Restore window shown in Figure 25-1 opens.
2. Click Create A Restore Point; then click the Next> button.

3. Type a description, using your own wording, of this point (for example, Pre-Web Cam Installation Point if you’re about to install a Web cam).

4. Click the Close button in the next page that appears.

That’s all there is to it. Whether or not you’ll ever need to revert to that restore point remains to be seen. If everything works correctly after the installation, you won’t need to use the new restore point at all. Later in this chapter, you’ll learn how to get back to a restore point, if the situation requires doing so.

**Installing New Software**

Unlike documents, which you can freely copy to your hard disk and use on the spot, any new program you acquire needs to be installed before you can use it. The installation process configures the software to work with your particular hardware and software. The process also creates an icon or program group on your All Programs menu, so you can start the new program as you would any other.

You need to install a program only once, not each time you intend to use it. Once you’ve installed a program, you can put the disk from which you installed away for safekeeping. You’ll need only the original installation disk to reinstall the program if you accidentally delete it from your hard disk or if some sort of hard disk crash damages the program on your hard disk.
Exactly how you install a new program depends on how the program was delivered to you. Programs delivered to you on a CD require one procedure, whereas programs you download require a slightly different procedure. We’ll look at each procedure separately in the sections that follow.

**Installing Software from CDs and Floppies**

Programs sold through computer stores are usually delivered on CD-ROMs, although occasionally you’ll still find programs delivered on floppy disks. Installation is usually pretty simple. With programs delivered on CD, the process usually goes like this:

1. Close all open program windows on your desktop by clicking their Close buttons or by right-clicking their taskbar buttons and choosing Close.
2. Insert the CD into your computer’s CD drive and wait a few seconds.
3. When the installation program appears on the screen, read and follow its instructions until the program is installed.
4. When the installation procedure is complete, remove the CD from your CD drive and store the disk in a safe place.

**If Nothing Happens When You Insert the Disk . . .**

Let’s suppose that you’re trying to install a program that was delivered to you on a floppy disk. Or perhaps the program was delivered on a CD. But when you insert the CD, nothing pops up on your screen automatically. In either case, you need to start the program’s installation process manually. Here’s how:

1. Close all open program windows on your desktop by clicking their Close buttons or by right-clicking their taskbar buttons and choosing Close.
2. After you’ve inserted the disk and waited long enough to ensure that nothing is going to open automatically, click the Start button and choose My Computer.
3. In My Computer, double-click the icon that represents the drive into which you inserted the disk.
4. If just doing Step 2 starts the installation program, skip to Step 6 now. Otherwise:
5. Look for and double-click the icon named Setup or Setup.exe. The picture on that icon will look like the example shown at left.
6. Read and follow the instructions presented in the installation program that opens.
7. When the installation is complete, remove the disk from its drive and put it away for safekeeping.
To start the new program, click the Start button and look around for its icon on the All Programs menu. Then just click the icon that represents the new program.

**Downloading and Installing Programs**

The Web is home to thousands of programs that you can download and install right on the spot. The exact procedure will vary a little from one program to the next. Typically, all the instructions you need will be available on the Web page that allows you to perform the download. You can print that page by choosing File ➪ Print from your Web browser’s menu bar.

**Tip**

The Ultimate Collection of Windows Shareware at www.tucows.com is home to thousands of programs you can download and try out for free.

If you don’t see any installation instructions, but just a link to download the program, go ahead and click that link. Before Windows starts the download, you’ll see the standard warning that appears when you download a program, as shown in Figure 25-2.

![File Download](image)

**Figure 25-2:** The standard warning that appears when you download a program.
You always have to make a judgment call as to the safety of a program you're downloading. If you're downloading from a software manufacturer's Web site, or a service like Tucows (pronounced two cows), mentioned in the preceding tip, you can assume it’s safe to proceed. If you heard about this program through some junk e-mail or dubious Web site, you’re taking a risk if you proceed. If you have any doubts, you’ll do well to click Cancel and forget it. Then go to a reliable service like Tucows and try to find the same program or a similar program there.

Anyway, let's assume that you trust the company providing this program enough to just go ahead and install the program. You have only to click the Open button and follow the instructions on the screen. Once the installation is complete, you can start the program from your All Programs menu.

If you’re not 100-percent sure about the program you’re downloading, you can click the Save button, rather than the Open button, to just copy the program without installing it. After you choose Save, the Save As dialog box will open. There, you can navigate to the folder in which you want to place the file (perhaps a folder named Recent Downloads). Take a look at the file’s name, too, so you can recognize it later. Go ahead and save the file normally.

Next, you can scan the downloaded file for viruses, just to make sure. When you feel confident enough to install the program, go to whatever folder you placed the icon in, and double-click the program’s icon. Then follow the installation instructions that appear on the screen.

As always, once the program is installed, you can start it anytime by clicking its icon on the All Programs menu.

**Installing Missing Windows Components**

As you know, Windows XP comes with several sample programs already built right in. The various programs that come with Windows XP are generally referred to as Windows Components. These programs are generally installed as soon as Windows is installed on your computer. So there’s rarely any need to install such a program. Instead, just work your way to the program’s icon through the All Programs menu, and click the program’s icon.

If, for whatever reason, you happen to find that a component is missing, you can install the component yourself. Most likely, you’ll need to grab your original Microsoft Windows XP CD for this job or grab whatever CD your computer manufacturer provided.

**Tip** Some computer manufacturers configure their systems in such a way that you can install missing Windows components without using a CD. If in doubt, you can try installing the component without a CD.
1. Insert your Windows XP CD into your CD drive and wait a few seconds.

2. If the Welcome to Windows XP window opens, click its Exit button to close that window.

3. Click the Start button and choose Control Panel.

4. Click (or double-click) Add Or Remove Programs.

5. In the left column of the window that opens, click Add/Remove Windows Components. The Windows Components Wizard shown in Figure 25-3 opens.

![Figure 25-3: First page of the Windows Components Wizard](image)

**Caution** Do not clear any existing checkmarks from Windows Components Wizard, as doing so will uninstall the program whose checkmark you cleared.

6. The Accessories and Utilities option is a collection of handy programs and games. To install items from that category, you need to navigate down to the specific components. For example:

   - To get to general components such as Calculator and Paint, click Accessories and Utilities; then click the Details button. Click Accessories in the next page that appears; then click the Details button again.

   - To get to games that come with Windows XP, click Accessories and Utilities; then click the Details button. Click Games in the next page that appears; then click the Details button again.
7. When you see the name of the program you want to install, select (check) its checkbox. You can select multiple items to install in this manner.

8. If you navigated down from Step 6, click the OK button in each open dialog box until you get back to the first Wizard page, which contains a Next> button.

9. Click the Next button. Wait while the Wizard installs the components.

10. When the last Wizard page appears, click Finish.

11. Close the Add or Remove Programs window and Control Panel.

12. Remove the CD from your CD drive, and store it in a safe place.

The newly installed components will be available from the All Programs menu. For example, to get to general Windows Components, click the Start button and choose All Programs ➤ Accessories. To get to games, click the Start button and choose All Programs ➤ Games. Some larger programs, such as Internet Explorer and Windows Messenger, will be right on the All Programs menu.

Installing New Hardware

Installing new hardware can be complicated. First of all, there are internal hardware devices that you have to install inside the computer. (Or get someone to install for you, if you’re not comfortable with taking your computer apart and digging through wires.) Then there’s external hardware, which connects to your computer through a cable and a port (or plug) on the computer.

The exact plugs available on any given computer, where those plugs are, and how they’re arranged vary from one computer to the next. The plugs are rarely labeled. You have to be able to recognize each port by its shape. The cable for any device will fit only in one of those pugs, however, so that is a good clue as to which port you need to use. Figure 25-4 shows some common ports, though your computer’s ports may be arranged differently.

External devices come in two categories as well. There are hot-pluggable devices, which connect to a USB port. To install such a device, see the section “Installing USB Devices” that follows. Then there’s everything else, which connects to one of the ports (other than USB) shown in Figure 25-4. To install one of those devices, see the section “Installing Non-USB Devices” that follows.

Note Many digital video cameras can connect to a computer through an IEEE 1394 (also called FireWire) port. For more information on FireWire, see the section “Getting Video from Your Camcorder” in Chapter 18.
Installing USB Devices

Universal Serial Bus (USB) is a relatively new technology that makes installing hardware simple. Many hardware devices you buy these days connect to the computer through a USB port and cable. The symbol for USB ports and devices is shown at left.

While you should always follow the device manufacturer’s instructions to install a USB device, the general procedure goes like this:

**STEPS: Install a USB Device**

1. Leave your computer turned on and running.
2. If the device needs to be plugged into a wall socket, go ahead and plug it in.
3. If the device has an on/off switch, turn the device off.
4. Connect one end of the USB cable to the device; connect the other end of the USB cable to the computer.
5. Turn the device on using its on/off switch.
6. Keep your eye on the screen and wait a few seconds.
You should see a message, or a series of messages, pop up near the notification area. When you see a message telling you that the product is installed and ready to use, as in the example in Figure 25-5, you’re done. The product is ready to use.

Figure 25-5: Connected USB device installed and ready to use

Installing Non-USB Devices

Hardware devices that don’t plug into a USB (or FireWire) port are not hot-pluggable, which means that the computer must be turned off when you connect the device. Again, I strongly encourage you to follow the device manufacturer’s installation instructions. But in general, the procedure goes like this:

1. Close all open programs and save any work in progress.
2. Shut down windows (click the Start button and choose Turn Off Computer ➔ Turn Off).
3. If your computer doesn’t shut down all the way, turn the computer off using its main power switch.
4. If your device needs to be plugged into a wall socket, go ahead and plug it in.
5. Connect the device to the computer via the appropriate cable.
6. Turn the hardware device on.
7. Turn the computer on last.

As Windows is booting up, it should detect the device. If Windows needs more information or files, you’ll see instructions on the screen. Follow those instructions, and the device should be ready to use by the time you get to the Windows desktop.

Uninstalling Programs

If you have any old programs that you don’t use any more and want to free up the disk space that the program is using, you can uninstall the program. Likewise, if the newly installed program is causing your computer to misbehave, you can uninstall it; then use System Restore to bring back your previous system files.

Keep in mind that it’s never sufficient or safe to just delete the program’s icons or files from your hard disk. When you install a program, it makes certain
changes to your system that need to be unchanged to get your computer back to its previous state.

The terms *uninstall* and *remove* mean to get rid of permanently. If you think there's even an outside chance you'll use the program again, don't remove it. The only way to get an uninstalled program back onto your system is to reinstall it from scratch by using the original installation CD or by downloading the file.

To uninstall a program currently installed on your computer, follow these steps:

**STEPS: Uninstall a Program**

1. If the program is currently open, close it.
2. Click the Start button and choose Control Panel.
3. Click (or double-click) Add or Remove Programs. A list of all programs currently installed on your computer appears in the Add or Remove Programs window, as in the example shown in Figure 25-6.

4. Scroll through the list of installed programs until you find the one you want to remove; then click that program’s name.
5. Click the Change/Remove or Remove (or whatever button appears) after you click the program’s name, and follow the instructions on the screen to completion.
If you see a message indicating that some of the files to be deleted might be shared with other programs, you can choose whichever option allows you to keep those files on the computer. They're tiny files that don't take up much space and will do no harm in left in place.

6. Close the Add or Remove Programs window and Control Panel.

The program has been removed from your computer, and its icon(s) removed from your All Programs menu. If you removed this program because it made your computer unstable, and you set a restore point before installing the program, see the section "Restoring Your System Files," later in this chapter, to go back to your previous restore point.

If you see a bunch of Windows XP Hotfix programs in the Add or Remove Programs window, those are security patches that have been downloaded automatically from the Windows Update Web site. Leave those in place. They make your computer more secure.

Uninstalling Hardware

Uninstalling (removing) hardware is easy for USB devices — a bit more complicated for other types of hardware. But either way, you generally want to tell Windows you’re about to remove the device before you actually remove it. Doing so gives Windows a chance to reconfigure your system to operate correctly without that hardware device.

Removing USB Devices

Certain types of USB devices, such as digital cameras and disk drives, transfer files back and forth to your computer. It’s always a good idea to make sure any open files are closed before you disconnect the device, so you don’t end up with any corrupted files. Here’s how it works:

STEPS: Remove a USB Device

1. Look for a Safely Remove Hardware icon in the notification area, as in the example shown in Figure 25-7 (the tooltip appears when you’re pointing to the correct icon).

2. Double-click the notification icon to open the Safely Remove Hardware dialog box shown in Figure 25-8. Then . . .
If you see the name of the device you’re about to remove, click its name and choose Stop. Click OK in the Stop a Hardware Device dialog box that opens.

If you don’t see the name of the device you’re about to remove, don’t worry about it. It just means there aren’t any open files, so the device need not be stopped.

3. Click the Close button in the Safely Remove Hardware dialog box.

Now you can turn off the USB device and unplug the cable.

Uninstalling Other Types of Hardware

Hardware devices that don’t connect through a USB or FireWire port are a little more complicated to remove. Once you uninstall a device, you won’t be able to use it again unless you reinstall it from scratch. So don’t uninstall any hardware devices just for practice. Know what you’re removing, and why, before you do anything. Then do the following:

**STEPS: Remove a Non-USB Hardware Device**

1. Close all open program windows.
2. Right-click the My Computer icon on your desktop or Start menu and choose Properties. The System Properties dialog box opens.
3. Click the Hardware tab in System Properties; then click the Device Manager button.
4. Click the + sign next to the icon that represents the type of device you’re about to remove; then click the name of the specific device you want to remove, as in the example shown in Figure 25-9.
5. Choose Action ➪ Uninstall from the menu bar in Device Manager, or click the Uninstall button in the toolbar.

6. Read and follow any instructions on the screen to completion.

7. Close all open dialog boxes and windows.

8. Click the Start button and choose Turn Off Computer ➪ Turn Off.

9. When the computer shuts down, disconnect the device from the computer.

10. Turn the computer back on.

The computer should boot up normally to the Windows desktop. If you set a restore point prior to installing the hardware you just removed, see the section "Restoring Your System Files," later in this chapter, to go back to your previous restore point.

Restoring Your System Files

If you set a restore point just before installing a new program or hardware device, then changed your mind and uninstalled that program or device, you can go the extra step and restore all your system files to their previous state. Make sure you uninstall the program or hardware device first. Then follow these steps to restore your system files to the most recent restore point:

Caution: Never use System Restore as an alternative to a simple Undo (Ctrl+Z). Restoring your system files to an earlier time undoes all changes that you've made to your system since setting the restore point. If you installed any new hardware or software since that time, restoring your system files is likely to create a lot more problems than it solves!
STEPS: Restore Your System Files

1. Close all open program windows and save any work in progress.

2. Click the Start button and choose All Programs ➪ Accessories ➪ System Tools ➪ System Restore.

3. In the System Restore window that opens, click *Restore my computer to an earlier time*; then click the Next> button.

4. In the calendar that opens, click the date on which you created the most recent restore point. Restore points from that date will appear in the window to the right.

   Windows XP automatically creates restore points from time to time. You’ll see those listed as System Checkpoint in the pane on the right.

5. Click the name of the restore point you created just before installing your hardware or software, as in the example shown in Figure 25-10; then click the Next> button.

   Figure 25-10: Choosing a recent restore point

6. Click the Next button on the next page that opens.

Your computer will begin its shutdown procedure, and you’ll see a dialog box indicating that system files are being restored. Then the computer will restart from scratch, and you’ll see another message indicating that the restoration was successful. Click the OK button in that message, and you’re done!
Summary

This chapter has been all about expanding your computer system by adding new hardware and software. To summarize the main points covered in this chapter:

✦ Before installing new hardware or software, consider creating a restore point as a safety net, in case things don’t work out as expected.

✦ To install new software from a CD, insert the CD into your CD drive, wait a few seconds, and follow the onscreen instructions.

✦ To download and install a program in one fell swoop, begin the download by clicking the appropriate link. When the File Download dialog box appears, click its Open button, and follow the onscreen instructions.

✦ To install a USB device, leave the computer on but the device turned off. Connect the device to the computer, turn on the device, and watch the notification area for feedback.

✦ To install non-USB hardware, turn off the computer, connect the device, and turn on the device. Turn on the computer last, and watch for any instructions that appear on the screen.

✦ To permanently remove a program from your system, click the Add or Remove Programs option in Control Panel.

✦ To safely disconnect a USB device, first double-click the Safely Remove Hardware icon in the notification area and stop the device. Then disconnect the device from the computer.

✦ To remove non-USB hardware, first uninstall the device via Device Manager. Then shut down the computer, disconnect the device, and restart the computer.

✦ To recover system files from a previous restore point, click the Start button and choose All Programs ➪ Accessories ➪ System Tools ➪ System Restore.
Computer problems will occur, especially if you’re a beginner trying to figure things out as you go along. Fortunately, most of these problems are trivial, resulting in no more than descriptive error messages on the screen and a button to get back to where you left off.

Some problems can be a bit more serious. We sometimes refer to the bigger problems as fatal errors. The word fatal is a bit extreme though. Using a human analogy, I think it would be more accurate to say temporarily unconscious rather than fatal.

Then again, there are big problems, like hard disk crashes that cause you to lose all or most of the contents of your hard disk. These are extremely rare, however. But it certainly can’t hurt to keep backup copies of important files, just in case. In this chapter, you’ll learn strategies for dealing with all types of problems, from small to large.

Dealing with Error Messages

There are lots of little things that can go wrong when using a computer, especially for beginners who are trying to do and learn at the same time (or are skipping the learn part altogether). When little things go wrong, you’ll see some sort of error message on the screen. There are tons of little error messages for different types of errors. Figure 26-1 shows an example of one.

Unfortunately, error messages don’t go to great lengths to explain things. Error messages use all the official buzzwords of the computer biz, which is like Greek (or geek) to the neophyte. Nonetheless, the way to deal
with them is as follows. First of all, read the message. That may seem obvious, but a lot of people just close these little message boxes without reading them first. Bad idea! The message appears for a reason: to tell you what went wrong.

![Error message]

**Figure 26-1:** A sample error message

If the message makes no sense to you, there are a few ways you can get more information.

✦ Some (but not all) error messages contain a Help button, which you can click to get more information about the problem.

✦ If you were trying to accomplish something by guessing, consider using Windows Help and Support to look up a better way to do the job.

✦ If there are specific technical terms in the message that you don’t understand, consider looking up those terms in Windows Help and Support.

**Tip**

The Windows Help and Support Center provides help for Windows only. Just about every program you use will have its own, separate help, which you can get to by choosing Help from that program’s menu bar. See Chapter 3 for more information on Help and Support.

For example, the error message in Figure 26-1 says there was an error copying the file but offers no Help button. A good strategy there would be to open Windows Help and Support, search for the phrase *copy file*, and learn about different ways to copy files. Maybe you can figure out what you did wrong by reading the Help.

**Tip**

The problem in Figure 26-1 is that I tried to copy a folder to itself, which doesn’t really make sense. As discussed in Chapter 19, the term *source* refers to the thing you’re copying, and the term *destination* refers to the place to which you’re copying the item.

If you try to get around the error by doing exactly what you did to create the error message in the first place, guess what? You’ll see the exact same error message again.

If the Help and Support Center is no help, you can break out the big guns and go to [http://search.microsoft.com](http://search.microsoft.com). That Web site contains mountains of information. So you’ll want to type as many significant words as possible from
your error message in your search. You’ll do well to type the letters XP as the first word of your search text, to try to narrow the search to Windows XP issues.

If the error message is related to printing, check out www.microsoft.com/insider/printhelp for possible solutions.

Still, there’s no guarantee that you’ll find your exact error message and simple solution. Sad but true — sometimes you just need to know what you’re doing. There is no single book, or single Web site, that contains everything there is to know, let alone a solution to every problem. But the better you’re able to search for information when you need it, the more likely you’ll be able to solve the problem quickly.

If Windows XP came preinstalled on your computer, your manufacturer’s Web site can also be a great resource for information. If you don’t know the URL, try sticking the company name between www. and .com, as in www.dell.com, www.gateway.com, www.hp.com, www.SystemMax.com, and so forth.

There’s an old saying about knowledge being of two kinds: the things we already know and the things we can find when we need it. Knowing how to use the Help and Support Center is critical to getting the information you need, when you need it.

### Easy Troubleshooting

Windows XP has some built-in troubleshooters that can help you diagnose and solve many problems on your own. To get to the troubleshooters:

1. Click the Start button and choose Help and Support.
2. Click Fixing a Problem (if you see it).

The left column of the Help and Support Center will list many different types of problems, as shown Figure 26-2. Use the scroll bar at the right side of the list to see all of your options; then click whichever option best describes your problem. Finally, click a specific option in the right pane.

Some computer manufacturers replace the built-in Help and Support Center with their own version. If you don’t see Fixing a Problem as an option on the first page of your Help screen, there’s another way to get to them. In the Search box near the top of the Help window, type List of troubleshooters, and press Enter or click the Start Searching button just to the right. Then click List of troubleshooters under Suggested Topics, as shown in Figure 26-3. Scroll through the list of troubleshooters, and click whichever one best describes the problem you’re experiencing.
When you open a troubleshooter, you’ll see a question and some choices. Answer each question as it appears, and click Next. Just follow along, answering questions as they appear and reading and following any instructions on how to fix the problem.
What to Do If the Computer Freezes Up

Some errors are too serious to just display a simple message. Those types of errors are often caused when two or more programs running simultaneously sort of crash into each other in your computer's memory. Because Windows isn’t involved in that problem, it can’t solve the problem. So instead, it just displays some generic, technical error message like *Invalid page fault* or some such thing, followed by a long (and not at all helpful) memory address.

When that happens, your mouse and keyboard may stop responding as well, leaving the computer *hung* or frozen. Sometimes, you can get control of your computer again by opening Task Manager. Try pressing Ctrl+Alt+Del (even if your keyboard doesn’t seem to be working, holding down the Ctrl, Alt, and Delete keys might work). If your mouse is still working, you can right-click the current time and choose Task Manager.

When Task Manager opens, click the Applications tab as in Figure 26-4. Read down the Status column for any program marked *Not responding*. Then click that program’s name, click the End Task button, and be patient. It might take a minute, but hopefully you’ll see a dialog box that offers the option to End Now. Click that button, and be patient for another minute or so.

If Windows can close the offending program or programs, at least you’ll be able to save your work in any other programs that are still open. You should save an unsaved work immediately, close all open programs, and restart the computer.

If you can’t get Task Manager to open at all, you’re only recourse will be to restart the computer. Look around the front of the computer case for a Restart button and press it.
button you can push. If your computer has no such button, you’ll need to turn the computer off using the main power switch. Then turn it back on.

**Getting Information About Your Computer**

If by some miracle you actually get to contact a real live human being to get help with a problem, there’s a good chance the person is going to answer your simple question with a lot of complex questions. The reason goes back to the fact that there are so many different hardware and software products available. It’s difficult to diagnose a specific problem without knowing some facts.

Many questions that you get in response to your question will be about your computer. Few people know what brand of video card or hard disk is in their computer. But you can get all kinds of detailed information like that from the System Information program, shown in Figure 26-5. Here’s how:

> System Information is very technical and not likely to be of much use to anybody except a computer professional.

![Figure 26-5: The System Information window](image)

**STEPS: Get Detailed Information About Your System**

1. Click the Start button and choose All Programs ➤ Accessories ➤ System Tools ➤ System Information.
2. In the left column, click the + sign next to any category name to expand the list.
3. Click a specific subcategory name to see detailed information in the right pane.
You can search System Information for specific information using the Find What textbox near the bottom of the window. For example, if you’re looking for specific information about your computer’s DVD drive, you can type DVD in the Find What box, make sure both checkmarks beneath it are clear, and click Find Next. If you don’t find the information you’re looking for, you can click Find Next again, until you locate the information you need.

If you need to know the version number of a specific program, open that program and choose Help ➤ About from its menu bar.

Fixing Startup Problems

Some problems can prevent your computer from starting normally. The most common problem, and easiest to fix, is the Nonsystem disk or disk error message that appears before you get to the Welcome screen or Windows desktop. The solution to that problem is usually simple: Remove the floppy disk from your floppy disk drive, and remove any CDs or DVD from their drives. Then press the Enter key and wait a few seconds. The computer should start normally; you’re back in business, and you can skip reading the rest of this section.

If that message appears even when there are no disks in any of your removable drives or if your computer begins to start up normally but stops before you get to the Welcome screen or Windows desktop, the problem might be on your hard disk. You can often get around that problem by following these steps:

1. Turn the computer off, then back on.
2. Keep tapping the F8 key as the computer is starting up. When you get to a screen with a bunch of options on it, press the ↓ key until the option Last known good configuration is highlighted.
3. Press the Enter key.

Let’s hope that will solve the problem and you’ll back in business. If that problem occurs every time you start the computer, however, you’ll be wise to restore your system files to an earlier time, as described in a moment.

If your computer won’t start normally and you can’t solve the problem using one of the preceding methods, you can usually start your computer in safe mode. As comforting as that name sounds, it really just means your computer will start with the bare minimum of capabilities, which makes it just usable enough to get the problem fixed. Sometimes, the computer will automatically go to safe mode if there is a problem.

If the computer won’t boot up, and won’t go into safe mode, turn off the computer, turn it back on, and keep tapping the F8 key. You should get to a menu of options with Safe Mode highlighted. Press Enter to select that option and start the computer in safe mode.

You’ll see a dialog box telling you that you’re in safe mode. Click OK in that dialog box, and you’ll be taken to a weird-looking desktop. Despite the screen’s
weirdness, you can click the Start button and choose All Programs ➪ Accessories ➪ System Tools ➪ System Restore to get to the System Restore window. From there, choose the most recent restore point — or the restore point just before that one — and follow the instructions on the screen to restart the computer with the previous system files. If it doesn’t work the first time, try again using an earlier restore point.

See “Restoring Your System Files” in Chapter 25 for more information on System Restore.

If all else fails, it could be a serious error with your hard drive. It would be best to have a professional take a look at the disk before you do anything drastic. But if the drive is damaged beyond repair, you’ve lost your hard drive. And since everything in your computer is stored on the hard drive, that means you’ve lost all your documents, favorites, settings, programs, and everything else.

Never format your hard drive. Doing so will erase Windows, all your programs, and your documents — everything!

The only hope of recovering any data from a ruined hard drive is by sending the drive to a specialized data recovery service. Getting the data off the disk requires a clean room (like an operating room), an expert, time, and money. There’s a risk, too, because there’s no way to know in advance what you’ll actually be able to recover from the drive.

Though such serious hard disk crashes are rare, the best defense is to have backups of all your important files. If you have backups of your important files, you can just trash the old hard drive, put in a new one (which is a lot cheaper than consulting a data recovery service), reinstall Windows, your programs, and your documents.

Making Backups

As mentioned in earlier chapters, everything in your computer, so to speak, is actually stored in folders and files on your hard disk. If your hard disk gets damaged beyond repair, you’ll lose everything in your computer. While such damage is rare, you don’t necessarily want to store hundreds of hours of work on one hard disk. Backup copies of your files provide the safety net you need to recover from a serious hard disk problem.

A backup is an exact copy of the original file, stored on some other disk. It doesn’t matter what type of medium you use. A CD, DVD, Zip disk, another hard disk, or even tape (if you have the patience of a saint) will do just fine.

Large corporations use expensive, complex backup hardware and software to keep copies of their mission-critical data. They even have backup administrators — people whose sole job is to ensure that backups are done right and know how to recover files from the backups in an emergency. As the owner of a PC, it’s unlikely that you’re going to want to spend a ton of money on backup equipment, let alone a full-time backup administrator’s salary.
Many smaller businesses use a technology known as RAID to make backups. This strategy involves using additional hard drives for backups, so you don’t have to fumble around with floppies, CDs, or tapes. The acronym stands for Redundant Array of Inexpensive Drives but is somewhat outdated. You don’t need an array of drives — just one equal in size to your existing drive. At about $1.50 to $2.00 a gigabyte, virtually all hard drives are inexpensive these days. They weren’t so cheap back in the days when RAID was invented.

I haven’t seen RAID offered as an option in any personal computers, even though many modern motherboards ship with RAID capabilities built into them. (The motherboard is a piece of hardware found in every computer.) I can’t really say how much it would cost to add RAID capabilities to a PC. Like everything else in the computer biz, RAID gets cheaper as time goes by.

Yet another option is to buy a third-party backup utility. Last time I checked, there were 65 such products listed in Windows Catalog. To see them, go to www.WindowsUpdate.com. On the home page, click the Software tab. Then click Utilities in the left column. Finally, click the Backup option.

If you’re looking to spend zero dollars and zero cents, you’ll need to learn why there’s a lot more to making backups than just clicking a button. There are tens of thousands of files on your hard disk. And backing them all up is no small feat. If you want to get off cheap, you’ll need strategies for managing your backups. For starters, you need to be able to discriminate among system files, program files, documents, and settings.

## Backing Up Windows and Programs

Most of the files are system files and program files — those files that make up Windows XP and all your programs. Backing up all those system and program files takes a lot of time and a lot of disks. Fortunately, there’s no need to back up your system and program files over and over again, because most of them never change.

Whether or not you even want to bother making backups of those files is questionable, because of the very nature of programs and system files. Unlike documents, which you can just copy to your hard disk and use, programs (that is, system files and program files) need to be installed on your computer to work properly. The installation process configures the program to run properly in your particular hardware and software environment. You can’t take a program installed on one computer and just copy it to another computer and expect it to work. It won’t.

So consider this. Let’s say you have copies of all your installed programs on CDs or some other medium. Your hard disk crashes and you have to replace it. How are you going to get all those programs that were installed on the old hard disk to the new hard disk? And how are you going to be sure that they’ll work on the new hard disk without ever having been installed on that disk? (Remember, you can’t just copy an installed program to another computer; you have to install the program.) They might work. But there’s a big difference between might and will.
Knowing how to do a backup is only a partial solution. You also have to know how to restore from the backup, should you ever need to.

Here’s a strategy that can avoid the whole business of backing up all those tens of thousands of system and program files and living with the anxiety of really not knowing if they’ll do you any good. When you buy a program, it’s usually delivered on a CD. When you buy a computer with software already installed, you usually get an extra copy of all the system files and program files on one or more CDs.

In a sense, those CDs are better than backups, because the copies on the CDs contain the actual installation files needed to install the program. In other words, they’re the very files you need to install the program. So in a sense, you already have backups of all those tens of thousands of program and system files that are on your hard disk. If you lose Windows and all your programs, you can just reinstall them from the original CDs.

Many programs require a serial number or product key to install. You should store all your original CDs, and any serial numbers/product keys, in a safe place. A fireproof safe would be your best bet, as many insurance companies won’t cover software, no matter how you lose it.

Then, of course, there are programs you download for which you don’t have any original CD. Probably the best solution to backing those up is to just remember where you got them. In the unlikely event of a serious disk crash, you could always go back to the Web site and get the latest-and-greatest version of that program. Once again, you’re installing from scratch, which is the proper way to do it.

**Backing Up Documents**

Documents are files you create or download. Reports and letters you type, spreadsheets, pictures, songs, and videos are all examples of documents. You’re free to open and change documents at any time. Thus, unlike system files and program files, documents can, and do, change.

You can easily back up any given document or set of documents just by copying them to a CD or some other removable disk. There’s no need to use fancy backup software there. Just use the built-in copying capabilities discussed in Chapter 19.

Forget about using floppy disks to back up all of your documents. Most likely, you’d need tons of floppies and a lot of time. Use a writable CD, which can hold as much as about 650-700 floppies, or a writable DVD, which can store as much as about 4,500 floppies.
If you use CD-R, DVD-R, or DVD+R disks, you’ll have to start with a new, blank disk each time; once you burn one of those disks, you can’t change its contents in any way. The R disks are often referred to as *distribution media*, because the whole idea is to permanently burn the data to a disk, then ship the disk off to somebody and never see it again. The music industry uses blank CD-R disks to create the music CDs you buy in music stores. The movie industry uses blank DVD-R disks to distribute movies.

CD-RW and DVD-RW are reusable disks, in that you can reuse the same disk for backups over and over again. For this reason, *RW* disks are often referred to as *backup media* rather than distribution media. The main catch there is that you need a CD-RW or DVD-RW disk to even write to those types of disks.

Tip
---
You can’t write to DVDs directly using Windows XP. You need to use DVD-burning software for that. See Chapter 21 for more information on writable CDs and DVDs.

If you keep all your documents in your My Documents and Shared Documents folder, making backups of all those files is relatively easy as well. Just copy each folder to some sort of removable disk, and you have all your backups. Again, no special hardware or software is needed. You just need enough Windows know-how to be able to copy folders. If you lose a document, or all your documents, you just copy them from the backup disk to your hard disk, again using standard Windows tools and techniques.

---

**Messages and Financial Data Are Not Documents**

Not all data is stored in the form of documents, settings, program files, or system files. Take, for instance, e-mail messages. Search as you may, you’ll never find any e-mail messages stored in documents on your hard disk, despite the fact that you may have tons of messages sitting in your e-mail program. Like e-mail messages, certain types of *data files* aren’t exactly documents either. For example, names and addresses stored in e-mail program address books and financial data stored in bookkeeping and accounting programs, don’t qualify as documents.

To make backups of e-mail messages, names and addresses, and financial data, you have to use the same program you use to manage the data. For example, to make backups of e-mail messages with Outlook Express as your e-mail client, you have to use Outlook Express, not Windows. To make backups of Quicken and QuickBooks data, you have to use the Backup options contained within those programs.

For help in backing up e-mail messages, names and addresses, Quicken, QuickBooks, or other data files, open that program’s Help (not Windows XP’s Help) and search for the words *backup* and *restore*. 
Backing Up Settings

Settings files store things such as all the options you’ve selected in all those dialog boxes that Windows offers. The files are tiny. Usually, you can fit them all on two or three blank floppy disks. (Finally, you have a use for that floppy drive!) The problem is that the settings files are scattered about your hard drive and not particularly easy to find. But there’s a tool in Windows that can find them for you. It’s called the Files and Settings Transfer Wizard.

The Files and Settings Transfer Wizard is actually a tool designed to help you transfer documents and settings from an old computer to a new computer that already has Windows and other programs installed on it. But there’s no rule that says you can’t use it to make backup copies of files on your hard disk.

If you have a zip drive, you can copy the settings to a single zip disk, provided there’s at least 4MB of space on the disk. If you want to use floppies, you should have two or three empty disks on hand. I can’t say exactly how many you’ll need; it depends on how many programs with settings are installed on your computer. You’ll want to label the disks something like Settings Backup 1, Settings Backup 2, and so forth, so you can keep track of which is which. Then, to back up your settings files:

1. Insert blank floppy disk #1 into your floppy disk drive.
2. Click the Start button and choose All Programs ➪ Accessories ➪ System Tools ➪ Files and Settings Transfer Wizard.
3. On the first page of the Wizard that opens, click Next.
4. Choose Old Computer from the second page of the Wizard, and click Next.
5. On the third Wizard page, choose Floppy drive or other removable media and 3 ½ Floppy (A:), as in Figure 26-6. Then click Next.
6. Choose Settings Only on the next page and click Next.

![Figure 26-6: Third page of the Files and Settings Transfer Wizard]
The process begins. If you need more than one floppy disk, you’ll see a message telling you how many you need. Just keep that first disk in the drive and click the OK button. If more floppies are needed, you’ll be prompted when to insert them. When the copying is finished, you’ll come to the last Wizard page, where you just click the Finish button. Be sure to put the floppies someplace where you can find them in the event of a hard disk catastrophe.

Should you ever need to recover those settings, install Windows and all your programs to the hard disk first. Then grab your backup floppies (or zip disk) and run the Files and Settings Transfer Wizard again. This time, choose New Computer when the Wizard asks, and follow the onscreen instructions to bring those settings files to your new hard disk.

If you are lucky, you’ll never have to bother with a crashed hard disk. In fact, that’s the most likely scenario. I have a stack of spare hard drives I’ve saved from old computers I’ve long since trashed. I use several other leftover drives as backup drives in other computers. All these spare hard drives outlived the computers in which they were originally installed! I’ve lost only two hard drives over the last 20 years. And that’s only because I worked the poor things to death over a period of many years!

**Summary**

This chapter has been about dealing with common computer problems and steps you can take to protect yourself against data loss. The main points to remember are as follows:

- Minor problems and errors result in only a temporary error message on the screen.
- Windows XP’s Help and Support Center includes some troubleshooters designed to help you diagnose and solve common problems in a step-by-step manner.
- If your computer hangs, you can often free it open by pressing Ctrl+Alt+Del and closing any programs listed as *Not responding*.
- To get technical information about your computer, use System Information in the System Tools menu.
- If your computer won’t start normally from the hard disk, restart the computer, press F8 repeatedly as the computer is warming up, and choose the Last Known Good... or Safe Mode option from the menu that opens.
- When it comes to making backups, there is no simple Make Backup button. You need special hardware, special software, or special know-how.
Warning: You are heading into the technological major leagues. This is not recommended for slow children at play. If you skipped Parts I, II, V, VI (and maybe III and IV) to get here . . . Well, I really don’t know what to say. Except maybe “Good luck” (snicker, snicker). Getting two or more computers to talk to each other is not an undertaking for the technologically faint of heart. It’s outright ugly.

But when it works, it’s great. You don’t have to have a printer for every darn computer in the house. You don’t have to have an Internet account for every computer. You don’t have to fumble around with floppy disks or CDs to get stuff from one computer to another. You just have to know what you’re doing with one computer before you start messing with lots of them. So, consider yourself forewarned as you take a step forward into high-tech big leagues.
Design and Create Your Own Network

If you have two or more computers, you may already be using what’s known as a sneaker network. For example, to get files from one computer to another, you copy files to a floppy of CD. Then you walk over to the other computer and copy the files from the disk to that computer. Wouldn’t it be nice if you could just drag icons from one computer to the other without having to use a floppy or CD?

What if you have several computers, but only one printer, one Internet connection, one DVD burner? Wouldn’t it be nice if all the computers could use that one printer, that one Internet connection, and that one burner? All of these things are possible if you connect the computers to one another in a local area network (LAN).

What Is a LAN?

A local area network (sometimes referred to as a LAN or workgroup) is a small group of computers within a single building or household that can communicate with one another and share resources. A resource is anything useful to the computer. For example:

- All computers in the LAN can use a single printer.
- All computers in the LAN can connect to the Internet through a single modem and Internet account.
- All computers in the LAN can access shared files and folders on any other computer in the LAN.
In addition, you can move and copy files and folders among computers using exactly the same techniques you use to move and copy files among folders on a single computer.

**Tip** If your computer is already part of a LAN, you don’t need to read this chapter. Go straight to Chapter 28 to learn how to use your LAN. If you’re wondering how a LAN works, you can look ahead to Chapter 28 as well.

**Planning a LAN**

To create a LAN, you need a plan and special hardware to make that plan work. For one thing, each computer will need a device known as a network interface card (NIC) or Ethernet card. Those you can purchase and install yourself. But if you get an internal card (one that connects inside the computer) and you’re not big on opening computer cases and fumbling around in wires, you should probably buy the cards and have them installed professionally. There are also external NIC cards, which generally just plug into a USB port on the computer. Those are simple to install.

The exact NIC you get depends on how you want to connect the computers. The traditional way of connecting computers involved using Ethernet cables, specifically designed for connecting computers. But in recent years, engineers have invented many new ways to connect computers using existing phone lines and power lines within the house and even without any cables at all. These more recent methods are often best for household networking, because you don’t have to run cables all through the house to get the computers talking to one another.

Obviously, you’re not going to find any of this specialized hardware at your local supermarket. You need to go to a computer store, one of the large office-supply chain stores, or an online vendor such as LinkSys (www.linksys.com). With that in mind, let’s take a look at some different ways you can create a LAN from two or more computers.

**Caution** I can’t tell you exactly how to install your hardware, because that depends on what you purchase. Be sure the follow the manufacturer’s instructions to correctly install whatever hardware you buy.

**Connect Two Computers in a Traditional LAN**

If you have two computers, and don’t plan on getting more any time soon, you can install an Ethernet card (NIC) in each computer. Then you just need a single Ethernet crossover cable to connect the two computers. The cable must be a crossover, as shown in Figure 27-1, or the connection won’t work.
Connect Three or More Computers in a Traditional LAN

If you have three or more computers to connect, and they’re all in the same room and close to one another, you can use a traditional Ethernet hub and Ethernet cables to connect the computers. You’ll need exactly one NIC and one traditional Ethernet cable (no crossover cables!) for each computer in the LAN. Figure 27-2 shows an example of four computers connected in a traditional LAN. Notice how each computer connects to the hub only — there are no cables that run directly from one computer to another computer.

Connect Computers Without Ethernet Cables

If you want to connect multiple computers in separate rooms, and don’t want to run cables all over the place, you can use the wires already there. You can either use phone jacks (provided those phone jacks are all connected to the same phone number). Or you can use power outlets. These are actually two different technologies, the first called phoneline networking, the other called powerline networking. You have to get hardware designed for one or the other — don’t try to mix and match.

For example, you can a powerline NIC in each computer and connect each computer to a traditional power plug (the same plugs you use for lamps). You’ll also need one hub specifically designed for powerline networks. If you prefer to use phone lines instead of power lines, you’ll need a phoneline NIC for each computer in the LAN. You also need one hub specifically designed for phoneline networks. Figure 27-3 shows an example. The computers in the lower part of the figure would likely be in a different room from the computer shown in the top of that figure.
Figure 27-2: Example of four computers connected in a traditional Ethernet LAN

The network interface card (NIC) used in a phoneline network is often referred to as a *home phoneline network adapter*, abbreviated HPNA.

The advantage to using a phoneline or powerline LAN is that you don’t have to run cables all over the house. The only disadvantage is that these LANS don’t transfer data quite as quickly as a traditional LAN. But it’s not likely that anyone would notice, because when it comes to day-to-day networking tasks, the speed difference is trivial.

**Connecting Computers in a Wireless LAN**

Wireless networking reigns supreme when it comes to convenience and ease of use. As the name implies, with wireless networks you don’t have to run any cables anywhere. Plus, no computer is tied down to any one cable. For example, you can use your notebook computer in any room in the house, or even out on the patio, and still have Internet access without being tied to a cable. Wireless networking is definitely the wave of the future.

The Centrino standard being marketed by Intel Corporation is likely to become the most widely used method of wireless Internet access. When shopping for wireless LAN hardware, Centrino compatibility is a definite plus.
To set up a wireless LAN, you need a wireless NIC for each computer. You also need one Wireless Access Point (WAP) that connects to one computer, as illustrated in Figure 27-4.

The advantages of wireless networking are, of course, the lack of cables and the ease of setting it all up. The only disadvantage is that wireless networking is a little more expensive than traditional Ethernet networking and a little slower. But again, the speed difference is trivial, and I doubt that anyone is going to complain that it’s too slow. (Even the slowest LAN hardware is still a thousand times faster than a dial-up connection to the Internet!)

**Caution** The speed of your LAN is independent of the speed of your Internet connection. If you have a slow dial-up Internet connection before you create your LAN, you’ll still have the same slow connection after you set up your LAN. The only way to speed up your Internet access is to get rid of your dial-up account and get a new broadband account.

One other possible disadvantage with wireless is the occasional blind spot in or around the house, where a notebook computer just can’t seem to get connected to the LAN. But those blind spots tend to be few and far between, as long as you’re within about 300 feet of the Wireless Access Point.
Networking with a Router

In each of the preceding examples, I’ve pictured one computer as already having an Internet connection through a modem. That could be either a dial-up modem or a broadband modem that connects through cable or DSL. From the standpoint of the LAN, it doesn’t matter how the one computer connects to the Internet.

As an alternative to using a modem connected to one computer, and a separate hub to connect the computers in a LAN, you can use a device known as a router. A router plays two roles: It’s both the modem that provides Internet access and the hub that connects all the computers in the LAN together, as illustrated in Figure 27-5. Routers are available for broadband (DSL or Cable) Internet connections only and thus are often referred to as broadband routers.

A router is sometimes referred to as a residential gateway.

The techniques you use to set up a LAN based on a router are slightly different from the techniques used when the hub and modem are separate components. As always, be sure to follow the manufacturer’s instructions to a tee when setting up a network that uses a router.
Mixed Mode Networking

Far be it for me to complicate things, but I don’t want to leave you with the impression that you can use only one type of networking equipment in your LAN. The fact is that you can mix and match to some extent. Doing so can be a real brain challenge, and I wouldn’t recommend it for the technologically faint of heart. But if you already have a traditional Ethernet LAN and want to add computers to it, you can use phoneline, powerline, or wireless networking to add those computers.

Figure 27-6 shows an example similar to the LAN in my own house. (I know you don’t care about my LAN, and I’m not trying to impress you. It’s just an easy example for me to use.) The computers in my office are connected to each other in a traditional LAN. The kids’ computers, which are on another floor on the other side of the house, connect to my LAN through phone lines. Then we have a free-floating notebook computer that connects to my LAN wirelessly.

We all share a single 1,000K cable Internet connection and a single printer, both of which are in my office. I have a collection of about 5,000 songs on one of my computers, which anyone can access and play from any computer in the house. One computer also has a spare hard disk, which every other computer can use for making backups (without fumbling around with removable media like CDs).

I maintain all network security from my office. Each family member has an e-mail account and .NET Passport. I maintain a single spam filter on one computer that cleans out unwanted mail from everyone’s e-mail account every 30
I also have free reign over every file and folder on every computer in the house. But nobody can get to my e-mail, work folders, or anything else I want to keep private. In short, everyone gets to share exactly what I want him or her to share but nothing else. I am the network administrator in this household.

But enough about my boring stuff. The point is, when it comes to networking, the possibilities are endless. All of the examples presented so far are just examples and aren’t intended to show limitations. For example, you can have as many computers as you want in a LAN. You’re not limited to three or four computers. The whole trick is getting the right hardware for your goals and getting it all installed and connected according to the instructions that came with the hardware.

If you order a new broadband Internet account, you can often get your ISP to send somebody out to the house and set up the whole kit and caboodle for you.

Figure 27-6: Example of a LAN that uses traditional, phoneline, and wireless networking to share a printer, files, and Internet connection
Using the Network Setup Wizard

As mentioned, I can’t tell you exactly how to set up your networking hardware — only the people who manufactured your hardware can help with that. So I have to make a big leap here and assume you’ve already set up all your hardware according to the manufacturer’s instructions and that all the computers are connected to a hub (or connected wirelessly).

When all the hardware is installed, and all the computers are connected, you’re almost ready to run the Network Setup Wizard, which will guide you through the process of setting up your LAN. First:

✧ Make sure all hardware devices (computers, printers, modems) are plugged in and turned on.
✧ Restart every computer in the LAN to get to a fresh and clean Windows desktop, with no other programs running to complicate matters.
✧ Know the brand name of your modem or router, so you can recognize its icon later when running the Network Setup Wizard.
✧ Determine which computer (if any) in your LAN will act as the ICS host, as described next.

Determine Your ICS Host

If your LAN is set up like one of the examples shown in Figures 27-1 through 27-4, the computer connected to the modem will be the ICS host (or Internet Connection Sharing Host). In all four of those figures, the computer on the left (which has both a printer and a modem attached to it) is the ICS host. Think of the Internet as a party and the computer with a modem attached as the host of that party. Before you run the Network Setup Wizard, there are some things you need to know about the ICS host:

✧ Before you run the Network Setup Wizard for the first time, make sure you’re sitting at the ICS host computer.
✧ Make sure that the ICS host is online, and stay online, before you run the ICS host. (If you can open a Web page from the ICS host, you know you’re online.)

If you’re using a router, as in Figure 27-5, no computer will act as ICS host. The router itself is the host of the party. So in that case, it doesn’t matter which computer you’re sitting at when you start the Network Setup Wizard. But since you’re going to be the administrator of this network, I suggest that you start at whichever computer you use most often.
Adding Non-XP Computers to the LAN

If you have any computers currently running Windows 98, Windows 98 SE, or Windows ME, and plan to add those to the LAN, you’ll need a blank floppy disk. You should make sure the disk is formatted. Label this disk *XP Network Setup Wizard*, and just keep it handy. The Network Setup Wizard (and I) will tell you when to insert the disk.

**Caution**

You cannot run the Network Setup Wizard on computers running Windows 95, Windows 3, DOS, Linux, or Mac OS. To add a Macintosh to the LAN, you’ll need to refer to the documentation that came with your Mac.

If all of the computers in the LAN are running Windows XP, you won’t need a blank floppy disk.

Running the Network Setup Wizard

With everything else in place, as described previously, you’re ready to change this mass of computer hardware into an actual working LAN. Follow these steps:

**STEPS: Run the Network Setup Wizard**

1. Click the Start button and choose Control Panel.
2. If Control Panel opens in Category View, click Network and Internet Connections. (Otherwise, skip this step.)
3. Open the Network Connections icon. The Network Connections folder opens, looking something like the example shown in Figure 27-7. (Your icons will be different — don’t worry about that.)

![Network Connections](image)

**Figure 27-7:** The Network Connections folder

4. In the Explorer bar at the left side of Network Connections, click *Set up a home or small office network*. The first page of the Network Setup Wizard opens. Click its Next button.
5. The second page of the Wizard tells you to do all the things I already told you to do. Click Next.

6. The next Wizard page will look like one of the examples shown in Figure 27-8. Choose one of the options I’ve marked as Option A, Option B, or Option C as follows:

![Network Setup Wizard](image)

Figure 27-8: Internet connection options in the Network Setup Wizard

- **Option A**: If you are currently sitting at the computer that will act as the ICS host, choose this option.
- **Option B**: If your network uses a broadband router (where there is no ICS host), choose this option.
- **Option C**: Choose this option only on computers that will get their Internet access from an ICS host. Don’t choose this option on the ICS host or on any computers connected to a broadband router.

7. Click the Next button. If you see an option titled *Determine the appropriate connections for me (Recommended)*, choose that option. Or if you see a list of possible connections as in Figure 27-9, click the one that represents your modem (this is why you need to know the brand name of your modem); then click Next.
Figure 27-9: Here I chose my RCA USB Cable Modem as the device that connects this computer to the Internet.

Caution If your computer has a FireWire port, it may appear as a 1394 Net Adapter in the Network Setup Wizard. It’s extremely unlikely that you’ll use that for networking. So if faced with 1394 Net Adapter as an option, it’s safe to assume that’s not the connection you want to use here.

8. On the next Wizard page, enter a brief description of the computer at which you’re sitting, such as Wanda’s room or Family Room. Then enter an even briefer, one-word name with no spaces or punctuation (such as DAD, NOTEBOOK, or KITCHEN).

Caution Some ISPs require that you use a specific computer name. If you already see such a name in the Computer name textbox, don’t change it, or you’ll lose the ability to get online.

9. The next Wizard page asks for a Workgroup name. You must use exactly the same name on every computer in the LAN. (Even a slight misspelling is deadly.) To prevent typos, your best bet might be to use the name already typed. Then click Next.

10. The next Wizard page presents a summary of the selections you’ve made so far. Click the Next button, and wait as Windows configures the computer to access the LAN. Eventually, you’ll see the page shown in Figure 27-10. What you do there depends on your future plans, as follows:
• If you will be adding a Windows 98, Windows 98 SE, or Windows ME computer to this LAN, choose Create a Network Setup Disk; click Next, and follow the onscreen instructions to create that XP Network Setup Disk described earlier in this chapter.

• If you’re sitting at a Windows 98, Windows 98 SE, or Windows ME computer, and have that XP Network Setup Disk floppy in hand, choose Use the Network Setup Disk I already have; click Next, and follow the onscreen instructions.

• If you’re sitting at a Windows 98, Windows 98 SE, or Windows ME computer that doesn’t have a floppy drive, insert your original Microsoft Windows XP CD into the computer’s CD drive, and choose Use my Windows XP CD. Click Next, and follow the onscreen instructions.

• If the other computers you plan to add to the LAN are all using Windows XP, choose Just Finish the wizard. I don’t need to run the wizard on other computers. Click Next.

11. When you’ve completed the Wizard, you’ll come to its last page, where you can click the Finish button. You can close the Network Connections folder as well. You’re done setting up this computer.

You need to go to each computer in the LAN and run the Windows XP Network Setup Wizard on that computer. Don’t expect anything to work until you’ve done so. Exactly how you do that depends on those other computers. Exactly how you run the Network Setup Disk on each of the other computers depends on what operating system it’s using:

✦ To run the Network Setup Wizard on another Windows XP computer, just begin at Step 1 under “STEPS: Run the Network Setup Wizard” earlier in this chapter. No need for any floppy disks or CDs.
To run the Network Setup Wizard on a Windows 98, Windows 98 SE, or Windows ME computer that has a floppy drive, insert the XP Network Setup Disk you created on the first computer into that computer’s floppy drive. Open the My Computer folder on that computer, double-click the icon for the floppy disk drive, double-click the netsetup icon on the floppy disk, and follow the instructions on the screen.

To run the Network Setup Wizard on a Windows 98, Windows 98 SE, or Windows ME computer that has no floppy disk drive, insert your original Windows XP CD into the CD drive of that computer, and wait for some options to appear on your screen. Click Perform additional tasks; then click Set up home or small office networking, and follow the onscreen instructions.

After you’ve run the Network Setup Wizard on every computer in the LAN, you’re ready to test your LAN, as discussed next.

Using the Internet in a LAN

Accessing the Internet from any computer in a local area network is largely a transparent operation, in the sense that each user at each computer should be able to just open his or her Web browser or e-mail client and access the Internet normally. No extra steps should be necessary. There are a couple of gotchas to be aware of, though:

✦ If one of the computers is acting as an ICS host, that computer must be running and online for other computers to access the Internet.

✦ If you use a router rather than an ICS to share an Internet connection, there is no ICS host, so only the computer trying to access the Internet needs to be running.

Dial-up Internet accounts and local area networks don’t mix well — just about everyone who has a LAN also has a broadband Internet connection, which is accessible to all computers in the LAN, as long as the ICS host is running. Plus, all computers in the LAN must share (split up) the available bandwidth. And with a dial-up account, there’s very little bandwidth to share!

If you can’t get a computer other than the ICS host to access the Internet, you’ll need to make sure the modem that provides access is shared. To do so, get to your Network Connections folder and take a close look at the icon that represents your modem. If it’s shared, its icon will show a little sharing hand, as in the left side of Figure 27-11.
To share the modem and to verify that it’s configured correctly, right-click the modem’s icon and choose Properties. Click the Advanced tab in the Properties dialog box that opens. Make sure the second option, *allow other network users to connect through this computer’s Internet connection*, is selected (checked). To protect all computers in the LAN from hacking, also select the *Protect my computer and network by limiting or preventing access to this computer from the Internet* option, as on the right side of Figure 27-11. Then click OK.

To play it extra safe, close the Network Connections folder, and restart the ICS host. If problems persist, consider restarting other computers in the LAN after the ICS host boots up.

**Securing a LAN**

A local area network connected to the Internet has the same Internet security threats as a single computer connected to the Internet. How you deal with the problem varies with different types of hardware. You may want to refer to the documentation that came with the hardware for specifics. However, the general rule of thumb is that, if you’re using an ICS host, you only need to enable the Internet Connection Firewall on that one computer, as shown back in Figure 27-11. Doing so will block hacking attempts for all computers in the LAN.

If you enable the Internet Connection Firewall on computers other than the ICS host, you may prevent the LAN from sharing resources. I say *may* because when Windows XP originally shipped, that was how things worked. However, several months later, Microsoft made a change that allows computers in a LAN to share resources, even when their firewalls are turned on.

That change is in one of the automatic updates described in Chapter 13. So if you’re all caught up on updates, it really doesn’t matter whether individual computers have their firewalls up or not. (Since hacking attempts are blocked at the modem, before they get to any computers in the LAN, it’s really only necessary to activate the firewall on the ICS host — not on every computer in the LAN.)
Enabling/disabling the firewall is the same on all types of network connections. While sitting at the computer on which you want to disable the Internet Connection Firewall, open its Network Connections folder. Then right-click the icon that represents that computer’s network interface card (NIC) and choose Properties. Click the Advanced tab.

With a router, firewalls are a little trickier, because each computer in the LAN has its own connection to the Internet through the router. However, virtually all routers (that I know of) have a firewall or NAT (Network Address Translation) built right into them. So once again, hacking attempts get blocked before they reach any computer in the network. Technically, it’s not really necessary to enable the firewall in any computer on the LAN when there’s a router involved. However, if you’re up to date with Windows Updates, enabling the firewall on individual computers couldn’t hurt and wouldn’t prevent normal sharing of resources.

**Beyond Firewalls**

Of course, firewalls block hackers and worms only. They don’t block viruses or other malicious code sent in e-mail attachments or stored in programs you can download from the Internet. Each computer in the LAN needs its own virus protection.

Each computer in the LAN needs to be up to date with Windows Update to maximize its security. So you may want to enable automatic updating on each computer, as discussed in Chapter 13.

**Testing and Troubleshooting Your LAN**

By the time you read this, you should have already set up all of your network hardware and run the Network Setup Wizard on every computer in your LAN. Now for the moment of truth (drum roll). Let’s see if your computers know about each other. Here’s how:

1. Go to any computer in the LAN, click the Start button, and choose My Documents.
4. Give the computer a second to go out and gather up all the names of other computers in the network.

You should see an icon for each computer currently turned on and part of the LAN. Figure 27-12 shows an example. The icons in your folder will reflect the names and descriptions you gave to computers in your own LAN, of course, not the icons shown in the figure.
Figure 27-12: An example of computers in a LAN showing up under View Workgroup Computers

If icons don’t appear right away after you choose View Workgroup Computers, choose View ➪ Refresh from the menu bar. You may need to do that a few times, especially if you’re walking from computer to computer to verify their connections.

**Tip**

You can add icons for My Network Places and Network Connections to your Start menu. Right-click the Start button and choose Properties. Click the Customize button; then click the Advanced tab. Scroll through the list of Start Menu Items and choose My Network Places, and Link To Network Connections Folder. Then click OK.

If you double-click the icon for a computer in your LAN, you’ll see icons representing that computer’s shared resources, assuming that computer is turned on and running.

If you weren’t able to see icons for all the computers in your LAN, don’t panic. Sometimes a little wake-up call is all it takes. Carefully check all cables to make sure they’re tight and connected where they should be. Restart each computer after verifying that its cables are snug in their plugs.

**Tip**

Any device or computer not turned on is inaccessible to the LAN. In fact, from a network standpoint, any device currently turned off doesn’t even exist.

If a particular computer still won’t cooperate, run the Network Setup Wizard on that computer again. And don’t expect things to be to speedy when you’re first browsing around in the My Network Places and View Workgroup Computers folders. It takes a few minutes for all the computers to figure out who’s sharing what. Once things get settled in, things will move much more quickly.

**Network Troubleshooting**

If you’re fortunate, you won’t have to do this. But if you tried every alternative can’t see icons for all the computers in your LAN in View Network Computers, you have some troubleshooting to do. Fortunately, most network problems
turn out to be something minor rather than some big technical brouhaha. The most common problems are:

✦ A device (computer, modem, hub, or printer) is turned off and needs to be turned back on.
✦ A cable is unplugged somewhere or isn’t properly seated in its plug.
✦ A wireless networking card on a laptop computer isn’t properly seated in its PC Card slot.
✦ A computer needs to be restarted, because something wasn’t turned on or properly installed when the computer was first started.

If you’ve checked and rechecked all the connections and still can’t see other computers in the network through View Network Computers, the next step is to run the Network Troubleshooter. Here’s how:

1. Click the Start button and choose Help and Support. Then . . .
   • If you see a Fixing a Problem option in your Help and Support Center, click that; then click Networking Problems in the left pane, and click Home and Small Office Networking Troubleshooter in the right pane. Go to Step 2.
   • Otherwise, type troubleshooters in the Search textbox in help, and press Enter. Then click Home and Small Office Networking Troubleshooter in the left pane.

2. Answer the first question in the Networking Troubleshooter (Figure 27-13), and click Next. Continue answering each question to the best of your ability, followed by a click on the Next button.
The troubleshooter might able to help you solve the problem. Don’t be afraid to poke around through available resources, as described in Chapter 28. You never know — sometimes a computer that doesn’t show up under View Workgroup Computers might actually be there, sharing some of its resources.

You Did It!

When you get the LAN working, give yourself a big pat on the back. Creating a LAN is no small technological feat. They should give away trophies, or at least a T-shirt, to people who accomplish this task. But, alas, the only reward is the tremendous power and convenience of having all your computers talking to each other in a LAN.

Summary

Let’s review the main points covered in this chapter before we move on to Chapter 28, where you’ll learn how to use the LAN you worked so hard to create:

✦ A local area network allows computers in a home or building to share resources.
✦ A resource is anything useful, such as an Internet account, a printer, or a folder that contains files useful to everyone on the LAN.
✦ To create a LAN, you need to purchase and install networking hardware.
✦ You can connect computers using traditional Ethernet cables, phone lines, and power lines already in your house, or even wirelessly with no cables at all.
✦ The first step in creating the LAN is to install all the networking hardware according to the hardware manufacturer’s instructions.
✦ Once all the hardware is in place, you need to run the Windows XP Network Setup Wizard on each computer in the LAN.
✦ To view all the computers in a LAN, open your My Network Places folder, and click View Workgroup Computers.
✦ To use the Internet from any computer in the LAN, just start any Internet-related program normally (for example, a Web browser or e-mail client).
✦ To troubleshoot a LAN, first check the most likely problems (power turned off on a computer or device, loose or disconnected cable, or firewall turned on even though the computer isn’t the ICS host). Use the Network Troubleshooter to help with subtle problems.
A local area network (LAN) consists of two or more computers connected through some sort of networking hardware. In a local area network, you can use shared resources from other computers in much the same way as you use local resources on your own computer. In fact, the way you do things in a local area network is almost identical to the way you do things on a single computer.

For example, everything you learned about printing documents on your own computer earlier in this book works just as well for printing on a network printer.

Opening a document on some other computer in a network is no different from opening a document on your own computer. Moving and copying files among computers in a network is the same as moving and copying files among folders on your own computer.

Some Networking Buzzwords

Like everything else computerish, networking has its own set of buzzwords. All the buzzwords you learned in earlier chapters still apply. But there are some new words to learn, as defined here:

- **Resource**: Anything useful, including a folder, a printer, or other device.
- **Shared**: A resource accessible to all users on a computer and to all computers within a network. A shared folder is often referred to as a *share* or *network share*. 
✦ **Local computer**: The computer at which you’re currently sitting.

✦ **Local resource**: A folder, printer, or other useful thing on the local computer or directly connected to the local computer by a cable. For example, if there’s a printer connected to your computer by a cable, it’s a local resource (or more specifically, a *local printer*).

✦ **Remote computer**: Any computer in the network other than the one at which you’re currently sitting.

✦ **Remote resource**: A folder, printer, or other useful thing on some computer other than the local computer. For example, a printer connected to someone else’s computer on the network is a remote resource (or more specifically, a *remote printer*).

Figure 28-1 shows an example of how the terms *local* and *remote* are always used in reference to the computer at which you’re currently sitting.

---

**Figure 28-1**: Examples of local and remote resources, from your perspective
Using a Shared Printer

On a network, anybody can use a shared printer connected to any computer in the network. Printing to a shared printer is no different from printing to a local printer. The steps are the same:

**STEPS: Print Using a Network Printer**

1. While viewing the document you want to print, do whichever of the following is most convenient for you:
   - Choose File ➪ Print from the program’s menu bar.
   - Press Ctrl+P.
   - In some cases, you can just right-click the text you want to print and choose Print.

2. Click the name of the printer you want to use, or choose its name from the Printer drop-down list, as in the examples shown in Figure 28-2.

3. Click the Print button in the dialog box to start printing.

If the document fails to print, the computer or printer you’re trying to use may be turned off. You’ll need to make sure both of those devices are turned on before you can use the printer.

If a printer on the network doesn’t show up in your Print dialog box, either the printer isn’t shared, or your computer doesn’t know that the shared printer is available. Both problems are easily fixed, as described in the next sections.
Sharing a Printer

Printers in a local area network will usually be connected to one of the computers in that network. To ensure that the printer is shared, so everybody in the network can use it, follow these steps:

With the right hardware, you can connect a printer directly to a LAN without going through a computer. With that type of arrangement, you need only to make sure that the printer is turned on.

**STEPS: Share a Printer on a Network**

1. Go to the computer to which the printer is connected by cable. If either is turned off, turn on the printer first and the computer second.

2. Click the Start button and choose Printers and Faxes. Or, if that option isn’t available, click the Start button, and choose Control Panel. Click Printers and Faxes (if you see that option); then open the Printers and Faxes icon.

3. Click the icon that represents the printer you want to share.

4. Click Share this Printer under Printer Tasks in the Explorer bar. Or right-click the printer’s icon, chose Properties, and click the Sharing tab in the dialog box that opens.

5. Choose Share this Printer; then type a name for the printer as in the example shown in Figure 28-3. Click OK in the dialog box.

![Figure 28-3: Sharing a printer](image)

The printer’s icon will show a little sharing hand, as in the example shown at left. The printer should show up automatically in all network computers’ Print dialog boxes. In case the printer doesn’t show up on a particular computer, the next section will explain how to make it show up.

To add a Printers and Faxes option to your Start menu, right-click the Start button and choose Properties. Click the Customize button; then click the Advanced tab in the dialog box that opens. Select (check) Printers and Faxes in the list of Start Menu Items. Click OK.
Adding a Shared Printer to Your Computer

If you know that a printer on the network is shared, but you still can’t access the printer from your computer, add the printer to your Printers and Faxes folder manually. Here’s how:

**STEPS: Add a Shared Printer to a Network Computer**

1. Make sure the printer, and the computer to which it’s attached, are turned on and shared.
2. Sit at the computer that cannot access the shared printer.
3. Click the Start button and choose Printers and Faxes. Or click the Start button and choose Control Panel. Click Printers and Faxes (if you see that option); then open the Printers and Faxes icon.
5. Choose *A network printer or a printer attached to another computer*; then click Next.
6. Choose Browse for a printer. Click Next.
7. Scroll through the list of available printers until you find the one you want. Click the printer’s name. Click Next.
8. Follow any additional instructions that appear on the screen; then click Finish on the last Wizard page.

An icon for the printer will appear in your Printers and Faxes folder. If you want to make that printer your default (which means, it’s the printer used automatically if you don’t specify a different printer), right-click the printer’s icon and choose Set as Default Printer. The default printer’s icon will display a white checkmark in a black circle.

Close the Printers and Faxes window. You should be able to access the printer from any program’s Print dialog box as described in the section “STEPS: Print Using a Network Printer,” earlier in this chapter.

Using Shared Documents and Folders

Every Windows XP computer in a network has a Shared Documents folder. The subfolders and documents in the Shared Documents folder are available to everyone in the network. Files and subfolders in your My Documents folder are private, meaning they’re invisible to other computers in the network and can’t be accessed from the network.

If you want to share some of the documents currently in your My Documents folder (or any subfolder within My Documents), you can just move or copy those documents to an appropriate Shared... folder on your local computer. For example, moving songs from your My Music folder to your Shared Music...
folder will instantly make all those songs available to every computer in the network. You can use any of the techniques described in Chapter 19 to move and copy files between folders on your My . . . folders and your Shared . . . folders.

If you move a document to a shared folder, there will still be only one copy of the document on the entire network. So, if some other user on the network changes the document, you’re stuck with the changes.

If you want other users to be able to play around with the document, but not change your original, copy (don’t move) the document to the shared folder instead. The copy in your My Documents folder will remain invisible to other users, so they can’t even see it, let alone change it. Whatever havoc other users wreak on the shared copy of the document won’t affect the copy in your My Documents folder at all.

**Using My Network Places**

All of the shared folders and documents in a network are neatly bundled together in a single folder named My Network Places. To get to all shared folders and documents on the network, open your My Network Places folder. There are two quick and easy ways to do that, as illustrated in Figure 28-4 and described here:

![Figure 28-4: Two quick routes to your My Network Places folders](image-url)
Click the Start button and choose My Network Places.

Open your My Documents folder. (Click the Start button, and choose My Documents.) Then click My Network Places under Other Places in the Explorer bar.

If you don’t see My Network Places on your Start menu, and want to add it, follow these steps:

1. Right-click the Start button and choose Properties.
2. Make sure Start Menu (not Classic Start Menu) is selected. Then click the Customize button next to Start Menu.
3. In the Customize Start Menu dialog box that opens, click the Advanced Tab.
4. In the list of Start Menu Items that appears, scroll down to and select (check) My Network Places.
   
   **Tip**
   While you’re in the Start Menu Items list, feel free to choose any other items you care to place on your Start menu.

5. Click the OK button in both open dialog boxes.

From now on, whenever you click the Start button, the Start menu will display all the items you selected in the Start Menu Items list. Now let’s get back to networking.

**Opening Shared Documents and Folders**

To open, edit, or print a document on a remote computer, it’s not necessary to copy that file to your computer first. You can just open it from its current location by following these steps:

**STEPS: Open a Shared Folder or Document**

1. From your own computer, open My Network Places. The folder containing icons for all shared resources to which you have access opens, as in the example shown in Figure 28-5.

   **Tip**
   If My Network Places doesn’t show everything you were expecting it to show, choose View ➪ Refresh from its menu bar. It may take a few seconds for all icons to appear.

2. Double-click the icon that represents the folder that contains the document you want to open. If necessary, navigate through subfolders until you find the document you want.
Figure 28-5: A sample My Network Places folder

In My Network Places, Icons that look like folders represent shared folders on the local area network. Other icons might represent sites on the Internet to which you can upload files.

3. Double-click the icon for the document you want to open. Or right-click the document’s icon and choose Open With and the program you want to use.

The document should open normally on your computer — no differently from a document stored on your own computer’s hard disk. If the document won’t open because you don’t have an appropriate program installed on your computer, see the “What About Sharing Programs?” sidebar that follows.

If you can’t even find the shared document you’re searching for, there are several possible causes:

✦ The computer on which the shared resource resides is turned off. You’ll need to start that computer normally to access its shared resources.
✦ The resource you’re trying to access isn’t shared. You’ll need to go to the computer on which the document resides and move it to a shared folder or share the folder in which the document is currently stored.
✦ The folder you need to access is already shared, but needs to be added to your local computer’s My Network Places folder manually.

Solutions to the latter two problems are described in the sections that follow. But first, there’s the possibility that when you double-click a shared folder’s icon, the folder won’t even open. Instead, you’ll see an error message like the one in Figure 28-6.
One possible cause for the error is that the computer sharing the folder isn’t connected to the network or isn’t turned on. But an even more perplexing possibility is that the whole computer is being protected by a firewall. The only computer that needs firewall protection is the ICS host. A connection to a local area network really doesn’t need firewall protection, because you can’t hack one computer in a LAN from another computer in the same LAN.

So, the solution, if it’s a firewall problem, is to go to the computer on which the shared folder is stored. Open that computer’s Network Connections folder. Right-click the icon that represents that computer’s connection to the local area network, and turn off its firewall. See the section “Securing a LAN” in Chapter 27 for details.

**Sharing Folders**

All documents within a shared folder — including documents within subfolders of that shared folder — are accessible to all users of the network. If you’re using an older version of Windows that doesn’t have a Shared Documents folder, you can create a folder and share it. Or you can just share the folder as it stands. While the exact techniques and dialog boxes for sharing folders vary slightly from one version of Windows to the next, the general procedure described as follows will usually do the trick:

**STEPS: Share a Folder**

1. On your local computer, open My Documents, and navigate to the parent of the folder you want to share, so you can see the icon that represents the folder you want to share.

2. Right-click the icon of the folder you wish to share and choose Sharing and Security.

   **Tip** In some versions of Windows, you may have to right-click the icon, choose Properties, and look for the Sharing options within the dialog box that opens. If in doubt, search that version of Windows’ Help for *share*.

3. On the Sharing tab of the dialog box that opens, choose Share this folder on the network, as in Figure 28-7.
4. Optionally, do either or both of the following:

- Give this folder a unique name, which will appear only in My Network Places. On your own computer, the folder will retain its original name.

- If you want other users to be able open and change the documents in the folder, select the Allow network users to change my files option. If you want only others users to open and view — but not change — documents in the folder, clear the same checkbox.

5. Click OK in the dialog box.

**What About Sharing Programs?**

While you can share folders and documents freely on a LAN, there’s no way to share programs. You can only run programs currently installed on your computer and accessible from your All Programs menu. If you try to open a document on another computer, but don’t have the appropriate program for that document type, you can’t open the document.

Don’t bother trying to copy an installed program from one computer to another — it won’t work. Only programs that you specifically install on your own computer will run on your computer.

The only solution will be to install the necessary program on your own computer. If the program you need is a freebie, like Adobe Acrobat Reader, you can download and install the program in the usual manner. (For Acrobat Reader, go to www.adobe.com and click Get Acrobat Reader.)
Once shared, the folder’s icon will display the sharing hand, as in the example shown at left. To unshare the folder at any time in the future — so network users can’t get to it anymore — repeat the preceding steps and click the Share this folder on the network checkbox.

If the Shared Documents folder from the local computer isn’t showing in My Network Places on other computers, open My Computer on the local computer. Then right-click the icon for Shared Documents and share it on the network, as described in the preceding steps.

The folder should show up in My Network Places on all computers throughout the network automatically. If it doesn’t, there are solutions to that problem, too, as discussed next.

Adding a Shared Folder to Your My Network Places Folder

Normally, your My Network Places folder will keep itself up to date, always showing shared folders from all computers in the network. Once in a while, you might need to give it a little slap upside the head, by choosing View ➤ Refresh from its menu bar, to make it go out and check again. But if you know for certain that there’s some shared folder out there in the network that isn’t showing up, you can manually add that folder by performing the following steps:

**STEPS: Add a Shared Folder to My Network Places**

1. On your local computer, open you My Network Places folder.
2. Under Network Tasks in the Explorer bar, click Add a network place. The first page of the Add Network Place Wizard opens. Click its Next button.
3. In the next Wizard page, click Choose another network location; then click Next.
4. Click the Browse button on the next Wizard page.
5. In the Browse For Folder dialog box that opens, expand the Entire Network and Microsoft Windows Network names by clicking the + signs.
6. Expand the name that represents your workgroup (typically Mshome or Workgroup).
7. Click the + sign next to the name of the computer on which the shared folder is located. Shared folders on that computer are listed below the computer name, as in the example shown in Figure 28-8.
8. Click the name of the folder for which you need an icon; then click OK in the Browser for Folders button. Click the Next button in the Wizard.

9. A suggested name for the icon appears. You can change that name, if you like, to something more meaningful. (The name change will be applied to your My Network Places folder only.) Then click Next.

10. On the last Wizard page, select or clear the checkbox, depending on whether or not you want to open the folder immediately; then click the Finish button.

An icon for the shared folder will be visible in your My Network Places folder from now on. So you can just double-click that icon at any time in the future to open the folder and view its current content.

Tip You're free to rename icons in your My Network Places folder as you see fit (right-click any icon and choose Rename). The new names won’t have any effect on names outside of your folder.

**Moving and Copying Files on a LAN**

Moving and copying files on a LAN is virtually identical to doing so on a single computer. You can use any of the techniques described in Chapter 19 to move or copy files around on any computer or from one computer to another. As always, there will be a source folder and a destination folder.

For example, let’s say you have a lot of songs in your My Music folder that you want to make accessible to all the computers in the LAN. But while you’re at it, you decide to put them in someone else’s Shared Music folder, rather than in your own Shared Music folder, to reclaim the hard-disk space they’re taking up on your computer.
If you want to do the drag-and-drop method using two open folders, first navigate to your own local My Music folder. Shrink that window a bit to make room for another folder.

Next, open your My Network Places folder, and navigate to the folder to which you want to move the files. For example, in Figure 28-9, the folder in the upper-left corner is on the local computer — the computer at which I’m currently sitting as I write this.

The folder in the lower right of Figure 28-9 is the Shared Music folder on a completely different computer named Homie. I opened that folder by opening My Network Places on my local computer and just drilling down from the Shared Docs folder on Homie.

Note the name of the source folder in the upper left, as it appears in the Address bar: C:\Documents and Settings\Alan\My Documents\My Music. The C:\ at the start of that name tells me that I’m looking at files on my own local hard disk, drive C:\.

Next, look at the name in the destination folder’s Address bar, \\Homie\shareddocs\My Music. The \\Homie part at the front of that name tells me that I’m looking at the Shared Music folder on the computer named Homie, not on my own local computer.

Figure 28-9: Source folder (upper left) and destination folder (lower right)
Unlike the path to a resource on your local hard disk, which always starts with C:\, the path to another computer follows the Universal Naming Convention (UNC), where the remote computer’s name appears first, after two backslashes. For example, \Homie represents a shared resource on a remote computer named Homie.

The rest is easy. Select the files to move or copy in the source folder, right-drag them to the destination folder, release the mouse button, and choose Move Here or Copy Here (depending on which you want to do). This is the same as moving or copying files between two folders on my own hard disk. The fact there are two separate computers involved here is irrelevant and has no bearing on how you select, move, or copy the files. Adios, sneaker net!

Summary

Whew, this last part of the book has been a whirlwind tour of creating and using a local area network. In truth, networking is one of those topics one could easily write an entire book about. And certainly many people have. But the basic things you need to know to take advantage of a network for day-to-day tasks are all summed up right here in one chapter. To recap:

✦ In a network, a local resource is something on your own computer’s hard disk or a device installed on your own computer.
✦ A remote resource is any device or folder in, or on, some other computer in the network and shared so everyone in the network can use it.
✦ To use a remote printer, just print your document normally. But when you get to the Print dialog box, choose the remote printer’s name.
✦ To get to a remote document in a shared folder, open your My Network Places folder. Then open the folder (or parent folder) to the document you want to open.
✦ To move and copy files between computers in a network, use the same techniques you use to move and copy files on your own network. The remote folder can be either the source folder or the destination folder.
Installing Windows XP

If you purchased your PC with Windows XP already installed, you need to hang a U-turn. There’s nothing in Appendix A for you. Go straight to the introduction, or Chapter 1, at the start of this book, and forget all about this appendix.

If you purchased an upgrade version of Windows XP to replace your current Windows 98 or Windows ME, and you haven’t yet installed that upgrade, this is the place to be. To tell you the truth, you really don’t have to read this entire appendix to install your upgrade. You really just have to do this:

1. Insert the CD that came with your Windows XP Upgrade into your computer’s CD drive and wait a few seconds.
2. Follow the instructions that appear on the screen to install XP by upgrading your current version of Windows.

When the installation is complete, remove the new CD from your CD-ROM drive, put it someplace safe, and ignore the rest of this appendix. If these two steps don’t quite get the job done, please read on.

Windows XP System Requirements

For the more technically savvy readers who know what things like RAM and hard disk capacity are about, here are the absolute, bare-minimum requirements for installing Windows XP:

- 128MB of RAM (though 256MB is more like it)
- A 233 megahertz (MHz) Pentium/Celeron or equivalent microprocessor
A 2GB or larger hard disk with at least 650MB free space available
A VGA or better monitor
A keyboard
A mouse or similar pointing device
A CD-ROM or DVD drive

Preinstallation Housekeeping

If you’ve been using your PC for a while with an earlier version of Windows, you’ll want to do some things before you begin your upgrade:

✦ If your computer has any time-out features, such as the power-down features found on some portable PCs, disable those features now.
✦ If you have an antivirus program handy, run it now to check for, and delete, dormant viruses that may still be lurking on your hard disk.
✦ Make sure that any external devices (printers, modems, external disk drives, and so on) are connected and turned on so Windows XP can detect them during installation.
✦ To play it safe, back up the entire hard disk at this point.
✦ If your PC is connected to a local area network (LAN), check to make sure that you’re connected to the LAN so Windows XP can see your LAN during installation.

When all that’s finished, you’re ready to begin the installation.

Installing Windows XP

To upgrade an existing version of Windows, start your computer normally. Then put the Windows XP CD in your CD-ROM drive and wait for the Welcome screen to open. If nothing appears on the screen within a minute or so, follow these steps:

1. Open My Computer on your desktop.
2. Open the icon for your CD-ROM drive. If the Welcome screen opens, skip the next step.
3. Click (or double-click) the Setup (or setup.exe) file on the CD.

By now, you should definitely see on your screen some options for Installing Windows XP. To get things rolling:

1. Choose the Install Microsoft Windows XP option.
2. When the *Welcome to Windows Setup* wizard opens, choose Upgrade (Recommended) from the Installation Type drop-down list; then click Next.

The installation procedure will begin. You might notice that the screen goes blank once in a while during the installation. Don’t be alarmed; that’s normal. If the screen goes blank for a long time, try moving the mouse around a bit to bring it back. From here on out, you can just follow the instructions on the screen.

### Installation Options

The exact procedure from this point on will vary a bit, depending on whether you’re installing the Professional Edition or Home (Personal) Edition. Also, the specific hardware that’s connected to your computer will affect the information that the setup procedure requests. Each request is largely self-explanatory, but here’s a summary of the items you’re likely to encounter along the way.

- **Regional and Language Options:** Choose your preferred location and keyboard layout.
- **Name and Organization:** Type your complete name and business name (if any).
- **Product Key:** Type the Product Key. You should be able to find it on the sleeve in which the Windows XP CD-ROM was delivered.
- **Computer name and Administrator Password:** (Professional Edition) Enter any name you wish to identify this computer, and enter a password. You’ll need to enter the password twice to verify that you typed it as intended the first time.
- **Modem Dialing Information:** If your computer has a modem, choose the country you’re in and enter the area code you’re in now. If you’re in an office that requires dialing some number to access an outside line, enter that number. If your system uses the older “pulse” dialing tone, as opposed to touch tone, choose Pulse dialing.
- **Date and Time Settings:** Set the date and current time; choose your time zone, and decide whether or not you want Windows to automatically adjust the time for daylight savings changes.
- **Network Settings:** Unless you’re a network administrator who needs to customize networking capabilities on this computer, choose Typical Settings.
- **Workgroup or Computer Domain:** A *workgroup* is a collection of computers connected together in a local area network (LAN). If you’ve already set up a network and want this computer to be a member of an existing workgroup, choose No and enter the name of the workgroup to which this computer will belong. If this is a stand-alone computer, or you haven’t set up a network yet, you can just select the suggested name, WORKGROUP. If this computer will be a member of a corporate *domain*, choose Yes and enter the name of the domain to which this computer will belong.
The Setup Wizard

When the installation is complete, the computer will reboot one more time, and you’ll be taken to a final setup wizard. You’ll be asked how you want to connect to the Internet:

- **DSL or Cable Modem**: Select this option if this computer is directly connected to a cable modem or DSL modem that provides access to the Internet.

- **Local Area Network**: Select this option if this computer is a member of a LAN and some other computer on the network shares its Internet connection with other LAN members.

- **Telephone Modem**: Select this option if this computer has an internal modem or is directly connected to an external modem that provides Internet access through a standard (non-DSL) telephone line.

If you don’t have an Internet connection at the moment but plan to get one, just choose whichever option best describes how you think you will connect. Don’t worry, there’s no big commitment here. You can make whatever kind of connection you want in the future.

If you connect through a LAN or broadband device (for example, cable or DSL), you’ll be asked about IP (Internet Protocol) and DNS (Domain Name Services) addresses. The settings you enter must match the settings provided by your Internet Service Provider (ISP). Many ISPs automatically assign IP and DNS settings. So if in doubt, you can select the options to obtain that information automatically.

Product Activation

The wizard then asks that you activate your copy of Windows. If you have an Internet connection already, on a modem that’s connected to a phone line, you can choose Yes . . . and activate now. Otherwise, select No to activate later.

Getting Online

If your computer has a modem, you’ll be given the option to set up your existing account information, as provided by your Internet Service Provider (ISP), or set up a new account from scratch. You’ll want to keep your current ISP, unless you’ve previously set up an account with another.

Sharing the Computer

If more than one person will be using the computer, you can choose to give each person his or her own *user account*. Doing so will allow each person to have a private My Documents folder, desktop, Internet favorites, e-mail address, and so forth.
If you’re not so sure about the *user account* business, you can skip it for now. You can create user accounts at any time by referring to Chapter 23 in this book.

**Done!**

When you’ve finished the final setup phase, click the Finish button. Then proceed to Chapter 1 to get Windows XP rolling.

**Re-Enabling Old Startup Programs**

If you upgrade from an earlier version of Windows, you may discover that some of the programs that used to start automatically on your computer don’t do so after you’ve installed Windows XP. You can follow these steps to get those programs to start automatically again in the future:

1. Click the Start button, choose Run, and type `msconfig`; then click OK.
2. In the System Configuration Utility that opens, click the Startup tab.
3. To enable all previous autostart programs, click the Enable All button. Optionally, select (check) only those programs you want to autostart.
4. Click OK.
5. Click the Start button and choose Turn Off Computer ➔ Restart.

Now you can go to Chapter 1 to start using Windows XP.
Trying to use Windows XP without a mouse or other pointing device is like trying to drive a car without a steering wheel — not easy. About the only time you need to use the keyboard is when you’re typing text.

If your work requires a lot of typing, such that your hands are on the keyboard a lot, you can use shortcut keys to get many things done without taking your hands off the keyboard. Most of these keys are described throughout the book, but here’s a quick reference to them all.

To view shortcut keys on your screen, search Windows Help and Support for shortcut keys overview.
<table>
<thead>
<tr>
<th>General Keyboard Shortcuts</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel (bail out)</td>
</tr>
<tr>
<td>Close active document window</td>
</tr>
<tr>
<td>Copy</td>
</tr>
<tr>
<td>Copy by dragging</td>
</tr>
<tr>
<td>Create shortcut by dragging</td>
</tr>
<tr>
<td>Cut</td>
</tr>
<tr>
<td>Delete</td>
</tr>
<tr>
<td>Delete without Recycle Bin</td>
</tr>
<tr>
<td>Help</td>
</tr>
<tr>
<td>Menu bar (activate)</td>
</tr>
<tr>
<td>Next menu bar menu</td>
</tr>
<tr>
<td>Open menu</td>
</tr>
<tr>
<td>Paste</td>
</tr>
<tr>
<td>Prevent CD autostart</td>
</tr>
<tr>
<td>Previous menu bar menu</td>
</tr>
<tr>
<td>Print</td>
</tr>
<tr>
<td>Rename selected item</td>
</tr>
<tr>
<td>Select All</td>
</tr>
<tr>
<td>Start menu (open)</td>
</tr>
<tr>
<td>Stop task</td>
</tr>
<tr>
<td>Switch to another open program</td>
</tr>
<tr>
<td>Task Manager</td>
</tr>
<tr>
<td>Undo</td>
</tr>
<tr>
<td>View properties</td>
</tr>
<tr>
<td>View shortcut menu</td>
</tr>
</tbody>
</table>
# Text-Editing Shortcut Keys

<table>
<thead>
<tr>
<th>Action</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Delete character to left</td>
<td>Backspace</td>
</tr>
<tr>
<td>Delete character to right</td>
<td>Delete (Del)</td>
</tr>
<tr>
<td>Down a line</td>
<td>↓</td>
</tr>
<tr>
<td>Down a page</td>
<td>Page Down (PgDn)</td>
</tr>
<tr>
<td>End of document</td>
<td>Ctrl+End</td>
</tr>
<tr>
<td>End of line</td>
<td>End</td>
</tr>
<tr>
<td>Next character</td>
<td>→</td>
</tr>
<tr>
<td>Next paragraph</td>
<td>Ctrl+↓</td>
</tr>
<tr>
<td>Next word</td>
<td>Ctrl+→</td>
</tr>
<tr>
<td>Previous character</td>
<td>←</td>
</tr>
<tr>
<td>Previous paragraph</td>
<td>Ctrl+↑</td>
</tr>
<tr>
<td>Previous word</td>
<td>Ctrl+←</td>
</tr>
<tr>
<td>Select all</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Select next character</td>
<td>Shift+→</td>
</tr>
<tr>
<td>Select next word</td>
<td>Shift+Ctrl+→</td>
</tr>
<tr>
<td>Select page above</td>
<td>Shift+Page Up (PgUp)</td>
</tr>
<tr>
<td>Select page below</td>
<td>Shift+Page Down (PgDn)</td>
</tr>
<tr>
<td>Select previous character</td>
<td>Shift+←</td>
</tr>
<tr>
<td>Select previous word</td>
<td>Shift+Ctrl+←</td>
</tr>
<tr>
<td>Select to end of document</td>
<td>Shift+Ctrl+End</td>
</tr>
<tr>
<td>Select to end of line</td>
<td>Shift+End</td>
</tr>
<tr>
<td>Select to end of paragraph</td>
<td>Shift+Ctrl+↓</td>
</tr>
<tr>
<td>Select to start of line</td>
<td>Shift+Home</td>
</tr>
<tr>
<td>Select to top of document</td>
<td>Shift+Ctrl+Home</td>
</tr>
<tr>
<td>Select to top of paragraph</td>
<td>Shift+Ctrl+↑</td>
</tr>
<tr>
<td>Start of line</td>
<td>Home</td>
</tr>
<tr>
<td>Top of document</td>
<td>Ctrl+Home</td>
</tr>
<tr>
<td>Undo last edit</td>
<td>Ctrl+Z</td>
</tr>
<tr>
<td>Up a line</td>
<td>↑</td>
</tr>
<tr>
<td>Up a page</td>
<td>Page Up (PgUp)</td>
</tr>
</tbody>
</table>
## Dialog Box Shortcut Keys

<table>
<thead>
<tr>
<th>Action</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cancel</td>
<td>Esc</td>
</tr>
<tr>
<td>Help</td>
<td>F1</td>
</tr>
<tr>
<td>Next option</td>
<td>Tab</td>
</tr>
<tr>
<td>Next tab</td>
<td>Ctrl+Tab</td>
</tr>
<tr>
<td>Previous option</td>
<td>Shift+Tab</td>
</tr>
<tr>
<td>Previous tab</td>
<td>Ctrl+Shift+Tab</td>
</tr>
<tr>
<td>Select/clear checkbox</td>
<td>Spacebar</td>
</tr>
</tbody>
</table>

## Windows Explorer Shortcut Keys

<table>
<thead>
<tr>
<th>Action</th>
<th>Key(s)</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collapse expanded list or select parent folder</td>
<td>←</td>
</tr>
<tr>
<td>Collapse selected folder</td>
<td>Num Lock + - (on numeric keypad)</td>
</tr>
<tr>
<td>End of list</td>
<td>End</td>
</tr>
<tr>
<td>Expand selected list or select first subfolder</td>
<td>→</td>
</tr>
<tr>
<td>Favorites (show/hide)</td>
<td>Ctrl+I</td>
</tr>
<tr>
<td>History (show/hide)</td>
<td>Ctrl+H</td>
</tr>
<tr>
<td>Next item</td>
<td>F6</td>
</tr>
<tr>
<td>Open Address bar drop-down list</td>
<td>F4</td>
</tr>
<tr>
<td>Parent folder</td>
<td>Backspace</td>
</tr>
<tr>
<td>Refresh contents</td>
<td>F5</td>
</tr>
<tr>
<td>Search</td>
<td>F3</td>
</tr>
<tr>
<td>Shortcut menu (selected icon)</td>
<td>Shift+F10</td>
</tr>
<tr>
<td>Show all subfolders under selected folder</td>
<td>Num Lock + * (on numeric keypad)</td>
</tr>
<tr>
<td>Show contents of selected folder</td>
<td>Num Lock + + (on numeric keypad)</td>
</tr>
<tr>
<td>Start of list</td>
<td>Home</td>
</tr>
<tr>
<td>System menu</td>
<td>Alt+Spacebar</td>
</tr>
</tbody>
</table>
## Accessibility Shortcut Keys

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>FilterKeys on/off</td>
<td>Hold down right Shift key for five seconds</td>
</tr>
<tr>
<td>High Contrast on/off</td>
<td>Left Alt + Left Shift + Print Screen</td>
</tr>
<tr>
<td>MouseKeys on/off</td>
<td>Left Alt + Left Shift + Num Lock</td>
</tr>
<tr>
<td>StickyKeys on/off</td>
<td>Press Shift 5 times</td>
</tr>
<tr>
<td>ToggleKeys on/off</td>
<td>Hold down Num Lock for 5 seconds</td>
</tr>
<tr>
<td>Utility Manager</td>
<td>📌+U</td>
</tr>
</tbody>
</table>

## Natural Keyboard Shortcut

<table>
<thead>
<tr>
<th>Feature</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Minimize all</td>
<td>⌘+M</td>
</tr>
<tr>
<td>My Computer (open)</td>
<td>⌘+E</td>
</tr>
<tr>
<td>Restore all</td>
<td>⌘+Shift+M</td>
</tr>
<tr>
<td>Run</td>
<td>⌘+R</td>
</tr>
<tr>
<td>Search</td>
<td>Ctrl+⌘+F</td>
</tr>
<tr>
<td>Show desktop</td>
<td>⌘+D</td>
</tr>
<tr>
<td>Start menu</td>
<td>⌘</td>
</tr>
<tr>
<td>Switch users (or lock keyboard in domain network)</td>
<td>⌘+L</td>
</tr>
<tr>
<td>Utility Manager</td>
<td>⌘+U</td>
</tr>
<tr>
<td>Windows Help and Support</td>
<td>⌘+F1</td>
</tr>
</tbody>
</table>
SYMBOLS AND NUMERIC
\ (backslash)
  path separator, 310
  root folder name, 469
: (colon) drive suffix, 460
. (period) file extension prefix, 100
? (question mark) Help button, 33–34, 51, 535
; (semicolon) e-mail address list separator, 212
/ (slash) URL separator, 205
3½ inch Floppy (A:) folder, 79

A
About Windows Movie Maker dialog box, 384
Accept button (Windows Messenger), 267
accessibility, 556–559, 637
Accessories menu, 12
account
  administrator account
    capability accorded to, 518, 522, 524–525, 528–529
    creating, 520
    deleting, 524
  hiding administrator document from other administrator, 518, 519, 525
  installing Windows XP upgrade, configuring when, 629
  limited user account versus, 517–518
  network administrator, 600
  password, 629
  ISP, 166, 209–210, 228, 246
  .NET Passport, 246–248, 524
user account
  accessibility feature, association with, 556
  All Users, 470
  copying file to another account, 531
  creating, 518, 519–520
  default accounts, 470–471
  deleting, 518, 522, 523–524
  described, 516
  desktop, association with, 521, 530, 536
  document, association with, 521, 524–525
  Documents and Settings folder, display in, 529
  editing, 521–522
  folder, association with, 521
  Guest, 519, 524
  hardware installation, type needed for, 518
  installing Windows XP upgrade, configuring when, 630–631
  Internet favorite, association with, 530
  limited user, 517–518
  moving file to another account, 531
  naming, 471, 520, 522, 529
  .NET Passport, association with, 247, 524
  password, 518–519, 522, 525
  picture, 518, 522, 523
  privacy, 517, 518, 524–525, 528–531
  RAM needed to keep open, 527
  signing in, 518, 520–521, 525–526
  software installation, type needed for, 518
  Start menu, association with, 530
  switching user, 521, 524, 526–528
  type, changing, 518, 522
Acer Computers Web site, 51
Acrobat Reader, 116, 130, 197
Action ➤ Uninstall (Device Manager), 574
Actions ➤ Invite Someone to this Conversation (Windows Messenger), 257
Actions ➤ Start Application Sharing (Windows Messenger), 266
Actions ➤ Start Whiteboard (Windows Messenger), 268
activating Windows XP, 630
Ad-Aware software, 295–296
Add a Contact Wizard (Windows Messenger), 251
Add Favorite dialog box (IE), 186, 190
Add Network Place Wizard, 623–624
Add Or Remove Programs Control Panel area, 567–568, 571–572
Add Someone dialog box (Windows Messenger), 257
Add to Favorites button (Help and Support Center), 44
Address bar
  IE, 175
    taskbar display, 553–554
  Windows Explorer, 86, 88, 177, 474, 475
address book. See WAB (Windows Address Book)
Addresses button (Outlook Express), 232
Adobe Acrobat Reader, 116, 130, 197
Advanced Appearance dialog box, 539
adware, 295–296
.afc files, 342
.ai files, 306
.aif files, 342
Alerter service, 293
alignment
icon, 96
picture, 216
text, 125, 214
All Programs ➪ Accessories, 58
All Programs ➪ Accessories ➪ Accessibility ➪ Accessibility Wizard, 556
All Programs ➪ Accessories ➪ Accessibility ➪ Magnifier, 558
All Programs ➪ Accessories ➪ Accessibility ➪ Narrator, 558
All Programs ➪ Accessories ➪ Accessibility ➪ On-Screen Keyboard, 558
All Programs ➪ Accessories ➪ Accessibility ➪ Utility Manager, 558
All Programs ➪ Accessories ➪ Address Book, 232
All Programs ➪ Accessories ➪ Calculator, 12
All Programs ➪ Accessories ➪ Communications ➪ Fax ➪ Fax Console, 155
All Programs ➪ Accessories ➪ Communications ➪ Fax ➪ Fax Services, 153
All Programs ➪ Accessories ➪ Communications ➪ Fax ➪ Send a Fax, 156
All Programs ➪ Accessories ➪ Communications ➪ Network Connections, 167
All Programs ➪ Accessories ➪ Paint, 327
All Programs ➪ Accessories ➪ System Tools ➪ Character map, 137
All Programs ➪ Accessories ➪ System Tools ➪ Files and Settings Transfer Wizard, 588
All Programs ➪ Accessories ➪ System Tools ➪ System Information, 582
All Programs ➪ Accessories ➪ System Tools ➪ System Restore, 562
All Programs ➪ Accessories ➪ Windows Movie Maker, 392
All Programs ➪ Accessories ➪ WordPad, 123
All Programs ➪ Internet Explorer, 174
All Programs ➪ LavaSoft 6 ➪ Ad-Aware 6, 296
All Programs menu, 12, 57–58, 547
All Programs ➪ Outlook Express, 210
All Programs ➪ Windows Media Player, 333
All Programs ➪ Windows Messenger, 248
All Programs ➪ Windows Movie Maker, 383
All Users
account, 470
folder, 471, 530
All Users Desktop folder, 530
All Users Favorites folder, 530
All Users Shared Documents folder, 530
All Users Shared Music folder, 530
All Users Shared Pictures folder, 530
All Users Start Menu folder, 530
Allow Control button (Windows Messenger), 267
AltaVista search engine, 195
Analyze button (Hard Drive Properties dialog box), 467
Application key, 7
Arrange Icons By ➪ Name, 15
arrow keys, 36, 128
.art files, 305
.asf files, 341
.asx files, 341
.au files, 342
audio. See also CD (audio CD); music accessibility, customizing for, 556–557
bit rate, 353
camera audio out plug, 390
described, 333
file format, 341–342, 380
keyboard, playing sound when key pressed, 557
microphone
Audio Tuning Wizard, 261
headset, 261
port, 569
USB, 261
Windows Messenger, using with, 261, 262
Windows Movie Maker, using with, 407
muting, 204
Outlook Express sound options, 237
RealAudio format, 342
speaker port, 569
video, in
clip, inserting, 406–407
controlling, 204, 338, 398, 406–407
format support, 396
input from camera, 390–391
music, background, 396, 397, 406–407
narration, 398, 407
volume control, 204, 262, 338
Windows Messenger
Audio Tuning Wizard, 261
sound options, 276
voice conversation, 261–262, 279
Windows Movie Maker support, 396
Audio Levels dialog box (Windows Movie Maker), 398, 406, 407
AutoComplete feature
IE, 175–176
Search Companion, 457
Windows XP, 37–38
autotype feature, 130
A/V plug, 390, 392
.avi files, 341, 342, 353
Back button
IE, 180
Windows Explorer, 88
Windows Media Player, 349
backslash (\)
path separator, 310
root folder name, 469
Backspace key, 35, 36, 85
backup
audio CD, of, 359
CD-ROM, to, 493, 587
described, 479, 584
document, of, 586–587
dragging file, via, 442
drive, dedicating to, 585, 589
DVD, to, 587
e-mail, of, 587
Files and Settings Transfer Wizard, using, 588
floppy disk, to, 437, 586, 588–589
folder, facilitating by grouping documents in, 587
hardware, specialized, 584
installing Windows XP upgrade, prior to, 628
license, of digital, 351–352
picture, of, 308
QuickBooks data, of, 587
Quicken data, of, 587
RAID, 585
restoring, 586, 589
setting (personal preference), of, 588–589
software
program files, of, 585–586
specialized software, using, 584
Windows, of, 585–586
Zip disk, to, 588
Backup Now button (Windows Media Player), 352
bandwidth, 164–165, 353
bit rate
audio, 353
bandwidth, 164
video, 164, 353, 410
bits per second. See bps
Block button (Windows Messenger), 257
BMP files, 102, 307
booting up, 9–11
border
picture border, 216
window border, 67
bounce-back message, 285
bps (bits per second), 164, 410
brightness control, desktop, 537
broadband connection, 164, 165, 169, 283, 598
Browse button
Display Properties dialog box, 537, 538
Outlook Express, 240
Windows Messenger, 277
Windows Movie Maker, 408
Browse For Folder dialog box (Add Network Place Wizard), 623
browser. See Web browser
Buddy Icon Grabber software, 458
buffer, printer, 146
business, searching online, 194
button. See also specific button
dialog box button overview, 34, 535
label, 83
taskbar buttons, grouping similar, 549
using, 34
byte, 461–462
cabling
LAN, 594–595
printer, 149
video, 390, 391
Calculator utility
installing, 567
maximizing/minimizing, 65
sizing window, 64, 65
starting, 12, 58–59
taskbar button, 13, 61
title bar, 13
Called Subscriber Identification. See CSID
camera, digital. See also picture
A/V plug, 390, 392
FireWire plug, 389, 390, 568
RCA plug, 389, 390, 391
still camera
deleting picture from, 311
downloading from, 310–312
installing, 315–317
USB plug, 316, 390, 391
video camera
audio output, 390–391
bridging to computer, 390–391
capturing from, 389–395
copying video to digital tape using, 410
VCR mode, 392
Web cam, 263, 563
Cancel button (common software control), 34, 535

capture, screen, 150

case sensitivity
  password, 38, 246
  searching, in, 452

CD (audio CD)
  backing up, 359
  behavior when inserted, changing default, 495–497
  CDDB, 361
  copying music
    to computer from, 337, 365–368
    from computer to, 337, 341, 379–380
    disk type used, 359
    file format, 341, 380
    HighMAT, 367
    information about song contained on, 366
    library, adding CD music to, 337, 364–365, 369–371
    playing, 204, 344–346, 487
    ripping, 365, 367
    speed, 489
    tag information, 361
  CD Writing Wizard, 492–493
  .cda files, 341, 380
  CDDB (Compact Disk Data Base), 361
  CD-R disk, 490–491
  .cdr files, 306

CD-ROM
  backup medium, as, 493, 587
  behavior when inserted, changing default, 495–497
  burning, 490, 493–494
  capacity, 478
  distribution medium, as, 487, 587
  DVD drive, accessing using, 487, 490
  ejecting, 488
  file
    copying from, 307–310, 489–490
    copying to, 490–493
    deleting, 433, 493
    displaying, 488
    moving from, 490
    renaming, 426
    saving to, 109
  temporary file created when writing to, 492
  formatting, 493
  installation CD, 489, 564, 585–586
  opening, 308, 487, 488, 495–497
  packet-writing, 493
  picture
    copying from, 307–310
    copying to, 307, 321
  film, having developer deliver CD-ROM from, 307
  Kodak Picture CD, 307, 309
  prerecorded, 487–488
  space free, determining, 492
  speed rating, 489
  startup error caused by nonsystem disk in CD-ROM drive, 583
  troubleshooting, 497–498
  types of disk, 490–491
  video, copying to, 411
  WORM, 491
  CD-RW disk, 79, 491, 493–494, 587
  cell phone, instant messaging using, 282
  Center button (Outlook Express), 214
  Centrino standard, 596
  CGM (Computer Graphics Metafile), 305
  Change Icon button (Desktop Items dialog box), 538
  Change Icon dialog box, 457–458
  Change Picture button (User Accounts window), 522
  Change View button (Help and Support Center), 44
  Character Map utility, 137–138
  chat room, MSN/.NET Passport, 282
  checkbox control, 29–30
  child folder, 80, 420
  child, safeguarding on Internet, 296–297, 353
  Choose Details dialog box (Windows Explorer), 94–95
  Choose Profile dialog box (Outlook Express), 505
  Clean Desktop Now button (Desktop Items dialog box), 538
  Clean Desktop Now button (Desktop Items dialog box), 538
  client, 165
  Clip ➤ Add to Storyboard (Windows Movie Maker), 399
  Clip ➤ Add to Timeline (Windows Movie Maker), 399
  Clip ➤ Clear Trim Points (Windows Movie Maker), 415
  Clip ➤ Combine (Windows Movie Maker), 415
  Clip ➤ Nudge Left (Windows Movie Maker), 401
  Clip ➤ Set End Trim Point (Windows Movie Maker), 401
  Clip ➤ Set Start Trim Point (Windows Movie Maker), 401
  clipboard, 306
  clock, taskbar, 549
  Close button (common software control), 13, 34, 72, 535
  closing
dialog box, 34
document, 72, 109–110
e-mail message, 221
folder, 84
Help and Support Center, 48
pop-up, 72
software, 13, 581–582
Web browser favorite, 190
window, 71–73
Windows Explorer, 96
Windows Movie Maker, 413
Windows XP, 11, 20–21, 526, 570
.clp files, 306
.cmx files, 306
collapsible menu, 70
colon (:) drive suffix, 460
color
depth, 540–541
desktop
   background color, 537, 538
   scheme, 539
Help and Support Center, 44
printing, 144
scanning color document, 313
text, 132, 402
window border, 67
Windows Media Player, 338
Windows Messenger, 267, 271
.com Internet domain, 174
COM port, 150
combo box control, 37–38
Compact Disk Data Base. See CDDB
Compaq/Hewlett-Packard Web site, 51
Composite A/V plug, 390, 392
compression
   AVI, 353
   DivX, 342, 353
   file, compressing unused, 465
   floppy disk, enabling on, 482
   JPEG, 511
   media file, of, 353, 367, 511
   MPEG, 511
   MP3, 511
   WMA, 367, 511
   WMV, 511
Zip disk, enabling on, 482
zip file
   creating, 502–504
   decompressing, 507–510
deleting, 510
e-mail attachment, using for, 218, 223, 504, 505–507, 508
extracting content, 507–510
folder, as compressed, 501, 502
icon, 504
introduced, 202
naming, 504
picture file, compressing using, 510
recompressing file, 511
saving, 508, 509
size, 504, 511
software for managing, 502
Zip disk versus, 502
CompuServe Graphics Interchange format.
   See GIF
computer. See also hardware
documentation, 51
domain, 629
emergency boot disk, 482
Ethernet port, 569
game port, 569
hung, 581
information about, displaying, 582–583
input device, alternative, 559
LAN, connecting to, 594–599, 602–606
local, 614
manufacturer help resources, 51, 579
memory
   printer buffer, 146
   RAM, 104, 527
   ROM, 307
   system requirement, 627
   user account, needed to keep open, 527
   volatile, 104
microphone port, 569
motherboard, 585
naming, 604, 629
OS, 8–9, 561
platform, 9, 561
processor, 472–473
PS/2 port, 569
remote, 614
restoring to earlier state, 562–563, 570, 574–575, 584
serial port, 569
sharing, 515–516
shutting down, 20–21
software bundled with, 58
speed, 472
startup disk, creating, 482
troubleshooting frozen computer, 581–582
USB plug, 569
Computer Graphics Metafile. See CGM
Confirm Multiple File Delete dialog box
   (Windows Explorer), 434
Connected message (Windows Messenger), 266
connection, Internet
   bandwidth, 164–165, 353
   broadband, 164, 165, 169, 283, 598
cost, 164, 166
Continued
connection, Internet (continued)
dial-up
  connectoid, 167
described, 164
  IE, using with, 174
  LAN environment, in, 606–607
  Notification Area display, 169
  security, 283
  signing in, 165
  speed, 164
  troubleshooting, 170–171
  Web cam, using with, 263
  Windows Messenger, using with, 263, 264, 266
disabling, 169
displaying, 167–168, 289
DSL, 164, 630
firewall, 168, 289–291, 607–608
hardware requirement, 163–164
IE connection requirement, 174
information about, displaying, 169
offline, 165
online, 165
sharing over LAN, 290, 598–599, 601, 602–604, 606–607
speed, 164–165
status, displaying, 168
troubleshooting, 169–171
Windows Media Player, 335, 344–345
connectoid, 167, 168–169
contact
WAB, 230–231, 233–234
Windows Messenger
  adding, 251, 256–257
  alert, displaying when arriving online, 276
  blocking, 277–278
  deleting, 274
  displaying, 251, 259
  displaying people who have added you, 278
  grouping, 272–274
  permission, 256–257
  phone number, displaying/hiding, 279
content, protected, 350, 368, 396
contrast control, 537, 556, 558
Control Panel
  Accessibility Options icon, 557
  accessing, 24–25, 544
  Add Or Remove Programs area, 567–568, 571–572
  Category View, 24–27
  Classic View, 24–27
  navigating, 25–26
  Network and Internet Connections area, 602
  Network Connections folder
    accessing, 167
    connectoid display, 167, 168–169
    firewall display, 168, 608
    Internet connection display, 167–168
    LAN display, 167–168, 602
    modem status display, 168
    object property, accessing using, 25–27
    Performance and Maintenance area, 297
    Printers and Faxes folder, 146–148, 155
    Printers and Other Hardware area, 146
    Scanners and Cameras folder, 316
    System icon, 297
    User Accounts area, 247, 519, 521–522
    view, 24–27
  Control ➢ Request Control (Windows Messenger), 267
  control (screen item), 16–19, 27–33. See also specific control type
cookie, Internet, 184–185, 530
coolnerds.com Web site, 51
Copy button
  Windows Explorer, 443
  Windows Media Player, 380
Copy Disk dialog box (My Computer), 487
Copy Items dialog box (Windows Explorer), 444
Copy To dialog box (Paint), 328–329
copying
  clipboard, 306
desktop shortcut
    My Documents folder, to, 555
    Quick Launch toolbar, to, 556
document, item to another, 134–135, 137
dragging, via, 6, 17, 440–442
file
  cutting and pasting, via, 443
dragging, via, 440–442
  DVD, from, 489–490
  DVD, to, 411–412, 494–495
  floppy disk, from, 485–486
  floppy disk, to, 483–485
  folder, to another, 439–442
  folder, within same, 443, 578
  undoing copy operation, 444–445
  user account, to another, 531
  Windows folder, within, 472
  Zip disk, from, 485–486
  Zip disk, to, 483–485
  zip file, to, 502–503
music
CD, from, 337, 365–368
CD, to, 337, 341, 379–380
device, to, 337, 380–381
vinyl LP, 381–382
pasting, 133

picture
CD-ROM, from, 307–310
CD-ROM, to, 307, 321
Paint, to, 327–328
text document, to, 135–136
user account, to another, 531
Web page, from, 136, 179, 314–315, 327–328
Windows Messenger Whiteboard, to, 268, 271

screen, printing, 150–151
software, data to another, 134–136
text
document, to another, 134–135
document, within same, 133
instant messaging conversation, in, 256
Web page to text document, from, 134, 179, 201–202
URL, 176

video
CD-ROM, to, 411
DVD, from, 489–490
DVD, to, 411–412, 494–495
tape, to, 412
Web page, from
picture, 136, 179, 314–315, 327–328
text, 134, 179, 201–202
Windows Messenger Whiteboard, 268, 271

Corbis Web site, 194
cracking, 288–290
Create a Hyperlink button (Outlook Express), 216
Create Folder dialog box (Outlook Express), 229
Create In button (IE), 190
Create Mail button (Outlook Express), 212
Create New Folder button (Windows Explorer), 425, 426
critical update, 299
crossover cable, 594–595
CSID (Called Subscriber Identification), 154, 155
.cut files, 306
Current button (IE), 185
cursor, 35–36, 127–128
Custom Settings button (Camera and Scanner Wizard), 313
Customize button (IE), 193
Customize Desktop button (Display Properties dialog box), 538
Customize Notifications dialog box, 552–553

Customize Start Menu dialog box, 30, 31, 112, 544–545
.cut files, 306
cutting
file, 443
text, 137

data file, 587
data recovery service, 584
date
file date information
displaying, 91
searching by, 451
sorting file list by, 92–93, 95, 453
system date, setting, 549, 629
Dazzle video bridge, 390–391
dcx files, 307
Declined Updates button (System Properties dialog box), 298
Decrease Indentation button (Outlook Express), 214
default setting, 34–35. See also under specific topic
defragmenting hard disk, 466–468
Delete button
IE, 189
Outlook Express, 220, 227
WAB, 234
Windows Movie Maker, 407
Delete Cookies button (IE), 184
Delete Files button (IE), 184
Delete key, 36
Deleted Items folder (Outlook Express), 211, 227, 228, 242
deletion defined, 433
Dell Web site, 51
desktop. See also taskbar
brightness control, 537
cleaning, 538
color
background, 537, 538
scheme, 539
contrast control, 537, 556, 558
displaying, 66, 459, 533
effect, special, 539
font size, 539
icon
adding, 538
arranging, 15, 542
folder containing, 79
removing, 538
opening software on, 12
picture, background, 537–538

Continued
shortcut
creating, 191, 554–556
Fax feature, to, 155, 156
file, to, 458–459
folder, to, 80, 458–459, 555
icon, 555–556
My Documents folder, copying to, 555
Quick Launch toolbar, copying to, 556
unused, 538
Web page, to, 190–191
sizing item on, 18–19
theme, 537, 539, 541
user account, association with, 521, 530, 536
Desktop folder, 79
Desktop Items dialog box, 538
Device Independent Bitmap files. See DIB files
Device Manager, 573–574
dialog box
button overview, 34, 535
canceling change, 34
closing, 34
control overview, 27–33, 34
default, restoring, 33–34
Help (?) button, 33–34, 51, 535
introduced, 24
moving, 534
navigating, 27–28
option
button, 28–29
disabled, 535
preview area, 29, 534, 535
shortcut key overview, 636
tab, 28, 534, 535
title bar, 534, 535
dial-up Internet connection
connectoid, 167
described, 164
IE, using with, 174
LAN environment, in, 606–607
Notification Area display, 169
security, 283
signing in, 165
speed, 164
troubleshooting, 170–171
Web cam, using with, 263
Windows Messenger, using with, 263, 264, 266
DIB (Device Independent Bitmap) files, 307
Dictionary.com Web site, 189
digital camera. See camera, digital
digital license, 350, 351–352
Digital Photo Editor software, 331
digital signature, 237, 242
Digital Subscriber Line. See DSL
directory. See folder
disaster recovery. See also troubleshooting
backup, restoring, 586, 589
computer, frozen, 581–582
emergency boot disk, 482
hard disk, recovering data from damaged, 584
restoring computer to earlier state, 562–563, 570, 574–575, 584
Disk Cleanup dialog box, 464–465
disk error message, 583
Display button (Help and Support Center), 46
Display Properties dialog box
accessing, 536
Appearance tab, 539, 541
Browse button, 537, 538
Customize Desktop button, 538
Desktop tab, 537–538
Effects tab, 539
Power button, 539
Preview button, 539
Save As button, 541
Screen Resolution slider, 540
Screen Saver tab, 538–539
Settings button, 538
Settings tab, 540–541
Themes tab, 537, 539, 541
Turn Off Monitor option, 539
DivX compression, 342, 353
Do you wish to debug? message, 205
DOC files, 102
document
All Users Shared Documents folder, 530
backing up, 586–587
closing, 72, 109–110
copying item to another, 134–135, 137
creating, 103–104
described, 75
downloading, 200–201
e-mail
attaching document to, 217–218
message as document, 587
file, 75
financial data as, 587
format, 99
icon, 75–76
locking, 135
media file as, 333, 359
My Recent Documents folder, 107, 110–111, 112, 113, 545
naming, 105, 106–108
opening
folder, from, 111
icon, from, 75
Open dialog box, using, 112–114
recent document, 107, 110–111, 112, 113, 545
shared document, 619–621
software area opened to, 76
software default, bypassing, 114–115
software default, into, 76–77, 110, 113
software default, when missing, 116–117
picture as, 303
private, 518, 524–525, 529
saving
CD-ROM, to, 109
closing, before, 72
described, 104
floppy disk, to, 109
menu bar, using, 104
naming when, 105, 106–108
Save As dialog box, using, 72, 104–108, 117–118, 201
toolbar, using, 104
type, changing when, 117–118
scanning, 312–314
Shared Documents folder, 79, 530, 587, 617, 623
sharing
LAN, over, 617–618
opening shared document, 619–621
private document versus, 518
software sharing, via, 266–268
text document
copying text from Web page to, 134, 179, 201–202
copying text to another, 134–135
copying text within same, 133
picture, inserting in, 135–136
type
changing, 117–118
described, 99
file extension, relation to, 100
user account, association with, 521, 524–525
window, 61, 76, 119–120, 327
Documents and Settings folder, 471, 525, 529
domain
computer domain, 629
Internet domain, 173, 174
DOS operating system, 59
dots per inch. See DPI
downloading
Ad-Aware, 295–296
Adobe Acrobat Reader, 197
camera, from digital, 310–312
content, protected, 350
described, 166, 350
document, 200–201
folder, creating for, 199, 287
font, 132–133
media file, 349, 351
medium, streaming, 201
MPEG, 353
MSN Messenger, 250
music, 350–351, 353, 363
opening downloaded file, 200–201
security, 197–198, 566
software, 197–199, 565–566
video, 346, 353
virus protection, 198, 287–288
Windows Media Player
skin, 357
update, 335–336
visualization, 354
Windows Movie Maker, 384
Windows XP update, 297–298
WMV file, 353
DPI (dots per inch), 313
dragging
canceling drag operation, 442
copying via, 6, 17, 440–442
desktop shortcut, creating via, 191, 554
file
copying via, 440–442
moving via, 438, 440–442
handle, 18–19
icon
copying via, 442
moving via, 442
selecting via, 428–429
left-dragging, 442
Recycle Bin, item to, 436
right-dragging, 440–441
selecting via, 129, 428–429
Start menu, arranging via, 545–546, 547
taskbar, 550, 551
window
moving via, 68
resizing via, 67
drawing on Windows Messenger Whiteboard, 269–270
drilling down, 25, 473
drop-down list control, 30–31, 38
.dds files, 306
DSL (Digital Subscriber Line), 164, 630
dump, screen, 150
DVD
backups medium, as, 587
behavior when inserted, changing default, 495–497
burning, 495
capacity, 478
disk types, 495
distribution medium, as, 487, 587
Continued
DVD (continued)

drive

CD-ROM, accessing using, 487, 490
compatibility, downward, 487
information about, displaying, 583
startup error caused by nonsystem
disk in, 583
ejecting, 488
file

copying from, 489–490
copying to, 411–412, 494–495
deleting, 433
displaying, 488
moving from, 490
name, changing, 426
opening, 487, 488, 495–497
playing using Windows Media Player,
347–348, 487
prerecorded, 487–488
size, 412
speed rating, 489
troubleshooting, 497–498

DVD+R disk, 495
DVD-R disk, 495
DVD-ROM, 487, 490
DVD+RW disk, 495
DVD-RW disk, 495
.dvr—ns files, 341
.dxf files, 305

E

Easy CD Creator software, 493
eBay Web site, 189, 280, 281
Edit Clear Page (Windows Messenger), 271
Edit Clear Storyboard (Windows Movie
Maker), 400
Edit Clear Timeline (Windows Movie
Maker), 400
Edit Copy To (Paint), 328
Edit Copy (WordPad), 133
Edit Cut (WordPad), 137
Edit Delete (Outlook Express), 227
Edit Empty ‘Deleted Items’ Folder (Outlook
Express), 227
Edit Invert Selection (Windows Explorer), 432
Edit menu (WordPad), 69
Edit Paste
Paint, 327
software menu item, common, 151
WordPad, 133
Edit Select all
IE, 429
Outlook Express, 226
software menu item, common, 69
Windows Explorer, 429
Windows Movie Maker, 416

Edit Undo (Windows Messenger), 272
Edit Undo (Windows Explorer), 445
Edit Undo Remove Clip (Windows Movie
Maker), 415
.edu Internet domain, 174
eFax Web site, 158
Effects dialog box, 539
eMachines Web site, 51
e-mail. See also Outlook Express
account, 209–210, 228, 246
address
format, 209
hiding using blind carbon copy
option, 212
.NET Passport user name, using as,
246, 247
recipient address, 212
searching online, 194
WAB, adding from, 235–236
aligning
picture, 216
text, 214
attachment
blocking, 222
document, 217–218
multiple files, 217
music, 217
opening, 222–224, 225, 508
picture, 215–216, 217
printing, 223
saving, 223, 224–225
security, 221–222, 224, 242
sending, 215–216, 217–218, 505–506
size, 217, 409, 504
video, 217, 409, 411
virus protection, 221–222, 224, 225,
284–286
zip file, using, 218, 223, 504, 505–507, 508
backing up, 587
blocking
attachment, 222
sender, 295
body of message, 220
bounce-back message, 285
carbon copy, 212
client
default, specifying, 210
introduced, 209
starting, 57–59, 174, 210, 544–545
closing message, 221
compacting messages, 242
composing message, 212, 213–217, 238
deleting message, 220, 226, 227–228, 242
document
  attaching to, 217–218
message as, 587
folder, organizing messages in, 211, 227, 228–230
font, 214, 238
format, specifying, 213–214, 238
forwarding message, 220, 221
header, 219–220, 222
HTML, 213, 240
hyperlink, inserting in message, 216–217
list, arranging text into, 214–215
mailing list, 234–235
navigating messages, 220
.NET Passport, integrating with, 228, 243, 245–247
POP3, 209–210
previewing message, 219
printing message, 220, 223
read status, 230
reading message, 219–221
replying to message, 220, 221
retrieving message, 211, 219–221, 237–238
searching
  address, for, 194
  message, for, 449
security, 221–222, 224, 237, 240–242
selecting message, 226
sender, blocking, 295
sending
  group using mailing list, to, 234–235
  group via entering multiple addresses, to, 212
  individual, to, 212–213, 218–219
server, 218
signature
  appending to message, 239–240
  digital, 237, 242
sorting messages, 219
spam, 227, 295
spelling, checking, 214, 240
subject line, 212
text, plain/rich, 213–214
transmission process, 218
troubleshooting, 243
URL, inserting in message, 177, 216
vCard, 241
Web-based
  family situation, using in, 228
  POP3 mail, accessing using, 210
Windows Messenger e-mail verification, 249–250
E-mail Address Not Verified message
  (Windows Messenger), 250
emergency boot disk, 482
.emf files, 306
emoticon, 252–255
Encapsulated PostScript files. See EPS files
Encarta, 194
encryption, 191
encyclopedia, online, 194
End key, 128
Enter key, 124
EPS (Encapsulated PostScript) files, 306
error message
described, 577–578
disk error, 583
Do you wish to debug?, 205
fatal error, 577
help concerning, obtaining, 578–579
Non-system disk, 583
Page not Found, 205
termination, abnormal, 11
Esc key, 68, 69
Ethernet, 569, 594–595
Exchange Instant Messaging service, 279
.exe files, 198
executable file, 198
Explorer bar
  IE, 182, 186, 192, 203
Windows Explorer
    CD Writing Tasks section, 492
    Copy the Selected Icons option, 484
described, 83
  Details section, 492
displaying, 83, 420
  File and Folder Tasks section, 304, 425, 434, 443, 490
  Folders list, 469–470, 474
  Imaging Tasks section, 313, 317, 320–321
  Make a new folder section, 304
  Music Tasks section, 340–341
  My Network Places section, 608–609, 618
  Network Tasks section, 608, 623
  Picture Tasks section, 313, 317, 320–321
  Printers Tasks section, 616
  Recycle Bin Tasks section, 435–436
  Search section, 448
Extraction Wizard, 508
F
  Fandango Web site, 189
Fast Forward button
  Windows Media Player, 338
  Windows Movie Maker, 389
fatal error, 577
Favorites feature
  IE, 180, 185–190
  user account, association with, 530
  Windows XP, 44, 47–48
Fax Configuration Wizard, 154–155
Fax Console, 155–156
Fax Services, 153–155
faxing
   address book information, using when, 157
   answer mode, 154, 158
   cover page, 157
   CSID, 154, 155
   editing faxed document, 153
   help resources, 159
   Internet fax service, via, 158
   previewing fax, 157
printing
   fax device, to, 148, 157
   printer, to, 154
   receiving fax, 154, 155–156, 158
   recipient information, 157
   sender information, 154
   sending fax, 148, 152–153, 154, 155–157
   text, converting fax to using OCR, 153
   TSID, 154, 155
   Word, from, 158
faxmodem, 152, 153
Features taskbar (Windows Media Player), 336–337, 354, 357, 379
file
   audio file format, 341–342, 380
   compressing unused file, 465
   cookie file, 184–185, 530
   copying
      CD-ROM, from, 307–310, 489–490
      CD-ROM, to, 490–493
      cutting and pasting, via, 443
      dragging, via, 440–442
      DVD, from, 489–490
      DVD, to, 411–412, 494–495
      floppy disk, from, 485–486
      floppy disk, to, 483–485
      folder, to another, 439–442
      folder, within same, 443, 578
      LAN, over, 594, 624–626
      moving versus, 437–438
      MP3 file to player, 380–381
      Program Files folder, 380–381
      undoing copy operation, 444–445
      user account, to another, 531
      Windows folder, within, 472
      Zip disk, from, 485–486
      Zip disk, to, 483–485
      zip file, to, 502–503
   data file, 587
   date information
      displaying, 91
      searching by, 451
      sorting by, 92–93, 95, 453
deleting
   CD-ROM, from, 433, 493
   DVD, from, 433
   floppy disk, from, 435
   picture file, 326
   Program Files folder, from, 472
   undoing deletion, 434–437, 493
   Windows folder, from, 472
   zip file, 510
desktop theme file, 537
destination location, 437
Details view, 91–95, 323–324, 453
displaying
   CD-ROM file, 488
   date information, 91
   DVD file, 488
   extension, 100–101, 307, 426
   size, 91
   time information, 91
type, file of specific, 113
document file, 75
executable file, 198
extension
   changing, 101, 107, 117, 426, 511
   displaying/hiding, 100–101, 307, 426
document type, relation to, 100
executive file, 198
searching for file by, 450
zip file, 504
Filmstrip view, 90–91, 303, 305
folder
   copying to another, 439–442
   copying within same, 443, 578
distinguishing from, 419–420
   moving to another, 439–442
   source folder, 437, 483
icon
   display of file icon, 89, 346, 420, 504
   system file used to store, 458
index, 451, 465
instant messaging, transferring during, 259–260, 277
List view, 91
media file
   compression, 353, 367, 511
document, as, 333, 359
downloading, 349, 351
format overview, 341–342
format, preferred, 341, 342, 353
introduced, 333
license, digital, 350, 351–352
metadata, 359
opening, 343–344
player, specifying default, 344, 345
searching, 342–343, 449, 454–455
size, 349
streaming medium versus, 350
Summary property, 359–361

moving
CD-ROM, from, 490
copying versus, 437–438
cutting and pasting, via, 443
dragging, via, 438, 440–442
DVD, from, 490
floppy disk, to, 484
folder, to another, 439–442
LAN, over, 624–626
music file after addition to library, 353
Program Files folder, within, 472
subfolder, to, 438–439
user account, to another, 531
video file after addition to Windows Movie Maker, 396
Windows folder, within, 472
Zip disk, to, 484

music file
format, converting, 367
format overview, 341–342
format, preferred, 341, 342, 353
format, specifying when ripping CD, 367
naming, 366
size, 363, 364
name
assigning when saving, 105, 106–108
changing, 426–427
music file, assigning to, 366
sorting by, 92–93, 95
UNC, 626
uniqueness, 108, 109

opening
downloaded file, 200–201
installation file, 198
media file, 343–344
MP3 file, 102, 367

path, 260, 310, 472–475

picture file
clipboard, picture file used to store, 306
compressing, 510
deleting, 326
format, converting, 510
format overview, 305–307
searching, 449, 450
size, 313, 510–511

saving
CD-ROM, to, 109
floppy disk, to, 109
name, assigning when, 105, 106–108
software installation file, 199
video file, 408–409
zip file, 508, 509

searching
backtracking to previous search, 450
case sensitivity, 452
content, 450
date, limiting by, 451
document file, 449
extension, limiting by, 450
indexing service, using, 451, 465
location, limiting by, 451, 452, 454
media file, 342–343, 449, 454–455
music file, 342–343, 449, 454–455
name, for specific, 450
picture file, 449, 450
size, limiting by, 452
type, limiting by, 450, 454–455
video file, 342–343, 449, 454–455

selecting, 427–433

sharing
Gnutella file sharing network, 287, 349, 352–353
virus protection, 287, 351

shortcut to, creating, 458–459

size
determining combined size of multiple files, 483–484
displaying, 91
e-mail attachment, 217, 409, 504
media file, 349
music file, 363, 364
picture file, 313, 510–511
search, limiting by, 452
sorting by, 92–93, 95
video file, 409–411
zip file, 504, 511

sorting, 92–93, 95–96, 453

system file, 75, 458, 472, 574–575, 585–586
temporary file
CD-ROM, created when writing to, 492
Internet temporary file, 181, 184, 464, 465

 Thumbnails view, 90, 346, 387, 396, 492
Tiles view, 89
time information
displaying, 91
sorting by, 92–93, 95, 453

type
common types listed, 102
displaying file of specific type, 113
known/unknown, 101
search, limiting by, 450, 454–455
software associated with, changing
default, 115–116
undeleting, 434–437, 493
uninstalling software, keeping unused shared file when, 572
uploading, 166

Continued
file (continued)

video file
  format overview, 341–342
  format, preferred, 341, 342, 353
  icon, 346
  importing, 396–397
  naming, 410
  saving, 408
  size, 409–411

view, changing, 88, 90

virus, scanning for, 287–288

Windows Cannot Open This File message, 260

Windows Movie Maker
  format support, 396
  moving video file after addition to, 396

File ➪ Capture Video (Windows Movie Maker), 392

File ➪ Empty Recycle Bin, 436

File ➪ Exit
  Windows Media Player, 338
  Windows Messenger, 272
  Windows Movie Maker, 413

File ➪ Export ➪ Business Card (WAB), 241

File ➪ Folder ➪ New (Outlook Express), 229

File ➪ Import into Collections (Windows Movie Maker), 397

File Name Options dialog box (Windows Media Player), 366

File ➪ New ➪ Folder (Windows Explorer), 425

File ➪ New Group (WAB), 235

File ➪ Open (common menu item), 112

File ➪ Open Project (Windows Movie Maker), 408

File ➪ Open Received Files (Windows Messenger), 260

File ➪ Page Setup
  IE, 182
  WordPad, 126

File ➪ Print
  IE, 181
  Paint, 330
  software menu item, common, 141
  WAB, 234

File ➪ Print Preview (common menu item), 142

File ➪ Receive Fax Now (Fax Console), 158

File ➪ Save As
  Paint, 331
  software menu item, common, 117

File ➪ Save Movie File (Windows Movie Maker), 408

File ➪ Save Project (Windows Movie Maker), 408

File ➪ Send a Fax (Fax Console), 156

File ➪ Send ➪ Shortcut to Desktop (IE), 191

File ➪ Send To ➪ Recipient Using a Fax Mode (common menu item), 156

File ➪ Send To ➪ Recipient Using Internet Fax Service (Word), 158

File ➪ Sign Out (Windows Messenger), 257, 281

File ➪ Status (Windows Messenger), 258

Files and Settings Transfer Wizard, 588

Filext Web site, 103

Filled Ellipse tool (Windows Messenger Whiteboard), 270

Filled Rectangle tool (Windows Messenger Whiteboard), 270

FilterKeys feature, 557, 558, 637

firewall, 168, 289–291, 607–608

FireWire, 149–150, 389, 390, 568, 604

FirstGov Web site, 189

fixed disk, 435. See also hard disk

floppy disk
  accessing, 481
  backup medium, as, 437, 586, 588–589
  capacity, 477–478, 480
  cloning, 486–487
  compression, enabling, 482
  drive letter, 479
  file
    copying from, 485–486
    copying to, 483–485
    deleting from, 435
    moving to, 484
    saving to, 109
  filing cabinet analogy, 477–478
  formatting, 481–483
  inserting, 481
  software, installing from, 564
  startup
    startup error caused by nonsystem disk in floppy drive, 583
    using floppy for startup disk, 482
    volume label, 482
    write-protecting, 486
    Zip disk compared, 480

focus, 27

folder. See also specific folder
  backup, facilitating by grouping documents in, 587
  cascading, 84
  child folder, 80, 420
  closing, 84
  compressed folder, 501, 502
  creating, 304, 421–426
  deleting, 433–436
  described, 77
desktop shortcut to, 80, 458–459, 555
  Details view, 91–95, 323–324, 453
downloading, dedicating folder to, 199, 287
  drilling down, 25, 473
e-mail, organizing in, 211, 227, 228–230
  expanding, 470, 473
file
  copying to another, 439–442
copying within same, 443, 578
distinguishing from, 419–420
moving to another, 439–442
source folder, 437, 483
filing cabinet analogy, 77
hierarchy, 78–79, 80, 85–86, 420, 469
icon, 78, 89, 420, 457
LAN, sharing over, 613, 617–618, 619–623
List view, 91
Local Disk (C:) folder, 79
maximizing, 84
minimizing, 84
music
  monitoring folder for new, 363
  organizing in, 339–340, 365–366
name
  assigning, 425
  changing, 426–427
  displaying, 80, 82, 89
  extension, 100
navigating, 83–86, 88, 420, 469–470
opening, 78, 80, 84–85, 454, 619–621
opening document from, 111
parent folder, 80–81, 420
path, 260, 310, 472–475
root, 469, 471–472, 473
searching, 449, 451, 452
selecting, 427–433
shortcut menu associated with, 80
source folder, 437, 483
Start menu display, 84, 542–543, 545
subfolder, 80–81, 85, 304, 420, 421–422
Tiles view, 89
tiling, 84
undeleting, 434–437
user account, association with, 521
video, dedicating to, 396
view
  default, changing, 459–460
  switching, 88, 94
WAB contacts, organizing in, 232
Web browser favorites, organizing in, 188, 190
Windows Explorer, navigating using, 83–86,
  88, 420, 469–470, 474
Folder dialog box (IE), 188
Folder Options dialog box (Windows Explorer)
  General tab, 429–430
  Hide extensions for known file types
    option, 342
  Show common tasks in folders option, 83
  View tab, 94, 101, 474, 475
font. See also text
  character, special, 138
desktop, 539
downloading, 132–133
e-mail, 214, 238
Notepad, 132
proportional, 125
Windows Messenger, 255–256, 274
Windows Movie Maker, 402
word processing software, changing in, 132
WordPad, 132
Format bar (WordPad), 125, 132
Format dialog box, 482
Format ◄ Rich Text (HTML) (Outlook Express), 214
Formatting Bullets button (Outlook Express), 214
formatting disk
  CD-ROM, 493
  floppy/zip disk, 481–483
  hard disk, 482, 584
Formatting Numbers button (Outlook Express), 214
Forward button
  IE, 180
  Outlook Express, 220
  Windows Explorer, 88
  Windows Media Player, 349
.fpx files, 306
fragmenting, 467
frame, Web page, 181
freeware, 353
G
game
  installing, 567
  port, 569
Gateway Computers Web site, 51
gateway, residential. See router
 .gem files, 306
Get Digital ID button (Outlook Express), 242
GHz (Gigahertz), 472
GIF (Graphics Interchange Format), 102
gigabyte, 462
Gnutella file sharing network, 287, 349, 352–353
Go button (IE), 177
Google search engine, 189, 195–196
 .gov Internet domain, 174
graphic. See picture
Graphics Interchange Format. See GIF
graphics program, 319
group
  MSN Group, 282
  WAB contact, 235
  Windows Messenger contact, 272–274
 工作组, 604, 608–609, 629
  Guest user account, 519, 524
hacking, 288–290
handle, sizing item using, 18–19, 67–68
hard disk
backup, dedicating drive to, 585, 589
capacity, 462–463
cleaning up, 464–465
cost, 463
defragmenting, 466–468
drive letter, 460
filing cabinet analogy, 477–478
folder display, 79
formatting, 482, 584
introduced, 3
My Computer display, 460–461
recovering data from damaged, 584
root folder, 469, 471–472, 473
rotation speed, 466
scanning for error, 466, 467
space free, determining, 364, 462–464
hardware. See also specific device
backup hardware, specialized, 584
Device Manager, 573–574
external, 568, 628
hot-pluggable, 568, 570
installing, 518, 562–563, 568–570
internal, 568
overview, 3–8
port, 150, 288, 568–569
system requirement, 627–628
uninstalling, 572–574
help
computer manufacturer resources, 51, 579
dialog box help, 33–34, 535
error message help, 578–579
expert, trusted, 264
Favorites, adding help topic to, 44, 47–48
faxing help, 159
history of topics visited, displaying, 47
IE help, 206
keyboard Help key, 7, 41, 52
navigating help topics, 46–47
.NET Passport help, 282
online resources, 49–51
Outlook Express help, 219, 243
printing
accessing help concerning, 148, 579
making printout of help topic, 45
Properties dialog box information, 51
screen tip, 6, 51, 52, 62
searching help resources, 41–46, 49–50
software-specific, 71
Suggested Topics option, 43
Windows Media Player help, 382
Windows Messenger Remote Assistance feature, 264–266
Windows Picture and Fax Viewer help, 326
Help ‡ About (common menu item), 331
Help ‡ About Windows Media Player, 335
Help ‡ About Windows Messenger, 250
Help ‡ About Windows Movie Maker, 384
Help and Support Center
accessing, 41
Add to Favorites button, 44
Change View button, 44
closing, 48
color, 44
computer manufacturer, customization by, 41, 206
Display button, 46
error message help source, as, 578
Favorites pane, 47–48
History button, 47
index, 45–46, 47
Pick a Help Topic option, 42
Table of Contents, 45
toolbar, 46–47
Topics Found dialog box, 46
Troubleshooters, 48, 49, 498, 579–580, 610
Windows Basics option, 42
Windows XP help, limited to, 578
Help (?) button (common software control), 33–34, 51, 535
Help ‡ Check for Player Updates (Windows Media Player), 335
Help ‡ Getting Started (Windows Media Player), 382
Help ‡ Help Topics (Windows Media Player), 382
Help ‡ Office on the Web (Office software), 299
Help ‡ Online Support (IE), 206
Help ‡ Windows Movie Maker on the Web, 384
Hewlett-Packard/Compaq Web site, 51
.HGL files, 306
highlighting
selection, 128
Start menu, newly installed software in, 545
Windows Messenger Whiteboard, on, 128
HighMAT (High-Performance Media Access Technology) CD, 367
History button (Help and Support Center), 47
History feature (IE), 182–183, 184
Home button (IE), 180
Home key, 128
home page, 173, 175, 185
Home (Personal) Edition of Windows XP, 629
hot (hyperlink attribute), 256
Hotfix patch, 572
Hotmail Web-based e-mail, 210, 228, 286
hot-pluggable hardware, 568, 570
HPNA (home phoneline network adapter), 596
HTM files, 102
HTML (Hypertext Markup Language), 102, 213, 240
HTTP (Hypertext Transfer Protocol), 192
HTTPS (HyperText Transmission Protocol, Secure), 192
hub, 595, 596, 598
Hubble Telescope Web site, 510
hung computer, 581
hyperlink
e-mail, inserting in, 216–217
hot, 256
IE Links toolbar, 553
instant messaging conversation, inserting in, 256
opening, 178–179
picture as, 178
printing, 182
target, 179–180
Hyperlink dialog box (Outlook Express), 216
Hypertext Markup Language. See HTML
Hypertext Transfer Protocol. See HTTP
HyperText Transmission Protocol, Secure. See HTTPS
icon
aligning, 96
All Programs menu icon display, 548
arranging
desktop, 15, 542
My Computer folder, 461
Windows Explorer, 95–96
creating custom, 458
default, changing, 457–458, 538
described, 14
desktop icon
adding, 538
arranging, 15, 542
folder containing, 79
removing, 538
Details view, 91–95, 323–324, 453
document icon, 75–76
dragging
copying via, 442
moving via, 442
selecting via, 428–429
file
display of file icon, 89, 346, 420, 504
system file used to store, 458
folder icon, 78, 89, 420, 457
grouping, 96
List view, 91
Notification Area, 550, 552
opening, 15, 75, 88, 429
picture icon, 305
pinned icon, 542
printer icon, 616
Quick Launch toolbar, 551–552
selecting, 428–432
shortcut icon, 555–556
shrinking item back to, 15
sorting, 92–93, 95–96
Start menu, 542, 544, 546–547
Tiles view, 89
title bar, display in, 13
view, changing, 88
Icon Grabber software, 458
Icon Maker software, 458
IconCool Editor software, 458
Icons view, 89
ICS (Internet Connection Sharing) host, 601, 606, 607
identity (WAB), 232
IE (Internet Explorer). See also Web browser
Add Favorite dialog box, 186, 190
Address bar, 175
AutoComplete feature, 175–176
Back button, 180
Create In button, 190
Current button, 185
Customize button, 193
Delete button, 189
Delete Cookies button, 184
Delete Files button, 184
dial-up connection, using with, 174
Explorer bar, 182, 186, 192, 203
Favorites feature, 180, 185–190
Folder dialog box, 188
Forward button, 180
Go button, 177
help features, 206
History feature, 182–183, 184
Home button, 180
home page, default, 175, 185
Internet connection requirement, 174
Internet Options dialog box, 184–185
Links toolbar, 553
Media bar, 203, 204–205
music, playing, 202–205
New Folder button, 190
Organize Favorites window, 187–188
Print button, 181
Print dialog box, 142, 181
Quick Launch toolbar button, 174
Refresh button, 180, 181
Rename button, 189
Continued
IE (Internet Explorer) (continued)
  Save Picture dialog box, 315
  Search Assistant, 193, 194–195
  Search bar, 192–193
  Search button, 183
  Security Alert message, 192
  security zone, 240–241
  Standard toolbar, 180
  starting, 59, 174
  status bar, 177
  Stop button, 180
  support, online, 206
  taskbar button, 179
  Temporary Internet Files folder, 181, 184
  toolbar display, 177
  Troubleshooter, 206
  video, playing, 202–205
  View button, 183
  volume control, 204
  window management, 175, 178–179
  Windows Explorer versus, 81
  Windows XP, included with, 174
     .iff files, 305
     image. See picture
  Image ▸ Stretch/Skew (Paint), 327
  iMesh Gnutella client, 352
  .img files, 306
  Import button (Windows Movie Maker), 397
  Import File dialog box (Windows Movie Maker), 404, 406
  Increase Indentation button (Outlook Express), 214
  index card, electronic, 135
  ink (hand-written message), 275
  input device, alternative, 559
  Insert ▸ Hyperlink (Outlook Express), 216
  Insert ▸ My Business Card (Outlook Express), 241
  Insert Picture button (Outlook Express), 215
  Insert ▸ Signature (Outlook Express), 240
  insertion point, 127
  installing. See also uninstalling; upgrading
  Calculator, 567
  camera, digital, 315–317
  CD-ROM, from, 489, 564, 585–586
  Character Map, 137
  Digital Photo Editor, 331
  Fax Services, 153
  floppy disk, from, 564
  game, 567
  hardware, 518, 562–563, 568–570
  opening installation file, 198
  Paint, 567
  printer, 149–150
  product key requirement, 586, 629
  Restore Point, creating before, 197, 562–563
  scanner, 315–317
  serial number requirement, 586
  software, 197–199, 489, 518, 563–566
  Start menu, highlighting newly installed software in, 545
  USB device, 569–570
  user account type needed, 518
  utility, 567
  Windows Component, 137, 566–568
  Windows XP upgrade, 297–299, 627–631
  instant messaging. See messaging, instant
  interface, 334
  Internet. See also connection, Internet; World Wide Web
  cloud analogy, 166
  cookie, 184–185, 530
  described, 163
  domain, 173, 174
  faxing via Internet fax service, 158
  searching, 192–196, 457
  Internet Connection Sharing host. See ICS host
  Internet Connection Wizard, 210
  Internet Explorer. See IE
  Internet Options dialog box (IE), 184–185
  ISP (Internet Service Provider)
  account, 166, 209–210, 228, 246
  cable provider as, 166
  described, 163–164
  LAN setup done by, 600
  phone company as, 166
  Jaz disk, 478, 479
  .jif files, 306
  JPEG (Joint Photographic Experts Group) format
  bitmap compared, 510–511
  compression, 511
  file size, 510–511
  introduced, 102
  searching for JPEG file, 450
  summary information, 323–324
  support, universality of, 307
  Web graphic, using for, 151
  K
  Kazaa Gnutella client, 352
  kbps (kilobits per second), 410
  kbps (kilobytes per second), 164
  KDC (Kodak Digital Camera) files, 306
  keyboard
  accessibility features, 557, 558
  Application key, 7
  arrow keys, 36, 128
  Backspace key, 35, 36, 85
combination keystroke, 8, 69, 557
End key, 128
Enter key, 124
Esc key, 68, 69
FilterKeys feature, 557, 558, 637
function key overview, 7
Help key, 7, 41, 52
Home key, 128
keypad, numeric, 6–7
MouseKeys feature, 557, 558, 637
navigation key overview, 6–7
Num Lock key, 7
on-screen, 558
PgDn key, 128
PgUp key, 128
PrtScn key, 150
SerialKeys feature, 557, 559
shortcut
   accessibility shortcut overview, 637
   combination keystroke, 8, 69, 557
   dialog box shortcut overview, 636
   listing all, 633
   menu bar command shortcut, 69
   natural keyboard shortcut overview, 637
   text editing shortcut overview, 635
   Windows Explorer shortcut overview, 636
sound, playing when key pressed, 557
StickyKeys feature, 557, 558, 637
tab key, 125
ToggleKeys feature, 557, 558, 637
Windows key, 7, 558
kilobits per second. See kbps
kilobyte, 462
kilobytes per second. See kbps
Kodak
   Picture CD, 307, 309
   PLUSDigital camera, 307
Kodak Digital Camera files. See KDC files

L
LAN (local area network)
   Add Network Place Wizard, 623–624
   administrator, 600
cabling, 594
Centrino standard, 596
crputer, connecting, 594–599, 602–606
described, 593–594
dial-up connection, 606–607
document, sharing over, 617–618
file
   copying over, 594, 624–626
   moving over, 624–626
FireWire connection, 604
folder, sharing over, 613, 617–618, 619–623
HPNA, 596
hub, 595, 596, 598
ICS host, 601, 606, 607
installing Windows XP upgrade, configuring
   when, 630
Internet connection, sharing over, 290,
   598–599, 601, 602–604, 606–607
ISP, setup done by, 600
mixed mode, 599–600
modem, sharing, 607
My Network Places folder, 289–290, 608–609,
   618–620, 623–624
Network Connections folder, display in,
   167–168, 602
Network Setup Wizard, configuring using,
   601–606
NIC, 594, 595–596, 597, 608
phoneline networking, 595
planning, 594
powerline networking, 595
printer, sharing over, 147, 614, 615–617
resource, shared, 593, 613
router, 598–599, 601, 603, 606, 608
security, 607–608
software, sharing over, 622
speed, 596, 597
typical, 594–595
transparency, 606
troubleshooting, 609–611, 620–621
wireless, 596–598
workgroup, configuring for, 604, 608–609
landscape page orientation, 127, 143
language
   bar, 553
   installing Windows XP upgrade, specifying
      when, 629
laser medium, 479
Lavasoft Ad-Aware software, 295–296
.lbm files, 306
license, digital, 350, 351–352
License Management dialog box (Windows
   Media Player), 351–352
LimeWire Gnutella client, 352, 353
limited user account, 517–518
Line tool (Windows Messenger Whiteboard),
   269–270, 271
link. See hyperlink
Links button (taskbar), 553
Links toolbar (IE), 553
LinkSys Web site, 594
Liquid Audio software, 351
list box control, 31–32
list, text, 214–215
local area network. See LAN
Local Disk (C:) folder, 79
local resource, 165, 168, 419, 614
locking
document, 135
player, 203
taskbar, 548, 550
toolbar, 87, 474
Windows Messenger Whiteboard, 270
Log Off ➪ Switch User, 524
Log Off Windows dialog box, 526, 527
logging in/out. See signing in/out
LPT port, 150
Lycos search engine, 195
.m.ac files, 306
Magnifier feature, 558, 559
Main Identity’s Contacts folder (WAB), 232
map
searching online, 189, 194
WAB, displaying from, 234
MapQuest Web site, 189
margin
printing, for, 142
text document, 126
Maximize/Restore Visual button (Windows Media Player), 348
maximizing
folder, 84
window, 65–66
mbps (megabits per second), 410
McAfee software
SpamKiller, 295
VirusScan, 286, 287
MDI (multiple document interface), 110, 119
Media bar (IE), 203, 204–205
media file
compression, 353, 367, 511
document, as, 333, 359
downloading, 349, 351
format
overview, 341–342
preferred, 341, 342, 353
introduced, 333
license, digital, 350, 351–352
metadata, 359
opening, 343–344
player, specifying default, 344, 345
searching, 342–343, 449, 454–455
size, 349
streaming medium versus, 350
Summary property, 359–361
Media Player. See Windows Media Player
medium
distribution medium, 487, 587
laser, 479
magnetic, 479, 480
removable, 3, 435, 477–480
streaming
described, 350
downloading, 201
media file versus, 350
music, 202–204
playing, 202–204
saving, 346, 350
video, 202–204, 346
megabits per second. See mbps
megabyte, 462
Megahertz. See MHz
memory
printer buffer, 146
RAM, 104, 527
ROM, 307
system requirement, 627
user account, needed to keep open, 527
volatile, 104
menu. See also specific menu
bar
described, 60
Outlook Express, 212
printing from, 141
pull-down menu, accessing from, 69
saving document using, 104
shortcut key, accessing menu bar
command using, 69
Windows Explorer, 82
Windows Media Player, 334
Windows Movie Maker, 385
collapsible, 70
command, 69
exiting, 69
folder shortcut menu, 80
introduced, 11
pull-down menu, 69
submenu, 69
toggle option, 70–71
Message ➪ Block Sender (Outlook Express), 295
Message ➪ New Message (Outlook Express), 212
messaging, instant. See also Windows Messenger
alert display, 257, 276, 281
cell phone, using, 282
contact
adding, 251, 256–257
alert, displaying when arriving
online, 276
blocking, 277–278
deleting, 274
displaying, 251, 259
displaying people who have added
you, 278
grouping, 272–274
permission, 256–257
phone number, displaying/hiding, 279

conversation
blocking someone from, 257
copying and pasting text, 256
displaying, 257, 262, 266
hyperlink, inserting, 256
My Allow List requirement, 278
participants, with multiple, 257
picture, inserting in text area, 256
starting, 251–252, 257, 264
video, 263–264
voice, 261–262, 279
described, 250
emoticon, 252–255
Exchange Instant Messaging service, 279
file, transferring, 259–260, 277
font, 255–256
ink (hand-written message), receiving, 275
.NET Passport requirement, 250
Notification Area display, 248, 257, 276, 281
online status display, 258–259, 275, 276, 278
picture, transferring, 259–260
privacy, 277–279
signing in/out, 248, 257, 259, 281
voice conversation, 261–262, 279
Windows Messenger Whiteboard, 268–272

Messenger, MSN, 250
Messenger Properties dialog box (Windows Messenger), 293–294
metadata, 359
MHz (Megahertz), 472

microphone
Audio Tuning Wizard, 261
headset, 261
port, 569
USB, 261
Windows Messenger, using with, 261, 262
Windows Movie Maker, using with, 407

microprocessor, 472

Microsoft Office. See specific Office software
Microsoft Plus! Digital Media Edition software, 382
Microsoft Web site
accessibility resources, 559
downloading software from, 197
error message resources, 578–579
faxing resources, 159
firewall resources, 290
IE resources, 206
Knowledge Base, 159, 206
Office update page, 299
Outlook Express resources, 243
printing resources, 579
searching, 49–50, 189
Windows Movie Maker resources, 384
Windows update page, 299, 381
Microsoft Windows Movie Maker files. See MSWMM files
MIDI (Musical Instrument Digital Interface), 341
.m1v Internet domain, 174

minimizing
folder, 84
window, 65–66, 120, 358

modem
cable modem, 168
described, 163
DSL modem, 630
faxmodem, 152, 153
installing Windows XP upgrade, configuring when, 629, 630
pulse dialing, 629
sharing, 607
status, displaying, 168
troubleshooting, 170–171

.m1v files, 341

monitor
brightness control, 537
burn-in, 538
color depth, 540–541
contrast control, 537, 556, 558
flat, 540
notebook computer, 540
resolution, screen, 384, 540–541
system requirement, 628
turn off option when idle, 539

Morpheus Gnutella client, 352
motherboard, 585

Motion Pictures Experts Group format. See MPEG format

mouse. See also dragging
accessibility, customizing for, 557, 558
button, 4
clicking, 6, 63, 129, 429–430
holding properly, 5
keyboard, performing mouse function using, 557
pointing, 5–6
port, 569
scrolling using, 17
Start menu submenu, opening when pausing over, 545
wheel, 4, 17, 31

MouseKeys feature, 557, 558, 637
.mov files, 342
Move button (Windows Explorer), 443
Move dialog box (Outlook Express), 430
Move to Folder ➤ Inbox (Outlook Express), 227

Notification Area display, 248, 257, 276, 281

offline, appearing, 259

online status display, 258–259, 275, 276, 278

picture, transferring, 259–260

privacy, 277–279

signing in/out, 248, 257, 259, 281

voice conversation, 261–262, 279

Windows Messenger Whiteboard, 268–272

Microsoft Office. See specific Office software
Microsoft Plus! Digital Media Edition software, 382
Microsoft Web site
accessibility resources, 559
downloading software from, 197
error message resources, 578–579
faxing resources, 159
firewall resources, 290
IE resources, 206
Knowledge Base, 159, 206
Office update page, 299
Outlook Express resources, 243
printing resources, 579
searching, 49–50, 189
Windows Movie Maker resources, 384
Windows update page, 299, 381
Microsoft Windows Movie Maker files. See MSWMM files
MIDI (Musical Instrument Digital Interface), 341
.m1v Internet domain, 174

minimizing
folder, 84
window, 65–66, 120, 358

modem
cable modem, 168
described, 163
DSL modem, 630
faxmodem, 152, 153
installing Windows XP upgrade, configuring when, 629, 630
pulse dialing, 629
sharing, 607
status, displaying, 168
troubleshooting, 170–171

.m1v files, 341

monitor
brightness control, 537
burn-in, 538
color depth, 540–541
contrast control, 537, 556, 558
flat, 540
notebook computer, 540
resolution, screen, 384, 540–541
system requirement, 628
turn off option when idle, 539

Morpheus Gnutella client, 352
motherboard, 585

Motion Pictures Experts Group format. See MPEG format

mouse. See also dragging
accessibility, customizing for, 557, 558
button, 4
clicking, 6, 63, 129, 429–430
holding properly, 5
keyboard, performing mouse function using, 557
pointing, 5–6
port, 569
scrolling using, 17
Start menu submenu, opening when pausing over, 545
wheel, 4, 17, 31

MouseKeys feature, 557, 558, 637
.mov files, 342
Move button (Windows Explorer), 443
Move dialog box (Outlook Express), 430
Move to Folder ➤ Inbox (Outlook Express), 227
movie. See video
Movie button (Windows Movie Maker), 398
Movie Maker. See Windows Movie Maker
.mp files, 341
.mp files, 341
MPEG (Motion Pictures Experts Group) format compression, 511
downloading, 353
file types associated with, 341
prevalence, 341
Summary property, 359–361
Windows Media Player support, 342
.MPG files, 102
MP3 Creation Pack plug-in, 367
MP3 files
compression, 511
creating when ripping CD, 367
downloading, 353
introduced, 102
opening, 102, 367
player, 380–381
prevalence, 341
Summary property, 359–361
Windows Media Player
player, copying to using, 380–381
support, 342, 367
WMA, converting from, 367
.mp2 files, 341
.mp2 files, 341
.mpv2 files, 341
msconfig command, 631
MS-DOS startup disk, creating, 482
MSN
chat room, 282
e-mail, 210, 228, 286
Group feature, 282
Messenger, 250
.msp files, 306
MSWMM (Microsoft Windows Movie Maker) files, 409
.m3u files, 341
multimedia, 333
multiple document interface. See MDI
music
album title, displaying, 360
All Users Shared Music folder, 530
artist, displaying, 360
audio control, 204, 338
bit rate, 353
content, protected, 350, 368
copying
CD, from, 337, 365–368
CD, to, 337, 341, 379–380
device, to, 337, 380–381
vinyl LP, 381–382
copyright, 368
downloading, 350–351, 353, 363
e-mail, attaching to, 217
file
format, converting, 367
format overview, 341–342
format, preferred, 341, 342, 353
format, specifying when ripping CD, 367
naming, 366
size, 363, 364
folder
monitoring for new music, 363
organizing music in, 339–340, 365–366
genre, displaying, 360
Gnutella file sharing network, 287, 349, 352–353
information about song
accessing online, 344–345, 361–362, 364
CD, contained on, 366
displaying, 355, 360
Summary property, 359–361
updating, 363
library
adding CD music to, 337, 364–365, 369–371
adding downloaded music to, 353, 363
deleting music from, 363
displaying, 360–361
file size cut-off point, specifying, 363
moving music file after addition to, 353
updating, 353
license, digital, 350, 351–352
metadata, 359
muting, 204
My Music folder, 79, 80–81, 85, 339–341, 521
naming
file, 366
song, 365
opening, 343–344
playing
CD, 204, 344–346
choosing player, 203
default player, specifying, 344, 345
fast forward, 338
folder, all songs in, 340
IE, using, 202–205
jumping to part of song, 338
locking/unlocking player, 203
MP3 file, 102, 367
muting, 338
online music, 202–205
pausing, 204, 337
stopping, 204, 338
streaming music, 202–204
track, specifying, 204
window, sizing, 203
radio, online, 304, 337, 355
searching, 342–343, 449, 454–455
Shared Music folder, 79, 339, 365–366, 530, 617
streaming, 202–204
Summary property, 359–361
title, displaying, 360
video background music, 396, 397, 406–407
visualization, 337, 354, 355
volume control, 204, 338
Musical Instrument Digital Interface. See MIDI
Mute button (Windows Media Player), 338
My Computer folder
Copy Disk dialog box, 487
drive display, 460–461, 479, 496, 564
Enable CD recording on this drive option, 494
icon, arranging, 461
introduced, 79
opening, 461
My Documents folder
backup, facilitating using, 587
desktop shortcut, copying to, 555
hiding content from other user, 525
hierarchy, 80–81
introduced, 79
opening, 80
user account, association with, 521, 524, 528–529, 530
My DVD software, 495
My Music folder, 79, 80–81, 85, 339–341, 521
My Pictures folder
Filmstrip view, 90–91, 303, 305
hiding content from other user, 525
introduced, 79
My Documents, contained in, 80, 81
opening, 80, 85, 304, 320
opening document in, 111
screen saver slideshow using, 538
Shared Pictures folder compared, 319
subfolder, creating in, 304, 421–422
Thumbnails view, 90, 346, 387, 396, 492
user account, association with, 521
My Received Files folder, 260, 277
My Recent Documents folder, 107, 110–111, 112, 113, 545
My Videos folder, 396

N
naming
computer, 604, 629
document, 105, 106–108
file
changing name, 426–427
music file, 366
saving, when, 105, 106–108
UNC, 626
uniqueness, 108, 109
folder
assigning name, 425
changing name, 426–427
extension, 100
music
file, 366
song, 365
picture, 308, 310, 314, 323
song, 365
UNC, 626
user account, 471, 520, 522, 529
WAB group, 235
Web browser favorite, 186, 189
workgroup, 604
Narrate button (Windows Movie Maker), 398
narration, video, 398, 407
Narrator feature, 558, 559
Nero software, 493
.net Internet domain, 174
.NET Passport
account, 246–248, 524
alert, displaying in Windows Messenger, 281
Change my .NET Passport option, 247
chat room, 282
described, 245–246
e-mail, integrating with, 228, 243, 245–247
family situation, using in, 246
help features, 282
instant messaging requirement, 250
Outlook Express, integrating with, 228, 243
password, 246, 278
signing in/out, 247, 249, 259, 281
user account, association with, 247, 524
user name, 245–246
Web site access mechanism, as, 280
Windows Messenger, relation to, 248
network. See LAN (local area network)
Network and Internet Connections Control Panel
area, 602
Network Connections folder
accessing, 167
connectoid display, 167, 168–169
firewall display, 168, 608

Continued
Network Connections folder (continued)
  Internet connection display, 167–168
  LAN display, 167–168, 602
  modem status display, 168
network interface card. See NIC
Network Setup Wizard, 601–606
New button
  Outlook Express, 240
  WAB, 233
New Folder button (IE), 190
New ⬢ Folder (Windows Explorer), 425
newsgroup, accessing using Outlook Express, 238
Next frame button (Windows Movie Maker), 389
NIC (network interface card), 594, 595–596, 597, 608
Nonsystem disk error, 583
Norton software
  Anti-Virus, 286
  Utilities, 435
Notepad utility, 132, 135
Notification Area
  connection display, 169
  described, 13–14
  icon display, 550, 552
  instant messaging display, 248, 257, 276, 281
  print queue display, 145
  printer display, 150
  process display, 552
  Safely Remove Hardware icon, 572
  Windows Messenger display, 248, 257, 276, 281
NTFS (NT File System), 482
Num Lock key, 7

O
object, 23–24
OCR (Optical Character Recognition), 153, 312
offline Internet connection, 165
OK button (common software control), 34, 535
online Internet connection, 165
OnlineConversion.com Web site, 189
Open button (common software control), 112
Open dialog box (common software dialog box), 112–114, 555
Open With dialog box (common software dialog box), 115
Open With ⬢ Windows Media Player, 344
Open With ⬢ Windows Picture and Fax Viewer, 326
opening
  CD-ROM, 308, 487, 488, 495–497
document
  folder, from, 111
  icon, from, 75
  Open dialog box, using, 112–114
  recent document, 107, 110–111, 112, 113, 545
  shared document, 619–621
  software area opened to, 76
  software default, bypassing, 114–115
  software default, into, 76–77, 110, 113
  software default, when missing, 116–117
  DVD, 487, 488, 495–497
e-mail attachment, 222–224, 225, 508
  file
    downloaded file, 200–201
    installation file, 198
    media file, 343–344
    MP3 file, 102, 367
    folder, 78, 80, 84–85, 454, 619–621
    hyperlink, 178–179
    icon, 15, 75, 88, 429
    music, 343–344
    My Computer folder, 461
    My Documents folder, 80
    My Pictures folder, 80, 85, 304, 320
    Paint, 327
    Start menu submenu by pausing over, 545
    video, 343–344, 346
    virus, 284
    Web browser favorite, 186–187
    Windows Explorer, Web page from, 177
operating system. See OS
Optical Character Recognition. See OCR
option button, 28–29
Options dialog box
  Outlook Express
    accessing, 236–237
    Compose tab, 238–239
    Connection tab, 240–242
    General tab, 237
    Maintenance tab, 240–242
    Read tab, 237, 238
    Receipts tab, 237–238
    Security tab, 222, 240–242
    Send tab, 231, 238, 239
    Signatures tab, 239–240
    Spelling tab, 239, 240
Windows Media Player
  Copy Music tab, 365
  File Types tab, 344
  Media Library tab, 362–363
  Player tab, 336, 347, 357
  Privacy tab, 364
Windows Messenger
  accessing, 274
  Accounts tab, 279
  Connection tab, 279
  Personal tab, 274–275
Phone tab, 279
Preferences tab, 275–276
Privacy tab, 277–279, 280
Windows Movie Maker, 404, 405, 408
.org Internet domain, 174
OS (operating system), 8–9, 561
Outlook Express. See also e-mail account, setting up, 210–211
Addresses button, 232
Bcc: box, 212
Blocked Senders list, 295
Browse button, 240
Cc: box, 212
Center button, 214
Choose Profile dialog box, 505
Create a Hyperlink button, 216
Create Folder dialog box, 229
Create Mail button, 212
Decrease Indentation button, 214
Delete button, 220, 227
Deleted Items folder, 211, 227, 228, 242
e-mail client, making default, 210
Folders pane, 211
Formatting Bullets button, 214
Formatting Numbers button, 214
Forward button, 220
Get Digital ID button, 242
help features, 219, 243
Hyperlink dialog box, 216
Inbox, 211, 219, 229
Increase Indentation button, 214
Insert Picture button, 215
Internet Connection Wizard, configuring using, 210–211
menu bar, 212
Move dialog box, 230
.NET Passport, integrating with, 228, 243
New button, 240
New Message window, 212, 240
newsgroup, accessing using, 238
Options dialog box
accessing, 236–237
Compose tab, 238–239
Connection tab, 240–242
General tab, 237
Maintenance tab, 240–242
Read tab, 237, 238
Receipts tab, 237–238
Security tab, 222, 240–242
Send tab, 231, 238, 239
Signatures tab, 239–240
Spelling tab, 239, 240
Outbox, 211
Picture dialog box, 215
Previous button, 220
Print button, 220
Rename button, 240
Reply All button, 220
Reply button, 220
Save As dialog box, 508
Save Attachment As dialog box, 224
Save Attachments dialog box, 224
Save button, 224
security, 222, 225
Select Recipients window, 236
send options, 219
Send/Recv button, 219
Sent Items folder, 211
sound options, 237
Spelling button, 214
starting, 210
Subject: box, 212
To: button, 236
toolbar, 212
virus protection, 222, 225, 286
WAB, interfacing with, 231–236
Web site, 243
window management, 219
Windows XP, included with, 209
TheOutlookExpressClub MSN group, 243

P

packet handling, Web browser, 180
packet-writing, 493
Page not Found error, 205
Page Setup dialog box (WordPad), 126
page (total number of items visible at once), 32
Paint utility
Copy To dialog box, 328–329
copying picture to, 327–328
document window, 76, 327
installing, 567
opening, 327
Print dialog box, 330–331
Save As dialog box, 331
Save button, 329
screen print, pasting to, 151
Select tool, 328
sizing window, 64, 65
starting, 59
Stretch and Skew dialog box, 330
undo functionality, 328
parallel port, 150
password
administrator password, 629
case-sensitivity, 38, 246
entering, 38
.NET Passport, 246, 278
safeguarding, 519
text document, protecting using, 135
user account, 518–519, 522, 525
pasting, 133. See also copying
path, 260, 310, 472–475
PBM (Portable Bitmap) files, 306
PC-cillin software, 286
.pcd files, 306
.pct files, 306
.pcx files, 307
PDF (Portable Document Format), 102, 116, 118, 135, 224
peer-to-peer network. See p2p network
Pen tool (Windows Messenger Whiteboard), 269
Performance and Maintenance Control Panel area, 297
period (.) file extension prefix, 100
PgDn key, 128
PGM (Portable Greymap) files, 306
PgUp key, 128
phone
  instant messaging
    cell phone, using, 282
    contact phone number, displaying/hiding, 279
    making call using Windows Messenger, 279
phoneline networking, 595
Photo Editor software, 119
Photo Printing Wizard, 321–322, 326
.pic files, 306
picture. See also specific file format
  aligning, 216
  All Users Shared Pictures folder, 530
  backing up, 308
  border, 216
  camera, downloading from digital, 310–312
  copying
    CD-ROM, from, 307–310
    CD-ROM, to, 307, 321
    Paint, to, 327–328
    text document, to, 135–136
    user account, to another, 531
    Web page, from, 136, 179, 314–315, 327–328
    Windows Messenger Whiteboard, to, 268, 271
  cropping, 328–329
  deleting
    camera, from digital, 311
    computer, from, 326
desktop background, 537–538
document, as, 303
editing, 319, 322–323, 326–331
e-mail, attaching to, 215–216, 217
file
  clipboard, picture file used to store, 306
  compressing, 510
  deleting, 326
format, converting, 510
format overview, 305–307
searching, 449, 450
size, 313, 510–511
film, having copied to CD-ROM by developer, 307
group, creating, 308
hyperlink, as, 178
icon display, 305
instant messaging, transferring during, 259–260
My Pictures folder
  Filmstrip view, 90–91, 303, 305
  introduced, 79
My Documents, contained in, 80, 81
opening, 80, 85, 304, 320
opening document in, 111
Shared Pictures folder compared, 319
subfolder, creating in, 304, 421–422
Thumbnails view, 90, 346, 387, 396, 492
user account, association with, 521
naming, 308, 310, 314, 323
organizing, 421–424
orientation, changing, 303
original, safekeeping, 322–323, 329, 330
pixilation, 330
printing, 321–322, 326, 330–331
resolution, 313
rotating, 323, 325
saving, 329, 331
scanning, 312–314
selecting, 321, 328
sharing, 79, 303–304, 319, 321, 530
sizing, 313–314, 329–330
skewing, 330
slideshow, 320, 325, 404, 538
sorting, 323
stretching, 330
subject information, adding, 323–324
text, of, 271, 312
Thumbnails view, 90, 346, 387, 396, 492
title, 323–324
undoing edit, 328
user account picture, 518, 522, 523
video
  frame, converting to picture, 403
  importing into, 396, 397, 404
viewing
  filmstrip display, 90–91, 303, 305
graphics program, using, 319
  rotating picture on-screen, 325
  screen, fitting to, 325
  slideshow, 320, 325, 404, 538
  thumbnail display, 90, 303, 305
Windows Explorer, using, 90–91, 303, 305, 320
Windows Picture and Fax Viewer, using, 325–326
zooming, 151, 325
Web graphic, 151
working copy, 322–323, 330
zooming, 151, 325
Picture dialog box (Outlook Express), 215
pixilation, 330
platform, 9, 561
Play button (Windows Movie Maker), 397
Play ‹ DVD, VCD, or CD Audio (Windows Media
Player), 348
Playback indicator button (Windows Movie
Maker), 398, 400
Play/Pause button
  Windows Media Player, 337
  Windows Movie Maker, 388, 399, 400
Plus! Digital Media Edition software, 382
PLUSDigital camera, 307
PNG (Portable Network Graphics) files, 306
pointing, 5–6
PolderbitS Sound Recorder software, 382
POP3 (Post Office Protocol 3), 209–210
pop-up window
  blocking, 281, 290–294, 353
closing, 72
extortion pop-up, 294
software, generated by free, 197
Windows Messenger pop-up, 281, 293–294
port, 150, 288, 568–569
Portable Bitmap files. See PBM files
Portable Document Format. See PDF
Portable Greymap files. See PGM files
Portable Network Graphics files. See PNG files
Portable Pixelmap files. See PPM files
portrait page orientation, 127, 143
Position dialog box, 537
Post Office Protocol 3. See POP3
postal address, searching online, 194
Power button (Display Properties dialog
box), 539
powerline networking, 595
PowerPoint viewer, 224
PPM (Portable Pixelmap) files, 306
PPT files, 102, 224
Preview button
  Camera and Scanner Wizard, 313
  Display Properties dialog box, 539
Previous button
  Outlook Express, 220
  Windows Media Player, 338
Previous frame button (Windows Movie
Maker), 388
primary drive. See hard disk
Print button
  IE, 181
  Outlook Express, 220
  software control, common, 141
  WAB, 234
Print dialog box
  IE, 142, 181
  Paint, 330–331
  software dialog box, common, 142, 143,
  148–149, 615
  Word, 142
print server, 145
printer. See also printing
  buffer, 146
cable, 149
default, setting, 148, 617
deleting, 147
FireWire connection, 149–150
icon, 616
infrared connection, 150
ink, 152
installing, 149–150
manufacturer Web site, accessing from
  Printers and Faxes folder, 147
output options, specifying, 143–144
port, 150, 569
queue, 144–146, 147
remote printer, 614
selecting, 142, 148–149, 615
serial connection, 150
sharing over LAN, 147, 614, 615–617
troubleshooting, 151–152
USB connection, 149–150
Printer ‹ Cancel All Documents (common menu
item), 146
Printer ‹ Close (common menu item), 146
Printer ‹ Pause Printing (common menu
item), 146
Printers and Faxes
  folder, 146–148, 155
  Start menu option, 616–617
Printers and Other Hardware Control Panel
  area, 146
printing. See also printer
  back to back, 143
canceling, 145, 146
collating output, 143
color, 144
copies, multiple, 143
delay, normal, 142
duplex, manual, 143
e-mail, 220, 223
Continued
printing (continued)
fax
  fax device, to, 148, 157
  printer, to, 154
help
  accessing help concerning, 148, 579
  making printout of help topic, 45
hyperlink, 182
IE, 142, 181
job, controlling, 144–146
margin, 142
menu bar, from, 141
page
  order, 143, 151
  orientation, 127, 143
  range, 143
  sheet, multiple pages to one, 143
paper, 143–144, 152
pausing, 145, 151
picture, 321–322, 326, 330–331
previewing output, 142
quality of output, specifying, 144
queue, 144–146, 147
screen, 150–151
starting, 141, 144, 152
stopping, 145, 146
text, 127
toolbar, from, 141
troubleshooting, 148, 151–152
WAB contact, 234
Web page, 181–182
WordPad, 127
Printing Preferences button (Photo Printing Wizard), 321
privacy
  administrator account, 518, 519, 525
  user account, 517, 518, 524–525, 528–531
  Web browser, 184
  Windows Media Player, 364
  Windows Messenger, 277–279
process, 552
processor, 472–473
product activation, 630
product key, 586, 629
Professional Edition of Windows XP, 629
program. See software
Program Files folder, 472
program window, 59. See also window property
  accessing using Control Panel, 25–27
  object, relation to, 23
protected content, 350, 368, 396
PrtScn key, 150
  .ps files, 306
  .psd files, 306
  .psp files, 306
PS/2 port, 569
p2p (peer-to-peer) network, 352
pull-down menu, 69
Q
question mark (?) Help button, 33–34, 51, 535
Quick Launch toolbar
  desktop shortcut, copying to, 556
  displaying/hiding, 66, 549, 553
  icon display, 551–552
  Internet Explorer button, 174
  introduced, 58
  Show Desktop button, 66
  sizing, 551
  Windows Media Player button, 333
QuickBooks software, 587
Quicken software, 587
R
radio
  button, 28–29
  online, 304, 337, 355
RAID (Redundant Array of Inexpensive Drives), 585
  .ram files, 342
RAM (Random Access Memory), 104, 527
  .ras files, 306
  .raw files, 306
  RCA jack, 389, 390, 391
Read Only Memory. See ROM
RealAudio format, 342
Receive Now button (Fax Console), 158
Record dialog box (Windows Movie Maker), 392
recovering from disaster. See disaster recovery
RecoverMyFiles software, 437
Recycle Bin, 434–437, 464–465, 493
Redundant Array of Inexpensive Drives. See RAID
Refresh button
  IE, 180, 181
  Windows Media Player, 349
regional option, specifying when installing
  Windows XP upgrade, 629
Remote Assistance feature (Windows Messenger), 264–266
remote resource, 165, 168, 419, 614
Rename button
  IE, 189
  Outlook Express, 240
Reply All button (Outlook Express), 220
Reply button (Outlook Express), 220
residential gateway. See router
resolution
  picture, 313
  screen, 384, 540–541
resource
described, 593, 613
  local, 165, 168, 419, 614
  remote, 165, 168, 419, 614
  shared, 593, 613
Restore button, 65–66
Restore Default button
  Desktop Items dialog box, 538
  software control, common, 34
Restore from Backup button (Windows Media Player), 352
Restore Point feature, 197, 562–563, 575
restoring
  backup, 586, 589
  computer to earlier state, 562–563, 570, 574–575, 584
dialog box default, 33–34
Rewind button
  Windows Media Player, 338
  Windows Movie Maker, 398, 400
Rich Text Format. See RTF
ripping audio CD, 365, 367
  .rle files, 306
ROM (Read Only Memory), 307
root folder, 469, 471–472, 473
router, 598–599, 601, 603, 606, 608
Roxio Easy CD Creator software, 493
RTF (Rich Text Format), 102

S
safe mode, 583
Safely Remove Hardware dialog box, 572–573
Save As button (Display Properties dialog box), 541
Save As dialog box
document, saving using, 72, 104–108, 117–118, 201
  Kodak Picture CD, 309
  Outlook Express, 508
  Paint, 331
  software installation file, saving using, 199
  Windows Explorer, 425–426
Save Attachment As dialog box (Outlook Express), 224
Save Attachments dialog box (Outlook Express), 224
Save button
  Kodak Picture CD, 309
  Outlook Express, 224
  Paint, 329
  toolbar, 104
Windows Explorer, 425
  Windows Movie Maker, 408
Save Picture As dialog box (Windows Movie Maker), 403
Save Picture dialog box (IE), 315
Save Project As dialog box (Windows Movie Maker), 408
saving
document
  CD-ROM, to, 109
  closing, before, 72
described, 104
  floppy disk, to, 109
  menu bar, using, 104
toolbar, using, 104
type, changing when, 117–118
e-mail attachment, 223, 224–225
toolbar, using, 104
medium, streaming, 346, 350
  picture, 329, 331
  software installation file, 199
text, 138–139
  video file, 408–409
  zip file, 508, 509
Scanner and Camera Wizard, 308, 310, 313–314
Scanners and Cameras folder, 316
scanning
  hard disk for error, 466, 467
  imaging process, 303, 312–314, 315–317
  virus scanning, 287–288
SciTex Continuous Tone files. See SCT files
screen
  capture, 150
  dump, 150
  picture, fitting to, 325
  printing, 150–151
resolution, 384, 540–541
screen saver, 347, 538–539
screen tip, 6, 51, 52, 62
scroll bar, 16–17
SCT (SciTex Continuous Tone) files, 306
Search Assistant (IE), 193, 194–195
Search bar (IE), 192–193
Search Companion, 448–454, 455–457. See also
  Windows Explorer
search engine, 195
searching
  business, online, 194
e-mail
  address, for, 194
  message, for, 449
Continued
searching (continued)

file
backtracking to previous search, 450
case sensitivity, 452
content, 450
date, limiting by, 451
document file, 449
extension, limiting by, 450
indexing service, using, 451, 465
location, limiting by, 451, 452, 454
media file, 342–343, 449, 454–455
music file, 342–343, 449, 454–455
name, for specific, 450
picture file, 449, 450
size, limiting by, 452
type, limiting by, 450, 454–455
video file, 342–343, 449, 454–455
folder, 449, 451, 452
help topic, 41–46, 49–50
Internet, 192–196, 457
map, online, 189, 194
Microsoft Web site, 49–50, 189
spelling, importance of, 195

Secure Sockets Layer. See SSL

security
adware, 295–296
child, safeguarding on Internet, 296–297, 353
connection, dial-up versus broadband, 283
cracking, 288–290
downloading from Internet, when, 197–198, 566
e-mail, 221–222, 224, 237, 240–242
encryption, 191
firewall, 168, 289–291, 607–608
hacking, 288–290
Hotfix patch, 572
HTTPS, 192
IE, 192, 240–241
LAN, 607–608
Outlook Express, 222, 225
port, 288
spyware, 295–296
SSL, 191
Trojan horse, 284, 286
virus
described, 283
download protection, 198, 287–288
e-mail attachment protection, 221–222, 224, 225, 284–286
file sharing protection, 287, 351
firewall, protection offered by, 608
opening, 284
scanning for, 287–288
software, anti-virus, 286–288
WAB as vehicle for, 285
worm compared, 283

World Wide Web, 191–192
worm, 283–284, 286, 351, 608
zone, 240–241

Security Alert message (IE), 192

Seek bar
Windows Media Player, 338
Windows Movie Maker, 388

Select button (WAB), 235
Select Group Members dialog box (WAB), 235
Select Members button (WAB), 235
Select tool (Paint), 328

selecting
dragging, via, 129, 428–429
e-mail message, 226
file, 427–433
folder, 427–433
highlighting, 128
icon, 428–432
inverting selection, 432–433
picture, 321, 328
printer, 142, 148–149, 615
text, 36–37, 128–130
URL, 176
video clip, 387, 399–400, 416

Windows Messenger Whiteboard area, 270

Selector tool (Windows Messenger Whiteboard), 269, 271

semicolon (;) e-mail address list separator, 212
Send a File dialog box (Windows Messenger), 259
Send Fax Wizard, 156–157
Send To \(\rightarrow\) CD Drive (Windows Explorer), 491
Send To \(\rightarrow\) Compressed (zipped) file (Windows Explorer), 503
Send To \(\rightarrow\) Desktop (Windows Explorer), 554
Send To \(\rightarrow\) Mail Recipient
Outlook Express, 217
Windows Explorer, 505
Send To \(\rightarrow\) My Documents (Windows Explorer), 485
Send/Recv button (Outlook Express), 219
Sent Items folder (Outlook Express), 211
Serial Information Protocol. See SIP
serial number, software, 586
serial port, 150, 569
SerialKeys feature, 557, 559

server
client, relation to, 165
described, 165
mail server, 218
print server, 145
Web server, 165, 173
Services window, 293

session
SIP, 279
Web browser, 180, 184
Windows Messenger Sharing Session window, 266, 268
Session Initiative Protocol. See SIP
setting (personal preference)
  backing up, 588–589
  default, 34–35
  described, 471
Settings button (Display Properties dialog box), 538
Setup Wizard, 630
Setup.exe file, 564
Shared Contacts folder (WAB), 232
Shared Documents folder, 79, 530, 587, 617, 623
Shared Music folder, 79, 339, 365–366, 530, 617
Shared Pictures folder, 79, 303–304, 319, 321
sharing
  computer, 515–516
  document
    LAN, over, 617–618
    opening shared document, 619–621
    private document versus, 518
    software sharing, via, 266–268
  file
    copyright considerations, 368
    Gnutella file sharing network, 287, 349, 352–353
    virus protection, 287, 351
  folder over LAN, 613, 617–618, 619–623
  Internet connection over LAN, 290, 598–599, 601, 602–604, 606–607
  modem, 607
  music, 79, 339, 365–366, 530, 617
  picture, 79, 303–304, 319, 321, 530
  printer over LAN, 147, 614, 615–617
  resource, 593
  software
    LAN, over, 622
    Windows Messenger Application Sharing, using, 266–268
  WAB contact, 232
Sharing dialog box (Windows Messenger), 268
shopping, online, 191–192
shortcut
desktop shortcut
  creating, 191, 554–556
  Fax feature, to, 155, 156
  file, to, 458–459
  folder, to, 80, 458–459, 555
  icon, 555–556
  My Documents folder, copying to, 555
  Quick Launch toolbar, copying to, 556
  unused, 538
  Web page, to, 190–191
key
  accessibility shortcut overview, 637
  combination keystroke, 8, 69, 557
  dialog box shortcut overview, 636
  listing all, 633
  menu bar command shortcut, 69
  natural keyboard shortcut overview, 637
  text editing shortcut overview, 635
  Windows Explorer shortcut overview, 636
  Show Desktop button (Quick Launch toolbar), 66
  Show the Desktop option, 66
  Show/Hide button
    software control, common, 17–18, 70
    Windows Media Player, 336
  Shuffle button (Windows Media Player), 338
  shutting down Windows XP, 11, 20–21, 526, 570
  Sign Up Now button (Windows Messenger), 281
signature
  digital signature, 237, 242
  e-mail message, appending to, 239–240
signing in/out
  dial-up connection, 165
  eBay, 280
  .NET Passport, 247, 249, 259, 281
  user account, 518, 520–521, 525–526
  to Web site, using .NET Passport, 280
  Windows Messenger, 248, 257, 259, 281
SIP (Serial Information Protocol), 279
SIP (Session Initiative Protocol), 279
skin
  described, 334
slash (/) URL separator, 205
slider control, 32–33
slideshow, 320, 325, 404, 538
Smart Parent Web site, 297
.snd files, 342
sneaker network, 593
software
  adware, 295–296
  backup
    program files, of, 585–586
    specialized software, using, 584
  closing, 13, 581–582
  computer, bundled with, 58
  copying data to another, 134–136
  default
    bypassing, 114–115
    changing, 115–116
    missing, 116–117
    opening document into, 76–77, 110, 113
  desktop, opening on, 12
  document area, 61, 76
  downloading, 197–199, 565–566
  freeware, 353
  graphics program, 319
  help, software-specific, 71
  installing, 197–199, 489, 518, 563–566
  interface, 334
Continued
software (continued)
  introduced, 8
  media player, 333
  picture editing software, 319
  platform dependence, 9
  product key, 586, 629
  Program Files folder, 472
  serial number, 586
  sharing
    LAN, over, 622
    Windows Messenger Application Sharing, using, 266–268
  skin, 334
  spyware, 295–296
  starting, 57–59, 174, 544–545, 546, 631
  status bar, 61
  status, displaying in Task Manager, 581
  switching to another open application, 13, 62–63
  uninstalling, 502, 546, 570–572
  version, displaying, 546
  virus protection software, 286–288
  zip file software, 502
Sony Vaio Web site, 51
sorting
  All Programs menu, 547
  e-mail, 219
  file list, 92–93, 95–96, 453
  icon, 92–93, 95–96
  picture, 323
  Start menu, 547
sound. See audio
Sounds and Audio Devices dialog box (Windows Messenger), 276
spam, 227, 295
SpamKiller software, 295
speaker port, 569
Speakers slider (Windows Messenger), 262
Specify Dates ➤ Created Dates (Search Companion), 451
spelling
  e-mail, spell checking, 214, 240
  searching, importance in, 195
Spelling button (Outlook Express), 214
spin box control, 30
Split button (Windows Movie Maker), 389, 413–414
spyware, 295–296
SSL (Secure Sockets Layer), 191
Standard toolbar (IE), 180
Start button, 5–6, 7, 11
Start Capture button (Windows Movie Maker), 395
Start menu
  accessing, 7, 11
  All Programs submenu, 12, 57–58, 547
  arranging, 545–546, 547
  Classic view, 544
  column layout, 542
  Control Panel, accessing from, 543
described, 11
  Favorites, accessing from, 186
  folder display, 84, 542–543, 545
  icon display, 542, 544, 546–547
  Log Off option, 520, 524, 526
  My Network Places option, 618–619
  My Recent Documents option, 107, 110–111, 112, 113, 545
  naming item on, 547
  Network Connections option, 167
  number of items on, specifying maximum, 544
  pinning item to, 542–543, 546
  Printers and Faxes option, 616–617
  removing item from, 546
  Scroll Programs option, 546
  Search option, 342–343
  software
    highlighting newly installed, 545
    starting from, 57–59, 174, 544–545, 546
  sorting, 547
  submenu, opening when mouse pauses over, 545
  user account, opening when mouse pauses over, 545
starting
  Calculator, 12, 58–59
  e-mail client, 57–59, 174, 210, 544–545
  IE, 59, 174
  instant messaging conversation, 251–252, 257, 264
  Outlook Express, 210
  Paint, 59
  printing, 141, 144, 152
  safe mode, in, 583
  software, 57–59, 174, 544–545, 546, 631
  WAB (Windows Address Book), 232
  Windows Messenger, 248, 275
  Windows XP, 9–11, 583–584
startup disk, 482
status bar
  IE, 177
  software feature, common, 61
StickyKeys feature, 557, 558, 637
Stop a Hardware Device dialog box, 573
Stop button
  IE, 180
  Windows Media Player, 338, 349
  Windows Movie Maker, 388
Stop Camera button (Windows Messenger), 263
Stop Capture button (Windows Movie Maker), 395
Stop Narration button (Windows Movie Maker), 407
stopping Windows XP, 11, 20–21
Storyboard button (Windows Movie Maker), 398
streaming medium
described, 350
downloading, 201
media file versus, 350
music, 202–204
playing, 202–204
saving, 346, 350
video, 202–204, 346
Stretch and Skew dialog box (Paint), 330
Stretch button (Camera and Scanner Wizard), 314
S-Video cable, 390, 391
Switch User button (Log Off Windows dialog box), 527
Switch view button (Log Off Windows dialog box), 527
Symantec software
Anti-Virus, 286
Norton Utilities, 435
system
backing up, 585–586
date, setting, 549, 629
file, 75, 458, 472, 574–575, 585–586
folder, 79
requirement for Windows XP, 627–628
time, setting, 549, 629
System Configuration Utility, 631
System icon (Control Panel), 297
System Information window, 582–583
System Properties dialog box, 297–298, 573
System Restore feature, 562–563, 570, 574–575, 584
Systemax Web site, 51

T

Tab (dialog box panel), 28, 534, 535
Tab key, 125
Tagged Image File Format. See TIF
Take photo button (Windows Movie Maker), 389
target (hyperlink destination), 179–180
Task Manager, 581–582
taskbar. See also Notification Area; Quick Launch toolbar
Address bar display, 553–554
buttons, grouping similar, 549
clock, 549
described, 10, 12–13
desktop icons, showing all on taskbar, 553
displaying/hiding, 549
dragging, 550, 551
IE button, 179
Language bar button, 553
Links button, 553
locking/unlocking, 548, 550
moving item on, 550
row display, 551
sizing item on, 550–551
toolbar, dragging off, 554
window representation in, 13, 60, 61
Windows Media Player control set, adding to, 553
Windows Movie Maker, 385
Taskbar and Start Menu Properties dialog box, 30, 112, 544, 548–549
taskbar button (Windows Explorer), 83–84
telephone. See phone
Telex Communications microphone headset, 261
Temporary Internet Files folder, 181, 184
terabyte, 462
termination, abnormal, 11
text
aligning, 125, 214
autotype, 130
boldface, 131, 133
Character Map, 137–138
color, 132, 402
copying
document, to another, 134–135
document, within same, 133
instant messaging conversation, in, 256
Web page to text document, 134, 179, 201–202
cutting, 137
deleting, 36, 130, 131
editing, availability for, 130
editor, 130
fax, converting to text using OCR, 153
font
character, special, 138
described, 131
desktop, 539
downloading, 132–133
e-mail, 214, 238
Notepad, 132
proportional, 125
Windows Messenger, 255–256, 274
Windows Movie Maker, 402
word processing software, changing in, 132
WordPad, 132
indenting, 125, 214
inserting, 36, 127, 130–131
italic, 131, 133
line break, 124–125
list, formatting, 214–215
margin, 126
moving, 133, 137
navigating, 125, 137–138
OCR, 153, 312
Continued
text (continued)
  outdenting, 125
  Overwrite mode, 130–131
  paragraph break, 124–125
  picture, inserting in text document, 135–136
  printing, 127
  replacing, 37, 131
  saving, 138–139
  scanning, 312, 313
  selecting, 36–37, 128–130
  shortcut key overview, 635
  strikethrough, 131
  styling, 131–133
  symbol, entering, 137–138
  tab, entering, 125
  underlining, 131, 133
  video, inserting in, 401–403
  Web browser, editing using, 130
  weight, 131
  word wrap, 124
Text tool (Windows Messenger Whiteboard), 269
  textbox control, 35–37
  .tga files, 306
TheOutlookExpressClub MSN group, 243
  3½ Floppy (A:) folder, 79
Thumbnails view, 90, 346, 387, 396, 492
  Thumbs.db file, 492
TIF (Tagged Image File Format), 306
  time
    clock, taskbar, 549
    file time information
      displaying, 91
      sorting file list by, 92–93, 95, 453
    system time, setting, 549, 629
Timeline button (Windows Movie Maker), 397
  title bar
    Calculator, 13
    described, 60
    dialog box, 534, 535
    icon display, 13
    window, dragging by, 68
    Windows Explorer, 82, 420
    Windows Movie Maker, 385
  tld (top-level domain), 173, 174
To: button (Outlook Express), 236
  toggle control, 204
  ToggleKeys feature, 557, 558, 637
toolbar
  described, 60
  displaying/hiding, 87
  floating, 554
  Help and Support Center, 46–47
  IE toolbar display, 177
  locking/unlocking, 87, 474
  moving, 87
  Outlook Express, 212
  printing from, 141
  Save button, 104
  sizing, 87
  taskbar, dragging off, 554
  Windows Explorer, 82–83, 420
  Windows Media Player, 334
  Windows Movie Maker, 385
  WordPad, 125
Toolbars ➪ Quick Launch, 66
  Tools ➪ Accounts (Outlook Express), 210
  Tools ➪ Add a Contact (Windows Messenger), 251
  Tools ➪ Audio Levels (Windows Movie Maker), 407
  Tools ➪ Audio Tuning Wizard (Windows Messenger), 261
  Tools ➪ Folder options (Windows Explorer), 83
  Tools ➪ Import into Collections (Windows Movie Maker), 404
  Tools ➪ Import (Windows Movie Maker), 404
  Tools ➪ Internet Options, 176
  Tools ➪ License Management (Windows Media Player), 351
  Tools ➪ Manage Groups ➪ Add a Group (Windows Messenger), 273
  Tools ➪ Message Rules ➪ Blocked Senders List (Outlook Express), 295
  Tools ➪ Narrate Timeline (Windows Movie Maker), 407
  Tools ➪ Options
    Media Player, 334
    Outlook Express, 219
    Windows Messenger, 274
  Tools ➪ Search For Media Files (Windows Media Player), 353
  Tools ➪ Show Tabs ➪ Microsoft .NET Alerts (Windows Messenger), 281
  Tools ➪ Titles and Credits (Windows Movie Maker), 402
  Tools ➪ Video Effects (Windows Movie Maker), 404
tooltip. See screen tip
Topics Found dialog box, 46
top-level domain. See tld
To: button (Outlook Express), 236
  troubleshooting. See also disaster recovery
    CD-ROM, 497–498
    computer, frozen, 581–582
    DVD, 497–498
    e-mail, 243
    Help and Support Center Troubleshooters, 48, 49, 498, 579–580, 610
Trojan horse, 284, 286
IE, 206
Internet connection, 169–171
LAN, 609–611, 620–621
modem, 170–171
network, 170
printing, 148, 151–152
Windows XP startup, 583–584
TSID (Transmitting Subscriber Identification), 154, 155
Tucows Web site, 565, 566
Turn Off Computer ➪ Restart, 466
Turn Off Computer ➪ Turn Off, 570
TV, capturing video from, 392

U

UNC (Universal Naming Convention), 626
undo functionality
file deletion, 434–437, 493
Paint, 328
Recycle Bin, 434–437
System Restore versus, 574
Windows Explorer, 427, 435, 444–445
Windows Messenger Whiteboard deletion, 272
Windows Movie Maker, 400, 415
Unfilled Ellipse tool (Windows Messenger Whiteboard), 270
Unfilled Rectangle tool (Windows Messenger Whiteboard), 270
Uniform Resource Locator. See URL
uninstalling
defined, 571
hardware, 572–574
software, 502, 546, 570–572
United States Postal Service Web site, 189
Universal Naming Convention. See UNC
Universal Serial Bus. See USB
Unshare All button (Windows Messenger), 268
Unshare button (Windows Messenger), 268
Unused Desktop Shortcuts folder, 538
Up button (Windows Explorer), 85, 86, 510
upgrading
Microsoft Office, 299
update, critical, 299
Windows Media Player, 335–336
Windows Messenger, 250
Windows Movie Maker, 384
Windows XP, 297–299, 627–631
uploading, 166
URL (Uniform Resource Locator)
auto completing, 175–176
copying and pasting, 176
e-mail, inserting in, 177, 216
to Web browser, 175–176, 205
to Windows Explorer, 177

format, 173, 205
introduced, 173
selecting, 176
USB (Universal Serial Bus)
camera, digital, 316, 390, 391
hot-pluggability, 568
installing USB device, 569–570
microphone, 261
port, 569
scanner, 316
uninstalling USB device, 572–573
Web cam, 263
user account. See account, user account
User Accounts
Control Panel area, 247, 519, 521–522
window, 519–520, 521–522, 528
Utilities ➪ Accessories, 137
Utility Manager feature, 558–559, 637

V

Vaio Web site, 51
vCard, 241
VCD (video CD), 348–349
VCR (Video Cassette Recorder)
capturing video to computer from, 392
recording computer video to, 412
Venali Web site, 158
VGA port, 569
cable, S-Video, 390, 391
camera
audio clip, inserting, 406–407
controlling, 204, 338, 398, 406–407
format support, 396
input from camera, 390–391
music, background, 396, 397, 406–407
narration, 398, 407
bit rate, 164, 353, 410
cable, S-Video, 390, 391

video. See also Windows Movie Maker
audio
clip, inserting, 406–407
controlling, 204, 338, 398, 406–407
format support, 396
input from camera, 390–391
music, background, 396, 397, 406–407
narration, 398, 407
bit rate, 164, 353, 410
VCR mode, 392
clip
audio clip, 406–407
collection, moving to another, 415–416
combining, 414–415
creating when capturing video, 394, 395
deleting, 414
introduced, 385
naming, 414
nudging, 401

Continued
video (continued)

clip (continued)
- playing, 387, 395, 397
- selecting, 387, 399–400, 416
- splitting, 387, 389, 413–414
- storyboard, adding to/deleting from, 399
- timeline, adding to/deleting from, 398, 399

collection
- capturing to, 395
- clip, moving to another, 415–416
- displaying, 386
- importing to, 397, 404
- introduced, 386
- Video Transitions collection, 405

compression, 353

content, importing protected, 396

credits, inserting, 401–403

described, 333

downloading, 346, 353

DVD
- copying from, 489–490
- copying to, 411–412
- playing using Windows Media Player, 347–348, 487
- size, 412

effect, 404–406

e-mail, attaching to, 217, 409, 411

fast forward, 338, 389

file
- format overview, 341–342
- format, preferred, 341, 342, 353
- icon, 346
- importing, 396–397
- naming, 410
- saving, 408
- size, 409–411

folder, dedicating to, 396

frame
- navigating one frame at a time, 388–389
- picture, converting frame to, 403
- snapshot, taking, 387, 389
- trimming, 400–401

information about, displaying, 359–360

instant messaging video, 263–264

library, 363

My Videos folder, 396

narration, 398, 407

opening, 343–344, 346

pausing, 204, 337, 399

picture
- frame, converting to, 403
- importing, 396, 397, 404

playing
- captured video, 395
- choosing player, 203
- clip, 387, 395, 397
- default player, specifying, 344, 345
- DVD, 347–348, 487
- fast forward, 338, 389
- folder, all videos in, 341
- full screen, 348, 355, 388
- IE, using, 202–205
- imported video, 397
- jumping to part of video, 338
- locking/unlocking player, 203
- online video, 202–205
- pausing, 204, 337, 399
- position, displaying current, 398, 400
- screen saver, keeping from starting while, 347
- stopping, 204, 338
- streaming video, 202–204
- VCD, 348–349
- window, sizing, 203
- Windows Movie Maker, using, 387–389

previewing, 400

project, 398, 408

quality, 394, 409–411

rewinding, 338, 398, 400

saving
- file, 408–409
- project, 408
- streaming video, 346

scene, 385, 399–401

searching, 342–343, 449, 454–455

slideshow, creating using, 404

storyboard, 386, 398, 399–400

streaming, 202–204, 346

Summary property, 359–361

tape, copying to, 412

text, inserting, 401–403

Thumbnails view, 346, 387, 396

timeline
- clearing, 400
- clip, adding to/deleting from, 398, 399
- described, 397
- narration, adding to, 407
- overlapping scenes in, 401
- sizing, 398, 401
- title, inserting, 401–403
- transition, 386, 387, 401, 405–406
- trim point, 401

tV, capturing from, 392
undoing edit, 400, 415
VCR
capturing from, 392
recording computer video to, 412
Web page, posting on, 411
zooming, 398, 401
Video Cassette Recorder. See VCR
video CD. See VCD
Video Effects button (Windows Movie Maker), 404
View ➤ All Headers (Outlook Express), 212
View ➤ Arrange Icons By ➤ Name (Windows Explorer), 425
View ➤ Arrange Icons By ➤ Show in Groups (My Computer), 461
View ➤ Arrange Icons By ➤ Type (Windows Explorer), 428
View ➤ Arrange Icons By (Windows Explorer), 420
View button (IE), 183
View ➤ Choose Details (Windows Explorer), 94
View ➤ Explorer Bar ➤ Favorites (IE), 186
View ➤ Explorer Bar ➤ Folder (Windows Explorer), 469
View ➤ Explorer Bar ➤ History (IE), 182
View ➤ Explorer Bar ➤ Media (IE), 203
View ➤ Explorer Bar ➤ Search
IE, 192
Windows Explorer, 448
View ➤ Explorer Bar (Windows Explorer), 420
View ➤ Folders and Groups (Outlook Express), 232
View ➤ Go To ➤ Up One Level (Windows Explorer), 510
View ➤ List (Windows Explorer), 428
View Map button (WAB), 234
View ➤ Refresh
My Network Places, 619
Windows Explorer, 486
View ➤ Tasks (Windows Movie Maker), 386
View ➤ Toolbars
IE, 177
Windows Explorer, 420
View ➤ Toolbars ➤ Address bar (Windows Explorer), 177
View ➤ Toolbars ➤ Lock the Toolbars (common menu item), 87
View ➤ Toolbars ➤ Standard buttons (IE), 180
View ➤ Zoom, 151
Views button (Windows Explorer), 305, 420
virus
described, 283
download protection, 198, 287–288
e-mail attachment protection, 221–222, 224, 225, 284–286
file sharing protection, 287, 351
firewall, protection offered by, 608
opening, 284
scanning for, 287–288
software, anti-virus, 286–288
WAB as vehicle for, 285
worm compared, 283
VirusScan software, 286, 287
visualization (music player feature), 337, 354, 355
voice
accessibility features, 556–557, 558
instant messaging voice conversation, 261–262, 279
Narrator feature, 558, 559
recognition, 553
volume control
IE, 204
Windows Media Player, 338
Windows Messenger, 262
WAB (Windows Address Book)
Business tab, 234
contact list, 230–231, 233–234
Delete button, 234
faxing using information from, 157
Group tab, 235
Home tab, 234
identity, 232
mailing list, 234–235
Main Identity’s Contacts folder, 232
map, displaying, 234
Name tab, 233
New button, 233
Outlook Express, interfacing with, 231–236
Print button, 234
printing contact, 234
Select button, 235
Select Group Members dialog box, 235
Select Members button, 235
Shared Contacts folder, 232
starting, 232
vCard, exporting, 241
View Map button, 234
virus vehicle, as, 285
WAP (Wireless Access Point), 597
.wav files, 341
.wax files, 341
Web browser. See also IE (Internet Explorer)
caching, 181, 464
described, 174
Continued
Web browser (continued)

favorite
  adding page to, 180, 185–186
  closing, 190
  deleting, 189
  folder, organizing in, 188, 190
  moving, 188–189
  naming, 186, 189
  opening, 186–187
  user account, association with, 530

file, temporary, 181, 184, 464, 465
  frame handling, 181

history, 182–183, 184
  navigation, 178–181
  packet handling, 180
  printing, 181–182
  privacy, 184
  session, 180, 184
  starting, 174, 544
  text, editing using, 130
  URL, entering, 175–176, 205

Web cam, 263, 563
Web graphic, 151
Web page
  copying from
    picture, 136, 179, 314–315, 327–328
    text, 134, 179, 201–202
  desktop shortcut to, creating, 190–191
  error message when problem encountered, 205
  frame, 181
  home page, 173, 175, 185
  .NET Passport, using as site access mechanism, 280
  printing, 181–182
  refreshing, 180, 181
  video, posting on, 411
Web server, 165, 173
Webmaster, 205
Welcome screen, 9–10
Welcome to Windows Setup Wizard, 629
Whiteboard, Windows Messenger, 268–272

window
  active window, 61–63
  border, 67
  cascading, 63, 64, 68
  closing, 71–73
  document window, 61, 76, 119–120, 327
  dragging, 68
  item overview, 60–61
  maximizing, 65–66
  minimizing, 65–66, 120, 358
  moving, 68
  pop-up
    blocking, 281, 290–294, 353
    closing, 72
    extortion pop-up, 294
    software, generated by free, 197
    Windows Messenger pop-up, 281, 293–294
  program window, 59
  sizing, 64, 65, 66–68
  stack, 61–62
  switching to another open window, 13, 62–63
  taskbar, representation in, 13, 60, 61
  tiling, 64
  toolbar, 60
  Web page, opening in new, 178–179

Windows Address Book. See WAB
Windows Cannot Open This File message, 260
Windows Catalog Web site, 153
Windows Component, installing, 137, 566–568
Windows Explorer
  Address bar, 86, 88, 177, 474, 475
  Back button, 88
  CD Writing Wizard, 492–493
  closing, 96
  column width, changing, 453
  Confirm Multiple File Delete dialog box, 434
  Copy button, 443
  Copy Items dialog box, 444
  Create New Folder button, 425, 426
  described, 81, 419
  Details view, 91–95, 323–324, 453
  Explorer bar
    CD Writing Tasks section, 492
    Copy the Selected Icons option, 484
    described, 83
    Details section, 492
    displaying, 83, 420
    File and Folder Tasks section, 304, 425,
      434, 443, 490
    Folders list, 469–470, 474
    Imaging Tasks section, 316
    list display, 420
    Make a new folder section, 304
    Music Tasks section, 340–341
    My Network Places section, 608–609, 618
    Network Tasks section, 608, 623
    Picture Tasks section, 313, 317, 320–321
    Printer Tasks section, 616
    Printers and Faxes section, 147
    Recycle Bin Tasks section, 435–436
    Search section, 448
    folder, navigating, 83–86, 88, 420,
      469–470, 474
Folder Options dialog box, 83, 94, 101, 429–430, 460
Forward button, 88
IE versus, 81
List view, 420, 428
menu bar, 82
Move button, 443
Other Places category, 85–86
picture, displaying using, 90–91, 303, 305, 320
Save As dialog box, 425–426
Send To options, 485, 491, 503, 505, 554
shortcut key overview, 636
sizing, 420
slideshow option, 320
sorting file list, 92–93, 323, 453
starting, 419
taskbar button, 83–84
title bar, 82, 420
toolbar, 82–83, 420
undo functionality, 427, 435, 444–445
Up button, 85, 86, 510
view
default, changing, 459–460
refreshing, 486
Views button, 305, 420
Web page, opening from, 177
Windows folder, 472
Windows key, 7, 558
Windows Media Audio files. See WMA files
Windows Media Player
anchor window, 357
Back button, 349
Backup Now button, 352
CDDDB, interaction with, 361–362
closing, 338–339
color, 338
Copy button, 380
Copy from CD section, 337, 370
Copy Music tab, 365
Copy to CD or Device section, 337, 379
default player, setting as, 344, 345
downloading
skin, 357
update, 335–336
visualisation, 354
DVD, playing, 347–348, 487
Enhancements feature, 355
Fast Forward button, 338
Features taskbar, 336–337, 354, 357, 379
File Name Options dialog box, 366
format support overview, 341–342
Forward button, 349
full mode, 334, 348, 355, 356
help features, 382
Info Center View, 355
Internet connection, 335, 344–345
License Management dialog box, 351–352
Maximize/Restore Visual button, 348
Media Guide section, 336, 337, 349
menu bar, 334
mini mode, 357–358
minimizing, 358
MPEG support, 342
MP3 file
player, copying to using, 380–381
support, 342, 367
music, playing, 337–338, 354–355
Mute button, 338
Options dialog box
File Types tab, 344
Media Library tab, 362–363
Player tab, 336, 347, 357
Privacy tab, 364
Play/Pause button, 337
plug-in, 355, 367
Premium Services option, 337, 355
Previous button, 338
progress indicator, 349
Quick Launch toolbar button, 333
Radio Tuner, 337, 355
RealAudio support, 342
Refresh button, 349
Restore from Backup button, 352
Rewind button, 338
Seek bar, 338
Show/Hide button, 336
Shuffle button, 338
skin, 334, 337, 338, 356–357
starting, 333–334
Stop button, 338, 349
taskbar, adding control set to, 553
toolbar, 334
upgrading, 335–336
VCD, playing, 348–349
version, displaying, 335
Visualization feature, 337, 354, 355
Volume button, 338
Web site, 336, 382
Windows XP, included with, 335
WMA support, 342
WMV support, 342
Windows Media Video files. See WMV files
Windows Messenger. See also messaging, instant
Accept button, 267
Add a Contact Wizard, 251
Add Someone dialog box, 257
alert display, 257, 276, 281
Allow Control button, 267
Application Sharing feature, 266–268
audio
Audio Tuning Wizard, 261
sound options, 276
voice conversation, 261–262, 279
authentication, 249–250
autostarting, 275
background, running in, 275
Bell tab, 281
Block button, 257
Browse button, 277
cell phone, accessing using, 282
color, 267, 271
Connected message, 266
contact
adding, 251, 256–257
alert, displaying when arriving online, 276
blocking, 277–278
deleting, 274
displaying, 251, 259
displaying people who have added you, 278
grouping, 272–274
permission, 256–257
phone number, displaying/hiding, 279
Copy Contact To option, 272
dial-up connection, using with, 263, 264, 266
Do Not Disturb feature, 258–259, 267
e-mail verification, 249–250
emoticon list, 252–255
font, 255–256, 274
ink (hand-written message), receiving, 275
main window, 249
Messenger Properties dialog box, 293–294
microphone, using, 261, 262
Microsoft quality control and improvement program, 274
My Allow List, 277–278
My Block List, 277
My Received Files folder, 260, 277
name display options, 274–275
.NET Passport, relation to, 248
Notification Area display, 248, 257, 276, 281
online status display, 258–259, 275, 276, 278
Options dialog box
accessing, 274
Accounts tab, 279
Connection tab, 279
Personal tab, 274–275
Phone tab, 279
Preferences tab, 275–276
Privacy tab, 277–279, 280
phone call, making using, 279
pop-up, blocking, 281, 293–294
privacy, 277–279
Remote Assistance feature, 264–266
Send a File dialog box, 259
Sharing dialog box, 268
Sharing Session window, 266, 268
Sign Up Now button, 281
signing in/out, 248, 257, 259, 281
SIP support, 279
Sounds and Audio Devices dialog box, 276
Speakers slider, 262
Start Talking option, 262
starting, 248, 275
Stop Camera button, 263
Unshare All button, 268
Unshare button, 268
upgrading, 250
version covered in this book, 250
video, 263–264
voice conversation, 261–262, 279
Whiteboard, 268–272
Windows XP, included with, 248
Windows Meta File. See WMF
Windows Movie Maker. See also video
About Windows Movie Maker dialog box, 384
Audio Levels dialog box, 398, 406, 407
audio support, 396
Audio/Music bar, 407
Best fit to file size option, 410–411
Browse button, 408
closing, 413
collection
capturing video to, 395
displaying, 386
importing video to, 397, 404
introduced, 386
Video Transitions collection, 405
Contents pane, 386–387, 399
Delete button, 407
downloading, 384
Fast Forward button, 389
file
format support, 396
moving video file after addition to, 396
font, 402
Import button, 397
Import File dialog box, 404, 406
Make titles or credits option, 402
menu bar, 385
microphone, using, 407
monitor, 387–389
Movie button, 398
Movie Tasks pane, 385–386
Narrate button, 398
Narrate Timeline pane, 407
Next frame button, 389
Nudge options, 401
Options dialog box, 404, 405, 408
Play button, 397
Playback indicator button, 398, 400
Play/Pause button, 388, 399, 400
Previous frame button, 388
Record dialog box, 392
resolution needed, 384
Rewind button, 398, 400
Save button, 408
Save Movie Wizard, 408–409, 410
Save Picture As dialog box, 403
Save Project As dialog box, 408
Seek bar, 388
Split button, 389, 413–414
Start Capture button, 395
starting, 59, 383, 392
Stop button, 388
Stop Capture button, 395
Stop Narration button, 407
Storyboard button, 398
Storyboard/Timeline pane, 386, 398, 399–400
Switch view button, 399
Take photo button, 389
taskbar, 385
Thumbnails view, 387
Timeline button, 397
title bar, 385
toolbar, 385
Trim Point options, 401
undo functionality, 400, 415
upgrading, 384
version, displaying, 384
Video Capture Wizard, 392–395
Video Effects button, 404
video, playing, 387–389
Video Transitions and Effects feature, 387, 405
vinyl LP, copying using, 381
Web site, 384
WMV file, creating using, 408
work area, 386
Zoom buttons, 398
Windows Picture and Fax Viewer, 325–326
Windows XP, 9–11
WindowsCatalog Web site, 561–562
WindowsMedia.com Web site, 204
WINNT folder, 472
WinZip software, 502
Wireless Access Point. See WAP
wireless LAN, 596–598
.wm files, 341
WMA to MP3 Web site, 367
WMA (Windows Media Audio) files
compression, 367, 511
creating when ripping CD, 367
downloading, 353
introduced, 102
MP3, converting to, 367
Summary property, 359–361
Windows Media Player support, 342
Windows XP preferred format, as, 341, 342
.wmd files, 341
WMF (Windows Meta File), 306
WMV (Windows Media Video) files
compression, 511
downloading, 353
introduced, 102
Summary property, 359
Windows Media Player support, 342
Windows Movie Maker, creating using, 408
Windows XP preferred format, as, 341, 342
.wmx files, 341
.wmz files, 341
Word
faxing from, 158
Print dialog box, 142
word processing. See text
word wrap, 124
WordPad utility. See also Notepad utility; text
described, 123
document area, 76
Edit menu, 69
Font dialog box, 132
Format bar, 125, 132
Page Setup dialog box, 126
printing, 127
starting, 59, 123
text, copying from Web page to, 201–202
toolbar, 125
workgroup, 604, 608–609, 629
World Wide Web. See also Internet; Web
browser; Web page
address, 173, 175, 176–177
navigating, 178–181
searching, 192–196
security, 191–192
tld, 173, 174
World Wide Web Consortium Web site. See
W3C Web site
worm (virus-like program), 283–284, 286,
351, 608
WORM (Write Once, Read Many), 491
WPD (WordPerfect Document) files, 102
.wpg files, 307
.wpl files, 341
.wvx files, 341

Y
Yahoo! search engine, 195

Z
Zip disk
accessing, 481
backup medium, as, 588
capacity, 478, 480
compression, enabling, 482
file
  copying from, 485–486
  copying to, 483–485
  moving to, 484
floppy compared, 480
formatting, 481–483
inserting, 481
volume label, 482
zip file versus, 502
zip file
  creating, 502–504
  decompressing, 507–510
  deleting, 510
e-mail attachment, using for, 218, 223, 504,
  505–507, 508
extracting content, 507–510
folder, as compressed, 501, 502
icon, 504
introduced, 202
naming, 504
picture file, compressing using, 510
recompressing file, 511
saving, 508, 509
size, 504, 511
software for managing, 502
Zip disk versus, 502
zooming
picture, 151, 325
video, 398, 401
Windows Messenger Whiteboard, 270
Windows Movie Maker, 398